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System Training 
A well-trained workforce is critical to the success of your operation. Knowing how to correctly install, 
configure, program, calibrate, and trouble-shoot your Emerson equipment provides your engineers and 
technicians with the skills and confidence to optimize your investment. Energy and Transportation 
Solutions offers a variety of ways for your personnel to acquire essential system expertise. Our full-time 
professional instructors can conduct classroom training at several of our corporate offices, at your site, or 
even at your regional Emerson office. You can also receive the same quality training via our live, interactive 
Emerson Virtual Classroom and save on travel costs. For our complete schedule and further information, 
contact the Energy and Transportation Solutions Training Department at 800-338-8158 or e-mail us at 
Education@Emerson.com. 
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Section 1: Introduction  
FBxConnect™ configuration software enables you to monitor, configure, and calibrate 
Emerson's FB3000 RTU. Designed for ease of use, FBxConnect™ provides at-a-glance 
monitoring, quick access to commonly performed tasks, and configuration wizards to 
quickly get your equipment up and running. 

1.1 Installing and Starting FBxConnect 

FBxConnect™ Configuration Software is installed as a part of Emerson Field Tools. For 
more information about installation of Field Tools and connecting to a device, refer to 
Emerson Field Tools Quick Start Guide (D301703X412). 

1.2 User Interface 

FBxConnect™ is designed for ease of use. At the top of the display, FBxConnect™ utilizes a 
ribbon-style tabbed menu to navigate the software. Select a menu and submenu option 
to open the various displays of FBxConnect™.  

Note 

• Standard Microsoft® Windows® keyboard shortcuts are supported. Refer to 
Keyboard Shortcuts. 

• You can right-click your mouse on any field that is associated with an object or 
parameter in the FBx product database and select Copy Tag to copy the database tag 
to your computer's clipboard. You can then paste the information into another 
application such as FBxDesigner™ or FBxNet. 
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Figure 1. User Interface 

 

Click on the links below for more information about each user interface element: 

1. Menu – Use the Menu to access the displays and wizards used to configure and 
monitor your FB Series product. 

2. Instance Drop-Down List – The instance drop-down list allows you to choose different 
instances of a database object and appears at the top-left of many displays in 
FBxConnect™.  

3. Point Picker – The Point Picker dialog allows you to reference a specific object or 
parameter in the database.  

4. Forward, Back, and Pop-Up Buttons Forward, back, and pop-up buttons give you the 
ability to quickly jump back and forth between displays without losing your spot in the 
configuration process. 
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5. Copy and Paste Buttons – Use the Copy and Paste buttons to copy information from 
one instance and paste it into another instance.  

6.  Status Bar – The Status Bar provides general information about the connection to the 
FB Series product and contains a slider that controls the zoom level of the display. 

7. Pause/Resume Button (not shown) – Use the Pause/Resume button to prevent or 
restart automatically refreshing the values on the display.  

1.2.1 Menu 

FBxConnect™ contains a ribbon-style tabbed menu at the top of the window. Select a 
menu tab to view a list of options in a submenu. Select an option from the submenu to 
open that display or option.  

Note 

The submenu options are grouped together based on functionality. For example, the 
Configure menu has a group named Control where you can configure PID Loops, Action 
Blocks, Math Blocks, and Effects.  

Figure 2. Menu and Submenu 

 

For more information about each menu, select the name of a menu tab below: 

File Menu – Use the options in this menu to save a device configuration file to your PC, 
save a device configuration to flash memory, load a saved configuration to the device, or 
close the current connection to the device. 

Monitor Menu – Use the options in this menu to view current conditions including flowing 
conditions, history, alarms, events, and communication port status. 

Configure Menu – Use the options in this menu to configure device parameters, including 
meter runs, I/O, fluid properties, history, customizing the display, and running the Guided 
Setup. 

Services Menu – Use the options in this menu to access utilities and perform maintenance 
on your device, such as user management, firmware updates, and calibration. 
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Reports Menu – Use the options in this menu to collect information and view reports, 
including EFM, CFX, fluid composition, history, alarms, events, and diagnostic reports. 

Applications Menu – Use the options in this menu to access applications installed on your 
flow computer or RTU. 

FBxVue Menu – Use the FBxVue menu to create customized displays for the FB Series 
products. 

Help Menu – Use the options in this menu to view information about your installed 
version of Field Tools, and to access the online help system. 

Note 

If the submenu extends past the end of your screen, use the arrows located on the sides 
of the submenu to view the available options. 

 

1.2.2 Instance Drop-Down List 

The instance drop-down list allows you to choose different instances of a database object 
and appears at the top-left of many displays in FBxConnect™. When viewing a display with 
an instance drop-down list, select ▼ to show all available instances. For example, the 
Alarms display (shown below) allows you to choose many different instances of the alarm 
object. The text shown in the instance drop-down list follows a specific format. This text 
shows the object name and instance number (Alarm_1 in the picture below) followed by 
the configured Tag in parentheses (Diff Pressure 1 in the picture below).  

Note 

The tag shows in the instance drop-down list only if you have configured a unique tag for 
an instance. If you have not configured a unique tag, only the object and instance number 
shows in the instance drop-down list. 
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Instance Drop-Down List 

 

1.2.3 Point Picker 

In many locations in FBxConnect, you can click browse ( ) to view the Point Picker 

dialog. The Point Picker dialog allows you to reference a specific object or parameter in 
the database. These are used typically when linking two objects together (like a meter to a 
station) or when dynamically assigning an input or output variable to a source (like an 
analog input to a meter temperature input). 

You can also open the Point Picker dialog to view the database by selecting Configure > 
Point Picker from the FBxConnect™ main menu. 
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You can select two different types of references in FBxConnect™ depending on the field: 
object references and parameter references. 

Note 

If you open the Point Picker from the FBxConnect™ main menu (Configure > Point 
Picker), the dialog shows parameter references. 

• Object References – Sometimes the point picker is used to pick an object reference. 
In this case, you are only able to select the object and instance of the object. For 
example, if you are configuring a meter run and are setting the station assignment, 
you can only pick which station you wish to assign, not a particular parameter.  

Figure 3. Point Picker – Object Reference 

 

• Parameter References – Sometimes the point picker is used to pick a parameter 
reference. In this case, the Point Picker dialog shows three columns. You select an 
object and instance of the object in the first column. After clicking on the object type 
and instance in the first column, the second column displays all appropriate 
parameters for this particular object reference. Sometimes the parameter you pick in 
the second column is an object itself, and this object contains additional referenced 
parameters. You can choose these additional referenced parameters in the third 
column.  
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Figure 4. Point Picker – Parameter Reference 

 

Note 

To quickly remove a previously assigned object or parameter reference, right-click the 

browse button ( ) and select Undefined. 

 

 

Field Description 

Filter Click ▼ to change which objects and parameters are displayed. 
Filters may be based on object type, measurement type, or data type. 

Note 

Select No Filter to view all available Objects. 
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Field Description 

Object and 
Instances 

Object A group of configuration settings and calculated or 
measured values related to a specific function. For 
example, all values associated with the device clock 
(second, hour, day, etc.) are part of an Object named 
Clock. From the first column, click on the object type 
you wish to reference. 

Instance There may be one or more occurrences of each type 
of object with its own set of configuration settings and 
values. Each occurrence of an object is called an 
instance. For example, there are multiple instances of 
the object named Comm, and each instance 
represents one of the FB Series product’s 
communication ports. After clicking on the object you 
wish to reference, the available instances are 
displayed. Click on the instance you wish to reference. 

Parameter One of the configuration settings, calculated values, or measured 
values that is a part of the object. Each parameter has a value as well 
as a set of attributes that define it, such as data type, R/W access, 
measurement type, units, and parameter health. After clicking on the 
object and instance you wish to reference, the available parameters 
are displayed. Click on the parameter you wish to reference. 

Note 

This column appears only if you select the Point Picker for a 
Parameter Reference. 

Referenced 
Parameter 

If the point picker is used to pick a parameter reference, you can pick 
a parameter directly from the object to which it belongs, or you can 
pick the parameter through an object reference in a related object. 
For instance, to pick a parameter to assign to an Average object, you 
can pick the DP Mtr_1 object and the Station Assignment parameter 
and then the third column displays all of the parameters that are 
available from the Station object that is assigned to DP Mtr_1. This is 
useful because even if the station assignment later changes, the 
Average object is always associated with DP Mtr_1. 

Note 

This column appears only if you select the Point Picker for a 
Parameter Reference. 
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Field Description 

Tag This read-only field shows the name of the selected parameter. 

Data This read-only field shows the data type of the selected parameter. 
For more information, refer to Native Data Types. 

Access This read-only field shows the read/write access of the selected 
parameter. 

Value This read-only field shows the value of the selected parameter. 

Collect Tag 
Names 

Select this button to query the FB Series product and display any 
unique tag names you have assigned to individual parameters. 

Note 

You can perform this action at any time to reflect recent 
configuration changes. 

Copy Tag Select this button to copy the currently selected tag to the computer’s 
clipboard. You can then paste the selected tag into a different 
application, such as FBxDesigner™. 

 

1.2.4 Forward, Back, and Pop-Up Buttons 

Forward, back, and pop-up buttons give you the ability to quickly jump back and forth 
between displays without losing your spot in the configuration process. Forward buttons 
allow you to navigate to a new display to perform additional configuration changes, back 
buttons return you to the previous display, and pop-up buttons open a pop-up display 
that contains additional configuration options without navigating away from the current 
display. You can determine the behavior of a button based on the direction of the arrow 
on the button label. 

• Buttons with an arrow pointing to the right ( ) navigate to a new display. 

• Buttons with an arrow pointing to the left ( ) navigate to the previous display. 

• Buttons with an arrow pointing to the upper-right ( ) open a pop-up display.  

For example: 

1. Select Configure > Gas > DP Meter from the FBxConnect™ main menu. The DP Meter 
– General display opens.  
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2. Select the forward button ( ) located to the right of the Differential Pressure field. 

The Differential Pressure I/O display opens and allows you to configure the selected 
differential pressure input. 

Figure 5. Forward Buttons 

 

3. After you are done performing changes on the Differential Pressure I/O display, select 

the back button ( ) to return to the DP Meter display. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

25 

Figure 6. Back Button 

 

4. Select the Advanced button (with the arrow pointing to the upper-right ) to open 

the DP Meter – Advanced display to configure additional options for your meter.  

Figure 7. Pop-Up Button 
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5. When you are done making configuration changes, select Cancel to close the DP 
Meter – Advanced pop-up display. 

Figure 8. Cancel Button 

 

1.2.5 Copy and Paste Buttons 

Use the Copy and Paste buttons to copy information from one instance and paste it into 
another instance. This makes it easy to configure objects that contain similar information, 
such as meter runs or stations.  

For example: 

1. Select Configure > Gas > DP Meter. The DP Meter opens showing the General tab. 

2. Select the Copy button located at the bottom of the display. 

3. Click ▼ from drop-down list at the top of the display and select DP Meter instance 2. 

4. Select the Paste button. A confirmation message opens. 

Figure 9. Copy/Paste Confirmation 
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5. Select Yes to paste the data. Configuration information is copied from the first 
instance into the second instance. Any information that was changed is highlighted. 

Note 

If you copy information between two different configurations, FBxConnect™ shows an 
exception message with details about any objects or parameters that cannot be copied to 
the current configuration. 
Figure 10. Copy/Paste Exception 
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Figure 11. Display Showing Copied Information 

 

6. Review the information and then select Save to save your changes. 

1.2.6 Status Bar 

The Status Bar is located at the bottom of the display and provides general information 
about the connection to the FB Series product. Information includes the database build 
status, your user name, connection status, device type, and type of connection. 

Figure 12. Status Bar 
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1. Database Build Status – Shows the status of the FB Series product database. When 
the database build is completed, the icon is green. When the database build is not 
completed, the icon is red. 

2. SAv5 Enabled – This icon appears when DNP3 Secure Authentication version 5 (SAv5) 
is enabled on the FB Series product. 

3. Lock Status – This field appears when the Event Log Configuration Type is set to 
Separate Verifiable & Exportable Logs and the legal event log becomes full. 

Note 

• When the legal event log is full, a warning message appears and the device no 
longer accepts changes to legal parameters, firmware updates, calibrations, or 
configuration downloads. For more information, refer to Event Setup. 

 

• If your FB Series product becomes locked due to a full event log, refer to Export 
Events. 

4. System Verification – This color-coded field shows the status of the FB Series product 
as Verified (green) or Unverified (red). 

Note 

This information appears only if you select Separate Verifiable & Exportable Logs 
on the Event Setup display. 

5. User Name – Shows the user name currently logged into FBxConnect™. 

6. Communications Status – Shows the communications status between the FB Series 
product and FBxConnect™. When the connection to the FB Series product is good, the 
icon says "Online" and the color is green. When communications have been 
interrupted, the icon says "Comm Error" and the color is red. When viewing a 
configuration without being connected to an FB Series product, the icon says "Offline" 
and the color is grey. 
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7. Device Type – Shows the FB Series product type currently connected through 
FBxConnect™. 

8. CPU Communications Port and Speed – Shows the communications port being used 
for communications by FBxConnect™. 

9. Zoom – Use the slider to adjust the zoom level of the FBxConnect™ display. 

Note 

You can also hover your mouse pointer over the slider and move the scroll wheel to 
adjust the zoom level. 

10. Device Time – Shows the time the current time of the FB Series product's clock. 

1.2.7 Pause/Resume Button 

Use the Pause/Resume button to prevent or restart automatically refreshing the values 
shown on the display. The Pause/Resume button appears on displays with values that are 
constantly updated. 

For example: 

1. Select Configure > Gas > DP Meter. The DP Meter opens showing the General tab. 

2. Select the Rates & Totals button. The DP Rates & Totals pop-up display opens 
showing the Rate & Totals tab. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

31 

Figure 13. DP Meter Rates & Totals – Pause Button 

 

3. Select the Pause button to prevent values shown on the display from automatically 
refreshing. 
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Figure 14. DP Meter Rates & Totals – Resume Button 

 

4. Select the Resume button to restart automatically refreshing the values shown on the 
display. 

5. Review the information and then select Close to return to the previous display. 

1.2.8 Keyboard Shortcuts 

FBxConnect™ supports keyboard shortcuts that provide an alternate way of performing 

an action. Below is the list of supported keyboard shortcuts: 

Table 1. Keyboard Shortcuts 

Shortcut Description 

Ctrl+O Export all parameter values on a display to a CSV file. 

Ctrl+U Open a pop-up version of the User Data display without closing the 
display you’re currently viewing. 

Ctrl+C Copy the selected text to the clipboard. 

Ctrl+V Paste text from the clipboard. 
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Shortcut Description 

Ctrl When creating a display in FBxVue, press and hold to select multiple 
objects on the canvas. 

 

1.3  File Formats 

The following table describes the file formats used by FBxConnect™ and FBxDesigner™: 

Table 2. File Formats 

File Extension Software Description 

.csv  FBxConnect™  Option for report generation in FBxConnect™ 
(Alarms, Events, History, etc.). 

.mwt  FBxDesigner™  Main FBxDesigner™ project file. 

.pak  FBxConnect™  Individual firmware image (CPU, I/O Modules, etc.). 

.pdf  FBxConnect™  Option for report generation in FBxConnect™ 
(Alarms, Events, History, etc.). 

.ptc  FBxConnect™  Partial configuration file for FB Series products saved 
via FBxConnect™. 

.ets  FBxConnect™  License file generated via Licensing Tool and 
imported to a device via FBxConnect™. 

.xml  FBxConnect™  Multiple uses: 

• Configuration file for FB Series flow computers 
and is saved via FBxConnect™. 

• FBxVue display file that is a user interface. The 
display file can be edited and viewed via 
FBxConnect™. 

.zap  FBxConnect™  Zipped application package that contains an 
IEC61131 project and components. 

.zip  FBxConnect™  System firmware image that contains all firmware 
images required for the FB3000 (CPU, I/O Modules, 
etc.). 

.zsl  FBxConnect™  Zipped Solution that contains the configuration for 
an FB3000 device and is saved via FBxConnect™. 
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File Extension Software Description 

.zwt  FBxDesigner™  Zipped FBxDesigner™ project file that contains all 
files needed for a project. 

1.4  Native Data Types 

Values stored within FB Series devices exist as parameters in an internal database. Each of 
these parameters has a native data type that best fits the purpose of the data. Many of 
these data types are industry standard, such as signed integers, unsigned integers, 32-bit 
floats, and 64-bit doubles. However, more unusual and specialized native data types, such 
as ENUM16, BIN8, and BYTE4 are also used throughout the device. Data type definitions, 
their size (in bytes), and typical use or range is defined in the table below. 

Understanding the native data types is important for configuration exercises, such as 
mapping Modbus registers and custom DNP3 maps. External systems do not often have 
the same native data types as an FB Series device. Choosing appropriate remote data 
type conversions (Modbus) or Tables (DNP3) will depend on the size, range, and purpose 
of the native data types. 

Note 

• ENUM16 – The ENUM16 data type is used extensively throughout the internal 
database. It is an integer which represents an enumeration where each value (0, 1, 2, 
etc.) has a different meaning. This data type is the same as a UINT16 (unsigned 16-bit 
integer) and should be treated as such for mapping to external systems. 

• BIN – The BIN data types (BIN8, BIN16, BIN32) are integers where each bit of the 
value has a specific meaning. A BIN8 (which is the same as a UINT8) has 8 bits, a 
BIN16 (same as a UINT16) has up to 16 bits, and a BIN32 (same as a UINT32) has up to 
32 bits (note that not all bits may be used). Treat these data types as their associated 
unsigned integers (UINT8, UINT16, UINT32) when mapping to external systems. 

• BYTE – The BYTE data types (BYTE4, BYTE6, BYTE32) represent a series of bytes which 
are all related, but do not typically form an integer. Use of these data types is rare, 
and they do not typically have an analogous data type in external systems.  

• PRMREF and OBJREF – The PRMREF and OBJREF data types are used throughout the 
system for linking data and groups of data together. These references can be used to 
point to other parameters (or objects) sometimes as defined by the user, and other 
times in a fixed manner. Because of the “tag” based nature of accessing parameters in 
FB Series devices, a PRMREF is essentially a UC40 (40-character string), and an OBJREF 
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is essentially a UC20 (20-characters string). Treat these data types as their associated 
strings (UC40 and UC20) when mapping to external systems. 

Table 3. FB Series Device Native Data Types 

Data 
Type 
(Protocol 
Name)1 

Data Type 
(FBxConnect™ 
Name)2 

# of 
Bytes 

Database 
Block 
Size 

Definition 

UINT8 INTEGER 8 1 Small Unsigned 8-bit integer.  

Range of 0 to 255. 

INT8 INTEGER 8 1 Small Signed 8-bit integer.  

Range of -128 to 127. 

UINT16 INTEGER 16 2 Small Unsigned 16-bit integer. 

Range of 0 to 65,353. 

INT16 INTEGER 16 2  Small Signed 16-bit integer.  

Range of -32,768 to 32,767. 

UINT32 INTEGER 32 4 Small Unsigned 32-bit integer. 

Range of 0 to 4,294,967,296. 

INT32 INTEGER 32 4 Small Signed 32-bit integer. 

Range of -2,147,483,648 to 
2,147,483,647. 

UINT64 INTEGER 64 8  Small Unsigned 64-bit integer. 

INT64 INTEGER 64 8 Small Signed 64-bit integer. 

FLOAT FLOAT 4 Small 32-bit IEEE floating-point number. 

DOUBLE DOUBLE 8  Small 64-bit IEEE floating-point number. 

UC10 STRING 10 11  Medium 10-character string with null 
termination. 

UC20 STRING 20 21  Medium 20-character string with null 
termination. 

UC30 STRING 30 31  Large 30-character string with null 
termination. 

UC40 STRING 40 41  Large 40-character string with null 
termination. 
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Data 
Type 
(Protocol 
Name)1 

Data Type 
(FBxConnect™ 
Name)2 

# of 
Bytes 

Database 
Block 
Size 

Definition 

BYTE4 BYTE 4 4  Small Byte array with 4 bytes (i.e., an IP 
address). 

BYTE6 BYTE 6 6  Small Byte array with 6 bytes (i.e., a MAC 
address). 

BYTE32 BYTE 32 32  Large Byte array with 32 bytes. 

TIME INTEGER 64 8  Small Bytes 1 thru 4 – Seconds since Jan 1, 
2000. 

ENUM16 ENUM 2 Small 16-bit unsigned integer, which 
represents an enumeration. 

BIN8 BIN 8 1 Small 8-bit binary value (bitwise indication). 

BIN16 BIN 16 2 Small 16-bit binary value (bitwise 
indication). 

BIN32 BIN 32 4 Small 32-bit binary value (bitwise 
indication). 

PRMREF PRMREF 41  Large Parameter Reference. 

OBJREF OBJREF 21  Medium Object Reference. 

Note 

1. The Data Type (Protocol Name) column lists the data type name shown in the 
DNP3 Protocol Specifications Manual (for Emerson FB3000 RTUs) (D310858X012). 

2. The Data Type (FBxConnect™ Name) column lists the data type name shown in 
FBxConnect™ Configuration Software. 

 

1.5 Calculation Library Limit Checks 

FB Series products support multiple calculation libraries for both gas and liquid 
measurements. Each calculation library is subject to unique limits. Refer to the following 
tables based on the fluid you are measuring and the calculation you have selected: 

Natural Gas Compressibility & Density Limit Checks 

• AGA 8 2017 
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• AGA 8 1992 + ISO 12213-2 2006 

• GERG TM5 1991 (SGERG) + ISO 12213-3 2006 

• AGA NX-19 1962 + AGA NX-19 MOD 1966 + AGA NX-19 MOD BR KORR 1982 + VDI/VDE 
2040 Part 2 1987 

Natural Gas Calorific Value (CV) Limit Checks 

• ISO 6976 1995 + Amendment 1997 

• GPA 2172 1996/2009 + GPA 2145 1996/2000/2003/2009/2016 

Natural Gas Flow Measurement Limit Checks 

• AGA 3 1994 

• ISO 5167 1991/1998/2003 

• Rosemount 1595 Conditioning Orifice Plate, 405 Compact Orifice Plate 

• V-CONE (McCrometer and NuFlo) 

Liquid Limit Checks 

• API Ch. 11.1 2007 

• API 11.2.2 

• GPA 8117 

• GPA 8217 

1.5.1 Natural Gas Compressibility & Density Limit Checks 

Refer to the following tables for information about specific limit checks for the following 
calculations: 

• AGA 8 2017 

• AGA 8 1992 + ISO 12213-2 2006 

• GERG TM5 1991 (SGERG) + ISO 12213-3 2006 

• AGA NX-19 1962 + AGA NX-19 MOD 1966 + AGA NX-19 MOD BR KORR 1982 + VDI/VDE 
2040 Part 2 1987 
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AGA 8 2017 

Table 4. AGA 8 Part 1 Detail method 
 

Range A Range B Range C 

Lower temperature 
limit  

>= 25.0°F  

>= –4.0°C 

25.0°F  

 –4.0°C 

17.0°F  

–8.0°C 

Upper pressure limit  <=1500.0 psia  

<=10.3 MPa 

300.0 psia  

2.1 MPa 

3000.0 psia  

21.0 MPa 

Gross heating value†  23.5 – 44.7 MJ/m3 25.3 – 56.0 MJ/m3 35.8 – 40.6 
MJ/m3 

Relative density†  0.554 – 0.91  0.47 – 0.91  0.554 – 0.64 

Upper composition 
limits: 

      

Methane  <= 100.0% 100.0% 100.0% 

Nitrogen  <= 50.0% 50.0% 3.0% 

Carbon dioxide  <= 30.0%* 80.0% 3.0% 

Ethane  <= 10.0% 25.0% 4.0% 

Propane  <= 4.0% 6.0% 2.0% 

Isobutane  <= 0.4% 1.5%  0.1% 

n-Butane  <= 0.6 6.0% 0.4% 

Isopentane  <= 0.3% 2.0% 0.1% 

n-Pentane <= 0.3% 2.0% 0.1% 

Total pentanes  <= 0.3% 2.0% 
 

n-Hexane <= 0.12%  0.2% 0.03% 

n-Heptane <= 0.04% 0.2% 0.01% 

n-Octane <= 0.03% 0.2% 0.003% 

n-Nonane <= 0.03% 0.2% 0.003% 

n-Decane <= 0.03% 0.2% 0.003% 

Total hexanes plus  <= 0.15% 
  

Total heptanes 
plus  

<= 0.04% 
  

Hydrogen  <= 5.0% 100.0% 1.0% 
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Range A Range B Range C 

Oxygen    <= 0.2% 1.0% 0.2% 

Carbon 
monoxide 

<= 1.0% 10.0% 1.0% 

Water <= 0.05% 1.4% 0.005% 

Hydrogen sulfide <= 0.1% 4.0% 0.1% 

Helium <= 0.4% 5.0% 0.4% 

Argon <= 0.2% 
  

† Values are based on a methane lower limit composition of 60 mole percent. 

*The mole percent of carbon dioxide upper limit is reduced for the following conditions 
for Range A: 

• Carbon Dioxide <= 20.0% when Nitrogen > 7.0% 

• Carbon Dioxide <= 10.0% when Nitrogen > 15.0% 

• Carbon Dioxide <= 7.0% when Propane > 1.0% 

• Carbon Dioxide <= 5.0% when Propane > 2.0% 

• Carbon Dioxide <= 10.0% when Isobutane > 0.1% 

• Carbon Dioxide <= 10.0% when n-Butane > 0.3% 

 

Table 5. AGA 8 Part 1 Gross Method 1 & 2 
 

Range 1 Range 2 

Lower Temperature >=25.0°F 

>=-4.0°C 

17.0°F 

-8.0°C 

Min Temperature <=143.0°F  

<=62.0°C  

143.0°F 

62.0°C 

Max Pressure <=1500.0 psia 

<=10.3 MPa 

600.0 psia 

4.1 MPa 

Gross heating value 34.7 – 38.7 MJ/m3 24.8 – 41 MJ/m3 

Relative density 0.554 – 0.63 0.554 – 0.89 

Upper composition limits: 
  

Carbon Dioxide <= 3.0% 25.0% 

Hydrogen <= 0.2% 2.0% 

Nitrogen <= 7.0% 20.0% 
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Table 6. AGA 8 Part 2 GERG Method 

Upper Temperature  <=800.0°F 

<=700.0 K 

Maximum Pressure <=10150.0 psia  

<=70.0 MPa 

Note 
Composition limits are not considered since the “model is also applicable to each of the 
pure natural gas components and to numerous binary and multi-component mixtures” 
(AGA 8 Part 2 pg. 1). Mixtures with high compositions of water, hydrogen, or helium 
may be subject to errors (AGA 8 Part 2 pg. 23). 

 

AGA 8 1992 + ISO 12213-2 2006 

Table 7. AGA 8 Detail method (Normal Range) 

Pressure 0.0 – 275.79 MPa 

0.0 – 40000 psia 

Temperature 144.26 – 677.60 K 

-200.0 – 760.0°F 

Methane  45.0 – 100.0% 

Nitrogen  <= 50.0% 

Carbon Dioxide  <= 30.0% 

Ethane  <= 10.0% 

Propane  <= 4.0% 

iC4 + nC4  <= 1.0% 

iC5 + nC5  <= 0.3% 

nC6 + nC7 + nC8 + nC9 + nC10  <= 0.2% 

Helium  <= 0.2% 

Hydrogen  <= 10.0% 

Carbon Monoxide  <= 3.0% 

Argon  <= 0.1%  

Oxygen  <= 0.1% 
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Pressure 0.0 – 275.79 MPa 

0.0 – 40000 psia 

Water  <= 0.05% 

Hydrogen Sulfide  <= 0.02% 

 

Table 8. AGA 8 Gross 1 method 

Pressure 0.0 – 12.07 MPa 

0.0 – 1750.0 psia 

Temperature 265.0 – 335.0 K 

17.0 - 143.0°F 

Specific Gravity 0.554 – 0.87 

Gross Heating Value  18.7 – 45.1 MJ 

Carbon Dioxide  <= 30.0% 

Hydrogen  <= 10.0% 

 

Table 9. AGA 8 Gross 2 method 

Pressure 0.0 – 12.07 MPa (0.0 – 1750.0 psia) 

Temperature 265.0 – 335.0 K (17.0 - 143.0°F) 

Specific Gravity 0.554 – 0.87 

Nitrogen  <= 53.6% 

Carbon Dioxide  <= 30.0% 

Hydrogen  <= 10.0% 

 

Table 10. ISO 12213-2 AGA8 Detail method (Wide Range) 

Pressure 0.0 – 65.0 MPa 

Temperature 225.00 – 335.00 K 

 

Table 11. ISO 12213-2 AGA8 Detail method (Pipeline Quality) 

Methane  70.0 – 100.0% 

Nitrogen  <= 20.0% 
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Methane  70.0 – 100.0% 

Carbon Dioxide  <= 20.0% 

Ethane  <= 10.0% 

Propane  <= 3.5% 

iC4 + nC4  <= 1.5% 

iC5 + nC5  <= 0.5% 

nC6  <= 0.1% 

nC7  <= 0.05% 

nC8 + nC9 + nC10  <= 0.05% 

Helium  <= 0.5% 

Hydrogen  <= 10.0% 

Carbon Monoxide  <= 3.0% 

Argon  <= 0.02% 

Oxygen  <= 0.02% 

Water  <= 0.015% 

Hydrogen Sulfide  <= 0.02% 

 

GERG TM5 1991 (SGERG) + ISO 12213-3 2006 

Table 12. SGERG Methods 1 - 4 

Pressure 0.01 – 12.0 MPa 

Temperature 265.0 – 335.0 K (-8.15 – 61.85°C) 

Relative Density 0.55 – 0.90 

Heating Value 19.0 – 48.0 MJ/m3 

Nitrogen 0.0 – 50.0% 

Carbon Dioxide 0.0 – 30.0% 

Hydrogen 0.0 – 10.0% 
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Table 13. ISO 12213-3 Data Sets 1 - 4 

Pressure 0.01 – 12.0 MPa 

Temperature 263.0 – 338.0 K 

Relative Density 0.55 – 0.90 

Heating Value 20.0 – 48.0 MJ/m3 

Nitrogen 0.0 – 50.0% 

Carbon Dioxide 0.0 – 30.0% 

Hydrogen 0.0 – 10.0% 

 

AGA NX-19 1962 + AGA NX-19 MOD 1966 + AGA NX-19 MOD BR 
KORR 1982 + VDI/VDE 2040 Part 2 1987 

Table 14. NX-19 1962 / NX-19 MOD 

Pressure 0.01 – 34.58 MPa (0.0 – 5000.0 psig) 

Temperature 233.14 – 388.76 K (-40.0 – 240.0°F) 

Relative Density 0.554 – 1.0 

Nitrogen 0.0 – 15.0% 

Carbon Dioxide 0.0 – 15.0% 

 

Table 15. NX-19 MOD BR KORR 

Pressure 0.01 – 34.58 MPa (0.0 – 5000.0 psig) 

Temperature 233.14 – 388.76 K (-40.0 – 240.0°F) 

Relative Density 0.554 – 1.0 

Heating Value 39.8 – 46.2 MJ/m3 

Nitrogen 0.0 – 15.0% 

Carbon Dioxide 0.0 – 15.0% 

 

Table 16. NX-19 VDI/VDE 2040 

Pressure 0.001 – 13.79 MPa 

Temperature 233.14 – 388.76 K (-40.15 – 115.6°C) 
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Pressure 0.001 – 13.79 MPa 

Relative Density 0.554 – 0.75 

Nitrogen 0.0 – 15.0% 

Carbon Dioxide 0.0 – 15.0% 

 

1.5.2 Natural Gas Calorific Value (CV) Limit Checks 

Refer to the following tables for information about specific limit checks for the following 
calculations: 

• ISO 6976 1995 + Amendment 1997 

• GPA 2172 1996/2009 + GPA 2145 1996/2000/2003/2009/2016 

 

ISO 6976 1995 + Amendment 1997 

Table 17. ISO6976 1995 

Pressure 0.001 – 13.79 MPa 

Base Temperature (t2) -10.0 – 30.0°C 

Each Component 0.0 – 100.0% 

Component Sum 99.9 – 100.1% 

 

GPA 2172 1996/2009 + GPA 2145 1996/2000/2003/2009/2016 

Table 18. GPA 2172 1996 / GPA 2172 2009 

Pressure 0.0 – 30.0 psia 

Temperature -10.0 – 30.0°C 

Each Component 0.0 – 100.0% 

Component Sum 99.9 – 100.1% 
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1.5.3 Natural Gas Flow Measurement Limit Checks 

Refer to the following tables for information about specific limit checks for the following 
calculations: 

• AGA 3 1994 

• ISO 5167 1991/1998/2003 

• Rosemount 1595 Conditioning Orifice Plate, 405 Compact Orifice Plate 

• V-CONE 

 

AGA 3 1994 

Table 19. AGA 3 1994, FLANGE, CORNER, and D-D/2 

Pressure 0.0 – 100000.0 psia 

Differential Pressure < Pressure 

Pressure Ratio >= 0.75 

Temperature -400.0 – 1000.0°F 

Relative density 0.1 – 2.0 

Flowing density 0.001 – 100.0 lbm/ft3 

Pipe diameter 2.0 – 100.0 in 

Orifice diameter 0.45 – 100.0 in 

Orifice diameter  < Pipe diameter 

Isentropic exponent > 0.0 

Viscosity > 0.0 

Beta ratio 0.1 – 0.75 

Reynolds number 4000.0 – 1.0e10 

Gravity 30.0 – 40.0 ft/sec2 

Elevation -10000.0 – 50000.0 ft 
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ISO 5167 1991/1998/2003 

Table 20. ISO5167 1991, ISO5167 1998, and ISO5167 2003 

Upstream pressure >= 1.0e-10 

Differential Pressure < Upstream pressure 

Pressure Ratio >= 0.75 

Upstream temperature -200.0 – 1000.0°C 

Upstream density 0.01 – 2000.0 kg/m3 

Orifice diameter < Pipe diameter 

Isentropic exponent > 1.0e-10 

Viscosity > 1.0e-10 

 

Table 21. FLANGE 

Orifice diameter >= 12.5 mm 

Pipe diameter (D) 50.0 – 1000.0 mm 

Beta Ratio (B) 0.2 – 0.75 (ISO5167 1991) 

0.1 – 0.75 (ISO5167 1998, 2003) 

Reynolds number >= 1260.0*B*B*D (ISO5167 1991) 

>= 4000.0 & >= 170.0*B*B*D (ISO5167 
1998) 

>= 5000.0 & >= 170.0*B*B*D (ISO5167 
2003) 

 

Table 22. CORNER 

Orifice diameter >= 12.5 mm 

Pipe diameter 50.0 – 1000.0 mm 

Beta Ratio (B) 0.2 – 0.75 - ISO5167 1991 

0.1 – 0.75 - ISO5167 1998, 2003 
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Orifice diameter >= 12.5 mm 

Reynolds number  > 5000.0 for B in 0.2 – 0.45 (ISO5167 
1991) 

> 10000.0 for B > 0.45 (ISO5167 1991) 

> 4000.0 for B in 0.1 – 0.5 (ISO5167 
1998) 

> 16000.0*B*B for B > 0.5 (ISO5167 
1998) 

> 5000.0 for B in 0.1 – 0.56 (ISO5167 
2003) 

> 16000.0*B*B for B > 0.56 (ISO5167 
2003) 

 

Table 23. D-D/2 

Orifice diameter >= 12.5 mm 

Pipe diameter 50.0 – 1000.0 mm 

Beta Ratio (B) 0.2 – 0.75 - ISO5167 1991 

0.1 – 0.75 - ISO5167 1998, 2003 

Reynolds number  >= 1260.0*B*B*D (ISO5167 1991) 

> 4000.0 for B in 0.1 – 0.5 (ISO5167 
1998) 

> 16000.0*B*B for B > 0.5 (ISO5167 
1998) 

> 5000.0 for B in 0.1 – 0.56 (ISO5167 
2003) 

> 16000.0*B*B for B > 0.56 (ISO5167 
2003) 

 

Table 24. NOZZLE 1932 

Pipe diameter 50.0 – 500.0 mm 

Orifice diameter >= 0.0 mm 

Beta Ratio (B) 0.3 – 0.8 
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Pipe diameter 50.0 – 500.0 mm 

Reynolds number 70000.0 – 10000000.0 for B 0.3 – 0.44 

20000.0 – 10000000.0 for B >= 0.44 

 

Table 25. NOZZLE LONG RADIUS 

Pipe diameter 50.0 – 630.0 mm 

Orifice diameter >= 0.0 mm 

Beta Ratio 0.2 – 0.8 

Reynolds number 10000.0 – 10000000.0 

 

Table 26. VENTURI NOZZLE 

Pipe diameter 65.0 – 500.0 mm 

Orifice diameter >= 50.0 mm 

Beta Ratio 0.316 – 0.775 

Reynolds number 150000.0 – 2000000.0 

 

Table 27. VENTURI TUBE AS CAST 

Pipe diameter 100.0 – 800.0 mm 

Orifice diameter >= 0.0 mm 

Beta Ratio 0.3 – 0.75 

Reynolds number 200000.0 – 2000000.0 

 

Table 28. VENTURI TUBE MACHINED 

Pipe diameter 50.0 – 250.0 mm 

Orifice diameter >= 0.0 mm 

Beta Ratio 0.3 – 0.75 

Reynolds number 200000.0 – 1000000.0 
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Table 29. VENTURI TUBE ROUGH WELD 

Pipe diameter 200.0 – 1200.0 mm 

Orifice diameter >= 0.0 mm 

Beta Ratio 0.4 – 0.70 

Reynolds number 200000.0 – 2000000.0 

 

Rosemount 1595 Conditioning Orifice Plate, 405 Compact 
Orifice Plate 

Table 30. RSMT1595 2003, RSMT405C 2003, RSMT405P 2003 

Upstream pressure >= 1.0e-10 

Differential Pressure < Upstream pressure 

Pressure Ratio >= 0.75 

Upstream temperature -200.0 – 1000.0°C 

Upstream density 0.01 – 2000.0 kg/m3 

Orifice diameter < Pipe diameter 

Isentropic exponent > 1.0e-10 

Viscosity > 1.0e-10 

 

V-CONE (McCrometer, NuFlo) 

Table 31. McCROMETER 2.3 1997, McCROMETER 3.0 2001, NUFLO 2007, and NUFLO 
2013 

Upstream pressure >= 1.0e-10 

Differential Pressure < Upstream pressure 

Pressure Ratio >= 0.75 

Upstream temperature -200.0 – 1000.0°C 

Upstream density 0.01 – 2000.0 kg/m3 

Orifice diameter < Pipe diameter 

Isentropic exponent > 1.0e-10 

Viscosity > 1.0e-10 
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Upstream pressure >= 1.0e-10 

Pipe diameter 10.0 – 4000.0 mm 

Orifice diameter >= 0.0 mm 

Beta Ratio 0.1 – 0.95 

Reynolds number 20000.0 – 2000000.0 

 

1.5.4 Liquid Limit Checks 

Refer to the following tables for information about specific limit checks for the following 
calculations: 

• API Ch. 11.1 2007 

• API 11.2.2 

• GPA 8117 

• GPA 8217 

 

API Ch. 11.1 2007 

Table 32. Crude Oil 

Density (observed) 470.5 – 1201.8 kg/m3 

Density @ 60°F 610.0 – 1163.5 kg/m3 

Temperature -50.00 – 150.00°C (-58.0 – 302.0°F) 

Pressure 0.0 – 1,500.0 psig 

α60z 0.000230 – 0.000930 per °F 

 

Table 33. Refined Products 

Density (observed) 470.4 – 1209.5 kg/m3 

Density @ 60°F 610.0 – 1163.5 kg/m3 

Temperature -50.00 – 150.00°C 

Pressure 0.0 – 1,500.0 psig 

α60z 0.000230 – 0.000930 per °F 
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Table 34. Lubricating Oils 

Density (observed) 714.3 – 1208.3 kg/m3 

Density @ 60°F 800.9 – 1163.5 kg/m3 

Temperature -50.00 – 150.00°C 

Pressure 0 – 1,500 psig 

α60z 0.000230 – 0.000930 per °F 

 

Table 35. Specific Refined Products (Density @ 60°F) 

Fuel Oils 838.3127 – 1163.5 kg/m3 

Jet Fuels 787.5195 – 838.3127 kg/m3 

Transition Zone 770.3520 – 787.5195 kg/m3 

Gasolines 610.6 – 770.3520 kg/m3 

 

API 11.2.2 

Table 36. API 11.2.2 

Rel. Density @ 60°F 0.350 – 0.637 RD 

Temperature -50.0 – 140.0°F 

Tmax 0.96Tcritical ; Tcritical = 621.418 - 
822.686 * RD60 + 1737.86 * RD602 

Pressure Difference 0.0 – 2,200.0 psig 

 

GPA 8117 

Table 37. GPA 8117 

Rel. Density @ 60°F 0.350 – 0.676 RD 

Temperature -50.0 – 140.0 °F 

Note  
If RD60 < 0.425 then Tmax = (695.51 * RD60 - 155.51)°F 
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GPA 8217 

Table 38. GPA 8217 

Density (observed) 0.2100 – 0.7400 RD 

Density @ 60°F 0.3500 – 0.6880 RD 

Temperature -50.8 – 199.4 °F 

 

1.6 Troubleshooting Pop-Up Displays 

You may encounter an issue where pop-up displays (such as DP Meter – Diagnostics or 
Liquid Linear Meter – Rates and Totals) fail to open. FBxConnect™ uses the system 
registry to monitor application memory, and this behavior can occur when performance 
counters in the system registry become corrupted and FBxConnect™ is unable to 
determine the memory consumption. You can fix this issue by rebuilding the performance 
counters in the system registry. 

To rebuild the performance counters: 

1. Click Start and type CMD to perform a search for the Command Prompt. 

2. Select Command Prompt from the search results. The Command Prompt windows 
opens. 

3. Type cd c:\windows\system32 and press Enter. 

4. Type lodctr /R and press Enter. 

5. Type cd c:\windows\sysWOW64 and press Enter. 

6. Type lodctr /R and press Enter. 

After performing these steps, you have rebuilt the performance counters and can open 
pop-up displays in FBxConnect™. 
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Section 2: File Menu 
Use the options in this menu to save an FB Series product configuration file to your PC, 
save an FB Series product configuration to flash memory, load a saved configuration to 
the FB Series product, or close the current connection to the FB Series product. 

Figure 15. File Menu (online and offline) 

 

 

The File menu contains the following options: 

Save – Save changes when modifying a solution's configuration file in offline mode (not 
connected to an FB Series product).  

Save As – Save changes when modifying a solution's configuration file in offline mode (not 
connected to an FB Series product) to a new file on your PC. 

Upload Solution – Package application and configuration data from your FB Series 
product and save it on your PC. 

Download Solution – Load a previously saved configuration file or solution to the 
connected FB Series product. 

Download to Flash – Save a previously saved configuration file to the flash memory of the 
connected FB Series product. 

Save to Flash – Save the current configuration to the flash memory of the connected FB 
Series product.  

Close – Close the current connection and exit FBxConnect™. 
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2.1  Save (Offline Mode) 

Use the Save option to save changes when modifying a solution's configuration file in 
offline mode (not connected to an FB Series product). It is good practice to save your 
configuration whenever you make a change to the file. 

 When you save a solution's configuration, a file is saved to your PC. This allows you to 
reload the solution's configuration if something should corrupt your device. 

Note 

When working in offline mode from a newly created FBxConnect™ configuration file, read-
only output parameters are not included in the configuration file and are instead 
displayed as default values. 

To save a solution's configuration file in offline mode: 

1. Open an FB Series product configuration file in Field Tools, and make the required 
changes. 

2. Select File > Save from the FBxConnect™ main menu. The Solution Configuration Save 
dialog opens and shows the progress of saving your solution's configuration. 

Figure 16. Solution Saved Successfully 

 

3. Select Close to exit the Solution Configuration Save dialog. 
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2.2  Save As (Offline Mode) 

Use the Save As option to save a copy of the current solution's configuration file and 
specify a new file name or location. This option is only available while in offline mode (not 
connected to an FB Series product).  

Note 

• When working in offline mode from a newly created FBxConnect™ configuration file, 
read-only output parameters are not included in the configuration file and are instead 
displayed as default values. 

• After you create a backup configuration file, you can load it onto a device using 
Download Solution and save it to the device's flash memory using Download to Flash.  

To save a copy of a solution's configuration to a file on your PC: 

1. Open an FB Series product configuration file in Field Tools, and then make the 
required changes. 

2. Select File > Save As from the FBxConnect™ main menu. The Configuration Save As 
dialog displays: 

Figure 17. Solution Configuration Save As 

 

3. Select Browse to open a file explorer window. 
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Figure 18. Save As 

 

4. Navigate to a location on your PC you wish to save the configuration file, enter a 
name for the file, and then select Save. The Configuration Save As screen re-displays. 
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Note 

• The default file name includes the connection/device name, report type, and 
timestamp of report creation (ConnectionName_ReportType_YYMMDDThhmmss). 

• The default location for saved configuration files is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Solutions. This location is in a hidden 
folder, and you may need to select "show hidden files" on your computer to view this 
folder. 

Figure 19. Partial configuration 

 

5. If you want to manually select which Objects and Instances are saved in the 
configuration file, select Partial Upload. The Select Configuration dialog opens. 

Note 

The Partial configuration option requires firmware version 2.7 or later. 
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Figure 20. Select Configuration 

 

6. Place a check mark next to the specific Objects and Instances you wish to save in the 
configuration file and click Close. The Configuration Upload dialog re-displays. 

Note 

• Select an object in the left most column to show the associated objects/instances in 
the next column. Continue this process for the subsequent columns to select which 
parameters to include in the configuration. For example, select Measurement in the 
left-hand column and Fluid Properties in the middle column to display the configured 
Fluid Properties instances in the right-hand column. 

• An asterisk (*) next to an object indicates that only a partial set of parameters is 
selected for that particular object. 

• Partial configuration files are stored with the file extension .PTC.  
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Figure 21. Save  

 

7. Select Save to save your device configuration to a file on your PC. 

Note 

A progress bar displays the status of the configuration save process. 

8. When the configuration save process is complete, select Close to return to the main 
FBxConnect™ screen. 

Figure 22. Solution Saved Successfully 
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2.3  Upload Solution 

A Solution contains application and configuration data for an FB Series product. When you 
Upload a Solution, the system packages application and configuration data from your FB 
Series product and saves it on your PC.  

Note 

A Solution consists of two parts: a .ZSL file and a file folder. These two parts must have 
the same name and be used together when working offline or downloading a saved 
solution to another unit. 

To upload a Solution to your PC: 

1. Select File > Upload Solution for the FBxConnect™ main menu. The Solution Upload 
screen displays. 

Figure 23. Solution Upload 

 

2. Select Browse to open a file explorer window. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

61 

Figure 24. Save As 

 

3. Navigate to a location on your PC you wish to save the Solution, enter a name for the 
Solution, and then select Save. The Solution Upload screen re-displays. 

Note 

• The default file name includes the connection/device name, report type, and 
timestamp of report creation (ConnectionName_ReportType_YYMMDDThhmmss). 

• The default location for saved Solutions is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Solutions. This location is in a hidden 
folder, and you may need to select "show hidden files" on your computer to view this 
folder. 
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Figure 25. Partial Upload 

 

4. If you want to manually select which Objects and Instances are saved in the 
configuration file, select Partial Upload. The Select Configuration dialog opens. 

Note 

The Partial Upload option requires firmware version 2.7 or later. 
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Figure 26. Select Configuration 

 

5. Place a check mark next to the specific Objects and Instances you wish to save in the 
configuration file and click Close. The Configuration Upload dialog re-displays. 

Note 

• Select an object in the left most column to show the associated objects/instances in 
the next column. Continue this process for the subsequent columns to select which 
parameters to include in the configuration. For example, select Measurement in the 
left-hand column and Fluid Properties in the middle column to display the configured 
Fluid Properties instances in the right-hand column.  

• An asterisk (*) next to an object indicates that only a partial set of parameters is 
selected for that particular object. 

• Partial configuration files are stored with the file extension .PTC. 

• Select the Create Objects/Instances File button to create a file with an .OIF file 
extension that contains the object names and instance numbers for the selected 
objects. You can use this file to upload a partial configuration using the 
UPLOAD_PARTIAL command in the FBx Script Developer tool. This file is not used by 
FBxConnect. 
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6. Select Upload read only parameters to include all read-only parameters in the 
configuration file. This option provides a snapshot of the FB Series product, and the 
resulting configuration file includes flow rates, totals, and diagnostic values. This 
option is useful when troubleshooting a device. 

Note 

This option is not available if you select Partial Upload. 

Figure 27. Upload read only parameters 

 

7. Select Upload. FBxConnect™ saves the selected Solution to your PC. 
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Figure 28. Upload 

 

Note 

A progress bar displays the status of the Solution save process. 

8. When the Solution upload process is complete, select Close to return to the main 
FBxConnect™ screen. 
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Figure 29. Solution Saved Successfully 

 

2.4  Download Solution 

You can download a solution file to your FB Series product after you have saved the 
solution file to your PC. A Solution contains application and configuration data for an FB 
Series product. When you Download a Solution, the system transfers application and 
configuration data from your PC and loads it into your FB Series product.  

Note 

A Solution consists of two parts: a .ZSL file and a file folder. These two parts must have 
the same name and be used together when working offline or downloading a saved 
solution to another unit. 

To download a Solution to your FB Series product: 

1. Select File > Download Solution from the FBxConnect™ menu. The Solution 
Download display opens. 
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Note 

Emerson recommends performing step 1 and step 2 prior to downloading a solution. 

Figure 30. Solution Download 

 

2. Select History to save history data. The History Report display opens. For more 
information, refer to History Report. 

3. Select Alarms to save alarm data. The Alarm Report display opens. For more 
information, refer to Alarm Report. 

4. Select Events to save event data. The Event Report display opens. For more 
information, refer to Event Report. 

5. Select Cold Start. The Cold Start display opens. For more information, refer to Cold 
Start. 

Note 

Be sure to select Database is re-initialized with factory defaults. 

6. Select Solution Download. The Solution Download dialog displays: 
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Figure 31. Solution Download 

 

7. Select Browse to open a file explorer window. 

Figure 32. Open 
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8. Navigate to a location on your PC of the saved configuration file and select Open. The 
Solution Download screen re-displays. 

Note 

• The default location for saved Solutions is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Solutions. This location is in a hidden 
folder, and you may need to select "show hidden files" on your computer to view this 
folder. 

• Partial configuration files are stored with the file extension .PTC. To view partial 
configuration files, you must select PTC files in the file type drop-down. 

 

Figure 33. Partial Download 
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9. If you want to manually select which Objects and Instances are saved in the 
configuration file, select Partial Download. The Select Configuration dialog opens. 

Note 

The Partial Download option requires firmware version 2.7 or later. 

Figure 34. Select Configuration 

 

10. Place a check mark next to the specific Objects and Instances you wish to download to 
your FB Series product and click Close. The Solution Download dialog re-displays. 

Note 

• Select an object in the left most column to show the associated objects/instances in 
the next column. Continue this process for the subsequent columns to select which 
parameters to include in the configuration. For example, select Measurement in the 
left-hand column and Fluid Properties in the middle column to display the configured 
Fluid Properties instances in the right-hand column.  

• An asterisk (*) next to an object indicates that only a partial set of parameters is 
selected for that particular object. 
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• The system does not download objects and instances that require features or licenses 
not present in the FB Series product. 

• Select the Create Objects/Instances File button to create a file with an .OIF file 
extension that contains the object names and instance numbers for the selected 
objects. You can use this file to upload a partial configuration using the 
UPLOAD_PARTIAL command in the FBx Script Developer tool. This file is not used by 
FBxConnect. 

Figure 35. Selected Components 

 

11. A solution file may contain multiple items, including the standard FB Series product 
configuration and various applications. Place a check mark in the Selected column for 
any item you want to download to the FB Series product. 

Note 

If you include any applications in the download, use the drop-down menu in the 
Components column to select either the application and configuration or the only the 
configuration. 
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Figure 36. Download 

 

12. Select Download to download your Solution to your FB Series product. 

Note  

• A progress bar displays the status of the Solution download process. 

• A warning dialog opens when you try to download a Solution that includes configured 
communications parameters. You can potentially lose connection with the FB Series 
product if you change the parameters on the port to which you are currently 
connected. Select Yes to continue loading the Solution with the new communications 
configuration. Select No to return to the Solution Download screen. 

 

• A warning dialog opens if you attempt to download a solution created with a newer 
firmware version to an FB Series product with an older firmware version. Some 
features and parameters may not be present in older versions of firmware. 
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Downloading the configuration may result in the loss of history records and 
configuration. Select Yes to continue or No to cancel the download.  

 

13.  When the Solution download is complete, select Close to return to the main 
FBxConnect™ screen. 

Figure 37. Solution Downloaded Successfully 

 

2.5  Download to Flash 

Use this option to load a previously saved solution's configuration file to the flash 
memory of the connected FB Series product. The FB Series product can then load the 
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solution's configuration file saved in flash memory when performing a cold start or 
rebuilding the FB Series product database after corruption. 

Note 

You must save a solution's configuration file to your PC before you can download a 
solution's configuration file to flash memory. For information on saving a solution's 
configuration file to your PC, refer to Upload Solution and Save As.  

To download a previously saved solution's configuration file to flash memory: 

1. Select File > Download to Flash from the FBxConnect™ main menu. The Download 
solution's configuration to flash dialog displays. 

Figure 38. Browse 

 

2. Select Browse to open a file explorer window. 
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Figure 39. Open Configuration File 

 

3. Navigate to the location of your saved configuration file and select Open. 

Figure 40. Download 
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4. Select Download. FBxConnect™ downloads the selected configuration to the FB Series 
product and saves the configuration to flash memory. 

Note 

A progress bar displays the status of the configuration save process. 

5. When the configuration download to flash process is complete, select Close to return 
to the main FBxConnect™ screen. 

Figure 41. Configuration Downloaded Successfully 

 

2.6  Save to Flash 

Use this option to save the current configuration to the flash memory of the connected FB 
Series product. The FB Series product can then load the configuration file saved in flash 
memory when performing a cold start or rebuilding the FB Series product database after 
corruption. 

To save a configuration to flash memory: 
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Figure 42. Save to Flash 

 

 

1. Select File > Save to Flash from the FBxConnect™ main menu. A confirmation 
message opens. 

Figure 43. Save to Flash – Confirmation Message 

 

2. Select Yes to save your configuration to flash memory. 

Note 

• A progress window displays the status of the configuration save process. 

• After saving your configuration to flash memory, you should verify the timestamp of 
the configuration file loaded to flash memory on the Configure > System display to 
ensure the process completed successfully. 

2.7  Close 

Use this option to close the current connection or configuration and exit FBxConnect™. 

To close FBxConnect: 

1. Select File > Close from the FBxConnect™ main menu. A confirmation dialog opens. 
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Figure 44. Closing Connection 

 

2. Select Yes to close the connection. 
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Section 3: Monitor Menu 
Use the options in this menu to view the current flowing conditions, communication port 
status, FB Series product history, alarms, and events. 

Figure 45. Monitor Menu 

 

The Monitor menu contains the following options: 

Main – Shows an graphical representation of your RTU. 

I/O – View data about the currently installed I/O points and currently configured PID 
loops.  

Gas 

DP Meter – View the current flow rates and totals for gas differential pressure meters.  

Linear Meter – View the current flow rates and totals for gas linear meters.  

Liquid 

Note 

These options appear only if the FB Series product has a Liquid Calculation license 
installed. 

Liquid Linear Meter – View the current flow rates and totals for liquid linear meters. 

Liquid Batching – Use this display to view the current batch totals for a liquid linear 
meter with batching enabled. 

History 

Periodic History – View user periodic, hourly, daily, weekly, and monthly history data 
stored on the connected FB Series product. 

Transaction History – View data from each configured transaction history group. 

Alarms – View alarms stored on the connected FB Series product. 

Events – View events stored on the connected FB Series product. 
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Comm Ports – View the status and configuration of the communications ports located on 
the connected FB Series product. 

3.1  Main 

The Main display shows a graphical representation of your RTU. The system displays an 
yellow line around objects that are links when you hover your cursor over them, and a 
tool-tip description of each object. Click on an object to open the FBxConnect™ 
configuration display for the selected object.  

Note 

• Click on a personality module to open the online help and view communications and 
I/O wiring diagrams. 

• If a module encounters a communications failure (such as when a previously 
configured module has been removed), the graphical representation of that module is 
dimmed and a red box with an exclamation mark appears under the module. Click the 
red box to uninstall the module. 

To access this display, select Monitor > Main from the FBxConnect™ main menu. 
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Figure 46. Main 

 

3.2  I/O 

Use The I/O display to view data about the currently installed I/O modules. I/O data 
includes the type of I/O, engineering units to use with the point, and the current value of 
the point. Channels with an alarm currently raised are highlighted in red. Channels that 
are disabled are highlighted in yellow. 

To access this display, select Monitor > I/O from the FBxConnect™ main menu. The I/O 
Overview display opens. 

Note 

• The amount of I/O points shown on this display will vary depending on the type and 
number of modules installed. 

• Fields highlighted in red are an indication of a value in an alarm state. 
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• Fields highlighted in yellow indicate a disabled channel. 

Figure 47. I/O 

 

3.3  Gas 

Use the Gas drop-down in the Monitor menu to view flow rates and totals for gas 
differential pressure and gas linear meters.  

Note 

The Gas drop-down items display only if you have previously configured at least one gas 
differential pressure or linear meter on the Meter Setup display. 

Figure 48. Monitor Gas 

 

The Gas drop-down contains the following options: 

DP Meter – Use the Monitor Gas DP Meter display to view the current flow rates and totals 
for gas differential pressure meters.  
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Linear Meter – Use the Monitor Gas Linear Meter display to view the current flow rates 
and totals for gas linear meters.  

3.3.1 DP Meter 

Use the Monitor Gas DP Meter display to view the current flow rates and totals for gas 
differential pressure meters. FBxConnect™ provides you with real-time values, as well as 
values for the current hour, previous hour, current day, and previous day. 

To access this display: 

1. Select Monitor > Gas > DP Meter from the FBxConnect™ main menu. The Monitor 
Gas DP Meter display opens. 

2. Click ▼ to select a meter to view. 

Figure 49. Monitor Gas DP Meter 
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3.3.2 Linear Meter 

Use the Monitor Gas Linear Meter display to view the current flow rates and totals for gas 
linear meters. FBxConnect™ provides you with real-time values, as well as values for the 
current hour, previous hour, current day, and previous day. 

To access this display: 

1. Select Monitor >Gas > Linear Meter from the FBxConnect™ main menu. The Monitor 
Gas Linear Meter display opens. 

2. Click ▼ to select a meter to view. 

Figure 50. Monitor Gas Linear Meter 

 

3.4 Liquid 

Use the Liquid drop-down in the Monitor menu to view flow rates and totals for liquid 
linear meters.  
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Note 

• This option appears only if the FB Series product has a Liquid Calculation license 
installed. 

• The Liquid drop-down displays only if you have previously configured at least one 
liquid meter on the Meter Setup display. 

Figure 51. Monitor Liquid 

 

The Liquid drop-down contains the following options: 

Liquid Linear Meter – Use this display to view the current flow rates and totals for liquid 
linear meters. 

Liquid Batching – Use this display to view the current batch totals for a liquid linear meter 
with batching enabled. 

3.4.1 Liquid Linear Meter 

Use this display to view the current flow rates and totals for liquid linear meters. 
FBxConnect™ provides you with the current values, as well as values for the current and 
previous hour, day, week, month, and batch. 

To access this display, select Monitor > Liquid > Liquid Linear Meter. The Monitor Liquid 
Linear Meter display opens. 

Click ▼ in the drop-down list at the top of the display to select a liquid linear meter to 
view. 
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Figure 52. Monitor Liquid Linear Meter 

 

3.4.2 Liquid Batching 

Use this display to view the current batch totals for a liquid linear meter with batching 
enabled. FBxConnect™ provides you with the current and previous batch averages and 
totals. 

To access this display, select Monitor > Liquid > Batching. The Monitor Liquid Batching 
display opens. 

Click ▼ in the drop-down list at the top of the display to select a liquid linear meter to 
view. 
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Figure 53. Monitor Liquid Linear Meter 

 

3.5 History 

Use the History drop-down in the Monitor menu to view history data stored in your FB 
Series product.  

Figure 54. Monitor History 
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The History drop-down contains the following options: 

Periodic History – Use this display to view the current flow rates and totals for liquid linear 
meters. 

Transaction History – Use this display to view the current flow rates and totals for liquid 
linear meters. 

3.5.1 Periodic History 

Use the Periodic History option to view user periodic, hourly, daily, weekly, and monthly 
history data. You can view data from each periodic history group, including User Periodic, 
General, and Station History. 

Note 

• You must first configure history points before viewing history data. For more 
information, refer to Configure – History. 

• The integrity of each history record is checked, and only history records with good 
integrity are shown. 

• Each history record has an associated sequence number. A missing history record 
sequence number indicates a deleted or lost record. 

• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 

To view periodic history data stored on an FB Series product: 

1. Select Monitor >History> Periodic History from the FBxConnect™ main menu. The 
Collection Criteria dialog displays. 
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Figure 55. Collection Criteria – Periodic History 

 

2. Click ▼ in the History Group field to select the history group you want to view. 
Possible options are User Periodic 1, User Periodic 2, General History, Station History 
1, or Station History 2. 

3. If you select General History, Station History 1, or Station History 2 in the History 
Group field, select a time frequency for the collected data in the Interval field. 
Possible options are Hourly, Daily, Weekly, or Monthly. 

4. In the Collection period field, select Oldest 20 records/Newest 20 Records to view 
the twenty oldest/newest history records or select Time Range to view history 
records from a specific time and date range. 

Note  

Your selection in the Sorting field controls the options presented in this field. 

5. Click the button in the in the Sorting field to control the order of records in the history 
report. Possible options are: 

• Newest First – Records are sorted from the newest to the oldest. 

• Oldest First – Records are sorted from the oldest to the newest.  
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6. If you select Time Range in the Collection period field, enter a beginning and ending 
date and time in the From and To fields.  

7. In the Columns field, select or deselect the columns you want to include in the default 
report view. 

8. Click View to view the selected history. 

Figure 56. Periodic History 

 

Note 

• Click ▼ in the Columns field to show or hide additional report columns. 
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• Every calculated parameter in meter runs has a health attribute. The status of this 
attribute is determined by a combination of the inputs used to calculate the 
parameter and the status of the calculation. Values with questionable data integrity 
are highlighted in pink, and a symbol is placed after the value. Hover your cursor over 
a highlighted value to view the reason for the highlighting. The symbol definitions are 
below:  
? = In Fault  
# = In Override 
X = Unverified Value  
! = In Alarm  
> = Over Range Limit  
^ = Stale Value  
& = Inactive 
* = Invalid History  
@ = Undefined History 

9. Click the Next button to retrieve 40 additional history records. 

10. Click View All to retrieve all data stored in the flow computer. 

11. Click the Create Report button to open the History Report dialog and save a history 
report to your computer. For more information, refer to History Report. 

12. Click the Select New button to return to step 1 and select new collection criteria. 

3.5.2 Transaction History 

 Use the Transaction History option to view data from each configured transaction history 
group. 

Note 

• You must first configure history points before viewing history data. For more 
information, refer to Configure – History. 

• The integrity of each history record is checked, and only history records with good 
integrity are shown. 

• Each history record has an associated sequence number. A missing history record 
sequence number indicates a deleted or lost record. 
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• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 

To view transaction history data stored on an FB Series product: 

1. Select Monitor > History > Transaction History from the FBxConnect™ main menu. 
The Collection Criteria dialog displays. 

Figure 57. Collection Criteria – Transaction History 

 

2. Click ▼ in the History Group field to select the transaction history group you want to 
view.  

3. In the Sub-Type field, select the type of history to include in the report. The default 
selection is Batch. 

Note  

• If you select Hourly, Daily, Weekly, or Monthly in the Sub-Type field, you must 
have previously configured transaction history to include periodic data in the 
Periodic Data Logging in Transaction History field on the Station – Batching Tab 
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and configured transaction history to include this data on the Transaction History 
Group Configuration display. 

• The Snapshot Sub-Type is not selectable for transaction history groups 
configured for liquid linear meter batching.  

4. In the Collection period field, select Oldest 20 records/Newest 20 Records to view 
the twenty oldest/newest history records or select Time Range to view history 
records from a specific time and date range. 

Note  

Your selection in the Sorting field controls the options presented in this field. 

5. Click the button in the in the Sorting field to control the order of records in the history 
report. Possible options are: 

• Newest First – Records are sorted from the newest to the oldest. 

• Oldest First – Records are sorted from the oldest to the newest.  

6. In the Filter field, enter a Transaction ID to narrow the results to show only specific 
transactions.  

Note 

• This field is not case sensitive. 

• For transactions assigned to a meter, you configure the Transaction ID in the 
Batch Identifier field on the Station – Batching display. 

• For transactions not assigned to a meter, you configure the Transaction ID in the 
Transaction ID field on the Transaction History Group Configuration display. 

7. Place a check mark in the Match whole words only field to search only for 
Transaction IDs that contain the entire word you entered in the Filter field. 

8. If you select Time Range in the Collection period field, enter a beginning and ending 
date and time in the From and To fields.  

9. In the Columns field, select or deselect the columns you want to include in the default 
report view. 

10. Click View to view the selected history. 
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Figure 58. Transaction History 

 

Note 

• Click Columns at the top-right of the display to show or hide additional report 
columns. Use the up (▲) and down (▼) arrows at the top and bottom of the list to 
view any additional columns.  

 

• Click Filter at the top-right of the display to open a Filter Options dialogue where you 
can refine the results by entering a Transaction ID. 

• Every calculated parameter in meter runs has a health attribute. The status of this 
attribute is determined by a combination of the inputs used to calculate the 
parameter and the status of the calculation. Values with questionable data integrity 
are highlighted in pink, and a symbol is placed after the value. Hover your cursor over 
a highlighted value to view the reason for the highlighting. The symbol definitions are 
below:  
? = In Fault  
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# = In Override 
X = Unverified Value  
! = In Alarm  
> = Over Range Limit  
^ = Stale Value  
& = Inactive 
* = Invalid History  
@ = Undefined History 

11. Click the Next button to retrieve 40 additional history records. 

12. Click View All to retrieve all data stored in the flow computer. 

13. Click the Create Report button to open the History Report dialog and save a history 
report to your computer. For more information, refer to History Report. 

14. Click the Select New button to return to step 1 and select new collection criteria. 

3.6  Alarms 

Use the Alarms screen to view any currently active alarms on your device.  

Note 

• The integrity of each alarm record is checked, and only alarm records with good 
integrity are shown. 

• Each alarm record has an associated sequence number. A missing alarm record 
sequence number indicates a deleted or lost record. 

• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 

To view alarms stored on the device: 

1. Select Monitor > Alarms from the FBxConnect™ main menu. The Collection Criteria 
dialog displays. 
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Figure 59. Collection Criteria – Alarm 

 

2. In the Collection period field, select Oldest 20 records/Newest 20 Records to view 
the twenty oldest/newest alarm records or select Time Range to view alarm records 
from a specific time and date range. 

Note  

Your selection in the Sorting field controls the options presented in this field. 

3. Click the button in the in the Sorting field to control the order of records in the history 
report. Possible options are: 

• Newest First – Records are sorted from the newest to the oldest. 

• Oldest First – Records are sorted from the oldest to the newest.  

4. If you select Time Range in the Collection period field, enter a beginning and ending 
date and time in the From and To fields.  

5. Click View to view the selected alarms. 
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Figure 60. Alarms 

 

Note 

Click ▼ in the Columns field to show or hide additional report columns. 

 

6. Click the Next button to retrieve 50 additional alarm records. 

7. Click View All to retrieve all data stored in the flow computer. 

Note 

Double-click on the first column of a row that contains a Flow/Property Calculation Alarm 
to view information for any raised flow or property calculation alarm codes. 
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8. Click the Create Report button to open the Alarm Report dialog and save an alarm 
report to your computer. For more information, refer to Alarm Report. 

9. Click the Select New button to return to step 1 and select new collection criteria. 

3.7  Events 

Use the Events screen to view events stored in device memory. 

Note 

• The integrity of each event record is checked, and only event records with good 
integrity are shown. 

• Each event record has an associated sequence number. A missing event record 
sequence number indicates a deleted or lost record. 

• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 

To access this screen: 

1. Select Monitor > Events from the FBxConnect™ main menu. The Collection Criteria 
dialog displays. 
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Figure 61. Collection Criteria – Event  

 

2. In the Sub-type field, select if you want to view legal or non-legal events. 

Note 

You must configure your FB Series product to keep separate legal and non-legal event 
logs on the Configure – System screen to view this field. 

3. In the Collection period field, select Oldest 20 records/Newest 20 Records to view 
the twenty oldest/newest event records or select Time Range to view event records 
from a specific time and date range. 

Note  

Your selection in the Sorting field controls the options presented in this field. 

4. Click the button in the in the Sorting field to control the order of records in the history 
report. Possible options are: 

• Newest First – Records are sorted from the newest to the oldest. 

• Oldest First – Records are sorted from the oldest to the newest.  



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

100 

5. If you select Time Range in the Collection period field, enter a beginning and ending 
date and time in the From and To fields.  

6. Click View to view the selected events. 

Figure 62. Events 

 

7. Click View All to retrieve all data stored in the flow computer. 

8. Click Next to retrieve 50 additional event records. 

9. Click Create Report to open the Event Report dialog and save an event report to your 
computer. For more information, refer to Event Report. 

10. Click Select New to return to step 1 and select new collection criteria. 

3.8  Comm Ports 

Use the Comm Ports display to view the read-only status and configuration of each 
communications port on the FB Series product. 

To access this display:  

1. Select Monitor > Comm Ports. The Communication Ports display opens showing the 
Overview tab. 
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Figure 63. Comm Ports  

 

2. Review the status of each port (Enabled or Disabled). 

3. Click Statistics to open a Communication statistics pop-up display and view the 
number of messages sent and received on the selected communications port. 

Note 

• For serial ports, a separate tab shows statistics for each configured Port Owner 
(DNP3, Modbus Slave, and Modbus Master). For more information, refer to 
Communications – General. 

• For Ethernet ports, use the IP Connections drop-down to view statistics for each IP 
connection. For more information, refer to Communications – General. 
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Figure 64. Communication statistics 

 

4. Click Reset statistics to reset the message counters for the selected communications 
port. 

Note  

For Ethernet ports, you must reset statistics for each IP Connection individually. 
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Section 4: Configure Menu 
Use the options in this menu to configure FB Series product parameters, including meter 
runs, I/O, fluid properties, and history. 

Figure 65. Configure Menu 

 

The Configure menu contains the following options: 

Home – Set a site name, set your home screen, and view general product information 
about your device.  

Guided Setup – Configure the FB3000 using a guide that directs you through the 
configuration process. 

Engr Units – Configure the engineering units used in calculations. 

Point Picker –View internal database parameters in the FB Series product. 

I/O Setup – Configure the inputs and outputs of the flow computer. 

Pass Thru – Configure parameters used when communicating with other Ethernet 
enabled FB Series products and remote I/O racks. 

Summary – Shows an overview of all configured stations and assigned meters.  

Meter Setup – Configure general meter run settings, including the number of DP and 
linear meter runs. 

Gas 

DP Meter – Configure differential pressure meters in your device.  

Linear Meter – Configure linear meters in your device. 

Fluid Properties – Define the physical properties of the fluid flowing through each 
meter. 

Components – Configure how the system calculates fluid composition and the different 
components of the fluid flowing through the meter. 

Liquid 

Liquid Linear Meter – Configure liquid linear meters in your FB Series product. 

Liquid Product – Define liquid products and their fluid properties. 
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Liquid Density – Configure liquid density inputs. 

Station – Configure parameters for stations.  

Averages – Configure which inputs the system uses to calculate averages, and view the 
results of those calculations. 

Totals – Configure which inputs the system totalizes, and to view the results of those 
calculations. 

GC – Configure gas chromatograph options for each meter, and to view the data from 
each configured gas chromatograph. 

Alarms – Configure which parameters need to be monitored, and which alarms need to 
be raised when limits are reached.  

History – Configure history points, to enable and disable history logging for the history 
groups, to configure user period for user periodic history group types and to configure 
contract time for standard history group types.  

Logs – Configure the options for history, alarm, and event logs. 

Custom Reports – Configure custom reports that are generated by your FB3000 RTU and 
configure a network printer used for the custom reports. 

PID Loops – Configure Proportional, Integral, and Derivative (PID) controls. 

Action Blocks – Configure Action Blocks.  

Math Blocks – Configure up to 10 instances of Math Blocks.  

Effects – Configure custom logic components that drive a selected device parameter to a 
user defined value. 

Control Setup – Configure the number of Action Blocks, Math Blocks, Effects, and PID 
Loops instances available. 

Communications – Configure the communications ports on your device. 

Localization – Configure the time and date format for each localization profile.  

Clock – Set the device clock and configure daylight savings time options. 

LCD Touchpad – Use this display to configure the functionality of a connected FB3000 RTU 
Touchpad.  

Power Control – Conserve battery power to a radio or any other communicating device. 

System – Configure your event log type and database recovery options.  
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I/O Bus – Configure the polling interval and view statistics for each I/O module installed in 
an FB3000 RTU. 

FBxNet – Configure the FB Series product to communicate over FBxNet. 

4.1  Home 

Use this display to enter a site name, modify which display opens when you first connect 
to the FB Series product, and view general product information. 

To access this display: 

1. Select Configure > Home. The Configure Home display opens. 

Figure 66. Configure – Home 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Product 
Type 

This read-only field shows the type of FB Series product to which you are 
connected (online) or the configuration you are viewing (offline).  
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Field Description 

Product 
Description 

This read-only field shows information about the FB Series product type. 

Site Name Enter a unique site name for the FB Series product.  

Current 
Time 

This read-only field shows the current time and date of the FB Series 
product's clock. 

Note 

This field appears only for FB Series products with a communication 
status of Online. 

Firmware 
Version 

This read-only field shows firmware version for the FB Series product 
configuration you are currently viewing.  

Note 

This field appears only for FB Series products with a communication 
status of Offline. 

Home 
Screen 

Select the Browse button a choose a specific display to open when you 
first connect to the FB Series product. For more information, refer to 
Configuring the Home Screen. 

3. Select Save to save any changes you make to this tab.  

4.1.1 Configuring the Home Screen 

You can configure a specific display to open when you first connect to the FB Series 
product. The default is the Main display in the Monitor Menu, but you can configure any 
application display, standalone display, or factory display located in the 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\CommonDisplays folder.  

To set the home screen display: 

1. Select Configure > Home. The Home display opens. 
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Figure 67. Configure – Home 

 

2. Select the Browse button. The Select Home Screen display opens. 
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Figure 68. Select Home Screen display 

 

3. From the list on the left-side of the display, select what type of display (factory, 
standalone, or application) you want to open when you first connect to the FB Series 
product. A list of possible displays shows on the right-side of the display. 
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Figure 69. Select Home Screen display – Select Button 

 

4. Navigate to your desired display, highlight the display, and select the Select button. 
The Select Home Screen display closes showing the Configure Home display. 
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Figure 70. Configure – Home 

 

5. Select Save to save your changes. The next time you connect to the FB Series product, 
the display you selected will be the first display that opens. 

Note 

You can also configure the display to show a specific instance when it opens. To do this, 
add a colon (:) after the display name followed by the instance. For example, the third 
instance of the Logs display opens if you enter Configure_Logs_Logs:Log_3. 

4.2  Guided Setup  

Use Guided Setup to configure an FB3000 for the first time. Guided Setup directs you 
through the process of configuring your FB3000's measurement and I/O functionality, 
and automatically configures history points needed by API 21.1. 

Note 

• The steps available in the Guided Setup differ based on your FB Series product type 
and purchased options. This document shows all possible steps. 
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• If you need help on a specific display of Guided Setup, press F1 to open the online 
help system for that particular display. 

CAUTION 
Guided Setup may change your history configuration. If you have previously configured 
your FB3000, collect history data before proceeding. 

To access Guided Setup: 

1. Select Configure > Guided Setup. The first page of Guided Setup opens. 

Figure 71. Guided Setup 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Site Name Sets the name of the active connection in Field Tools. 

Product 
Description 

This read-only field shows the description of the FB Series product 
you are currently configuring. 
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Field Description 

Product Type This read-only field shows the product type of the FB Series product 
you are currently configuring. 

Current Time This read-only field shows current time and date of the FB Series 
product clock. 

Synchronize 
Time 

Select this button to synchronize the FB Series product clock with 
your PC clock. 

Serial Number This read-only field shows the serial number of the FB Series product 
you are configuring. 

Configuration 
Steps 

Shows the steps involved in the Guided Setup process. 

3. Select Next to advance to the next step in the Guided Setup. 

4.2.1 Guided Setup: I\O Configuration 

Use this display to configure the input and output types available on your FB3000 RTU. 
You can configure an input to operate as an analog input (AI), digital input (DI), or pulse 
input (PI). 

Note 

• A separate I/O Configuration display is available for each installed I/O module.  

• There is not a separate display for communications modules. You configure 
communications modules during the Communications Settings step of the Guided 
Setup 

• The number of I/O points shown on this display varies depending on the device type 
and installed options. 

• You can right-click on the Module Setup node or individual modules in the navigation 
tree to add or remove a module, and you can also copy and paste the configuration of 
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one module to another. 

 

Figure 72. Guided Setup: I/O Configuration 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Module Type This read-only field shows the I/O module type installed in the 
selected slot. The fields available for each module type are described 
below: 
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Field Description 

8AIDIPI 2AO 
2DO Module 

The 8AIDIPI 2AO 2DO (3MIX12) module provides eight input 
channels and four output channels. You can configure each input 
channel as either an analog input (AI), digital input (DI), or pulse 
input (PI). The output channels are comprised of two analog outputs 
(AO) and two digital outputs (DO).  

Inputs Sets each input channel as either an analog input, 
digital input, or pulse input.  

Note 

Select either All AI, All DI, or All PI to configure all 
input channels as either analog inputs, digital inputs, or 
pulse inputs, respectively. 

Outputs Shows the available output channels on the selected 
I/O module. 

IO Loop 
Power 
Control 

Enables or disables the 24-Volt loop power feature. 

8AODO 
Module 

The 8AODO module provides eight output channels. You can 
configure each output channel as either an analog output (AO) or 
digital output (DO).  

Outputs Sets each output channel as either an analog output, 
digital input, or pulse input.  

Note 

Select either All AO or All DO to configure all output 
channels as either analog outputs or digital outputs, 
respectively. 

HART 4 
Module 

The HART 4 (HRT04) module provides four input/output channels 
used to communicate with HART devices using the HART protocol. 
You can configure each channel as either an analog input (AI) or 
analog output (AO). A channel set as an input can be configured for 
use in point-to-point or multi-drop mode. A channel set as an output 
can be configured for use in point-to-point mode only. 

Analog Sets each channel as either and analog input (AI) or 
analog output (AO). 
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Field Description 

COMM 4 The 4-port serial communications module (COM04) provides 
additional serial communication channels beyond those available on 
the CPU module. 

Note 

To make configuration changes to this module, refer to 
Communications – General.  

I/O Import 
Export 

Select this button to import a CSV file containing a new I/O 
configuration or export you current I/O configuration to a CSV file. 
For more information, refer to Importing I/O Configuration CSV Files, 
Exporting I/O Configuration CSV Files, and Creating I/O Configuration 
CSV Files. 

2. Select Apply to save your selections to the FB Series product and advance to the next 
step in the Guided Setup. 

4.2.2 Guided Setup: I\O Configuration Details 

Use this display to select what input and output types are available on your device. You 
can configure inputs to operate as an analog input (AI), digital input (DI), or pulse input 
(PI). 

Note 

• A separate I/O Configuration display is available for each installed I/O module.  

• The number of I/O points shown on this display varies depending on the device type 
and installed options. 
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Figure 73. Guided Setup: I/O Config 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Channel This read-only column shows the type of I/O you selected for each 
channel on the previous page. 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
channel. 

Units Type Select ▼ to set the measurement type used for the selected channel. 

Note 

This field appears only for channels configured as analog inputs, 
analog outputs, or pulse inputs. 

Units Select ▼ to set the engineering units used for the selected channel. 

Note 

This field appears only for channels configured as analog inputs, 
analog outputs, or pulse inputs. 
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Field Description 

Type Select ▼ to set if the channel measures either current input or 
voltage input. 

Note  

• This field appears only for channels configured as analog inputs. 

• The default selection is Disabled. You must select either Current 
or Voltage before the AI will scan a field device. 

• When Current Input is selected, an on-board software switchable 
250-ohm resistor is enabled for the selected channel. 

EU Scaling 
Mode 

Select ▼ to set how the EU scaling parameters are determined. 

Note 

This field appears only for channels configured as analog inputs. 

Multi-Point 
Calibration 

EU scaling parameters are determined by the 
calibration. You cannot modify the EU scaling 
parameters (Low Reading EU, High Reading EU, 
Adjusted A/D 0 Percent, Adjusted A/D 100 Percent) 
directly. You must use the calibration wizard to adjust 
the scaling of the AI.  

Note 

If you download a configuration file that has Multi-
Point Calibration selected, the calibration on your 
device remains unchanged. 

EU Scaling EU scaling parameters are determined by the values 
you enter in the Low Reading EU, High Reading EU, 
Adjusted A/D 0 Percent, Adjusted A/D 100 Percent 
fields. 

Note 

If you download a configuration file that has EU 
Scaling selected, the existing calibration on your 
device is overwritten using the EU scaling 
parameters. 
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Field Description 

Low Reading 
EU 

Sets the minimum value (in A/D counts) that the analog input can 
measure. 

Note 

You must select EU Scaling in the EU Scaling Mode field to enable 
entry in this field. 

High Reading 
EU 

Sets the maximum value (in A/D counts) that the analog input can 
measure. 

Note 

You must select EU Scaling in the EU Scaling Mode field to enable 
entry in this field. 

Details Select this button to open the selected I/O channel configuration 

display. Select  to return to Guided Setup. 

HART Channel 
Configuration 

Use these fields to configure the HART I/O module. 

Note 

These fields show only if your configuration contains a HART I/O 
module. 

HART 
Channel 

This read-only field displays the name of the channel 
on the HART module. 
 

HART 
Comm 
Mode 
  

Sets the communication mode for the selected 
channel. Possible options are: 

Disabled  Stop all HART communication. 

Point to 
Point 

Enables the channel to communication 
with one HART device per channel. 

MultiDrop  Enables the channel to communicate 
with up to five HART devices 
connected in parallel. 

Note 

This option is available only for 
channels configured as analog inputs 
(AI). 
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Field Description 

Number of 
Devices 

Sets the number of HART devices connected in 
parallel. 

Note 

This field appears only if you select MultiDrop in the 
HART Comm Mode field. 

Details Select to open the HART I/O display and configure the 
selected HART channel. 

2. Select Apply to save your selections to the FB Series product and advance to the next 
step in the Guided Setup. 

4.2.3 Guided Setup: Communication Settings 

Use this display to enable communications with 4088B multivariable transmitters and 
configure gas chromatographs. 

Figure 74. Guided Setup: Communication Settings 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

MVS 
Communication 
Settings 

Select ▼ to enable or disable 4088B communications on the 
selected communication port. 
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Field Description 

Comm Port to 
GC 

Select  to open a Point Picker dialog and define which 

communications port on the FB Series product is connected to the 
gas chromatograph. 

GC Device 
Address 

Sets the Modbus address the FB Series product uses to 
communicate with the gas chromatograph. You must set this value 
before the program can poll data and write it to the meter run. 

Baud Rate Sets the baud rate of communications over the selected port. 

Note 

This field applies only to GC connections using a serial port. 

GC Server IP 
Address 

Specifies the IP address of the GC. 

Note 

This field applies only to GC connections using an Ethernet port. 

GC Server Port 
Number 

Specifies port number used by the GC. 

Note 

This field applies only to GC connections using an Ethernet port. 

Polling Interval Sets the delay (in seconds) the system waits before asking the gas 
chromatograph for the next set of results. 

Polling  Select ▼ to enable or disable polling of the gas chromatograph.  

GC Polling 
Alarm 

This read-only field shows the status of the poll result. Possible 
statuses are: 

• Normal 

• Poll Failed 

• Comp Code Match Error 

• Poll Disabled 

• Auto config Failed 

Chromat Type Specifies either the American or European version of the SIM-2251 
Modbus map and polling sequences. 
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Field Description 

Auto Configure Select this button to automatically configure the selected 
communications port and Modbus parameters necessary to poll 
the gas chromatograph. The port owner is automatically changed 
to Modbus Master for selected communications port. 

Note  

• This field is only available if you are connected to an FB Series 
product. 

• Before selecting the Auto Configure button, you must first 
specify a communications port in the Comm Port to GC field 
and an address in the GC Modbus Address field, select 
Disabled in the Polling field, and then click Save to write these 
settings to the FB Series product.  

• To view which parameters are automatically configured when 
you select Auto Configure, refer to Automatically Configured 
Parameters. 

Details Select this button to open the Communications configuration 
display for the communications port configured in the Comm Port 

to GC field. Select  to return to Guided Setup. 

Note 

You must configure the Comm Port to GC field before this button 
is active. 

2. Select Apply to save your selections to the FB Series product and advance to the next 
step in the Guided Setup. 

4.2.4 Guided Setup: 4088 Setup 

Use this display to enable communications with a 4088B multivariable transmitter on 
selected communications ports. 

Note 

When communicating with more than six 4088Bs at 9600 baud, update times exceed once 
per second. 
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Figure 75. Guided Setup: 4088 Setup 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Communications 
Port Instance 

Click ▼ to select a communications port on which to enable 
multivariable transmitters. 

Note  
Only communications ports with the Port Owner field configured 
as MVS4088B are shown. 

Enable All Select to enable communications for all transmitters. 
Baud Rate Sets the baud rate for 4088B communications using the selected 

port. 
Comm Details Select this button to open the Communications configuration 

display for the communications port configured in the Comm Port 

to GC field. Select  to return to Guided Setup. 
Transmitter 
Scanning 

Place a check mark to enable the system to scan the selected 
4088B for data.  

Tag Sets a name (up to 8-alphanumeric characters) for the selected 
4088B. 
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Field Description 

Description Sets a description (up to 16-alphanumeric characters) for the 
selected 4088B. 

4088B Modbus 
Address 

Sets the unique Modbus address for the selected 4088B 
multivariable transmitter. The default address is 1. If the 4088B is 
used in the multi-drop mode, each 4088B must have a unique 
address. Use Address 240 to poll the sensor to determine the 
address of the connected sensor. This is similar to polling a device 
using Address and Group 240. When Address 240 is used, the 
sensor responds with its address by updating the Address field. 

Input Health 
Status 

This read-only field shows the current operating status of the 
selected 4088B. 

Auto Scan Select to have the system automatically scan the baud rates for 
the 4088B with the indicated Modbus address. 

Note  

• The baud rate of the transmitter is changed to the baud rate 
configured in the Baud Rate field. 

• You must select the Enable checkbox in the Transmitter 
Scanning field to activate this button. 

Details Select this button to open the 4088B configuration display for the 

selected transmitter. Select  to return to Guided Setup. 

Note 

You must select the Enable checkbox in the Transmitter 
Scanning field to activate this button. 

Wiring Diagram Click to open a 4088B wiring diagram for the selected 
communications port.  

2. Select Apply to save your selections to the FB Series product and advance to the next 
step in the Guided Setup. 

4.2.5 Guided Setup: Fluid Selection 

Use this display to select the station layout, and to assign number and types of meters for 
each fluid type. 
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Figure 76. Guided Setup: Fluid Selection 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Station Layout Select how meters are assigned to stations. 

One per 
each meter 

Each meter is assigned to a separate station. 

One per 
fluid type 

Each fluid type is assigned to a separate station. 

Custom Select Custom and select Apply to open the Custom 
Station Layout Configuration display. This display 
allows you to specify the number of stations, assign 
the fluid type for each station, and configure the 
number and types of meters assigned to each 
station. 
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Field Description 

Note 

This field is read-only and set to Custom if you have previously 
configured any meter in your FB Series product. 

Fluid Type Select the type of fluids being measured. 

DP Meters Set the number of differential pressure meters for each fluid type. 

Linear Meters Set the number of linear meters for each fluid type. 

Maximum 
Meters 

This read-only field shows the number of meters available in your 
FB3000. 

Used/Allocated 
Meters 

This read-only field shows the number of meters currently assigned 
in your FB3000. 

2. Complete the following step based on your selections: 

• If you select either One per each meter or One per each fluid type in the Station 
Layout field, select Apply to save your selections to the FB Series product. A 
confirmation dialog opens. Select OK to advance to Engineering Units. 

Figure 77. Confirmation 

 

• If you select Custom in the Station Layout field and you do not have any meters 
currently assigned to a station, select Next to open the Custom Station Layout 
Configuration pop-up display. 

• If you select Custom in the Station Layout field and you do have any meters 
currently assigned to a station, select Next to open the Station Assignment display. 
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4.2.6 Guided Setup: Custom Station Layout Configuration 

Use this display to manually customize your station layout. You can select the type of fluid 
being measured by the station, and the number and type of meters belonging to each 
station. 

Note 

This display opens only if you select Custom in the Station Layout field on the Fluid 
Selection display and you do not have any meters currently assigned to a station. 

Figure 78. Guided Setup: Custom Station Layout Configuration 

 

1. Select Add Station to add a station and configure its properties. 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Station Select  to select a station iteration to configure. 
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Field Description 

Fluid Select  to set the type of fluids being measured by the selected 
station. 

Gas DP Meter Select  to set the number of gas differential pressure meters 

being measured by the selected station. 

Note 

You must select Natural Gas in the Fluid field to enable this field. 

Gas Linear 
Meter 

Select  to set the number of gas linear meters being measured by 

the selected station. 

Note 

You must select Natural Gas in the Fluid field to enable this field. 

Liquid Linear 
Meter 

Select  to set the number of liquid linear meters being measured 

by the selected station. 

Note 

You must select Liquid in the Fluid field to enable this field. 

Totals These read-only fields show the total number of each meter type 
currently assigned to station. 

3. Select Apply to save any changes you make to this display. A confirmation dialog 
opens. 

Note 

Stations without at least one meter type assigned are automatically removed from the 
list. 

Figure 79. Confirmation 

 

4. Select Yes to advance to the next step in the Guided Setup. 
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4.2.7 Guided Setup: Station Assignment 

Use this display to manually customize your station layout. You can select the type of fluid 
being measured by the station, and the number and type of meters belonging to each 
station. 

Note 

This display opens only if you select Custom in the Station Layout field on the Fluid 
Selection display and you do have any meters currently assigned to a station. 

Figure 80. Guided Setup: Station Assignment 

 

1. Tabs appear at the top of the display. Each tab consists of up to 12 meters. Select the 
tab that contains the meters you want to assign to a specific station. 

2. Select  to open a Point Picker dialog and assign each meter to a specific station. 

Note  

Gas meters and liquid meters cannot belong to the same station. If you assign a gas 
meter to a liquid station or a liquid meter to a gas station, a Flow Calculation alarm is 
raised. 
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3. Select Station Fluid Type and Batching to configure the fluid type measured by each 
station and to enable batching on liquid stations. 

Note  

You cannot change the fluid type of a station if a meter is already assigned to that 
station. In this case, you must first remove any meters assigned to the selected station 
before you are able to change the Fluid Type field.  

4. Select Apply to save your selections to the FB Series product and advance to the next 
step in the Guided Setup.  

4.2.8 Guided Setup: Engineering Units 

Use this display to configure the engineering units used by the station for measurements. 
You can select Set all to US/Imperial, Set all to Metric, Set all to Canadian, or configure 
each measurement type individually. You can also configure how many decimal places are 
used for each measurement value. 

Conversion factors for the different engineering units are taken from the following 
standards: 

• IEEE/ASTM SI 10-2002 - IEEE/ASTM Standard for Use of the International System of 
Units (SI): The Modern Metric System 

• Manual of Petroleum Measurement Standards Chapter 15—Guidelines for the Use of 
the International System of Units (SI) in the Petroleum and Allied Industries 

• ANSI/API MPMS Ch. 14.3.3/AGA Report No. 3 

Note 

• FB Series products use full-resolution data for all calculations. The Decimal 
Places fields on this display are used only for viewing data in FBxConnect™ 
Configuration Software. 

• Fields on this display differ based on what fluid type the selected station is measuring 
(Natural Gas or Liquid). 

• Changes to engineering units are applied to the station and all meters assigned to the 
selected station, even if a meter has previously been configured. Additionally, any I/O 
associated with the station or its meters is also updated. Refer to Configure – 
Summary to view which meters are assigned to each station. 
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• You can configure the number of decimal places shown on history reports using the 
Settings menu option in the Field Tools menu bar. 

Molar mass units are dependent upon the density units: 

Density Unit  Molar Mass Unit 

lb/ft³  lb/lb-mol 

lb/MMCF  lb/lb-mol 

lb/US gal  lb/lb-mol 

lb/bbl  lb/lb-mol 

RD  lb/lb-mol 

°API  lb/lb-mol 

kg/m³  kg/kmol 

kg/L  kg/kmol 

g/cc  g/mol 

Joule Thomson units are dependent upon the pressure units: 

Pressure Unit  Joule Thompson 
Unit 

psi  °F/psi 

kPa  K/kPa 

bar °C/bar 

MPa  K/MPa 

kg/cm²  K/MPa 

Acceleration units are dependent upon the linear long units: 

Linear Long Unit  Acceleration Unit 

ft  ft/s² 

m  m/s² 

Note 

The 4088 does not support temperature units of Kelvin. 
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Figure 81. Guided Setup: Engineering Units (Liquid Station shown) 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Set all to 
US/Imperial 

Select to automatically configure the selected station to use 
US/Imperial units for all measurements and calculations. 

Set all to 
Metric 

Select to automatically configure the selected station to use metric 
units for all measurements and calculations. 

Set all to 
Canadian 

Select to automatically configure the selected station to use 
Canadian units for all measurements and calculations. 

Meter Inputs Select ▼ to choose the measurement units used with each meter 
input and the number of decimal places shown in FBxConnect™. 
Meter Inputs include differential pressure units, static pressure 
units, and temperature units. 
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Field Description 

Totals Select ▼ to choose the measurement units used when calculating 
totals and the number of decimal places shown in FBxConnect™. 
Totals include gas volume units, energy units, mass units, liquid 
volume units, water volume units, and flow time units. 

Rates Select ▼ to choose the measurement units used when displaying 
rate and the number of decimal places shown in FBxConnect™. 
Rates include gas volume units, energy units, mass units, liquid 
volume units, and water volume units. 

Fluid Select ▼ to choose the measurement units used when performing 
fluid calculations and the number of decimal places shown in 
FBxConnect™. Fluid properties include dynamic viscosity, density, 
volume-based heating value, mass-based heating value, water 
density, and oil density. 

Length Select ▼ to choose the measurement units used for distance and 
the number of decimal places shown in FBxConnect™. Length 
includes linear short and linear long. 

K-Factor Select ▼ to choose the measurement units used when calculating 
the K-factor and the number of decimal places shown in 
FBxConnect™. K-factor includes volumetric and mass. 

Other Select ▼ to choose the measurement units used for other 
calculations, including water content, and the number of decimal 
places shown in FBxConnect™. 

Reset Decimal 
Places 

Select to revert all measurement units to show the default number 
of decimal places in FBxConnect™. 

2. Select Apply to save your selections to the FB Series product and advance to the next 
step in the Guided Setup. 

4.2.9 Guided Setup: Station 

Use this display to configure parameters for the selected station.  

Note 

• Available station parameters are slightly different based on the measured fluid type. 
All possible fields are described below. 
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• You can right-click on the Station node in the navigation tree to copy or paste the 
configuration of one station to another. 

 

 

Figure 82. Guided Setup: Station (Natural Gas shown) 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

General Tag Sets an identifier (up to 20-alphanumeric 
characters) for the selected station. 

Description Sets a description (up to 20-alphanumeric 
characters) for the selected station. 
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Field Description 

Fluid Type This read-only field shows the type of fluid 
measured by the selected station. 

Details Select this button to open the standard Station configuration 

display. Select  to return to Guided Setup. 
Atmospheric 
Pressure 

Atm 
Pressure 
Mode 

Click ▼ to set how the system acquires the 
atmospheric pressure value used in calculations. 
Possible options are: 

Override The system uses a value you define in 
the Override Atm Pressure field. 

Calculated The system calculates the 
atmospheric pressure value. 

Override 
Atm 
Pressure 

Sets a value to use for the atmospheric pressure in 
calculations when Override is selected in the Atm 
Pressure Mode field. 

Base 
Temperature 
Selection 

Sets the flow measurement Base Temperature specified in the gas 
contract. The temperature units are in degrees Fahrenheit or 
degrees Celsius.  

Note  

Select User to enter a custom temperature value. 

Base Pressure 
Selection 

Sets the flow measurement Base Pressure specified in the gas 
contract. The pressure units are in psi(a) or kPa. 

Note 

• Select User to enter a custom pressure value. 

• This field appears only for stations with a Fluid Type of Natural 
Gas. 

Contract 
Properties 

Contract 
Hour 

Sets the hour at which daily, weekly, and totals 
rollover and history records are logged (for daily-
based, weekly-based, or monthly-based reports). 

Contract 
Day of Week 

Sets the day of the week at which totals rollover and 
history records are logged (for weekly-based 
reports). 
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Field Description 

Contract 
Day of 
Month 

Sets the day of the month at which totals rollover 
and history records are logged (for monthly-based 
reports). 

Component 
Configuration 

Note 
These fields appears only for stations with a Fluid Type of Natural 
Gas. 

Components 
Object 

Click  to open a Point Picker dialog and select a 

Components object from the database that the 
station uses to calculate fluid composition. 

Operation 
Mode 

Sets how the system acquires the component 
information. Possible options are: 

Measured Selected composition is obtained from 
the LIVE parameters updated from a 
gas chromatograph. 

Override Selected composition is obtained from 
the OVRD parameters entered by a 
user. Changes to OVRD parameters 
are logged to the event log. 

Remote 
Download 

Selected composition is obtained from 
the OVRD parameters downloaded 
from a SCADA host or other remote 
master. Changes to OVRD parameters 
are not logged to the event log. 

GC Data 
Object 

Select  to open a Point Picker dialog and define 

which GC Data instance is associated with each 
Components instance. 

Note 

This field appears only if you select Measured in 
the Operation Mode field. 
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Field Description 

Stream 
Number 

Sets the Stream number associated with each GC 
Data instance configured in the GC Data Object 
field. 

Note 

This field appears only if you select Measured in 
the Operation Mode field. 

Calculation 
Methods 

Heating 
Value Calc 
Standard 

Sets the calculation standard used in heating value, 
relative density of the gas to air, and Wobbe Index 
calculations. Options are GPA 2172 2009 Gross, ISO 
6976 1995 Superior, ISO 6976 1995 Inferior, AGA5 
2009 Gross, and AGA5 2009 Net.  

Note 

• This field appears only for stations with a 
Fluid Type of Natural Gas. 

• GPA 2172 2009 uses GPA 2145 2016. 

• ISO 6976 1995 Superior and ISO 6976 1995 
Inferior use the base compressibility (Zb) 
value calculated per ISO 6976 in the heating 
value calculation when base temperature 
selection is 0°C, 15°C, or 20°C; in these cases 
a base pressure of 1.01325 bar is used for 
the real Heating Value and Real Relative 
density. For other base temperature 
selections, the selected Zb from the 
compressibility calculation is used. The base 
pressure for combustion is always 1.01325 
bar. 

• If the base compressibility method is 
dependent upon the Heating value or 
relative density, GPA 2172 uses the Base 
Compressibility using the GPA 2172 2009 
method. Otherwise, GPA 2172 2009 uses the 
Selected Base Compressibility value found 
on the Fluid Properties – Advanced tab in 
the heating value calculation. 
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Field Description 

• If the base compressibility method is 
dependent upon the heating value or 
relative density, then GPA 2172 2009 Gross, 
AGA5 2009 Gross, and AGA5 2009 Net use 
the base compressibility from their 
respective internal compressibility method. 
Otherwise, GPA 2172 2009 Gross, AGA5 
2009 Gross, and AGA5 2009 Net use the 
Selected Base Compressibility value found 
on the Fluid Properties – Advanced tab in 
the heating value calculation. 

• Although AGA5 says the base temperature 
and the combustion temperature shall be 
the same, the calculation will handle any 
base temperature and combustion 
temperature combination. 

• Since the components Benzene and Toluene 
are not included in AGA5, their properties 
are calculated separately. This calculation 
closely follows Example Process for 
Supporting Additional Compounds in 
Appendix A of AGA5 2009. 

• The AGA5 2009 Net (Inferior / Lower) 
heating value option assumes that the water 
formed in the combustion reaction remains 
in the ideal (gaseous) state. The AGA5 2009 
Gross (Superior / Higher) heating value 
option assumes that water formed in the 
combustion reaction condenses totally to 
the liquid state. For fiscal measurement 
applications, the gross heating value is more 
commonly used. 

Calculation 
Failure 
Option 

Sets how the FB Series product responds if a 
calculation failure occurs. Possible options are: 

Alarm 
Disabled 

No alarm is logged if a calculation 
failure occurs. 
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Field Description 

Alarm and 
Continue 

An alarm is logged and the 
calculation continues if a calculation 
failure occurs. 

Alarm and 
Halt 
Calculation 

An alarm is logged and the 
calculation stops if a calculation 
failure occurs. 

Compressibility 
/ Density 
Calculation 

Sets the desired compressibility/density calculation for the selected 
station. Select a standard from the list on the left, and then select a 
version/method to use from the list on the right. 
Note 

• This field appears only for stations with a Fluid Type of Natural 
Gas. 

• AGA8 2017 Part 2 / GERG 2008 can be used for both natural gas 
and pure gas measurement. For more information about pure 
gas measurement, refer to Measuring Pure Gas. 

• If you select AGA8 2017 Gross 1 or Gross 2, AGA8 1994 Gross 1 
or Gross 2, any SGERG, any ISO 12213-3, or any NX-19 option, 
the real heating value and real relative density base 
compressibility are calculated using your selection in the 
Heating Value Calc Standard field. 

• Some compressibility/density standards are based on a specific 
set of reference conditions. For the most accurate results, 
ensure the following reference conditions are configured based 
on the Compressibility/Density Calculation you select: 

AGA8 

 Any reference conditions. 

ISO 12213-2 2006 

 Any reference conditions. 

SGERG 1991 Std, CV/RD/N2/H2 or CV/N2/CO2/H2  

 The Base Temperature Selection field is set to 0°C. 

 The Base Pressure Selection field is set to 1.01325 bar. 

 The Heating Value Combustion Temperature field is set to 
25°C. 

ISO 12213-3 2006 Pref, Set B or Set D 
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Field Description 

 The Base Temperature Selection field is set to 0°C. 

 The Base Pressure Selection field is set to 1.01325 bar. 

 The Heating Value Combustion Temperature field is set to 
25°C. 

SGERG 1991 RD/N2/CO2/H2 or ISO 12213-3 2006 Set C 

 The Base Temperature Selection field is set to 0°C. 

 The Base Pressure Selection field is set to 1.01325 bar. 

NX-19 1962 

 The Base Temperature Selection field is set to 60°F. 

 The Base Pressure Selection field is set to 14.73 psi(a). 

NX-19 Mod or NX-19 VDE/VDI 

 The Base Temperature Selection field is set to 0°C. 

 The Base Pressure Selection field is set to 1.01325 bar. 

Apply Select to apply the currently selected station configuration to all 
other stations with the same fluid type. 

Note 

This field appears only if you have multiple stations with the same 
fluid type. 

2. Select Next to advance to the next step in the Guided Setup. 

4.2.10 Guided Setup: Gas Composition 

Use this display to configure gas composition parameters for the selected station.  

Note 

This display is applicable only for stations with a fluid type set to Natural Gas. 
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Figure 83. Guided Setup: Gas Composition 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Operation 
Mode 

This read-only field shows how the system acquires the component 
information. Possible options are: 

Measured Selected composition is obtained from the LIVE 
parameters updated from a gas chromatograph. 

Override Selected composition is obtained from the OVRD 
parameters entered by a user. Changes to OVRD 
parameters are logged to the event log. 

Remote 
Download 

Selected composition is obtained from the OVRD 
parameters downloaded from a SCADA host or 
other remote master. Changes to OVRD 
parameters are not logged to the event log. 
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Field Description 

Details Select this button to open the Component configuration display. 

Select  to return to Guided Setup. 

Normalization 
Option 

Sets what action is taken if the total of the gas mole percentages 
does not add up to 100%. 

None No action is taken if the total does not equal 100%. 

Full 
Normalization 

The system automatically adjusts each component 
proportionally so that the total adds up to 100%. 

Methane 
Adjust 

The system automatically adjusts the methane 
mole percent up or down so that the total adds up 
to 100%. 

Override Sets the mole percent of each fluid component (as a percentage) to 
use in calculations when Override is selected in the Operation Mode 
field. 

Totals This read-only field shows the total mole percent of all fluid 
components.  

2. Select Next to advance to the next step in the Guided Setup. 

4.2.11 Guided Setup: DP Meter 

Use this display to configure parameters for the selected differential pressure meter.  

Note 

You can right-click on a DP Meter node in the navigation tree to copy or paste the 
configuration of one meter to another. 
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Figure 84. Guided Setup: DP Meter 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
meter. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
meter. 

Meter Type Click ▼ to specify the type of differential pressure meter you are 
configuring, and the calculation to use for the selected meter. 

AGA 3 
Calculation 
Selection 

Click ▼ to specify the calculation to use for the selected meter. 

Note 
This field shows only if you select an AGA3 Orifice meter in the 
Meter Type field. 

ISO 5167 
Calculation 
Selection 

Click ▼ to specify the calculation to use for the selected meter. 

Note 
This field shows only if you select an ISO5167 meter in the Meter 
Type field. 
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Field Description 

Rosemont 
Orifice 
Calculation 

Click ▼ to specify the calculation to use for the selected meter. 

Note 
This field shows only if you select a 1595 Conditioning Orifice or 
405C Compact Orifice meter in the Meter Type field. 

Meter 
Material 
Option 

Indicates the material from which the orifice (or other meter element) 
is made. Nearly all natural gas applications use stainless steel orifice 
plates. 

Orifice 
Diameter 

Specifies the orifice plate bore diameter. 

Note 

This field appears only if you select an orifice meter in the Meter 
Type field. 

Throat 
Diameter 

Specifies the Venturi tube throat diameter. 

Note 

This field appears only if you select a Venturi meter in the Meter 
Type field. 

Nozzle 
Diameter 

Specifies the nozzle throat diameter. 

Note 

This field appears only if you select a nozzle meter in the Meter 
Type field. 

Orifice 
Diameter 
(single hole) 

Specifies the typical orifice hole size (single hole). 

Note 

This field appears only if you select a conditioning orifice meter in 
the Meter Type field. 

Cone 
Diameter 

Specifies the cone diameter. 

Note 

This field appears only if you select a cone meter in the Meter Type 
field. 

Pipe Material 
Option 

Indicates the material from which the meter tube is constructed. 
Nearly all natural gas applications use a carbon steel meter tube.  

Pipe Diameter Specifies the inside diameter of the pipe in which the meter is 
installed. 
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Field Description 

Static 
Pressure 
Location 

Sets the location of the static pressure tap in relation to the meter 
and normal flow. 

Upstream The static pressure tap is located upstream in 
relation to the meter and normal flow. 

Downstream The static pressure tap is located downstream in 
relation to the meter and normal flow. 

Pressure 
Transmitter 
Type 

Indicates the type of static pressure transmitter (absolute or gauge) 
configured for the selected meter. 

Note 

This field appears only if you select a User Data instance in the 
Flowing Pressure I/O Definition field. 

No Flow Cut-
off Limit 

Sets the low flow cutoff point. When the live differential pressure of 
the metering device is less than this value, the meter flow rates will 
be set to zero. 

Details Select this button to open the DP Meter configuration display. Select 

 to return to Guided Setup. 

Differential 
Pressure 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

differential pressure input to use for the selected 
meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• DP object (Forward) – SELECTED VALUE 

• DP object (Reverse) – REVERSE DIFFERENTIAL 
PRESSURE 

• AI object – SELECTED VALUE 
Note  
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to AI. 

• User Data object – DOUBLE FLOATING POINT 1. 
For more information, refer to User Data. 
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Field Description 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the differential pressure value to use in 
calculations when the Mode field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units used 
for the selected input. 

Flowing 
Pressure 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

static pressure input to use for the selected meter. 

If you select a Press object, the firmware determines 
the pressure input type (absolute or gauge) directly 
from the sensor. 

If you select an AI object, the firmware determines 
the pressure input type from the configurable Units 
Type selection that is associated with the selected 
analog input.  

If you select a User Data object, you must indicate 
the pressure input type in the Pressure Transmitter 
Type field. The value is assumed to be in the pressure 
units selected for the associated station. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• Press object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note  
You must first configure an AI instance to use the 
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Field Description 

correct measurement type before it is visible in 
the Point Picker. For more information, refer to AI. 

• User Data – DOUBLE FLOATING POINT 2. For 
more information, refer to User Data. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the static pressure value to use in calculations 
when the Mode field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units used 
for the selected input. 

Flowing 
Temperature 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

flowing temperature input to use for the selected 
meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• RTD object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to AI. 

• User Data – DOUBLE FLOATING POINT 3. For 
more information, refer to User Data. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

147 

Field Description 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the flowing temperature value to use in 
calculations when the Mode field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units used 
for the selected input. 

Apply Select to apply the currently selected meter configuration to all other 
meters with the same meter type. 

Note 

This field appears only for the first instance of multiple meters with 
the same meter type. 

2. Select Next to advance to the next step in the Guided Setup. 
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4.2.12 Guided Setup: Linear Meter 

Use this display to configure parameters for the selected linear meter.  

Note 

You can right-click on a Linear Meter node in the navigation tree to copy or paste the 
configuration of one meter to another. 

 

Figure 85. Guided Setup: Linear Meter 

 

1. Review – and change as necessary – the values in the following fields: 
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Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
meter. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
meter. 

No Flow 
Option 

Sets how the system calculates a "no flow" condition for the meter. 
Possible options are: 

Time 
Between 
Pulses 

The system determines a "no flow" condition for the 
meter based on the amount of time between 
successive pulses. The calculated flow is set equal to 
zero. 

Note 

• This field applies only if you select a pulse input 
object in the Indicated Flow field.  

• You must enter a time (in seconds) for the 
system to use in the text field. 

Flow Cut-off When the value of the uncorrected volume input is 
less than or equal to the Low Flow Cutoff value, the 
calculated flow is set equal to zero. 

Note 

You must enter a value (in Hz) for the system to use 
in the text field. 

Meter Type Specifies the type of linear meter you are configuring. Possible 
options are: 
Turbine Select if measuring flow through a turbine meter or 

other linear meter with a frequency or analog signal 
representing actual volumetric flow rate. 

Coriolis Select if measuring flow through a Coriolis meter or 
other linear meter with a frequency or analog signal 
representing a mass flow rate. 

Auto-Adjust Select if measuring flow through an Auto-Adjust 
meter. This meter type requires 2 pulse inputs, one 
representing the main rotor and one representing 
the sensing rotor. 
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Field Description 

Ultrasonic Select if measuring flow through an ultrasonic meter. 
This meter type option performs the same flow 
calculations as the Turbine option, and this option is 
provided for equipment identification. CFX files 
generated by FBxConnect™ include this option in the 
configuration section of the CFX file. 

Positive 
Displacement 

Select if measuring flow through a positive 
displacement meter. This meter type option 
performs the same flow calculations as the Turbine 
option, and this option is provided for equipment 
identification. CFX files generated by FBxConnect™ 
include this option in the configuration section of the 
CFX file. 

Pressure 
Transmitter 
Type 

Indicates the type of static pressure transmitter (absolute or gauge) 
configured for the selected meter. 

Note 

This field appears only if you select a User Data instance in the Static 
Pressure I/O Definition field. 

Details Select this button to open the Linear Meter configuration display. 

Select  to return to Guided Setup. 
Meter Factor 
/ K-factor 
Curve Option 

Sets how system uses calculates K-factors or Meter Factors in the flow 
calculation. Possible options are: 

Single Meter 
Factor / 
Single K-
factor 

Uses a single Meter Factor and a single K-factor for 
the meter. This is the simplest choice and means that 
a value for the meter factor and a value for the K-
factor are fixed for all flow rates and the values are 
taken from the last prove or an entered value. Select 
this option when using either the K-factor or meter 
factor proving, as long as neither the K-factor or 
meter factor will vary with flow rate or product. 

Note 

This option appears only if you select Turbine or 
Coriolis in the Meter Type field. 
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Field Description 

Meter Factor 
Curve / 
Single K-
factor 

A meter factor calculates for the current flow rate 
based on a linear interpolation of the meter factor 
versus flow rate values entered under the Factor 
Curve heading, but the K-factor will be fixed. Select 
this option when using meter factor proving if 
proving is done at multiple flow rates. 

Note 

This option appears only if you select Turbine or 
Coriolis in the Meter Type field. 

Single Meter 
Factor / K-
factor Curve 

A K-factor calculates for the current flow input 
frequency based on a linear interpolation of the 
meter factor versus frequency values entered under 
the Factor Curve, but the meter factor will be a single 
value from the last prove or entered value. The K-
factor curve can come from multiple proves at 
different flow rates with a meter factor of 1.0 (K-
factor proving) or the K-factor curve can come from 
factory calibration and a single meter factor from a 
prove (meter factor proving). 

Note 

This option appears only if you select Turbine or 
Coriolis in the Meter Type field. 

Override 
Meter Factor 

Sets a fixed meter factor value to use in calculations. 

Note 

This field appears only if you select either Single Meter Factor / 
Single K-factor or Single Meter Factor / K-factor Curve in the Meter 
Factor / K-factor Curve Option field. 

Override K-
factor 

Sets the discharge coefficient value to use in calculations. 

Note 

This field appears only if you select either Single Meter Factor / 
Single K-factor or Meter Factor Curve / Single K-factor in the Meter 
Factor / K-factor Curve Option field. 
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Field Description 

Calibration 
Curve Option 

Sets how the system uses the Adjusted Uncorrected Volume Factor 
(AUVF) in calculations. Possible options are: 

Note 

These options appear only if you select Auto-Adjust in the Meter 
Type field. 

Disable The system does not use the AUVF in calculations 
(which is equal to an AUVF of 1.00).  

Note  

If you disable the calibration curve, the adjusted 
volume rate reflects the result of the auto-adjust 
algorithm with no correction for the calibration 
curve. 

Enable The system includes the Adjusted Uncorrected 
Volume Factor (AUVF) in calculations.  

Note  

You must enter information from the calibration 
report in the % Error and AAT Volume fields. The 
program applies the AUVF to the result of the auto-
adjust algorithm to calculate the adjusted volume 
rate at flowing conditions. 

Indicated 
Flow 

I/O 
Definition 

Click  to open a Point Picker dialog and select an 

indicated flow input to use for the selected meter. 
This field represents the Pulse Frequency for a 
Turbine or Coriolis meter type, and the Main Rotor 
Frequency for an Auto-Adjust meter type. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object.  

• PI object – SELECTED FREQUENCY and 
ACCUMULATED PULSES 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use 
the correct measurement type before it is visible 
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Field Description 

in the Point Picker. For more information, refer 
to AI. 

• User Data – DOUBLE FLOATING POINT 1. For 
more information, refer to User Data. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the system 
uses the value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units 
used for the selected input. 

Secondary 
Flow Input 
Object 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

secondary flow object to use for the selected meter. 
The secondary flow object represents the Sensing 
Rotor Frequency and must be a PI object. This field is 
currently only used for an Auto-Adjust meter type.  

Note 

Only an object is chosen, and the Auto-Adjust 
algorithm reads the SELECTED FREQUENCY and 
ACCUMULATED PULSES parameters from the 
selected PI object. 
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Field Description 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the system 
uses the value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units 
used for the selected input. 

Note 

These fields appear only if you select Auto-Adjust in the Meter Type 
field. 

Static 
Pressure 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

static pressure input to use for the selected meter. 

If you select a Press object, the firmware determines 
the pressure input type (absolute or gauge) directly 
from the sensor. 

If you select an AI object, the firmware determines 
the pressure input type from the configurable Units 
Type selection that is associated with the selected 
analog input.  

If you select a User Data object, you must indicate 
the pressure input type in the Pressure Transmitter 
Type field. The value is assumed to be in the pressure 
units selected for the associated station. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 
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Field Description 

• Press object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use 
the correct measurement type before it is visible 
in the Point Picker. For more information, refer 
to AI. 

• User Data – DOUBLE FLOATING POINT 2. For 
more information, refer to User Data. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the system 
uses the value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units 
used for the selected input. 

Flowing 
Temperature 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

flowing temperature input to use for the selected 
meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 

• RTD object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use 
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Field Description 

the correct measurement type before it is visible 
in the Point Picker. For more information, refer 
to AI. 

• User Data – DOUBLE FLOATING POINT 3. For 
more information, refer to User Data. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the system 
uses the value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units 
used for the selected input. 

Apply Select to apply the currently selected meter configuration to all other 
meters with the same meter type. 

Note 

This field appears only for the first instance of multiple meters with 
the same meter type. 

2. Select Next to advance to the next step in the Guided Setup. 

4.2.13 Guided Setup: Linear Meter Curve Setup 

Use this display to enter a meter factor curve or K-factor curve. 

Note 

This display appears only if you select Meter Factor Curve/Single K-factor or Single Meter 
Factor/K-factor Curve in the Meter Factor/K-factor Curve Option field on the previous 
display. 
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Figure 86. Guided Setup: Linear Meter Curve Setup 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

K-factor / 
Frequency 

If you selected Meter Factor Curve / Single K-factor in the Meter 
Factor / K-factor Curve Option field on the previous display, enter up 
to 20 points on the curve (pairs of meter factor and flow rate) and a 
meter factor is calculated for use in the flow equation by linear 
interpolation of the current indicated quantity flow rate. 

Meter Factor / 
Flow Rate 

If you selected Single Meter Factor / K-factor Curve in the Meter 
Factor / K-factor Curve Option field on the previous display, enter up 
to 20 points on the curve (pairs of K-factor and frequency) and a K-
factor is calculated for use in the flow equation by linear interpolation 
of the current flow meter input frequency. 
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Field Description 

% Error / AAT 
Volume 

If you selected Auto-Adjust in the Meter Type field on the previous 
display, enter up to 20 points on the curve (pairs of % Error and AAT 
Volume {the volumetric flow rate calculated by the Auto-Adjust 
Turbine algorithm}). The adjusted Uncorrected Volume Factor is 
calculated for use in the flow equation by using linear interpolation of 
the AAT Volume to determine % Error and then the AUVF is calculated 
as follows: 

 

Note 

A valid point must have a non-zero flow rate/frequency and a non-zero factor. The points 
may be entered in any order and will be internally sorted by flow rate (MF curve) or 
frequency (K-Factor Curve), discarding any invalid points. No extrapolation is done beyond 
the lowest and highest points on the curve. If the flow rate/frequency is less than the 
lowest point on the curve, the calculated factor will be the factor for the lowest point on 
the curve. If the flow rate/frequency is greater than the highest point on the curve, the 
calculated factor will be the factor for the highest point on the curve. 

2. Select Next to advance to the next step in the Guided Setup. 

4.2.14 Guided Setup: Calculation Options 

Use this display to set the flow calculation methodology used to calculate crude oil, crude 
oil byproducts, water quantities, and density input for the selected liquid linear meter.   
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Figure 87. Guided Setup: Calculation Options 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

What is the 
liquid type? 

Sets the specific type of hydrocarbon fluid for the selected product 
instance. Possible options are: 

Crude Oil A liquid hydrocarbon is generally considered to be a 
crude oil if its density falls between approximately 
0.61120 to 1.16464 relative density (100 to −10 °API). 
Crude oils that have been stabilized for transportation 
or storage purposes with API gravities within this 
range are considered to be part of this group. 

Light 
Hydrocarbon 

A liquid hydrocarbon is generally considered to be a 
light hydrocarbon if its density falls between 
approximately 0.3500 to 0.6880 relative density (272.8 
to 72.2 °API). Light hydrocarbons are often referred to 
as LPGs (Liquified Petroleum Gases) or NGLs (Natural 
Gas Liquids) and are predominantly composed of 
lighter hydrocarbons, such as methane, ethane, 
butane, and propane. 
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Field Description 

Refined 
Products 

A liquid hydrocarbon is generally considered to be a 
refined product if it falls into one of the following 
product groups: 

• Gasoline – Motor gasoline and unfinished 
gasoline blending stock with a base density 
range between approximately 50° API and 85° 
API. 

• Jet Fuels – Jet fuels, kerosene, and Stoddard 
solvents with a base density range between 
approximately 37° API and 50° API. 

• Fuel Oils – Diesel oils, heating oils and fuel oils 
with a base density range between 
approximately -10° API and 37° API. 

Lubricating 
Oil 

A liquid hydrocarbon is generally considered to be a 
lubricating oil if it is a base stock derived from crude 
oil fractions by distillation or asphalt precipitation. 
Lubricating oils have densities in the range between 
approximately -10 to 45° API. 

Additional 
Fluid 

Any fluid not covered by the other options. If a 
measured density is available and the base density is 
known, then the volume correction factor for 
temperature and pressure (CTPL) is calculated as the 
ratio of the measured density to the base density. If a 
measured density is not available, then the CTPL is set 
to 1.0 and no volume correction for temperature or 
pressure is calculated. The density options below are 
chosen via the Density Option field on the Station – 
General display: 

Station Base Density 
 meter observed density = station base density 
 CTPL = 1.0 

Meter Observed Density 
 CTPL = meter observed density / station base 

density 
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Field Description 

Station Header Density 
 meter observed density = station header density 
 CTPL = meter observed density / station base 

density 

Note 
Even though independent temperature (CTL) and 
pressure (CPL) correction factors cannot be 
calculated, CTL is set equal to CTPL and CPL is set 
equal to 1.0 to provide support for systems that do 
not recognize or use CTPL. 

What 
calculation 
standard do 
you want to 
use? 

Sets the flow calculation methodology used to calculate crude oil, 
crude oil byproducts, and water quantities. Possible options are: 

API Ch. 12.2 
Custody 
Transfer 

Meters assigned to the selected station use API Ch. 
12.2 for oil measurement. This standard is typically 
used for custody transfer but can also be utilized for 
allocation applications. The standard assumes a low 
amount of water in the measured fluid and treats the 
water stream as an oil for volume correction 
purposes. 

The meter calculates flow rates and accumulations 
representing indicated quantity, gross volume, gross 
standard volume, net standard volume, water 
volume, and mass. CTPL is calculated as the product 
of the rounded CTL and CPL, which is in turn rounded 
as per correction factors in API Ch 12.2 Table 6. 

Note 

CTL, CPL, CCF, and Meter Factor (MF) are rounded as 
per API Ch. 12.2 Table 6. The associated Station 
provides flow rates and accumulations representing 
gross volume, net standard volume, water volume, 
and mass. 
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Field Description 

API Ch. 20.1 
Allocation 

Meters assigned to the selected station use API Ch. 
20.1 standard for allocation measurement. The 
standard handles unstable crude oil and/or higher 
water cases. The standard is partitioned by its water 
volume correction methodology. 

Note 

This field appears only if you select Crude Oil in the 
previous field. 

Water Factor Sets how the system calculates the water volume correction. 

Note 

This field appears only if you select API Ch. 20.1 in the previous field. 

Apply S&W% 
at end (to 
base 
conditions)  

Meters assigned to the selected station use API Ch. 
20.1 Procedure A for oil measurement. The standard 
assumes a low amount of water in the measured fluid 
and treats the water stream as an oil for volume 
correction purposes. API Ch. 20.1 (2016) suggests 
using this method when the sediment and water is 
generally less than 5.0 percent. 

The meter calculates the same quantities as the API 
Ch. 12.2 Custody Transfer Meter, but a shrinkage 
factor is applied to the gross standard volume. If the 
shrinkage factor includes a correction for 
temperature, the CTL should be set to override mode 
with a value of 1.0, otherwise it should be set to 
calculated mode. If pressure correction is included in 
the SF or pressure correction is not required, CPL 
should be set to override mode at 1.0, otherwise CPL 
should be set to calculated mode. CTPL is calculated 
as the product of the rounded CTL and CPL, which is 
in turn rounded as per correction factors in API Ch 
12.2 Table 6. The water fraction is calculated using the 
in-use CSW. 

Note 
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Field Description 

CTL, CPL, CCF, and Meter Factor (MF) are rounded as 
per API Ch. 12.2 Table 6. Station quantity calculations 
are not supported for allocation meters. 

Apply % 
Water to 
Gross 
Volume (oil 
and water 
volumes 
corrected 
separately) 

Meters assigned to the selected station use API Ch. 
20.1 Procedure C for oil measurement. The oil and 
water have separate volume correction factors and 
are split before volume correction is applied. API Ch. 
20.1 (2016) suggests using this method when the 
sediment and water is generally greater than 5.0 
percent. 

The meter calculates flow rates and accumulations 
representing indicated quantity, gross volume, oil 
unshrunk volume, net standard volume, water 
metered volume and water net volume. Additionally, 
a flash gas net volume and an NGL net volume may 
be calculated by entering an override flash gas factor 
and NGL factor. 

The correction factor for the oil is entered via an 
override or external shrinkage factor (SF). The 
Shrinkage Factor is assumed to include any correction 
for shrinkage, temperature, and pressure. CTL, CPL, 
CTPL, CCF and CSW are assumed to be 1.0 The 
correction factor for water is calculated according to 
API Ch. 20.1 A.1 (2016).  

Note 

The flow calculation uses unrounded correction 
factors. Station quantity calculations are not 
supported for allocation meters. 

Where is the 
density input 
coming 
from? 

Sets where the density measurement is occurring. Possible options 
are: 

Note 

This field appear only if you select either API Ch. 12.2 Custody 
Transfer or API Ch. 20.1 Allocation and Apply S&W% at end (to base 
conditions). 
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Field Description 

Station Base 
Density 

Use the static density value you define in the Base 
Density field. No densitometer is at the meter. A 
base to alternate calculation occurs using the meter 
temperature and pressure as the alternate 
conditions. 

Note 

If the base density and temperature units are 
different than the station's base conditions, the 
system converts the value to the station's base 
conditions. 

Base 
Density 

Enter a base density value to use in 
calculations. 

Note 

This field appears only if you select 
Station Base Density as the density 
input source. 

Meter 
Observed 
Density 

Use the dynamic density value measured at the 
meter by a densitometer you configure in the 
Flowing Density Parameter field. The observed to 
base density calculation uses the meter temperature 
and pressure as the observed density conditions. In 
most cases where the meters have individual live 
density measurement, there is only one temperature 
measurement and one pressure measurement to 
cover both the density and the meter. This means 
that the meter density is set equal to the observed 
density and only an observed to base calculation is 
performed. 

Station 
Header 
Density 

Use the dynamic density value measured at the 
station/header (with header temperature and 
pressure). You configure the measurement source in 
the Header Density Object field. 
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Field Description 

Header 
Density 
Object 

Sets the Liquid Density instance 
associated with the selected station. 

Select  to open a Point Picker 

dialog and choose the liquid density 
instance used by the selected station.  

Note 

This field appears only if you select 
Station Header Density as the 
density input source. 

Rounding 
Option 

Sets the rounding used by the system for volume correction factors. 
 
Rounding 
According to 
API 12.2.2 

Calculation outputs are rounded according to API 
12.2.2. 

No Rounding No rounding is performed on intermediate or final 
calculated variables, and values display in full double 
precision. 

Apply Select to apply the currently selected station configuration to all other 
stations with the same fluid type. 

Note  

This field appears only for the first instance of multiple stations with 
the same fluid type. 

2. Select Next to advance to the next step in the Guided Setup. 
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4.2.15 Guided Setup: Liquid Density 

If you select Station Header Density in the Calculation Options step of the Guided Setup, 
use this display to configure the station header density input.  

Note 

• You must configure the Density Parameter field. 

• The Density Pressure Parameter and Density Temperature Parameter fields are 
optional, but a property calculation alarm is raised at any associated liquid linear 
meter if the Density Temperature Parameter is Undefined. 

Figure 88. Guided Setup: Liquid Density 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
product instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
product instance. 
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Field Description 

Density 
Parameter 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

density input to use for the selected Liquid Density 
instance. 

Note  
Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• AI object – SELECTED VALUE  
Note  
You must first configure an AI instance to use the 
correct measurement type before it is visible in the 
Point Picker. For more information, refer to AI. 

• User Data – You can manually select any parameter. 
For more information, refer to User Data.  
Note  
The value is assumed to be in the same units selected 
for the associated station. 

Value This read-only field shows the value currently used in 
calculations based on the selected options. 

Note 
If you select a User Data object, enter a value to use for 
the selected parameter. 

Units This read-only field shows the engineering units used for 
the selected input. 

Alarms Click to open the Alarms display and configure the alarm 
currently assigned to the input. 

Note  
This selection is not available if you select a User Data 
object; however, you can configure an alarm object 
separately on the Configure > Alarms display for the User 
Data value. 
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Field Description 

Density 
Pressure 
Parameter 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

density pressure input to use for the Liquid Density 
instance. 

If you select a Press object, the firmware determines the 
pressure input type (absolute or gauge) directly from the 
sensor. 

Note  
Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• AI object – SELECTED VALUE  
Note  
You must first configure an AI instance to use the 
correct measurement type before it is visible in the 
Point Picker. For more information, refer to AI. 

• Press object – SELECTED VALUE 

• User Data – You can manually select any parameter. 
For more information, refer to User Data.  
Note  
The value is assumed to be in the same units selected 
for the associated station. 

Value This read-only field shows the value currently used in 
calculations based on the selected options. 

Note 
If you select a User Data object, enter a value to use for 
the selected parameter. 

Units This read-only field shows the engineering units used for 
the selected input. 

Alarms Click to open the Alarms display and configure the alarm 
currently assigned to the input. 

Note  
This selection is not available if you select a User Data 
object; however, you can configure an alarm object 
separately on the Configure > Alarms display for the User 
Data value. 
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Field Description 

Density 
Temperature 
Parameter 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

density temperature input to use for the Liquid Density 
instance. 

Note  
Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• AI object – SELECTED VALUE  
Note  
You must first configure an AI instance to use the 
correct measurement type before it is visible in the 
Point Picker. For more information, refer to AI. 

• RTD object – SELECTED VALUE 

• User Data – You can manually select any parameter. 
For more information, refer to User Data.  
Note  
The value is assumed to be in the same units selected 
for the associated station. 

Value This read-only field shows the value currently used in 
calculations based on the selected options. 

Note 
If you select a User Data object, enter a value to use for 
the selected parameter. 

Units This read-only field shows the engineering units used for 
the selected input. 

Alarms Click to open the Alarms display and configure the alarm 
currently assigned to the input. 

Note  
This selection is not available if you select a User Data 
object; however, you can configure an alarm object 
separately on the Configure > Alarms display for the User 
Data value. 

Density 
Correction 
Factor 

Sets the multiplier value to correct the observed density provided by a 
pycnometer or similar device. The Density Correction Factor 
(sometimes referred to as DCF) is a unitless scaler used to adjust the 
density referenced by the density parameter. 
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2. Select Next to advance to the next step in the Guided Setup. 

4.2.16 Guided Setup: Liquid Fluid Properties (Sediment and 
Water) 

If you select Crude Oil as the liquid type and you select either API Ch. 12.2 Custody 
Transfer or API Ch. 20.1 Allocation and Apply S&W% at end (to base conditions) in the 
Calculation Options step, use this display to configure the sediment and water value 
parameters for the selected liquid linear meter. 

Figure 89. Guided Setup: Liquid Fluid Properties (Sediment and Water) 
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1. Review – and change as necessary – the values in the following fields: 

Field Description 

Do you have 
Sediment 
and Water? 

Determines if calculations include corrections for sediment and water 
volumes. 

No Water Select this option if you do not have any sediment or 
water flowing through the meter. 

Yes, I’m 
measuring 

Select this option if you have sediment water flowing 
through the meter, and the amount is being 
measured. 

Yes, I’m using 
a fixed value 

Select this option to use an override value for the 
percent of sediment and water flowing through the 
meter. 

Sediment 
and Water 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the sediment and water value for the selected meter. 

Note 

This field appears only if you select Yes, I’m measuring. 

Override 
Sediment 
and Water 

Sets, in percent, a fixed sediment and water value to use in 
calculations for the selected meter. 

Note 

This field appears only if you select Yes, I’m using a fixed value. 

Selected 
Sediment 
and Water 

This read-only field shows the current sediment and water value, 
based on the selected options, used in calculations. 

Note 

This field appears only if you select Yes, I'm measuring or select Yes, 
I'm using a fixed value. 

2. Select Next to advance to the next step in the Guided Setup. 

4.2.17 Guided Setup: Liquid Fluid Properties (Additional 
Factors) 

If you select Crude Oil as the liquid type and you select API Ch. 20.1 Allocation in the 
Calculation Options step of the Guided Setup, use this display to configure general fluid 
properties and additional factors for the fluid being measured. 
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Note 

• The fields shown on this display are determined by your answer to the question What 
calculation standard do you want to use? in the Calculation Options step of the 
Guided Setup. 

• Physically impossible inputs may be clamped at a high or low limit value in order to 
ensure reasonable results. If a value is clamped at a high or low limit, a corresponding 
flow or property alarm is raised.  

 

Figure 90. Guided Setup: Liquid Fluid Properties (Additional Factors) 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Oil Base 
Density 

Sets how the system acquires the oil base density value. Possible 
options are: 

Measured The system uses a parameter you configure in the Oil 
Base Density Parameter field to acquire the value. 
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Field Description 

Override The system uses the value you define in the Override 
Oil Base Density field. 

Base Density 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the oil base density value. 

Override 
Base Density 

Sets the oil base density value to use in calculations when Override is 
selected in the Oil Base Density Mode field. 

Calculated 
Base Density 

This read-only field shows the oil base density value as calculated by 
the system. 

Selected Base 
Density 

This read-only field shows the current oil base density value, based on 
the selected options, used in calculations. 

Water Base 
Density 

Sets how the system acquires the water base density value. Possible 
options are: 

Measured The system uses a parameter you configure in the 
Water Base Density Parameter field to acquire the 
value. 

Note 

The system ignores invalid measured water base 
density values and uses a value of 0 instead. 

Override The system uses the value you define in the Override 
Water Base Density field. 

Water Base 
Density 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the water base density value. 

Override 
Water Base 
Density 

Sets the water base density value to use in calculations when Override 
is selected in the Water Base Density Mode field. 

Selected 
Water Base 
Density 

This read-only field shows the current water base density value, based 
on the selected options, used in calculations. 

Shrinkage 
Factor 

Sets how the system acquires the shrinkage factor value. The 
shrinkage factor is the ratio of hydrocarbon liquid at base conditions 
to the hydrocarbon liquid at metering conditions. Possible options are: 
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Field Description 

Measured The system uses a parameter you configure in the 
Shrinkage Factor Parameter field to acquire the 
value. 

Note 

Valid values are between 0 and 1. The system ignores 
an invalid measured shrinkage factor values and uses a 
value of 0 instead.  

Override The system uses the value you define in the Override 
Shrinkage Factor field. 

Shrinkage 
Factor 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the shrinkage factor value. 

Override 
Shrinkage 
Factor 

Sets the shrinkage factor value to use in calculations when Override is 
selected in the Shrinkage Factor Mode field. 

Selected 
Shrinkage 
Factor 

This read-only field shows the current shrinkage factor value, based 
on the selected options, used in calculations. 

Flowing 
Density 

Sets how the system acquires the flowing density value. Possible 
options are: 

Measured The system uses a parameter you configure in the 
Flowing Density Parameter field to acquire the value. 

Note 

The system ignores invalid measured emulsion density 
values and uses a value of 0 instead. 

Override The system uses the value you define in the Override 
Flowing Density field. 

Flowing 
Density 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the flowing density value. 

Override 
Flowing 
Density 

Sets the flowing density value to use in calculations when Override is 
selected in the Flowing Density Mode field. 

Calculated 
Flowing 
Density 

This read-only field shows the flowing density value as calculated by 
the system. 
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Field Description 

Selected 
Flowing 
Density 

This read-only field shows the current flowing density value, based on 
the selected options, used in calculations. 

Water Cut Sets how the system acquires the water cut value. Possible options 
are: 

Measured The system uses a parameter you configure in the 
Water Cut Parameter field to acquire the value. 

Note 

The system ignores negative or invalid measured water 
cut values and uses a value of 0% instead. Water cut 
values greater than 100% are treated as 100% 

Override The system uses the value you define in the Water Cut 
Override field. 

Sediment and 
Water 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the sediment and water value. 

Override 
Sediment and 
Water 

Sets the sediment and water value to use in calculations when 
Override is selected in the Water Cut Mode field. 

Selected 
Water Cut 

This read-only field shows the current sediment and water value, 
based on the selected options, used in calculations. 

Sediment and 
Water 
Fraction In 
Use 

This readd-only field shows the volume fraction of water applied to 
the gross volume of fluid measured to determine uncorrected (actual) 
water volume at metering conditions.  

Water Cut 
Method 

Sets how the water cut value is obtained. 

Dynamic Live reading of water cut at metering conditions. 

Static Off-line reading of water cut at laboratory conditions 
(needs to be corrected to metering conditions before 
using in the calculation). 

NGL Factor Sets how the system acquires the NGL factor value. The NGL factor is 
the ratio of the natural gas liquids at metering conditions to the 
hydrocarbon liquids at base conditions. Possible options are: 
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Field Description 

Measured The system uses a parameter you configure in the NGL 
Factor Parameter field to acquire the value. 

Note 

The system ignores negative or invalid NGL factor 
values and uses a value of 0 instead. 

Override The system uses the value you define in the Override 
NGL Factor field. 

NGL Factor 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the NGL factor value. 

Override NGL 
Factor 

Sets the NGL factor value to use in calculations when Override is 
selected in the NGL Factor Mode field. 

Selected NGL 
Factor 

This read-only field shows the current NGL factor value, based on the 
selected options, used in calculations. 

Flash Gas 
Factor 

Sets how the system acquires the flash gas factor value. The flash gas 
factor is the ratio of the flash gas at metering conditions to the 
hydrocarbon liquids at base conditions. Possible options are: 

Measured The system uses a parameter you configure in the 
Flash Gas Factor Parameter field to acquire the value. 

Note 

The system ignores negative or invalid flash gas factor 
values and uses a value of 0 instead. 

Override The system uses the value you define in the Override 
NGL Factor field. 

Flash Gas 
Factor 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the flash gas factor value. 

Override 
Flash Gas 
Factor 

Sets the flash gas factor value to use in calculations when Override is 
selected in the Flash Gas Factor Mode field. 

Selected 
Flash Gas 
Factor 

This read-only field shows the current flash gas factor value, based on 
the selected options, used in calculations. 

2. Select Next to advance to the next step in the Guided Setup. 
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4.2.18 Guided Setup: Liquid Linear Meter 

Use this display to configure parameters for the selected liquid linear meter.  

Note 

You can right-click on a Liquid Linear Meter node in the navigation tree to copy or paste 
the configuration of one meter to another. 

 

 

Figure 91. Guided Setup: Liquid Linear Meter 
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1. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
meter. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
meter. 

No Flow 
Option 

Sets how the system calculates a "no flow" condition for the meter. 
Possible options are: 

Time 
Between 
Pulses / 
Increments 

If the amount of time between pulses/increments is 
greater than or equal to the time you enter in the text 
field, then system sets the calculated flow equal to 
zero. 

Note 

• This option applies only if you select a PI object in 
the Flow Rate Parameter field. 

• You must enter a time (in seconds) for the system 
to use in the text field. 

• The label of this option changes based on your 
selection in the Flow Input Option field of the 
Liquid Linear Meter display accessed through 
the Details button. If you select Flow Input Only, 
then the label shows Time Between Pulses. If 
you select External Accumulator or External 
Accumulator with Flow Rate, then the label 
shows Time Between Increments. 
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Field Description 

Flow Cut-off If the value of the uncorrected volume or mass input 
is less than or equal to the value you enter in the text 
field, then the system sets the calculated flow rates 
equal to zero. Enter a value (in units based on the 
table below) for the system to use in the text field.  

Indicated 
Flow  
Input Type 

Meter 
Type Unit Type 

Pulse Input 
Turbine Hz 

Coriolis Hz 

AI or User 
Data 

Turbine  
Volume 
Rate 

Coriolis Mass Rate 

Note 

• You must enter a value (in the indicated units) in 
the text field for the system to use. 

• The lowest frequency the system can 
accurately measure is 1 divided by the PI Scan 
Period (configured on the Pulse Input display). 
Flow control may be erratic below this threshold. 

Flow Cut-off 
with 
accumulation 

If the value of the uncorrected volume or mass input 
is less than or equal to the value you enter in the text 
field, then the system sets the calculated flow rates 
equal to zero, but any accumulations are still counted.  

Note  

• You must enter a value (in the indicated units) in 
the text field for the system to use. 

• For details on the unit types used by different 
indicated flow input and meter types, refer to the 
table in the Flow Cut-off field description. 

Meter Type Specifies the type of liquid linear meter you are configuring. Possible 
options are: 
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Field Description 

Turbine Select if measuring flow through a turbine meter or 
other linear meter with a frequency or analog signal 
representing actual volumetric flow rate. 

Coriolis Select if measuring flow through a Coriolis meter or 
other linear meter with a frequency or analog signal 
representing a mass flow rate. 

Ultrasonic Select if measuring flow through an ultrasonic meter. 
This meter type option performs the same flow 
calculations as the Turbine option, and this option is 
provided for equipment identification. CFX files 
generated by FBxConnect™ include this option in the 
configuration section of the CFX file. 

Positive 
Displacement 

Select if measuring flow through a positive 
displacement meter. This meter type option performs 
the same flow calculations as the Turbine option, and 
this option is provided for equipment identification. 
CFX files generated by FBxConnect™ include this 
option in the configuration section of the CFX file. 

Flow Type Click ▼ to specify the type of flow rate you are measuring through the 
meter. Possible options are: 

Note 
This field appears only if you select Coriolis in the Meter Type field. 

Volume Select if you are measuring volume flow rate. 

Mass Select if you are measuring mass flow rate. 

Pressure 
Transmitter 
Type 

Indicates the type of static pressure transmitter (absolute or gauge) 
configured for the selected meter. 

Note 

This field appears only if you select a User Data instance in the Static 
Pressure I/O Definition field. 

Details Select this button to open the Liquid Linear Meter display. Select  

to return to Guided Setup. 
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Field Description 

Meter Factor 
/ K-factor 
Curve 
Option 

Sets how system uses calculates K-factors or Meter Factors in the flow 
calculation. Possible options are: 

Single Meter 
Factor / 
Single K-
factor 

Uses a single Meter Factor and a single K-factor for 
the meter. This is the simplest choice and means that 
a value for the meter factor and a value for the K-
factor are fixed for all flow rates and the values are 
taken from the last prove or an entered value. Select 
this option when using either the K-factor or meter 
factor proving, as long as neither the K-factor or 
meter factor will vary with flow rate or product. 

Meter Factor 
Curve / Single 
K-factor 

A meter factor calculates for the current flow rate 
based on a linear interpolation of the meter factor 
versus flow rate values entered under the Factor 
Curve heading, but the K-factor will be fixed. Select 
this option when using meter factor proving if 
proving is done at multiple flow rates. 

Single Meter 
Factor / K-
factor Curve 

A K-factor calculates for the current flow input 
frequency based on a linear interpolation of the 
meter factor versus frequency values entered under 
the Factor Curve, but the meter factor will be a single 
value from the last prove or entered value. The K-
factor curve can come from multiple proves at 
different flow rates with a meter factor of 1.0 (K-factor 
proving) or the K-factor curve can come from factory 
calibration and a single meter factor from a prove 
(meter factor proving). 

Override 
Meter Factor 

Sets a fixed meter factor value to use in calculations. 

Note 

This field appears only if you select either Single Meter Factor / Single 
K-factor or Single Meter Factor / K-factor Curve in the Meter Factor 
/ K-factor Curve Option field. 
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Field Description 

Override K-
factor 

Sets a fixed discharge coefficient value to use in calculations. 

Note 

This field appears only if you select either Single Meter Factor / Single 
K-factor or Meter Factor Curve / Single K-factor in the Meter Factor 
/ K-factor Curve Option field. 

Flow Rate 
Parameter 

I/O Definition Click  to open a Point Picker dialog and select a 

flow rate input to use for the selected meter. This field 
represents the Pulse Frequency for a Turbine or 
Coriolis meter type. 

• PI object – RATE or SELECTED FREQUENCY 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to 
AI. 

• User Data – Any parameter. For more 
information, refer to User Data. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units used 
for the selected input. 
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Field Description 

Static 
Pressure 
Object 

I/O Definition Click  to open a Point Picker dialog and select the 

static pressure input to use for the selected meter. 

If you select a Press object, the firmware determines 
the pressure input type (absolute or gauge) directly 
from the sensor. 

If you select an AI object, the firmware determines 
the pressure input type from the configurable Units 
Type selection that is associated with the selected 
analog input.  

If you select a User Data object, you must indicate 
the pressure input type in the Pressure Transmitter 
Type field. The value is assumed to be in the pressure 
units selected for the associated station. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 

• Press object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to 
AI. 

• User Data – DOUBLE FLOATING POINT 2. For 
more information, refer to User Data. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 
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Field Description 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units used 
for the selected input. 

Flowing 
Temperature 
Object 

I/O Definition Click  to open a Point Picker dialog and select the 

flowing temperature input to use for the selected 
meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 

• RTD object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to 
AI. 

• User Data – DOUBLE FLOATING POINT 3. For 
more information, refer to User Data. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 
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Field Description 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units used 
for the selected input. 

Meter Density 
Parameter 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

flowing temperature input to use for the selected 
meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to 
AI. 

• User Data – Any parameter. For more 
information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 
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Field Description 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Units This read-only field shows the engineering units used 
for the selected input. 

Note 
This field appears only in certain configuration scenarios: 

• If the selected meter is assigned to a Station where the Liquid 
Product Reference is configured with a Liquid Product Type set 
to Crude Oil (configured on the Liquid Product display), the 
Density Option is set to Meter Observed Density, and the 
Crude Oil Option is set to API Ch. 12.2 or API Ch. 20.1 with Use 
Oil Correction Factor for Water. 

• If the selected meter is assigned to a Station where the Liquid 
Product Reference is configured with a Liquid Product Type set 
to Crude Oil (configured on the Liquid Product display), the 
Crude Oil Options is set to API Ch. 20.1 and Use Separate 
Correction Factor for Water, and the Meter Type is set to 
Coriolis. 

• If the selected meter is assigned to a Station where the Liquid 
Product Reference is configured with a Liquid Product Type set 
to anything other than Crude Oil (configured on the Liquid 
Product display) and the Density Option is set to Meter 
Observed Density. 

Apply Select to apply the currently selected meter configuration to all other 
meters with the same meter type. 

Note 

This field appears only for the first instance of multiple meters with the 
same meter type. 

2. Select Next to advance to the next step in the Guided Setup.  
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4.2.19 Guided Setup: Liquid Meter Curve Setup 

Use this display to enter a meter factor curve or K-factor curve. 

Figure 92. Guided Setup: Liquid Meter Curve Setup 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

K-factor / 
Frequency 

If you selected Meter Factor Curve / Single K-factor on the 
previous display, enter up to 20 points on the curve (pairs of meter 
factor and flow rate) and a meter factor is calculated for use in the 
flow equation by linear interpolation of the current indicated 
quantity flow rate. 

Meter Factor / 
Flow Rate 

If you selected Single Meter Factor / K-factor Curve on the 
previous display, enter up to 20 points on the curve (pairs of K-factor 
and frequency) and a K-factor is calculated for use in the flow 
equation by linear interpolation of the current flow meter input 
frequency. 
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Note 

A valid point must have a non-zero flow rate/frequency and a non-zero factor. The points 
may be entered in any order and will be internally sorted by flow rate (MF curve) or 
frequency (K-Factor Curve), discarding any invalid points. No extrapolation is done beyond 
the lowest and highest points on the curve. If the flow rate/frequency is less than the 
lowest point on the curve, the calculated factor will be the factor for the lowest point on 
the curve. If the flow rate/frequency is greater than the highest point on the curve, the 
calculated factor will be the factor for the highest point on the curve. 

2. Select Next to advance to the next step in the Guided Setup. 

4.2.20 Guided Setup: Default Meter History Setup 

Use this display to configure history points in your FB3000 RTU using the default history 
values. 

Note 

• For more information about the structure of history stored in the FB Series products, 
refer to History Overview.  

• If liquid batching is enabled on any meters, then you cannot configure history using 
the Guided Setup Wizard. In this case, you must use the standard Default History 
Setup display to configure history. 
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Figure 93. Guided Setup: Default Meter History Setup 

 

1. Review – and change as necessary – the values in the following fields: 

Field Description 

Do you want 
to setup 
default 
history for all 
meters? 

Sets if you want the default history configuration applied to all 
meters configured in the FB3000. 

No FBxConnect™ does not configure history for any 
meters in the FB3000. 

Yes FBxConnect™ configures the default history for all 
meters in the FB3000. 

Do you want 
components 
averaged and 
archived? 

Sets if you want the FB3000 to average and archive components in 
history. 

No Components are not averaged and archived in 
history. 

Yes – 
Standard 
Composition 

The FB Series product archives standard composition 
component averages for gas meters. 
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Field Description 

Yes – 
Extended 
Composition 

The FB Series product archives extended composition 
(includes C7, C8, C9, and C10) component averages 
for gas meters. 

Total Num of 
Available 
Standard 
Points 

This read-only field shows the total number of history points 
allocated to the standard group both before (Current) and after (Post 
Setup) applying the default history setup.  

Number of 
Points used 
for Meter 
History 
Groups 

This read-only field shows the total number of history points 
allocated to the station history groups both before (Current) and 
after (Post Setup) applying the default history setup.  

Standard 
General 
Current Num 
of Pts 

This read-only field shows the total number of history points 
allocated to the standard group both before (Current) and after (Post 
Setup) applying the default history setup.  

2. Select Finish to complete the Guided Setup. A confirmation message opens. 

Note 

A message appears if have previously sized history and the FB Series product does not 
have the number of history points required to perform the default history setup. If this 
occurs, you must first increase the number of points on the History Setup – Advanced – 
Standard History Sizing Tab before you perform the default history setup. 

3. Select Yes to save the configuration and exit the Guided Setup. 

Figure 94. Finish Confirmation 
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4.3  Engineering Units 

Use this display to configure the engineering units used by the station for measurements. 
You can select Set all to US/Imperial, Set all to Metric, Set all to Canadian, or configure 
each measurement type individually. You can also configure how many decimal places are 
used for each measurement value. 

Conversion factors for the different engineering units are taken from the following 
standards: 

• IEEE/ASTM SI 10-2002 - IEEE/ASTM Standard for Use of the International System of 
Units (SI): The Modern Metric System 

• Manual of Petroleum Measurement Standards Chapter 15—Guidelines for the Use of 
the International System of Units (SI) in the Petroleum and Allied Industries 

• ANSI/API MPMS Ch. 14.3.3/AGA Report No. 3 

Note 

• FB Series products use full-resolution data for all calculations. The Decimal 
Places fields on this display are used only for viewing data in FBxConnect™ 
Configuration Software. 

• Fields on this display differ based on what fluid type the selected station is measuring 
(Natural Gas or Liquid). 

• Changes to engineering units are applied to the station and all meters assigned to the 
selected station, even if a meter has previously been configured. Additionally, any I/O 
associated with the station or its meters is also updated. Refer to Configure – 
Summary to view which meters are assigned to each station. 

• You can configure the number of decimal places shown on history reports using the 
Settings menu option in the Field Tools menu bar. 

Molar mass units are dependent upon the density units: 

Density Unit  Molar Mass Unit 

lb/ft³  lb/lb-mol 

lb/MMCF  lb/lb-mol 

lb/US gal  lb/lb-mol 

lb/bbl  lb/lb-mol 

RD  lb/lb-mol 
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Density Unit  Molar Mass Unit 

°API  lb/lb-mol 

kg/m³  kg/kmol 

kg/L  kg/kmol 

g/cc  g/mol 

 

Joule Thomson units are dependent upon the pressure units: 

Pressure Unit  Joule Thompson 
Unit 

psi  °F/psi 

kPa  K/kPa 

bar °C/bar 

MPa  K/MPa 

kg/cm²  K/MPa 

 

Acceleration units are dependent upon the linear long units: 

Linear Long Unit  Acceleration Unit 

ft  ft/s² 

m  m/s² 

Note 

The 4088B does not support temperature units of Kelvin. 

To access this display: 

1. Select Configure > Engr Units. from the FBxConnect™ main menu. The Engineering 
Units display opens: 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

193 

Figure 95. Engineering Units (Gas Station shown) 

 

2. Click ▼ in the Station drop-down list to select the station to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Set all to 
US/Imperial 

Select to automatically configure the selected station to use 
US/Imperial units for all measurements and calculations. 

Set all to 
Metric 

Select to automatically configure the selected station to use metric 
units for all measurements and calculations. 
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Field Description 

Set all to 
Canadian 

Select to automatically configure the selected station to use Canadian 
units for all measurements and calculations. 

Meter Inputs Select ▼ to choose the measurement units used with each meter 
input and the number of decimal places shown in FBxConnect™. 
Meter Inputs include differential pressure units, static pressure units, 
and temperature units. 

Totals Select ▼ to choose the measurement units used when calculating 
totals and the number of decimal places shown in FBxConnect™. 
Totals include gas volume units, energy units, mass units, liquid 
volume units, water volume units, and flow time units. 

Rates Select ▼ to choose the measurement units used when displaying 
rates and the number of decimal places shown in FBxConnect™. 
Rates include volume units, energy units, mass units, liquid volume 
units, and water volume units, 

Fluid Select ▼ to choose the measurement units used when performing 
fluid calculations and the number of decimal places shown in 
FBxConnect™. Fluid properties include dynamic viscosity, density, 
volume-based heating value, mass-based heating value, liquid 
density, and water density. 

Length Select ▼ to choose the measurement units used for distance and the 
number of decimal places shown in FBxConnect™. Length includes 
linear short and linear long. 

K-Factor Select ▼ to choose the measurement units used when calculating the 
K-factor and the number of decimal places shown in FBxConnect™. K-
factor includes volumetric and mass. 

Other Select ▼ to choose the measurement units used for other 
calculations, including water content, and the number of decimal 
places shown in FBxConnect™. 

Reset Decimal 
Places 

Select to revert all measurement units to show the default number of 
decimal places in FBxConnect™. 

4. Select Save to save any changes you make to this display. 
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4.4  Point Picker 

Use this display to view internal database parameters in the FB Series product. 

Note 

Refer to User Interface – Point Picker for more information. 

To access this display: 

1. Select Configure > Point Picker from the FBxConnect™ main menu. The Point Picker 
dialog opens. 

Figure 96. Point Picker (Parameter Reference) 

 

2. Review the values in the following fields: 

Field Description 

Filter Select ▼ to change which objects and parameters are displayed. 
Filters may be based on object type, measurement type, or data 
type. 

Note  
Select No Filter to view all available Objects. 
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Field Description 

Object and 
Instances 

Object A group of configuration settings and calculated or 
measured values related to a specific function. For 
example, all values associated with the device clock 
(second, hour, day, etc.) are part of an Object named 
Clock. From the first column, select the object type you 
wish to reference. 

Instance There may be one or more occurrences of each type of 
object with its own set of configuration settings and 
values. Each occurrence of an object is called an 
instance. For example, there are multiple instances of 
the object named Comm, and each instance represents 
one of the FB Series product’s communication ports. 
After clicking on the object you wish to reference, the 
available instances are displayed. Select the instance 
you wish to reference. 

Parameter One of the configuration settings, calculated values, or measured 
values that is a part of the object. Each parameter has a value as 
well as a set of attributes that define it, such as data type, R/W 
access, measurement type, units, and parameter health. After 
clicking on the object and instance you wish to reference, the 
available parameters are displayed. Select the parameter you wish 
to reference. 

Note 

This column appears only if you select the Point Picker for a 
Parameter Reference. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

197 

Field Description 

Referenced 
Parameter 

If the point picker is used to pick a parameter reference, you can 
pick a parameter directly from the object to which it belongs, or you 
can pick the parameter through an object reference in a related 
object. For instance, to pick a parameter to assign to an Average 
object, you can pick the DP Mtr_1 object and the Station 
Assignment parameter and then the third column displays all of the 
parameters that are available from the Station object that is 
assigned to DP Mtr_1. This is useful because even if the station 
assignment later changes, the Average object is always associated 
with DP Mtr_1. 

Note 

This column appears only if you select the Point Picker for a 
Parameter Reference. 

Tag This read-only field shows the name of the selected parameter. 

Data This read-only field shows the data type of the selected parameter. 
For more information, refer to Native Data Types. 

Access This read-only field shows the read/write access of the selected 
parameter. 

Value This read-only field shows the value of the selected parameter. 

Collect Tag 
Names 

Select this button to query the FB Series product and display any 
unique tag names you have assigned to individual parameters. 

Note 

You can perform this action at any time to reflect recent 
configuration changes. 

Copy Tag Select this button to copy the currently selected tag to the 
computer's clipboard. You can then paste the selected tag into a 
different application, such as FBxDesigner™. 

3. Select Close to exit the Point Picker dialog. 

4.5 I/O Setup 

The I/O Setup drop-down menu provides an interface to configure each I/O point. Each 
I/O type is configured using a separate display. 

To access these configuration displays: 
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1. Select the Configure menu 

2. Select the down arrow (▼) next to I/O Setup. 

3. Select the I/O type you want to configure. 

Figure 97. I/O Setup Drop-Down Menu 

 

The I/O Setup drop-down menu contains the following options (depending on your 
hardware specifications and current configuration): 

I/O Configuration – Use this display to configure the I/O type (AI/AO/DI/DO/PI) and to 
view module properties. 

MVS Setup – Use this display to enable communications with 4088B multivariable 
transmitters on either COM3 or COM4 of your FB3000 RTU. 

MVS Configuration – Use this display to view and configure various parameters of a 
multivariable sensor. 

HART I/O –Use this display configure a HART® module to process input from field-based 
HART devices. 

Differential Pressure – Use this display to view and configure general parameters 
associated with the differential pressure input. 

Pressure – Use this display to view and configure general parameters associated with the 
static pressure input. 
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RTD – Use this display to view and configure general RTD parameters. 

MV Sensor – Use this display to view multivariable sensor values and properties for both 
the integral sensor and 4088B. 

AI – Use this display to configure the analog inputs (AI). 

AO – Use this display to configure analog outputs (AO). 

DI – Use this display to configure digital inputs (DI). 

DO – Use this display to configure digital outputs (DO). 

PI – Use this display to configure pulse inputs (PI). 

User Data – Use this display as a generic data storage area that any application can use. 

4.5.1 I/O Configuration 

Use the I/O Configuration display to configure the type of inputs and outputs available on 
your FB Series product and to view module properties. 

To access this display, select Configure > I/O Setup > I/O Configuration from the 
FBxConnect™ main menu. 

Figure 98. I/O Setup – I/O Configuration 
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The I/O Configuration display has the following tabs: 

General – Use this tab to configure the type of inputs and outputs available on your FB 
Series product. 

Properties – Use this tab to view details of the modules installed in your FB Series product, 
including the module type and the number of channels available on the module.  

4.5.1.1 I/O Configuration – General Tab  

Use the General tab on the I/O Configuration display to select what input and output 
types are available on your FB Series product. 

Note 

A separate I/O Configuration display is available for each installed module. The amount of 
I/O points and available fields shown on this display varies depending on the device type 
and installed options. 

To access this display: 

1. Select Configure > I/O Setup > I/O Configuration. The I/O Configuration display 
opens showing the General tab. 
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Figure 99. I/O Configuration – General Tab 

 

2. Click ▼ in the drop-down list at the top of the display to select a I/O module slot to 
configure. 

3. Review – and change as necessary – the values in the following fields:  

Field Description 

Module Type This read-only field shows the I/O module type installed in the 
selected slot. 

8AIDIPI 2AO 
2DO 

The 8AIDIPI 2AO 2DO module (3MIX12) provides eight input channels 
and four output channels. You can configure each input channel as 
either an analog input (AI), a digital input (DI), or a pulse input (PI). 
The output channels are comprised of two analog outputs (AO) and 
two digital outputs (DO).  
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Field Description 

Inputs Sets each input channel as either an analog input, a 
digital input, or a pulse input.  

Note 

Select either All AI, All DI, or All PI to configure all input 
channels as either AI, DI, or PI respectively.  

Outputs Shows the available output channels on the selected I/O 
module. 

IO Loop 
Power 
Control 

Enables or disables the 24-Volt loop power feature. 

8AODO The 8AODO module provides eight output channels. You can 
configure each output channel as either an analog output (AO) or a 
digital output (DO). 

Outputs Sets each output channel as either an analog output or 
a digital output. 

Note 

Select All AO or All DO to set all channels as either 
analog outputs or digital outputs, respectively. 

16DIPI The 16DIPI module provides sixteen input channels. You can configure 
each input channel as either a digital input (DI) or a pulse input (PI). 

Outputs Sets each input channel as either a digital input or a pulse 
input. 

Note 

Select All DI or All PI to set all channels as either digital 
inputs or pulse inputs, respectively. 

HART 4 The HART 4 module (HRT04) provides four input/output channels 
used to communicate with HART devices using the HART protocol. 
You can configure each channel as either an analog input (AI) or 
analog output (AO). A channel set as an input can be configured for 
use in point-to-point or multi-drop mode. A channel set as an output 
can be configured for use in point-to-point mode only. 

Analog Sets each channel as either and analog input (AI) or 
analog output (AO). 
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Field Description 

4 COMM 
Module 

The 4-port serial communications module (COM04) provides 
additional serial communication channels beyond those available on 
the CPU module. 

Note 

To make configuration changes to this module, refer to 
Communications – General. 

I/O Import 
Export 

Select this button to import a CSV file containing a new I/O 
configuration or export you current I/O configuration to a CSV file. 
For more information, refer to Importing I/O Configuration CSV Files, 
Exporting I/O Configuration CSV Files, and Creating I/O Configuration 
CSV Files. 

4. Select Save to save any changes you make to this display. 

4.5.1.2 I/O Configuration – Properties Tab  

Use this tab to view details of the modules installed in your FB Series product, including 
the module type and the number of channels available on the module. You can also reset 
the message counters of each module. 

To access this tab: 

1. Select Configure > I/O Setup > I/O Configuration. The I/O Configuration display 
opens. 

2. Click ▼ in the drop-down list at the top of the display to select a I/O module slot to 
configure. 

3. Select the Properties tab. 
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Figure 100. I/O Configuration – Properties Tab 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Module Type This read-only field shows the kind of module installed in the FB 
Series product. 

Module Mode This read-only field shows the operational status of the module. 
Possible statuses are: 

Not Installed No module is installed in the selected module slot. 

Boot The selected module is operating in startup mode 
(boot), and will not function properly until the 
module firmware is loaded. 

Normal The selected module is operating as expected. 
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Field Description 

Not Licensed No license for the selected module exists on the FB 
Series product. The module will not run. 

Communication 
Failure 

The selected module slot is known to contain a 
module, but the module is no longer 
communicating with the main CPU module. 

Module Failure The selected module has failed and requires 
service. 

Termination 
Missing 

The selected module slot does not contain the 
required termination module. 

Firmware 
Mismatch 

The CPU firmware version and the module 
firmware version are not compatible. Firmware for 
one (or both) module must be upgraded. 

Note 

For CPU firmware version 2.1 or lower, the Module Mode field toggles 
between Normal, Communication Failure, and Boot if the CPU 
firmware version does not match with the I/O module firmware 
version. 

Installed This read-only field shows the installation status of the module. 

Module 
Licensed 

This read-only field shows if a license is present in the FB Series 
product for the module.  

Number of 
Channels 

This read-only field shows the number of channels present on the 
module. 

Number of 
Good 
Messages 

This read-only field shows the number of messages successfully 
received by the module. 

Number of 
Bad 
Messages 

This read-only field shows the number of messages that failed to be 
received by the module. 

Reset 
Message 
Counters 

Click to reset to zero the number of good and the number of bad 
messages. 

Note 

Each Reset Message Counters button affects only the selected 
module. 
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Field Description 

I/O Import 
Export 

Select this button to import a CSV file containing a new I/O 
configuration or export you current I/O configuration to a CSV file. For 
more information, refer to Importing I/O Configuration CSV Files, 
Exporting I/O Configuration CSV Files, and Creating I/O Configuration 
CSV Files. 

5. Select Save to save any changes you make to this tab. 

4.5.1.3 IO Import Export 

Use this pop-up display to import or export CSV files that contain the I/O configuration for 
your FB Series product. The FB Series product uses one CSV file that contains information 
about all modules in the configuration (module type, rack location, and channel 
information) and separate CSV files that contain the configuration information for each 
I/O type (analog inputs, analog outputs, digital inputs, digital outputs, and pulse inputs). 

Note 

For more information about creating your own I/O configuration CSV file, refer to 
Creating I/O Configuration CSV Files. 

To access this pop-up display: 

1. Select Configure > I/O Setup > I/O Configuration. The I/O Configuration display 
opens. 
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Figure 101. IO Import Export 

 

2. Select the IO Import Export button. The IO Import Export pop-up display opens. 

Figure 102. IO Import Export 

 

3. Use the buttons on this display to perform the following actions: 
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Field Description 

Import CSV Click to import a CSV file into your FB Series product that contains 
your desired I/O configuration. Navigate to the folder location that 
contains the CSV files and select OK to start the import process. For 
more information, refer to Importing I/O Configuration CSV Files. 

Note 

The system verifies the integrity of the CSV and asks for confirmation 
before continuing if any errors are found. 

Export CSV Click to save CSV files to your computer that contains the current I/O 
configuration of your FB Series product. A Select Table dialog opens 
where you can select which I/O modules and which I/O types to 
include in the export. Click Start, navigate to a folder on your 
computer where the CSV files will be saved, and click OK to begin the 
export process. For more information, refer to Exporting I/O 
Configuration CSV Files. 

Open Log Click to open the ImportExportLogs folder on your computer that 
contains FBxConnect™ import/export error logs. Any errors 
encountered when importing a CSV file are stored in a log in this 
folder. 

Note 

Log file name includes the date and time the log was created. 

4. Select Close to exit the pop-up display. 

4.5.1.3.1 Importing I/O Configuration CSV Files 

You can import CSV files that contain the I/O configuration for your FB Series product. The 
FB Series product uses one CSV file that contains information about all modules in the 
configuration (module type, rack location, and channel information) and separate CSV 
files that contain the configuration information for each I/O type (analog inputs, analog 
outputs, digital inputs, digital outputs, and pulse inputs). 

Note 

• For more information about creating your own I/O configuration CSV file, refer to 
Creating I/O Configuration CSV Files. 

• For more information about exporting a CSV file that contains the FB Series product's 
current I/O configuration, refer to Exporting I/O Configuration CSV Files. 
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• If you want to remove a previously imported I/O configuration, perform a Cold Start 
and select Database is re-initialized with factory defaults. 

To import I/O Configuration CSV files: 

1. Select Configure > I/O Setup > I/O Configuration. The I/O Configuration display 
opens. 

2. Select the IO Import Export button. The IO Import Export pop-up display opens. 

Figure 103. IO Import Export 

 

3. Select the Import CSV button. 

Figure 104. Browse For Folder 

 

4. Navigate to the folder with your I/O configuration CSV files and select OK. The Select 
CSV File display opens showing the available I/O configuration CSV files in the selected 
folder. 
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Note 

In order to successfully import any I/O Configuration CSV files, the folder you select must 
include one I/O Config CSV file and no more than one CSV file for each I/O type (analog 
inputs, analog outputs, digital inputs, digital outputs, and pulse inputs). 

Figure 105. Select CSV Files 

 

5. Place a check mark next to the CSV files you want to import. 

Note 

The IO Config File is always selected. 

6. Select Start to import the selected files. The files are downloaded, the FB Series 
product performs a warm start, and a confirmation message opens. 

Note 

• The system verifies the integrity of the CSV and asks for confirmation before 
continuing if any errors are found. If you select Import removing invalid 
parameters, any invalid lines in the CSV file are ignored and data currently in the FB 
Series device is maintained. 
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Figure 106. Example Import I/O Errors 

 

• Low Reading EU and High Reading EU values are not imported for online devices 
with AI channels where the EU Scaling Mode is set to Multi-Point Calibration. 

7. A confirmation message displays after importing the CSV. Select OK to complete the 
process. 

Figure 107. Import Successful 

 

4.5.1.3.2 Exporting I/O Configuration CSV Files 

You can export the current I/O configuration of your FB Series product as CSV file saved to 
your computer. You can then modify the files on your computer or import them into 
another device. The FB Series product uses one CSV file that contains information about 
all modules in the configuration (module type, rack location, and channel information) 
and separate CSV files that contain the configuration information for each I/O type 
(analog inputs, analog outputs, digital inputs, digital outputs, and pulse inputs). 

Note 

• For more information about creating your own I/O configuration CSV file, refer to 
Creating I/O Configuration CSV Files. 
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• For more information about importing a CSV file that contains the FB Series product's 
current I/O configuration, refer to Importing I/O Configuration CSV Files. 

To export I/O Configuration CSV files: 

1. Select Configure > I/O Setup > I/O Configuration. The I/O Configuration display 
opens. 

2. Select the IO Import Export button. The IO Import Export pop-up display opens. 

Figure 108. IO Import Export 

 

3. Select the Export CSV button. The Select Table pop-up display opens. 

Figure 109. Select Table 
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4. Place a check mark next to each module slot whose configuration you want to export. 

Note 

A single CSV file is created for all selected modules. 

5. Place a check mark next to each I/O type (Export ALL, AI, AO, DI, and/or DO) whose 
configuration you want to export. 

Note 

Separate CSV files are created for each selected I/O type. 

6. Place a check mark next to Alarm if you want to include alarm configuration data in 
the CSV files for each selected I/O type. 

7. Select Start. A Browse For Folder windows opens. 

Figure 110. Browse For Folder 

 

8. Navigate to the folder where the I/O configuration CSV files will be saved and Select 
OK to begin the export process. 

Note 

Each time you export I/O configuration CSV files, save the files to a unique folder that 
does not contain any other I/O configuration CSV files. 
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9. When the process completes, a confirmation dialog opens. Select OK. 

Figure 111. Confirmation 

 

4.5.1.3.3 Creating I/O Configuration CSV Files 

You can create a CSV file that contains your I/O configuration on your computer and then 
import the CSV file for use in the FB Series product. If your I/O configuration contains a 
large number of channels, it may be easier to create a CSV file on your computer than it is 
to configure each I/O channel individually in FBxConnect™. The FB Series product uses 
one CSV file that contains information about all modules in the configuration (module 
type, rack location, and channel information) and separate CSV files that contain the 
configuration information for each I/O type (analog inputs, analog outputs, digital inputs, 
digital outputs, and pulse inputs). 

Note 

• The system automatically corrects for incorrect capitalization and missing special 
characters, such as the degree symbol (°) and superscripts (3), in the created I/O 
configuration CSV files. This means you can enter F or C without the degrees symbol 
in the I/O configuration CSV file and the system automatically corrects the entry to °F 
or °C, and you can enter KG/M3 or mpa(a) and the system automatically corrects the 
entry to kg/m3 or MPa(a). 

• The easiest way to begin creating a custom map is to export I/O configuration CSV 
files that contain the current configuration and then edit that file. For more 
information about exporting a I/O Configuration CSV files, refer to Exporting I/O 
Configuration CSV Files. 
 
Figure 112. Example Analog Input Configuration CSV Format 
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To create CSV files that contain your I/O configuration: 

1. Open a blank spreadsheet (or open a previously exported I/O configuration CSV file). 

2. Review – and change as necessary – the values for each CSV file according to the 
tables below (I/O Configuration CSV File Format, Analog Input CSV File Format, Analog 
Output CSV File Format, Digital Input CSV File Format, Digital Output CSV File Format, 
and Pulse Input CSV File Format): 

I/O Configuration CSV File Format 

The I/O configuration CSV file contains information for all I/O modules in the 
configuration, including the module type, installation location, and IO type configuration 
for each channel. Each row corresponds to a different channel on the module. 

Note 

• All columns must be present in the I/O Configuration CSV file. 

• The I/O configuration CSV file must include _IOConfig_ in the file name in order to be 
successfully imported. 

• The system ignores any invalid lines in the CSV file and data currently in the FB Series 
device is maintained. 

 

Column Heading Description 

Channel Rack position of the module and channel number. 

Card Type Identifies the type of I/O module installed. Possible options are: 

• 4 COMM 

• 8AIDIPI 2AI 2DO 

• 8AODO 

• 16DIPI 

• HART 4 

Selected IO Type Sets the input or output type for the selected channel. Possible 
options are: 

4 COMM Module 

None 
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Column Heading Description 
8AIDIPI 2A0 2DO Module 

Channels 1 through 8 

• AI 

• DI 

• PI 

Channels 9 and 10 

• AO 

Channels 11 and 12 

• DO 

8AODO Module 

Channels 1 through 8 

• AO 

• DO  

16DIPI Module 

Channels 1 through 16 

• DI 

• PI  

HART 4 Module 

Channels 1 through 4 

• AI 

• AO 

 

Analog Input CSV File Format 

The analog input CSV file contains  

Note  

• The Channel column must be present in the Analog Input CSV file. All other columns 
are optional. 

• The I/O configuration CSV file must include _AI_ in the file name in order to be 
successfully imported. 
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Column Heading Description 

Channel Rack position of the module and channel number. 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected channel. 

DESC Sets a description (up to 20-alphanumeric characters) for the 
selected channel. 
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Column Heading Description 

UNITS_TYPE Sets the measurement type used for the selected channel. 
Possible options are: 

• Unitless  

• Absolute Pressure 

• Temperature 

• Gas Density 

• Volume Heating Value 

• Dynamic Viscosity 

• Linear (Short) 

• Linear (Long) 

• Gas Volume Rate 

• Mass Rate 

• Energy Rate 

• Current 

• Voltage 

• Percentage 

• Acceleration 

• Water Content 

• Resistance 

• Differential Pressure 

• Gauge Pressure 

• Mass Heating Value 

• Liquid Density 

• Water Density 

• Liquid Volume 

• Water Volume 

• Liquid Rate 

• Water Rate 

• Relative Density 

Note 

If you populate this column, you must also populate the UNITS 
column. 
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UNITS Sets the engineering units used for the selected channel. Options 
change based the selected UNITS_TYPE option. Possible options 
are: 

Unitless 

• N/A 

Absolute Pressure 

• psi(a) 

• kPa(a) 

• MPa(a) 

• bar(a) 

• kg/cm2(a) 

Temperature 

• °F 

• °C 

• K 

Gas Density 

• lb/ft3 

• kg/m3 

• g/cc 

• lb/MMCF 

• lb/US gal 

• kg/L 

• lb/bbl 

• RD(liq) 

• °API 

Volume Heating Value 

• Btu/ft3 

• MJ/m3 

Dynamic Viscosity 

• cP 

• lb/ft-s 

Linear (Short) 

• in 

• mm 
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Linear (Long) 

• ft 

• m 

Gas Volume Rate 

• ft3/s 

• ft3/min 

• ft3/h 

• ft3/d 

• MCF/s 

• MCF/min 

• MCF/f 

• MCF/d 

• m3/s 

• m3/min 

• m3/h 

• m3/d 

• (k)m3/s 

• (k)m3/min 

• (k)m3/h 

• (k)m3/d 

• MMCF/s 

• MMCF/min 

• MMCF/h 

• MMCF/d 

• BCF/s 

• BCF/min 

• BCF/h 

• BCF/d 

• L/s 

• L/min 

• L/h 

• L/d 

• US gal/s 

• US gal/min 
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• US gal/h 

• US gal/d 

• bbl/s 

• bbl/min 

• bbl/h 

• bbl/d 

Mass Rate 

• lb/s 

• lb/min 

• lb/h 

• lb/d 

• Mlb 

• kg/s 

• kg/min 

• kg/h 

• kg/d 

• tonne/s 

• tonne/min 

• tonne/h 

• tonne/d 

• ton/s 

• ton/min 

• ton/h 

• ton/d 

Energy Rate 

• Btu/s 

• Btu/min 

• Btu/h 

• Btu/d 

• MMBtu/s 

• MMBtu/min 

• MMBtu/h 

• MMBtu/d 

• J/s 
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• J/min 

• J/h 

• J/d 

• MJ/s 

• MJ/min 

• MJ/h 

• MJ/d 

• GJ/s 

• GJ/min 

• GJ/h 

• GJ/d 

• Dth/s 

• Dth/min 

• Dth/h 

• Dth/d 

• TJ/s 

• TJ/min 

• TJ/h 

• TJ/d 

• PJ/s 

• PJ/min 

• PJ/h 

• PJ/d 

Current 

• mA 

• A 

Voltage 

• V 

• kV 

Percentage 

• % 

• ppm 

Acceleration 

• ft/s2 
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• m/s2 

Water Content 

• lb/MMSCF 

• kg/(k)m3 

Resistance 

• ohms 

Differential Pressure 

• inH2O@60°F 

• inH2O@68°F 

• kPa 

• mbar 

• kg/cm2 

• psi 

• bar 

Gauge Pressure 

• psi(g) 

• kPa(g) 

• MPa(g) 

• bar(g) 

• kg/cm2(g) 

Mass Heating Value 

• Btu/lb 

• MJ/kg 

Liquid Density 

• lb/ft3 

• kg/m3 

• g/cc 

• lb/MMCF 

• lb/US gal 

• kg/L 

• lb/bbl 

• RD 

• °API 
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Water Density 

• lb/ft3 

• kg/m3 

• g/cc 

• lb/MMCF 

• lb/US gal 

• kg/L 

• lb/bbl 

• RD 

• °API 

Liquid Volume 

• ft3 

• m3 

• MCF 

• (k)m3 

• MMCF 

• BCF 

• L 

• US gal 

• bbl 

Water Volume 

• ft3 

• m3 

• MCF 

• (k)m3 

• MMCF 

• BCF 

• L 

• US gal 

• bbl 

Liquid Rate 

• ft3/s 

• ft3/min 

• ft3/h 
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• ft3/d 

• MCF/s 

• MCF/min 

• MCF/h 

• MCF/d 

• m3/s 

• m3/min 

• m3/h 

• m3/d 

• (k)m3/s 

• (k)m3/min 

• (k)m3/h 

• (k)m3/d 

• MMCF/s 

• MMCF/min 

• MMCF/h 

• MMCF/d 

• BCF/s 

• BCF/min 

• BCF/h 

• BCF/d 

• L/s 

• L/min 

• L/h 

• L/d 

• US gal/s 

• US gal/min 

• US gal/h 

• US gal/d 

• bbl/s 

• bbl/min 

• bbl/h 

• bbl/d 

Water Rate 
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• ft3/s 

• ft3/min 

• ft3/h 

• ft3/d 

• MCF/s 

• MCF/min 

• MCF/h 

• MCF/d 

• m3/s 

• m3/min 

• m3/h 

• m3/d 

• (k)m3/s 

• (k)m3/min 

• (k)m3/h 

• (k)m3/d 

• MMCF/s 

• MMCF/min 

• MMCF/h 

• MMCF/d 

• BCF/s 

• BCF/min 

• BCF/h 

• BCF/d 

• L/s 

• L/min 

• L/h 

• L/d 

• US gal/s 

• US gal/min 

• US gal/h 

• US gal/d 

• bbl/s 

• bbl/min 
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Column Heading Description 

• bbl/h 

• bbl/d 

Relative Density 

• RD 

Note 

If you populate this column, you must also populate the 
UNITS_TYPE column. 

CONV_TYPE Sets if the channel measures either current input, voltage input 
or is disabled. Possible options are: 

• Current – The channel measure current. 

• Voltage – The channel measures voltage. 

• Disabled – The channel is disabled. 

For channels on a HART module, the only available options are 
Disabled and Current. 

SCALE_MODE Specifies how the EU scaling parameters are determined. 
Possible options are: 

• Multi-Point Calibration – EU scaling parameters are 
determined by the calibration. You cannot modify the EU 
scaling parameters (Low Reading EU, High Reading EU, 
Adjusted A/D 0 Percent, Adjusted A/D 100 Percent) directly. 
You must use the calibration wizard to adjust the scaling of 
the AI.  

Note 

If you download a configuration file that has Multi-Point 
Calibration selected, the calibration on your device remains 
unchanged. 

• EU Scaling – EU scaling parameters are determined by the 
values you enter in the Low Reading EU, High Reading EU, 
Adjusted A/D 0 Percent, Adjusted A/D 100 Percent fields. 

Note 

If you download a configuration file that has EU Scaling 
selected, the existing calibration on your device is 
overwritten using the EU scaling parameters. 
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Column Heading Description 

LOW_EU Sets the low reading (in engineering units) that is equal to zero 
percent input. For example, if a temperature transmitter is 
connected to the analog input with a range of –40 to 160 degrees 
F, the Low field would be set to –40. 

Note 

If you enter a value in this column, you must also populate the 
CONV_TYPE column with either Voltage or Current and the 
SCALE_MODE column with EU Scaling. 

HIGH_EU Sets the high reading (in engineering units) that is equal to 100 
percent input. For example, if a temperature transmitter is 
connected to the analog input with a range of – 40 to 160 
degrees F, the High field would be set to 160. 

Note 

If you enter a value in this column, you must also populate the 
CONV_TYPE column with either Voltage or Current and the 
SCALE_MODE column with EU Scaling. 

USER_MODE Sets how the system acquires the value written to the Selected 
Value parameter under normal operation. Possible options are: 

• Live – The system copies the Live Value to the Selected Value 
parameter. 

• Override – The system copies the value set in the Override 
Value (OVRD) field to the Selected Value parameter. 

Note 

If a fault occurs and the operation mode (USER_MODE) is set 
to Override, the Selected Value parameter is set to the 
Override Value (OVRD) and is not set based on the Fault 
Mode. 

OVRD Sets the value (in engineering units) written to the Selected Value 
field when the Operation Mode is set to Override. 

FAULT_MODE Sets how the system acquires the value written to the Selected 
Value parameter when a fault occurs. Possible options are: 

• Fault – The system copies the value set in the Fault Value 
field to the Selected Value parameter. 

• Last Good – The system copies the value of the Last Good 
Value field to the Selected Value parameter. 
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Column Heading Description 

FAULT Sets the value (in engineering units) that is written to the Selected 
Value parameter when a fault occurs on the selected sensor and 
the Fault Mode is set to Fault. 

CLIP_MODE Sets if clipping occurs on the selected input. Clipping forces the 
Selected Value to stay within a range defined by the Low Clipping 
Limit and High Clipping Limit. Clipping is only applied when there 
is not a fault. Possible options are: 

• Enable – Clipping does occur. 

Note  

You must enter a value in the CLIP_LOW_LIMIT and 
CLIP_HIGH_LIMIT fields. 

• Disable – Clipping does not occur. 

CLIP_LOW_LIMIT When clipping (CLIP_MODE) is enabled, sets the lower limit of the 
Selected Value parameter. 

CLIP_HIGH_LIMIT When clipping (CLIP_MODE) is enabled, sets the upper limit of the 
Selected Value parameter. 

DAMPING_FACTOR Sets a time (in seconds) used to dampen the reading of the AI. 
Small fluctuations can occur with every reading. The damping 
time is used to give a value that is less prone to those 
fluctuations, based on the value previous read. A value of 0.0 will 
disable damping. 

AVG_PERIOD When the Operation Mode (USER_MODE) is set to Live, this field 
defines the period of time (in seconds) over which the Live Value 
will be averaged before it is written to the Selected Value. 

Alarm Tag Set an identifier (up to 20-alphanumeric characters) for the 
selected instance. 

ALM_DESC Set a description (up to 20-alphanumeric characters) for the 
selected instance. 

HIHI_ENB Sets if the system monitors the point for the specified the High 
High alarm limit (HIHI_LIM). Possible options are: 

• Enable – The system monitors the point for the specified 
alarm limit. 

• Disable – the system ignores the specified alarm limit. 
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HIHI_LIM Sets a limit value (in engineering units) to which the input must 
rise to generate a High High alarm. 

HI_ENB Sets if the system monitors the point for the specified the High 
alarm limit (HI_LIM). Possible options are: 

• Enable – The system monitors the point for the specified 
alarm limit. 

• Disable – The system ignores the specified alarm limit. 

HI_LIM Sets a limit value (in engineering units) to which the input must 
rise to generate a High alarm. 

LO_ENB Sets if the system monitors the point for the specified the Lo 
alarm limit (LO_LIM). Possible options are: 

• Enable – The system monitors the point for the specified 
alarm limit. 

• Disable – The system ignores the specified alarm limit. 

LO_LIM Sets a limit value (in engineering units) to which the input must 
fall to generate a Low alarm. 

LOLO_ENB Sets if the system monitors the point for the specified the High 
alarm limit (LOLO_LIM). Possible options are: 

• Enable – The system monitors the point for the specified 
alarm limit. 

• Disable – The system ignores the specified alarm limit. 

LOLO_LIM Sets a limit value (in engineering units) to which the input must 
fall to generate a Low Low alarm. 

PF_ENB Sets if an alarm is raised on a point failure. Possible options are: 

• Enable – An alarm is raised if the selected channel reports a 
point failure. 

• Disable – No alarm is raised if the selected channel reports a 
point failure. 

DEADBAND Sets the value (in engineering units) that is an inactive zone 
above the low alarm and below the high alarm.  
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ROC_MODE Use this section to configure alarming based on the speed of 
variability in the value of the alarm input. Possible options are: 

• Disabled – The system does not monitor the input for rate of 
change alarming. 

• Alarm on Positive Changes – An alarm is raised if the value 
increases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

• Alarm on Negative Changes – An alarm is raised if the value 
decreases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

• Alarm on Both – An alarm is raised if the value increases or 
decreases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

ROC_LIM Sets a limit value (in engineering units) to which the input must 
rise or fall during the configured time period to generate an 
alarm. 

ROC_TM Sets the time duration (in seconds) that the system uses to 
determine the Rate of Change for an input. 

 

Analog Output CSV File Format 

The analog output CSV file contains information for all I/O modules in the configuration, 
including the module type, installation location, and IO type configuration for each 
channel. 

Note 

• The Channel column must be present in the Analog Output CSV file. All other 
columns are optional. 

• The I/O configuration CSV file must include _AO_ in the file name in order to be 
successfully imported. 
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Channel Rack position of the module and channel number. 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected channel. 

DESC Sets a description (up to 20-alphanumeric characters) for the 
selected channel. 

UNITS_TYPE Sets the measurement type used for the selected channel. 
Possible options are: 

• Unitless  

• Absolute Pressure 

• Temperature 

• Gas Density 

• Volume Heating Value 

• Dynamic Viscosity 

• Linear (Short) 

• Linear (Long) 

• Gas Volume Rate 

• Mass Rate 

• Energy Rate 

• Current 

• Voltage 

• Percentage 

• Acceleration 

• Resistance 

• Differential Pressure 

• Gauge Pressure 

• Mass Heating Value 

• Liquid Density 

• Water Density 

• Liquid Volume 

• Water Volume 

• Liquid Rate 

• Water Rate 

• Relative Density 
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Note 

If you populate this column, you must also populate the UNITS 
column. 

UNITS Sets the engineering units used for the selected channel. 
Possible options are: 

Unitless 

• N/A 

Absolute Pressure 

• psi(a) 

• kPa(a) 

• MPa(a) 

• bar(a) 

• kg/cm2(a) 

Temperature 

• °F 

• °C 

• K 

Gas Density 

• lb/ft3 

• kg/m3 

• g/cc 

• lb/MMCF 

• lb/US gal 

• kg/L 

• lb/bbl 

• RD(liq) 

• °API 

Volume Heating Value 

• Btu/ft3 

• MJ/m3 

Dynamic Viscosity 

• cP 

• lb/ft-s 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

234 

Column Heading Description 
Linear (Short) 

• in 

• mm 

Linear (Long) 

• ft 

• m 

Gas Volume Rate 

• ft3/s 

• ft3/min 

• ft3/h 

• ft3/d 

• MCF/s 

• MCF/min 

• MCF/f 

• MCF/d 

• m3/s 

• m3/min 

• m3/h 

• m3/d 

• (k)m3/s 

• (k)m3/min 

• (k)m3/h 

• (k)m3/d 

• MMCF/s 

• MMCF/min 

• MMCF/h 

• MMCF/d 

• BCF/s 

• BCF/min 

• BCF/h 

• BCF/d 

• L/s 

• L/min 
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• L/h 

• L/d 

• US gal/s 

• US gal/min 

• US gal/h 

• US gal/d 

• bbl/s 

• bbl/min 

• bbl/h 

• bbl/d 

Mass Rate 

• lb/s 

• lb/min 

• lb/h 

• lb/d 

• Mlb 

• kg/s 

• kg/min 

• kg/h 

• kg/d 

• tonne/s 

• tonne/min 

• tonne/h 

• tonne/d 

• ton/s 

• ton/min 

• ton/h 

• ton/d 

Energy Rate 

• Btu/s 

• Btu/min 

• Btu/h 

• Btu/d 
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• MMBtu/s 

• MMBtu/min 

• MMBtu/h 

• MMBtu/d 

• J/s 

• J/min 

• J/h 

• J/d 

• MJ/s 

• MJ/min 

• MJ/h 

• MJ/d 

• GJ/s 

• GJ/min 

• GJ/h 

• GJ/d 

• Dth/s 

• Dth/min 

• Dth/h 

• Dth/d 

• TJ/s 

• TJ/min 

• TJ/h 

• TJ/d 

• PJ/s 

• PJ/min 

• PJ/h 

• PJ/d 

Current 

• mA 

• A 

Voltage 

• V 
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• kV 

Percentage 

• % 

• ppm 

Acceleration 

• ft/s2 

• m/s2 

Resistance 

• ohms 

Differential Pressure 

• inH2O@60°F 

• inH2O@68°F 

• kPa 

• mbar 

• kg/cm2 

• psi 

• bar 

Gauge Pressure 

• psi(g) 

• kPa(g) 

• MPa(g) 

• bar(g) 

• kg/cm2(g) 

Mass Heating Value 

• Btu/lb 

• MJ/kg 

 

Liquid Density 

• lb/ft3 

• kg/m3 

• g/cc 

• lb/MMCF 

• lb/US gal 
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• kg/L 

• lb/bbl 

• RD 

• °API 

Water Density 

• lb/ft3 

• kg/m3 

• g/cc 

• lb/MMCF 

• lb/US gal 

• kg/L 

• lb/bbl 

• RD 

• °API 

Liquid Volume 

• ft3 

• m3 

• MCF 

• (k)m3 

• MMCF 

• BCF 

• L 

• US gal 

• bbl 

Water Volume 

• ft3 

• m3 

• MCF 

• (k)m3 

• MMCF 

• BCF 

• L 

• US gal 
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• bbl 

Liquid Rate 

• ft3/s 

• ft3/min 

• ft3/h 

• ft3/d 

• MCF/s 

• MCF/min 

• MCF/h 

• MCF/d 

• m3/s 

• m3/min 

• m3/h 

• m3/d 

• (k)m3/s 

• (k)m3/min 

• (k)m3/h 

• (k)m3/d 

• MMCF/s 

• MMCF/min 

• MMCF/h 

• MMCF/d 

• BCF/s 

• BCF/min 

• BCF/h 

• BCF/d 

• L/s 

• L/min 

• L/h 

• L/d 

• US gal/s 

• US gal/min 

• US gal/h 
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• US gal/d 

• bbl/s 

• bbl/min 

• bbl/h 

• bbl/d 

Water Rate 

• ft3/s 

• ft3/min 

• ft3/h 

• ft3/d 

• MCF/s 

• MCF/min 

• MCF/h 

• MCF/d 

• m3/s 

• m3/min 

• m3/h 

• m3/d 

• (k)m3/s 

• (k)m3/min 

• (k)m3/h 

• (k)m3/d 

• MMCF/s 

• MMCF/min 

• MMCF/h 

• MMCF/d 

• BCF/s 

• BCF/min 

• BCF/h 

• BCF/d 

• L/s 

• L/min 

• L/h 
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• L/d 

• US gal/s 

• US gal/min 

• US gal/h 

• US gal/d 

• bbl/s 

• bbl/min 

• bbl/h 

• bbl/d 

Relative Density 

• RD 

Note 

If you populate this column, you must also populate the 
UNITS_TYPE column. 

CONV_TYPE Sets if the channel measures either current input, voltage input 
or is disabled. Possible options are: 

• Current – The channel measure current. 

• Voltage – The channel measures voltage. 

• Disabled – The channel is disabled. 

For channels on a HART module, the only available options are 
Disabled and Current. 

LOW_EU Sets the value (in engineering units) that is equal to zero 
percent output (low end of the EU range). 

HIGH_EU Sets the value (in engineering units) that is equal to 100 percent 
output (high end of the EU range). 

USER_MODE Sets how the system acquires the value written to the Selected 
Value parameter under normal operation. Possible options are: 

• Auto – The system copies the value in the Auto Value 
(AUTO) field to the Selected Value parameter. 

• Override – The system copies the value set in the Override 
Value (OVRD) field to the Selected Value parameter. 

Note  

If a fault occurs and the operation mode (USER_MODE) is 
set to Override, the Selected Value parameter is set to the 
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Override Value (OVRD) and is not set based on the Fault 
Mode. 

• Auto Read – The system copies the value of the parameter 
you configure in the Auto Read Parameter Reference 
(AUTO_READ_PARAM) field to the Selected Value parameter. 
This value is updated once per second.  

Note  

When setting the Operation Mode (USER_MODE) to Auto 
Read, make sure that the units and scaling are correct for 
the referenced parameter. 

AUTO Sets the value (in engineering units) to use for the selected 
channel when the Operation Mode (USER_MODE) is set to Auto. 

AUTO_READ_PARAM Enter a parameter from the FB Series internal database to use 
as the analog output value when the Operation Mode 
(USER_MODE) is set to Auto Read. 

OVD Sets the value (in engineering units) that is written to the 
Selected Value field when the Operation Mode (USER_MODE) is 
set to Override. 

FAULT_MODE Sets the value to use when the output experiences a fault 
condition. Possible options are: 

• Fault – The system uses the value set in the Fault Value 
(FAULT) field. 

• Last Good Value – The system uses the last good value 
received before the fault occurred. 

• Last Hour Average – The system uses the last hourly 
average before the fault occurred. 

• Ramp To Fault Value – The system ramps the output to the 
value you configure in the Fault Value (FAULT) field over the 
time configured in the Ramp Duration (RAMP_DURATION) 
field. 

• Ramp To Last Hour Avg – The system ramps the output to 
the value shown in the Last Hour Average Value field over 
the time configured in the Ramp Duration 
(RAMP_DURATION) field. 
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FAULT Sets the value (in engineering units) to use when a fault occurs 
on the selected channel and the Fault Mode (FAULT_MODE) is 
set to Fault. 

RAMP_DURATION Sets, in seconds, the amount of time the system takes after a 
fault has occurred to ramp the output to the new value. 

RESET_MODE Sets the value to use for the channel after a power cycle occurs. 
Possible options are: 

• Fault – Use the value you set in the Fault Value (FAULT) 
field.  

• Last Good – Use the last known good value. 

Note  

• During a power cycle, an analog output generates 0mA 
while the FB Series product is restarting. Once the FB Series 
product has completed the restart, then the Action on CPU 
Restart is applied. 

• If only the 12MIO restarts, then the Action on CPU Restart is 
applied until communication is established with main CPU. 

CLIP_MODE Sets if clipping occurs on the selected input. Clipping forces the 
Selected Value to stay within a range defined by the Low 
Clipping Limit and High Clipping Limit. Clipping is only applied 
when there is not a fault. Possible Values are: 

• Disable – Clipping does not occur. 

• Enable – Clipping does occur. 

Note  

You must enter a value in the Low Clipping Limit 
(CLIP_LOW_LIMIT) and High Clipping Limit (CLIP_HIGH_LIMIT) 
fields. 

CLIP_LOW_LIMIT When clipping is enabled, this field sets the lower limit of the 
Selected Value parameter. 

CLIP_HIGH_LIMIT When clipping is enabled, this field sets the upper limit of the 
Selected Value parameter. 

Alarm Tag Set an identifier (up to 20-alphanumeric characters) for the 
selected instance. 
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ALM_DESC Set a description (up to 20-alphanumeric characters) for the 
selected instance. 

HIHI_ENB Sets if the system monitors the point for the specified the High 
High alarm limit (HIHI_LIM). Possible options are: 

• Enable – The system monitors the point for the specified 
alarm limit. 

• Disable – The system ignores the specified alarm limit. 

HIHI_LIM Sets a limit value (in engineering units) to which the input must 
rise to generate a High High alarm. 

HI_ENB Sets if the system monitors the point for the specified the High 
alarm limit (HI_LIM). Possible options are: 

• Enable – The system monitors the point for the specified 
alarm limit 

• Disable – The system ignores the specified alarm limit. 

HI_LIM Sets a limit value (in engineering units) to which the input must 
rise to generate a High alarm. 

LO_ENB Sets if the system monitors the point for the specified the Lo 
alarm limit (LO_LIM). Possible options are: 

• Enable – The system monitors the point for the specified 
alarm limit 

• Disable – The system ignores the specified alarm limit. 

LO_LIM Sets a limit value (in engineering units) to which the input must 
fall to generate a Low alarm. 

LOLO_ENB Sets if the system monitors the point for the specified the High 
alarm limit (LOLO_LIM). Possible options are: 

• Enable – The system monitors the point for the specified 
alarm limit 

• Disable – The system ignores the specified alarm limit. 

LOLO_LIM Sets a limit value (in engineering units) to which the input must 
fall to generate a Low Low alarm. 
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PF_ENB Sets if an alarm is raised on a point failure. Possible options are: 

• Enable – An alarm is raised if the selected channel reports a 
point failure. 

• Disable – No alarm is raised if the selected channel reports 
a point failure. 

DEADBAND Sets the value (in engineering units) that is an inactive zone 
above the low alarm and below the high alarm. 

ROC_MODE Use this section to configure alarming based on the speed of 
variability in the value of the alarm input. Possible options are: 

• Disabled – The system does not monitor the input for rate 
of change alarming. 

• Alarm on Positive Changes – An alarm is raised if the value 
increases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

• Alarm on Negative Changes – An alarm is raised if the 
value decreases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

• Alarm on Both – An alarm is raised if the value increases or 
decreases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

ROC_LIM Sets a limit value (in engineering units) to which the input must 
rise or fall during the configured time period to generate an 
alarm. 

ROC_TM Sets the time duration (in seconds) that the system uses to 
determine the Rate of Change for an input. 

 

Digital Input CSV File Format 

The digital input CSV file contains information for all I/O modules in the configuration, 
including the module type, installation location, and IO type configuration for each 
channel. 
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Note 

• The Channel column must be present in the Digital Input CSV file. All other columns 
are optional. 

• The I/O configuration CSV file must include _DI_ in the file name in order to be 
successfully imported. 

 

Column 
Heading 

Description 

Channel Rack position of the module and channel number. 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
channel. 

DESC Sets a description (up to 20-alphanumeric characters) for the 
selected channel. 

DI_TYPE Set how the digital inputs function when the Operation Mode is set 
to Live. Possible options are: 

• Normal – The Selected Value is updated based on the Live Value. 

• Latched – When the Live parameter transitions from off to on, 
the selected parameter remains on, until the latch is cleared 
using the Reset Latch parameter. 

USER_MODE Sets how the system acquires the value written to the Selected Value 
parameter under normal operation. Possible options are: 

• Live – The system copies the Live Value to the Selected Value 
parameter. 

• Override – The system copies the value you select in the 
Override Value field to the Selected Value parameter. 

Note  

If a fault occurs and the Operation Mode (USER_MODE) is set to 
Override, the Selected Value parameter is set to the Override 
Value (OVRD) and is not set based on the Fault Mode. 
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OVRD Sets the value that is written to the Selected Value field when the 
Operation Mode (USER_MODE) is set to Override. Possible options 
are: 

• Off – The selected channel is set to Off when the Operation 
Mode is set to Override. 

• On – The selected channel is set to On when the Operation Mode 
is set to Override. 

FAULT_MODE Sets how the system acquires the value written to the Selected Value 
parameter when a fault occurs. 

• Fault – The system copies the value set in the Fault Value field to 
the Selected Value parameter. 

• Last Good – The system copies the value of the Last Good Value 
field to the Selected Value parameter. 

FAULT Sets the value to use when a fault occurs on the selected channel and 
the Fault Mode (FAULT_MODE) is set to Fault. Possible options are: 

• Off – The channel is set to Off when a fault occurs on the 
selected channel and the Fault Mode is set to Fault. 

• On – The channel is set to On when a fault occurs on the selected 
channel and the Fault Mode is set to Fault. 

ZERO_DESC Enter a short description (up to 10-alphanumeric characters) for the 
digital input off state. 

ONE_DESC Enter a short description (up to 10-alphanumeric characters) for the 
digital input on state. 

LOGIC_LEVEL Sets the amount of current that the channel sources. Pick the 
appropriate setting based on the digital input device used with this 
channel. Possible options are: 

• 66 microamps – The input will source 66 microamps. 

• 2 milliamps – The input will source 2 milliamps. 

Note  

This field applies to the 8AIDIPI 2AO 2DO module (3MIX12) only. 
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INVERT Sets whether the system will invert the Live value before writing it to 
the Selected value. Possible options are: 

• Disable – The Selected Value will be set to the Live value. 

• Enable – The Selected Value will be set to the inverse of the Live 
value. For example, if the Live value is "Off" then the Selected 
value will be "On." 

Note  

This mode only works when the Operation Mode (USER_MODE) is 
set to Live and there is not a fault. 

FILTER_TIME Sets the amount of time (in seconds) the discrete input must remain 
in the On (high) state before it is recognized as such. The discrete 
input returns to the Off state immediately upon detection of the On 
to Off transition; there is no filtering for this transition. 

ALARM_MODE Sets alarming for the digital input. Possible options are: 

• Off – No alarms are logged. 

• On – A Set Alarm is logged when the Selected value transitions 
from “off” to “on.” A Clear Alarm is logged when the digital input 
transitions from “on” to “off.” 

RESISTOR_TYPE Activates a pull-up or pull-down resistor to maintain input in a 
deterministic state when no input is applied. 

• Pull Up – Maintain signal High when no input is applied. 

• Pull Down – Maintain signal Low when no input is applied.  
Note  
Open collector circuit configuration is not supported with a pull-
down resistor. 

Note  

This field applies to the 8AIDIPI 2AO 2DO module (3MIX12) only. 

 

Digital Output CSV File Format 

The digital output CSV file contains information for all I/O modules in the configuration, 
including the module type, installation location, and IO type configuration for each 
channel. 
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Note 

• The Channel column must be present in the Digital Output CSV file. All other columns 
are optional. 

• The I/O configuration CSV file must include _DO_ in the file name in order to be 
successfully imported. 

 

 

Column Heading Description 

Channel Rack position of the module and channel number of the I/O 
point. 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected channel. 

DESC Sets a description (up to 20-alphanumeric characters) for the 
selected channel. 

DO_TYPE Select the function of the digital output when the Operation 
Mode is Auto or Auto Read and there is no fault. Digital outputs 
are high/low outputs used to turn equipment on and off. 
Possible options are: 

• Latching – The discrete output turns on when the Auto or 
Auto Read Value, depending on Operation mode, is on. The 
output remains on until the Auto or Auto Read value turns 
off. 

• Momentary – When the Auto or Auto Read Value 
transitions from off to on, the discrete output will turn the 
discrete output on for the amount of time defined in the 
Time On field. The Auto parameter will be automatically set 
to 0 (off) when the discrete output generates the 
momentary output. 

Note 

The discrete output will not set the Auto Read Value back to 
0. 

• Toggle – Enables a square-wave output for which both the 
time on and time off are defined by the value in the Time 
On and Time Off parameters, respectively. 
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• Timed Duration Output Momentary – Enables the 

discrete output to complete one cycle based on the time 
related parameters in the Time Duration Output frame, and 
the Auto EU value. Once a cycle is completed, the DO will 
remain off until the Auto EU value is modified, starting a 
new cycle. 

• Timed Duration Output Toggle – Enables the discrete 
output to continuously repeat in a cycle defined by the 
value in the Cycle Time field on the TDO Parameters Tab 
where the EU Value controls the on-time duration. The 
current cycle will be completed before a new Auto EU value 
takes effect. 

• Scaled Pulse Output – Enables the discrete output to be 
turned on for the amount of time defined in the Time On 
field each time an accumulation limit is reached. This could 
be used to send a pulse output to another device, such as 
an odorizer, or to turn a sampler on each time a certain 
amount of flow is accumulated. 

USER_MODE Sets how the system acquires the value written to the Selected 
Value parameter under normal operation. Possible options are: 

• Auto – The system copies the value in the Auto Value field 
to the Selected Value parameter. 

• Override – The system copies the value set in the Override 
Value field to the Selected Value parameter. 

• Auto Read – The system copies the value of the parameter 
you configure in the Auto Read Parameter Reference field 
to the Selected Value parameter. 

Note 

This field applies only if you select Latching or Momentary in 
the Digital Output Type (DO_TYPE) field. 
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AUTO Sets the value to use for the selected channel when the 
Operation Mode (USER_MODE) is set to Auto. Possible options 
are: 

• Off – The system copies a value of Off to the Selected Value 
parameter. 

• On – The system copies a value of On to the Selected Value 
parameter. 

Note 

This field applies only if you select Latching or Momentary in 
the Digital Output Type (DO_TYPE) field. 

AUTO_READ_PARAM Enter a parameter from the FB Series product's internal 
database to use as the digital output value when the Operation 
Mode (USER_MODE) is set to Auto Read. 

Note  

This field applies only if you select Latching or Momentary in 
the Digital Output Type (DO_TYPE) field. 

OVRD Sets the value that is written to the Selected Value field when 
the Operation Mode (USER_MODE) is set to Override. Possible 
options are: 

• Off – The system copies a value of Off to the Selected Value 
parameter. 

• On – The system copies a value of On to the Selected Value 
parameter. 

FAULT_MODE Sets the value to use when the output experiences a fault 
condition. Possible options are: 

• Fault – The system uses the value set in the Fault Value 
field. 

• Last Good – The system uses the last good value output 
before the fault occurred. 

Note 

If the Digital Output Type (DO_TYPE) is TDO momentary, TDO 
toggle, or SPO, the DO will be set to off instead of set based on 
the fault mode. 
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FAULT Sets the value to use when a fault occurs on the selected 
channel and the Fault Mode (FAULT_MODE) is set to Fault. 
Possible options are: 

• Off – The channel is set to off when a fault occurs on the 
selected channel and the Fault Mode is set to Fault. 

• On – The channel is set to on when a fault occurs on the 
selected channel and the Fault Mode is set to Fault. 

ZERO_DESC Enter a short description (up to 10-alphanumeric characters) for 
the Off state of the digital output. 

Note  

This field applies only if you select Latching, Momentary, 
Toggle, Time Duration Output Momentary, or Time Duration 
Output Toggle in the Digital Output Type (DO_TYPE) field. 

ONE_DESC Enter a short description (up to 10-alphanumeric characters) for 
the On state of the digital output. 

Note  

This field applies only if you select Latching, Momentary, 
Toggle, Time Duration Output Momentary, or Time Duration 
Output Toggle in the Digital Output Type (DO_TYPE) field. 

ALARM_MODE Sets Alarming for the digital output. 

• Off – No alarms are logged. 

• On – A Set Alarm is logged when the Selected value 
transitions from “off” to “on.” A Clear Alarm is logged when 
the digital output transitions from “on” to “off.” 

RESET_MODE For Latched DO's, sets the value to use for the channel after a 
power cycle occurs. 

For Momentary DO's, the output is set to Off and no 
momentary pulse is generated. 

For all other DO's, the output is set based on the behavior 
described in the Digital Output Type parameter section. 

Possible options are: 

• Fault – The system uses the value set in the Fault Value 
field. 
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• Last Good – The system uses the last good value output 

before the fault occurred. 

Note  

• During a power cycle, a discrete output is set to Off while 
the FB Series product is restarting. Once the FB Series 
product has completed the restart, then the action on 
power cycle is applied. 

• This field applies only if you select Latching in the Digital 
Output Type (DO_TYPE) field and Auto in the Operation 
Mode (USER_MODE) field. 

• If only the 12MIO restarts, then the Action on CPU Restart is 
applied until communication is established with main CPU. 

TIME_ON Sets the amount of time, in seconds, an output is set to On. The 
minimum On and Off time is 0.01 seconds, resulting in a 
maximum frequency of 50 Hz. The default value is 1.0 seconds.  

• In Momentary mode, this is the amount of time (in 
seconds) that the output is energized. 

• In Toggle mode, this is the amount of time (in seconds) 
between switching On or Off. 

• In Scaled Pulse Output mode, this is the amount of time 
(in seconds) that the output is energized each time the 
change in the Scaled Pulse Output Value is greater than the 
Pulse Output Significance. For example, if the Scaled Pulse 
Output Value is 950 MCF when the scaled pulse output 
functionality is enabled and the Pulse Output Significance is 
1000 MCF, the DO will be energized when the Scaled Pulse 
Output Value reaches 1950 MCF. 

Note 

This field applies only if you select Momentary, Toggle, or 
Scaled Pulse Output in the Digital Output Type (DO_TYPE) 
field. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

254 

Column Heading Description 

TIME_OFF Sets the amount of time, in seconds, the output is set to Off. The 
minimum On and Off time is 0.01 seconds, resulting in a 
maximum frequency of 50 Hz. The default value is 1.0 seconds. 

Note 

This field applies only if you select Toggle in the Digital Output 
Type (DO_TYPE) field. 

TDO_CYCLE_TIME Sets the total amount of time (in seconds) the cycle spends in 
the On and Off positions. The Cycle Time entry is used to define 
the Off Time in the Time Duration Output Toggle mode. The Off 
Time is calculated by the formula: 

Off Time = Cycle Time - On Time 

Example: 

A Time Duration Output is used to emulate a field instrument 
measuring flow. The Time Duration Output outputs a pulse 
width of 3 seconds for no flow and a pulse width of 12 seconds 
for 1000 MCF per day flow. The output is repeated every 15 
seconds. 

If the Cycle Time is less than, or equal to the On Time, the Off 
Time is set to one. Care must be taken in configuration to 
ensure that the Cycle Time remains greater than the calculated 
On Time for proper operation. 

Note 

This field applies only if you select Time Duration Output 
Toggle in the Digital Output Type (DO_TYPE) field. 

TDO_LOW_EU Sets the value for the low reading to zero percent output (low 
end of the EU range). Based on the EU range determined in part 
by this parameter, the EU value is converted to a corresponding 
signal. 

Note 

This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the Digital 
Output Type (DO_TYPE) field. 
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TDO_HIGH_EU Sets the value for the high reading to 100 percent output (or 
high end of the EU range). Based on the EU range determined in 
part by this parameter, the EU value is converted to a 
corresponding signal. 

Note 

This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the Digital 
Output Type (DO_TYPE) field. 

TDO_0%_TIME Sets the amount of time (in seconds) the cycle is in the On 
position when the EU is at zero percent. 

Note 

• 0% and 100% should be less than or equal to the Cycle 
Time. 

• This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the 
Digital Output Type (DO_TYPE) field. 

TDO_100%_TIME Sets the amount of time (in seconds) the cycle is in the on 
position when the EU is at 100 percent.  

Note 

• 0% and 100% should be less than or equal to the Cycle 
Time. 

• This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the 
Digital Output Type (DO_TYPE) field. 

SPO_INPUT_PRM This parameter chooses the parameter the digital output will 
monitor for changes so that it can turn the digital output on for 
the amount of time specified by the Time On parameter each 
time it changes by the amount specified in the Pulse Output 
Significance parameter.  

Note 

• Choose a parameter with an incremental value. 

• This field applies only if you select Scaled Pulse Output in 
the Digital Output Type (DO_TYPE) field. 
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SPO_ACCUM_LIMIT This field defines the amount of change that must occur in the 
Scaled Pulse Output parameter before a pulse will be 
generated.  

Note 

• This parameter is in the same units as the Scaled Pulse 
Output Value. 

• This field applies only if you select Scaled Pulse Output in 
the Digital Output Type (DO_TYPE) field. 

LOW_SIDE_SWITCH Sets if the digital output is internally connected to or isolated 
from ground. Possible options are: 

• Enabled – The DO_LO pin is internally connected to ground 
and provides a grounded output (50 mA current limit). 

• Disabled – The DO_LO pin is internally isolated from 
ground and acts as a contact closure. 

 

Pulse Input CSV File Format 

The pulse input CSV file contains information for all I/O modules in the configuration, 
including the module type, installation location, and IO type configuration for each 
channel. 

Note 

• The Channel column must be present in the Pulse Input CSV file. All other columns 
are optional. 

• The I/O configuration CSV file must include _PI_ in the file name in order to be 
successfully imported. 

 

Column Heading Description 

Channel Rack position of the module and channel number. 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected channel. 

DESC Sets a description (up to 20-alphanumeric characters) for the 
selected channel. 
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UNITS_TYPE Sets the measurement type used for the selected channel. 

Note 

If you populate this column, you must also populate the UNITS 
column. 

UNITS Sets the engineering units used for the selected channel. 

Note 

If you populate this column, you must also populate the 
UNITS_TYPE column. 

CONV_FACTOR Sets the ratio of the number of pulses per engineering unit. 

Note  

This field applies only if the selected pulse input channel is not 
assigned to a Gas or Liquid Linear Meter Input. 

CONTRACT_HR Click ▼ to set the hour of the day to begin the daily counted 
parameters. 

RATE_PERIOD Click ▼ to set the time units used for the PI scan rate. 

USER_MODE Sets the source of the selected value. Possible options are: 

Live – The system uses the current value of the input. 

Override – The system uses the value set in the Override 
Frequency (OVRD_FREQ) field. 

OVRD_FREQ Sets the value to use for the selected channel when the 
Operation Mode (USER_MODE) is set to Override. 

FILTER Sets the amount of filtering that will be applied to the pulse 
input. Choose a filtering mode that is appropriate for the input 
frequency, and the amount of noise that may be present. 
Possible options are: 

• Low Speed Filter – Choose low speed filtering if the pulse 
input will be measuring frequencies less than 10Hz. 

• Medium Speed Filter – Choose medium speed filtering if 
the pulse input will be measuring frequencies between 0 to 
300Hz. 

• High Speed Filter – Choose high speed filtering if the pulse 
input will be measuring frequencies above 300Hz.  
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LOGIC_LEVEL This setting determines the amount of current that the channel 
sources. Pick the appropriate setting based on the pulse input 
device used with this channel. Possible options are: 

• 66 microamps – The input will source 66 microamps. 

• 2 milliamps – The input will source 2 milliamps. 

Note 

• This field applies to the 8AIDIPI 2AO 2DO module (3MIX12) 
only. 

• For the PI configuration driven from an open collector 
stage, high speed (10KHz) is only supported with the 2 
milliamps setting. 

• For the PI configuration driven from a voltage source, 66 
microamps is acceptable for low and high speed. 

RESISTOR_TYPE Activates a pull-up or pull-down resistor to maintain input in a 
deterministic state when no input is applied. 

• Pull Up – Maintain signal High when no input is applied. 

• Pull Down – Maintain signal Low when no input is applied. 

Note 

Open collector circuit configuration is not supported with a 
pull-down resistor. 

Note 

This field applies to the 8AIDIPI 2AO 2DO module (3MIX12) 
only. 

SCAN_PERIOD Sets how frequently the system scans the input (in seconds) to 
acquire the value. Each input updates based on their individual 
scan period. 

MONITOR_MAX Sets the maximum value of the pulse input gauge shown on the 
Monitor > Main display. 

Note 

This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 
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MONITOR_MIN Sets the minimum value of the pulse input gauge shown on the 
Monitor > Main display. 

Note  

This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 

Alarm Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected instance. 

ALM_DESC Sets a description (up to 20-alphanumeric characters) for the 
selected instance. 

HIHI_ENB Sets if the system monitors the point for the specified the High 
High alarm limit (HIHI_LIM). Possible options are: 

• Enable – the system monitors the point for the specified 
alarm limit. 

• Disable – The system ignores the specified alarm limit. 

HIHI_LIM Sets a limit value (in engineering units) to which the input must 
rise to generate a High High alarm. 

HI_ENB Sets if the system monitors the point for the specified the High 
alarm limit (HI_LIM). Possible options are: 

• Enable – the system monitors the point for the specified 
alarm limit. 

• Disable – The system ignores the specified alarm limit. 

HI_LIM Sets a limit value (in engineering units) to which the input must 
rise to generate a High alarm. 

LO_ENB Sets if the system monitors the point for the specified the Lo 
alarm limit (LO_LIM). Possible options are: 

• Enable – the system monitors the point for the specified 
alarm limit. 

• Disable – The system ignores the specified alarm limit. 

LO_LIM Sets a limit value (in engineering units) to which the input must 
fall to generate a Low alarm. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

260 

Column Heading Description 

LOLO_ENB Sets if the system monitors the point for the specified the High 
alarm limit (LOLO_LIM). Possible options are: 

• Enable – the system monitors the point for the specified 
alarm limit. 

• Disable – The system ignores the specified alarm limit. 

LOLO_LIM Sets a limit value (in engineering units) to which the input must 
fall to generate a Low Low alarm. 

PF_ENB Sets if an alarm is raised on a point failure. Possible options are: 

• Enable – An alarm is raised if the selected channel reports a 
point failure. 

• Disable – No alarm is raised if the selected channel reports 
a point failure. 

DEADBAND Sets the value (in engineering units) that is an inactive zone 
above the low alarm and below the high alarm.  

ROC_MODE Use this section to configure alarming based on the speed of 
variability in the value of the alarm input. Possible options are: 

• Disabled – The system does not monitor the input for rate 
of change alarming. 

• Alarm on Positive Changes – An alarm is raised if the value 
increases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

• Alarm on Negative Changes – An alarm is raised if the 
value decreases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

• Alarm on Both – An alarm is raised if the value increases or 
decreases more than the limit set (ROC_LIM) over the 
specified period of time (ROC_TM). 

ROC_LIM Sets a limit value (in engineering units) to which the input must 
rise or fall during the configured time period to generate an 
alarm. 

ROC_TM Sets the time duration (in seconds) that the system uses to 
determine the Rate of Change for an input. 
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3. Save your changes. You can now import your I/O configuration CSV files for use in 
your FB Series product. For more information, refer to Importing I/O Configuration 
CSV Files. 

Note 

Make sure to save the file with a .csv file extension. 

4.5.2 MVS Setup 

Use this display to enable communications with 4088B multivariable transmitters on 
either COM3 or COM4. 

Note 

• To view this display, you must first set the Port Owner of COM3 or COM4 to 
MVS4088B. For more information, refer to Port Owner field on the Communications – 
General tab. 

• If you enabled MVS4088B communications on multiple communications ports, select 
the different communications ports using the communications port drop-down list at 
the top-left of the display. 

• When communicating with more than six transmitters at 9600 baud, update times 
exceed once per second. 

To access this display: 

1. Select Configure > I/O Setup > MVS Setup from the FBxConnect™ main menu. The 
MVS Setup display opens. 
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Figure 113. MVS Setup 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Communications 
Port Instance 

Click ▼ to select a communications port on which to enable 
multivariable transmitters. 
Note  
Only communications ports with the Port Owner field configured 
as MVS4088B are shown. For more information, refer the 
Communications – General tab. 

Enable All Select to enable communications for all multivariable transmitters. 
Baud Rate Sets the baud rate for multivariable transmitter communications 

using the selected port. 
Comm Details Select this button to open the Communications configuration 

display for the communications port configured in the Comm Port 
to GC field. 

Transmitter 
Scanning 

Place a check mark to enable the system to scan the selected 
multivariable transmitter for data.  

Tag Sets a name (up to 8-alphanumeric characters) for the selected 
multivariable transmitter. 
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Field Description 

Description Sets a description (up to 16-alphanumeric characters) for the 
selected multivariable transmitter. 

4088B Modbus 
Address 

Sets the unique Modbus address for the selected multivariable 
transmitter. The default address is 1. If the multivariable 
transmitter is used in the multi-drop mode, each multivariable 
transmitter must have a unique address. Use Address 240 to poll 
the sensor to determine the address of the connected sensor. This 
is similar to polling a device using Address and Group 240. When 
Address 240 is used, the sensor responds with its address by 
updating the Address field. 

Note 
This field shows only if the Port Owner field for the selected 
communications port is configured as MVS4088B. For more 
information, refer the Communications – General tab. 

Input Health 
Status 

This read-only field shows the current operating status of the 
selected multivariable transmitter. 

Auto Scan Select to have the system automatically scan the baud rates for the 
multivariable transmitter with the indicated Modbus address. 

Note  

• The baud rate of the transmitter is changed to the baud rate 
configured in the Baud Rate field. 

• You must select the Enable checkbox in the Transmitter 
Scanning field to activate this button. 

Details Select this button to open the configuration display for the selected 
transmitter. 

Note 

You must select the Enable checkbox in the Transmitter 
Scanning field to activate this button. 

Wiring Diagram Click to open a 4088B wiring diagram for the selected 
communications port.  

3. Select Save to save any changes you make to this display. 
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4.5.3 MVS Configuration 

Use this display to view and configure various parameters of a 4088B multivariable 
transmitter. 

Note 

To view this display, you must first set the Port Owner of COM3 or COM4 to either 
MVS4088B. For more information, refer to Communication – General Tab. 

To access this display, select Configure > I/O Setup > MVS Configuration from the 
FBxConnect™ main menu. The MVS Configuration display opens. 

Figure 114. I/O Setup – MVS Configuration 

 

The MVS Configuration display has the following tabs: 

General – Use this tab to view and configure communication settings, and issue 
commands related to the 4088B. 

User Defines – Use this tab to setup the user defined points in the 4088B multivariable 
transmitter, and what is displayed on the 4088B's LCD. 

4.5.3.1 MVS Configuration – General Tab 

Use this tab to view and configure communication settings, and issue commands related 
to the 4088B multivariable transmitter. 
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To access this tab: 

1. Select Configure > I/O Setup > MVS Configuration. The MVS Configuration display 
opens showing the General tab. 

Figure 115. MVS Configuration – General Tab 

 

2. Click ▼ in the drop-down list at the top of the display to select a 4088B instance to 
configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected 4088B instance. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected 4088B instance. 
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Field Description 

Module 
Location 

This read-only field shows the location of the module in the FB 
Series product. 

Channel This read-only field shows the channel in the FB Series product 
used by the module. 

Transmitter 
Sensor 

This read-only field shows the sensor object associated with the 

selected 4088B instance. Click  to open the MV Sensor display 

and view sensor properties. 

Input Health 
Status 

This read-only field shows the current operating status of the 
selected 4088B. Possible values are: 

• Normal 

• Not Licensed 

• Instance Inactive 

• Communication Failed 

• Config. Issue Due To Write Protect 

• DP Failed 

• Pressure Failed 

• RTD Failed 

• Synchronization In Progress 

• Scan Disabled 

• Writing Failed 

• Reserved 

• 4088 in Mode A 

Note 

4088A models and 4088 model in Mode A are not supported. 

• Reading Device 

• Writing Device 

• Baud Too Low 

• Writing Baud Failed 

• Sensor Disconnected 

• Scanning Baud Rate 1200 

• Scanning Baud Rate 2400 
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Field Description 

• Scanning Baud Rate 4800 

• Scanning Baud Rate 9600 

• Scanning Baud Rate 19200 

Sensor Type This read-only field shows the type of multivariable transmitter 
connected to the FB Series product. 

4088B Tag Sets a name (up to 8-alphanumeric characters) for the selected 
4088B. 

4088B 
Description 

Sets a description (up to 16-alphanumeric characters) for the 
selected 4088B. 

4088B Message Sets a message (up to 32-alphanumeric characters) for the selected 
4088B. 

4088B Modbus 
Address 

Sets the unique Modbus address for the selected 4088B 
multivariable transmitter. The default address is 1. If the 4088B is 
used in the multi-drop mode, each 4088B must have a unique 
address. Use address 240 to poll the sensor to determine the 
address of the connected sensor. When address 240 is used, the 
sensor responds with its address by updating the Address field. 

Note 

Only one 4088B should be connected to the FB Series product when 
polling address 240. 

Write Protect 
Switch Status 

This read-only field show the status of the write protect switch on 
the 4088B. 

Transmitter 
Scanning 
enable 

Sets if the system scans the 4088B for data. 

Disable The system does not scan the 4088B for data. 

Enable The system does scan the 4088B for data. 

Communication 
Health 

This read-only field shows the status of Modbus communications 
between the FB Series product and the 4088B. 

Configuration 
Change 
Counter 

This read-only field shows the number of configuration changes 
that have been made to the 4088B. The FB Series product 
automatically reads the configuration of the 4088B if it detects a 
change in this value. 

Transmitter 
Status Option 

This read-only field shows information about the capabilities of the 
4088B. 
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Field Description 

DP Sensor 
Present 

The box next to this field is checked if a differential 
pressure sensor is installed in the 4088B. 

AP Sensor 
Present 

The box next to this field is checked if an absolute 
pressure sensor is installed in the 4088B. 

GP Sensor 
Present 

The box next to this field is checked if a gauge 
pressure sensor is installed in the 4088B. 

PT Sensor 
Present 

The box next to this field is checked if a process 
temperature RTD interface is installed in the 4088B. 

LCD 
Available 

The box next to this field is checked if an LCD is 
installed in the 4088B. 

Connect Click to establish communications with the selected 4088B. The FB 
Series device automatically changes the baud rate of the 
communications port to attempt to locate a 4088B. Once 
communications are established, the system updates the 
transmitter's baud rate to match the baud rate selected in 
FBxConnect™. 

Note 

Only one 4088B should be connected to the FB Series product when 
using this command. 

Synchronize Click to synchronize parameters between the FB Series product and 
the 4088B. This command automatically executes when you enable 
communications. 

Reset Click to power cycle to 4088B. 

Firmware 
Version 

This read-only field shows the revision level of the firmware in the 
selected 4088B. 

Transmitter 
Modbus 
Version 

This read-only field shows the revision level of the Modbus protocol 
used in the selected 4088B. 

Transmitter 
Serial Number 

This read-only field shows the serial number of the 4088B. 

Calibration 
Status of 4088 

Shows, if checked, a calibration is currently being performed on the 
selected I/O point. 

Transmitter 
Variable Status 

Shows the status of each process variable. 
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4. Select Save to save any changes you make to this tab. 

4.5.3.2 MVS Configuration – User Defines Tab 

Use this display to setup the user defined points in the 4088B multivariable transmitter, 
and what is displayed on the 4088B's LCD. 

To access this tab: 

1. Select Configure > I/O Setup > MVS Configuration. The MVS Configuration display 
opens. 

2. Select the User Defines tab. 

Figure 116. MVS Configuration – User Defines Tab 
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3. Click ▼ in the drop-down list at the top of the display to select a 4088B instance to 
configure. 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

User Defined 
Variables 

Use these fields to configure the three host variable screens 
supported by the 4088B’s LCD.  

User Defined Variables are sent to the 4088B periodically, making it 
possible to display parameters in the FB Series product that change 
frequently on the 4088B’s LCD. For example, you can configure User 
Defined Variables to display the flow rate calculated by one of the 
meter runs in the FB Series product. 

User 
Defined 
Text 

Sets the text (up to 10-alphanumeric characters) 
displayed on the top line of the 4088B’s LCD screen. 

User 
Defined 
Variable 

Click  to set a parameter in the FB Series product 

whose value is written to the 4088B. This value is 
displayed on the middle line of the 4088B’s LCD. 

User 
Defined 
Unit 

Sets the text (up to 5-alphanumeric characters) that is 
displayed on the bottom line of the 4088B’s LCD 
screen. 

User Defined 
Parameters 

Use these fields to configure the six host parameter screens 
supported by the 4088B’s LCD.  

User Defined Parameters are only sent to the 4088B when they are 
changed, and are meant to display values that do not change 
frequently. For example, you can configure User Defined Parameters 
to display the orifice plate diameter for a meter run. 

User 
Defined 
Text 

Sets the text (up to 10-alphanumeric characters) that 
is displayed on the top line of the 4088B’s LCD screen. 

User 
Defined 
Parameter 

Sets the floating-point value that is displayed on the 
middle line of the 4088B’s LCD screen. 

User 
Defined 
Unit 

Sets the text (up to 5-alphanumeric characters) that is 
displayed on the bottom line of the 4088B’s LCD 
screen. 
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Field Description 

LCD The checkboxes inside this frame provide control over which of the 
available 4088B LCD screens will be displayed. 

LCD Scroll 
Time 

Sets the amount of time the 4088B LCD remains on a screen before 
switching to the next. 

5. Select Save to save any changes you make to this display. 
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4.5.3.3 Configuring Communications with a 4088B 

Use these steps to configure a 4088B multivariable transmitter to communicate with your 
FB Series product. 

To configure communications with a 4088B: 

1. Select Configure > Communications from the FBxConnect™ main menu. The 
Communications display opens showing the General tab. 

2. Click ▼ in the drop-down list at the top of the display and select COM3 or COM3 or 
COM4. 

3. Click ▼ in the Port Owner field and select MVS4088B. 

Figure 117. Communications – General 

 

4. Select Save to save your changes. 

5. Select Configure > I/O Setup > MVS Configuration. The MVS Configuration display 
opens showing the General tab. 
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Figure 118. MVS Configuration – General Tab 

 

6. Click ▼ in the drop-down list at the top of the display to select a 4088B instance to 
configure. 

7. In the Tag field, enter a name for the 4088B. 

8. In the Description field, enter a description for the 4088B. 

9. In the 4088B Modbus Address field, enter the Modbus Address of the 4088B. 

10. In the Transmitter Scanning field, select Enable to set the system to scan the 4088B 
for data. 

11. Select Save to save your changes to device memory, and to retrieve data from the 
4088B. 
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Note 

The remaining fields are automatically populated with data retrieved from the 4088B after 
a successful scan. To avoid having your changes overwritten, ensure that Transmitter 
Scanning is successful before you configure additional fields. 

12. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to MVS Configuration. 

13. Select Save to save your changes to device memory, and to write the changes to the 
4088B. 

14. You can now select a 4088B instance on the Differential Pressure, Static Pressure, and 
RTD displays. 

4.5.4 HART® I/O 

The HART® (Highway Addressable Remote Transducer) I/O module allows an FB3000 RTU 
to process input from field-based HART devices. The module has four channels that are 
independently selectable as either an input or output channel. You use each channel's 
analog input capabilities for diagnostic and primary process variable measurement. You 
can configure an input channel for use in point-to-point or multi-drop mode. You can 
configure an output channel for use in point-to-point mode only.  

HART superimposes Frequency Shift Keying (FSK) signals on an analog signal. This 
technique allows digital information to pass to and from the HART device on a 4 to 20 mA 
analog signal.  

In point-to-point mode, the analog signal is representative of the measured variable. This 
mode allows communications with one HART device per channel with up to one second 
updates. The scan time for one channel does not affect the scan time of any other 
channel. Point-to-point mode with one second updates meets API 21 requirements. 

In multi-drop mode, as many as five HART devices can be connected (in parallel) to each 
channel. Like the point-to-point mode, digital communications are superimposed on the 
analog signal that is used for powering the HART devices. Each HART device in multi-drop 
mode requires 4mA, and the analog signal does not represent any measured variable 
value. With all four channels in the multi-drop mode, the FB3000 can support a maximum 
of twenty HART devices. 

You can configure the FB3000 as a primary master with a Class 1 Conformance 
classification or as a secondary master for use in redundant applications. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

275 

To access this display: 

1. Select Configure > I/O Setup > HART I/O from the FBxConnect™ main menu. The 
HART display opens. 

Figure 119. HART I/O 

 

2. Click ▼ in the drop-down list at the top of the display to select a HART channel to 
configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Channel 
Information 

Sets the configuration of the selected channel. Possible options 
are: 
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Field Description 

HART Comm 
Status 

This read-only field shows the current 
operational state of the selected channel. 
Possible states are: 

Scanning Indicates the channel is currently 
scanning the HART device(s). 

Not 
Scanning 

Indicates the channel is not 
currently scanning the HART 
device(s) because the FB Series 
product is currently offline or not 
communicating.  

Dual 
Master 

Indicates that the channel has 
another master connected. 
Examples of other masters include 
a Hand-Held Communicator. 

When in Dual Master, the FB3000 is 
not scanning the HART device, 
which allows communications 
between the other master and the 
devices. When the other master 
finishes communicating with the 
HART device, normal HART module 
scanning will automatically 
resume. 

Burst 
Mode 

Indicates that the channel has a 
device that is configured to be in 
burst mode. 

Note 

Burst mode is not supported by 
the HART module. The device 
should not be configured in Burst 
mode when connected to FB3000. 
If a device is in Burst mode, use a 
Hand-Held Communicator to turn 
off Burst mode. 
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Field Description 

AI The channel is an analog input. 

Note 

If you want to use the selected HART channel 
as an analog input, you should also configure 
the input using the Analog Input configuration 
display and selecting 

the instance (chassis, slot, and channel 
number) of the input. 

AO The channel is an analog output. 

Note  

If you want to use the selected HART channel 
as an analog output, you should also configure 
the output using the Analog Output 
configuration display and selecting the 
instance (chassis, slot, and channel number) of 
the output. 

HART Master 
Type 

Sets sequencing to ensure that two masters can communicate with 
one slave device. 

Primary The FB3000 has priority in communications. 

Secondary The FB3000 must wait until the Primary 
communications have completed. 

HART Comm 
Mode 

Sets the communication mode for the selected channel. Possible 
options are: 
 
Disabled Stop all HART communication. 

Point to Point Enables the channel to communication with 
one HART device per channel. 

MultiDrop Enables the channel to communicate with up to 
five HART devices connected in parallel. 

Note 

• This option is available only if you select AI 
in the Channel Information field.  

• AI calibration cannot be performed in this 
communication mode. Calibration can only 
be performed in Point to Point mode. 
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Field Description 

Number of 
Devices 

Sets the number of HART devices connected in parallel. 

Note 

This field applies only if you select MultiDrop in the HART Comm 
Mode field. 

Device 1-5 Each button represents one HART device connected to the selected 
channel. Select a button to open the HART Device display and 
configure the selected HART device. 

Note 

• The name of the HART device shows in the Device Tag field. 

• A  icon next to a Device Tag indicates a device that is in an 
alarm state. 

Pass Through 
Mode 

Sets how communications pass from a host device through the FB 
Series product on to the HART devices. Possible options are: 

Disable No pass-through communications occur. 

Strip Removes all preamble bytes in HART protocol. 

Full Leaves the entire message intact. 

Note 

If you select Strip or Full, you also must enable HART protocol on 
the Ethernet port for this feature to work. For more information, 
refer to Communications – General Tab. 

Values These fields display values from the selected HART AI or AO 
channel. 
Selected Value This read-only field shows the value (in 

engineering units) based on the Operation and 
Fault Mode fields, as well as the health status 
of the selected input. It is intended to be used 
as an input to calculations and control logic. 

Last Good Value This read-only field shows the last good value 
(in engineering units) received by the selected 
sensor. This value is written to the Selected 
Value parameter if a fault occurs and the Fault 
Mode is set to Last Good. 

Raw Value This read-only field shows the current digital 
count directly from the Analog-to-Digital 
converter. 
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Field Description 

Auto Read 
Value 

This read-only field shows the current value of 
the parameter configured in the Auto Read 
Parameter Reference field. 
Note 
This field appears only if you select AO in the 
Channel Information field. 

Actual Mode This read-only field shows the source of the 
selected value. Possible values are: 
• Live 
• Auto 
• Auto Read 
• Override 
• Calibration 
• Fault 
• Last Good 
• Last Hour Average 
• Ramp To Fault Value 
• Ramp To Last Hour Avg 
• Polling Disabled 

Input/Output 
Health Status 

This read-only field shows the status of the 
selected channel. Possible values are: 
• Normal 
• Not Licensed 
• Instance Inactive 
• Comm Fail 
• Override Active 
• In Alarm 
• Point Fail 
• Above Calibration Limit 
• Below Calibration Limit 
• Input Frozen 
• Input Clipped 
• Factory Calibration Invalid 
• User Calibration Invalid 
• Disabled 
• Termination Missing 
• Hardware Fail 
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Field Description 

• HART Device Fail 
Note 
This field may temporarily show Point Fail if the 
Interval to Poll I/O field on the I/O Bus display 
is set to 10 ms and the AO value is changed 
more than 10%. 

Composite 
Alarm Status 

This read-only field shows the current active 
alarms for the selected channel. The Composite 
Alarm Status is Normal if there are no active 
alarms. 

Configuration Use these fields to configure the selected AI or AO channel. 

Low Reading EU Sets the value (in engineering units) that is 
equal to zero percent output (low end of the EU 
range). 

Sets the low reading (in engineering units) that 
is equal to zero percent input. For example, if a 
temperature transmitter is connected to the 
analog input with a range of –40 to 160 
degrees F, the Low field would be set to –40. 

Note 

You must select EU Scaling in the EU Scaling 
Mode frame to modify this field. 

High Reading 
EU 

Sets the value (in engineering units) that is 
equal to 100 percent output (high end of the 
EU range). 

Sets the high reading (in engineering units) 
that is equal to 100 percent input. For example, 
if a temperature transmitter is connected to 
the analog input with a range of – 40 to 160 
degrees F, the High field would be set to 160. 

Note 

You must select EU Scaling in the EU Scaling 
Mode frame to modify this field. 
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Field Description 

Adjusted A/D 0 
percent 

Sets the calibrated Analog-to-Digital count 
corresponding to zero percent input. In the 
Calibrate function, this value is altered to set 
the zero percent input exactly at the Low 
Reading EU value. 

Note 

• This field appears only if you select AI in 
the Channel Information field. 

• You must select EU Scaling in the EU 
Scaling Mode frame to modify this field. 

Adjusted A/D 
100 percent 

Sets the calibrated Analog-to-Digital count 
corresponding to 100 percent input. In the 
Calibrate function, this value is altered to set 
the zero percent input exactly at the Low 
Reading EU value. 

Note 

• This field appears only if you select AI in 
the Channel Information field. 

• You must select EU Scaling in the EU 
Scaling Mode frame to modify this field. 

Adjusted D/A 0 
percent 

Sets the count that the digital-to-analog 
converter uses for zero percent output. This 
value scales the output to engineering units. 

Note 

• This field appears only if you select AO in 
the Channel Information field. 

• You must select EU Scaling in the EU 
Scaling Mode frame to modify this field. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

282 

Field Description 

Adjusted D/A 
100 percent 

Sets the count that the digital-to-analog 
converter uses for zero percent output. This 
value scales the output to engineering units. 

Note 

• This field appears only if you select AO in 
the Channel Information field. 

• You must select EU Scaling in the EU 
Scaling Mode frame to modify this field. 

EU Scaling 
Mode 

Specifies how the EU scaling parameters are 
determined. 

Note 

• These fields appear only if you select AI in 
the Channel Information field. 

• You must select Current in the 
Current/Voltage Selection frame to 
modify this field. 

 Multi-Point 
Calibration 

EU scaling parameters are 
determined by the calibration. 
You cannot modify the EU 
scaling parameters (Low 
Reading EU, High Reading EU, 
Adjusted A/D 0 Percent, 
Adjusted A/D 100 Percent) 
directly. You must use the 
calibration wizard to adjust the 
scaling of the AI.  

Note 

If you download a configuration 
file that has Multi-Point 
Calibration selected, the 
calibration on your device 
remains unchanged. 
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Field Description 

 EU Scaling EU scaling parameters are 
determined by the values you 
enter in the Low Reading EU, 
High Reading EU, Adjusted A/D 0 
Percent, Adjusted A/D 100 
Percent fields. 

Note 

If you download a configuration 
file that has EU Scaling selected, 
the existing calibration on your 
device is overwritten using the 
EU scaling parameters. 

Current/Voltage 
Selection 

Sets the signal type of the selected I/O point. 

Disabled No signal is present on the 
selected channel. 

Current A 4 to 20 mA signal is present on 
the selected channel. 

Operation 
Mode 

Sets how the system acquires the value written 
to the Selected Value parameter under normal 
operation. Possible options are: 

Live The system copies the Live Value 
to the Selected Value parameter. 

Note 

This field appears only if you 
select AI in the Channel 
Information field. 

Auto The system copies the value in 
the Auto Value field to the 
Selected Value parameter. 

Note 

This field appears only if you 
select AO in the Channel 
Information field. 
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Field Description 

Override The system copies the value set 
in the Override Value field to the 
Selected Value parameter. 

Note  

If a fault occurs and the 
operation mode is set to 
Override, the Selected Value 
parameter is set to the Override 
Value and is not set based on 
the Fault Mode. 

Override 
Value 

Sets the value (in 
engineering units) 
written to the 
Selected Value field 
when the Operation 
Mode is set to 
Override. 

Auto Read The system copies the value of 
the parameter you configure in 
the Auto Read Parameter 
Reference field to the Selected 
Value parameter. This value is 
updated once per second. 

Note 

• This field appears only if 
you select AO in the 
Channel Information field. 

• When setting the Operation 
Mode to Auto Read, make 
sure that the units and 
scaling are correct for the 
referenced parameter. 

Override 
Value 

Sets the value (in engineering 
units) to use when the Operation 
Mode is set to Override. 
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Field Description 

Auto Value Sets the value (in engineering 
units) to use when the Operation 
Mode is set to Auto Read.  

Note 

This field appears only if you 
select AO in the Channel 
Information field. 

4. Select Save to save any changes you make to this tab. 

4.5.4.1 HART Device 

Use this pop-up display to configure parameters specific to the selected HART® device. 
When in MultiDrop mode, a separate Device button exists for each connected HART 
device.  

To access this tab: 

1. Select Configure > I/O Setup > HART I/O from the FBxConnect™ main menu. The 
HART display opens. 

2. Select the Device button for the device you want to configure. The HART Device pop-
up display opens. 

Figure 120. HART Device 
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3. Review – and change as necessary – the values in the following fields: 

Field Description 

Variables to 
Poll 

Sets the polling behavior for this device. Possible options are: 

Skip Removes this device from the polling sequence 

PV Only Poll only the Primary Variable value. 

All Process Poll all process variable values (Primary, 
Secondary, Tertiary, Quaternary). 

All Dynamic Poll values for all Dynamic Variables (Slot 0, Slot 1, 
Slot 2, and Slot 3). 

Misc These fields allow you to set and view general information about the 
selected HART device. 

Status This read-only field shows the state of the device.  

Device Tag Sets the name for the HART device to identify it 
throughout the configuration. The tag should be 8 
characters or less. When in Multidrop mode, the 
tag must be unique for every device. 

Description Provides up to 16 alphanumeric characters of 
information (in addition to the device Tag) to more 
specifically describe the device. 

Message Defines a message (up to 32 alphanumeric 
characters in length) sent to and stored in the 
device. 

Polling 
Address 

This read-only field shows the address used for 
this HART device. In Point to Point mode, the Poll 
Address is 0. In Multidrop mode, the system uses 
addresses between 1 and 5. 

ID Number This read-only field shows a 3-byte globally unique 
address of the device. 

Device ID This read-only field shows the coded ID that 
reflects the manufacturer of the device, the device 
type, and the device ID. 

Sensor Serial 
Number 

This read-only field shows the serial number of 
the sensor. 
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Field Description 

Response 
Status 

This read-only field shows the response status of 
the device. Refer to the documentation from the 
transmitter manufacturer and HART specification 
for more information. 

Sensor These read-only fields show you general information about the 
sensor range and health of the HART device. 

Device Status This read-only field shows the state of the device.  

PV Alarm 
Reference 

This read-only field shows you which alarm is 
currently configured for the selected HART device. 

PV Upper 
Sensor Limit 

This read-only field shows the upper limit on the 
sensor. 

PV Lower 
Sensor Limit 

This read-only field shows the lower limit on the 
sensor. 

PV Upper 
Range Limit 

This read-only field shows the maximum value in 
the sensor range. 

Note 

The PV Upper Range Limit is typically a user-
configurable value and should be a value less than 
or equal to the Upper Sensor Limit. 

PV Lower 
Range Limit 

This read-only field shows the minimum value in 
the sensor range. 

Note 

The PV Lower Range Limit is typically a user-
configurable value and should be a value greater 
than or equal to the Lower Sensor Limit. 

PV Minimum 
Span 

This read-only field shows the minimum sensor 
span. 

PV Damping 
Value 

This read-only field shows the damping value 
reported by the device for the Primary Variable. 

% of Range This read-only field shows the percentage of the 
range currently being reported by the device. 

Dynamic 
Variables 

Use these fields to configure the dynamic variable values used by 
the system. 
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Field Description 

Slot 0 Assign Sets a valid value according to the manufacturer 
specification between 0-255 to determine which 
variable in that slot to request. 

Slot 0 Value This read-only field shows the value of the variable 
requested from that slot. The read-only units 
defined in the device are shown to the right of this 
field. 

Slot 1 Assign Sets a valid value according to the manufacturer 
specification between 0-255 to determine which 
variable in that slot to request. 

Slot 1 Value This read-only field shows the value of the variable 
requested from that slot. The read-only units 
defined in the device are shown to the right of this 
field. 

Slot 2 Assign Sets a valid value according to the manufacturer 
specification between 0-255 to determine which 
variable in that slot to request. 

Slot 2 Value This read-only field shows the value of the variable 
requested from that slot. The read-only units 
defined in the device are shown to the right of this 
field. 

Slot 3 Assign Sets a valid value according to the manufacturer 
specification between 0-255 to determine which 
variable in that slot to request. 

Slot 3 Value This read-only field shows the value of the variable 
requested from that slot. The read-only units 
defined in the device are shown to the right of this 
field. 

Calibration Use these fields to configure values related to calibration. 
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Field Description 

PV 
Inactivity 
Timeout 

Sets, in minutes, the time period the system waits for 
activity during the Calibration or Plate Change 
process. If no activity occurs during the specified 
time period, the Calibration or Plate Change process 
automatically ends. The default is 60 minutes. 

Note  
This applies to the primary variable (PV) of a HART 
device only. 

Primary 
Variables 

Use these fields to configure the primary variable values used by the 
system. 

PV Actual 
Mode 

This read-only field shows the source for the 
primary variable value used by the system. 
Possible values are: 

Polling 
Disabled 

The system is not currently polling for 
this variable. 

Live The system uses the live value 
received from the HART device. 

Override The system uses the value set in the PV 
Override Value field. 

Fault The system uses the value set in the PV 
Fault Value field. 

Last 
Good 

The system uses the value shown in 
the Last Good Value field. 

PV Selected 
Value 

This read-only field shows the current in-use 
primary variable value. 

PV Operation 
Mode 

Sets the operation mode of the primary variable. 
Possible options are: 

Live The system uses the live value 
received from the HART device. 

Override The system uses the value set in the PV 
Override Value field. 

PV Override 
Value 

Sets the primary variable value to use when the PV 
Operation Mode is set to Override. 
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Field Description 

PV Live Value This read-only field shows the live primary variable 
value received from the HART device. 

PV Fault 
Mode 

Sets the source of the primary variable value when 
a fault is encountered. Possible options are: 

Fault The system uses the value set in the PV 
Fault Value field. 

Last 
Good 

The system uses the value shown in 
the Last Good Value field. 

PV Fault 
Value 

Sets a value to use for the primary variable when a 
fault occurs and the PV Fault Mode field is set to 
Fault. 

PV Last Good 
Value 

This read-only field shows the last known good 
value received from the HART device. 

Secondary 
Variables 

Use these fields to configure the secondary variable value used by 
the system. 

SV Actual 
Mode 

This read-only field shows the source for the 
secondary variable value used by the system. 
Possible values are: 

Polling 
Disabled 

The system is not currently polling for 
this variable. 

Live The system uses the live value 
received from the HART device. 

Override The system uses the value set in the SV 
Override Value field. 

Fault The system uses the value set in the SV 
Fault Value field. 

Last 
Good 

The system uses the value shown in 
the Last Good Value field. 

SV Selected 
Value 

This read-only field shows the current in-use 
secondary variable value. 

SV Operation 
Mode 

Sets the operation mode of the secondary variable. 

Live The system uses the live value 
received from the HART device. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

291 

Field Description 

Override The system uses the value set in the SV 
Override Value field. 

SV Override 
Value 

Sets the secondary variable value to use when the 
SV Operation Mode is set to Override. 

SV Live Value This read-only field shows the live secondary 
variable value received from the HART device. 

SV Fault Mode Sets the source of the secondary variable value 
when a fault is encountered. 

Fault The system uses the value set in the SV 
Fault Value field. 

Last 
Good 

The system uses the value shown in 
the Last Good Value field. 

SV Fault Value Sets a value to use for the secondary variable when 
a fault occurs and the SV Fault Mode field is set to 
Fault. 

SV Last Good 
Value 

This read-only field shows the last known good 
value received from the HART device. 

Tertiary 
Variables 

Use these fields to configure the tertiary variable value used by the 
system. 

TV Actual 
Mode 

This read-only field shows the source for the 
tertiary variable value used by the system.  

Polling 
Disabled 

The system is not currently polling for 
this variable. 

Live The system uses the live value 
received from HART device. 

Override The system uses the value set in the TV 
Override Value field. 

Fault The system uses the value set in the TV 
Fault Value field. 

Last 
Good 

The system uses the value shown in 
the Last Good Value field. 

TV Selected 
Value 

This read-only field shows the current in-use 
tertiary variable value. 
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Field Description 

TV Operation 
Mode 

Sets the operation mode of the tertiary variable. 

Live The system uses the live value 
received from the HART device. 

Override The system uses the value set in the TV 
Override Value field. 

TV Override 
Value 

Sets the tertiary variable value to use when the TV 
Operation Mode is set to Override. 

TV Live Value This read-only field shows the live tertiary variable 
value received from the HART device. 

TV Fault 
Mode 

Sets the source of the tertiary variable value when 
a fault is encountered. 

Fault The system uses the value set in the 
TV Fault Value field. 

Last Good The system uses the value shown in 
the Last Good Value field. 

TV Fault 
Value 

Sets a value to use for the tertiary variable when a 
fault occurs and the TV Fault Mode field is set to 
Fault. 

TV Last Good 
Value 

This read-only field shows the last known good 
value received from the HART device. 

Quaternary 
Variables 

Use these fields to configure the quaternary variable value used by 
the system. 

QV Actual 
Mode 

This read-only field shows the source for the 
quaternary variable value used by the system.  

Polling 
Disabled 

The system is not currently polling for 
this variable. 

Live The system uses the live value 
received from the HART device. 

Override The system uses the value set in the 
QV Override Value field. 

Fault The system uses the value set in the 
QV Fault Value field. 
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Field Description 

Last 
Good 

The system uses the value shown in 
the Last Good Value field. 

QV Selected 
Value 

This read-only field shows the current in-use 
quaternary variable value. 

QV Operation 
Mode 
 

Sets the operation mode of the quaternary 
variable. 

Live The system uses the live value 
received from the HART device. 

Override The system uses the value set in the 
QV Override Value field. 

QV Override 
Value 

Sets the quaternary variable value to use when the 
QV Operation Mode is set to Override. 

QV Live Value This read-only field shows the live quaternary 
variable received from the HART device. 

QV Fault 
Mode 
 

Sets the source of the quaternary value when a 
fault is encountered. 

Fault The system uses the value set in the 
QV Fault Value field. 

Last Good The system uses the value shown in 
the Last Good Value field. 

QV Fault 
Value 

Sets a value to use for the quaternary variable 
when a fault occurs and the QV Fault Mode field is 
set to Fault. 

QV Last Good 
Value 

This read-only field shows the last known good 
value received from the HART device. 

4. Select Save to save any changes you make to this tab. 

4.5.4.2 Configuring HART® I/O 

Use these steps to configure HART® I/O on your FB3000 RTU. 

To configure HART I/O: 

1. Select Configure > I/O Setup > HART I/O from the FBxConnect™ main menu. The 
HART display opens. 
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Figure 121. HART 

 

2. Click ▼ in the drop-down list at the top of the display to select a HART channel to 
configure; there are four HART channels per module. 

3. Specify whether this is a Primary or Secondary HART Master in the HART Master 
Type field. 

4. Choose the HART Comm Mode: 

• If you have a single HART device on the channel, select Point to Point. 

• If multiple devices are multi-dropped on the channel, select Multidrop and specify 
the Number of Devices. 

5. Select if HART pass through communications are allowed and if the FB Series devices 
removes the preamble bytes in HART protocol (Strip) or if the entire message is 
forwarded (Full) in the Pass Through Mode field. 
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6. Click Save. If you chose Multidrop, the HART menu creates a button for each of the 
devices. 

7. Click on the Device button to configure the HART device on this channel. The HART 
Device display opens. 

Note 

For more information, refer to HART Device. 

Figure 122. HART Device 

 

8. Select the variables you want to poll from the device, then click Save and Close the 
screen. 

9. If this channel uses multi-drop, repeat steps 8 and 9 for any other connected HART 
devices. 

4.5.5 Differential Pressure 

Use this display to view and configure general parameters associated with the differential 
pressure input, set the calibration timeout period, and view calibration/verification values.  
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Note 

To view this display, you must first enable 4088B communications on either COM3 or 
COM4. For more information, refer to Port Owner field on the Communications – General 
tab. 

To access this display, select Configure > I/O Setup > Differential Pressure from the 
FBxConnect™ main menu.  

Figure 123. I/O Setup – Differential Pressure 

 

The Differential Pressure contains the following items: 

General – Use this display to view and configure general parameters associated with the 
differential pressure input. 

Calibration Values – Use this pop-up display to set the calibration timeout period and view 
previous calibration/verification values. 

4.5.5.1 Differential Pressure – General 

Use this display to view and configure general parameters associated with the differential 
pressure input. 

To access this display: 

1. Select Configure > I/O Setup > Differential Pressure from the FBxConnect™ main 
menu. The Differential Pressure display opens. 
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Figure 124. Differential Pressure – General 

 

2. Click ▼ in the sensor drop-down list and select the sensor you want to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
sensor. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
sensor. 

Module 
Location 

This read-only field shows the location of the module in your FB 
Series product. 
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Field Description 

Channel This read-only field shows the unique channel number for this 
differential pressure instance. 

Alarm 
Reference 

This read-only field shows you which alarm is currently configured 
for the point. 

Note 

Click  to open the Alarms display and configure the alarm 

parameters. 

Input Health 
Status 

This read-only field shows the status of the input. Possible values 
are: 

• Normal 

• Not Licensed 

• Instance Inactive 

• Comm Fail 

• Override Active 

• In Alarm 

• Point Fail 

• Above URL 

• Below LRL 

• Input Frozen 

Calibration 
Status 

This read-only field shows the current calibration status of the 
selected channel.  

Calibration 
Values 

Select this button to open a pop-up display where you can set the 
calibration timeout period and view previous calibration/verification 
values. 

Live Value This read-only field shows the current value (in engineering units) of 
the selected sensor. 

Override 
Value 

Sets the value (in engineering units) written to the Selected Value 
field when the Operation Mode is set to Override. 

Selected Value This read-only field shows the value (in engineering units) based on 
the Operation Mode and Fault Mode fields, as well as the health 
status of the selected sensor. It is intended to be used as an input to 
calculations and control logic. 
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Field Description 

Fault Value Sets the value (in engineering units) written to the Selected Value 
parameter when a fault occurs on the selected sensor and the Fault 
Mode is set to Fault. 

Last Good 
Value 

This read-only field shows the last good value (in engineering units) 
received by the selected sensor. This value is written to the Selected 
Value parameter if a fault occurs and the Fault Mode is set to Last 
Good. 

Reverse 
Differential 
Pressure 

This read-only field shows the Selected Value multiplied by −1. 

Upper Range 
Limit 

This read-only field shows the maximum amount of differential 
pressure the sensor can detect. 

Lower Range 
Limit 

This read-only field shows the minimum amount of differential 
pressure the sensor can detect. 

Monitor 
Maximum 

Sets the maximum value of the differential pressure gauge shown on 
the Monitor > Main display. 

Note 

• To avoid prolonged display rendering times, limit the scale range 
to no more than 10,000.  

• This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 

Monitor 
Minimum 

Sets the minimum value of the differential pressure gauge shown on 
the Monitor > Main display. 

Note 

• To avoid prolonged display rendering times, limit the scale range 
to no more than 10,000.  

• This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 

Minimum 
Span 

This read-only field shows the minimum span of the sensor. 

Units Sets the measurement units to use with the differential pressure 
input value. 

Operation 
Mode 

Sets how the system acquires the value written to the Selected Value 
parameter under normal operation. Possible options are: 
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Field Description 

Live The system copies the Live Value to the Selected Value 
parameter. 

Override The system copies the Override Value to the Selected 
Value parameter. 

Note 

If a fault occurs and the operation mode is set to 
Override, the Selected Value parameter is set to the 
Override Value and is not set based on the Fault 
Mode. 

Fault Mode Sets how the system acquires the value written to the Selected Value 
parameter when a fault occurs. 

Live The system copies the value of the Live Value field to 
the Selected Value Parameter. 

Fault The system copies the value set in the Fault Value 
field to the Selected Value parameter. 

Last Good The system copies the value of the Last Good Value 
field to the Selected Value parameter. 

Damping Time Sets a time (in seconds) used to dampen the reading of the signal 
from the sensor. Small fluctuations can occur with every reading. The 
damping time is used to give a value that is less prone to those 
fluctuations, based on the previous read value. A value of 0.0 disables 
damping. 

4. Select Save to save any changes you make to this display. 

4.5.5.2 Differential Pressure – Calibration Values 

Use this pop-up display to set the calibration timeout period and view previous 
calibration/verification values. 

To access this pop-up display: 

1. Select Configure > I/O Setup > Differential Pressure from the FBxConnect™ main 
menu. 

2. Click ▼ in the sensor drop-down list and select the sensor you want to configure. 

3. Select the Calibration Values button. The Calibration Values pop-up display opens. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

301 

Figure 125. Differential Pressure – Calibration Values 
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4. Review – and change as necessary – the values in the following fields: 

Field Description 

Inactivity 
Timeout 

Sets the period of time (in minutes) the system waits for activity 
during the calibration process. If no activity occurs during the 
specified time period, the calibration automatically ends. The default 
is 60 minutes.  

Zero Shift This read-only field shows the offset applied to the input to 
compensate for environmental factors to set the reading as close to 
zero as possible. 

Calibration 
Values 

These read-only fields show the date and time of the last calibration, 
and the Calibrated Zero, Midpoints, and Span. 

Verification 
Values 

These read-only fields show the date and time of the last verification, 
and the Actual and Expected values of that verification. 

5. Select Save to save any changes you make to this tab. 

4.5.5.3 Configuring Differential Pressure Inputs 

Use these steps to configure a differential pressure input on your FB Series product. 

To configure a differential pressure input: 

1. Select Configure > I/O Setup > Differential Pressure from the FBxConnect™ main 
menu. 
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Figure 126. Differential Pressure – General 

 

2. Click ▼ in the drop-down list at the top of the display to select a differential pressure 
input to configure. 

3. In the Tag field, enter a name for the selected input. 

4. In the Description field, enter a description for the selected input. 

5. In the Units frame, set the engineering units used for the selected channel. 

6. In the Operation Mode frame, set how the system acquires the value of the selected 
channel under normal operating conditions. 
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Note 

If you select Override, you must enter a value in the Override Value field. 

7. In the Fault Mode frame, set how the system acquires the value written to the 
Selected Value parameter when a fault occurs (Live, Fault, or Last Good). 

Note 

If you select Fault, you must enter a value in the Fault Value field. 

8. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to Differential Pressure. 

9. Select Save to save your changes to device memory. 

4.5.6 Pressure 

Use this display to view and configure general parameters associated with the static 
pressure input, set the calibration timeout period, and view calibration/verification values.  

Note 

To view this display, you must first enable 4088B communications on either COM3 or 
COM4. For more information, refer to Port Owner field on Communications – General. 

To access this display, select Configure > I/O Setup > Pressure from the FBxConnect™ 
main menu.  
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Figure 127. I/O Setup – Pressure 

 

The Pressure display has the following sections: 

General – Use this display to view and configure general parameters associated with the 
static pressure input. 

Calibration Values – Use this pop-up display to set the calibration timeout period, and to 
view previous calibration/verification values. 

4.5.6.1 Pressure – General 

Use this display to view and configure general parameters associated with the static 
pressure input. 

To access this display: 

1. Select Configure > I/O Setup > Pressure from the FBxConnect™ main menu. The 
Pressure display opens. 
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Figure 128. Pressure – General  

 

2. Click ▼ in the sensor drop-down list and select the sensor you want to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
sensor. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
sensor. 

Module 
Location 

This read-only field shows the location of the module in your FB 
Series product. 
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Field Description 

Channel This read-only field shows the unique channel number for this static 
pressure instance. 

Alarm 
Reference 

This read-only field shows you which alarm is currently configured 
for the point. 

Note 

Click  to open the Alarms display and configure the alarm 

parameters. 

Input Health 
Status 

This read-only field shows the status of the input. Possible values 
are: 

• Normal 

• Not Licensed 

• Instance Inactive 

• Comm Fail 

• Override Active 

• In Alarm 

• Point Fail 

• Above URL 

• Below LRL 

• Input Frozen 

Calibration 
Status 

This read-only field shows the current calibration status of the 
selected channel.  

Calibration 
Values 

Select this button to open a pop-up display where you can set the 
calibration timeout period and view previous calibration/verification 
values. 

Live Value This read-only field shows the current value (in engineering units) of 
the selected sensor. 

Override 
Value 

Sets the value (in engineering units) written to the Selected Value 
field when the Operation Mode is set to Override. 

Selected Value This read-only field represents the value (in engineering units) based 
on the Operation Mode and Fault Mode fields, as well as the health 
status of the selected sensor. It is intended to be used as an input to 
calculations and control logic. 
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Field Description 

Fault Value Sets the value (in engineering units) written to the Selected Value 
parameter when a fault occurs on the selected sensor and the Fault 
Mode is set to Fault. 

Last Good 
Value 

This read-only field shows the last good value (in engineering units) 
received by the selected sensor. This value is written to the Selected 
Value parameter if a fault occurs and the Fault Mode is set to Last 
Good. 

Upper Range 
Limit 

This read-only field shows the maximum amount of static pressure 
the sensor can detect. 

Lower Range 
Limit 

This read-only field shows the minimum amount of static pressure 
the sensor can detect. 

Monitor 
Maximum 

Sets the maximum value of the static pressure gauge shown on the 
Monitor > Main display. 

Note  

• To avoid prolonged display rendering times, limit the scale range 
to no more than 10,000.  

• This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 

Monitor 
Minimum 

Sets the minimum value of the static pressure gauge shown on the 
Monitor > Main display. 

Note  

• To avoid prolonged display rendering times, limit the scale range 
to no more than 10,000.  

• This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 

Minimum 
Span 

This read-only field shows the minimum span of the sensor. 

Units Sets the measurement units to use with the pressure input value. 

Operation 
Mode 

Sets how the system acquires the value written to the Selected Value 
parameter under normal operation. 

Live The system copies the Live Value to the Selected Value 
parameter. 
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Field Description 

Override The system copies the Override Value to the Selected 
Value parameter. 

Note 

If a fault occurs and the operation mode is set to 
Override, the Selected Value parameter is set to the 
Override Value and is not set based on the Fault Mode. 

Fault Mode Sets how the system acquires the value written to the Selected Value 
parameter when a fault occurs. 

Live The system copies the Live Value to the Selected Value 
parameter. 

Fault The system copies the Fault Value to the Selected 
Value parameter. 

Last Good The system copies the Last Good Value to the Selected 
Value parameter. 

Damping Time Sets a time (in seconds) used to dampen the reading of the signal 
from the sensor. Small fluctuations can occur with every reading. The 
damping time is used to give a value that is less prone to those 
fluctuations, based on the previous read value. A value of 0.0 disables 
damping. 

4. Select Save to save any changes you make to this display. 

4.5.6.2 Pressure – Calibration Values 

Use this pop-up display to set the calibration timeout period, and to view previous 
calibration/verification values. 

To access this pop-up display: 

1. Select Configure > I/O Setup > Pressure from the FBxConnect™ main menu. 

2. Click ▼ in the sensor drop-down list and select the sensor you want to configure. 

3. Select the Calibration Values button. The Calibration Values pop-up display opens. 
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Figure 129. Pressure – Calibration Values 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Inactivity 
Timeout 

Sets the period of time (in minutes) the system waits for activity 
during the calibration process. If no activity occurs during the 
specified time period, the calibration automatically ends. The default 
is 60 minutes.  

Zero Shift This read-only field shows the offset applied to the input to 
compensate for environmental factors to set the reading as close to 
zero as possible. 

Calibration 
Values 

These read-only fields show the date and time of the last calibration, 
and the Calibrated Zero, Midpoints, and Span. 
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Field Description 

Verification 
Values 

These read-only fields show the date and time of the last 
verification, and the Actual and Expected values of that verification. 

5. Select Save to save any changes you make to this pop-up display. 

4.5.6.3 Configuring Static Pressure Inputs 

Use these steps to configure a static pressure input on your FB Series product. 

To configure a static pressure input: 

1. Select Configure > I/O Setup > Pressure from the FBxConnect™ main menu. 

Figure 130. Pressure – General 
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2. Click ▼ in the drop-down list at the top of the display to select a static pressure input 
to configure. 

3. In the Tag field, enter a name for the selected input. 

4. In the Description field, enter a description for the selected input. 

5. In the Units frame, set the engineering units used for the selected channel. 

6. In the Operation Mode frame, set how the system acquires the value of the selected 
channel under normal operating conditions. 

Note 

If you select Override, you must enter a value in the Override Value field. 

7. In the Fault Mode frame, set how the system acquires the value written to the 
Selected Value parameter when a fault occurs (Live, Fault, or Last Good). 

Note 

If you select Fault, you must enter a value in the Fault Value field. 

8. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to Pressure. 

9. Select Save to save your changes to device memory. 

4.5.7 RTD 

Use this display to view and configure general RTD parameters, set the calibration 
timeout period, and view calibration/verification values.  

Note 

To view this display, you must first enable 4088B communications on either COM3 or 
COM4. For more information, refer to Port Owner field on the Communications – General 
tab. 
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To access this display, select Configure > I/O Setup > RTD from the FBxConnect™ main 
menu.  

Figure 131. I/O Setup – RTD 

 

The RTD display contains the following items: 

General – Use this display to view and configure general RTD parameters. 

Calibration Values – Use this pop-up display to set the calibration timeout period, and to 
view previous calibration/verification values. 

4.5.7.1 RTD – General  

Use this display to view and configure general RTD parameters. 

To access this display: 

1. Select Configure > I/O Setup > RTD from the FBxConnect™ main menu. The RTD 
display opens. 
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Figure 132. RTD – General  

 

2. Click ▼ in the drop-down list at the top of the display to select an RTD to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
RTD. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
RTD. 

Module 
Location 

This read-only field shows the location of the module in your FB 
Series product. 

Channel This read-only field shows the unique channel number for this RTD 
instance. 
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Field Description 

Alarm 
Reference 

This read-only field shows you which alarm is currently configured 
for the point. 

Note 

Click  to open the Alarms display and configure the alarm 

parameters. 

Input Health 
Status 

This read-only field shows the status of the selected channel. 
Possible values are: 

• Normal 

• Not Licensed 

• Instance Inactive 

• Comm Fail 

• Override Active 

• In Alarm 

• Point Fail 

• Above URL 

• Below LRL 

• Input Frozen 

• Type Mismatch 

Calibration 
Status 

This read-only field shows the current calibration status of the 
selected channel. Possible values are: 

• Calibration Not In Progress 

• Input Frozen 

• Calibration In Progress 

• Set Command Failed 

• Timeout Occurred 

• Span Too Small 

• Excess Correction 

• Passed Parameter Too Small 

• Passed Parameter Too Large 

• Ideal Value Too Small 

• Ideal Value Too Large 
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Field Description 

• Wrong Command 

• Verification In Progress 

Calibration 
Values 

Select this button to open a pop-up display where you can set the 
calibration timeout period and view previous calibration/verification 
values. 

Live Value This read-only field shows the current value (in engineering units) of 
the RTD. 

Override 
Value 

Sets the value (in engineering units) written to the Selected Value 
field when the Operation Mode is set to Override. 

Selected Value This read-only field represents the value (in engineering units) based 
on the Operation Mode and Fault Mode fields, as well as the health 
status of the selected sensor. It is intended to be used as an input to 
calculations and control logic. 

Fault Value Sets the value (in engineering units) written to the Selected Value 
parameter when a fault occurs on the selected sensor and the Fault 
Mode is set to Fault. 

Last Good 
Value 

This read-only field shows the last good value (in engineering units) 
received by the selected sensor. This value is written to the Selected 
Value parameter if a fault occurs and the Fault Mode is set to Last 
Good. 

Minimum 
Span 

This read-only field shows the minimum difference between the zero 
and the span (in engineering units). When performing a calibration, 
the span must at least be greater than the zero by the value of this 
parameter. 

Upper Range 
Limit 

This read-only field shows the maximum temperature the RTD can 
detect. 

Lower Range 
Limit 

This read-only field shows the minimum temperature the RTD can 
detect. 

Monitor 
Maximum 

Sets the maximum value of the temperature gauge shown on the 
Monitor > Main display. 

Note  

• To avoid prolonged display rendering times, limit the scale 
range to no more than 10,000.  
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Field Description 

• This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 

Monitor 
Minimum 

Sets the minimum value of the temperature gauge shown on the 
Monitor > Main display. 

Note  

• To avoid prolonged display rendering times, limit the scale range 
to no more than 10,000.  

• This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 

Minimum 
Span 

This read-only field shows the minimum span of the sensor. 

Units Sets the measurement units to use with the RTD input value. 

Operation 
Mode 

Sets how the system acquires the value written to the Selected Value 
parameter under normal operation. 

Live The system copies the Live Value to the Selected Value 
parameter. 

Override The system copies the Override Value to the Selected 
Value parameter. 

Note 

If a fault occurs and the operation mode is set to 
Override, the Selected Value parameter is set to the 
Override Value and is not set based on the Fault 
Mode. 

Fault Mode Sets how the system acquires the value written to the Selected Value 
parameter when a fault occurs. 

Live The system copies the Live Value to the Selected Value 
parameter. 

Fault The system copies the Fault Value to the Selected 
Value parameter. 

Last Good The system copies the Last Good Value to the Selected 
Value parameter. 
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Field Description 

Damping Time Sets a time (in seconds) used to dampen the reading of the signal 
from the sensor. Small fluctuations can occur with every reading. The 
damping time is used to give a value that is less prone to those 
fluctuations, based on the previous read value. A value of 0.0 disables 
damping. 

RTD Type Specifies the wiring and signal type of the RTD used by the FB Series 
product. Possible options are 3-wire or 4-wire. 

CVD Curve 
Selection 

Click ▼ to select the Callendar-Van Dusen equation to use for the 
RTD. The Callendar-Van Dusen equation describes the relationship 
between resistance (R) and temperature (T) of a resistance 
temperature detector (RTD). The form of the equation is as follows: 

 

 

You can pick from two pre-defined sets of coefficients for the 
equation based on a specific material temperature coefficient of 
resistance (Alpha) or you can select a user set of coefficients. The 
Alpha value will be specified by the RTD manufacturer. 

4. Select Save to save any changes you make to this display. 

4.5.7.2 RTD – Calibration Values  

Use this pop-up display to set the calibration timeout period, and to view previous 
calibration/verification values. 

To access this pop-up display: 

1. Select Configure > I/O Setup > RTD from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select an RTD to configure. 

3. Select the Calibration Values button. The Calibration Values pop-up display opens. 
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Figure 133. RTD – Calibration Values  

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Inactivity 
Timeout 

Sets the period of time (in minutes) the system waits for activity 
during the calibration process. If no activity occurs during the 
specified time period, the calibration automatically ends. The default 
is 60 minutes.  

Zero Shift This read-only field shows the offset applied to the input to 
compensate for environmental factors to set the reading as close to 
zero as possible. 

Calibration 
Values 

These read-only fields show the date and time of the last calibration, 
and the Calibrated Zero, Midpoints, and Span. 
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Field Description 

Verification 
Values 

These read-only fields show the date and time of the last 
verification, and the Actual and Expected values of that verification. 

5. Select Save to save any changes you make to this pop-up display. 

4.5.7.3 Configuring an RTD 

Use these steps to configure an RTD on your FB Series product. 

To configure an RTD: 

1. Select Configure > I/O Setup > RTD from the FBxConnect™ main menu. 

Figure 134. RTD – General  

 

2. Click ▼ in the drop-down list at the top of the display to select an RTD to configure. 
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3. In the Tag field, enter a name for the selected channel. 

4. In the Description field, enter a description for the selected channel. 

5. In the RTD Type field, select type of RTD used by the FB Series product. Possible 
options are  

6. In the CVD Curve frame, set the Callendar-Van Dusen constants to use for the RTD. 

7. In the Units frame, set the engineering units used for the selected input. 

8. In the Operation Mode frame, set how the system acquires the value of the selected 
input under normal operating conditions. 

Note 

If you select Override, you must enter a value in the Override Value field. 

9. In the Fault Mode frame, set how the system acquires the value written to the 
Selected Value parameter when a fault occurs (Live, Fault, or Last Good). 

Note 

If you select Fault, you must enter a value in the Fault Value field. 

10. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to RTD. 

11. Select Save to save your changes to device memory. 

4.5.8 MV Sensor 

Use this display to view multivariable sensor values and properties for both the integral 
sensor and 4088B MultiVariable Transmitter. 

Note 

To view this display, you must first enable 4088B communications on either COM3 or 
COM4. For more information, refer to Port Owner field on the Communications – General 
display. 

To access this display: 

1. Select Configure > I/O Setup > MV Sensor from the FBxConnect™ main menu. 
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Figure 135. MV Sensor  

 

2. Click ▼ in the drop-down list at the top of the display to select a sensor to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
sensor. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
sensor. 

Serial Number This read-only field shows the serial number of the sensor. 

Sensor App 
FW Revision 

This read-only field shows the firmware revision level of the sensor. 

Sensor Status This read-only field shows the status of the sensor. 
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Field Description 

Details Click open the Sensor Status Details pop-up display 
and view possible MV sensor status conditions. 

Note 

Current active statuses are selected with a check 
mark. 

Differential 
Pressure 
Object 

This read-only field shows the differential pressure parameter in the 
FB Series product currently configured for the selected sensor, and 
the current value of that parameter. 

Static 
Pressure 
Object 

This read-only field shows the static pressure parameter in the FB 
Series product currently configured for the selected sensor, and the 
current value of that parameter. 

Flowing 
Temperature 
Object 

This read-only field shows the temperature of the fluid in the meter. 

Sensor 
Temperature 

This read-only field shows the current temperature of the selected 
sensor. 

Note 
This field appears only if you select a 4088B in the MV Sensor drop-
down list. 

Upper Range 
Limit 

This read-only field shows the upper temperature range limit of the 
selected sensor. 

Note 
This field appears only if you select a 4088B in the MV Sensor drop-
down list. 

Lower Range 
Limit 

This read-only field shows the lower temperature range limit of the 
selected sensor. 

Note 
This field appears only if you select a 4088B in the MV Sensor drop-
down list. 

Sensor 
Configuration 

This read-only field shows the connection type of the sensor in the 
current configuration. 

Static 
Pressure Type 

This read-only field shows the type of static pressure returned from 
the currently configured sensor. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

324 

Field Description 

Sensor Type This read-only field shows the type of sensor connected in the 
current configuration. 

Flange Type This read-only field shows the type of flange in the currently 
configured sensor. 

DP Range This read-only field shows the differential pressure range of the 
currently configured sensor. 

SP Range This read-only field shows the static pressure range of the currently 
configured sensor. 

O-ring 
Material 

This read-only field shows the O-ring construction material in the 
currently configured sensor. 

Flange 
Material 

This read-only field shows the flange construction material in the 
currently configured sensor. 

Module 
Isolate 
Material 

This read-only field shows the module isolate construction material 
in the currently configured sensor. 

Drain Vent 
Material 

This read-only field shows the drain vent construction material in the 
currently configured sensor. 

Module Fill 
Fluid 

This read-only field shows the type of module fill fluid in the 
currently configured sensor. 

4. Select Save to save any changes you make to this display. 

4.5.8.1 Sensor Status Details 

Use this display to view status conditions associated with your multivariable sensor. 

Note  

Current active statuses are selected with a check mark. 

To access this display: 

1. Select Configure > I/O Setup > MV Sensor from the FBxConnect™  main menu. The 
Transmitter Sensor display opens. 

2. Click ▼ in the drop-down list at the top of the display to select a sensor to configure. 

3. Select the Details button.  
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Figure 136. Sensor Status 

 

4.5.9 Analog Input 

Use this display to view and configure general parameters associated with analog inputs.  

To access this display, select Configure > I/O Setup > AI from the FBxConnect™ main 
menu.  
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Figure 137. I/O Setup – AI 

 

The Analog Input display contains the following items: 

General – Use this display to configure the analog inputs. 

Calibration Values – Use this pop-up display to set the calibration timeout period, and to 
view previous calibration/verification values. 

4.5.9.1 Analog Input – General  

Use this display to configure the analog inputs. Analog inputs are analog signals that 
measurement devices (such as pressure and temperature transmitters, including RTD 
probes and pressure sensors) generate. 

To access this display: 

1. Select Configure > I/O Setup > AI from the FBxConnect™ main menu. The Analog 
Input display opens. 
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Figure 138. Analog Input – General 

 

2. Click ▼ in the drop-down list at the top of the display to select an analog input 
channel to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected channel. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected channel. 

Module 
Location 

This read-only field shows the location of the module in your FB 
Series product. 

Channel This read-only field shows the currently selected channel. 
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Field Description 

Alarm 
Reference 

This read-only field shows you which alarm is currently configured 
for the selected channel. 

Note 

Click  to open the Alarms display and configure the alarm 

parameters for the selected channel. 

Input Health 
Status 

This read-only field shows the status of the selected channel. 
Possible values are: 

• Normal 

• Disabled 

• Not Licensed 

• Instance Inactive 

• Comm Fail 

• Override Active 

• In Alarm 

• Point Fail 

• Above CAL Limit 

• Below CAL Limit 

• Input Frozen 

• Input Clipped 

• Factory Calibration Invalid 

• User Calibration Invalid 

• Termination Missing 

• Hardware Fail 

Calibration 
Status 

This read-only field shows the current calibration status of the 
selected channel. Possible values are: 

• Calibration Not In Progress 

• Input Frozen 

• Calibration In Progress 

• Set Command Failed 

• Timeout Occurred 

• Span Too Small 
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Field Description 

• Excess Correction 

• Wrong Command 

• Verification In Progress 

Actual Mode This read-only field shows the source of the selected value. Possible 
values are: 

• Live 

• Override 

• Calibration 

• Fault 

• Last Good 

Calibration 
Values 

Select this button to open a pop-up display where you can set the 
calibration timeout period and view previous calibration/verification 
values. 

Live Value This read-only field shows the current value (in engineering units) 
from the field device. 

Raw Value This read-only field shows the current digital count directly from 
the Analog-to-Digital converter. 

Low Reading EU Sets the low reading (in engineering units) that is equal to zero 
percent input. For example, if a temperature transmitter is 
connected to the analog input with a range of –40 to 160 degrees F, 
the Low field would be set to –40. 

Note 

You must select EU Scaling in the EU Scaling Mode frame to modify 
this field. 

High Reading 
EU 

Sets the high reading (in engineering units) that is equal to 100 
percent input. For example, if a temperature transmitter is 
connected to the analog input with a range of – 40 to 160 degrees F, 
the High field would be set to 160. 

Note 

You must select EU Scaling in the EU Scaling Mode frame to modify 
this field. 
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Field Description 

Adjusted A/D 0 
Percent 

Sets the calibrated Analog-to-Digital count corresponding to zero 
percent input. In the Calibrate function, this value is altered to set 
the zero percent input exactly at the Low Reading EU value. 

Note 

You must select EU Scaling in the EU Scaling Mode frame to modify 
this field. 

Adjusted A/D 
100 Percent 

Sets the calibrated Analog-to-Digital count corresponding to 100 
percent input. Use this value to convert the input to engineering 
units. In the Calibrate function, this value is altered to set the 100 
percent input exactly at the High Reading EU value. 

Note 

You must select EU Scaling in the EU Scaling Mode frame to modify 
this field. 

Operation 
Mode 

Sets how the system acquires the value written to the Selected 
Value parameter under normal operation. Possible options are: 

Live The system copies the Live Value to the Selected 
Value parameter. 

Override The system copies the value set in the Override Value 
field to the Selected Value parameter. 

Note 

If a fault occurs and the operation mode is set to 
Override, the Selected Value parameter is set to the 
Override Value and is not set based on the Fault 
Mode. 

Override Value Sets the value (in engineering units) written to the Selected Value 
field when the Operation Mode is set to Override. 

Selected Value This read-only field shows the value (in engineering units) based on 
the Operation and Fault Mode fields, as well as the health status of 
the selected input. It is intended to be used as an input to 
calculations and control logic. 

Fault Mode Sets how the system acquires the value written to the Selected 
Value parameter when a fault occurs. 

Fault The system copies the value set in the Fault Value 
field to the Selected Value parameter. 
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Field Description 

Last Good The system copies the value of the Last Good Value 
field to the Selected Value parameter. 

Fault Value Sets the value (in engineering units) that is written to the Selected 
Value parameter when a fault occurs on the selected sensor and the 
Fault Mode is set to Fault. 

Last Good Value This read-only field shows the last good value (in engineering units) 
received by the selected sensor. This value is written to the Selected 
Value parameter if a fault occurs and the Fault Mode is set to Last 
Good. 

Units Sets the measurement type and engineering units used for the 
selected channel. 

Type Sets the measurement type used for the selected 
channel. 

Units Sets the engineering units used for the selected 
channel. 

Note 

Changing the Units does not alter the value of 
parameters. 

Range Limits Shows the minimum and maximum value that the analog input can 
measure. 

Lower 
Range 
Limit 

This read-only field shows the minimum value (in A/D 
counts) that the analog input can measure. 

Upper 
Range 
Limit 

This read-only field shows the maximum value (in 
A/D counts) that the analog input can measure. 

Clipping Mode Sets if clipping occurs on the selected input. Clipping forces the 
Selected Value to stay within a range defined by the Low Clipping 
Limit and High Clipping Limit. Clipping is only applied when there is 
not a fault. 

Enable Clipping does occur. 

Note 

You must enter a value in the Low Clipping Limit and 
High Clipping Limit fields. 
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Field Description 

Disable Clipping does not occur. 

Low 
Clipping 
Limit 

When clipping is enabled, this field sets the lower 
limit of the Selected Value parameter. 

High 
Clipping 
Limit 

When clipping is enabled, this field sets the upper 
limit of the Selected Value parameter. 

EU Scaling 
Mode 

Specifies how the EU scaling parameters are determined. 

Multi-
Point 
Calibration 

EU scaling parameters are determined by the 
calibration. You cannot modify the EU scaling 
parameters (Low Reading EU, High Reading EU, 
Adjusted A/D 0 Percent, Adjusted A/D 100 Percent) 
directly. You must use the calibration wizard to adjust 
the scaling of the AI.  

Note 

If you download a configuration file that has Multi-
Point Calibration selected, the calibration on your 
device remains unchanged. 

EU Scaling EU scaling parameters are determined by the values 
you enter in the Low Reading EU, High Reading EU, 
Adjusted A/D 0 Percent, Adjusted A/D 100 Percent 
fields. 

Note 

If you download a configuration file that has EU 
Scaling selected, the existing calibration on your 
device is overwritten using the EU scaling 
parameters. 

Current/Voltage 
Selection 

Sets if the channel measures either current input, voltage input or is 
disabled. 

Note  

• The default Current/Voltage Selection is disabled. You must 
select either Current or Voltage before the AI will scan a field 
device. 

• When Current Input is selected, an on-board software 
switchable 250-ohm resistor is enabled for the selected channel. 
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Field Description 

• For channels on a HART module, the only available options are 
Disabled and Current. 

Durations Sets the damping time and averaging period for the input. 

Damping 
Time 

Sets a time (in seconds) used to dampen the reading 
of the AI. Small fluctuations can occur with every 
reading. The damping time is used to give a value 
that is less prone to those fluctuations, based on the 
value previous read. A value of 0.0 will disable 
damping. 

Averaging 
Period 

When the Operation Mode is set to Live, this field 
defines the period over which the Live Value will be 
averaged before it is written to the Selected Value. 

4. Select Save to save any changes you make to this display. 

4.5.9.2 Analog Input – Calibration Values 

Use this pop-up display to set the calibration timeout period, and to view previous 
calibration/verification values. 

To access this pop-up display: 

1. Select Configure > I/O Setup > AI from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select an analog input 
channel to configure. 

3. Select the Calibration Values button. The Calibration Values pop-up display opens. 
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Figure 139. AI – Calibration Values 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Inactivity 
Timeout 

Sets the period of time (in minutes) the system waits for activity 
during the calibration process. If no activity occurs during the 
specified time period, the calibration automatically ends. The default 
is 60 minutes.  

Zero Shift This read-only field shows the offset applied to the input to 
compensate for environmental factors to set the reading as close to 
zero as possible. 

Calibration 
Values 

These read-only fields show the date and time of the last calibration, 
and the Calibrated Zero, Midpoints, and Span. 

Verification 
Values 

These read-only fields show the date and time of the last 
verification, and the Actual and Expected values of that verification. 
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5. Select Save to save any changes you make to this pop-up display. 

4.5.9.3 Configuring Analog Inputs 

Use these steps to configure an analog input on your FB Series product. 

Note 

You must configure I/O types before you configure I/O. For more information, refer to 
I/O Configuration. 

To configure an analog input: 

1. Select Configure > I/O Setup > AI from the FBxConnect™ main menu. 

Figure 140. Analog Input – General 

 

2. Click ▼ in the drop-down list at the top of the display to select an analog input 
channel to configure. 
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3. In the Tag field, enter a name for the selected channel. 

4. In the Description field, enter a description for the selected channel. 

5. In the Current/Voltage Selection frame, select either Current or Voltage to set if the 
channel measures current or voltage. 

Note 

• The default Current/Voltage Selection is disabled. You must select either Current or 
Voltage before the AI will scan a field device. 

• When Current Input is selected, an on-board software switchable 250-ohm resistor is 
enabled for the selected channel. 

• For channels on a HART module, the only available options are Disabled and Current. 

6. Select Save to save your changes to device memory. 

7. In the Units frame, set the measurement type and engineering units used for the 
selected channel. 

8. In the Operation Mode frame, set how the system acquires the value of the selected 
channel under normal operating conditions. 

Note 

If you select Override, you must enter a value in the Override Frequency field. 

9. In the EU Scaling Mode frame, set how the EU scaling parameters are determined. 

Note 

If you select EU Scaling, you must select Save and manually enter values in the Low 
Reading EU, High Reading EU, Adjusted A/D 0 Percent, Adjusted A/D 100 Percent fields. 

10. In the Low Reading EU field, set the low reading that is equal to zero percent input. 

11. In the High Reading EU field, set the high reading that is equal to 100 percent input. 

12. In the Fault Mode frame, set how the system acquires the value written to the 
Selected Value parameter when a fault occurs (Fault or Last Good). 
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Note 

If you select Fault, you must enter a value in the Fault Value field. 

13. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to Analog Input. 

14. Select Save to save your changes to device memory. 

4.5.10 Analog Output 

Use this display to configure analog outputs. Analog outputs are analog signals the FB 
Series product uses to generate signals sent to regulate equipment, such as any analog 
device requiring proportional control. 

To access this display: 

1. Select Configure > I/O Setup > AO from the FBxConnect™ main menu. 

Figure 141. Analog Output 
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2. Click ▼ in the drop-down list at the top of the display to select an analog output 
channel to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected channel. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected channel. 

Module 
Location 

This read-only field shows the location of the module in your FB 
Series product. 

Channel This read-only field shows the currently selected module channel. 

Alarm 
Reference 

This read-only field shows you which alarm is currently configured 
for the selected channel. 

Note 

Click  to open the Alarms display and configure the alarm 

parameters for the selected channel. 

Output Health 
Status 

This read-only field shows the current operating status of the 
selected channel. Possible values are: 

• Normal 

• Not Licensed 

• Instance Inactive 

• Comm Fail 

• Override Active 

• In Alarm 

• Point Fail 

• Above URL 

• Below LRL 

• Output Frozen 

• Output Clipped 

• Factory Calibration Invalid 

• Auto Read Parameter Invalid 

• AO Readback Failure 
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Field Description 

• Termination Missing 

• Disabled 

• Hardware Fail 

Note 

This field may temporarily show Point Fail if the Interval to Poll I/O 
field on the I/O Bus display is set to 10 ms and the AO value is 
changed more than 10%.  

Factory 
Calibration 
Status 

This read-only field shows the current factory calibration status of 
the selected channel. To ensure accuracy of the Analog Output, a 
factory calibration is applied when an I/O module is manufactured. 

Actual Mode This read-only field shows the source of the selected value. Possible 
values are: 

• Auto 

• Auto Read 

• Override 

• Fault 

• Last Good 

• Last Hour Average 

• Ramp To Fault Value 

• Ramp To Last Hour Avg 

Auto Value Sets the value (in engineering units) to use for the selected channel 
when the Operation Mode is set to Auto. 

Raw Value This read-only field shows the current counts written directly to the 
Digital-to-Analog converter. 

Low Reading EU Sets the value (in engineering units) that is equal to zero percent 
output (low end of the EU range). 

High Reading 
EU 

Sets the value (in engineering units) that is equal to 100 percent 
output (high end of the EU range). 

Adjusted D/A 0 
Percent 

Sets the count that the digital-to-analog converter uses for zero 
percent output. This value scales the output to engineering units. 

Adjusted D/A 
100 Percent 

Sets the count that the digital-to-analog converter uses for 100 
percent output. This value scales the output to engineering units. 
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Field Description 

Operation 
Mode 

Sets how the system acquires the value written to the Selected 
Value parameter under normal operation. Possible options are: 

Auto The system copies the value in the Auto Value field to 
the Selected Value parameter. 

Override The system copies the value set in the Override Value 
field to the Selected Value parameter. 

Note 

If a fault occurs and the operation mode is set to 
Override, the Selected Value parameter is set to the 
Override Value and is not set based on the Fault 
Mode. 

Auto Read The system copies the value of the parameter you 
configure in the Auto Read Parameter Reference 
field to the Selected Value parameter. This value is 
updated once per second. 

Note 

When setting the Operation Mode to Auto Read, 
make sure that the units and scaling are correct for 
the referenced parameter. 

Override Value Sets the value (in engineering units) that is written to the Selected 
Value field when the Operation Mode is set to Override. 

Auto Read 
Value 

This read-only field shows the current value of the parameter 
configured in the Auto Read Parameter Reference field. 

Auto Read 
Parameter 
Reference 

Click  to open a Point Picker dialog and select a parameter to 

use as the analog output value when the Operation Mode is set to 
Auto Read. 

Selected Value This read-only field shows the value (in engineering units) based on 
the Operation Mode and Fault Mode fields, as well as the health 
status of the selected output. It is intended to be used as an input 
to calculations and control logic. 

Units Sets the measurement type and engineering units used for the 
selected channel. 
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Field Description 

Type Sets the measurement type used for the selected 
channel. 

Note 

Click Save after you select the type of units to update 
the units available in the Units field. 

Units Sets the engineering units used for the selected 
channel. 

Note 

Changing the Units does not alter the value of 
parameters. 

Range Limits Shows the minimum and maximum value that the analog output 
can generate. 

Lower 
Range 
Limit 

This read-only field shows the minimum value (in D/A 
counts) that the analog output can generate. 

Upper 
Range 
Limit 

This read-only field shows the maximum value (in 
D/A counts) that the analog output can generate. 

Action on CPU 
Restart 

Sets the value to use for the channel after a power cycle occurs. 
Possible options are Fault (use the value you set in the Fault Value 
field) or Last Good (use the last known good value). 

Note 

• During a power cycle, an analog output generates 0mA while 
the FB Series product is restarting. Once the FB Series product 
has completed the restart, then the Action on CPU Restart is 
applied. 

• If only the 12MIO restarts, then the Action on CPU Restart is 
applied until communication is established with main CPU. 

Current/Voltage 
Selection 

Sets the signal type output by the selected channel. Possible 
options are: 

Current A 4 to 20 mA signal is output on the selected channel. 

Voltage A 1 to 5 Vdc signal is output on the selected channel. 

Disabled No signal is output on the selected channel. 
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Field Description 

Note  

For channels on a HART module, the only available options are 
Disabled and Current. 

Fault Mode Sets the value to use when the output experiences a fault condition. 
Possible options are Fault (the system uses the value set in the 
Fault Value field), Last Good (the system uses the last good value 
received before the fault occurred), Last Hour Average (the system 
uses the last hourly average before the fault occurred ). 

Fault 
Value 

Sets the value (in engineering units) to use when a 
fault occurs on the selected channel and the Fault 
Mode is set to Fault. 

Last Good 
Value 

This read-only field shows the last good value (in 
engineering units) output by the channel. This value 
is used if a fault occurred and the Fault Mode was set 
to Last Good. 

Last Hour 
Average 

This read-only field shows the last hourly average 
value before the fault occurred. This value is used if a 
fault occurred and the Fault Mode was set to Last 
Hour Average. 

Ramp To 
Fault 
Value 

The system ramps the output to the value you 
configure in the Fault Value field over the time 
configured in the Ramp Duration field. 

Ramp To 
Last Hour 
Avg 

The system ramps the output to the value shown in 
the Last Hour Average Value field over the time 
configured in the Ramp Duration field. 

Ramp 
Duration 

Sets, in seconds, the amount of time the system takes 
after a fault has occurred to ramp the output to the 
new value. 

Clipping Mode Sets if clipping occurs on the selected input. Clipping forces the 
Selected Value to stay within a range defined by the Low Clipping 
Limit and High Clipping Limit. Clipping is only applied when there is 
not a fault. 

Disable Clipping does not occur. 
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Field Description 

Enable Clipping does occur. 

Note 

You must enter a value in the Low Clipping Limit and 
High Clipping Limit fields. 

Low 
Clipping 
Limit 

When clipping is enabled, this field sets the lower 
limit of the Selected Value parameter. 

High 
Clipping 
Limit 

When clipping is enabled, this field sets the upper 
limit of the Selected Value parameter. 

4. Select Save to save any changes you make to this display. 

4.5.10.1 Configuring Analog Outputs 

Use these steps to configure an analog output on your FB Series product. 

Note 

You must configure I/O types before you configure I/O. For more information, refer to 
I/O Configuration. 

To configure an analog output: 

1. Select Configure > I/O Setup > AO from the FBxConnect™ main menu. 
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Figure 142. Analog Output 

 

2. Click ▼ in the drop-down list at the top of the display to select an analog output 
channel to configure. 

3. In the Tag field, enter a name for the selected channel. 

4. In the Description field, enter a description for the selected channel. 

5. In the Units frame, set the measurement type and engineering units used for the 
selected channel. 

6. In the Operation Mode frame, set how the system acquires the value of the selected 
channel under normal operating conditions. 

Note 

• If you select Auto, the system copies the value in the Auto Value field to the Selected 
Value parameter.  

• If you select Override, the system copies the value set in the Override Value field to 
the Selected Value parameter. 
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• If you select Auto Read, the system copies the value of the parameter you configure 
in the Auto Read Parameter Reference field to the Selected Value parameter. 

7. In the Fault Mode frame, set how the system acquires the value of the selected 
channel when a fault occurs. 

Note 

If you select Fault, you must enter a value in the Fault Value field. 

8. In the Low Reading EU field, set the low reading that is equal to zero percent output. 

9. In the High Reading EU field, set the high reading that is equal to 100 percent output. 

10. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to Analog Output. 

11. Select Save to save your changes to device memory. 

4.5.11 Digital Input 

Use this display to configure digital inputs (DI). Digital inputs monitor the status of relays, 
open collector/open drain type solid-state switches, and other two-state devices. Each DI 
channel can also be software configured to function as a "latched" DI, which remains in 
the active state until reset. Other parameters can invert the field signal and gather 
statistical information on the number of transitions and the time accumulated in the on or 
off state. 

To access this display: 

1. Select Configure > I/O Setup > DI from the FBxConnect™ main menu. 
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Figure 143. Digital Input 

 

2. Click ▼ in the drop-down list at the top of the display to select a digital input channel 
to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
channel. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
channel. 

Module 
Location 

This read-only field shows the location of the module in your FB 
Series product. 

Channel This read-only field shows the currently selected module channel. 
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Field Description 

Input Health 
Status 

This read-only field shows the current operating status of the 
selected channel. Possible values are: 

• Normal 

• Not Licensed 

• Instance Inactive 

• Comm Fail 

• Override Active 

• In Alarm 

• Point Fail 

• Termination Missing 

• Status Alarm 

• Hardware Fail 

Actual Mode This read-only field shows the source of the selected value. Possible 
values are: 

• Live 

• Override 

• Fault 

• Last Good 

Digital Input 
Type 

Set how the digital inputs function when the Operation Mode is set to 
Live. Possible options are: 

Normal The Selected Value is updated based on the Live 
Value. 

Latched When the Live parameter transitions from off to on, 
the selected parameter remains on, until the latch is 
cleared using the Reset Latch parameter. 

Reset Latch Select to clear the latched state of the digital input. 

Note 

This field display only if you select Latched in the Digital Input Type 
frame. 

Disable No action is taken. 
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Field Description 

Enable Clears the latched state of the digital input. The Reset 
Latch parameter will be reset back to Disable once 
the latch is cleared. 

Logic Level Sets the amount of current that the channel sources. Pick the 
appropriate setting based on the digital input device used with this 
channel. 

Note  

This field shows for the 8AIDIPI 2AO 2DO module (3MIX12) only. 

66 
microamps 

The input will source 66 microamps. 

2 milliamps The input will source 2 milliamps. 

Digital Input 
Inversion 
Mode 

Sets whether the system will invert the Live value before writing it to 
the Selected value. 

Note 

This mode only works when the Operation Mode is set to Live and 
there is not a fault. 

Disable The Selected Value will be set to the Live value. 

Enable The Selected Value will be set to the inverse of the 
Live value. For example, if the Live value is "Off" then 
the Selected value will be "On." 

Digital Input 
Filter Time 

Sets the amount of time (in seconds) the discrete input must remain in 
the On (high) state before it is recognized as such. The discrete input 
returns to the Off state immediately upon detection of the On to Off 
transition; there is no filtering for this transition. 

Operation 
Mode 

Sets how the system acquires the value written to the Selected Value 
parameter under normal operation. Possible options are: 

Live The system copies the Live Value to the Selected 
Value parameter. 
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Field Description 

Override The system copies the value you select in the 
Override Value field to the Selected Value parameter. 

Note 

If a fault occurs and the operation mode is set to 
Override, the Selected Value parameter is set to the 
Override Value and is not set based on the Fault 
Mode. 

Fault Mode Sets how the system acquires the value written to the Selected Value 
parameter when a fault occurs. 

Fault The system copies the value set in the Fault Value 
field to the Selected Value parameter. 

Last Good The system copies the value of the Last Good Value 
field to the Selected Value parameter. 

Digital Status 
Alarm Mode 

Sets alarming for the digital input. 

Off No alarms are logged. 

On A Set Alarm is logged when the Selected value 
transitions from “off” to “on.” A Clear Alarm is logged 
when the digital input transitions from “on” to “off.” 

Pull up or Pull 
down 
Resistor Type 

Activates a pull up or pull down resistor to maintain input in a 
deterministic state when no input is applied. 

Note  

This field shows for the 8AIDIPI 2AO 2DO module (3MIX12) only. 

Pull Up Maintain signal High when no input is applied. 

Pull Down Maintain signal Low when no input is applied. 

Live Value This read-only field shows the state of the selected input. 

Selected 
Value 

This read-only field shows the value based on the Operation Mode 
and Fault Mode fields, as well as the health status of the selected 
input. It is intended to be used as an input to calculations and control 
logic. 

Override 
Value 

Sets the value that is written to the Selected Value field when the 
Operation Mode is set to Override. Possible options are: 

Off The selected channel is set to Off when the 
Operation Mode is set to Override. 
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Field Description 

On The selected channel is set to On when the 
Operation Mode is set to Override. 

Last Good 
Value 

This read-only field shows the last good value (Off or On) received by 
the channel. This value would be used if a fault occurred and the Fault 
Mode was set to Last Good. 

Fault Value Sets the value to use when a fault occurs on the selected channel and 
the Fault Mode is set to Fault. Possible options are: 

Off The channel is set to Off when a fault occurs on the 
selected channel and the Fault Mode is set to Fault. 

On The channel is set to On when a fault occurs on the 
selected channel and the Fault Mode is set to Fault. 

DI 
Accumulated 
On Time 

Counts the number of 1-second periods when the Live Value 
parameter is in the On state. The On Counter is a 32-bit number that 
automatically "rolls over" when it reaches its maximum value. You can 
preset the On Counter by entering the desired value or clear the 
counter by entering 0. 

DI 
Accumulated 
Off Time 

Counts the number of 1-second periods when the Live Value 
parameter is in the Off state. The Off Counter is a 32-bit number that 
automatically "rolls over" when it reaches its maximum value. You can 
preset the Off Counter by entering the desired value or clear the 
counter by entering 0. 

Digital Input 
Off-On 
Transition 
Count 

Sets a value for the accumulated number of off-to-on transitions for 
the selected channel. The accumulator is a 32-bit number with a 
maximum count of 4,294,967,295. You can preset the accumulator to 
a desired value or clear it by entering 0. 

 

Click to open a pop-up display that lets you preset or reset the values 
for the selected digital input. 
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Field Description 

DI 
Accumulated 
On Time 

You can preset the On Counter by entering the 
desired value or clear the counter by entering 0. 

DI 
Accumulated 
Off Time 

You can preset the Off Counter by entering the 
desired value or clear the counter by entering 0. 

Digital Input 
Off-On 
Transition 
Count 

You can preset the accumulator to a desired value or 
clear it by entering 0. 

Refresh The values shown are frozen at the time you open 
this pop-up display. Select this button to update these 
values. 

Save Select this button to save any changes you make to 
the DI values and close the pop-up display. 

Description of 
Off State 

Enter a short description (up to 10-alphanumeric characters) for the 
digital input off state. 

Description of 
On State 

Enter a short description (up to 10-alphanumeric characters) for the 
digital input on state. 

4. Select Save to save any changes you make to this display. 

4.5.11.1 Configuring Digital Inputs 

Use these steps to configure a digital input on your FB Series product. 

Note 

You must configure I/O types before you configure I/O. For more information, refer to 
I/O Configuration. 

To configure a digital input: 

1. Select Configure > I/O Setup > DI from the FBxConnect™ main menu. 
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Figure 144. Digital Input 

 

2. Click ▼ in the drop-down list at the top of the display to select a digital input channel 
to configure. 

3. In the Tag field, enter a name for the selected channel. 

4. In the Description field, enter a description for the selected channel. 

5. In the Digital Input Type frame, select how the digital inputs function when the 
Operation Mode is set to Live (Normal or Latched). 

6. In the Logic Level frame, select the amount of current sourced by the channel. 

Note 

Pick the appropriate setting based on the digital input device used with this channel. 

7. In the Operation Mode frame, set how the system acquires the value of the selected 
channel under normal operating conditions. 
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Note 

If you select Override, you must set a value in the Override Value field. 

8. In the Fault Mode frame, set how the system acquires the value of the selected 
channel when a fault occurs. 

Note 

If you select Fault, you must enter a value in the Fault Value field. 

9. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to Digital Input. 

10. Select Save to save your changes to device memory. 

4.5.12 Digital Output 

Use this display to configure digital output channels. Digital outputs are high/low outputs 
used to turn equipment on and off. You can set a digital output to send a pulse to a 
specified device. You can also configure a digital output as latching, momentary, toggle, 
timed duration output momentary, timed duration output toggle, or scaled pulse output 
with a fixed pulse width. 

Note 

Set the Digital Output Type field to Scaled Pulse Output to send a pulse output to 
another device, such as an odorizer, and to control a gas sampler for a meter run. 

To access this display, 

1. Select Configure > I/O Setup > DO from the FBxConnect™ main menu. 
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Figure 145. Digital Output 

 

2. Click ▼ in the drop-down list at the top of the display to select a digital output channel 
to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
channel. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
channel. 

Module 
Location 

This read-only field shows the location of the module in your FB 
Series product. 

Channel This read-only field shows the currently selected module channel. 
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Field Description 

Output Health 
Status 

This read-only field shows the current operating status of the 
selected channel. Possible values are: 

• Normal 

• Not Licensed 

• Instance Inactive 

• Comm Fail 

• Override Active 

• In Alarm 

• Point Fail 

• Auto Read Parameter Invalid 

• SPO Parameter Invalid 

• Termination Missing 

• Status Alarm 

• Hardware Fail 

Actual Mode This read-only field shows the source of the selected value. Possible 
values are: 

• Auto 

• Auto Read 

• Override 

• Fault 

• Last Good 

Digital Output 
Type 

Select the function of the digital output when the Operation mode is 
Auto or Auto Read and there is no fault. Digital outputs are high/low 
outputs used to turn equipment on and off. Possible options are: 

Latching The discrete output turns on when the Auto or Auto 
Read Value, depending on Operation mode, is on. The 
output remains on until the Auto or Auto Read value 
turns off. 
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Field Description 

Momentary When the Auto or Auto Read Value transitions from off 
to on, the discrete output will turn the discrete output 
on for the amount of time defined in the Time On 
field. The Auto parameter will be automatically set to 0 
(off) when the discrete output generates the 
momentary output. 

Note 

The discrete output will not set the Auto Read Value 
back to 0. 

Toggle Enables a square-wave output for which both the time 
on and time off are defined by the value in the Time 
On and Time Off parameters, respectively. 

Timed 
Duration 
Output 
Momentary 

Enables the discrete output to complete one cycle 
based on the time related parameters in the Time 
Duration Output frame, and the Auto EU value. Once a 
cycle is completed, the DO will remain off until the 
Auto EU value is modified, starting a new cycle. 

Timed 
Duration 
Output 
Toggle 

Enables the discrete output to continuously repeat in a 
cycle defined by the value in the Cycle Time field on 
the TDO Parameters Tab where the EU Value controls 
the on-time duration. The current cycle will be 
completed before a new Auto EU value takes effect. 

Scaled 
Pulse 
Output 

Enables the discrete output to be turned on for the 
amount of time defined in the Time On field each time 
an accumulation limit is reached. This could be used to 
send a pulse output to another device, such as an 
odorizer, or to turn a sampler on each time a certain 
amount of flow is accumulated. 

Fault Mode Sets the value to use when the output experiences a fault condition. 
Possible options are: 

Note 

If the DO type is TDO momentary, TDO toggle, or SPO, the DO will be 
set to off instead of set based on the fault mode. 

Fault The system uses the value set in the Fault Value field. 
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Field Description 

Last Good The system uses the last good value output before the 
fault occurred. 

Fault Value Sets the value to use when a fault occurs on the selected channel and 
the Fault Mode is set to Fault. Possible options are: 

Off The channel is set to off when a fault occurs on the 
selected channel and the Fault Mode is set to Fault. 

On The channel is set to on when a fault occurs on the 
selected channel and the Fault Mode is set to Fault. 

Operation 
Mode 

Sets how the system acquires the value written to the Selected Value 
parameter under normal operation. Possible options are: 

Auto The system copies the value in the Auto Value field to 
the Selected Value parameter. 

Override The system copies the value set in the Override Value 
field to the Selected Value parameter. 

Auto Read The system copies the value of the parameter you 
configure in the Auto Read Parameter Reference 
field to the Selected Value parameter. 

Note 

This field applies only if you select Latching or 
Momentary in the Digital Output Type frame. 

Auto Value Sets the value to use for the selected channel when the Operation 
Mode is set to Auto. Possible options are: 

Off The system copies a value of Off to the Selected Value 
parameter. 

On The system copies a value of On to the Selected Value 
parameter. 

Note 

This field applies only if you select Latching or Momentary in the 
Digital Output Type frame. 

Override 
Value 

Sets the value that is written to the Selected Value field when the 
Operation Mode is set to Override. Possible options are: 

Off The system copies a value of Off to the Selected Value 
parameter. 
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Field Description 

On The system copies a value of On to the Selected Value 
parameter. 

Auto Read 
Value 

This read-only field shows the current value (Off or On) of the 
parameter configured in the Auto Read Parameter Reference field. 

Note 

This field applies only if you select Latching or Momentary in the 
Digital Output Type frame. 

Auto Read 
Parameter 
Reference 

Click  to open a Point Picker dialog and select a parameter to use 

as the digital output value when the Operation Mode is set to Auto 
Read. 

Note 

This field applies only if you select Latching or Momentary in the 
Digital Output Type frame. 

Auto EU Value Sets the EU Value which controls the Time On. The output is set based 
on the magnitude of the value, as calculated by the following 
equation: 

Time On = ((EU Value - Low Reading EU) / (High Reading EU - Low 
Reading EU) * (High Time - Low Time)) + Low Time 

Note 

This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the Digital Output 
Type frame. 

Selected Value This read-only field shows the value based on the Operation Mode 
and Fault Mode fields, as well as the health status of the selected 
input. It is intended to be used as an input to calculations and control 
logic. 

Note 

The Selected Value will mirror the DO’s physical output. For example, 
the Selected Value will toggle on and off if the DO Type is set to 
toggle. 
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Field Description 

Time On Sets the amount of time, in seconds, an output is set to On. The 
minimum On and Off time is 0.01 seconds, resulting in a maximum 
frequency of 50 Hz. The default value is 1.0 seconds.  

• In Momentary mode, this is the amount of time (in seconds) that 
the output is energized.  

• In Toggle mode, this is the amount of time (in seconds) between 
switching On or Off.  

• In Scaled Pulse Output mode, this is the amount of time (in 
seconds) that the output is energized each time the change in the 
Scaled Pulse Output Value is greater than the Pulse Output 
Significance. For example, if the Scaled Pulse Output Value is 950 
MCF when the scaled pulse output functionality is enabled and 
the Pulse Output Significance is 1000 MCF, the DO will be 
energized when the Scaled Pulse Output Value reaches 1950 MCF. 

Note 

This field applies only if you select Momentary, Toggle, or Scaled 
Pulse Output in the Digital Output Type frame. 

Time Off Sets the amount of time, in seconds, the output is set to Off. The 
minimum On and Off time is 0.01 seconds, resulting in a maximum 
frequency of 50 Hz. The default value is 1.0 seconds. 

Note 

This field applies only if you select Toggle in the Digital Output Type 
frame. 

Description of 
On State 

Enter a short description (up to 10-alphanumeric characters) for the 
On state of the digital output. 

Note 

This field applies only if you select Latching, Momentary, Toggle, 
Time Duration Output Momentary, or Time Duration Output 
Toggle in the Digital Output Type frame. 
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Field Description 

Description of 
Off State 

Enter a short description (up to 10-alphanumeric characters) for the 
Off state of the digital output. 

Note 

This field applies only if you select Latching, Momentary, Toggle, 
Time Duration Output Momentary, or Time Duration Output 
Toggle in the Digital Output Type frame. 

Number of 
Off-On 
Transitions 

Sets a value for the accumulated number of Off-to-On transitions for 
the selected channel. The accumulator is a 32-bit number with a 
maximum count of 4,294,967,295. You can preset the accumulator to 
a desired value or clear it by entering 0. 

Digital Status 
Alarm Mode 

Sets Alarming for the digital output. 

Off No alarms are logged. 

On A Set Alarm is logged when the Selected value 
transitions from “off” to “on.” A Clear Alarm is logged 
when the digital output transitions from “on” to “off.” 

Action on CPU 
Restart 

For Latched DO's, sets the value to use for the channel after a power 
cycle occurs. 

For Momentary DO's, the output is set to Off and no momentary 
pulse is generated. 

For all other DO's, the output is set based on the behavior described 
in the Digital Output Type parameter section. 

Possible options are: 

Fault The system uses the value set in the Fault Value field. 

Last Good The system uses the last good value output before the 
fault occurred. 

Note 

• During a power cycle, a discrete output is set to Off while the FB 
Series product is restarting. Once the FB Series product has 
completed the restart, then the action on power cycle is applied. 

• This field applies only if you select Latching in the Digital 
Output Type frame and Auto in the Operation Mode frame. 

• If only the 12MIO restarts, then the Action on CPU Restart is 
applied until communication is established with main CPU. 
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Field Description 

Time Duration 
Output Cycle 
Time 

Sets the total amount of time (in seconds) the cycle spends in the On 
and Off positions. 

The Cycle Time entry is used to define the Off Time in the Time 
Duration Output Toggle mode. The Off Time is calculated by the 
formula: 

Off Time = Cycle Time - On Time 

Example: 

A Time Duration Output is used to emulate a field instrument 
measuring flow. The Time Duration Output outputs a pulse width of 3 
seconds for no flow and a pulse width of 12 seconds for 1000 MCF 
per day flow. The output is repeated every 15 seconds. 

If the Cycle Time is less than, or equal to the On Time, the Off Time is 
set to one. Care must be taken in configuration to ensure that the 
Cycle Time remains greater than the calculated On Time for proper 
operation. 

Note 

This field applies only if you select Time Duration Output Toggle in 
the Digital Output Type frame. 

Time Duration 
Output Low 
EU 

Sets the value for the low reading to zero percent output (low end of 
the EU range). Based on the EU range determined in part by this 
parameter, the EU value is converted to a corresponding signal. 

Note 

This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the Digital Output 
Type frame. 

Time Duration 
Output High 
EU 

Sets the value for the high reading to 100 percent output (or high end 
of the EU range). Based on the EU range determined in part by this 
parameter, the EU value is converted to a corresponding signal. 

Note 

This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the Digital Output 
Type frame. 
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Field Description 

Time Duration 
Output 0% 
Time 

Sets the amount of time (in seconds) the cycle is in the On position 
when the EU is at zero percent. 

Note 

• 0% and 100% should be less than or equal to the Cycle Time. 

• This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the Digital 
Output Type frame. 

Time Duration 
Output 100% 
Time 

Sets the amount of time (in seconds) the cycle is in the on position 
when the EU is at 100 percent.  

Note 

• 0% and 100% should be less than or equal to the Cycle Time. 

• This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the Digital 
Output Type frame. 

TDO Time On This read-only field shows the value calculated from the entered 
Auto EU Value and the previous definitions of Low Reading Time, 
High Reading Time, Low Reading EU, and High Reading EU. The 
calculation formula is: 

TDO Time On = ((EU Value - Low Reading EU) / (High Reading EU - 
Low Reading EU) * (High Time - Low Time)) + Low Time 

Note 

This field applies only if you select Time Duration Output 
Momentary or Time Duration Output Toggle in the Digital Output 
Type frame. 

TDO Time Off This read-only field shows the value calculated from the Cycle Time 
and the TDO Time On. The calculation formula is: 

TDO Time Off = Cycle Time - TDO Time On 

Note 

This field applies only if you select Time Duration Output Toggle in 
the Digital Output Type frame. 
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Field Description 

Scaled Pulse 
Output 
Parameter 
Reference 

This parameter chooses the parameter the digital output will monitor 
for changes so that it can turn the digital output on for the amount of 
time specified by the Time On parameter each time it changes by the 
amount specified in the Pulse Output Significance parameter.  

Note 

• Choose a parameter with an incremental value. 

• This field applies only if you select Scaled Pulse Output in the 
Digital Output Type frame. 

Scaled Pulse 
Output Value 

This read-only field shows the value of the parameter configured in 
the Scaled Pulse Output Parameter Reference field. 

Note 

This field applies only if you select Scaled Pulse Output in the Digital 
Output Type frame. 

Pulse Output 
Significance 

This field defines the amount of change that must occur in the Scaled 
Pulse Output parameter before a pulse will be generated.  

Note 

• This parameter is in the same units as the Scaled Pulse Output 
Value. 

• This field applies only if you select Scaled Pulse Output in the 
Digital Output Type frame. 

Override 
Value 

Sets the value that is written to the Selected Value field when the 
Operation Mode is set to Override. Possible options are: 

Off The system copies a value of Off to the Selected Value 
parameter. 

On The system copies a value of On to the Selected Value 
parameter. 

Grounded 
Output (Low 
Side Switch) 

Sets if the digital output is internally connected to or isolated from 
ground. 

Enabled The DO_LO pin is internally connected to ground and 
provides a grounded output (50 mA current limit). 

Disabled The DO_LO pin is internally isolated from ground and 
acts as a contact closure. 
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Field Description 

Note 

This field applies to the Mixed I/O module only. 

4. Select Save to save any changes you make to this display. 

4.5.12.1 Configuring Digital Outputs 

Use these steps to configure a digital output on your FB Series product. 

Note 

You must configure I/O types before you configure I/O. For more information, refer to 
I/O Configuration. 

To configure a digital output: 

1. Select Configure > I/O Setup > DO from the FBxConnect™ main menu. 

Figure 146. Digital Output 
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2. Click ▼ in the drop-down list at the top of the display to select a digital output channel 
to configure. 

3. In the Tag field, enter a name for the selected channel. 

4. In the Description field, enter a description for the selected channel. 

5. In the Digital Output Type frame, select the function of the digital output when the 
Operation mode is Auto or Auto Read and there is no fault. 

6. Select Save to save your changes to device memory, and update the available fields 
based on the selected Digital Output Type. 

7. In the Operation Mode frame, set how the system acquires the value of the selected 
channel under normal operating conditions. 

Note 

If you select Auto, the system copies the value in the Auto Value field to the Selected 
Value parameter. 
If you select Override, the system copies the value set in the Override Value field to the 
Selected Value parameter. 
If you select Auto Read, the system copies the value of the parameter you configure in 
the Auto Read Parameter Reference field to the Selected Value parameter. 

8. In the Fault Mode frame, set how the system acquires the value of the selected 
channel when a fault occurs. 

Note 

If you select Fault, you must select a value to use in the Fault Value frame. 

9. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to Digital Output. 

10. Select Save to save your changes to device memory. 

4.5.13 Pulse Input 

Use this display to configure pulse inputs. Pulse inputs accept pulse trains (square wave 
signals) that measurement devices (such as turbine meters) generate. The pulse input 
accepts digital level on/off signals from an external device and accumulates the changes 
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over a configured period of time. Pulse inputs can also determine a rate from the 
accumulated pulses over a configured period of time. 

Note 

The lowest frequency the system can accurately measure is 1 divided by the PI Scan 
Period. Flow control may be erratic below this threshold. 

To access this display: 

1. Select Configure > I/O Setup > PI from the FBxConnect™ main menu. 

Figure 147. Pulse Input 

 

2. Click ▼ in the drop-down list at the top of the display to select a pulse input channel 
to configure. 

3. Review – and change as necessary – the values in the following fields: 
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Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
channel. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected channel. 

Module 
Location 

This read-only field shows the location of the module in your FB 
Series product. 

Channel This read-only field shows the currently selected module channel. 

PI Scan Period Sets how frequently the system scans the input (in seconds) to 
acquire the value. Each input updates based on their individual scan 
period. 

Frequency 
Alarm 
Reference 

This read-only field shows you which alarm is currently configured 
for the point. 

Note 

Click  to open the Alarms display and configure the alarm 
parameters. 

Input Health 
Status 

This read-only field shows the current operating status of the 
selected channel. Possible values are: 

• Normal 

• Not Licensed 

• Inactive 

• Comm Fail 

• Override Active 

• In Alarm 

• Point Fail 

• Above URL 

• Below LRL 

• Termination Missing 

• Hardware Fail 

Actual Mode This read-only field shows the source of the selected value. 

Today's Total This read-only field shows the total flow for the current day. 

Yesterday's 
Total 

This read-only field shows the total flow for the previous day. 
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Field Description 

Today's 
Accumulated 
Pulses (32-bit) 

This read-only field shows the number of pulses stored in the 
accumulated value counter in firmware. For each I/O scan period 
(poll interval), the device determines the number of pulses that have 
occurred since the last I/O scan period and adds them to the 
accumulated value counter. 

Accumulated 
Pulses 

This read-only field shows the number of raw counts stored in the 
accumulated value counter in firmware. For each scan period, the 
device determines the number of raw counts that have occurred 
since the last scan period and adds them to the accumulated value 
counter. 

Note  

The accumulated value rolls over to zero after reaching 
4,294,967,296. 

Resettable 
Accumulated 
Pulses 

This read-only field shows the number of raw counts stored in the 
accumulated value counter in firmware since the last time this field 
was manually reset to a custom value. 

Note  

To reset this field to a custom value, click  to open a pop-up 
display, enter the desired number of pulses in the Resettable 
Accumulated Pulses field, and select Save. New pulses are added to 
the entered value. 

Reset the 
Daily Counts 

Click to reset all daily pulse input totals [Today's Total, Yesterday's 
Total, and Today's Accumulated Pulses (32-bit)]. 

Units Sets the measurement type and engineering units used for the 
selected channel. 

Type Sets the measurement type used for the selected 
channel. 

Note 

Click Save after you select the type of units to update 
the units available in the Units field. 
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Field Description 

Units Sets the engineering units used for the selected 
channel. 

Note 

Changing the Units does not alter the value of 
parameters. 

Note 

These fields are hidden when the selected pulse input channel is 
assigned to a Linear Meter Input. 

Filter Mode Sets the amount of filtering that will be applied to the pulse input. 
Choose a filtering mode that is appropriate for the input frequency, 
and the amount of noise that may be present. 

Low Speed 
Filter 

Choose low speed filtering if the pulse input will be 
measuring frequencies less than 10Hz. 

Medium 
Speed Filter 

Choose medium speed filtering if the pulse input will 
be measuring frequencies between 0 to 300Hz. 

High Speed 
Filter 

Choose high speed filtering if the pulse input will be 
measuring frequencies above 300Hz.  

Logic Level This setting determines the amount of current that the channel 
sources. Pick the appropriate setting based on the pulse input device 
used with this channel. 

Note 

• This field shows for the 8AIDIPI 2AO 2DO module (3MIX12) 
only. 

• For the PI configuration driven from an open collector stage, 
high speed (10KHz) is only supported with the 2 milliamps 
setting. 

• For the PI configuration driven from a voltage source, 66 
microamps is acceptable for low and high speed. 

66 
microamps 

The input will source 66 microamps. 

2 milliamps The input will source 2 milliamps. 

Operation 
Mode 

Sets the source of the selected value. Possible options are: 

Live The system uses the current value of the input. 
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Field Description 

Override The system uses the value set in the Override 
Frequency field. 

Live 
Frequency 

This read-only field shows the current value from the field device. 

Override 
Frequency 

Sets the value to use for the selected channel when the Operation 
Mode is set to Override. 

Selected 
Frequency 

This read-only field shows the current value used in calculations. 

Conversion 
Factor 

Sets the ratio of the number of pulses per engineering unit. 

Note 

This field is hidden when the selected pulse input channel is 
assigned to a Gas or Liquid Linear Meter Input. 

Contract Hour Click ▼ to set the hour of the day to begin the daily counted 
parameters. 

Note 

This field is hidden when the selected pulse input channel is 
assigned to a Gas or Liquid Linear Meter Input. 

Rate Period Click ▼ to set the time units used for the PI scan rate. 

Note 

This field is hidden when the selected pulse input channel is 
assigned to a Linear Meter Input. 

Rate This read-only field shows the calculated rate as of the most recent 
scan expressed in engineering units per unit of time. The system 
calculates the rate at the end of each scan period by dividing the 
number of pulses received by the conversion value and then 
multiplying by the rate period. 

Note 

This field is hidden when the selected pulse input channel is 
assigned to a Linear Meter Input. 
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Field Description 

Period This read-only field shows the amount of time between each pulse. 
For example, if the input frequency was 100 Hz, the period will be 
0.01 seconds. 

Note 

This field is hidden when the selected pulse input channel is 
assigned to a Linear Meter Input. 

Accumulated 
Pulses 

This read-only field shows the number of raw counts stored in the 
accumulated value counter in firmware. For each scan period, the FB 
Series product determines the number of raw counts that have 
occurred since the last scan period and adds them to the 
accumulated value counter. 

The accumulated value rolls over to zero after reaching 
4,294,967,295. 

Note 

This field is hidden when the selected pulse input channel is 
assigned to a Linear Meter Input. 

Upper Range 
Limit 

This read-only field shows the maximum frequency the pulse input 
can measure. 

Lower Range 
Limit 

This read-only field shows the minimum frequency the pulse input 
can measure. 

Monitor 
Maximum 

Sets the maximum value of the pulse input gauge shown on the 
Monitor > Main display. 

Note  

• To avoid prolonged display rendering times, limit the scale 
range to no more than 10,000.  

• This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 

Monitor 
Minimum 

Sets the minimum value of the pulse input gauge shown on the 
Monitor > Main display. 

Note  

• To avoid prolonged display rendering times, limit the scale 
range to no more than 10,000.  

• This field applies only to the FB1000 and FB2000 Series Flow 
Computers. 
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Field Description 

Pull up or Pull 
down Resistor 
Type 

Activates a pull-up or pull-down resistor to maintain input in a 
deterministic state when no input is applied. 

Note  

This field shows for the 8AIDIPI 2AO 2DO module (3MIX12) only. 

Pull Up Maintain signal High when no input is applied. 

Pull Down Maintain signal Low when no input is applied. 

Note 

Open collector circuit configuration is not supported 
with a pull down resistor.  

4. Select Save to save any changes you make to this display. 

4.5.13.1 Configuring Pulse Inputs 

Use these steps to configure a pulse input on your FB Series product. 

Note 

You must configure I/O types before you configure I/O. For more information, refer to 
I/O Configuration. 

To configure a pulse input: 

1. Select Configure > I/O Setup > PI from the FBxConnect™ main menu. 
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Figure 148. Pulse Input 

 

2. Click ▼ in the drop-down list at the top of the display to select a pulse input channel 
to configure. 

3. In the Tag field, enter a name for the selected channel. 

4. In the Description field, enter a description for the selected channel. 

5. In the Units frame, set the measurement type and engineering units used for the 
selected channel. 

6. In the Logic Level frame, select the amount of current sourced by the channel. 

Note 

Pick the appropriate setting based on the pulse input device used with this channel. 
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7. In the Operation Mode frame, set the source of the selected value. 

Note 

If you select Override, you must enter a value in the Override Frequency field. 

8. In the Rate Period frame, click ▼ to set the time units used for the PI scan rate. 

9. In the PI Scan Period field, set how frequently the system scans the input to acquire 
the value. 

10. In the Filter Mode frame, set the amount of filtering that will be applied to the pulse 
input. 

11. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to Pulse Input. 

12. Select Save to save your changes to device memory. 

4.5.14 User Data 

Use this display as a global data storage area that any device or application can use. A 
user data entry may store the results of a specified calculation from a Math Block or an 
intermediate result of a specified value a Math Block acquires. 50 instances of the User 
Data display exist. 

Each user data instance consists of the following: 

• 1 Tag (20-alphanumeric string) 

• 1 Description (40-alphanumeric string) 

• 10 Double Floating Points (floating point values) 

• 20 Single Floating Points (floating point values) 

• 10 Long Integers (32-bit) 

• 10 Short Integers (16-bit) 

• 10 Byte Integers (8-bit) 

To access this display: 

1. Select Configure > I/O Setup > User Data from the FBxConnect™ main menu. 
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Figure 149. User Data 

 

2. Click ▼ in the drop-down list to select a user data instance to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
user data instance. 

Description Sets a description (up to 40-alphanumeric characters) for the 
selected user data instance. 

Event Logging Select to enable the system to log user data parameters changes to 
the event log. 

Note 

A change to this option may require up to 10 seconds to take effect. 

Double 
Floating Point  

Sets up to 10 parameters to provide storage for double precision 
floating point values. In the row for each parameter, use the 
Description field to describe (up to 200-alphanumeric characters) 
the data stored in that row. 
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Field Description 

Single 
Floating Point  

Sets up to 20 parameters to provide storage for single precision 
floating point values. In the row for each parameter, use the 
Description field to describe (up to 200-alphanumeric characters) 
the data stored in that row. 

Long Integer  Sets up to 10 parameters to provide storage for 32-bit unsigned 
integer values. In the row for each parameter, use the Description 
field to describe (up to 200-alphanumeric characters) the data stored 
in that row. 

Short Integer  Sets up to 10 parameters to provide storage for 16-bit unsigned 
integer values. In the row for each parameter, use the Description 
field to describe (up to 200-alphanumeric characters) the data stored 
in that row. 

Byte Integer  Sets up to 10 parameters to provide storage for 8-bit unsigned 
values. In the row for each parameter, use the Description field to 
describe (up to 200-alphanumeric characters) the data stored in that 
row.  

Reset All 
Descriptions 

Select this button to restore the default parameter descriptions for 
all user data types in all user data instances. A confirmation 
message opens asking if you are sure you want to continue. Select 
Yes to restore the default parameter descriptions. Select No to 
return to the User Data display without making changes. 

CAUTION  
This action restores the default parameter descriptions for all User 
Data types in all User Data instances.  

4. Select Save to save any changes you make to this display. 

4.6  Pass Thru 

Use this display to configure parameters used when communicating with other Ethernet 
enabled FB Series products and FBxRemote™ I/O racks. 
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Note:  

You can connect an FBxRemote I/O rack to an Ethernet communications port on the 
FB3000 using FBxNet™, and the FB3000 supports pass-thru communications. This allows 
you to connect to and configure the FBxRemote™ I/O rack through the FB3000 (without a 
direct connection). After configuring communication parameters on the FBxRemote™ I/O 
rack and the Pass Thru display, select the Connect via Pass Thru button to connect to the 
FBxRemote™ I/O rack. 

To access this display: 

1. Select Configure > Pass Thru. The Pass Thru display opens. 

Figure 150. Pass Thru 

 

2. Click ▼ in the FBxRemote™ I/O rack drop-down list and select the rack you want to 
configure. 

3. Review – and change as necessary – the values in the following fields: 
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Field Description 

Host 
Information 

Use these fields to specify communication parameters used by the 
host FB Series product when communicating with the selected 
FBxRemote™ I/O rack. 

Tag Sets an identifier (up to 20-alphanumeric characters) 
for the selected FBxRemote™ I/O rack.  

Pass thru 
Address 

Sets the TCP/IP port number that will be opened 
between the host and the PC running FBxConnect™. 

Comm Port 
Number 

Click ▼ to specify which communications port to use 
when communication with the selected FBxRemote™ 
I/O rack. 

Rack 
Information 

Use these fields to specify communications parameters of the 
selected FBxRemote™ I/O rack. 

Rack IP 
Address 

Enter the IP address of the selected FBxRemote™ I/O 
rack. 
 

Rack DNP 
Address 

Enter the DNP address of the selected FBxRemote™ 
I/O rack. 
 

TCP/IP Port 
 

Enter the DNP3 TCP/IP port of the selected 
FBxRemote™ I/O rack. 

Connect via 
Pass Thru 

Select this button to connect to the selected 
FBxRemote™ I/O rack. When connected, a new 
FBxConnect™ instance opens and allows you to 
configure the FBxRemote™ I/O rack. 

Note 

Since FBxRemote™ I/O racks do not support the full 
functionality available in FBxConnect, only a subset of 
menu items are available. 

4. Select Save to save any changes you make to this display. 

4.7 Summary 

The Summary display shows an overview of all configured stations and assigned meters.  

To access this display: 

1. Select Configure > Summary. 
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Figure 151. Summary 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Site Name This read-only field shows the configured location name of your 
FB3000. 

Device Serial 
Number 

This read-only field shows the serial number of your FB3000. 

Product 
Description 

This read-only field shows the configured description of your 
FB3000. 

Product Type This read-only field shows FB Series product type you are 
configuring. 

Current Time This read-only field shows the current time of the clock on the 
FB3000. 

Station Tabs A separate tab appears for each station you have configured. Select 
each station tab to view the following information. 

Fluid Type This read-only field shows the fluid type measured by 
each station. 
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Field Description 

Station 
Details 

Select this button to open the station configuration 

display for the selected station. Select  to return 

to Summary display. 

Description This read-only field shows the description of each 
meter assigned to the selected station. 

Meter Runs This column shows each meter assigned to the 
selected station. Select a meter name to open the 
meter configuration display for that meter. Select 

 to return to Summary display. 

Alarms This read-only field shows any currently active alarms 
on the meter. 

Corrected 
Volume 
Flow Rate 

This read-only field shows corrected Volume Flow 
Rate for the meter. 

Note 

This field appears only for gas meters. 

Water Net 
Volume 
Flow Rate 

This read-only field shows Water Net Volume Flow 
Rate for the meter. 

Note 

This field appears only for liquid linear meters. 

Oil Net 
Volume 
Flow Rate 

This read-only field shows Oil Net Volume Flow Rate 
for the meter. 

Note 

This field appears only for liquid linear meters. 

3. Select Save to save any changes you make to this display. 

4.8  Meter Setup 

Use this display to configure general meter run parameters, including the number of 
differential pressure (DP), gas linear, and liquid linear meter runs. 
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Note 

If the system is unable to create meter runs or experiences a fatal metering error, the 
system logs a Meter Task Detected Fatal Error event to the Event log. 

To access this display: 

1. Select Configure > Meter Setup. 

Figure 152. Meter Setup 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Maximum 
Meters 

This read-only field shows the maximum number of meter runs 
allowed in the FB Series product. 

Number of 
Gas DP 
Meters 

Sets the number of differential pressure meter runs on the currently 
attached FB Series product. 

Note 

This value (combined with the values in the Number of Gas Linear 
Meters and Number of Liquid Linear Meters fields) cannot exceed the 
value shown in the Maximum Meters field. 
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Field Description 

Number of 
Gas Linear 
Meters 

Sets the number of liner meter runs on the currently attached FB 
Series product. 

Note 

This value (combined with the values in the Number of Gas DP Meters 
and Number of Liquid Linear Meters fields) cannot exceed the value 
shown in the Maximum Meters field. 

Number of 
Liquid Linear 
Meters 

Sets the number of liquid linear meter runs on the currently attached 
FB Series product. 

Note 

This value (combined with the values in the Number of Gas Linear 
Meters and Number of Active DP Meters fields) cannot exceed the 
value shown in the Maximum Meters field. 

Batching 
Enabled 

This read-only field shows if the batching feature is 
enabled on any liquid stations. 

Note 

This checkbox has three possible states: 

• Empty – No liquid stations have the batching 
feature enabled. 

• Checked – All liquid stations have the batching 
feature enabled. 

• Grayed out – At least one liquid station has the 
batching feature enabled and at least one liquid 
station does not have the batching feature 
enabled. 

Station 
Assignment 

Select Station Assignment to configure which meters are assigned to 
which stations. 

Calculations These read-only fields show the status of calculation types on the 
FB3000 RTU. Possible statuses are: 

• Available – A valid licensed is installed for the calculation type. 

• Not available – A valid licensed is not installed for the calculation 
type. 
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Field Description 

Meter 
Averaging 
Method 

Sets the averaging method used by the currently attached FB Series 
product. The selected method is used for all averages associated with 
all gas meters in the FB Series product. Current and previous period 
averages are stored in the database by the Average object, and 
historical data is recorded under Station History if a history point is 
assigned to that Average object. For further details on the averaging 
techniques, see API measurement standard Chapter 21, Section 1, 
Appendix B (1993).  

Gas Averaging (API 21.1) 

• The current version of API Chapter 21, Section 1, Annex B (2013) 
states that Flow Dependent Linear averaging shall be used. 

• If there was an intermittent flow during the averaging period 
(hourly, daily, etc.), then only samples during flow are included. If 
there is no flow for the entire averaging period, then all of the 
samples are included. 

Liquid Averaging (API 12.2.2) 

• Averages associated with liquid linear meters are always flow-
weighted based on API 12.2.2, and periods of no flow produce 
averages of 0. 

Flow 
Dependent 
Linear 

This is the simplest and most commonly used method. 
This method sums the included samples and divides by 
the number of included samples to compute the 
average values for the period. 

Flow 
Dependent 
Formulaic 

This method raises each included sample to the lowest 
order power to which that particular value is used in 
the flow equation before averaging as above and then 
the result is raised to the inverse power. For averaging 
flowing pressure for a DP meter, for instance, where 
pressure is used to the 0.5 power, this means taking 
the square root of each sample and squaring the 
average of those samples. For averaging flowing 
pressure for a linear meter, however, where the 
pressure is used directly in the flow equation, the 
samples are taken to the “1” power, producing 
identical results to the flow dependent linear method. 
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Field Description 

Flow 
Weighted 
Linear 

This method determines a relative "weight" for each 
sample by first multiplying the sample by a flow value 
(the square root of the differential pressure for a DP 
meter and the indicated quantity flow rate for a linear 
meter) and then calculates a linear average by dividing 
the sum of the flow-weighted sample by the sum of the 
flow values. 

Flow 
Weighted 
Formulaic 

This method raises each included sample to the lowest 
order power as described above for flow dependent 
formulaic and also multiplies each sample by a weight 
as described above for flow weighted linear. The 
resulting sum is divided by the sum of the flows and 
raised to the inverse power to obtain the average 
value. 

Number of 
Spare Totals 

Sets the number of additional instances of the Totals object in the FB 
Series product database. Change this value to dynamically increase 
the number of Total_x object instances in the system database, as 
viewed by the Point Picker. New instances of the Totals object start 
with Total_50001. Up to four instances per meter are supported for a 
maximum of 144 additional Total_x object instances.  

Note 

• Spare totals are only used when calculating fault totals. For more 
information about fault totals, refer the Fault Total Enable field on 
the Station – Advanced Tab. 

• For more information about automatically configuring fault totals, 
refer to Totals Setup. 

• For more information about viewing totals, refer to Totals. 

QTR Log 
Break Option 

Sets the Quantity Transaction Record (QTR) log action to be taken 
when a configuration parameter is changed that affects the flow 
calculations. 

Note 

The action will be taken at the top of the minute following the 
parameter change. 

Disabled No action is taken. 

Hourly Only Logs an hourly record in affected station history group. 
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Field Description 

All Standard 
Period Logs 

Logs hourly, daily, weekly, and monthly records in 
affected station history group. 

Batch Restart 
Option 

If batching is enabled, sets how the system responds when a batch is 
in progress and the FB product restarts.  

End Current 
Start Next 

The current batch stops and a new batch automatically 
starts. 

Continue 
Current 

The current batch continues. 

Stop 
Current 

The current batch stops and a new batch does not 
automatically start. 

3. Select Save to save any changes you make to this display. 

4.8.1 Station Assignment 

Use this pop-up display to configure which meters are assigned to which station. 

To access this display: 

1. Select Configure > Meter Setup. The Meter Setup display opens. 

Figure 153. Station Assignment 
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2. Select Station Assignment. The Station Assignment pop-up display opens. 

Figure 154. Station Assignment 

 

3. Tabs appear at the top of the display. Each tab consists of up to 12 meters. Select the 
tab that contains the meters you want to assign to a specific station. 

4. In the row for each meter, select  to open a Point Picker dialog and assign each 

meter to a specific station. 

Note 

Gas meters and liquid meters cannot belong to the same station. If you assign a gas 
meter to a liquid station or a liquid meter to a gas station, a Flow Calculation alarm is 
raised. 

5. Select Station Fluid Type and Batching to configure the fluid type measured by each 
station. 

Note  

You cannot change the fluid type of a station if a meter is already assigned to that 
station. In this case, you must first remove any meters assigned to the selected station 
before you are able to change the Fluid Type field. 

6. Select Save to save any changes you make to this pop-up display. 

7. Select Close to exit the display. 
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4.8.2 Station Fluid Type 

 Use this pop-up display to configure the fluid type measured by each station. 

To access this display: 

1. Select Configure > Meter Setup. The Meter Setup display opens. 

Figure 155. Station Assignment 

 

2. Select Station Assignment. The Station Assignment pop-up display opens. 
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Figure 156. Station Assignment 

 

3. Select Station Fluid Type and Batching. The Station Fluid Type pop-up display opens 
showing a list of all stations. 

Figure 157. Station Fluid Type 

 

4. Select ▼ to assign a fluid type for each station. 
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Note  

Gas meters and liquid meters cannot belong to the same station. If you assign a gas 
meter to a liquid station or a liquid meter to a gas station, a Flow Calculation alarm is 
raised. 

You cannot change the fluid type of a station if a meter is already assigned to that 
station. In this case, you must first remove any meters assigned to the selected station 
before you are able to change the Fluid Type field.  

5. For FB3000 RTU liquid meters, place a check mark in the Batching column to enable 
the batching feature for the station configured in the selected row. 

Note 

Batching is enabled at the station level. If you enable batching for a meter assigned to a 
particular station, all other meters assigned to that station will also have the batching 
feature enabled.  

6. Select Save to save any changes you make to this pop-up display. 

7. Select Close to exit the display. 

4.9  DP Meter 

Use this display to configure differential pressure meters in your FB Series product. 

To access this display, select Configure > Gas > DP Meter from the FBxConnect™ main 
menu. 

Figure 158. Configure – DP Meter 

 

The DP Meter display contains the following items: 

General – Use this display to configure the type, sizing, and inputs for the selected meter. 

Advanced – Use this pop-up display to configure advanced properties for the selected 
meter, including meter construction material, temperature correction, and discharge 
coefficient options. 
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Diagnostics – Use this pop-up display to view read-only diagnostic information for the 
selected meter, including calculated values and alarm codes. 

Rates & Totals – Use this pop-up display to view read-only flow rates and accumulations 
for the selected meter. 

4.9.1 DP Meter – General 

Use this display to configure the type, sizing, and inputs for the selected differential 
pressure meter.  

To access this display: 

1. Select Configure > Gas > DP Meter. The DP Meter opens. 

Figure 159. DP Meter – General 

 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 
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3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
meter. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
meter. 

Serial number Sets a description (up to 20-alphanumeric characters) for the serial 
number or other identifier of the selected meter. 

Status This read-only field indicates the overall health of the selected meter. 
Possible values are: 

Normal Indicates the meter is not in an alarm, failure, or 
override condition. 

In alarm Indicates an active flow rate, I/O, property calculation, 
or flow calculation alarm. 

Failure Indicates a point fail on a meter input that is used in 
flow calculations or a severe calculation error that 
prevented calculations from continuing. 

Override Indicates a meter input that is used in flow 
calculations in override mode that is not typically in 
override. 
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Field Description 

Note 

The status is based on the health of the uncorrected volume, 
corrected volume, and mass of the meter. You can configure which 
parameters are considered in determining the health of the meter in 
the Fault Health Configuration field on the Station – Advanced Tab. 

The associated parameter (OBJ_STATUS) is a 32-bit binary value, 
where individual bits have different meaning. We currently use 3 bits. 
Starting from LSB (Least Significant Bit), Bit 1 represents “In Alarm,” 
Bit 2 represents “Failure,” and Bit 3 represents “Override.” When 
viewing this parameter via a host system, the value is represented as 
a decimal number. For example, a value of 0 means no bits are set 
and the meter status is Normal. A value of 1 means the meter status 
is In Alarm. A value of 2 means the meter status is Failure. A value of 
4 means the meter status is Override. A value of 7 means Bits 1, 2, 
and 3 are all set, and the meter status is In Alarm, Failure, and 
Override. 

Station 
Assignment 

Click  to open a Point Picker dialog and select the station to which 

this meter belongs. 

Note 

• After selecting a Station, click  to open the Station 

configuration display. 

• Stations measuring different fluid types are hidden in the Point 
Picker. 

• Gas meters and liquid meters cannot belong to the same 
station. If you assign a gas meter to a liquid station or a liquid 
meter to a gas station, a Flow Calculation alarm is raised. 

Fluid 
Properties 
Reference 

This read-only field shows the fluid properties instance currently 
assigned to the selected meter. 

Note 

Click  to open the Fluid Properties configuration display. 
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Field Description 

Flow Alarm 
Object 

This read-only field shows the alarm instance currently assigned to 
the selected meter. 

Note 

Click  to open the Alarms configuration display. 

Advanced Click this button to open the DP Meter – Advanced pop-up display 
and configure advanced properties for the selected differential 
pressure meter. 

Diagnostics Click this button to open the DP Meter – Diagnostics pop-up display 
and view read-only diagnostic information for the selected 
differential pressure meter. 

Rates & Totals Click this button to open the DP Meter – Rates & Totals pop-up 
display and view read-only flow rates and accumulations and to 
manually configure fault totals for the selected differential pressure 
meter. 

Components Click this button to open the Components pop-up display and set the 
mole percent of each fluid component present in the meter. 

Meter Type Click ▼ to specify the type of differential pressure meter you are 
configuring, and the calculation to use for the selected meter. 

Orifice 
Diameter 

Specifies the orifice plate bore diameter. 

Note 

This field appears only if you select an orifice meter in the Meter 
Type field. 

Throat 
Diameter 

Specifies the Venturi tube throat diameter. 

Note 

This field appears only if you select a Venturi meter in the Meter 
Type field. 

Nozzle 
Diameter 

Specifies the nozzle throat diameter. 

Note 

This field appears only if you select a nozzle meter in the Meter 
Type field. 
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Field Description 

Orifice 
Diameter 
(single hole) 

Specifies the typical orifice hole size (single hole). 

Note 

This field appears only if you select a conditioning orifice meter in 
the Meter Type field. 

Cone 
Diameter 

Specifies the cone diameter. 

Note 

This field appears only if you select a cone meter in the Meter Type 
field. 

Pipe Diameter Specifies the inside diameter of the pipe in which the meter is 
installed. 

No Flow Cut-
off Limit 

Sets the low flow cutoff point. When the live differential pressure of 
the metering device is less than this value, the meter flow rates will 
be set to zero. 

No Flow 
Status 

This read-only field shows the current flowing status of the selected 
meter. A differential pressure greater than or equal to the no flow 
cutoff is considered “flowing” and increments flow and flow time. A 
differential pressure below the no flow cutoff is considered “not 
flowing,” does not increment flow or flow time, and the Differential 
Pressure In Use field on the DP Meter – Diagnostics tab shows 0. 

Flow Direction Selects the value to be read from an integral or remote sensor DP 
object.  

Forward DP Value will be read from DP object’s SELECTED 
parameter. 

Reverse DP Value will be read from DP object’s REV_DP 
parameter. 

Note 

This selection only applies when a DP object is assigned as the 
differential pressure input. 
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Field Description 

Differential 
Pressure 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

differential pressure input to use for the selected 
meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• DP object (Forward) – SELECTED VALUE 

• DP object (Reverse) – REVERSE DIFFERENTIAL 
PRESSURE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to AI. 

• FBxNData object – SELECTED DOUBLE. For more 
information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data object – DOUBLE FLOATING POINT 1. 
For more information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the differential pressure value to use in 
calculations when the Mode field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 
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Field Description 

Selected 
Value 

This read-only field shows the current value of the 
selected differential pressure input. 

Units This read-only field shows the engineering units used 
for the selected input. 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms display 
for the User Data value. 

Static 
Pressure 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

static pressure input to use for the selected meter. 

If you select a Press object, the firmware determines 
the pressure input type (absolute or gauge) directly 
from the sensor. 

If you select an AI object, the firmware determines 
the pressure input type from the configurable Units 
Type selection that is associated with the selected 
analog input.  

If you select a User Data object, you must indicate 
the pressure input type in the Pressure Transmitter 
Type field.  

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• Press object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to AI. 

• FBxNData object – SELECTED DOUBLE. For more 
information, refer to FBxNet. 
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Field Description 

• HART object – PV SELECTED VALUE 

• User Data – DOUBLE FLOATING POINT 2. For 
more information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the static pressure value to use in calculations 
when the Mode field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Selected 
Value 

This read-only field shows the current value of the 
selected static pressure input. 

Units This read-only field shows the engineering units used 
for the selected input. 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms display 
for the User Data value. 
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Field Description 

Flowing 
Temperature 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

flowing temperature input to use for the selected 
meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• RTD object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to AI. 

• FBxNData object – SELECTED DOUBLE. For more 
information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data – DOUBLE FLOATING POINT 3. For 
more information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the current 
value of the input) or Override (the system uses the 
value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the flowing temperature value to use in 
calculations when the Mode field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Selected 
Value 

This read-only field shows the current value of the 
flowing temperature input used in calculations. 
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Field Description 

Units This read-only field shows the engineering units used 
for the selected input. 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms display 
for the User Data value. 

Pressure 
Transmitter 
Type 

Specifies the type of static pressure transmitter (absolute or gauge) 
configured for the selected meter. 

Note 

This field appears only if you select an FBxNData, HART, or User 
Data instance in the Flowing Pressure I/O Definition field. 

Corrected 
Volume Rate 
Alarm 

Sets the rate alarm limits for the corrected flow rate, and shows the 
status of each alarm. Possible statuses are: 

• Normal – The alarm is enabled and is not in an alarm condition. 

• Disabled – The alarm has been disabled. 

• In Alarm – The alarm is enabled and is in an alarm condition. 

Last Meter 
Inspection 
Time 

This read-only field shows the date and time the last meter element 
change event occurred in FBxConnect™ for the selected meter. For 
more information, refer to Plate Change. 

Note 

The default is 1/1/2000 12:00:00 AM. 

4. Select Save to save any changes you make to this display. 

4.9.2 DP Meter – Advanced  

Use this pop-up display to configure advanced properties for the selected differential 
pressure meter, including meter construction material, temperature correction, and 
discharge coefficient options. 

To access this pop-up display: 
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1. Select Configure > Gas > DP Meter from the FBxConnect™ main menu. The DP Meter 
display opens. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

3. Select the Advanced button. The DP Meter – Advanced pop-up display opens. 

Figure 160. DP Meter – Advanced 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Static 
Pressure 
Location 

Sets the location of the static pressure tap in relation to the meter and 
normal flow. 

Upstream The static pressure tap is located upstream in 
relation to the meter and normal flow. 

Downstream The static pressure tap is located downstream in 
relation to the meter and normal flow. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

401 

Field Description 

Temperature 
Correction 

Sets the option to correct the measured temperature to an upstream 
value. 

No Correction Temperature is either measured upstream or 
temperature correction is not significant and 
considered to be within the uncertainty of the 
measurement. AGA3 does not require temperature 
correction to upstream. 

Isentropic Temperature correction is made based on isentropic 
expansion across the meter using the isentropic 
exponent. 

Isenthalpic 
(Joule-
Thompson) 

Temperature correction is made based on isenthalpic 
expansion across the meter using Joule-Thomson 
coefficient. 

Note 

If you select AGA8 2017 Part 1 Detailed or AGA 8 
2017 – Part 2 / GERG 2008 in the 
Compressibility/Density Calculation field for the 
associated station (Station – General Tab), then the 
Joule-Thompson coefficient is calculated per the 
selected standard. For all other 
Compressibility/Density Calculation options, the 
Joule-Thompson coefficient is calculated per ISO/TR 
9464. 

Pipe 
Properties 

Indicates the material from which the meter tube is constructed. Nearly 
all natural gas applications use a carbon steel meter tube. This selection 
controls the value in the Pipe Material Alpha field. 

Note 

You must also configure the Pipe Diameter Reference Temperature 
field. 

Carbon Steel Indicates the meter tube material as carbon steel. 

304 Stainless 
Steel 

Indicates the meter tube material as 304 stainless 
steel. 

316 Stainless 
Steel 

Indicates the meter tube material as 316 stainless 
steel. 
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Field Description 

Generic 
Stainless Steel 

Indicates the meter tube material as generic stainless 
steel. This selection uses an average alpha based on 
304 and 316 stainless steel, and should be used if the 
exact grade is unknown. 

Monel 400 Indicates the meter tube material as Monel 400. 

User Entered 
Alpha 

Select User Entered Alpha to configure your own 
value in the Pipe Material User Alpha field. 

Pipe Material 
Alpha 

This field shows the coefficient of thermal expansion used to calculate 
the effect of temperature on the pipe. This number is shown with an 
implied multiplier of 1000. 

Note 

• This field is read-only unless you select User Entered Alpha in the 
Pipe Properties field. 

• This field shows a value only under flowing conditions, and shows 
0.0 under no flow conditions. 

Pipe 
Diameter 
Reference 
Temperature 

Indicates the reference temperature at which the internal diameter of 
the pipe was measured, expressed in degrees Fahrenheit or degrees 
Celsius. 

Meter 
Properties 

Indicates the material from which the orifice (or other meter element) is 
made. Nearly all natural gas applications use stainless steel orifice 
plates. 

Note 

You must also configure the Meter Diameter Reference Temperature 
field. 

Carbon Steel Indicates the meter element material as carbon steel. 

304 Stainless 
Steel 

Indicates the meter element material as 304 stainless 
steel. 

316 Stainless 
Steel 

Indicates the meter element material as 316 stainless 
steel. 

Generic 
Stainless Steel 

Indicates the meter element material as generic 
stainless steel. This selection uses an average alpha 
based on 304 and 316 stainless steel, and should be 
used if the exact grade is unknown. 
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Field Description 

Monel 400 Indicates the meter element material as Monel 400. 

User Entered 
Alpha 

Select User Entered Alpha to configure your own 
value in the Meter Material Alpha field. 

Meter 
Material 
Alpha 

This field shows the coefficient of thermal expansion used to calculate 
the effect of temperature on the meter. This number is shown with an 
implied multiplier of 1000. 

Note 

• This field is read-only unless you select User Entered Alpha in the 
Meter Properties field. 

• This field shows a value only under flowing conditions and shows 
0.0 under no flow conditions. 

Meter 
Diameter 
Reference 
Temperature 

Indicates the reference temperature at which the bore diameter of the 
orifice plate was measured (in selected temperature units). 

User 
Correction 
Factor 

Sets a factor the system multiplies by the base flow equation to make a 
desired adjustment to the flow. The user correction factor is applied to 
the volume, mass, and energy flow rates and totals. 

Note 

If you use the default value of 1, the system does not apply any 
correction. 

Relative 
Pressure 
Loss 

Enter the ratio of permanent pressure loss to differential pressure for 
the Venturi meter. This value is used to determine the pressure loss 
shown on the diagnostic pop-up display. 

Note 
This field appears only if you select ISO5167 Venturi (As Cast), 
ISO5167 Venturi (Machined), or ISO5167 Venturi (Rough Weld) in the 
Meter Type field on the DP Meter – General display. 

Discharge 
Coefficient 
Mode 

Sets how the system obtains the discharge coefficient value used in 
calculations. 

Override The system uses the value set in the Discharge 
Coefficient Override field for the discharge coefficient 
value. 
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Field Description 

Calculated The system calculates a value for the discharge 
coefficient. 

Calculated 
from Curve 

The system calculates a value for the discharge 
coefficient based on the values you enter. Select the 
Discharge Coefficient Calibration Curve Setup button 
to configure a 20-point discharge coefficient vs. 
Reynolds number curve. 

Note 

This field shows only if you select Cone in the Meter 
Type field on the DP Meter display. 

Override 
Discharge 
Coefficient  

Sets the discharge coefficient to use in calculations when Override is 
selected in the Discharge Coefficient Mode field. 

Calculated 
Discharge 
Coefficient  

This read-only field shows the discharge coefficient calculated by the 
system. This value is used by the system when you select Calculated in 
the Discharge Coefficient Mode field. 

Selected 
Discharge 
Coefficient 

This read-only field shows the discharge coefficient currently used in 
calculations based on the selected options. 

Discharge 
Coefficient 
Option 

Sets the option to calculate the discharge coefficient from the selected 
flow calculation method or from a calibrated curve of discharge 
coefficient vs. Reynolds number. 

Flow Equation 
Standard 

The system calculates the coefficient of discharge 
based on the selected calculation method. 

Calibrated 
Discharge 
Coefficient 
Curve 

The system calculates the coefficient of discharge 
from the user entered calibration curve. 

Note 

This option is not available for cone meters. 

Discharge 
Coefficient / 
Discharge 
Coefficient 
Calibration 
Curve Setup 

This option brings up a 20-point discharge coefficient vs. Reynolds 
number curve to allow you to enter values from a meter calibration 
report. Refer to Discharge Coeffcient. 
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Field Description 

Pipe 
Schedule 

Identifies the wall thickness of the pipe. 

Note 

This field appears only if you select 1595 Conditioning Orifice 
(Flange), 1595 Conditioning Orifice (D and D/2), or 405C Compact 
Orifice in the Meter Type field on the General tab. 

Pipe 
Schedule 
Adjustment 
Factor 

This read-only field shows an adjustment factor based on the selected 
pipe schedule. 

Note 

This field appears only if you select 1595 Conditioning Orifice 
(Flange), 1595 Conditioning Orifice (D and D/2), or 405C Compact 
Orifice in the Meter Type field on the General tab. 

Calibration 
Factor 

Enter the manufacturer supplied meter calibration factor. 

Note 

This field appears only if you select 1595 Conditioning Orifice 
(Flange), 1595 Conditioning Orifice (D and D/2), or 405C Compact 
Orifice in the Meter Type field on the General tab. 

Upstream 
Expansion 
Factor (Y1) 
Mode 

Sets how the system obtains the Upstream Expansion Factor (Y1) value 
used in calculations. Possible options are: 

Override The system uses the value you enter in the Override 
Upstream Expansion Factor (Y1) field. 

Calculated The system calculates the value per the selected DP 
meter standard. 

Override 
Upstream 
Expansion 
Factor (Y1) 

Sets the value to be used for the upstream expansion factor (Y1) in the 
calculations. Enter a value of 1.0 if the fluid measured is a liquid or a 
dense phase fluid. 

Selected 
Upstream 
Expansion 
Factor (Y1) 

This read-only field shows the value calculated per the selected DP 
meter standard. Notably, ISO 5167 calculations use the Reader-Harris 
equation, AGA 3 1992 calculations use the Buckingham-Beane equation, 
and AGA 3 2013 calculations use a revised equation developed at CEESI. 

5. Select Save to save any changes you make to this pop-up display . 
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4.9.2.1 Discharge Coefficient 

Use this option to enter values from the meter calibration report. 

To access this pop-up display: 

1. Select Configure > Gas > DP Meter . The DP Meter display opens. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

3. Select the Advanced button. The DP Meter – Advanced pop-up display opens. 

4. If present for your configured meter type, select either Calibrated from Curve in the 
Discharge Coefficient Mode frame or Calibrated Discharge Coefficient Curve in the 
Discharge Coefficient Option frame and Save your changes. 

5. Select the Discharge Coefficient /Discharge Coefficient Calibration Curve Setup 
button. The Discharge Coefficient pop-up display opens. 
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Figure 161. Discharge Coefficient 

 

6. Enter the Discharge Coefficient and Reynolds Number values from the meter 
calibration report. 

Note 

A valid point must have a non-zero Reynolds Number and a non-zero Discharge 
Coefficient. The points may be entered in any order and will be internally sorted by 
Reynolds Number, discarding any invalid points. No extrapolation is done beyond the 
lowest and highest points on the curve. If the Reynolds Number is less than the lowest 
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point on the curve, the calculated factor will be the factor for the lowest point on the 
curve. If the Reynolds Number is greater than the highest point on the curve, the 
calculated Discharge Coefficient will be the Discharge Coefficient for the highest point on 
the curve. 

7. Select Save to save any changes you make to this pop-up display. 

4.9.3 DP Meter Diagnostics 

Use this pop-up display to view read-only diagnostic information for the selected 
differential pressure meter, including calculated factors, calculated values, and alarm 
codes. 

Note 

• This pop-up can remain open while you change values on the other tabs of this 
display. 

• Physically impossible inputs may be clamped at a high or low limit value in order to 
ensure reasonable results. If a value is clamped at a high or low limit, a corresponding 
flow or property alarm is raised. 

To access this pop-up display: 

1. Select Configure > Gas > DP Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 
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Figure 162. DP Meter – Diagnostics Button 

 

3. Select the Diagnostics button. The DP Meter Diagnostics pop-up display opens 
showing the Factors & Values tab. 
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Figure 163. DP Meter Diagnostics 

 

The DP Meter Diagnostics pop-up display contains the following tabs: 

Factors and Values – This tab displays the read-only current values for inputs and interim 
figures used for the meter calculations. 

Calculation Alarms – This tab displays any current alarms that apply to the meter 
calculations. Use this tab to aid in the diagnosis of problems with the meter. 

4.9.3.1 DP Meter Diagnostics – Factors & Values Tab 

This tab displays the read-only current values for inputs and interim figures used for the 
meter calculations. 

To access this display: 

1. Select Configure > Gas > DP Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Diagnostics button. The DP Meter Diagnostics pop-up display opens 
showing the Factors & Values tab. 
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Figure 164. DP Meter Diagnostics – Factors & Values Tab 

 

4. Review the values in the following fields: 

Field Description 

Calculated 
Factors 

Reynolds 
Number (Re) 

This read-only field shows the pipe Reynolds 
number, a dimensionless ratio of forces used to 
correlate the variations in the meter coefficient of 
discharge (Cd) with changes in the fluid’s 
properties, flow rate, and meter geometry. 

Selected 
Discharge 
Coefficient (Cd) 

This read-only field shows the meter coefficient of 
discharge, the ratio of the actual flow to the 
theoretical flow and is applied to the theoretical 
flow equation to obtain the actual flow. 

Integral 
Multiplier 
Value (IMV/C-
Factor) 

This read-only field shows the integral multiplier 
value (also known as C-prime or C-Factor). It 
represents the static variables in the flow 
equation. 
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Field Description 

Velocity of 
Approach (Ev) 

This read-only field shows the velocity of 
approach factor (Ev), a mathematical expression 
that relates the velocity of the flowing fluid in the 
meter approach section (upstream meter tube) to 
the fluid velocity in the meter. 

Upstream 
Expansion 
Factor (Y1) 

This read-only field shows the upstream 
expansion factor (Y1), an empirical expression 
used to correct the flow rate for the reduction in 
fluid density that a compressible fluid experiences 
when it passes through the meter. 

Selected 
Diameter Ratio 
(β) 

This read-only field shows the ratio of the 
temperature corrected meter diameter to the 
temperature corrected pipe diameter. 

Isentropic 
Exponent (K) 

This read-only field shows the isentropic exponent 
(κ), a thermodynamic state property that 
establishes the relationship between an 
expanding fluid’s pressure and density as the fluid 
flows through the meter. 

Integral Value 
(IV) 

This read-only field shows the integral value (also 
known as hwPf or flow extension). It represents 
the dynamic variables in the flow equation and is 
calculated as the square root of the product of 
differential pressure and flowing pressure. 

Base 
Compressibility 
(Zb) 

This read-only field shows the base 
compressibility (Zb), an adjustment factor used to 
account for the deviation from the ideal gas law at 
user entered base temperature and pressure. 

Standard 
Compressibility 
(Zs) 

This read-only field shows the standard 
compressibility (Zs), an adjustment factor used to 
account for the deviation from the ideal gas law at 
standard temperature and pressure (60°F and 
14.73 psia). This value is used in the AGA3 Volume 
equations only. 
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Field Description 

Flowing 
Compressibility 
(Zf) 

This read-only field shows the flowing 
compressibility (Zf), an adjustment factor used to 
account for the deviation from the ideal gas law at 
flowing temperature and pressure. 

Calculated 
Values 

Selected 
Heating Value 

This read-only field shows the heating value of the 
fluid at base conditions. The heating value 
represents the amount of energy transferred as 
heat per unit mass or unit volume from the 
complete, ideal combustion of the gas with 
oxygen at a base temperature. 

Compressibility 
Heating Value 

If the compressibility calculation is dependent on 
the heating value, the value shown is the 
superior/gross volumetric heating value at the 
reference conditions you select on the Station – 
General. 

Note 

If the compressibility calculation is not dependent 
on the heating value, this field shows a value of 0. 

Dynamic 
Viscosity 

This read-only field shows the dynamic (absolute) 
viscosity of the fluid at flowing temperature and 
pressure. The dynamic viscosity represents the 
measure of a fluid’s intermolecular cohesive 
force’s resistance to shear per unit of time. 

Selected 
Pressure Loss 

This read-only field shows the permanent 
pressure loss due to the presence of the meter 
(upstream pressure less downstream pressure 
after recovery is complete). 

Base 
Compressibility 
for Heating 
Value 

This read-only field shows the calculated base 
compressibility used in heating value calculations. 

Note 

For more information about the heating value 
calculation, refer to the Station – Advanced. 
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Field Description 

In-Use Meter 
Value 

Differential 
Pressure In 
Use 

This read-only field shows the differential 
pressure being used by the flow calculation. It will 
reflect the value after the no-flow cutoff is applied 
in the selected differential pressure units of the 
station. 

Flowing 
Pressure In 
Use 

This read-only field shows the flowing pressure 
being used by the flow calculation. It will reflect 
the upstream, absolute pressure in the selected 
pressure units of the station. 

Flowing 
Temperature 
In Use 

This read-only field shows the flowing 
temperature being used by the flow calculation. It 
will reflect the value converted to upstream if 
upstream correction has been enabled in the 
selected temperature units of the station. 

Density Base Density This read-only field shows the base density value 
currently used in calculations. The base density is 
the mass per unit volume of the fluid being 
measured at user entered base temperature and 
pressure in the selected density units of the 
station. 

Relative 
Density 

This read-only field shows the relative density, the 
ratio of the density of the fluid to the density of air 
at base temperature and pressure. Relative 
density is a unit-less value. 

Flowing 
Density 

This read-only field shows the flowing density 
value currently used in calculations. The flowing 
density is the mass per unit volume of the fluid 
being measured at flowing temperature and 
pressure in the selected density units of the 
station. 

Corrected 
Values 

Corrected 
Meter 
Diameter 

This read-only field shows the meter diameter 
corrected for the difference between flowing 
temperature and the meter diameter reference 
temperature. 
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Field Description 

Corrected Pipe 
Diameter 

This read-only field shows the pipe diameter 
corrected for the difference between flowing 
temperature and the pipe diameter reference 
temperature. 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

 

4.9.3.2 DP Meter Diagnostics – Calculation Alarms Tab 

This tab displays any current alarms that apply to the meter calculations. Use this tab to 
aid in the diagnosis of problems with the meter. Alarm codes are comprised of two parts: 
Alarm Category (the reason for the alarm) and Alarm Value (the part of the calculation 
that raised the alarm). For example, if you assign a voltage signal to a pressure input, 
Invalid Input would be selected in the Alarm Category frame and Pressure would be 
selected in the Alarm Value frame. 

Note 

• The alarm code is a decimal representation of which alarm bits are set. Each bit is 
identified in the table below. 

• The error code can be a composite of one or more errors. 

• Error codes are generated according to your selection in the Calculation Failure 
Option field on the Station – Advanced. 

• Alarms are raised if calculation inputs and interim values do not fall within certain 
ranges based on the calculation you have selected. To view the boundary limits for 
calculations, refer to Calculation Library Limit Checks. 

To access this display: 

1. Select Configure > Gas > DP Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Diagnostics button. The DP Meter Diagnostics pop-up display opens. 

4. Select the Calculation Alarms tab. 
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Figure 165. DP Meter Diagnostics – Calculation Alarms Tab 

 

5. Review the values in the following fields: 

Field Description 

Flow 
Calculation 
Alarm 
Category 

These read-only fields show flow calculation alarm information. 

Alarm Code This read-only field shows a code that indicates 
whether the flow calculation is within the specified 
boundaries of the selected method. The alarm code is 
a decimal representation of which alarm bits are set. 

Note 

• This is the same alarm code shown in the Alarm 
report. 

• The Alarm Code may show 0 if Calculation Failure 
Option has been set to Alarm Disabled on the 
Station – Advanced. 

Alarm 
Category 

These read-only fields show, if checked, a general 
reason an alarm condition exists. Possible categories 
are: 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

417 

Field Description 

Invalid 
Input(s) 
(Bit 0) 

A required input is undefined, bad 
object type, wrong measurement 
type, measured input is not a valid 
floating-point number, or invalid 
combination of selections. 

Invalid 
Configuration 
(Bit 1) 

Database or program corruption. 

Note 

If detected, this alarm is asserted 
even when calculation alarms are 
disabled. 

Calculation 
Error 
(Bit 2) 

An error occurred in a calculation. 
Possible reasons are a conversion 
error, failure to converge, iteration 
limit, or divide by 0. 

Boundary 
Error 
(Bit 3) 

Something exceeded stated 
boundary of the calculation standard. 

Invalid 
Station 
Assignment 
(Bit 4) 

The meter type not is valid for the 
station type or station fluid type. 
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Field Description 

Alarm 
Value 

These read-only fields show, if checked, shows which 
part of the flow calculation is associated with the 
Alarm Category. 

• Differential Pressure (Bit 8) 

• Pressure (Bit 9) 

• Temperature (Bit 10) 

• Flowing Density / Compressibility (Bit 11) 

• Base Density / Compressibility (Bit 12) 

• Relative Density (Bit 13) 

• Heating Factor / Enthalpy (Bit 14) 

• Viscosity (Bit 15) 

• User Correction Factor (Bit 16) 

• Total / Increment (Bit 17) 

• Integral Multiplier Value (Bit 18) 

• Beta Ratio (Bit 25) 

• DP/P Ratio (Bit 26) 

• Isentropic Exponent (Bit 27) 

• Reynolds Number (Bit 28) 

• Pressure Loss / Pressure Loss Ratio (Bit 29) 

• Alpha (Bit 30) 

• Expansion Factor (Bit 31) 

Note 

A Total alarm can occur in the following situations: 

• A Fault Total object reference is incorrectly 
configured. For more information, refer to DP 
Meter Rates & Totals – Fault Totals Tab. 

• An internal error has occurred while totalizing. 
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Field Description 

Property 
Calculation 
Alarm 
Category 

These read-only fields show property calculation alarm information. 

Alarm Code This read-only field shows a code that indicates 
whether the property calculations (density, 
compressibility, and heating value) are within the 
specified boundaries of the selected method. The 
alarm code is a decimal representation of which alarm 
bits are set. 

Note 

• This is the same alarm code shown in the Alarm 
report. 

• The Alarm Code may show 0 if Calculation Failure 
Option has been set to Alarm Disabled on the 
Station – Advanced. 

Alarm 
Category 

These read-only fields show, if checked, a general 
reason an alarm condition exists. Possible categories 
are: 

Invalid 
Input(s) Bit 
(0) 

A required input is undefined, bad 
object type, wrong measurement 
type, measured input is not a valid 
floating-point number, or invalid 
combination of selections. 

Invalid 
Configuration 
Bit (1) 

Database or program corruption. 

Note 

If detected, this alarm is asserted 
even when calculation alarms are 
disabled. 

Calculation 
Error Bit (2) 

An error occurred in a calculation. 
Possible reasons are a conversion 
error, failure to converge, iteration 
limit, or divide by 0. 

Boundary 
Error Bit (3) 

Something exceeded stated 
boundary of the calculation standard. 
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Field Description 

Alarm 
Value 

These read-only fields show, if checked, shows which 
part of the flow calculation is associated with the 
Alarm Category. 

• Pressure (Bit 8) 

• Temperature (Bit 9) 

• Flowing Density/Compressibility (Bit 10) 

• Base Density/Compressibility (Bit 11) 

• Relative Density (Bit 12) 

• Heating Value/Enthalpy (Bit 13) 

• Composition (Bit 14) 

• Water Content (Bit 15) 

• Atmospheric Press/Gravitational Accel (Bit 16) 

• Viscosity (Bit 17) 

• Isentropic Exponent (Bit 18) 

• Speed of Sound (Bit 19) 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

 

4.9.4 DP Meter – Rates & Totals 

Use this tab to view read-only flow rates and accumulations and to manually configure 
fault totals for the selected differential pressure meter. 

Note 

This pop-up can remain open while you change values on the other tabs of this display. 

To access this tab: 

1. Select Configure > Gas > DP Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 
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Figure 166. DP Meter – Rates & Totals Button 

 

3. Select the Rates & Totals button. The DP Rates & Totals pop-up display opens. 
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Figure 167. DP Meter Rates & Totals 

 

The DP Rates & Totals pop-up display contains the following tabs: 

Rates & Totals – Use this tab to view read-only flow rates and accumulations for the 
selected differential pressure meter. 

Fault Totals – Use this tab to manually configure which Totals objects in the FB Series 
product database are used to store fault totals and view read-only fault total 
accumulations for the selected differential pressure meter. 

4.9.4.1 DP Meter Rates & Totals – Rates & Totals Tab 

Use this tab to view read-only flow rates and accumulations for the selected differential 
pressure meter. 

Note 

This pop-up can remain open while you change values on the other tabs of this display. 
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To access this tab: 

1. Select Configure > Gas > DP Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Rates & Totals button. The DP Rates & Totals pop-up display opens. 

Figure 168. DP Meter Rates & Totals – Rates & Totals Tab 

 

4. Review the values in the following fields: 

Field Description 

Current Flow 
Rates 

These read-only fields show the current uncorrected volume, 
corrected volume, energy, and mass flow rates for the selected 
meter. 

Current Totals These read-only fields show the total accumulation, as well as the 
current and previous hourly, daily, weekly, and monthly accumulation 
for the selected meter. 
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Field Description 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

 

4.9.4.2 DP Meter Rates & Totals – Fault Totals Tab 

Use this tab to manually configure which Totals objects in the FB Series product database 
are used to store fault totals and view read-only fault total accumulations for the selected 
differential pressure meter.  

Note 

• This pop-up can remain open while you change values on the other tabs of this 
display. 

• Fault totals are calculated when the system becomes unhealthy and can be used to 
determine how measurement quantities are affected by faults and alarms. To 
configure which faults and alarms cause the system to become unhealthy, refer to the 
Fault Health Configuration field on the Station – Advanced. 

• You can automatically configure which Totals objects are associated with fault totals 
by using the Totals Setup wizard.  

• You must configure additional spare Totals objects in the FB Series product database 
before manually configuring fault totals. For more information, refer to the Number 
of Spare Totals field on the Meter Setup display. 

To access this tab: 

1. Select Configure > Gas > DP Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Rates & Totals button. The DP Rates & Totals pop-up display opens. 

4. Select the Fault Totals tab. 
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Figure 169. DP Meter Rates & Totals – Fault Totals Tab 

 

5. Review the values in the following fields: 

Field Description 

Uncorrected 
Volume Total 
(fault) Object 

Click  to open a Point Picker dialog and select a Totals object from 

the FB Series product database to use for uncorrected volume fault 
totals. 

Note 

• Advanced users may select their own totals objects, but you must 
ensure you select a spare total (Total_5000x). 

• If you select a normal total that is already used elsewhere, a total 
increment alarm is raised at the meter and the normal total 
increments when a fault condition occurs. 

• If a fault total is Undefined, the normal total increments when a 
fault condition occurs. 
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Field Description 

Corrected 
Volume Total 
(fault) Object 

Click  to open a Point Picker dialog and select a Totals object from 

the FB Series product database to use for corrected volume fault 
totals. 

Note 

• Advanced users may select their own totals objects, but you must 
ensure you select a spare total (Total_5000x). 

• If you select a normal total that is already used elsewhere, a total 
increment alarm is raised at the meter and the normal total 
increments when a fault condition occurs. 

• If a fault total is Undefined, the normal total increments when a 
fault condition occurs. 

Mass Total 
(fault) Object 

Click  to open a Point Picker dialog and select a Totals object from 

the FB Series product database to use for mass fault totals. 

Note 

• Advanced users may select their own totals objects, but you must 
ensure you select a spare total (Total_5000x). 

• If you select a normal total that is already used elsewhere, a total 
increment alarm is raised at the meter and the normal total 
increments when a fault condition occurs. 

• If a fault total is Undefined, the normal total increments when a 
fault condition occurs. 

Energy Total 
(fault) Object 

Click  to open a Point Picker dialog and select a Totals object from 

the FB Series product database to use for energy fault totals. 

Note 

• Advanced users may select their own totals objects, but you must 
ensure you select a spare total (Total_5000x). 

• If you select a normal total that is already used elsewhere, a total 
increment alarm is raised at the meter and the normal total 
increments when a fault condition occurs. 

• If a fault total is Undefined, the normal total increments when a 
fault condition occurs. 
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Field Description 

Current Fault 
Totals 

These read-only fields show the total fault total accumulation, as well 
as the current and previous hourly, daily, weekly, and monthly fault 
total accumulations for the selected meter. 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

 

4.10  Linear Meter 

Use this display to configure linear meters in your FB Series product. 

To access this display, select Configure > Gas > Linear Meter from the FBxConnect™ 
main menu. 

Figure 170. Configure – Linear Meter 

 

The Linear Meter display contains the following items: 

General – Use this display to define basic parameters for the linear meter. The General 
tab displays when you first access the Linear Meter display. 

Auto-Adjust – Use this pop-up display to configure and view parameters specific to an 
Auto-Adjust meter. 

Note 

This tab is only available when a meter type of Auto-Adjust is configured. 

Advanced – Use this pop-up display to configure advanced properties for the selected 
linear meter, including meter construction material, temperature correction, and 
discharge coefficient options. 

Diagnostics – Use this pop-up display to view read-only diagnostic information for the 
selected linear meter, including calculated values and alarm codes.  

Rates & Totals – Use this pop-up display to view read-only flow rates and accumulations 
for the selected linear meter. 
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4.10.1 Linear Meter – General  

Use this display to define basic parameters for the linear meter. 

To access this display: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. The Linear 
Meter display opens. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

Figure 171. Linear Meter – General 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
meter. 
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Field Description 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
meter. 

Serial 
Number 

Sets a description (up to 20-alphanumeric characters) for the serial 
number or other identifier of the selected meter. 

Status This read-only field indicates the overall health of the selected meter. 
Possible values are: 

Normal Indicates the meter is not in an alarm, failure, or 
override condition. 

In alarm Indicates an active flow rate, I/O, property 
calculation, or flow calculation alarm. 

Failure Indicates a point fail on a meter input that is used in 
flow calculations or a severe calculation error that 
prevented calculations from continuing. 

Override Indicates a meter input that is used in flow 
calculations in override mode that is not typically in 
override. 

Note 

The status is based on the health of the uncorrected volume, 
corrected volume, and mass of the meter. You can configure which 
parameters determine the health of the meter in the Fault Health 
Configuration field on the Station – Advanced. 

The associated parameter (OBJ_STATUS) is a 32-bit binary value, where 
individual bits have different meaning. We currently use 3 bits. 
Starting from LSB (Least Significant Bit), Bit 1 represents “In Alarm,” Bit 
2 represents “Failure,” and Bit 3 represents “Override.” When viewing 
this parameter via a host system, the value is represented as a 
decimal number. For example, a value of 0 means no bits are set and 
the meter status is Normal. A value of 1 means the meter status is In 
Alarm. A value of 2 means the meter status is Failure. A value of 4 
means the meter status is Override. A value of 7 means Bits 1, 2, and 3 
are all set, and the meter status is In Alarm, Failure, and Override. 

Station 
Assignment 

Click  to open a Point Picker dialog and select the station to which 

this meter belongs. 

Note 
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Field Description 

• After selecting a Station, click  to open the Station 

configuration display. 

• Stations measuring different fluid types are hidden in the Point 
Picker. 

• Gas meters and liquid meters cannot belong to the same station. 
If you assign a gas meter to a liquid station or a liquid meter to a 
gas station, a Flow Calculation alarm is raised. 

Fluid 
Properties 
Reference 

This read-only field shows the fluid properties instance currently 
assigned to the selected meter. 

Note 

Click  to open the Fluid Properties configuration display. 

Flow Alarm 
Object 

This read-only field shows the alarm instance currently assigned to 
the selected meter. 

Note 

Click  to open the Alarms configuration display. 

Advanced Click this button to open the Linear Meter – Advanced pop-up display 
and configure advanced properties for the selected differential 
pressure meter. 

Diagnostics Click this button to open the Linear Meter – Diagnostics pop-up 
display and view read-only diagnostic information for the selected 
differential pressure meter. 

Rates & Totals Click this button to open the Linear Meter – Rates & Totals pop-up 
display and view read-only flow rates and accumulations and to 
manually configure fault totals for the selected differential pressure 
meter. 

Components Click this button to open the Components pop-up display and set the 
mole percent of each fluid component present in the meter. 

Meter Type Click ▼ to specify the type of linear meter you are configuring. 
Possible options are: 

Turbine Select if measuring flow through a turbine meter or 
other linear meter with a frequency or analog signal 
representing actual volumetric flow rate. Flow is 
calculated according to AGA 7. 
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Field Description 

Coriolis Select if measuring flow through a Coriolis meter or 
other linear meter with a frequency or analog signal 
representing a mass flow rate. Flow is calculated 
according to AGA 11. 

Auto-Adjust Select if measuring flow through an Auto-Adjust 
meter. This meter type requires 2 pulse inputs, one 
representing the main rotor and one representing 
the sensing rotor. 

Ultrasonic Select if measuring flow through an ultrasonic meter. 
This meter type option performs the same flow 
calculations as the Turbine option, and this option is 
provided for equipment identification. CFX files 
generated by FBxConnect™ include this option in the 
configuration section of the CFX file. 

Positive 
Displacement 

Select if measuring flow through a positive 
displacement meter. This meter type option performs 
the same flow calculations as the Turbine option, and 
this option is provided for equipment identification. 
CFX files generated by FBxConnect™ include this 
option in the configuration section of the CFX file. 

No Flow 
Option 

Sets how the system calculates a "no flow" condition for the meter and 
sets the calculated flow equal to zero. Possible options are: 

Time 
Between 
Pulses 

If the amount of time between pulses is greater than 
or equal to the time you enter in the text field, then 
system sets the calculated flow equal to zero. 

Note 

• This option is available only if you select a pulse 
input object in the Indicated Flow field.  

• You must enter a time (in seconds) for the 
system to use in the text field. 

• This method should be used for low frequency 
pulse inputs. 

• Use the method if you wish to perform a fixed 
count pulse input test. 
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Field Description 

Flow Cut-off If the value of the uncorrected volume input is less 
than or equal to the value you enter in the text field, 
then the system sets the calculated flow equal to 
zero. Enter a value (in units based on the table below) 
for the system to use in the text field.  

Indicated Flow  
Input Type Meter Type Unit Type 

Pulse Input 

Turbine Hz 

Auto-Adjust Hz 

Coriolis Hz 

AI or User 
Data 

Turbine  Volume Rate 

Auto-Adjust Volume Rate 

Coriolis Mass Rate 

Note 

The lowest frequency the system can accurately 
measure is 1 divided by the PI Scan Period 
(configured on the Pulse Input display). Flow control 
may be erratic below this threshold. 

No Flow 
Status 

This read-only field shows the current flowing status of the selected 
meter. An indicated flow greater than or equal to the no flow cutoff is 
considered “flowing” and increments flow and flow time. An indicated 
flow below the no flow cutoff is considered “not flowing” and does not 
increment flow or flow time. 

Pipe 
Diameter 

Indicates the pipe’s approximate internal diameter in selected Linear 
Short units. 

Note 

• For Auto-Adjust meter types, the program uses this value to 
complete the Blade Tip Sensor Factor field on the Auto-Adjust 
Alarms display. 

• For Turbine and Coriolis meter types, this field is for 
informational purposes. 
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Field Description 

Indicated 
Flow 

I/O 
Definition 

Click  to open a Point Picker dialog and select an 

indicated flow input to use for the selected meter. 
This field represents the Pulse Frequency for a 
Turbine or Coriolis meter type, and the Main Rotor 
Frequency for an Auto-Adjust meter type. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object.  

• PI object – SELECTED FREQUENCY and 
ACCUMULATED PULSES 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to 
AI. 

• FBxNData object – SELECTED DOUBLE. For more 
information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data – DOUBLE FLOATING POINT 1. For 
more information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the system 
uses the value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 
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Field Description 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Selected 
Value 

This field shows the value currently used in 
calculations based on the selected options. 

Units This read-only field shows the engineering units 
used for the selected input. 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms display 
for the User Data value. 

Secondary 
Flow Input 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

secondary flow input to use for the selected meter. 
The secondary flow input represents the Sensing 
Rotor Frequency and must be a PI object. This field is 
currently only used for an Auto-Adjust meter type.  

Note 

Only an object is chosen, and the Auto-Adjust 
algorithm reads the SELECTED FREQUENCY and 
ACCUMULATED PULSES parameters from the 
selected PI object. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the system 
uses the value you set in the override field). 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Selected 
Value 

This field shows the value currently used in 
calculations based on the selected options. 
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Field Description 

Units This read-only field shows the engineering units 
used for the selected input. 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Static 
Pressure 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

static pressure input to use for the selected meter. 

If you select a Press object, the firmware determines 
the pressure input type (absolute or gauge) directly 
from the sensor. 

If you select an AI object, the firmware determines 
the pressure input type from the configurable Units 
Type selection that is associated with the selected 
analog input.  

If you select a User Data object, you must indicate 
the pressure input type in the Pressure Transmitter 
Type field.  

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 

• Press object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to 
AI. 

• FBxNData object – SELECTED DOUBLE. For more 
information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data – DOUBLE FLOATING POINT 2. For 
more information, refer to User Data.  
Note 
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Field Description 

The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the system 
uses the value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Selected 
Value 

This field shows the value currently used in 
calculations based on the selected options. 

Units This read-only field shows the engineering units 
used for the selected input. 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms display 
for the User Data value. 

Flowing 
Temperature 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

flowing temperature input to use for the selected 
meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 

• RTD object – SELECTED VALUE 
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Field Description 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use the 
correct measurement type before it is visible in 
the Point Picker. For more information, refer to 
AI. 

• FBxNData object – SELECTED DOUBLE. For more 
information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data – DOUBLE FLOATING POINT 3. For 
more information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the system 
uses the value you set in the override field). 

Note 

This option is not available if you select a User Data 
object. 

Override 
Value 

Sets the value to use in calculations when the Mode 
field is set to Override. 

Note 

This value is not available if you select a User Data 
object. 

Selected 
Value 

This field shows the value currently used in 
calculations based on the selected options. 

Units This read-only field shows the engineering units 
used for the selected input. 
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Field Description 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms display 
for the User Data value. 

Pressure 
Transmitter 
Type 

Indicates the type of static pressure transmitter (absolute or gauge) 
configured for the selected meter. 

Note 

This field appears only if you select an FBxNData, HART, or User Data 
instance in the Static Pressure I/O Definition field. 

Corrected 
Volume Rate 
Alarms 

Sets the rate alarm limits for the corrected flow rate, and shows the 
status of each alarm. Possible statuses are: 

• Normal – The alarm is enabled and is not in an alarm condition. 

• Disabled – The alarm has been disabled. 

• In Alarm – The alarm is enabled and is in an alarm condition. 

Auto Adjust 
Main Rotor K-
factor 

Sets a scaling K-factor the program uses to convert the main rotor 
pulses to volume in the selected Volumetric K-factor units. 

Note 

This field appears only if you select Auto-Adjust in the Meter Type 
field. 

Auto Adjust 
Sensing 
Rotor K-
factor 

Sets a scaling K-factor the program uses to convert the sensing rotor 
pulses to volume in the selected Volumetric K-factor units. 

Note 

This field appears only if you select Auto-Adjust in the Meter Type 
field. 

Auto Adjust 
Mechanical 
K-factor 

Sets a scaling K-factor in the selected Volumetric K-factor units as 
provided from the Equimeter calibration sheet. The program uses this 
value to calculate a Mechanical Volume rate or unadjusted volume, 
which matches the Turbo-Meter mechanical totalizer volume. 

Note 

This field appears only if you select Auto-Adjust in the Meter Type 
field. 
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Field Description 

Auto Adjust 
Relative 
Adjustment 

Indicates the average relative adjustment (as a percentage) for the 
auto-adjust algorithm determined at factory calibration. 

Note 

This field appears only if you select Auto-Adjust in the Meter Type 
field. 

Auto Adjust 
Maximum 
Frequency 

Indicates the maximum frequency value (in Hz) the program uses 
when calculating the meter load, expressed as Current Frequency or 
Maximum Frequency. 

Note 

This field appears only if you select Auto-Adjust in the Meter Type 
field. 

Calibration 
Mode 

Sets the rotor calibration mode. Possible options are: 

Note 

This field appears only if you select Auto-Adjust in the Meter Type 
field. 

Disable Uses a self-checking cycle of 2,500 rotations 

Enable Uses the standard cycle of 25,000 rotations 

Details Select this button to open the Linear Meter – Auto Adjust pop-up 
display and configure options for the selected Auto-Adjust meter. 

Reset 
Algorithm 

Select this button to clear alarms and self-checking test data for the 
Auto-Adjust meter, and to re-start collection and analysis of the data. 
It is recommended to reset the algorithm after installation or after any 
maintenance on the meter. 

Note 

This field appears only if you select Auto-Adjust in the Meter Type 
field. 

4. 4 Select Save to save your changes if you modify any of the fields on this display. 

4.10.2 Linear Meter – Auto-Adjust 

Use this pop-up display to configure options for the selected Auto-Adjust meter. 
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Note 

This pop-up display is available only if you select Auto-Adjust in the Meter Type field. 

To access this pop-up display: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Details button in the Auto Adjust frame. The Linear Meter – Auto Adjust 
pop-up display opens. 

Figure 172. Linear Meter – Auto-Adjust 

 

4. Review – and change as necessary – the values in the following fields: 
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Field Description 

Auto Adjust 
Test Timer 

This read-only field shows the number of seconds elapsed since the 
program last started the Auto-Adjust self-checking calculation. The 
program resets this value either after 512 seconds or when the main 
rotor reaches 25,000 pulses, whichever occurs first. 

Auto Adjust 
Pulse Accum 

This read-only field shows the rotor pulses accumulated during the 
current self-checking calculation cycle. A self-checking calculation 
cycle takes either 25,000 rotor rotations or 512 seconds, whichever 
occurs first. 

Current 
Frequency 

This read-only field shows the current frequency (in Hz) for both the 
main and sensing rotors. The program updates this value once each 
second. 

Flow Rate This read-only field shows the raw volumetric rate (in ft3/second or 
m3/second) for both the main and sensing rotors. The program 
calculates this value as pulse/second divided by K-factor for the rotor. 

Accumulation This read-only field shows the raw volume values (in ft3 or m3) for 
both the main and sensing rotors during the current self-adjusting 
calculation cycle. 

Auto Adjust 
Base Delta A 

Sets the baseline delta adjustment (Delta A) value (as a percentage) 
derived either from the factory calibration curve or the initial field 
testing. 

Note 

The program’s run-time warning and alarm limits depend on this 
value. For example, the program calculates the low warning limit as 
the Baseline Delta Adjustment value minus the Normal Band value 
and the high alarm limit as the Baseline Delta Adjustment value plus 
the Abnormal Band value. 

Auto Adjust 
Calculated 
Delta A 

This read-only field shows the system-calculated delta adjustment 
(Delta A) value (as a percentage). This value is the amount of change 
that has occurred in the meter or flow condition compared to its 
original calibration value. The program refreshes this value at least 
every 512 seconds or 25,000 rotations of the main rotor. 

Auto Adjust 
Normal Band 

Sets the normal limits (as a percentage) above and below the 
Baseline Delta A value. The default value is 0.2. If the percentage 
exceeds this value, the program triggers a warning. 
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Field Description 

Auto Adjust 
Abnormal 
Band 

Sets the abnormal limits (as a percentage) above and below the 
Baseline Delta A value. The default value is 0.3. If the percentage 
exceeds this value, the program triggers an alarm. 

Auto Adjust 
Blade Factor 

This read-only field shows a predefined factor based on the value 
entered in the Pipe Diameter field on the Linear Meter – General 
display. 

Note 

The program considers any pipe diameter between 7 and 10 inches 
as 8 inches, to correspond to the Equimeter meter choices of 4, 6, 8, 
and 12 inches. 

Auto Adjust 
Calculated 
Load 

This read-only field shows the instantaneous turbine load (as a 
percentage), calculated as the current main rotor frequency divided 
by the maximum frequency. The program updates this value once 
every second. 

Auto Adjust 
Mechanical 
Rate 

Indicates the unadjusted flow rate (in MCF/day or KM3/day) based on 
the main rotor pulses and the mechanical K-factor. The system 
updates this value once per second. This parameter does not have 
compensation from the auto-adjust algorithm. 

Note 

The AGA 7 firmware expects a flow rate (in either MCF/day or 
KM3/day) when reading an uncorrected value other than from a 
pulse input point. 

Auto Adjust 
System Alarm 

This read-only field indicates the current system status. Possible 
system alarms include Normal Flow, No Flow or Loss of Both Rotor, 
Leakage or Resonant No-Net Flow, No Main Rotor Pulses Or Leakage 
Or Resonant No-Net Flow, and No Sensing Rotor Pulses. 

Note 

Alarms are audited in the alarm log. 

Auto Adjust 
Delta A Alarm 

This read-only field shows whether the program-calculated deviation 
from the average relative adjustment is within normal limits. Possible 
Delta A alarms include Normal, Low Warning, High Warning, Low 
Alarm, and High Alarm. 

Note 

Alarms are audited in the alarm log. 
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Field Description 

Auto Adjust 
Flow Alarm 

This read-only field shows the status of the ratio between the 
sensing rotor’s volume and the main rotor’s volume. Possible values 
are Normal Flow (the ratio is steady) or Non-Steady Flow (the ratios 
are below acceptable limits). 

Note 

Alarms are audited in the alarm log. 

Auto Adjust 
Initial Cycle 
Status 

This read-only field indicates whether the initial cycle has started or 
is complete. 

Auto Adjust 
Alarm Log 
Option 

Sets whether the Auto-Adjust alarms are written to the alarm log or 
not. 

Disable Alarm states are accessible through the alarm 
parameters, but alarm state changes are not logged 
to the alarm log. 

Enable Alarm states are accessible through the alarm 
parameters and alarm state changes are logged to the 
alarm log. 

Calibration 
Curve Option 

Activates the Auto-Adjust Calibration Curve calculation. Valid values 
are: 

Enable The system includes the Adjusted Uncorrected Volume 
Factor (AUVF) in calculations.  

Note 

You must enter information from the calibration 
report in the % Error and AAT Volume fields. The 
program applies the AUVF to the result of the auto-
adjust algorithm to calculate the adjusted volume rate 
at flowing conditions.  

Disable The system does not use the AUVF in calculations 
(which is equal to an AUVF of 1.00).  

Note 

If you disable the calibration curve, the adjusted 
volume rate reflects the result of the auto-adjust 
algorithm with no correction for the calibration curve. 
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5. Select Save to save your changes if you modify any of the fields on this pop-up 
display. 

4.10.2.1 Calibration Curve Option (Auto-Adjust) 

Use the Calibration Curve Option to enter a meter factor curve or K-factor curve for an 
Auto-Adjust meter. 

To access this option: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

3. Select the Details button in the Auto Adjust frame. The Auto Adjust pop-up display 
opens. 

4. Select Enable in the Calibration Curve Option frame. 
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Figure 173. Linear Meter – Auto Adjust 

 

5. Enter up to 20 points on the curve (pairs of % Error and AAT Volume {the volumetric 
flow rate calculated by the Auto-Adjust Turbine algorithm}). 

6. Enable the calibration curve option. The adjusted Uncorrected Volume Factor is 
calculated for use in the flow equation by using linear interpolation of the AAT Volume 
to determine % Error and then the AUVF is calculated as follows: 

 

Note 

A valid point must have an AAT Volume greater than zero. The points may be entered in 
any order and will be internally sorted by AAT Volume, discarding any invalid points. No 
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extrapolation is done beyond the lowest and highest points on the curve. If the actual AAT 
Volume is less than the lowest point on the curve, the % Error will be the % Error for the 
lowest point on the curve. If the actual AAT Volume is greater than the highest point on 
the curve, the % Error will be the % Error for the highest point on the curve. If there are 
no valid points, then a default of 1.0% is used. 

7. Select Save to save any changes you make to this pop-up display. 

4.10.3 Linear Meter – Advanced 

Use this pop-up display to configure advanced properties for the selected linear meter, 
including meter construction material, temperature correction, and discharge coefficient 
options. 

To access this pop-up display: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

3. Select the Advanced button. The Linear Meter – Advanced pop-up display opens. 
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Figure 174. Linear Meter – Advanced (Coriolis Meter Type) 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Meter Factor / 
K-factor Curve 
Option 

Sets how system uses calculates K-factors or Meter Factors in the flow 
calculation. Possible options are: 

Note  
This field appears only if you select either Turbine, Coriolis, 
Ultrasonic, or Positive Displacement in the Meter Type field on the 
General tab. 
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Field Description 

Single 
Meter 
Factor / 
Single K-
factor 

Uses a single Meter Factor and a single K-factor for 
the meter. This is the simplest choice and means that 
a value for the meter factor and a value for the K-
factor are fixed for all flow rates and the values are 
taken from the last prove or an entered value. Select 
this option when using either the K-factor or meter 
factor proving, as long as neither the K-factor or meter 
factor will vary with flow rate or product. 

Meter 
Factor 
Curve / 
Single K-
factor 

A meter factor calculates for the current flow rate 
based on a linear interpolation of the meter factor 
versus flow rate values entered under the Factor 
Curve heading, but the K-factor will be fixed. Select 
this option when using meter factor proving if proving 
is done at multiple flow rates. 

Note 

You must select the Curve Setup button and 
configure the meter factor curve. 

Single 
Meter 
Factor / K-
factor 
Curve 

A K-factor calculates for the current flow input 
frequency based on a linear interpolation of the meter 
factor versus frequency values entered under the 
Factor Curve, but the meter factor will be a single 
value from the last prove or entered value. The K-
factor curve can come from multiple proves at 
different flow rates with a meter factor of 1.0 (K-factor 
proving) or the K-factor curve can come from factory 
calibration and a single meter factor from a prove 
(meter factor proving). 

Note 

You must select the Curve Setup button and 
configure the K-factor curve. 
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Field Description 

Curve Setup Click to open the Curve Setup dialog and configure the meter 
factor/K-factor curve. For more information, refer to Curve Setup 
(Linear Meter). 

Note 

This field appears only if you select either Meter Factor Curve / 
Single K-factor or Single Meter Factor / K-factor Curve in the Meter 
Factor / K-factor Curve Option field. 

Meter Factor Sets how the system obtains the meter factor value used in 
calculations. Possible options are: 

Override The system uses the value set in the Override Meter 
Factor field for the meter factor value. 

Calculate The system calculates a value for the meter factor. 

Override 
Meter Factor 

Sets the meter factor value to use in calculations when you select 
Override in the Meter Factor field. 

Calculated 
Meter Factor 

This read-only field shows the meter factor value as calculated by the 
system. 

Note 

This value is used by the system when you select Calculate in the 
Meter Factor field. 

Selected 
Meter Factor 

This read-only field shows the meter factor currently used in 
calculations based on the selected options. 

K-factor Sets how the system obtains the K-factor value used in calculations. 
Possible options are: 

Note  
This field appears only if you select either Turbine, Coriolis, 
Ultrasonic, or Positive Displacement in the Meter Type field on the 
General tab. 

Override The system uses the value set in the Override K-
factor field for the K-factor value. 

Calculated The system calculates a value for the K-factor. 

Override K-
factor 

Sets the discharge coefficient value to use in calculations when you 
select Override in the K-factor field. 
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Field Description 

Calculated K-
factor 

This read-only field shows the discharge coefficient value as 
calculated by the system. 

Note  

• This field appears only if you select either Turbine, Coriolis, 
Ultrasonic, or Positive Displacement in the Meter Type field on 
the General tab. 

• This value is used by the system when you select Calculate in the 
K-factor field. 

Selected K-
factor 

This read-only field shows the K-factor currently used in calculations 
based on the selected options. 

Note  
This field appears only if you select either Turbine, Coriolis, 
Ultrasonic, or Positive Displacement in the Meter Type field on the 
General tab. 

User 
Correction 
Factor 

Sets a factor the system multiplies by the base flow equation to make 
a desired adjustment to the flow. The user correction factor is applied 
to the volume, mass, and energy flow rates and totals. 

Note 

If you use the default value of 1, the system does not apply any 
correction. 

Mass Pressure 
Effect 
Compensation 

This option allows for the compensation for the effects of high 
pressure on the accuracy of the meter mass flow rate and 
accumulation. This may be necessary in applications where the 
operating pressure is significantly different from the meter’s 
calibration pressure. 

Note 

This field appears only if you select Coriolis in the Meter Type field 
on the General tab. 

Enable The system compensates for the effects of pressure 
on accuracy. 

Note 

You must enter a value in the Mass Pressure Effect 
and Calibration Pressure fields. 
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Field Description 

Disable The system does not compensate for the effects of 
pressure on accuracy. 

Mass Pressure 
Effect 

Enter a value (in units of per psi or per bar) to be used when 
performing mass pressure effect compensation. 

Note 

• This value is supplied by the manufacture of the mass meter and 
is typically a small negative number. 

• This field appears only if you select Coriolis in the Meter Type 
field on the General tab. 

Calibration 
Pressure 

Sets the pressure (in units of gauge psi or bar) of the mass meter as 
calibrated. 

Note  

• This value is supplied by the manufacture of the mass meter and 
is typically a small negative number. 

• This field appears only if you select Coriolis in the Meter Type 
field on the General tab. 

5. Select Save to save your changes if you modify any of the fields on this pop-up 
display.  

4.10.3.1 Curve Setup (Linear Meter) 

Use this option to enter a meter factor curve or K-factor curve. 

To access this pop-up display: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

3. Select the Advanced button. The Linear Meter – Advanced pop-up display opens. 
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Figure 175. Linear Meter – Advanced 

 

4. Select either Meter Factor Curve / Single K-factor or Single Meter Factor / K-factor 
Curve in the Meter Factor / K-factor Curve Option frame and Save your changes. 

5. Select the Curve Setup button. The Curve Setup pop-up display opens. 
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Figure 176. Curve Setup 

 

6. If you selected Meter Factor Curve / Single K-factor on the previous display, enter 
up to 20 points on the curve (pairs of meter factor and flow rate) and a meter factor is 
calculated for use in the flow equation by linear interpolation of the current indicated 
quantity flow rate. If you selected Single Meter Factor / K-factor Curve on the 
previous display, enter up to 20 points on the curve (pairs of K-factor and frequency) 
and a K-factor is calculated for use in the flow equation by linear interpolation of the 
current flow meter input frequency. 
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Note 

A valid point must have a flow rate/frequency greater than zero and a factor greater than 
zero. The points may be entered in any order and will be internally sorted by flow rate (MF 
curve) or frequency (K-Factor Curve), discarding any invalid points. No extrapolation is 
done beyond the lowest and highest points on the curve. If the flow rate/frequency is less 
than the lowest point on the curve, the calculated factor will be the factor for the lowest 
point on the curve. If the flow rate/frequency is greater than the highest point on the 
curve, the calculated factor will be the factor for the highest point on the curve. If there 
are no valid points, then a default factor of 1.0 is used. 

7. Select Save to save any changes you make to this pop-up display. 

4.10.4 Linear Meter Diagnostics 

Use this pop-up display to view read-only diagnostic information for the selected linear 
meter, including calculated factors, calculated values, and alarm codes. 

Note 

• This pop-up can remain open while you change values on the other tabs of this 
display. 

• Physically impossible inputs may be clamped at a high or low limit value in order to 
ensure reasonable results. If a value is clamped at a high or low limit, a corresponding 
flow or property alarm is raised. 

To access this pop-up display: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 
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Figure 177. Linear Meter – Diagnostics Button 

 

3. Select the Diagnostics button. The Linear Meter Diagnostics pop-up display opens 
showing the Factors & Values tab. 
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Figure 178. Linear Meter Diagnostics 

 

The Linear Meter Diagnostics pop-up display contains the following tabs: 

Factors and Values – This tab displays the read-only current values for inputs and interim 
figures used for the meter calculations. 

Calculation Alarms – This tab displays any current alarms that apply to the meter 
calculations. Use this tab to aid in the diagnosis of problems with the meter. 

4.10.4.1 Linear Meter Diagnostics – Factors & Values Tab 

This tab displays the read-only current values for inputs and interim figures used for the 
meter calculations. 

To access this tab: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Diagnostics button. The Linear Meter Diagnostics pop-up display opens 
showing the Factors & Values tab 
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Figure 179. Linear Meter Diagnostics – Factors & Values Tab 

 

4. Review the values in the following fields: 

Field Description 

Calculated 
Factors 

Selected K-
factor 

This read-only field shows the pulses per unit 
quantity generated by a pulse output type flow 
meter (also system factor). The nominal value is 
determined by flow meter design and factory 
water flow calibration. The "average" K-factors for 
the flow meters are usually displayed on the flow 
meter nameplates. 

Selected Meter 
Factor 

This read-only field shows the number obtained 
by dividing the actual volume of fluid passed 
through a flow meter during a meter proving 
operation by the volume registered by the flow 
meter. The meter factor is used in flow 
calculations to correct the indicated volume (end 
flow meter registration minus start flow meter 
registration) to the observed gross volume (actual 
flow meter throughput at operating conditions). 
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Field Description 
Meter factor = (Meter prover volume corrected to 
standard conditions) / (Flow meter indicated 
volume corrected to standard conditions) 

Integral 
Multiplier 
Value  
(IMV/C-Factor) 

This read-only field shows the combined volume 
correction factor which is the product of the 
pressure, temperature, and compressibility factors 
described below. 

Pressure 
Multiplier 

This read-only field shows the pressure multiplier, 
a ratio of flowing pressure to base pressure that 
reflects the volume correction for pressure. 

Temperature 
Multiplier 

This read-only field shows the temperature 
multiplier, a ratio of base temperature to flowing 
temperature that reflects the volume correction 
for temperature. 

Compressibility 
Multiplier 

This read-only field shows the compressibility 
multiplier, a ratio of base compressibility to 
flowing compressibility that reflects the volume 
correction for non-ideal gas. 

Indicated 
Quantity Flow 
Rate 

This read-only field shows the raw flow rate from 
the meter in Volumetric or Mass Flow Rate units, 
depending on the meter type. This value is prior to 
any meter factor correction. 

Base 
Compressibility 
(Zb) 

This read-only field shows the compressibility at 
base conditions. 

Standard 
Compressibility 
(Zs) 

This read-only field shows the compressibility at 
standard conditions. 

Flowing 
Compressibility 
(Zf) 

This read-only field shows the compressibility at 
flowing conditions. 
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Field Description 

User 
Correction 
Factor 

This read-only field shows a factor the system 
multiplies by the base volume flow equation to 
make a desired adjustment to the flow. The user 
correction factor is applied to the volume, mass, 
and energy flow rates and totals. 

Note 

A value of 1 does not apply any correction. 

Calculated 
Values 

Selected 
Heating Value 

This read-only field shows the heating value of the 
fluid at base conditions. The heating value 
represents the amount of energy transferred as 
heat per unit mass or unit volume from the 
complete, ideal combustion of the gas with 
oxygen at a base temperature. 

Compressibility 
Heating Value 

If the compressibility calculation is dependent on 
the heating value, this read-only field shows the 
superior/gross volumetric heating value at the 
reference conditions you select on the Station – 
General. 

Note 

If the compressibility calculation is not dependent 
on the heating value, this field shows a value of 0. 

Base 
Compressibility 
for Heating 
Value 

This read-only field shows the calculated base 
compressibility used in heating value calculations. 

Note 

For more information about the heating value 
calculation, refer to the Station – Advanced. 

Calculated 
Speed of Sound 

This read-only field shows the speed of sound 
through the fluid calculated from the gas 
composition, temperature, and pressure. It is 
commonly compared to the measured speed of 
sound from an ultrasonic meter for diagnostic 
purposes. 
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Field Description 

Mass Pressure 
Effect 

This read-only field shows the mass pressure 
effect currently used in calculations. The mass 
pressure effect accounts for the effect of pressure 
on the vibrating tube of the Coriolis meter. 

Note 

This field shows only for Coriolis meter types. 

In-Use Meter 
Value 

Pulse 
Frequency / 
Main Rotor 
Frequency 

This read-only field shows the value of the 
indicated flow input configured on the Linear 
Meter – General. 

Sensing Rotor 
Frequency 

This read-only field shows the value of the 
secondary flow input configured on the Linear 
Meter – General. 

Flowing 
Pressure 

This read-only field shows the flowing pressure 
being used by the flow calculation. It will reflect 
the absolute pressure in the selected pressure 
units of the station. 

Flowing 
Temperature 

This read-only field shows the flowing 
temperature being used by the flow calculation. It 
will reflect the temperature in the selected 
temperature units of the station. 

Density Selected Base 
Density 

This read-only field shows the base density value 
currently used in calculations. The base density is 
the mass per unit volume of the fluid being 
measured at user entered base temperature and 
pressure in the selected density units of the 
station. 

Selected 
Relative 
Density 

This read-only field shows the relative density, the 
ratio of the density of the fluid to the density of air 
at base temperature and pressure. Relative 
density is a unit-less value. 
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Field Description 

Selected 
Flowing 
Density 

This read-only field shows the flowing density 
value currently used in calculations. The flowing 
density is the mass per unit volume of the fluid 
being measured at flowing temperature and 
pressure in the selected density units of the 
station. 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

 

4.10.4.2 Linear Meter Diagnostics – Calculation Alarms Tab 

This tab displays any current alarms that apply to the meter calculations. Use this tab to 
aid in the diagnosis of problems with the meter. Alarm codes are comprised of two parts: 
Alarm Category (the reason for the alarm) and Alarm Value (the part of the calculation 
that raised the alarm). For example, if you assign a voltage signal to a pressure input, 
Invalid Input would be selected in the Alarm Category frame and Pressure would be 
selected in the Alarm Value frame. 

Note 

• The alarm code is a decimal representation of which alarm bits are set. Each bit is 
identified in the table below. 

• The error code can be a composite of one or more errors. 

• Error codes are generated according to your selection in the Calculation Failure 
Option field on the Station – Advanced. 

• Alarms are raised if calculation inputs and interim values do not fall within certain 
ranges based on the calculation you have selected. To view the boundary limits for 
calculations, refer to Calculation Library Limit Checks. 

To access this tab: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Diagnostics button. The Linear Meter Diagnostics pop-up display opens 
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4. Select the Calculation Alarms tab. 

Figure 180. Linear Meter Diagnostics – Calculation Alarms Tab 

 

5. Review the values in the following fields: 

Field Description 

Flow 
Calculation 

These read-only fields show flow calculation alarm information. 

Alarm 
Code 

This read-only field shows a code that indicates 
whether the flow calculation is within the specified 
boundaries of the selected method. The alarm code is 
a decimal representation of which alarm bits are set. 

Note 

• This is the same alarm code shown in the Alarm 
report. 

• The Alarm Code may show 0 if Calculation Failure 
Option has been set to Alarm Disabled on the 
Station – Advanced. 

Alarm 
Category 

These read-only fields show, if checked, a general 
reason an alarm condition exists. Possible categories 
are: 
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Field Description 

Invalid 
Input(s)  
(Bit 0) 

A required input is undefined, bad 
object type, wrong measurement 
type, measured input is not a valid 
floating-point number, or invalid 
combination of selections. 

Invalid 
Configuration 
(Bit 1) 

Database or program corruption. 

Note 

If detected, this alarm is asserted 
even when calculation alarms are 
disabled. 

Calculation 
Error (Bit 2) 

An error occurred in a calculation. 
Possible reasons are a conversion 
error, failure to converge, iteration 
limit, or divide by 0. 

Boundary 
Error (Bit 3) 

Something exceeded stated 
boundary of the calculation standard. 

Invalid 
Station 
Assignment 
(Bit 4) 

The meter type is not valid for the 
station type or station fluid type. 

Alarm 
Value 

These read-only fields show, if checked, shows which 
part of the flow calculation is associated with the Alarm 
Category. 

• Flow (Bit 8) 

• Pressure (Bit 9) 

• Temperature (Bit 10) 

• Flowing Density/Compressibility (Bit 11) 

• Base Density/Compressibility (Bit 12) 

• Relative Density (Bit 13) 

• Heating Value/Enthalpy (Bit 14) 

• Viscosity (Bit 15) 

• User Correction Factor (Bit 16) 

• Total/Increment (Bit 17) 

• Integral Multiplier Value (Bit 18) 
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Field Description 
• K-factor/Meter Factor (Bit 25) 

• Mass Pressure Correction Factor (Bit 26) 

Note 

A Total alarm can occur in the following situations: 

• A Fault Total object reference is incorrectly 
configured. For more information, refer to Linear 
Meter Rates & Totals – Fault Totals Tab. 

• An internal error has occurred while totalizing. 

Property 
Calculation 

These read-only fields show property calculation alarm information. 

Alarm 
Code 

This read-only field shows a code that indicates 
whether the property calculations (density, 
compressibility, and heating value) are within the 
specified boundaries of the selected method. The 
alarm code is a decimal representation of which alarm 
bits are set. 

Note 

• This is the same alarm code shown in the Alarm 
report. 

• The Alarm Code may show 0 if Calculation Failure 
Option has been set to Alarm Disabled on the 
Station - Advanced tab. 

Alarm 
Category 

These read-only fields show, if checked, a general 
reason an alarm condition exists. Possible categories 
are: 

Invalid 
Input(s)  
(Bit 0) 

A required input is undefined, bad 
object type, wrong measurement 
type, measured input is not a valid 
floating-point number, or invalid 
combination of selections. 

Invalid 
Configuration 
(Bit 1) 

Database or program corruption. 

Note 

If detected, this alarm is asserted 
even when calculation alarms are 
disabled. 
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Field Description 

Calculation 
Error (Bit 2) 

An error occurred in a calculation. 
Possible reasons are a conversion 
error, failure to converge, iteration 
limit, or divide by 0. 

Boundary 
Error (Bit3) 

Something exceeded stated 
boundary of the calculation standard. 

Alarm 
Value 

These read-only fields show, if checked, shows which 
part of the flow calculation is associated with the Alarm 
Category. 

• Pressure (Bit 8) 

• Temperature (Bit 9) 

• Flowing Density/Compressibility (Bit 10) 

• Base Density/Compressibility (Bit 11) 

• Relative Density (Bit 12) 

• Heating Value/Enthalpy (Bit 13) 

• Composition (Bit 14) 

• Water Content (Bit 15) 

• Atmospheric Press/Gravitational Accel (Bit 16) 

• Viscosity (Bit 17) 

• Isentropic Exponent (Bit 18) 

• Speed of Sound (Bit 19) 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

4.10.5 Linear Meter Rates & Totals 

Use this pop-up display to view read-only flow rates and accumulations and to manually 
configure fault totals for the selected linear meter. 

Note 

This pop-up can remain open while you change values on the other tabs of this display. 

To access this pop-up display: 
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1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

Figure 181. Linear Meter – Rates & Totals Button 

 

3. Select the Rates & Totals button. Linear Meter Rates & Totals pop-up display opens. 
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Figure 182. Linear Meter Rates & Totals 

 

The Linear Rates & Totals pop-up display contains the following tabs: 

Rates & Totals – Use this tab to view read-only flow rates and accumulations for the 
selected linear meter. 

Fault Totals – Use this tab to manually configure which Totals objects in the FB Series 
product database are used to store fault totals and view read-only fault total 
accumulations for the selected linear meter. 

4.10.5.1 Linear Meter Rates & Totals – Rates & Totals Tab 

Use this tab to view read-only flow rates and accumulations for the selected linear meter.  

Note 

This pop-up can remain open while you change values on the other tabs of this display. 

To access this tab: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 
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2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Rates & Totals button. The Linear Meter Rates & Totals pop-up display 
opens showing the Rates & Totals tab. 

Figure 183. Linear Meter Rates & Totals – Rates & Totals Tab 

 

4. Review the values in the following fields: 

Field Description 

Current Flow 
Rates 

These read-only fields show the current flow rates for the selected 
meter. 

Current Totals These read-only fields show the total accumulation, as well as the 
current and previous hourly, daily, weekly, and monthly 
accumulations for the selected meter. 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 
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4.10.5.2 Linear Meter Rates & Totals – Fault Totals Tab 

Use this tab to manually configure which Totals objects in the FB Series product database 
are used to store fault totals and view read-only fault total accumulations for the selected 
linear meter.  

Note 

• This pop-up can remain open while you change values on the other tabs of this 
display. 

• Fault totals are calculated when the system becomes unhealthy and can be used to 
determine how measurement quantities are affected by faults and alarms. To 
configure which faults and alarms cause the system to become unhealthy, refer to the 
Fault Health Configuration field on the Station – Advanced. 

• You can automatically configure which Totals objects for fault totals by using the 
Totals Setup wizard. 

• You must configure additional spare Totals objects in the FB Series product database 
before manually configuring fault totals. For more information, refer to the Number 
of Spare Totals field on the Meter Setup display. 

To access this tab: 

1. Select Configure > Gas > Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Rates & Totals button. The Linear Meter Rates & Totals pop-up display 
opens. 

4. Select the Fault Totals tab. 
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Figure 184. Linear Meter Rates & Totals – Fault Totals Tab 

 

5. Review the values in the following fields: 

Field Description 

Uncorrected 
Volume Total 
(fault) Object 

Click  to open a Point Picker dialog and select a Totals object from 

the FB Series product database to use for uncorrected volume fault 
totals. 

Note 

• Advanced users may select their own totals objects, but you must 
ensure you select a spare total (Total_5000x). 

• If you select a normal total that is already used elsewhere, a total 
increment alarm is raised at the meter and the normal total 
increments when a fault condition occurs. 

• If a fault total is Undefined, the normal total increments when a 
fault condition occurs. 
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Field Description 

Corrected 
Volume Total 
(fault) Object 

Click  to open a Point Picker dialog and select a Totals object from 

the FB Series product database to use for corrected volume fault 
totals. 

Note 

• Advanced users may select their own totals objects, but you must 
ensure you select a spare total (Total_5000x). 

• If you select a normal total that is already used elsewhere, a total 
increment alarm is raised at the meter and the normal total 
increments when a fault condition occurs. 

• If a fault total is Undefined, the normal total increments when a 
fault condition occurs. 

Mass Total 
(fault) Object 

Click  to open a Point Picker dialog and select a Totals object from 

the FB Series product database to use for mass fault totals. 

Note 

• Advanced users may select their own totals objects, but you must 
ensure you select a spare total (Total_5000x). 

• If you select a normal total that is already used elsewhere, a total 
increment alarm is raised at the meter and the normal total 
increments when a fault condition occurs. 

• If a fault total is Undefined, the normal total increments when a 
fault condition occurs. 

Energy Total 
(fault) Object 

Click  to open a Point Picker dialog and select a Totals object from 

the FB Series product database to use for energy fault totals. 

Note 

• Advanced users may select their own totals objects, but you must 
ensure you select a spare total (Total_5000x). 

• If you select a normal total that is already used elsewhere, a total 
increment alarm is raised at the meter and the normal total 
increments when a fault condition occurs. 

• If a fault total is Undefined, the normal total increments when a 
fault condition occurs. 

Current Flow 
Rates 

These read-only fields show the current flow rates for the selected 
meter. 
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Field Description 

Current Totals These read-only fields show the total accumulation, as well as the 
current and previous hourly, daily, weekly, and monthly 
accumulations for the selected meter. 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

 

4.11  Fluid Properties 

Use this display to define the physical properties of the fluid flowing through each meter. 

To access this display, select Configure > Gas > Fluid Properties. 

Figure 185. Configure – Fluid Properties 

 

The Fluid Properties display contains the following items: 

General – Use this display to configure general fluid properties, including relative density, 
base density, and heating value of the fluid being measured. 

Advanced – Use this pop-up display to configure advanced fluid properties, including 
water content, compressibility, and viscosity of the fluid being measured. 

Components – Use this pop-up display to view the currently configured components for 
each meter. 

4.11.1 Fluid Properties – General  

Use this display to configure general fluid properties, including relative density, base 
density, and heating value of the fluid being measured. 

To access this display: 

1. Select Configure > Gas > Fluid Properties from the FBxConnect™ main menu. The 
Fluid Properties display opens. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

473 

2. Click ▼ in the drop-down list and select a Fluid Properties instance to configure. 

Figure 186. Fluid Properties – General 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
instance. 

Components 
Object 

Click  to open a Point Picker dialog and select the components 

instance parameter associated with the selected fluid properties 
instance. 
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Field Description 

Select  to open the Components display and configure the 

operation mode, normalization option, and mole percentage of each 
fluid component flowing through the meter. 

Advanced Click this button to open the Fluid Properties – Advanced pop-up 
display and configure advanced fluid properties, including water 
content, compressibility, and viscosity of the fluid being measured. 

Components 
In Use 

Click this button to open the Fluid Properties – Components In Use 
pop-up display and view read-only in-use values for the currently 
configured components. 

Relative 
Density 

Sets how the system acquires the real relative density (specific 
gravity) value, which is the ratio of the density of the flowing gas to 
the density of the reference gas. Possible options are: 

Measured The system acquires the real relative density value 
from a gas chromatograph input you configure in the 
Relative Density Parameter field. 

Note  

• For the most accurate measurement of flow and 
fluid properties the measured relative density 
parameter must match the Base Temperature 
Selection and Base Pressure Selection fields on 
the Station – General display. 

• You must also define a gas chromatograph input 
in the Relative Density Parameter field. 

• If the compressibility calculation is dependent on 
the relative density, the calculation updates every 
time the input changes. If the input is an analog 
input, the threshold before the calculation updates 
is 0.05%. 

Override The system uses a value you define in the Override 
Relative Density field. 

Calculated The system calculates the relative density value. 

Relative 
Density 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the real relative density value. 
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Field Description 

Override 
Relative 
Density 

Sets a value to use for the relative density in calculations when 
Override is selected in the Relative Density field. 

Note 

If the compressibility calculation is dependent on the relative density, 
the value you enter must match the reference conditions expected 
by the Compressibility / Density Calculation option you select. For 
more information, refer to the Station – General display. 

Calculated 
Relative 
Density 

This read-only field shows the relative density value as calculated by 
the system. 

Selected 
Relative 
Density 

This read-only field shows the current relative density value, based 
on the selected options, used in calculations. 

Base Density Sets how the system acquires the real base density value. Possible 
options are: 

Measured The system uses a parameter you configure in the 
Base Density Parameter field to acquire the real base 
density value. 

Note 

For the most accurate measurement of flow and fluid 
properties the measured base density parameter 
must match the Base Temperature Selection and 
Base Pressure Selection fields on the Station – 
General display. 

Override The system uses a value you define in the Override 
Base Density field. 

Calculated The system calculates the base density value. 

Base Density 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the real base density value. 

Override Base 
Density 

Sets a value to use for the base density in calculations when Override 
is selected in the Base Density field. 

Calculated 
Base Density 

This read-only field shows the base density value as calculated by the 
system. 
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Field Description 

Selected Base 
Density 

This read-only field shows the current base density value, based on 
the selected options, used in calculations. 

Flowing 
Density 

Sets how the system acquires the flowing density value. Possible 
options are: 

Measured The system uses a parameter you configure in the 
Flowing Density Parameter field to acquire the 
flowing density value. 

Override The system uses a value you define in the Override 
Flowing Density field. 

Calculated The system calculates the flowing density value. 

Flowing 
Density 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the flowing density value. 

Override 
Flowing 
Density 

Sets a value to use for the flowing density in calculations when 
Override is selected in the Flowing Density field. 

Calculated 
Flowing 
Density 

This read-only field shows the flowing density value as calculated by 
the system. 

Selected 
Flowing 
Density 

This read-only field shows the current flowing density value, based 
on the selected options, used in calculations. 

Heating Value 
(HV/CV) 

Sets how the system acquires the heating value of the measured fluid 
at base conditions. When the Heating value basis is volume, this 
value represents the real heating value, rather than the ideal heating 
value. When the heating value basis is mass, this value represents the 
mass heating value. Possible options are: 

Measured The system uses a parameter you configure in the 
Heating Value Parameter field to acquire the heating 
value. 

Note  

• The measured heating value parameter must 
match the Heating Value Measurement Basis. 
For the most accurate measurement of flow & fluid 
properties the measured heating value parameter 
should match the Base Temperature Selection, 
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Field Description 

Base Pressure Selection , and Heating Value 
Combustion Temperature fields on the Station – 
General display. 

• If the compressibility calculation is dependent on 
the heating value, the measured heating value 
must be gross / superior volumetric heating value. 
The compressibility calculation updates every time 
the input changes. If the input is an analog input, 
the threshold before the calculation updates is 
0.05%. 

• Negative or invalid heating values are rejected, 
and the calculation uses a heating value of 0. 

Override The system uses the value you define in the Override 
Heating Value field to calculate the energy flow rates, 
regardless of the selected station heating value 
calculation standard. 

Note  

• You must enter a value in the Override Heating 
Value field. 

• If the compressibility calculation is dependent 
upon the heating value, the override must be the 
override gross / superior heating value.  

• The value entered must match the reference 
conditions expected by the compressibility 
calculation you select in the 
Compressibility/Density Calculation field on the 
Station – General display. 

Calculated The system calculates the heating value based on your 
selection in the Heating Value Calc Standard field on 
the Station – General display. 

Heating Value 
Parameter 

Click  to open a Point Picker dialog and select a parameter used to 

acquire the heating value. 

Override 
Heating Value 

Sets the heating value used in calculations when Override is selected 
in the Heating Value (HV/CV) field. 
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Field Description 

Calculated 
Heating Value 

This read-only field shows the heating value as calculated by the 
system. 

Selected 
Heating Value 

This read-only field shows the current heating value, based on the 
selected options, used in energy calculations. If the compressibility 
calculation is dependent on the heating value, the value used by the 
calculation is shown in Compressibility Heating Value field on the 
DP Meter – Diagnostics display or the Linear Meter – Diagnostics 
display. 

Isentropic 
Exponent 

Sets how the system acquires the isentropic exponent. Possible 
options are: 

Measured The system uses a parameter you configure in the 
Isentropic Exponent Parameter field to acquire the 
isentropic exponent. 

Override The system uses a value you define in the Override 
Isentropic Exponent field. 

Calculated The system calculates the isentropic exponent at 
flowing conditions. 

Note 

You must select AGA8 1994 Detailed or ISO 12213-2 
2006 in the Compressibility/Density Calculation field 
on the Station – General display in order for the 
system to calculate the Isentropic Exponent. 

Note 

It is often accepted practice to use the specific heat ratio (Cp/Cv = 
ratio of specific heat at constant pressure to the specific heat at 
constant volume) in place of the isentropic exponent, as in many 
applications they are nearly identical. To enter a specific heat ratio, 
set the isentropic exponent mode to Override and enter the specific 
heat ratio value in the Override Isentropic Exponent field. 

Isentropic 
Exponent 
Parameter 

Click  to open a Point Picker dialog and select a parameter used to 

acquire the isentropic exponent. 
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Field Description 

Override 
Isentropic 
Exponent 

Sets the isentropic exponent used in calculations when Override is 
selected in the Isentropic Exponent field. 

Note 

This field appears only for differential pressure meters. 

Calculated 
Isentropic 
Exponent 

This read-only field shows the isentropic exponent as calculated by 
the system. 

Note 

This field appears only for differential pressure meters. 

Selected 
Isentropic 
Exponent 

This read-only field shows the current isentropic exponent value, 
based on the selected options, used in calculations. 

Note 

This field appears only for differential pressure meters. 

Dynamic 
Vicosity 

Sets how the system acquires the dynamic viscosity. Possible options 
are: 

Measured The system uses a parameter you configure in the 
Dynamic Viscosity Parameter field to acquire the 
dynamic viscosity. 

Override The system uses a value you define in the Override 
Dyanamic Viscosity field. 

Dynamic 
Viscosity 
Parameter 

Click  to open a Point Picker dialog and select a parameter used to 

acquire the dynamic viscosity. 

Override 
Dynamic 
Viscosity 

Sets the dynamic viscosity used in calculations when Override is 
selected in the Dynamic Viscosity field. 

Selected 
Dynamic 
Viscosity 

This read-only field shows the current dynamic viscosity value, based 
on the selected options, used in calculations. 

4. Select Save to save any changes you make to this display. 

4.11.2 Fluid Properties – Advanced 

Use this display to configure advanced fluid properties, including water content, 
compressibility, and viscosity of the fluid being measured. 
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To access this display: 

1. Select Configure > Gas > Fluid Properties from the FBxConnect™ main menu. The 
Fluid Properties display opens showing the General tab. 

2. Click ▼ in the drop-down list and select a fluid properties instance to configure. 

3. Select the Advanced button. The Fluid Properties – Advanced pop-up display opens. 

Figure 187. Fluid Properties – Advanced 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Water Content Sets how the system acquires the water content value used in 
calculations. Possible options are: 
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Field Description 

Measured The system acquires the water content value from the 
parameter you configure in the Water Content 
Parameter field. 

Note 

Measured Water Content is read every calculation 
cycle, but is only used to adjust gas composition if all 
of the following conditions are met. 

• The Water Content Basis field is set to Saturated 
at Base Conditions. 

• The Water Adjustment Option field is set to 
Adjust Composition. 

• The gas composition is updated. 

The gas composition is updated in the following 
circumstances: 

• The Operation Mode field on the Components – 
General display is set to Override, and you select 
the Apply Override Values on the Components – 
Component display.  

• The Operation Mode field on the Components – 
General display is set to Measured, and a new 
valid gas composition is received from a GC. 

• The Operation Mode field on the Components – 
General display is set to Remote Download, and 
the Apply Override Values parameter is set to 
Accept Composition (see protocol manual). 

Override The system uses a value you define in the Override 
Water Content field. 

Calculated Selected water content is calculated from the 
configured method. 

Water Content 
Parameter 

Click  to open a Point Picker dialog and select a parameter used 

to acquire the water content value. 

Override Water 
Content 

Sets a value to use for the water content in calculations when 
Override is selected in the Water Content field. 
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Field Description 

Calculated 
Water Content 

This read-only field shows the current water content value as 
calculated by the system. 

Selected Water 
Content 

This read-only field shows the current water content value used in 
calculations based on the selected options. 

Base 
Compressibility 
(Zb) 

Sets how the system acquires the base compressibility value used in 
calculations. Possible options are: 

Override The system uses a value you define in the Override 
Base Compressibility field. 

Calculated The system calculates the base compressibility value. 

Override Base 
Compressibility 

Sets a value to use for the base compressibility in calculations when 
Override is selected in the Base Compressibility field. 

Calculated 
Base 
Compressibility 

This read-only field shows the current base compressibility value as 
calculated by the system. 

Selected Base 
Compressibility 

This read-only field shows the current base density value used in 
calculations based on the selected options. 

Flowing 
Compressibility 
(Zf) 

Sets how the system acquires the flowing compressibility value used 
in calculations. Possible options are: 

Override The system uses a value you define in the Override 
Flowing Compressibility field. 

Calculated The system calculates the flowing compressibility 
value. 

Override 
Flowing 
Compressibility 

Sets a value to use for the flowing compressibility in calculations 
when Override is selected in the Flowing Compressibility field. 

Calculated 
Flowing 
Compressibility 

This read-only field shows the current flowing compressibility value 
as calculated by the system. 

Selected 
Flowing 
Compressibility 

This read-only field shows the current flowing compressibility value 
used in calculations based on the selected options. 

Standard 
Compressibility 
(Zs) 

Sets how the system acquires the standard compressibility value 
used in calculations. Possible options are: 

Override The system uses a value you define in the Override 
Standard Compressibility field. 
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Field Description 

Calculated The system calculates the standard compressibility 
value. 

Override 
Standard 
Compressibility 

Sets a value to use for the standard compressibility in calculations 
when Override is selected in the Standard Compressibility field. 

Calculated 
Standard 
Compressibility 

This read-only field shows the standard compressibility as 
calculated by the system. 

Selected 
Standard 
Compressibility 

This read-only field shows the current standard compressibility 
value used in calculations based on the selected options. 

Molar Mass This read-only field shows the average molar mass of the fluid. 
Units are based on selected density units for the station (e.g. density 
units selection of lb/ft3 would display molar mass in units of lb/lb-
mol). 

Calculated 
Wobbe Index 

This read-only field shows the Wobbe Index of the fluid as 
calculated by the system. The Wobbe Index is the BTU per cubic foot 
divided by the square root of the specific gravity. 

Calculated 
Speed Of 
Sound 

This read-only field shows the result of the speed of sound 
calculation. The system calculates speed of sound in the fluid in feet 
per second or meter per second based on the Pressure, 
Temperature, and Gas Composition.  

Note 

• You must select AGA8 1994 Detailed, AGA8 2017 Part 1 
Detailed, AGA8 Part 2 2017 / GERG 2008, or ISO 12213-2 2006 in 
the Compressibility/Density Calculation field on the Station – 
General display in order for the system to calculate the speed of 
sound. 

• If you select AGA8 1994 Detailed or ISO 12213-2 2006, then the 
system uses the AGA10 standard to calculate the speed of 
sound. 

• If you select AGA8 2017 Part 1 Detailed or AGA8 2017 Part 2 / 
GERG 2008, then the system uses the selected standard to 
calculate the speed of sound. 
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Field Description 

Super 
Compressibility 
(Fpv) 

This read-only field shows a correction factor used in certain 
compressibility calculations, such as NX-19 1962. For calculations 
without it, the factor is calculated as the square root of the ratio of 
base compressibility to flowing compressibility (per AGA3 1985). 

Joule-Thomson Sets how the system acquires the Joule-Thomson coefficient. 
Possible options are: 

Override The system uses a value you define in the Override 
Joule-Thomson field. 

Calculated The system calculates the Joule-Thomson coefficient 
at flowing conditions. 

Note 

• This field appears only for differential pressure meters if you 
select Isenthalpic (Joule-Thomson) in the Temperature 
Correction field on the DP Meter – Advanced display. 

• If you select AGA 8 Part 1 2017 Detailed or AGA 8 Part 2 2017 / 
GERG 2008 in the Compressibility/Density Calculation field on 
the Station – General display, then the Joule-Thomson coefficient 
is calculated by the selected standard.  

• For all other Compressibility/Density Calculation selections, it 
is calculated by ISO 9464. 

Override Joule-
Thomson 

Sets the Joule-Thomson coefficient used in calculations when 
Override is selected in the Joule-Thomson field. 

Note 

This field appears only for differential pressure meters if you select 
Isenthalpic (Joule-Thomson) in the Temperature Correction field 
on the DP Meter – Advanced display. 

Calculated 
Joule-Thomson 

This read-only field shows the Joule-Thomson coefficient as 
calculated by the system. 

Note 

This field appears only for differential pressure meters if you select 
Isenthalpic (Joule-Thomson) in the Temperature Correction field 
on the DP Meter – Advanced display. 
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Field Description 

Selected Joule-
Thomson 

This read-only field shows the current Joule-Thomson coefficient 
value, based on the selected options, used in calculations. 

Note 

This field appears only for differential pressure meters if you select 
Isenthalpic (Joule-Thomson) in the Temperature Correction field 
on the DP Meter – Advanced display. 

5. Select Save to save any changes you make to this tab. 

4.11.3 Fluid Properties – Components 

Use this display to view read-only in-use values for the currently configured components 
for each meter.  

Note 

• The in-use values are adjusted according to your selections in the Water Content 
Basis and Water Adjustment Option fields on the Station – Advanced display. 

• You configure the components of the fluid being measure on the Components 
display. 

To access this display: 

1. Select Configure > Gas > Fluid Properties from the FBxConnect™ main menu. The 
Fluid Properties display opens showing the General tab. 

2. Click ▼ in the drop-down list and select an instance to view the configured 
components. 

3. Select the Components In Use button. The Fluid Properties – Components pop-up 
display opens. 
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Figure 188. Fluid Properties – Components  

 

4.12  Component 

Use this display to configure how the system calculates fluid composition and the 
different components of the fluid flowing through the meter. 

Figure 189. Configure – Components 
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The Component display contains the following items: 

General – Use this display to configure how the system calculates fluid composition. 

Components – Use this pop-up display to set the mole percent of each fluid component 
present in the meter. 

Component Import Export – Use this button to import a new gas composition from a CSV 
file or export the current gas composition to a CSV file. 

Apply Override Values – Use this button to manually override the in-use gas composition. 

4.12.1 Component – General 

Use this display to configure how the system calculates fluid composition. 

To access this display: 

1. Select Configure > Gas > Components from the FBxConnect™ main menu. The 
Components display opens. 

2. Click ▼ in the drop-down list at the top of the display and select a Components 
instance to configure. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

488 

Figure 190. Component – General  

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected instance. 
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Field Description 

GC Data 
Object 

Click  to open a Point Picker dialog and select a parameter used 

to acquire the gas chromatograph data. 

Components Click this button to open the Component – Components pop-up 
display and set the mole percent of each fluid component present in 
the meter. 

Operation 
Mode 

Sets how the system acquires the component information. Possible 
options are: 

Measured Selected composition is obtained from a gas 
chromatograph and shown in the Live Value fields 
on the Component – Components display. If an 
analysis timeout alarm occurs, the selected 
composition updates according to the fault mode. 
The analysis timeout alarm resets on a system 
restart or on the receipt of a new measured gas 
composition that satisfies the gas chromatograph 
alarm/range checks (see Gas Chromatograph – 
Configuration Tab). 

Override Selected composition is obtained from the Override 
values you enter on the Component – Components 
display, even when a timeout alarm is active. Use of 
the Apply Override Values button, changes to the 
Override values, and changes resulting from 
normalization are logged to the event log. The 
analysis timeout alarm resets on a system restart 
or whenever you select the Apply Override Values 
button. 
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Field Description 

Remote 
Download 

Selected composition is obtained from the Override 
values downloaded from a SCADA host or other 
remote master. Changes to Override values are not 
logged to the event log. If an analysis timeout 
alarm occurs, the selected composition updates 
according to the fault mode. The analysis timeout 
alarm resets on a system restart or whenever you 
select the Apply Override Values button. 

Note 

Whenever the operation mode changes, the 
analysis timeout timer restarts and the current 
selected values are copied to the last good 
composition.  

Fault Mode Sets how the system responds if the Operation Mode field is set to 
Measured or Remote Download and an analysis timeout occurs. A 
measured analysis timeout may be due to a communications failure 
with the gas chromatograph or a failure of the returned data to pass 
the validity test. A remote download timeout occurs if the time since 
the last composition accepted exceeds the timeout limit.  

Note 
This field is read-only if you select Override in the Operation Mode 
field. 

Live / 
Download 

If you select Measured in the Operation Mode 
field, the selected composition continues to obtain 
values from a gas chromatograph. If you select 
Remote Download in the Operation Mode field, 
the selected composition continues to obtain 
values from a SCADA host or other remote master. 

Fault Selected composition is obtained from the user 
entered FAULT values. 
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Field Description 

Last Good Selected composition retains the last value prior to 
the analysis timeout. If the Operation Mode field is 
set to Measured, the last good composition is only 
updated on the receipt of a new measured gas 
composition that satisfies the gas chromatograph 
alarm/range checks (see Gas Chromatograph – 
Configuration Tab). If the Operation Mode field is 
set to Remote Download, the last good 
composition is only updated if the override 
composition can be normalized according to the 
current normalization option. 

Normalization 
Option 

Sets what action is taken if the total of the gas mole percentages 
does not add up to 100%. 

None No action is taken if the total does not equal 100%. 

Full 
Normalization 

The system automatically adjusts each component 
proportionally so that the total adds up to 100%. 

Methane 
Adjust 

The system automatically adjusts the methane 
mole percent up or down so that the total adds up 
to 100%. 

Components 
Alarm 

Analysis 
Timeout 

If enabled, this alarm indicates the selected 
composition has not been updated with a valid set 
of data in the amount of time specified by the user 
in Analysis Timeout Value. 

Normalization 
Failure 

This alarm indicates the composition did not add 
up to 100% and could not be normalized. This will 
only occur if a normalization option of Methane 
Adjust is selected and adjustment of methane does 
not make up the difference required to have the 
total composition add up to 100%. 

Timeout Sets the option to alarm on an analysis timeout. 

Analysis 
Timeout 
Value 

Sets an amount of time (in seconds) to wait for a 
valid update to the selected composition before 
setting the analysis timeout alarm. 
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Field Description 

Last Good 
Analysis Time 

This read-only field shows the date and time of the 
last good analysis. 

Component 
Import Export 

Select this button to import a new gas composition from a CSV file 
or export the current gas composition to a CSV file. For more 
information, refer to Component Import Export. 

Apply Override 
Values 

Select this button to manually override the in-use gas composition. 
For more information, refer to Apply Override Values. 

4. Select Save to save any changes you make to this display. 

4.12.2 Component – Components  

Use this pop-up display to set the mole percent of each fluid component present in the 
meter. This value is required to calculate the compressibility of gas using the AGA 8 
detailed method. 

Note 

You can save values on this display at any time, but the new values are not used in until 
you select the Apply Override Values button. This prevents a partial set of data from 
being processed by the meter. 

To access this pop-up display: 

1. Select Configure > Gas > Components from the FBxConnect™ main menu. The 
Component display opens. 

2. Click ▼ in the drop-down list at the top of the display and select a Components 
instance to configure. 

3. Select the Components button. The Component – Components pop-up display opens. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

493 

Figure 191. Component – Components 

 

4. Review – and change as necessary – the values in the following fields: 
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Field Description 

Selected Value 
% 

This read-only field shows the current gas quality readings before 
any water content or water adjustment option has been applied. 

Note 

Fields in this column turn red if there is a validation alarm associated 
with the selected component. 

Live GC Value 
% 

This read-only field shows gas quality readings from the configured 
gas chromatograph. 

Override % Sets the mole percent of each fluid component (as a percentage) to 
use in calculations when Override is selected in the Operation field 
on the Component – General display. 

Note 

You can save values on this display at any time, but the new values 
are not used in until you select the Apply Override Values button. 
This prevents a partial set of data from being processed by the 
meter.  

Fault Value % Sets the mole percent of each fluid component (as a percentage) to 
use in calculations when Fault is selected in the Fault Mode field on 
the Component – General display and a fault occurs. 

Note 

You can save values on this display at any time, but the new values 
are not used in until you select the Apply Override Values button. 
This prevents a partial set of data from being processed by the 
meter. 

Totals This read-only field shows the total mole percent of all fluid 
components.  

Component 
Import Export 

Select this button to import a new gas composition from a CSV file or 
export the current gas composition to a CSV file. For more 
information, refer to Component Import Export. 

Apply 
Override 
Values 

Select this button to manually override the in-use gas composition. 
For more information, refer to Apply Override Values. 

5. Select Save to save any changes you make to this display. 

Note 

A warning icon shows if the Selected Value field and Override Value field do not match. 
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4.12.3 Component Import Export 

Use this pop-up display to import gas component values from a CSV file or export the 
current gas component values to a CSV file.  

Note 

For more information about creating your own gas component CSV files, refer to Creating 
Gas Component CSV Files.  

To access this pop-up display: 

1. Select Configure > Gas > Components from the FBxConnect™ main menu. The 
Component display opens. 

2. Select the Components button. The Component – Components pop-up display opens. 
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Figure 192. Component Import Export 

 

3. Select the Component Import Export button. The Gas Component Import Export 
pop-up display opens. 
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Figure 193. Gas Component Import Export 

 

4. Use the buttons on this display to perform the following actions: 

Field Description 

Import CSV Click to import a CSV file into your FB Series product that contains 
your gas component values. Navigate to the location on your 
computer that contains the CSV files and select OK to start the 
import process. For more information, refer to Importing Gas 
Component CSV Files. 

Note 

The system verifies the integrity of the CSV and asks for confirmation 
before continuing if any errors are found. 

Export CSV Click to save CSV files to your computer that contain the current gas 
component values used by your FB Series product. A Select Table 
dialog opens that allows you to select which Components instances 
to include in the export. Click Start, navigate to a folder on your 
computer where the CSV files will be saved, and click Save to begin 
the export process. For more information, refer to Exporting Gas 
Component CSV Files.  

Open Log Click to open the ImportExportLogs folder on your computer that 
contains FBxConnect™ import/export error logs. Any errors 
encountered when importing a CSV file are stored in a log in this 
folder. 

Note 

Log file name includes the date and time the log was created. 

5. Select Close to exit the pop-up display. 
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4.12.3.1 Importing a Gas Composition CSV File 

You can import CSV files that contain your gas component values. You can include gas 
component values for all Components instances in a single CSV file or separate CSV files 
for each instance. 

Note 

• For more information about creating your own gas component CSV files, refer to 
Creating Gas Component CSV Files. 

• For more information about exporting CSV files that contains the FB Series product's 
current gas component values, refer to Exporting Gas Component CSV Files. 

• If you want to remove previously imported gas component values, perform a Cold 
Start and select Database is re-initialized with factory defaults. 

To import gas component CSV files: 

1. Select Configure > Gas > Components from the FBxConnect™ main menu. The 
Components display opens. 

2. Select the Components button. The Component – Components pop-up display opens. 

3. Select the Component Import Export button. The Gas Component Import Export 
pop-up display opens. 

Figure 194. Gas Component Import Export 

 

4. Select the Import CSV button. The Open csv File window opens. 
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Figure 195. Open csv File 

 

5. Navigate to location of your gas composition CSV file, highlight the file, and select 
Open.  

Note 

The system verifies the integrity of the CSV file and asks for confirmation before 
continuing if any errors are found. If you select Import removing invalid parameters, 
any invalid lines in the CSV file are ignored and data currently in the FB Series device is 
maintained. 

Figure 196. Example Import Gas Composition Errors 
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6. A confirmation message displays after importing the CSV file. Select OK to complete 
the process. 

Figure 197. Import Successful 

 

Note 

You must click the Apply Override Values button after importing a gas component CSV 
file before any changes take effect. 

4.12.3.2 Exporting a Gas Composition CSV File 

You can export CSV files to your computer that contain the current gas component values 
used by your FB Series product. You can then modify the files on your computer or import 
them into another device. You can export gas component values to one CSV file that 
contains information for all Components instances or export separate CSV files for each 
instance. 

Note 

• For more information about creating your own gas component CSV files, refer to 
Creating Gas Component CSV Files. 

• For more information about importing CSV files that contains gas component values, 
refer to Importing Gas Component CSV Files. 

To export gas component CSV files: 

1. Select Configure > Gas > Components (FB3000 RTU) from the FBxConnect™ main 
menu. The Components display opens. 

2. Select the Components button. The Component – Components pop-up display opens. 

3. Select the Composition Import Export button. The Gas Component Import Export 
pop-up display opens. 
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Figure 198. Gas Component Import Export 

 

4. Select the Export CSV button. The Select Table pop-up display opens. 

Figure 199. Select Table 

 

5. Place a check mark next to each Components instance you want to export. 
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Note 

By default, the FB Series device exports all Components instances to a single CSV file. 
Place a check mark next to Export to individual file to export separate CSV files for each 
selected Components instance. 

6. Select Start. A Save csv file windows opens. 

Figure 200. Save csv file 

 

7. Navigate to the folder where the Gas Component CSV files will be saved and select 
Save to begin the export process. 

8. When the process completes, a confirmation dialog opens. Select OK. 

Figure 201. Confirmation 
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4.12.3.3 Creating a Gas Composition CSV File 

You can create CSV files that contain your gas component values on your computer and 
then import the CSV files for use in the FB Series product. If your gas components 
configuration contains a large number of instances, it may be easier to create CSV files on 
your computer than it is to configure each Components instance individually in 
FBxConnect™. You can create either one CSV file that contains information about all 
Components instances or separate CSV files for each instance. 

Note 

• The system automatically corrects for incorrect capitalization in the created gas 
components CSV files. This means you can enter methane (ch4) and the system 
automatically corrects the entry to Methane (CH4). 

• The easiest way to begin creating a custom map is to export gas component CSV files 
that contain the current values and then edit that file. For more information about 
exporting a Gas Component CSV files, refer to Exporting Gas Component CSV Files. 
 
Figure 202. Example Gas Component CSV Format 

 

To create CSV files that contain gas component values: 

1. Open a blank spreadsheet (or open a previously exported gas component CSV file). 

2. Review – and change as necessary – the values for each CSV file according to the 
tables below: 
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Field Description 

Instance Enter the Components instance number in the rows below this 
column. Possible Values are 1 through 36. 

Note 
You can include multiple instances in a single CSV file or create 
separate CSV files for each instance. 

Component Enter the name for each component to include in your gas 
composition. You are not required to enter every possible 
component, but the names must match the list below. Possible 
options are: 

• Methane (CH4) 

• Nitrogen (N2) 

• Carbon Dioxide (CO2) 

• Ethane (C2H6) 

• Propane (C3H8) 

• Hydrogen Sulfide (H2S) 

• Hydrogen (H2) 

• Carbon Monoxide (CO) 

• Oxygen (O2) 

• i-Butane (C4H10) 

• n-Butane (C4H10) 

• i-Pentane (C5H12) 

• n-Pentane (C5H12) 

• n-Hexane (C6H14) 

• n-Heptane (C7H16) 

• n-Octane (C8H18) 

• n-Nonane (C9H20) 

• n-Decane (C10H22) 

• Helium (He) 

• Argon (Ar) 

• Neopentane (C5H12) 

• Benzene (C6H6) 

• Toluene (C7H8) 
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Field Description 

Override Enter the mole percent of each fluid component (as a percentage) to 
use in calculations when Override is selected in the Operation field 
on the Components – General tab. 

Fault Enter the mole percent of each fluid component (as a percentage) to 
use in calculations when Fault is selected in the Fault Mode field on 
the Components – General tab and a fault occurs. 

3. Save your changes. You can now import your gas component CSV files for use in your 
FB Series product. For more information, refer to Importing Gas Component CSV Files. 

Note 

Make sure to save the file with a .csv file extension. 

4.12.4 Apply Override Values 

Use this display to manually set mole percentages of each fluid component. 

To manually apply composition values: 

1. Select Configure > Gas > Components from the FBxConnect™ main menu. The 
Components display opens showing the General tab. 

2. Click ▼ in the drop-down list at the top of the display and select the Components 
instance you wish to configure. 

3. Select the Components button. The Component – Components pop-up display opens. 
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Figure 203. Apply Override Values 

 

4. Enter the mole percent of each fluid component. 

5. Once you have reviewed the override composition set and verified that the 
composition adds up to 100%, select Apply Override Values to put the new Override 
composition into use. A confirmation dialog opens:  
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Note 

When remotely updating components via Modbus, you need to map the Apply 
Override Values button to a map table register and write a value of 1 to that register 
before the changes take effect.  

Figure 204. Apply Composition Set 

 

6. Select one of the following three options on the confirmation dialog: 

• Select Yes to apply the composition changes to all Components instances.  

• Select No to apply the composition changes to the currently selected Components 
instance only. 

• Select Cancel to close the dialog without applying composition changes to any 
Components instance. 

4.13  Liquid Linear Meter 

Use this display to configure liquid linear meters in the FB3000. 

Note 

• You must configure at least one Liquid Linear Meter on the Meter Setup display 
before you can access this display. 

• The system uses different calculations based on three possible configurations. Refer 
to Liquid Linear Meter Calculations for a list of flow calculations used with different 
configurations. 

To access this display, select Configure > Liquid > Liquid Linear Meter. 
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Figure 205. Configure – Liquid Linear Meter 

 

The Liquid Linear Meter display contains the following items: 

Note 

The available pop-up displays vary based on your selection in the Crude Oil Options field 
on the Station – General display. 

General – Use this display to define basic parameters for liquid linear meters. The General 
tab opens when you first access the Liquid Linear Configuration display. 

Advanced – Use this pop-up display to configure advanced properties for liquid linear 
meters, including meter factor and K-factor. 

Volume Correction – Use this pop-up display to configure temperature and pressure 
volume correction options for the selected liquid linear meter. 

Water – Use this pop-up display to configure correction options for sediment in water 
present in the selected liquid linear meter.  

Additional Factors – Use this pop-up display to configure additional properties for the 
fluid flowing through the meter, including NGL, shrinkage, and flash gas factors. 

Diagnostics – Use this pop-up display to view read-only diagnostic information for liquid 
linear meters, including calculated values and alarm codes. 

Rates and Totals – Use this pop-up display to view read-only flow rates and 
accumulations for liquid linear meters. 

4.13.1 Liquid Linear Meter Flow Calculations 

Error! Bookmark not defined.You can configure liquid linear meters a number of 
different ways based on your specific application. The system uses different flow 
calculations based on three possible configurations: 
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Use-Case Description 

Crude Oil 
Custody 
Transfer 

For custody transfer applications: 

Select Crude Oil in the Liquid Product Type field on the Liquid 
Product display and select API Ch. 12.2 in the Crude Oil Options 
field on the Station – General display. 

Calculations 

• IQ = Pulses / K-Factor 

• GV (Turbine Meter) = IQ * MF 

• GV (Coriolis Meter) = IQ * MF / Meter Density 

• GSV = GV * CTL * CPL 

• NSV = GSV * (1 – SW / 100) 

• S&W = GSV * SW / 100 

• Mass (Turbine Meter) = GV * Meter Density 

• Mass (Coriolis Meter) = IQ * MF 

Crude Oil 
Allocation –  
Low Water 

For Crude Oil Allocation – Low Water applications: 

Select Crude Oil in the Liquid Product Type field on the Liquid 
Product display, and select both API Ch. 20.1 and Use Oil 
Correction for Water in the Crude Oil Options fields on the Station 
– General display. 

Calculations 

• IQ = Pulses / K-Factor 

• GV (Turbine Meter) = IQ * MF 

• GV (Coriolis Meter) = IQ * MF / Meter Density 

When SF applied to gross standard volume: 

• GSV = GV * SF * CTL * CPL 

• NSV = GSV * (1 – SW / 100) 

When SF applied to net standard volume: 

• GSV = GV * CTL * CPL 

• NSV = GSV * (1 – SW/100) * SF 

• S&W = GSV * SW / 100 
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Use-Case Description 

• Mass (Turbine Meter) = GV * Meter Density 

• Mass (Coriolis Meter) = IQ * MF  

Crude Oil 
Allocation – 
High Water 

For Crude Oil Allocation – High Water applications: 

Select Crude Oil in the Liquid Product Type field on the Liquid 
Product display, and select both API Ch. 20.1 and Use Separate 
Correction Factor for Water in the Crude Oil Options field on the 
Station – General display.  

Calculations 

• IQ = Pulses / K-Factor 

• GV (Turbine Meter) = IQ * MF 

• GV (Coriolis Meter) = IQ * MF / Meter Density 

• GVOil = GV * (1 – Xw) 

• GSVOil = GVOil * SF 

• GVWater = GV * Xw 

• GSVWater = GVWater * CTL 

• FGN = GSVOil * FGF 

• NGL = GSVOil * NGLF 

Refined 
Products / 
Lubricating Oil  

For Refined Products/Lubricating Oil applications: 

Select Refined Products / Lubricating Oil in the Liquid Product 
Type field on the Liquid Product display. 

Calculations 

• IQ = Pulses / K-Factor 

• GV (Turbine Meter) = IQ * MF 

• GV (Coriolis Meter) = IQ * MF / Meter Density 

• GSV = GV * CTL * CPL 

• Mass (Turbine Meter) = GV * Meter Density 

• Mass (Coriolis Meter) = IQ * MF 
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Use-Case Description 

Light 
Hydrocarbon 

For Light Hydrocarbon applications: 

Select Light Hydrocarbon in the Liquid Product Type field on 
the Liquid Product display. 

Calculations 

• IQ = Pulses / K-Factor 

• GV (Turbine Meter) = IQ * MF 

• GV (Coriolis Meter) = IQ * MF / Meter Density 

• GSV = GV * CTL * CPL 

• Mass (Turbine Meter) = GV * Meter Density 

• Mass (Coriolis Meter) = IQ * MF 

Additional 
Fluid 

For applications of other fluids with a measured Flowing Density 
and known Base Density: 

Select Additional Fluid in the Liquid Product Type field on the 
Liquid Product display. 

Calculations 

• IQ = Pulses / K-Factor 

• GV (Turbine Meter) = IQ * MF 

• GV (Coriolis Meter) = IQ * MF / Meter Density 

• CTPL = Meter Density / Base Density 

• GSV = GV * CTPL 

• Mass (Turbine Meter) = GV * Meter Density 

• Mass (Coriolis Meter) = IQ * MF 

Where: 

CTL = Correction for the effect of temperature on the liquid 

CPL = Correction for the effect of pressure on the liquid 

FGF = Flash Gas Factor 

FGN = Flash Gas Volume 

GV = Gross Volume 

GSV = Gross Std Volume 

IQ = Indicated Quantity 
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MF = Meter Factor 

NGL = Natural Gas Liquids Volume 

NGLF = Natural Gas Liquids Factor  

NSV = Net Standard Volume 

SF = Shrinkage Factor 

SW = Sediment and Water Percent 

S&W = Sediment and Water Volume 

Xw = Water Cut 

4.13.2 Liquid Linear Meter – General 

Use this tab to define basic parameters for liquid linear meters. 

To access this display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 
The Liquid Linear Meter display opens. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 
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Figure 206. Liquid Linear Meter– General  

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected meter. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected meter. 

Serial Number Enter a description (up to 20-alphanumeric characters) for the serial 
number or other identifier of the selected meter. 

Status This read-only field indicates the overall health of the selected 
meter. Possible values are: 

Normal Indicates the meter is not in an alarm, failure, or 
override condition. 

In alarm Indicates an active flow rate, I/O, property calculation, 
or flow calculation alarm. 
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Field Description 

Failure Indicates a point fail on a meter input that is used in 
flow calculations or a severe calculation error that 
prevented calculations from continuing. 

Override Indicates a meter input that is used in flow 
calculations in override mode that is not typically in 
override. 

Note 

The status is based on the health of the uncorrected volume, 
corrected volume, and mass of the meter. You can configure which 
parameters determine the health of the meter in the Fault Health 
Configuration field on the Station – Advanced display. 

The associated parameter (OBJ_STATUS) is a 32-bit binary value, 
where individual bits have different meaning. We currently use 3 
bits. Starting from LSB (Least Significant Bit), Bit 1 represents “In 
Alarm,” Bit 2 represents “Failure,” and Bit 3 represents “Override.” 
When viewing this parameter via a host system, the value is 
represented as a decimal number. For example, a value of 0 means 
no bits are set and the meter status is Normal. A value of 1 means 
the meter status is In Alarm. A value of 2 means the meter status is 
Failure. A value of 4 means the meter status is Override. A value of 
7 means Bits 1, 2, and 3 are all set, and the meter status is In Alarm, 
Failure, and Override. 

Operation 
Status 

This read-only field shows the current state of the batch. Possible 
values are Batch Idle or Batch Active. 

Note 

• This field applies only for Stations with a Fluid Type of Liquid. 

• For more information about starting or stopping a batch, refer 
to the Station – Batching display.  
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Field Description 

Station 
Assignment 

Click  to open a Point Picker dialog and select the station to 

which this meter belongs. 

Note 

• After selecting a Station, click  to open the Station 

configuration display. 

• Stations measuring different fluid types are hidden in the Point 
Picker. 

• Gas meters and liquid meters cannot belong to the same 
station. If you assign a gas meter to a liquid station or a liquid 
meter to a gas station, a Flow Calculation alarm is raised. 

Fluid Properties 
Reference 

This read-only field shows the fluid properties instance currently 
assigned to the selected meter. 

Note 

Click  to open the Fluid Properties configuration display. 

Flow Alarm 
Object 

This read-only field shows the alarm instance currently assigned to 
the selected meter. 

Transactional 
History Group 

Click  to open a Point Picker dialog and select the transaction 

history group to use for the selected instance. 

Note 

You must enable Transaction History on the History – Advanced 
Setup display before you can select a Transaction History group. 
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Field Description 

Calculation 
Library 

These read-only fields show the flow and property calculation 
methodologies used to calculate the liquid flow rates and quantities 
for the selected meter. The flow calculation is shown in the left-
hand field, and the property calculation is shown in the right-hand 
field. 

Note 

• For crude oil, the flow calculation shown is determined at the 
station level by your selection in the Crude Oil Options fields 
on the Station – General display. For all other liquid products, 
the flow calculation will use API Ch. 12.2 Custody Transfer 
Meter flow calculations. 

• For crude oil, the property calculation shown is determined at 
the station level by your selection in the Crude Oil Options field 
on the Station – General display. For all other liquid products, 
the property calculation shown is determined by the liquid 
product type selection on the Liquid Product display. 

API Ch. 12.2 
Custody 
Transfer 
Meter 

This meter uses API Ch. 12.2 for liquid 
measurement. This standard is typically used for 
custody transfer but can also be utilized for crude 
oil allocation applications. For crude oil, the 
standard assumes a low amount of water in the 
measured fluid and treats the water stream as an 
oil for volume correction purposes. The same 
calculation is used for refined products and 
lubricating oils with % water set to 0. 

The meter calculates flow rates and 
accumulations representing indicated quantity, 
gross volume, gross standard volume, net 
standard volume, water volume, and mass. CTPL 
is calculated as the product of the rounded CTL 
and CPL, which is in turn rounded as per 
correction factors in API Ch 12.2 Table 6.  

Note 

CTL, CPL, CCF, and Meter Factor (MF) are rounded 
as per API Ch. 12.2 Table 6. The associated Station 
provides flow rates and accumulations 
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Field Description 

representing gross volume, net standard volume, 
water volume, and mass. 

API Ch. 20.1 
Procedure A 
(Oil 
Correction 
Factor Used 
for Water) 

This meter uses API Ch. 20.1 Procedure A for oil 
measurement. The standard assumes a low 
amount of water in the measured fluid and treats 
the water stream as an oil for volume correction 
purposes. API Ch. 20.1 (2016) suggests using this 
method when the sediment and water is generally 
less than 5.0 percent. 

The meter calculates the same quantities as the 
API Ch. 12.2 Custody Transfer Meter, but a 
shrinkage factor is applied to the gross standard 
volume. If the shrinkage factor includes a 
correction for temperature, the CTL should be set 
to override mode with a value of 1.0, otherwise it 
should be set to calculated mode. If pressure 
correction is included in the SF or pressure 
correction is not required, CPL should be set to 
override mode at 1.0, otherwise CPL should be set 
to calculated mode. CTPL is calculated as the 
product of the rounded CTL and CPL, which is in 
turn rounded as per correction factors in API Ch 
12.2 Table 6. The water fraction is calculated using 
the in-use CSW. 

Note 

CTL, CPL, CCF, and Meter Factor (MF) are rounded 
as per API Ch. 12.2 Table 6. Station quantity 
calculations are not supported for allocation 
meters. 

API Ch. 20.1 
Procedure C 
(Separate 
Correction 
Factor Used 
for Water) 

This meter uses API Ch. 20.1 Procedure C for oil 
measurement. The oil and water have separate 
volume correction factors and are split before 
volume correction is applied. API Ch. 20.1 (2016) 
suggests using this method when the sediment 
and water is generally greater than 5.0 percent. 
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Field Description 

The meter calculates flow rates and 
accumulations representing indicated quantity, 
gross volume, oil unshrunk volume, net standard 
volume, water metered volume and water net 
volume. Additionally, a flash gas net volume and 
an NGL net volume may be calculated by entering 
an override flash gas factor and NGL factor.  

The correction factor for the oil is entered via an 
override or external shrinkage factor (SF). The 
Shrinkage Factor is assumed to include any 
correction for shrinkage, temperature, and 
pressure. CTL, CPL, CTPL, CCF and CSW are 
assumed to be 1.0. The correction factor for water 
is calculated according to API Ch. 20.1 A.1 (2016).  

Note 

The flow calculation uses unrounded correction 
factors. Station quantity calculations are not 
supported for allocation meters. 

API 11.1 2007 This meter uses the 2007 version of the API / 
ASTM / IP Volume Correction tables. 

GPA 8217 / 
API 11.24 

This meter uses GPA 8217 / API 11.2.4 Volume 
Correction Tables (formerly GPA TP-27). 

This method uses the following set of standards: 

• Temperature Correction – GPA 8217 / API 
11.2.4 Standard (2019) (formerly GPA TP-27) 

• Pressure Correction – API 11.2.2 (1986) and 
API 11.1 (2007)  

• Equilibrium Pressure – GPA 8117 / API 
11.2.5 (2017) (formerly GPA TP-15) 
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Field Description 

Allocation 
Measurement 

This meter is configured for allocation 
measurement. For flow calculations, refer to the 
API Ch. 20.1 Procedure A (Oil Correction Factor 
Used for Water) description. For property 
calculations, refer to API Ch. 20.1 Procedure C 
(Separate Correction Factor Used for Water) 
description. 

Additional 
Fluid 

This meter uses a ratio of the measured density to 
the base density to calculate volume correction.  

Note  

For more information, refer to the Liquid Product 
Type field on the Liquid Product display. 

Advanced Click this button to open the Liquid Linear Meter – Advanced pop-
up display and configure advanced properties for the selected 
liquid linear meter, including meter factor and K-factor. 

Volume 
Correction 

Click this button to open the Liquid Linear Meter – Volume 
Correction pop-up display and configure temperature and pressure 
volume correction options for the selected liquid linear meter. 

Water Click this button to open the Liquid Linear Meter – Water pop-up 
display and configure correction options for sediment in water 
present in the selected liquid linear meter.  

Additional 
Factors 

Click this button to open the Liquid Linear Meter – Additional 
Factors pop-up display and configure additional properties for the 
fluid flowing through the meter, including NGL, shrinkage, and 
flash gas factors. 

Diagnostics Click this button to open the Liquid Linear Meter – Diagnostics pop-
up display and view read-only diagnostic information for the 
selected liquid linear meter, including calculated factors, calculated 
values, and alarm codes. 

Rates & Totals Click this button to open the Liquid Linear Meter – Rates & Totals 
pop-up display and view read-only flow rates and accumulations for 
the selected liquid linear meter. 

Meter Type Click ▼ to specify the type of liquid linear meter you are 
configuring. Possible options are: 
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Turbine Select if measuring flow through a turbine meter 
or other linear meter with a frequency or analog 
signal representing actual volumetric flow rate. 

Coriolis Select if measuring flow through a Coriolis meter 
or other linear meter with a frequency or analog 
signal representing a mass or volume flow rate. 

Note 
If you select Coriolis, a new field appears directly 
below. Click ▼ to specify if you are measuring 
mass or volume flow rate. 

Ultrasonic Select if measuring flow through an ultrasonic 
meter. This meter type option performs the same 
flow calculations as the Turbine option, and this 
option is provided for equipment identification. 
CFX files generated by FBxConnect™ include this 
option in the configuration section of the CFX file.  

Positive 
Displacement 

Select if measuring flow through a positive 
displacement meter. This meter type option 
performs the same flow calculations as the 
Turbine option, and this option is provided for 
equipment identification. CFX files generated by 
FBxConnect™ include this option in the 
configuration section of the CFX file. 

Flow Input 
Option 

Sets how instantaneous flow rates and totals are calculated by the 
system. Possible options are: 

Flow Input 
Only 

Instantaneous flow rates and totals are 
determined by the selected Flow Rate Parameter. 
If the selected Flow Rate Parameter is associated 
with a pulse input object, the instantaneous flow 
rates are calculated from the frequency and the 
totals are calculated from the pulse accumulation. 
If the selected Flow Rate Parameter is associated 
with any other object type, the instantaneous flow 
rates are calculated from the selected parameter 
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Field Description 

and the totals are calculated by integrating the 
instantaneous rates.  

Note 

An External Accumulator Parameter is not 
required. 

External 
Accumulator 
Only 

Instantaneous flow rates and totals are 
determined by the selected External Accumulator 
Parameter. The instantaneous flow rates are 
calculated from the increment in the external 
accumulator value over time and the totals are 
calculated by summing the increments.  

Note 

A Flow Rate Parameter is not required. 

External 
Accumulator 
with Flow 
Rate 

Instantaneous flow rates are calculated from the 
selected Flow Rate Parameter and totals are 
calculated from the selected External Accumulator 
Parameter.  

Note 

Both the Flow Rate Parameter and External 
Accumulator Parameter must be defined.  

No Flow Option Sets how the system calculates a "no flow" condition for the meter, 
and sets the calculated flow equal to zero. Possible options are: 

Time 
Between 
Pulses / 
Increments 

If the amount of time between pulses is greater 
than or equal to the time you enter in the text 
field, then system sets the calculated flow equal to 
zero. 

Note 

• This option is available only if you select a 
pulse input object in the Indicated Flow 
field.  

• You must enter a time (in seconds) for the 
system to use in the text field. 

• The label of this option changes based on 
your selection in the Flow Input Option field. 
If you select Flow Input Only, then the label 
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shows Time Between Pulses. If you select 
External Accumulator or External 
Accumulator with Flow Rate, then the label 
shows Time Between Increments. 

Flow Cut-off If the value of the uncorrected volume or mass 
input is less than or equal to the value you enter 
in the text field, then the system sets the 
calculated flow rates equal to zero. Enter a value 
(in units based on the table below) for the system 
to use in the text field.  

Indicated 
Flow  
Input Type 

Meter 
Type Unit Type 

Pulse Input 
Turbine Hz 

Coriolis Hz 

AI or User 
Data 

Turbine  
Volume 
Rate 

Coriolis Mass Rate 

Note 

• You must enter a value (in the indicated 
units) in the text field for the system to use. 

• The lowest frequency the system can 
accurately measure is 1 divided by the PI 
Scan Period (configured on the Pulse Input 
display). Flow control may be erratic below 
this threshold. 

Flow Cut-off 
with 
accumulation 

If the value of the uncorrected volume or mass 
input is less than or equal to the value you enter 
in the text field, then the system sets the 
calculated flow rates equal to zero, but any 
accumulations are still counted.  

Note  

• You must enter a value (in the indicated 
units) in the text field for the system to use. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

523 

Field Description 

• For details on the unit types used by different 
indicated flow input and meter types, refer to 
the table in the Flow Cut-off field description. 

No Flow Status This read-only field shows the current flowing status of the 
selected meter. 

Flow Rate 
Parameter 

I/O Definition Click  to open a Point Picker dialog and select a 

flow rate input to use for the selected meter. This 
field represents the Pulse Frequency for a Turbine 
or Coriolis meter type.  

• PI object – RATE or SELECTED FREQUENCY 
Note 
A Pulse Input (PI) is not a valid selection for 
the Flow Rate Parameter if you select 
External Accumulator with Flow Rate in the 
Flow Input Option field. 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use 
the correct measurement type before it is 
visible in the Point Picker. For more 
information, refer to AI. 

• FBxNData object – SELECTED DOUBLE. For 
more information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data – Any parameter. For more 
information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Selected 
Value 

This read-only field shows the value currently 
used in calculations based on the selected 
options. 

Units This read-only field shows the engineering units 
used for the selected input. 
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Static Pressure I/O Definition Click  to open a Point Picker dialog and select 

the static pressure input to use for the selected 
meter. 

If you select a Press object, the firmware 
determines the pressure input type (absolute or 
gauge) directly from the sensor. 

If you select an AI object, the firmware 
determines the pressure input type from the 
configurable Units Type selection that is 
associated with the selected analog input.  

If you select a User Data object, you must 
indicate the pressure input type in the Pressure 
Transmitter Type field. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 

• Press object – SELECTED VALUE 

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use 
the correct measurement type before it is 
visible in the Point Picker. For more 
information, refer to AI. 

• FBxNData object – SELECTED DOUBLE. For 
more information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data – DOUBLE FLOATING POINT 2. For 
more information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 
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Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the 
system uses the value you set in the override 
field). 

Note 

This option is not available if you select a User 
Data object. 

Override 
Value 

Sets the value to use in calculations when the 
Mode field is set to Override. 

Note 

This value is not available if you select a User 
Data object. 

Selected 
Value 

This read-only field shows the value currently 
used in calculations based on the selected 
options. 

Units This read-only field shows the engineering units 
used for the selected input. 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms 
display for the User Data value. 

Flowing 
Temperature 

I/O Definition Click  to open a Point Picker dialog and select 

the flowing temperature input to use for the 
selected meter. 

Note 

Only an object is chosen, and the parameter is 
determined by the system based on the type of 
object. 

• RTD object – SELECTED VALUE 
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• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use 
the correct measurement type before it is 
visible in the Point Picker. For more 
information, refer to AI. 

• FBxNData object – SELECTED DOUBLE. For 
more information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data – DOUBLE FLOATING POINT 3. For 
more information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the 
system uses the value you set in the override 
field). 

Note 

This option is not available if you select a User 
Data object. 

Override 
Value 

Sets the value to use in calculations when the 
Mode field is set to Override. 

Note 

This value is not available if you select a User 
Data object. 

Selected 
Value 

This read-only field shows the value currently 
used in calculations based on the selected 
options. 

Units This read-only field shows the engineering units 
used for the selected input. 
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Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms 
display for the User Data value. 

Meter Density 
Parameter 

I/O Definition Click  to open a Point Picker dialog and select 

the meter density input to use for the selected 
meter.  

• AI object – SELECTED VALUE 
Note 
You must first configure an AI instance to use 
the correct measurement type before it is 
visible in the Point Picker. For more 
information, refer to AI. 

• FBxNData object – SELECTED DOUBLE. For 
more information, refer to FBxNet. 

• HART object – PV SELECTED VALUE 

• User Data – Any parameter. For more 
information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode Click ▼ to set how the system acquires this value. 
Possible options are Live (the system uses the 
current value of the input) or Override (the 
system uses the value you set in the override 
field). 

Override 
Value 

Sets the value to use in calculations when the 
Mode field is set to Override. 

Selected 
Value 

This read-only field shows the value currently 
used in calculations based on the selected 
options. 
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Units This read-only field shows the engineering units 
used for the selected input. 

Alarms Click to open the Alarms display and configure the 
alarm currently assigned to the input. 

Note 

This selection is not available if you select a User 
Data object; however, you can configure an alarm 
object separately on the Configure – Alarms 
display for the User Data value. 

Note 
This field appears only in certain configuration scenarios: 

• If the selected meter is assigned to a Station where the Liquid 
Product Reference is configured with a Liquid Product Type set 
to Crude Oil (configured on the Liquid Product display), the 
Density Option is set to Meter Observed Density, and the 
Crude Oil Option is set to API Ch. 12.2 or API Ch. 20.1 with Use 
Oil Correction Factor for Water. 

• If the selected meter is assigned to a Station where the Liquid 
Product Reference is configured with a Liquid Product Type set 
to Crude Oil (configured on the Liquid Product display), the 
Crude Oil Options is set to API Ch. 20.1 and Use Separate 
Correction Factor for Water, and the Meter Type is set to 
Coriolis. 

• If the selected meter is assigned to a Station where the Liquid 
Product Reference is configured with a Liquid Product Type set 
to anything other than Crude Oil (configured on the Liquid 
Product display) and the Density Option is set to Meter 
Observed Density. 
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External 
Accumulator 
Parameter 

I/O Definition Click  to open a Point Picker dialog and select a 

flow accumulator input to use for the selected 
meter. This field represents the accumulated 
volume for a turbine meter type or accumulated 
mass for a Coriolis meter type.  

• FBxNData object – Any parameter. For more 
information, refer to FBxNet. 
Note 
The value is assumed to be in the same units 
selected for the associated station. 

• User Data – Any parameter. For more 
information, refer to User Data.  
Note 
The value is assumed to be in the same units 
selected for the associated station. 

Mode This selection is not available. 

Override 
Value 

This selection is not available. 

Selected 
Value 

This read-only field shows the current value of 
the external accumulator being read from the 
selected parameter. 

Units This read-only field shows the shows the 
accumulator engineering units. 

Alarms This selection is not available; however, you can 
configure an alarm object separately on the 
Configure – Alarms display for the selected 
parameter. 

Note 

This field appears only if you select either External Accumulator 
Only or External Accumulator with Flow Rate in the Flow Input 
Option frame. 
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Pressure 
Transmitter 
Type 

Indicates the type of static pressure transmitter (absolute or gauge) 
configured for the selected meter. 

Note 

This field appears only if you select an FBxNData, HART, or User 
Data instance in the Static Pressure Object I/O Definition field. 

Corrected 
Volume Rate 
Alarm 

Sets the rate alarm limits for the corrected flow rate, and shows the 
status of each alarm. Possible statuses are: 

• Normal – The alarm is enabled and is not in an alarm condition. 

• Disabled – The alarm has been disabled. 

• In Alarm – The alarm is enabled and is in an alarm condition. 

External 
Accumulator 

Indicates the rollover value and maximum flow rate for the 
accumulator. 

External 
Accumulator 
Rollover 

Value at which the external accumulator will reset 
to 0. Set the value to 0 if the external accumulator 
does not rollover or the rollover value is unknown. 

Maximum 
Indicated 
Quantity 
Flow Rate 

Maximum rate the physical meter run was 
designed to measure. This is used as an integrity 
check against the accumulator increment. Set the 
value to 0 if this integrity check is not required. 

4. Select Save to save your changes if you modify any of the fields on this display. 

4.13.3 Liquid Linear Meter – Advanced 

Use this pop-up display to configure advanced properties for the selected liquid linear 
meter, including meter factor and K-factor. 

To access this pop-up display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

3. Select the Advanced button. The Liquid Linear Meter – Advanced pop-up display 
opens. 
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Figure 207. Liquid Linear Meter – Advanced 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Meter Factor / 
K-factor Curve 
Option 

Sets how system uses calculates K-factors or Meter Factors in the 
flow calculation. Possible options are: 

Single 
Meter 
Factor / 
Single K-
factor 

Uses a single Meter Factor and a single K-factor for 
the meter. This is the simplest choice and means that 
a value for the meter factor and a value for the K-
factor are fixed for all flow rates and the values are 
taken from the last prove or an entered value. Select 
this option when using either the K-factor or meter 
factor proving, as long as neither the K-factor or 
meter factor will vary with flow rate or product. 

Meter 
Factor 
Curve / 
Single K-
factor 

A meter factor calculates for the current flow rate 
based on a linear interpolation of the meter factor 
versus flow rate values entered under the Factor 
Curve heading, but the K-factor will be fixed. Select 
this option when using meter factor proving if 
proving is done at multiple flow rates. 
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Field Description 

Single 
Meter 
Factor / K-
factor 
Curve 

A K-factor calculates for the current flow input 
frequency based on a linear interpolation of the 
meter factor versus frequency values entered under 
the Factor Curve, but the meter factor will be a single 
value from the last prove or entered value. The K-
factor curve can come from multiple proves at 
different flow rates with a meter factor of 1.0 (K-factor 
proving) or the K-factor curve can come from factory 
calibration and a single meter factor from a prove 
(meter factor proving). 

Curve Setup Click to open the Curve Setup dialog and configure the meter 
factor/K-factor curve. For more information, refer to Curve Setup 
(Liquid Linear Meter). 

Note 

This field appears only if you select either Meter Factor Curve / 
Single K-factor or Single Meter Factor / K-factor Curve in the Meter 
Factor / K-factor Curve Option field. 

Meter Factor Sets how the system obtains the meter factor value used in 
calculations. Possible options are: 

Override The system uses the value set in the Override Meter 
Factor field for the meter factor value. 

Calculate The system calculates a value for the meter factor. 

Override 
Meter Factor 

Sets the meter factor value to use in calculations when you select 
Override in the Meter Factor field. 

Calculated 
Meter Factor 

This read-only field shows the meter factor value as calculated by 
the system. 

Note 

This value is used by the system when you select Calculated in the 
Meter factor field. 

Selected 
Meter Factor 

This read-only field shows the meter factor currently used in 
calculations based on the selected options. 

K-factor Sets how the system obtains the K-factor value used in calculations. 
Possible options are: 
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Field Description 

Override The system uses the value set in the Override K-
factor field for the K-factor value. 

Calculated The system calculates a value for the K-factor. 

Override K-
factor 

Sets the discharge coefficient value to use in calculations when you 
select Override in the K-factor field. 

Calculated K-
factor 

This read-only field shows the discharge coefficient value as 
calculated by the system. 

Note 

This value is used by the system when you select Calculated in the 
K-factor field. 

Selected K-
factor 

This read-only field shows the K-factor currently used in calculations 
based on the selected options. 

Mass Pressure 
Effect 
Compensation 

This option allows for the compensation for the effects of high 
pressure on the accuracy of the meter mass flow rate and 
accumulation. This may be necessary in applications where the 
operating pressure is significantly different from the meter’s 
calibration pressure. 

Note 

This field appears only if you select Coriolis as the Meter Type on 
the Liquid Linear Meter – General display. 

Enable The system compensates for the effects of pressure 
on accuracy. 

Note 

You must enter a value in the Mass Pressure Effect 
and Calibration Pressure fields. 

Disable The system does not compensate for the effects of 
pressure on accuracy. 

Mass Pressure 
Effect 

Enter a value (in units of per psi or per bar) to be used when 
performing mass pressure effect compensation. 

Note 

• This value is supplied by the manufacture of the mass meter and 
is typically a small negative number. 

• This field appears only if you select Coriolis as the Meter Type 
on the Liquid Linear Meter – General display. 
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Field Description 

Calibration 
Pressure 

Sets the pressure (in units of gauge psi or bar) of the mass meter as 
calibrated. 

Note 

• This value is supplied by the manufacture of the mass meter and 
is typically a small negative number. 

• This field appears only if you select Coriolis as the Meter Type 
on the Liquid Linear Meter – General display. 

5. Select Save to save your changes if you modify any of the fields on this display. 

4.13.3.1 Curve Setup (Liquid Linear Meter) 

Use this option to enter a meter factor curve or K-factor curve. 

To access this option: 

1. Select Configure > Liquid > Liquid Linear Meter. The Liquid Linear Meter display 
opens showing the General tab. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

3. Select the Advanced button. The Liquid Linear Meter – Advance pop-up display opens. 

Figure 208. Liquid Linear Meter – Advanced  
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4. Select either Meter Factor Curve / Single K-factor or Single Meter Factor / K-factor 
Curve in the Meter Factor / K-factor Curve Option frame and Save your changes. 

5. Select the Curve Setup button. The Curve Setup pop-up display opens. 

Figure 209. Curve Setup 

 

6. If you selected Meter Factor Curve / Single K-factor on the previous display, enter 
up to 20 points on the curve (pairs of meter factor and flow rate) and a meter factor is 
calculated for use in the flow equation by linear interpolation of the current indicated 
quantity flow rate. If you selected Single Meter Factor / K-factor Curve on the 
previous display, enter up to 20 points on the curve (pairs of K-factor and frequency) 
and a K-factor is calculated for use in the flow equation by linear interpolation of the 
current flow meter input frequency. 
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Note 

A valid point must have a flow rate/frequency greater than zero and a factor greater than 
zero. The points may be entered in any order and will be internally sorted by flow rate (MF 
curve) or frequency (K-Factor Curve), discarding any invalid points. No extrapolation is 
done beyond the lowest and highest points on the curve. If the flow rate/frequency is less 
than the lowest point on the curve, the calculated factor will be the factor for the lowest 
point on the curve. If the flow rate/frequency is greater than the highest point on the 
curve, the calculated factor will be the factor for the highest point on the curve. If there 
are no valid points, then a default factor of 1.0 is used. 

7. Select Save to save any changes you make to this pop-up display. 

4.13.4 Liquid Linear Meter – Volume Correction  

Use this pop-up display to configure temperature and pressure volume correction options 
for the selected liquid linear meter.  

Note 

• If you select a Liquid Product Type of Crude Oil (defined on the Liquid Product 
display), this tab appears only if you select API Ch. 12.2 or API Ch. 20.1 and Use Oil 
Correction Factor for Water in the Crude Oil Options fields on the Station – General 
display. 

• If you select a Liquid Product Type of Light Hydrocarbon (defined on the Liquid 
Product display), the system calculates the volume correction factors and shows the 
calculated values in the Selected CTL/CPL fields. 

To understand the options available, you need to understand the concept of volume 
correction in general. Mass does not change with pressure and temperature, but we 
measure fluids by volume which does vary with pressure and temperature. Therefore, in 
order not to have your product worth less on cold days, fluids are bought and sold based 
on a corrected or standard volume, where the volume is calculated at some agreed upon 
pressure and temperature, which is the next best thing to mass. Most of the calculations 
require a density at some known temperature and pressure as an input. Of course, fluids 
are actually measured at widely varying pressures and temperatures and sometimes 
densities are measured at that same temperature and pressure and sometimes at a 
different temperature and pressure, so everything has to be converted to the agreed 
upon base conditions, thus the need for volume correction. 
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The temperature and pressure that the density is measured at is typically referred to as 
“observed” conditions, the agreed upon contract temperature and pressure as “base” 
conditions, and the conditions at the meter as “alternate” or “line” conditions. When you 
see references to “Observed to Base”, it is referring to the calculations involved in 
converting a density from the conditions it was measured at to the base conditions. When 
you see references to “Base to Meter”, it is referring to calculations involved in converting 
a density at base conditions to a density at alternate / meter / line conditions, which is the 
heart of volume correction, as the ratio of meter density to base density is the volume 
correction factor. Multiplying the measured volume at the meter by the volume correction 
factor gives you the base or standard volume.  

To access this pop-up display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Volume Correction button. The Liquid Linear Meter – Volume Correction 
pop-up display opens. 

Figure 210. Liquid Linear Meter – Volume Correction 
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4. Review the values in the following fields: 

Field Description 

CTL Observed to 
Base Mode 

Sets how the system acquires the observed to base 
hydrocarbon CTL (correction for the effect of temperature on 
liquid) value. This is the temperature portion of the correction 
from observed conditions to base conditions and is calculated 
from the observed temperature. Possible options are: 

External The system uses a parameter you configure in the 
CTL Observed To Base Parameter field to acquire 
the value. 

Note 

The system ignores negative or invalid external 
CTL values and uses a value of 0.0 instead. 

Override The system uses the fixed value you define in the 
Override CTL Observed to Base field. 
 

Calculated The system calculates the observed to base CTL 
value, based on the appropriate calculation 
method for the product. 

CTL Observed To 
Base Parameter
  

Click  to open a Point Picker dialog and select a parameter to 

acquire the hydrocarbon CTL observed to base value. 

Override CTL 
Observed To Base 

Sets the CTL observed to base value to use in calculations when 
Override is selected in the CTL Observed To Base Mode field. 

Calculated CTL 
Observed To Base 

This read-only field shows the hydrocarbon CTL observed to 
base value as calculated by the system. 

Selected CTL 
Observed To Base 

This read-only field shows the current hydrocarbon CTL 
observed to base value, based on the selected mode option. 
This is the CTL value in-use by the calculations. 

CPL Observed to 
Base Mode 

Sets how the system acquires the observed to base 
hydrocarbon CPL (correction for the effect of pressure on liquid) 
value. This is the pressure portion of the correction from 
observed conditions to base conditions, and is calculated from 
the observed pressure. Possible options are: 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

539 

Field Description 

External The system uses a parameter you configure in the 
CPL Observed To Base Parameter field to acquire 
the value. 

Note 

The system ignores negative or invalid external 
CPL values and uses a value of 0.0 instead. 

Override The system uses the fixed value you define in the 
Override CPL Observed to Base field. 

Calculated The system calculates the observed to base CPL 
value, based on the appropriate calculation 
method for the product. 

CPL Observed To 
Base Parameter
  

Click  to open a Point Picker dialog and select a parameter to 

acquire the hydrocarbon CPL observed to base value. 

Override CPL 
Observed To Base 

Sets the CPL observed to base value to use in calculations when 
Override is selected in the CPL Observed To Base Mode field. 

Calculated CPL 
Observed To Base 

This read-only field shows the hydrocarbon CPL observed to 
base value as calculated by the system. 

Selected CPL 
Observed To Base 

This read-only field shows the current hydrocarbon CPL 
observed to base value, based on the selected mode option. 
This is the CPL value in-use by the calculations. 

CTL Base to Meter 
Mode 

Sets how the system acquires the base to meter hydrocarbon 
CTL (correction for the effect of temperature on liquid) value. 
This is the temperature portion of the correction from base 
conditions to meter conditions, and is calculated from the base 
temperature. Possible options are: 

External The system uses a parameter you configure in the 
CTL Base to Meter Parameter field to acquire the 
value. 

Note 

The system ignores negative or invalid external 
CTL values and uses a value of 0.0 instead. 

Override The system uses the fixed value you define in the 
Override CTL Base to Meter field. 
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Field Description 

Calculated The system calculates the observed to base CTL 
value, based on the appropriate calculation 
method for the product. 

CTL Base to Meter 
Mode Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the hydrocarbon CTL base to meter value. 

Override CTL Base 
to Meter Mode 

Sets the CTL base to meter value to use in calculations when 
Override is selected in the CTL Base to Meter Mode field. 

Calculated CTL 
Base to Meter 
Mode 

This read-only field shows the hydrocarbon CTL base to meter 
value as calculated by the system. 

Selected CTL Base 
to Meter Mode 

This read-only field shows the current hydrocarbon CTL base to 
meter value, based on the selected mode option. This is the CTL 
value in-use by the calculations. 

CPL Base to Meter 
Mode 

Sets how the system acquires the base to meter hydrocarbon 
CPL (correction for the effect of pressure on liquid) value. This is 
the pressure portion of the correction from base conditions to 
meter conditions, and is calculated from the base pressure. 
Possible options are: 

External The system uses a parameter you configure in the 
CPL Base to Meter Parameter field to acquire the 
value. 

Note 

The system ignores negative or invalid external 
CPL values and uses a value of 0.0 instead. 

Override The system uses the fixed value you define in the 
Override CPL Base to Meter field. 

Calculated The system calculates the base to meter CPL value, 
based on the appropriate calculation method for 
the product. 

CPL Base to Meter 
Mode Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the hydrocarbon CPL base to meter value. 

Override CPL Base 
to Meter Mode 

Sets the CPL base to meter value to use in calculations when 
Override is selected in the CPL Base to Meter Mode field. 
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Field Description 

Calculated CPL 
Base to Meter 
Mode 

This read-only field shows the hydrocarbon CPL base to meter 
value as calculated by the system. 

Selected CPL Base 
to Meter Mode 

This read-only field shows the current hydrocarbon CPL base to 
meter value, based on the selected mode option. This is the CPL 
value in-use by the calculations. 

5. Select Save to save your changes if you modify any of the fields on this display. 

4.13.5 Liquid Linear Meter – Water 

 Use this pop-up display to configure correction options for sediment in water present in 
the selected liquid linear meter.  

Note 

The Water button appears only if you select Crude Oil in the Liquid Product Type field 
on the Liquid Product display. 

To access this pop-up display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to configure. 

3. Select the Water button. The Liquid Linear Meter – Water pop-up display opens. 
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Figure 211. Liquid Linear Meter – Water 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Sediment and 
Water / Water 
Cut 

Sets how the system acquires the sediment and water or water cut 
value. Possible options are: 

Measured The system uses a parameter you configure in the 
Sediment and Water Parameter field to acquire the 
value. 

Note 

The system ignores negative or invalid sediment and 
water values and uses a value of 0.0 instead. 

Override The system uses the fixed value you define in the 
Override Sediment and Water field. 

Note 

The label changes based on your selection in the Crude Oil Options 
fields on the Station – General display. If you select API Ch. 20.1 and 
Use Separate Correction Factor for Water, this field is labeled 
Water Cut. 

Sediment and 
Water 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the sediment and water value. 
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Field Description 

Override 
Sediment and 
Water 

Sets a fixed sediment and water value to use in calculations when 
Override is selected in the Sediment and Water field. 

Selected 
Sediment and 
Water 

This read-only field shows the current sediment and water value, 
based on the selected mode option. This is the sediment and water 
value in-use by the calculations. 

Sediment and 
Water 
Fraction In 
Use 

This read-only field shows the volume fraction of water applied to 
the gross volume of fluid measured to determine uncorrected 
(actual) water volume at metering conditions.  

Water CTL 
Meter Mode 

Sets how the system acquires the water CTL meter value. The water 
CTL meter is the ratio of water at allocation point temperature to the 
water at base temperature. Possible options are: 

External The system uses a parameter you configure in the 
Water CTL Meter Parameter field to acquire the 
value. 

Note 

The system ignores negative or invalid water CTL 
meter values and uses a value of 0.0 instead. 

Override The system uses the fixed value you define in the 
Override Water CTL Meter field. 

Calculated The system calculates the water CTL meter value. 

Note 

These fields appear only if you select API Ch. 20.1 and Use Separate 
Correction Factor for Water in the Crude Oil Option fields on the 
selection on the Station – General display. 

Water CTL 
Meter 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the water CTL meter value. 

Override 
Water CTL 
Meter 

Sets the water CTL meter value to use in calculations when Override 
is selected in the Water CTL Meter Mode field. 

Calculated 
Water CTL 
Meter 

This read-only field shows the water CTL meter value as calculated by 
the system. 
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Field Description 

Selected 
Water CTL 
Meter 

This read-only field shows the current water CTL meter value, based 
of the selected options, used in calculations. 

Water Base 
Density 

Sets how the system acquires the water base density value. Possible 
options are: 

Measured The system uses a parameter you configure in the 
Water Base Density Parameter field to acquire the 
value. 

Note 

The system ignores negative or invalid water base 
density values and uses a value of 0.0 instead. 

Override The system uses the fixed value you define in the 
Override Water Base Density field. 

Note 

These fields appear only if you select API Ch. 20.1 and Use Separate 
Correction Factor for Water in the Crude Oil Option fields on the 
selection on the Station – General display. 

Water Base 
Density 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the water base density value. 

Override 
Water Base 
Density 

Sets the water base density value to use in calculations when 
Override is selected in the Water Base Density field. 

Selected 
Water Base 
Density 

This read-only field shows the current water base density value, 
based of the selected options, used in calculations. 

5. Select Save to save your changes if you modify any of the fields on this display. 

4.13.6 Liquid Linear Meter – Additional Factors 

U se this pop-up display to configure additional properties for the fluid flowing through 
the meter, including NGL, shrinkage, and flash gas factors. 
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Note 

The Additional Factors button appears only if you select Crude Oil in the Liquid Product 
Type field on the Liquid Product display and API Ch. 20.1 in the Crude Oil Options field 
on the Station – General display. 

To access this pop-up display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Additional Factors button. The Liquid Linear Meter – Additional Factors 
pop-up display opens. 

Figure 212. Liquid Linear Meter – Additional Factors 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

NGL Factor Sets how the system acquires the NGL factor. Possible options are: 

Measured The system uses a parameter you configure in the 
NGL Factor Parameter field to acquire the value. 

Override The system uses the fixed value you define in the 
Override NGL Factor field. 
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Field Description 

Note 

These fields appear only if you select API Ch. 20.1 and Use Oil 
Correction for Water in the Crude Oil Options field on the Station – 
General display. 

NGL Factor 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the NGL factor value. 

Override NGL 
Factor 

Sets the NGL Factor value to use in calculations when Override is 
selected in the NGL Factor field. 

Selected NGL 
Factor 

This read-only field shows the current NGL factor value, based of the 
selected options, used in calculations. 

Shrinkage 
Factor 

Sets how the system acquires the shrinkage factor. Possible options 
are: 

Measured The system uses a parameter you configure in the 
Shrinkage Factor Parameter field to acquire the 
value. 

Override The system uses the fixed value you define in the 
Override Shrinkage Factor field. 

Shrinkage 
Factor 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the shrinkage factor value. 

Override 
Shrinkage 
Factor 

Sets the shrinkage factor value to use in calculations when Override 
is selected in the Shrinkage Factor field. 

Selected 
Shrinkage 
Factor 

This read-only field shows the current shrinkage factor value, based 
of the selected options, used in calculations. 

Flash Gas 
Factor 

Sets how the system acquires the flash gas factor. Possible options 
are: 

Measured The system uses a parameter you configure in the 
Flash Gas Factor Parameter field to acquire the 
value. 

Override The system uses the fixed value you define in the 
Override Flash Gas Factor field. 
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Field Description 

Note 

These fields appear only if you select API Ch. 20.1 and Use Oil 
Correction for Water in the Crude Oil Options field on the Station – 
General display. 

Flash Gas 
Factor 
Parameter 

Click  to open a Point Picker dialog and select a parameter to 

acquire the flash gas factor value. 

Override Flash 
Gas Factor 

Sets, in percent, the sediment and water value to use in calculations 
when Override is selected in the Flash Gas Factor field. 

Selected Flash 
Gas Factor 

This read-only field shows the current flash gas factor value, based 
of the selected options, used in calculations. 

5. Select Save to save your changes if you modify any of the fields on this display. 

4.13.7 Liquid Linear Meter – Diagnostics 

Use this pop-up display to view read-only diagnostic information for the selected liquid 
linear meter, including calculated factors, calculated values, and alarm codes. 

Note 

• This pop-up can remain open while you change values on the other tabs of this 
display. 

• Physically impossible inputs may be clamped at a high or low limit value in order to 
ensure reasonable results. If a value is clamped at a high or low limit, a corresponding 
flow or property alarm is raised. 

To access this display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 
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Figure 213. Liquid Linear Meter – Diagnostics Button 

 

3. Select the Diagnostics button. The Liquid Linear Meter Diagnostics display opens 
showing the Factors and Values tab. 
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Figure 214. Liquid Linear Meter Diagnostics 

 

The Liquid Linear Meter Diagnostics display contains the following tabs: 

Factors and Values – This tab displays the read-only current values for inputs and interim 
figures used for the meter calculations. 

Calculation Alarms – This tab displays any current alarms that apply to the meter 
calculations. Use this tab to aid in the diagnosis of problems with the meter. 

4.13.7.1 Liquid Linear Meter Diagnostics – Factors and Values Tab 

This tab displays the read-only current values for inputs and interim figures used for the 
meter calculations. 

To access this display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Diagnostics button. The Liquid Linear Meter Diagnostics display opens 
showing the Factors and Values tab. 
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Figure 215. Liquid Linear Meter Diagnostics – Factors and Values Tab 

 

4. Review the values in the following fields: 

Field Description 

Calculated 
Factors 

Selected K-
factor 

This read-only field shows the pulses per unit 
quantity generated by a pulse output type flow 
meter (also system factor). The nominal value is 
determined by flow meter design and factory water 
flow calibration. The "average" K-factors for the flow 
meters are usually displayed on the flow meter 
nameplates. 

Selected 
Meter Factor 

This read-only field shows the number obtained by 
dividing the actual volume of liquid passed through a 
flow meter during a meter proving operation by the 
volume registered by the flow meter. The meter 
factor is used in flow calculations to correct the 
indicated volume (end flow meter registration minus 
start flow meter registration) to the observed gross 
volume (actual flow meter throughput at operating 
conditions). 
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Field Description 

Meter factor = (Meter prover volume corrected to 
standard conditions) / (Flow meter indicated 
volume corrected to standard conditions) 

Indicated 
Quantity 
Flow Rate 

This read-only field shows the raw flow rate from the 
meter in Volumetric or Mass Flow Rate units, 
depending on the meter type. This value is prior to 
any meter factor correction. 

In-Use Meter 
Value 

Frequency In 
Use 

This read-only field shows the value of the indicated 
flow input configured on the Liquid Linear Meter – 
General display. 

Flowing 
Pressure In 
Use (Gauge) 

This read-only field shows the flowing gauge 
pressure being used by the flow calculation. It will 
reflect the absolute pressure in the selected pressure 
units of the station. 

Flowing 
Temperature 
In Use 

This read-only field shows the flowing temperature 
being used by the flow calculation. It will reflect the 
temperature in the selected temperature units of the 
station. 

External 
Accumulator 
Value 

This read-only field shows the flow accumulator 
value being used by the flow calculation. This field 
represents the accumulated volume for a turbine 
meter type or accumulated mass for a Coriolis meter 
type. 

Calculated 
Values 

Mass 
Pressure 
Effect 

This read-only field shows the mass pressure effect 
currently used in calculations. The mass pressure 
effect accounts for the effect of pressure on the 
vibrating tube of the Coriolis meter. 

In Use / 
Selected 
Values 

These read-only fields show the current values being used by the 
flow calculation. 

Note 
The In Use/Selected Values shown vary depending on your selections 
in the Liquid Product Type field on the Liquid Product display and 
Crude Oil Options field on the Station – General display. 
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Field Description 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

 

4.13.7.2 Liquid Linear Meter Diagnostics – Calculation Alarms Tab 

This tab displays any current alarms that apply to the meter calculations. Use this tab to 
aid in the diagnosis of problems with meter. Alarm codes are comprised of two parts: 
Alarm Category (the reason for the alarm) and Alarm Value (the part of the calculation 
that raised the alarm). For example, if you assign a voltage signal to a pressure input, 
Invalid Input would be selected in the Alarm Category frame and Pressure would be 
selected in the Alarm Value frame. 

Note 

• The fields shown on this display are determined by your selection in the Liquid 
Product Type field on the Liquid Product display. 

• The alarm code is a decimal representation of which alarm bits are set. Each bit is 
identified in the table below. 

• The error code can be a composite of one or more errors. 

• Error codes are generated according to your selection in the Calculation Failure 
Option field on the Station – Advanced display. 

• Alarms are raised if calculation inputs and interim values do not fall within certain 
ranges based on the calculation you have selected. To view the boundary limits for 
calculations, refer to Calculation Library Limit Checks. 

To access this display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 

3. Select the Diagnostics button. The Liquid Linear Meter Diagnostics display opens. 

4. Select the Calculation Alarms tab. 
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Figure 216. Liquid Linear Meter Diagnostics – Calculation Alarms Tab 

 

5. Review the values in the following fields: 

Field Description 

Flow 
Calculation 
Alarm 
Category 

These read-only fields show flow calculation alarm information. 

Flow 
Calculation 
Alarm 
Code 

This read-only field shows a code that indicates 
whether the flow calculation is within the specified 
boundaries of the selected method. The alarm code is 
a decimal representation of which alarm bits are set.  

Note 

• This is the same alarm code shown in the Alarm 
report. 

• The Alarm Code may show 0 if Calculation Failure 
Option has been set to Alarm Disabled on the 
Station – Advanced display. 

Alarm 
Category 

These read-only fields show, if checked, a general 
reason an alarm condition exists. Possible categories 
are: 
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Field Description 

Invalid 
Input(s) (Bit 
0) 

A required input is undefined, bad 
object type, wrong measurement 
type, measured input is not a valid 
floating-point number, or invalid 
combination of selections. 

Invalid 
Configuration 
(Bit 1) 

Database or program corruption. 

Note 

If detected, this alarm is asserted 
even when calculation alarms are 
disabled. 

Calculation 
Error (Bit 2) 

An error occurred in a calculation. 
Possible reasons are a conversion 
error, failure to converge, iteration 
limit, or divide by 0. 

Boundary 
Error (Bit 3) 

Something exceeded stated boundary 
of the calculation standard. 

Invalid 
Station 
Assignment 
(Bit 4) 

The meter type not is valid for the 
station type or station fluid type. 
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Field Description 

Alarm 
Value 

These read-only fields show, if checked, which part of 
the flow calculation is associated with the Alarm 
Category. 

• Flow (Bit 8) 

• Pressure (Bit 9) 

• Temperature (Bit 10) 

• Flowing Density (Bit 11) 

• Base Density (Bit 12) 

• Total/Increment (Bit 17) 

• K-factor / Meter Factor (Bit 25) 

• Mass Pressure Correction Factor (Bit 26) 

• Water Cut (Bit 27) 

• Shrinkage Factor (Bit 28) 

• CTL (Bit 29) 

• NGL/Flash Gas Factor (Bit 30) 
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Field Description 

Property 
Calculation 
Alarm 
Category 

These read-only fields show property calculation alarm information. 

Property 
Calculation 
Alarm 
Code 

This read-only field shows a code that indicates 
whether the property calculations (density, 
compressibility, and heating value) are within the 
specified boundaries of the selected method. The 
alarm code is a decimal representation of which alarm 
bits are set. 

Note 

• This is the same alarm code shown in the Alarm 
report. 

• The Alarm Code may show 0 if Calculation Failure 
Option has been set to Alarm Disabled on the 
Station – Advanced display. 

Alarm 
Category 

These read-only fields show, if checked, a general 
reason an alarm condition exists. Possible categories 
are: 

Invalid 
Input(s)  
(Bit 0) 

A required input is undefined, bad 
object type, wrong measurement 
type, measured input is not a valid 
floating-point number, or invalid 
combination of selections. 

Invalid 
Configuration 
(Bit 1) 

Database or program corruption. 

Note 

If detected, this alarm is asserted 
even when calculation alarms are 
disabled. 

Calculation 
Error (Bit 2) 

An error occurred in a calculation. 
Possible reasons are a conversion 
error, failure to converge, iteration 
limit, or divide by 0. 

Boundary 
Error (Bit 3) 

Something exceeded stated boundary 
of the calculation standard. 
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Field Description 

Alarm 
Value 

These read-only fields show, if checked, shows which 
part of the flow calculation is associated with the Alarm 
Category. 

• Pressure (Bit 8) 

• Temperature (Bit 9) 

• Flowing Density (Bit 10) 

• Base Density (Bit 11) 

• Atmospheric Press/Gravitational Accel (Bit 16) 

• Critical Temp/Press (Bit 20) 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 

 

4.13.8 Liquid Linear Meter – Rates & Totals 

Use this pop-up display to view read-only flow rates and accumulations for the selected 
liquid linear meter.  

Note 

• This pop-up can remain open while you change values on the other tabs of this 
display. 

• The flow rates and totals shown vary depending on you selections in the Liquid 
Product Type field on the Liquid Product display and Crude Oil Options field on the 
Station – General tab. 

• The system uses different calculations based on three possible configurations. Refer 
to Liquid Linear Meter Flow Calculations for a list of flow calculations used with 
different configurations. 

To access this pop-up display: 

1. Select Configure > Liquid > Liquid Linear Meter from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a meter to view. 
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Figure 217. Liquid Linear Meter – Rates & Totals Button 

 

3. Select the Rates & Totals button. Liquid Linear Meter Rates & Totals display opens. 

Figure 218. Liquid Linear Meter Rates & Totals 
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4. Review the values in the following fields: 

Field Description 

Current Flow 
Rates 

These read-only fields show the current flow rates for the selected 
meter. 

Current Totals These read-only fields show the total accumulation, as well as the 
current and previous hourly, daily, weekly, monthly, and batch 
accumulations for the selected meter. 

Batching These read-only fields show the current and previous batch 
numbers, batch start times, and previous batch end time. 

Note 
These fields show only if the Batch Option field is set to Enable on 
the Station – General display. 

End Meter 
Batch 

Select this button to end a currently running batch. 

Click  to open a Point Picker dialog and select a 

numeric read/write parameter used by an external 
host to end a batch when the value is non-zero. 

Note 

If you select a parameter, a non-zero value is 
interpreted as a command and a zero value is 
interpreted as an idle state. After reading a non-zero 
value and taking the specified action (start or end), the 
FB3000 resets the command by setting the parameter 
back to 0 if the parameter selected is a R/W parameter. 
If you select a discrete input, it is recommended that 
the discrete input is configured as latched. After 
reading an “on” status from the discrete input and 
taking the specified action (start or end), the FB3000 
sends a reset latch command to the discrete input. 

Pause/Resume Select the Pause button to prevent the values on this display from 
updating. Select the Resume button to restart automatically 
refreshing the values shown on the display. 
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4.14 Liquid Product 

Use this display to define liquid products and their fluid properties. A liquid product flows 
through one or more meters that make up a station. In liquid pipeline applications, the 
product that flows through a given station may need to change dynamically. To facilitate 
this need for flexibility, the product definition is separate from the station definition and 
you assign the product to the station. At this point, you define all of the products that 
might ever need to be measured, even if you currently do not assign them to a station. 

To access this tab: 

1. Select Configure > Liquid > Liquid Product from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display and select a liquid product 
instance to configure. 

Figure 219. Liquid Product 

 

3. Review – and change as necessary – the values in the following fields: 
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Field Description 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
product instance. 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
product instance. 

Liquid 
Product Type 

Sets the specific type of hydrocarbon fluid for the selected product 
instance. Possible options are: 

Crude Oil A liquid hydrocarbon is generally considered to be a 
crude oil if its density falls between approximately 
0.61120 to 1.16464 relative density (100 to −10 °API). 
Crude oils that have been stabilized for transportation 
or storage purposes with API gravities within this 
range are considered to be part of this group. 

Refined 
Products 

A liquid hydrocarbon is generally considered to be a 
refined product if it falls into one of the following 
product groups: 

• Gasoline – Motor gasoline and unfinished gasoline 
blending stock with a base density range between 
approximately 50° API and 85° API. 

• Jet Fuels – Jet fuels, kerosene, and Stoddard 
solvents with a base density range between 
approximately 37° API and 50° API. 

• Fuel Oils – Diesel oils, heating oils and fuel oils with 
a base density range between approximately -10° 
API and 37° API. 

Lubricating 
Oil 

A liquid hydrocarbon is generally considered to be a 
lubricating oil if it is a base stock derived from crude 
oil fractions by distillation or asphalt precipitation. 
Lubricating oils have densities in the range between 
approximately -10 to 45° API. 
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Field Description 

Light 
Hydrocarbon 
(NGL/LPG) 

A liquid hydrocarbon is generally considered to be a 
light hydrocarbon if its density falls between 
approximately 0.3500 to 0.6880 relative density (272.8 
to 72.2 °API). Light hydrocarbons are often referred to 
as LPGs (Liquified Petroleum Gases) or NGLs (Natural 
Gas Liquids) and are predominantly composed of 
lighter hydrocarbons, such as methane, ethane, 
butane, and propane. 

Additional 
Fluid 

Any fluid not covered by the other options. If a 
measured density is available and the base density is 
known, then the volume correction factor for 
temperature and pressure (CTPL) is calculated as the 
ratio of the measured density to the base density. If a 
measured density is not available, then the CTPL is set 
to 1.0 and no volume correction for temperature or 
pressure is calculated. The density options below are 
chosen via the Density Option field on the Station – 
General display: 

Station Base Density 
 meter observed density = station base density 
 CTPL = 1.0 

Meter Observed Density 
 CTPL = meter observed density / station base 

density 

Station Header Density 
 meter observed density = station header density 
 CTPL = meter observed density / station base 

density 

Note 
Even though independent temperature (CTL) and 
pressure (CPL) correction factors cannot be calculated, 
CTL is set equal to CTPL and CPL is set equal to 1.0 to 
provide support for systems that do not recognize or 
use CTPL. 
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Field Description 

Base Density Sets a density for the Liquid Product Type you select at contract (base) 
temperature and pressure. Select ▼ to set the base density units and 
the base temperature that apply to the entered base density value. 

Note 

If the base density and temperature units are different than the 
station's base conditions, the system converts the value to the station's 
base conditions using the option selected in the API Ch 11 Volume 
Correction Method field. 

API Ch 11 
Volume 
Correction 
Method 

Sets the volume correction calculation used by all stations and meters 
associated with the selected product instance. The FBx products 
currently support the 2007 version of the API / ASTM / IP Volume 
Correction tables. 

Note 

This field appears only if you select Crude Oil in the Liquid Product 
Type field. 

Light 
Hydrocarbon 
Method 

Sets the volume correction calculation used by all stations and meters 
associated with the selected product instance. The FBx products 
currently support the GPA 8217 / API 11.2.4 Volume Correction Tables 
(formerly GPA TP-27). This method uses the following set of standards: 

• Temperature Correction – GPA 8217 / API 11.2.4 Standard (2019) 
(formerly GPA TP-27) 

• Pressure Correction – API 11.2.2 (1986) and API 11.1 (2007)  

• Equilibrium Pressure – GPA 8117 / API 11.2.5 (2017) (formerly 
GPA TP-15) 

Note 

This field appears only if you select Light Hydrocarbon in the Liquid 
Product Type field. 

4. Select Save to save any changes you make to this display. 
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4.15 Liquid Density 

Use this display to configure liquid density inputs. For the FB3000 RTU, you can configure 
up to 12 Liquid Density instances. 

Note 

• If you select Station Header Density in the Density Option field on the Station – 
General display, then you must configure the Density Parameter field. 

• The Density Pressure Parameter and Density Temperature Parameter fields are 
optional, but a property calculation alarm is raised at any associated liquid linear 
meter if the Density Temperature Parameter is Undefined. 

To access this display: 

1. Select Configure > Liquid > Liquid Density from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display and select a liquid density 
instance to configure. 
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Figure 220. Liquid Density 

 

3. Review the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
product instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
product instance. 
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Field Description 

Density 
Parameter 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

density input to use for the selected Liquid Density 
instance. 

Note  
Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• AI object – SELECTED VALUE  
Note  
You must first configure an AI instance to use the 
correct measurement type before it is visible in the 
Point Picker. For more information, refer to AI. 

• User Data – You can manually select any parameter. 
For more information, refer to User Data.  
Note  
The value is assumed to be in the same units selected 
for the associated station. 

Value This read-only field shows the value currently used in 
calculations based on the selected options. 

Note 
If you select a User Data object, enter a value to use for 
the selected parameter. 

Units This read-only field shows the engineering units used for 
the selected input. 

Alarms Click to open the Alarms display and configure the alarm 
currently assigned to the input. 

Note  
This selection is not available if you select a User Data 
object; however, you can configure an alarm object 
separately on the Configure > Alarms display for the User 
Data value. 
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Field Description 

Density 
Pressure 
Parameter 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

density pressure input to use for the Liquid Density 
instance. 

If you select a Press object, the firmware determines the 
pressure input type (absolute or gauge) directly from the 
sensor. 

Note  
Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• AI object – SELECTED VALUE  
Note  
You must first configure an AI instance to use the 
correct measurement type before it is visible in the 
Point Picker. For more information, refer to AI. 

• Press object – SELECTED VALUE 

• User Data – You can manually select any parameter. 
For more information, refer to User Data.  

Note  

• The value is assumed to be in the same units (psi, 
kPa, etc.) selected for the associated station. 

• When you select a parameter without explicit 
units, the value is assumed to be gauge pressure. 

Value This read-only field shows the value currently used in 
calculations based on the selected options. 

Note 
If you select a User Data object, enter a value to use for 
the selected parameter. 

Units This read-only field shows the engineering units used for 
the selected input. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

568 

Field Description 

Alarms Click to open the Alarms display and configure the alarm 
currently assigned to the input. 

Note  
This selection is not available if you select a User Data 
object; however, you can configure an alarm object 
separately on the Configure > Alarms display for the User 
Data value. 

Density 
Temperature 
Parameter 

I/O 
Definition 

Click  to open a Point Picker dialog and select the 

density temperature input to use for the Liquid Density 
instance. 

Note  
Only an object is chosen, and the parameter is 
determined by the system based on the type of object. 

• AI object – SELECTED VALUE  
Note  
You must first configure an AI instance to use the 
correct measurement type before it is visible in the 
Point Picker. For more information, refer to AI. 

• RTD object – SELECTED VALUE 

• User Data – You can manually select any parameter. 
For more information, refer to User Data.  
Note  
The value is assumed to be in the same units selected 
for the associated station. 

Value This read-only field shows the value currently used in 
calculations based on the selected options. 

Note 
If you select a User Data object, enter a value to use for 
the selected parameter. 

Units This read-only field shows the engineering units used for 
the selected input. 
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Field Description 

Alarms Click to open the Alarms display and configure the alarm 
currently assigned to the input. 

Note  
This selection is not available if you select a User Data 
object; however, you can configure an alarm object 
separately on the Configure > Alarms display for the 
User Data value. 

Density 
Correction 
Factor 

Sets the multiplier value to correct the observed density provided by a 
pycnometer or similar device. The Density Correction Factor 
(sometimes referred to as DCF) is a unitless scaler used to adjust the 
density referenced by the density parameter. 

4. Select Save to save any changes you make to this tab. 

4.16  Station 

Use this display to configure parameters for stations. The FB Series product organizes 
meter runs into stations. The meter runs can be grouped among the stations in any 
combination based on the type of fluid being measured (natural gas or liquid). You should 
configure stations before you configure meter runs. 

Meters are assigned to stations on the DP Meter, Linear Meter, and Liquid Linear Meter 
displays. Meter runs belong in the same station when they have the same gas data, 
calculation methods, and base/contract conditions. Each station may be given a unique 
Tag and Description. 

To access this display, select Configure > Station from the FBxConnect™ main menu. 

Figure 221. Configure – Station 

 

The Station display contains the following items: 

General – Use this display to configure general station parameters, including the contract 
date/time, compressibility/density calculation, and base temperature/pressure. 

Batching – Use this pop-up display to configure options related to batching, including the 
batch identifier, and batch start and end triggers. 
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Transaction History Log Options – Use this pop-up display to configure transaction history 
logging options. 

Advanced – Use this pop-up display to configure advanced station options, including 
location of the station, water content of the fluid flowing through the meters, and heating 
value parameters. 

Rates & Totals – Use this pop-up display to view flow rates and accumulations for the 
selected station.  

4.16.1 Station – General  

Use this display to configure general station parameters, including the contract 
date/time, compressibility/density calculation, and base temperature/pressure. 

Note 

The fields shown on this display vary based on the selected fluid type. 

To access this display: 

1. Select Configure > Station from the FBxConnect™ main menu. The Station display 
opens. 

2. Click ▼ in the drop-down list at the top of the display and select a Station instance to 
configure. 
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Figure 222. Station – General (Natural Gas Station shown) 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected instance. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected instance. 

Operation 
Status 

This read-only field shows the current state of the batch. Possible 
values are Batch Idle or Batch Active. 

Note 

• This field applies only for Stations with a Fluid Type of Liquid. 

• For more information about starting or stopping a batch, refer 
to the Station – Batching display. 
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Field Description 

Engineering 
Units 

Click to open the Engineering Units display and configure the 
engineering units used by the station for measurements. 

Note 

Changes to engineering units are written to all meters assigned to 
the selected station even if the meters have previously been 
configured. For the FB3000 RTU, refer to Configure – Summary to 
view your meter station assignments. 

Flow Alarm 
Object 

This read-only field shows which alarm is associated with the 

selected station. Select  to open the Alarms display and 

configure the alarm. When you have finished configuration 

options, select  to return to this display. 

History Group This read-only field shows which history group is associated with 
the selected station. The history group you select determines the 
contact hour and which history group is used to record average 

and periodic data for this station. Select  to open the Group 

Configuration display and configure the history group. When you 

have finished configuration options, select  to return to this 

display. 

Note 

• If an error occurs reading the contact hour and/or history 
group settings, an event is logged and totalization continues 
using default contract settings. 

• At the end of each reporting period, the station checks to see if 
the station historic data was correctly recorded. If there is an 
error, the system logs a No Response From History event to 
the Event log. 
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Field Description 

Liquid Product 
Reference 

Sets the Liquid Product instance associated with the selected 

station. Click  to open a Point Picker dialog and choose the 

liquid product instance used by the selected station. Select  to 

open the Liquid Product display and configure the liquid product. 

When you have finished configuration options, select  to 

return to this display. 

Note 

This field appears only for Stations with a Fluid Type of Liquid. 

Header Density 
Object 

Sets the Liquid Density instance associated with the selected 

station. Click  to open a Point Picker dialog and choose the 

liquid density instance used by the selected station. Select  to 

open the Liquid Density display and configure the liquid density 
parameters. When you have finished configuration options, select 

 to return to this display. 

Note 

This field appears only for Stations with a Fluid Type of Liquid and 
a Density Option set to Station Header Density. 

Advanced Select this button to open the Station – Advanced pop-up display 
and configure advanced station options, including location of the 
station, water content of the fluid flowing through the meters, and 
heating value parameters. 

Batching Select this button to open the Station – Batching pop-up display 
and configure options related to batching, including the batch 
identifier, batch start and end triggers, and transaction history 
logging options. 

Note 
This button shows only for liquid stations on the FB3000 RTU with 
the Batch Option field set to Enable. 

Rates & Totals Select this button to open the Station – Rates & Totals pop-up 
display and view gas totals and accumulations for the selected 
station.  
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Field Description 

Fluid Type Specifies the type of fluid measured by the meters assigned to the 
selected station. Possible options are: 

Natural 
Gas 

The selected station is used to for natural gas 
applications. Station settings apply to all meters 
assigned to the station. Station rates and totals are 
calculated based on the differential pressure and 
linear meters assigned to the station.  

Liquid The selected station is used for liquid applications. 
Station settings apply to all meters assigned to the 
station. Station rates and totals do not calculate based 
on the liquid linear meters assigned to the station. 

Note 

This field is read-only if you have already assigned a meter to the 
selected station. In this case, you must first remove any meters 
assigned to the selected station before you are able to change the 
Fluid Type field. 

Batch Option Sets the status of the batching feature on the selected station. 

Disable Batching is not implemented on the selected station. 

Enable Batching is implemented on the selected station. 

Note 

This field applies only for Stations with a Fluid Type of Liquid. 

Contract 
Properties 

These fields set the time at which totals rollover and history 
records are logged. 

Contract 
Day of 
Week 

Click ▼ to set the day of the week at which totals 
rollover and history records are logged (for weekly-
based reports). 

Contract 
Hour 

Click ▼ to set the hour at which daily, weekly, and 
totals rollover and history records are logged (for 
daily-based, weekly-based, or monthly-based reports). 

Contract 
Day of 
Month 

Click ▼ to set the day of the month at which totals 
rollover and history records are logged (for monthly-
based reports). 
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Field Description 

Compressibility 
/ Density 
Calculation 

Sets the desired compressibility/density calculation for the selected 
station. Select a standard from the list on the left, and then select a 
version/method to use from the list on the right. 

Note 

• This field appears only for stations with a Fluid Type of 
Natural Gas. 

• Some compressibility/density standards are based on a specific 
set of reference conditions. For the most accurate results, 
ensure the reference conditions outlined below are configured 
based on the Compressibility/Density Calculation you select. 

AGA8 AGA8 Part 1 
2017 Detailed 

Property calculations performed in 
accordance with the detailed 
method provided in AGA Report No. 
8 - Part 1 - 2017 Edition - 
Thermodynamic Properties of 
Natural Gas and Related Gases. 

Reference Conditions 

Any reference conditions. 

AGA8 Part 1 
2017 Gross 1 

Property calculations performed in 
accordance with the Gross 1 method 
provided in AGA Report No. 8 - Part 
1 - 2017 Edition - Thermodynamic 
Properties of Natural Gas and 
Related Gases. 

Reference Conditions 

Any reference conditions. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

AGA8 Part 1 
2017 Gross 2 

Property calculations performed in 
accordance with the Gross 2 method 
provided in AGA Report No. 8 - Part 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

576 

Field Description 

1 - 2017 Edition - Thermodynamic 
Properties of Natural Gas and 
Related Gases. 

Reference Conditions 

Any reference conditions. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

AGA8 Part 2 
2017 / GERG 
2008 

Property calculations performed in 
accordance with AGA Report No. 8 - 
Part 2 - 2017 Edition - 
Thermodynamic Properties of 
Natural Gas and Related Gases 
GERG–2008 Equation of State. 

Reference Conditions 

Any reference conditions. 

Note 

AGA8 2017 Part 2 / GERG 2008 can 
be used for both natural gas and 
pure gas measurement. For more 
information about pure gas 
measurement, refer to Measuring 
Pure Gas. 

AGA8 Part 1 
1994 Detailed 

Property calculations performed in 
accordance with the detailed 
method provided in AGA Report No. 
8 1994 Edition – Compressibility 
Factors of Natural Gas and Other 
Related Hydrocarbon Gases. 

Reference Conditions 

Any reference conditions. 
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Field Description 

AGA8 Part 1 
1994 Gross 1 

Property calculations performed in 
accordance with the Gross 1 method 
provided in AGA Report No. 8 1994 
Edition – Compressibility Factors of 
Natural Gas and Other Related 
Hydrocarbon Gases. 

Reference Conditions 

Any reference conditions. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

AGA8 Part 1 
1994 Gross 2 

Property calculations performed in 
accordance with the Gross 2 method 
provided in AGA Report No. 8 1994 
Edition – Compressibility Factors of 
Natural Gas and Other Related 
Hydrocarbon Gases. 

Reference Conditions 

Any reference conditions. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

ISO ISO12213-2 
2006 

Property calculations performed in 
accordance with the method 
provided in ISO12213 Part 2 2006 
Edition – Natural Gas - Calculation of 
compression factor - Part 2: 
Calculation using molar-composition 
analysis. 
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Field Description 

Reference Conditions 

Any reference conditions. 

ISO12213-3 
2006 
CV/RD/CO2/H2 
(Pref) 

Property calculations performed in 
accordance with the preferred 
method using heating value, relative 
density, mole % CO2 and mole % H2 
provided in ISO12213 Part 3 2006 
Edition – Natural gas - Calculation of 
compression factor - Part 3: 
Calculation using physical 
properties. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 

• The Heating Value Combustion 
Temperature field is set to 
25°C. 

ISO12213-3 
2006 
N2/CV/RD/H2 
(Set B) 

Property calculations performed in 
accordance with the method using 
physical property set B (heating 
value, relative density, mole % N2 
and mole % H2) provided in 
ISO12213 Part 3 2006 Edition – 
Natural gas - Calculation of 
compression factor - Part 3: 
Calculation using physical 
properties. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 
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Field Description 

• The Heating Value Combustion 
Temperature field is set to 
25°C. 

ISO12213-3 
2006 
N2/CO2/RD/H2 
(Set C) 

Property calculations performed in 
accordance with the method using 
physical property set C (relative 
density, mole % N2, mole % CO2 and 
mole % H2) provided in ISO12213 
Part 3 2006 Edition – Natural gas - 
Calculation of compression factor - 
Part 3: Calculation using physical 
properties. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 

ISO12213-3 
2006 
N2/CO2/CV/H2 
(Set D) 

Property calculations performed in 
accordance with the method using 
physical property set D (heating 
value, mole % N2, mole % CO2 and 
mole % H2) provided in ISO12213 
Part 3 2006 Edition – Natural gas - 
Calculation of compression factor - 
Part 3: Calculation using physical 
properties. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 

• The Heating Value Combustion 
Temperature field is set to 
25°C. 
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Field Description 

SGERG SGERG 1991 
CV/RD/CO2/H2 
(Std) 

Property calculations performed in 
accordance with the standard 
method using heating value, relative 
density, mole % CO2 and mole % H2 
provided in “Simplified GERG Virial 
Equation for Field Use” published 
1991. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 

• The Heating Value Combustion 
Temperature field is set to 
25°C. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

SGERG 1991 
CV/RD/N2/H2 

Property calculations performed in 
accordance with the alternative 
method using heating value, relative 
density, mole % N2 and mole % H2 
provided in “Simplified GERG Virial 
Equation for Field Use” published 
1991. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 
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Field Description 

• The Heating Value Combustion 
Temperature field is set to 
25°C. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

SGERG 1991 
RD/N2/CO2/H2 

Property calculations performed in 
accordance with the alternative 
method using relative density, mole 
% N2, mole % CO2 and mole % H2 
provided in “Simplified GERG Virial 
Equation for Field Use” published 
1991. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

SGERG 
CV/N2/CO2/H2 

Property calculations performed in 
accordance with the alternative 
method using heating value, mole % 
N2, mole % CO2 and mole % H2 
provided in “Simplified GERG Virial 
Equation for Field Use” published 
1991. 

Reference Conditions 
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Field Description 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 

• The Heating Value Combustion 
Temperature field is set to 
25°C. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

NX-19 NX19 1962  
(Z VDI/VDE) 

Fpv calculation based on PAR 
Research Project NX-19 1962, Zf 
calculation based on VDI/VDE 
modification of NX-19. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 60°F. 

• The Base Pressure Selection 
field is set to 14.73 psi(a). 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

NX-19 1962  
(Z Miller) 

Fpv calculation based on PAR 
Research Project NX-19 1962, Zf 
calculation based on Flow 
Measurement Engineering 
Handbook by Richard W. Miller. 

Reference Conditions 
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Field Description 

• The Base Temperature 
Selection field is set to 60°F. 

• The Base Pressure Selection 
field is set to 14.73 psi(a). 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

NX-19 Mod Fpv and Zf calculation based on 
“Correction of the AGA NX-19 Mod 
Data Processing System for Real Gas 
Factors of type H Natural Gas” 
published in 1982. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

NX-19 VDI/VDE Fpv and Zf calculation based on 
“VDI/VDE 2040 Part 2” published in 
1987. 

Reference Conditions 

• The Base Temperature 
Selection field is set to 0°C. 

• The Base Pressure Selection 
field is set to 1.01325 bar. 
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Field Description 

Note 

The real heating value and real 
relative density base compressibility 
are calculated using your selection 
in the Heating Value Calc Standard 
field. 

Crude Oil 
Options 

Sets the flow calculation methodology used to calculate crude oil, 
crude oil byproducts, and water quantities. Possible options are: 

Note 

This field appears only for stations with a Fluid Type of Liquid and 
a Liquid Product Type of Crude Oil (defined on the Liquid Product 
display). 

API 
Ch.12.2 

Meters assigned to the selected station use API Ch. 
12.2 for liquid measurement. This standard is typically 
used for custody transfer but can also be utilized for 
crude oil allocation applications. For crude oil, the 
standard assumes a low amount of water in the 
measured fluid and treats the water stream as an oil 
for volume correction purposes. The same calculation 
is used for refined products and lubricating oils with % 
water set to 0. 

The meter calculates flow rates and accumulations 
representing indicated quantity, gross volume, gross 
standard volume, net standard volume, water volume, 
and mass. CTPL is calculated as the product of the 
rounded CTL and CPL, which is in turn rounded as per 
correction factors in API Ch 12.2 Table 6. 

Note 

The associated Station provides flow rates and 
accumulations representing gross volume, net 
standard volume, water volume, and mass. 

API Ch. 
20.1 

Meters assigned to the selected station use API Ch. 
20.1 standard for allocation measurement. The 
standard handles unstable crude oil and/or higher 
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Field Description 

water cases. The standard is partitioned by its water 
volume correction methodology. 

 
Use Oil 
Correction 
Factor for 
Water 

Meters assigned to the selected 
station use API Ch. 20.1 Procedure A 
for oil measurement. The standard 
assumes a low amount of water in the 
measured fluid and treats the water 
stream as an oil for volume correction 
purposes. API Ch. 20.1 2016 suggests 
using this method when the sediment 
and water is generally less than 5.0 
percent.  

The meter calculates the same 
quantities as the API Ch. 12.2 Custody 
Transfer Meter, but a shrinkage factor 
is applied to the gross standard 
volume. If the shrinkage factor 
includes a correction for temperature, 
the CTL should be set to override 
mode with a value of 1.0, otherwise it 
should be set to calculated mode. If 
pressure correction is included in the 
SF or pressure correction is not 
required, CPL should be set to 
override mode at 1.0, otherwise CPL 
should be set to calculated mode. 
CTPL is calculated as the product of 
the rounded CTL and CPL, which is in 
turn rounded as per correction factors 
in API Ch 12.2 Table 6. The water 
fraction is calculated using the in-use 
CSW. 

Note 

Station quantity calculations are not 
supported for allocation meters.  
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Field Description 

Use 
Separate 
Correction 
Factor for 
Water 

Meters assigned to the selected 
station use API Ch. 20.1 Procedure C 
for oil measurement. The oil and 
water have separate volume 
correction factors and are split before 
volume correction is applied. API Ch. 
20.1 2016 suggests using this method 
when the sediment and water is 
generally greater than 5.0 percent. 

The meter calculates flow rates and 
accumulations representing indicated 
quantity, gross volume, oil unshrunk 
volume, net standard volume, water 
metered volume and water net 
volume. Additionally, a flash gas net 
volume and an NGL net volume may 
be calculated by entering an override 
flash gas factor and NGL factor.  

The correction factor for the oil is 
entered via an override or external 
shrinkage factor (SF). The Shrinkage 
Factor is assumed to include any 
correction for shrinkage, temperature, 
and pressure. CTL, CPL, CTPL, CCF and 
CSW are assumed to be 1.0. The 
correction factor for water is 
calculated according to API Ch. 20.1 
A.1 2016.  

Note 

The flow calculation uses unrounded 
correction factors. Station quantity 
calculations are not supported for 
allocation meters. 
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Field Description 

Base 
Temperature 
Selection 

Sets the flow measurement Base Temperature specified in the gas 
contract. The temperature units are in degrees Fahrenheit or 
degrees Celsius.  

Note 

Select User to enter a custom temperature value. 

Selected Base 
Temperature 

This read-only field shows the current Base Temperature value 
used in calculations. 

Base Pressure 
Selection 

Sets the flow measurement Base Pressure specified in the gas 
contract. The pressure units are in psi(a) or kPa. 

Note 

• Select User to enter a custom pressure value. 

• This field appears only for stations with a Fluid Type of 
Natural Gas. 

Selected Base 
Pressure 

This read-only field shows the current Base Pressure value used in 
calculations. 

Note 

This field appears only for stations with a Fluid Type of Natural 
Gas. 

Heating Value 
Measurement 
Basis 

Sets the option to have the heating (calorific) values represented 
on a volume basis or a mass basis. 

Volume Heating (calorific) value represents energy of 
combustion per unit volume at base conditions and 
specified combustion reference conditions, units 
determined by Volume Heating Value units. Energy is 
calculated from SVOL. 

Mass Heating (calorific) value represents energy of 
combustion per unit mass and specified combustion 
reference conditions, units determined by Mass 
Heating Value units. Energy is calculated from MASS. 

Note 

This field appears only for stations with a Fluid Type of Natural 
Gas. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

588 

Heating Value 
Calc Standard 

Sets the calculation standard used in heating value, relative density 
of the gas to air, and Wobbe Index calculations. Options are GPA 
2172 2009 Gross, ISO 6976 1995 Superior, ISO 6976 1995 Inferior, 
AGA5 2009 Gross, and AGA5 2009 Net.  

Note 

• This field appears only for stations with a Fluid Type of 
Natural Gas. 

• GPA 2172 2009 uses GPA 2145 2016. 

• ISO 6976 1995 Superior and ISO 6976 1995 Inferior use the 
base compressibility (Zb) value calculated per ISO 6976 in the 
heating value calculation when base temperature selection is 
0°C, 15°C, or 20°C; in these cases a base pressure of 1.01325 
bar is used for the real Heating Value and Real Relative density. 
For other base temperature selections, the selected Zb from 
the compressibility calculation is used. The base pressure for 
combustion is always 1.01325 bar. 

• If the base compressibility method is dependent upon the 
Heating value or relative density, GPA 2172 uses the Base 
Compressibility using the GPA 2172 2009 method. Otherwise, 
GPA 2172 2009 uses the Selected Base Compressibility value 
found on the Fluid Properties – Advanced display in the heating 
value calculation. 

• If the base compressibility method is dependent upon the 
heating value or relative density, then GPA 2172 2009 Gross, 
AGA5 2009 Gross, and AGA5 2009 Net use the base 
compressibility from their respective internal compressibility 
method. Otherwise, GPA 2172 2009 Gross, AGA5 2009 Gross, 
and AGA5 2009 Net use the Selected Base Compressibility value 
found on the Fluid Properties – Advanced display in the heating 
value calculation. 

• Although AGA5 says the base temperature and the combustion 
temperature shall be the same, the calculation will handle any 
base temperature and combustion temperature combination. 

• Since the components Benzene and Toluene are not included 
in AGA5, their properties are calculated separately. This 
calculation closely follows Example Process for Supporting 
Additional Compounds in Appendix A of AGA5 2009. 
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Field Description 

• The AGA5 2009 Net (Inferior / Lower) heating value option 
assumes that the water formed in the combustion reaction 
remains in the ideal (gaseous) state. The AGA5 2009 Gross 
(Superior / Higher) heating value option assumes that water 
formed in the combustion reaction condenses totally to the 
liquid state. For fiscal measurement applications, the gross 
heating value is more commonly used.  

Heating Value 
Combustion 
Temp 

Temperature at which the heating value was determined (Energy 
measured with reactants at this temperature prior to combustion 
and products returned to this temperature after combustion). 

Note 

• This field appears only for stations with a Fluid Type of 
Natural Gas. 

• GPA 2172 only supports heating value combustion 
temperatures of 60°F and 15°C. If you select a heating value 
combustion temperature of 0°C, 20°C or 25°C, then the heating 
value is calculated using a heating value combustion 
temperature of 15°C and base pressure selection of 101.325 
kPa. 

Density Option Sets the source of the density values used in volume correction 
calculations. Possible options are: 

Station 
Base 
Density 

Use the static density value you define for the Liquid 
Product instance you select in the Liquid Product 
Reference field. No densitometer is at the meter. A 
base to alternate calculation occurs using the meter 
temperature and pressure as the alternate conditions. 

Note 

If the base density and temperature units are different 
than the station's base conditions, the system converts 
the value to the station's base conditions. 

Meter 
Observed 
Density 

Use the dynamic density value measured at the meter 
by a densitometer. You configure the densitometer in 
the Meter Density Parameter field on the Liquid 
Linear Meter – General display. The observed to base 
density calculation uses the meter temperature and 
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Field Description 

pressure as the observed density conditions. In most 
cases where the meters have individual live density 
measurement, there is only one temperature 
measurement and one pressure measurement to 
cover both the density and the meter. This means that 
the meter density is set equal to the observed density 
and only an observed to base calculation is performed. 

Station 
Header 
Density 

Use the dynamic density value measured at the 
station/header (with header temperature and 
pressure). You configure the measurement source in 
the Header Density Object field. 

This selection performs an observed to base density 
calculation assuming the density, pressure, and 
temperature values referenced by the Header Density 
Object are at observed density conditions. The 
resulting station base density is used to perform a 
base to alternate calculation at each meter using the 
meter temperature and pressure as the alternate 
conditions. If the pressure is not measured at the 
station header, then the pressure parameter is 
undefined and the observed pressure is assumed to 
be at 0 psig. Similarly, if the temperature is not 
measured at the station header, then the temperature 
parameter is undefined and the temperature is 
assumed to be at the station base temperature.  

An alarm is raised if there is no Header Density Object 
assigned to the station or if the Header Density 
Object’s temperature or density is Undefined. Any 
parameter referenced via the Header Density Object 
that has no engineering unit is assumed to use the 
same engineering units as the station. If the pressure 
has no units, it is assumed to be gauge. 

Note 

This field appears only for Stations with a Fluid Type of Liquid, a 
Liquid Product Type of either Light Hydrocarbon or Crude Oil 
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Field Description 

(defined on the Liquid Product display), and one of the following 
options selected in the Crude Oil Options field: 

• API Ch. 12.2  

• API Ch. 20.1 and Use Oil Correction Factor for Water 

In Use Values These read-only fields show the density values used in the volume 
correction calculations. 

Note 

• These fields appear only for Stations with a Fluid Type of 
Liquid and a Density Option set to either Station Header 
Density or Station Base Density (Selected Density only). 

• The Header Density value is calculated as the observed 
header density (from the object you select in the Header 
Density Object field) multiplied by the density correction 
factor (configured on the Liquid Density display). 

4. Select Save to save any changes you make to this tab. 

4.16.2 Station – Batching  

Use this pop-up display to configure options related to batching, including the batch 
identifier, and batch start and end triggers. 

Note 

• This tab shows only for liquid stations with the Batch Option field set to Enable (set 
on the Station – General display). 

• There are multiple ways to start/end a batch: 

o Use the Start/End Batch buttons available on the FBxConnect™ display. 

o Write a value of 1 to the command parameters (Station_x.BATCH_START_CMD or 
Station_x.BATCH_END_CMD) from an application or from a SCADA/HMI. 

o Assign any numeric parameter using the point picker and set the value of the 
assigned parameter to a non-zero value. For example, use a push button wired to 
a DI. 

• All batch commands and trigger parameters are reset to zero after each calculation 
cycle. 
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• Only valid commands are executed. For example, you can only start a batch if it is 
currently idle and only end a batch if it is currently running. 

To access this pop-up display: 

1. Select Configure > Station from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display and select a station to configure. 

3. Select the Batching button. The Station – Batching pop-up display opens. 

Figure 223. Station – Batching 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Operation 
Status 

This read-only field shows the current state of the selected batch. 

Batch 
Identifier 

Sets an identifier (up to 20-alphanumeric characters) for the selected 
batch. The batch identifier is recorded with every batch transaction. It 
is also recorded with a period that is configured to ‘break with batch’ 
when the batch is active. 
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Field Description 

Current Batch 
Start Time 

This read-only field shows the date and time that the current batch 
was started. If the Operation Status field shows Batch Idle, then 
this field shows Not Set. 

Previous 
Batch Start 
Time 

This read-only field shows the date and time that the previous batch 
was started. This field shows Not Set until the first batch has 
completed. 

Previous 
Batch End 
Time 

This read-only field shows the date and time that the previous batch 
was ended. This field shows Not Set until the first batch has 
completed. 

Start Batch Select this button to start a batch. Click  to open a Point Picker 

dialog and select a numeric read/write parameter used by an 
external input to start a batch when the value is non-zero. 

Note 

If you select a parameter, a non-zero value is interpreted as a 
command and a zero value is interpreted as an idle state. After 
reading a non-zero value and taking the specified action (start or 
end), the FB3000 resets the command by setting the parameter back 
to 0 if the parameter selected is a R/W parameter. If you select a 
discrete input, it is recommended that the discrete input is 
configured as latched. After reading an “on” status from the discrete 
input and taking the specified action (start or end), the FB3000 sends 
a reset latch command to the discrete input. 

End Batch  Select this button to end a batch. Click  to open a Point Picker 

dialog and select a numeric read/write parameter used by an 
external input to end a batch when the value is non-zero. 

Note 

If you select a parameter, a non-zero value is interpreted as a 
command and a zero value is interpreted as an idle state. After 
reading a non-zero value and taking the specified action (start or 
end), the FB3000 resets the command by setting the parameter back 
to 0 if the parameter selected is a R/W parameter. If you select a 
discrete input, it is recommended that the discrete input is 
configured as latched. After reading an “on” status from the discrete 
input and taking the specified action (start or end), the FB3000 sends 
a reset latch command to the discrete input. 
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Field Description 

Continuous 
Batching 

Select to enable the next batch to begin as soon as the current batch 
is ended. 

5. Select Save to save any changes you make to this display. 

4.16.3 Station – Transaction History Log Options 

Use this pop-up display to configure transaction history logging options. 

Note 

This pop-up display shows only for stations on the FB3000 RTU with the Fluid Type field 
set to Liquid on the Station – General display. 

To access this pop-up display: 

1. Select Configure > Station from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display and select a station to configure. 

3. Select the Log Options button. The Station – Transaction History Log Options pop-up 
display opens. 
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Figure 224. Station – Transaction History Log Options 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Periodic Data 
Logging in 
Transaction 
History 

Sets if standard periodic history is logged along with liquid batch 
transactions. Possible options for each period (hourly, daily, weekly, 
monthly) are: 

Disable Do not log this type of periodic history in Transaction 
History. If configured, this data is logged in periodic 
history. 

Enable Log this type of periodic history in Transaction History 
based on top of hour, contract hour, contract day of 
week and/or contract day of month. Periodic data 
logging is not affected by batch start or batch end. 
Transaction history groups must be configured and 
assigned at the meter level. 
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Field Description 

 

Enable / 
Break with 
Batch 

Log this type of periodic history in Transaction history 
as described in the "Enable" option above, and also log 
when a batch starts and when a batch ends. 
Transaction history groups must be configured and 
assigned at the meter level. 

 

5. Select Save to save any changes you make to this display. 

4.16.4 Station – Advanced  

Use this pop-up display to configure advanced station options, including location of the 
station, water content of the fluid flowing through the meters, and heating value 
parameters. 

Note 

The fields shown on this display vary based on the selected fluid type. 

To access this pop-up display: 

1. Select Configure > Station from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display and select a station to configure. 
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3. Select the Advanced button. The Station – Advanced pop-up display opens. 

Figure 225. Station – Advanced (Natural Gas Station shown) 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Latitude Specifies the geographic latitude of the metering location. The units 
are in degrees and minutes, separated by a decimal point. For 
example: 46.15. 

Elevation Specifies the elevation or altitude of the metering location. The units 
are in feet or meters. 

Atmospheric 
Pressure 

Sets how the system acquires the atmospheric pressure value used 
in calculations. Possible options are: 

Override The system uses a value you define in the Override 
Atm Pressure field. 

Calculated The system calculates the atmospheric pressure 
value. 

Override Atm 
Pressure 

Sets a value to use for the atmospheric pressure in calculations 
when Override is selected in the Atmospheric Pressure field. 
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Field Description 

Calculated Atm 
Pressure 

This read-only field shows the atmospheric pressure value as 
calculated by the system using AGA3 2012. 

Selected Atm 
Pressure 

This read-only field shows the current atmospheric pressure value 
used in calculations based on the options you select. 

Local 
Gravitation 
Acceleration 
Mode 

Sets how the system acquires the local gravitation acceleration value 
used in calculations. Possible options are: 

Override The system uses a value you define in the Override 
Local Grav Acceleration field. 

Calculated The system calculates the local gravitation 
acceleration value. 

Note 

This field appears only for stations with a Fluid Type of Natural 
Gas. 

Override Local 
Grav 
Acceleration 

Sets a value to use for the local gravitation acceleration in 
calculations when Override is selected in the Local Gravitation 
Acceleration field. 

Note 

This field appears only for stations with a Fluid Type of Natural 
Gas. 

Calc Local Grav 
Acceleration 

This read-only field shows the local gravitational acceleration value 
as calculated by the system. 

Note 

This field appears only for stations with a Fluid Type of Natural 
Gas. 

Selected Local 
Grav 
Acceleration 

This read-only field shows the current local gravitational 
acceleration value used in calculations based on the selected 
options. 

Note 

This field appears only for stations with a Fluid Type of Natural 
Gas. 

Rounding 
Option 

Sets the rounding applied to volume correction factors when 
calculating totals. Possible options are: 

No 
Rounding 

No rounding is applied to volume correction factors. 
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Field Description 

Rounding 
Per API 12.2 

Rounding is applied to volume correction factors per 
API 12.2. This is the default. 

When this option is selected, rounding is used for 
the following parameters: 

• %S&W = XX.XX 

• CSW = X.XXXXX 

• CTL = X.XXXX 

• CPL = X.XXXX 

• MF = X.XXXX 

• CMF = X.XXXX 

• CCF = X.XXXX 

Note 

This field appears only for stations with a Fluid Type of Liquid. 

Water Content 
Basis 

Sets the option for assumptions about water content in the fluid. 

Dry Water content is set to 0. 

Saturated at 
Base 
Conditions 

Water content is calculated based on the fluid being 
fully saturated at base temperature and pressure. 

Partially 
Saturated 

Water content is entered by the user. 

Note 

This field appears only for stations with a Fluid Type of Natural 
Gas. 

Water 
Adjustment 
Option 

Sets the option to adjust the composition based on water content. 
Possible options are: 

No 
Adjustment 

No adjustment is made to the in-use composition of 
the meters that are assigned to this station. 

Adjust 
Composition 

Mole % water is calculated from water content and 
other component values are re-normalized to add up 
to 100% for the meters that are assigned to this 
station. 

Note 

In order for the adjustment to occur, you must also 
select Full Normalization in the Normalization 
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Field Description 

Option field on the Components – General display 
for each Components instance used by meters 
assigned to this station. 

Note 

• This field appears only for stations with a Fluid Type of Natural 
Gas. 

• This is a separate option from Water Content Basis, and you 
have option to obtain a value for water content for informational 
purposes without affecting the calculation. 

Water Content 
Calculation 

Sets the calculation standard used in water content calculations. 

Note 

This field appears only for stations with a Fluid Type of Natural 
Gas. 

Shrinkage 
Factor Option 

Selects how the shrinkage factor is applied to the flow calculation for 
all liquid meters assigned to the selected station. Possible options 
are: 

Apply to 
Gross 
Standard 
Volume 

The shrinkage factor is applied to the Gross Standard 
Volume (GSV) flow rate and totals as follows: 

GSV = GV * CTL * CPL * SF 

Since the Net Standard Volume and Sediment and 
Water Volume are calculated from the Gross 
Standard Volume, the shrinkage factor is accounted 
for in the Net Standard Volume and the Sediment 
and Water Volume is reduced.  

Apply to Net 
Standard 
Volume 

The shrinkage factor is applied to the Net Standard 
Volume (GSV) flow rate and totals as follows:  

NSV = GSV * (1 – SW / 100) * SF 

The Gross Standard Volume is not reduced by the 
shrinkage factor. 

Note 

• This field appears only for stations with a Fluid Type of Liquid, 
Liquid Product Type set to Crude Oil, and Crude Oil Options 
set to API Ch. 20.1 and Use Oil Correction Factor for Water. 
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Field Description 

This is otherwise referred to as the Allocation – Low Water use-
case. 

• Refer to Liquid Linear Meter Flow Calculations for a list of flow 
calculations used with different configurations. 

Corrected 
Volume Rate 
Alarm 

These fields show the alarm limits and statuses of the volume rate 
alarms. 

Calculation 
Failure Option 

Sets how the FB Series product responds if a calculation failure 
occurs. Possible options are: 

Alarm 
Disabled 

No alarm is logged if a calculation failure occurs. 

Alarm and 
Continue 

An alarm is logged and the calculation continues if a 
calculation failure occurs. 

Alarm and 
Halt 
Calculation 

An alarm is logged and the calculation stops if a 
calculation failure occurs. 

Note 

Refer to Calculation Failure Options for more information. 

Station 
Identifier 1 

Allows for the entry of a user specified identifier (up to 20-
alphanumeric characters) for the station. 

Note 

When generating BLM reports, this field is used to specify the lease 
number. 

Station 
Identifier 2 

Allows for the entry of a user specified identifier (up to 20-
alphanumeric characters) for the station. 

Note 

When generating BLM reports, this field is used to specify the flow 
measurement point (FMP) number. 

Custody 
Transfer Buyer 

Sets an identifier (up to 20-alphanumeric characters) for the 
purchaser of the fluid.  

Custody 
Transfer 
Seller/Producer 

Sets an identifier (up to 20-alphanumeric characters) for the seller of 
the fluid. 
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Field Description 

Fault Total 
Enable 

Place a check mark to enable the system to calculate fault totals. 
Fault totals are used to accumulate meter quantities separately from 
the normal totals when the system becomes unhealthy and 
measurement accuracy may be compromised. Fault totals are 
separate for each meter. If a fault occurs for a meter assigned to a 
station configured to calculate fault totals, fault totals are calculated 
only for that meter. Station totals include all totals - they continue to 
increment regardless of the fault status of associated meters. 

Note 

• These fields are shown only for Stations with a Fluid Type set to 
Natural Gas. 

• You configure which faults or alarms cause the system to 
become unhealthy in the Fault Health Configuration field. 

Fault Health 
Configuration 

Use these fields to determine which faults and alarms cause the 
system to become unhealthy. Each calculated station and meter 
parameter includes health (data quality) information (as seen on 
History Reports). Changes to these options determine if the 
parameter health takes into account the selected item.  

Note 

These fields are shown only for Stations with a Fluid Type set to 
Natural Gas. 

Primary 
Inputs - 
Fault 

Place a check mark to include primary meter input 
parameter faults when determining health. Examples 
of primary input faults include a point fail on a meter 
input (for example, differential pressure, indicated 
flow, static pressure, or flowing temperature) or a 
point fail on optional meter input alarm that is used 
in flow calculations (for example, measured relative 
density, measured base density, measured flowing 
density, measured heating value, etc.). 
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Field Description 

Primary 
Inputs - 
Alarm 

Place a check mark to include primary meter input 
parameter alarms when determining health. 
Examples of primary input alarms include Low, High 
High, or Rate of Change alarms on a meter input (for 
example, differential pressure, indicated flow, static 
pressure, or flowing temperature) or optional meter 
input alarm that is used in flow calculations (for 
example, measured relative density, measured base 
density, measured flowing density, measured 
heating value, etc.). 

Primary 
Inputs - 
Override 

Place a check mark to include primary input override 
conditions when determining health. Examples 
include a meter input (for example, differential 
pressure, indicated flow, static pressure, or flowing 
temperature) or optional meter input alarm that is 
used in flow calculations (for example, measured 
relative density, measured base density, measured 
flowing density, measured heating value, etc.) with a 
value currently in override. 

Calculation 
Alarms 

Place a check mark to include flow and property 
calculation alarms when determining health. For 
more information, refer to DP Meter Diagnostics - 
Calculation Alarms Tab and Linear Meter Diagnostics 
- Calculation Alarms Tab. 

Flow Rate 
Alarms 

Place a check mark to include flow rate calculation 
alarms when determining the health. The flow rate 
alarms that can have an effect on the health of the 
totals are limited to uncorrected volume, corrected 
volume, and mass. For more information, refer to DP 
Meter Diagnostics - Calculation Alarms Tab and 
Linear Meter Diagnostics - Calculation Alarms Tab. 

5. Select Save to save any changes you make to this tab. 
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4.16.4.1 Calculation Failure Options 

You can set how the FB Series product responds if a calculation failure occurs on the 
Station – Advanced display. Note that alarms indicating a system integrity failure (e.g., 
firmware corruption or hardware failure) are always logged if detected. Meter inputs are 
always checked, and the meter status (as shown in the Status field on the DP Meter – 
General, Linear Meter – General, and Liquid Linear Meter – General displays) and meter 
runs parameter health attribute will indicate failure if an invalid configuration or 
physically impossible value is detected, but the system only logs alarms for these 
conditions based on the selection below. Possible calculation failure options are:  

• Alarm Disabled – Do not log alarms and continue the calculation when parameters 
are outside of the published calculation limits, if possible. Use this option if you need 
to use flow or property calculations outside of their published limits. 

• Alarm and Continue – Log alarms and continue the calculation when parameters are 
outside of the published calculation limits, if possible. Use this option if you need to 
be notified if a calculation is operating outside of the calculation limits. 

• Alarm and Halt – Log alarms and stop the calculation when parameters are outside 
of the published calculation limits. Use this option if you need the flow or property 
calculation to strictly function within their published limits and need all alarms to 
logged. 

The behavior of FB Series products is determined by which calculation failure option you 
select. Refer to the table below for more information: 

Table 39. Calculation Failure Option Behaviors 

Behavior Alarm 
Disabled 

Alarm and 
Continue 

Alarm and 
Halt 

Raise alarm when inputs are outside of 
published ranges 

  X X 

Halt when inputs are outside of 
published ranges 

    X 

Raise alarm if intermediate calculation 
results are outside of published ranges 

  X X 

Halt if intermediate calculation results 
are outside of published ranges 

    X 

Raise alarm on fatal calculation error   X X 

Halt on fatal calculation error X X X 
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Behavior Alarm 
Disabled 

Alarm and 
Continue 

Alarm and 
Halt 

Raise alarm if a secondary rate 
calculation fails 

  X X 

On a property calculation failure, set 
calculated property values to predefined 
defaults & attempt to continue 
calculating flow 

X X   

On a property calculation failure, set 
calculated property values to 0 

    X 

Note 

• Examples of physically impossible inputs: negative density, heating value or 
absolute pressure. Temperature less than absolute zero. 

• Example of an invalid configuration: a temperature value assigned to a differential 
pressure. 

• Examples of intermediate results: Reynolds number, beta. 

• Examples of fatal errors: divide by zero, square root of negative number. 

• Examples of primary rates: ISO 5167 mass rate, Coriolis mass rate, Turbine volume 
rate. 

• A secondary rate is a rate derived from the primary rate. For example, turbine mass 
rates is calculated from volume and density. 

• Example of a property calculation failure: cannot calculate because composition is 
invalid. 

• Predefined default property values are based on methane.  

• If a calculation halts, its results are set to 0 and the parameter fault bit is set. 

• If a calculation continues, the results are written to the database with the 
parameter alarm bit set. 

• Flow and properties calculated outside of the range of their respective standards 
must be treated with caution; the results may be inaccurate and may affect overall 
measurement uncertainty of the flow calculations. 
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4.16.5 Station – Rates & Totals 

Use this pop-up display to view totals and accumulations for the selected station. Station 
rates and totals are calculated based on the differential pressure, gas linear, and liquid 
linear meters assigned to the station.  

Note 

• The fields shown on this display vary based on the selected fluid type and calculation 
options.  

• Stations do not keep flow rates or totals for liquid linear meters configured to use API 
Ch. 20.1 flow calculation methodology. For meters configured to use API Ch. 20.1, 
totals are available on the Liquid Linear Meter - Rates & Totals display. 

To access this pop-up display: 

1. Select Configure > Station from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display and select a station to configure. 

3. Select the Rates & Totals button. The Station – Rates & Totals pop-up display opens. 

Figure 226. Station – Rates & Totals (Natural Gas Station shown) 
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4. Review the values in the following fields: 

Field Description 

Current Flow 
Rates 

For stations measuring natural gas, these read-only fields show the 
current uncorrected volume, corrected volume, energy, and mass 
flow rates for the selected station. 

For stations measuring liquids, these read-only fields show the 
current gross volume, net standard volume, sediment & water 
volume, and mass flow rates.  

Current Totals These read-only fields show the total accumulation, as well as the 
current and previous hourly, daily, weekly, monthly, and batch 
accumulations for the selected station. 

Note 

Batch accumulations are shown for liquid stations only. 

 

4.17  Averages 

Use this display to configure which inputs the system uses to calculate averages and view 
the results of those calculations. For the FB3000 RTU, up to 400 inputs are averaged. 

Note 

• The average parameter health is a composite of the parameter health of every sample 
used to calculate the average. 

• Average samples of NAN or INF are ignored. 

To access this display: 

1. Select Configure > Averages from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select an Averages instance to 
configure. 
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Figure 227. Averages 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
instance. 

Input to 
Average 

Click  to open a Point Picker dialog and choose an input to sample 

for averaging calculations. 

Note 

• Averages associated with liquid linear meters are always flow-
weighted based on API 12.2.2, and periods of no flow produce 
averages of 0. 

• In order to map history correctly in reports, select the Input to 
Average by first selecting the meter, then the associated 
reference parameter for the desired input (e.g. DP 
Mtr_1.DP_OBJ.SELECTED). 
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Input to 
Weight 

Click  to open a Point Picker dialog and choose a Meter Object to 

use as the weighting factor. If the input you select in the Input to 
Average field is a meter parameter (DP Mtr, Linear Mtr, or Liq LinMtr), 
then the average will be based on the flow rate as described below 
and an Input to Weight does not need to be defined. If the input you 
select in the Input to Average field is not a meter parameter, then 
either a meter can be chosen to get an average based on the flow 
rate or left undefined to calculate a simple linear average that is not 
based on a flow rate. Only an object is chosen, and the parameter is 
determined by the system based on the type of object. Use of the 
weighting factor is determined by the Meter Averaging Method 
specified on the Meter Setup display. 

The weighting factor used is based on the configuration of the 
selected Meter Object : 

Meter Type Configuration Weighting Factor 

DP Meter 

AGA 3 Orifice (Volume) 

1595 Conditioning 
Orifice 

Cone  

Square Root of the 
Differential Pressure 

AGA 3 (Mass) 

AGA3 (Relative 
Density) 

ISO 5167 

405C 

Mass Rate 

Gas Linear 
Meter  

Turbine  

Auto-Adjust 
Indicated Quantity 
(Volume) 

Coriolis  
Indicated Quantity 
(Mass) 

Liquid Linear 
Meter  

Turbine  
Indicated Quantity 
(Volume) 

Coriolis  
Indicated Quantity 
(Mass) 
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Field Description 

Values These read-only fields show (for the selected input) the maximum, 
minimum, and average values for the current and previous hour, day, 
week, month, and batch. 

Note 
Batch averages apply to liquid meters only. 

4. Select Save to save any changes you make to this display. 

4.18 Totals Drop-Down Menu 

Use the options in the Totals drop-down menu to view meter and station totals, and to 
configure fault totals. To access these displays, select Configure > Totals from the 
FBxConnect™ main menu and select one of the options from the Totals drop-down menu. 

Figure 228. Totals Drop-Down Menu 

 

The Totals drop-down menu contains the following options: 

Totals – Use this display to view current and previous period totals associated with 
meters and stations, and to set the rollover value for each total.  

Totals Setup – Use the Totals Setup wizard to automatically configure optional fault totals 
in the FB Series device.  

4.18.1 Totals 

Use this display to view current and previous period totals associated with meters and 
stations, and to set the rollover value for each total. For the FB3000 RTU, up to 456 inputs 
are totalized. The following totals are captured: 

Station/Meter Type Totals 

Gas Station Corrected Volume 

Uncorrected Volume 

Mass 

Energy 
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Station/Meter Type Totals 

Gas DP Meter  Flow Time 

Integral Value 

Corrected Volume 

Corrected Volume Fault 

Uncorrected Volume 

Uncorrected Volume Fault 

Mass 

Mass Fault 

Energy 

Energy Fault 

Gas Linear Meter  Pulses 

Corrected Volume 

Corrected Volume Fault 

Uncorrected Volume 

Uncorrected Volume Fault 

Mass 

Mass Fault 

Energy 

Energy Fault 

Liquid Linear Meter Indicated Volume 

Gross Volume 

Oil Unshrunk Volume 

Oil Net Volume 

Water Uncorrected Volume 

Water Net Volume 

NGL Net Volume 

Flash Gas Net Volume 

 

Note 

• Totals are also provided on the Rates and Totals tab for individual gas meters, liquid 
meters, and gas stations. 
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• The total parameter health is a composite of the parameter health of every increment 
used to calculate the total. 

• When a total rolls over, a “Total rollover” event is added to the event log. The event 
indicates how many times the total rolled over. 

• If a totalization error occurs, a total/increment alarm is raised at the meter, regardless 
of the station calculation failure option.  

• You can configure up to four spare totals instances per meter with a maximum of 144 
instances. New instances of the Totals object start with Total_50001. For more 
information about spare totals, refer to the Number of Spare Totals field on the 
Meter Setup display. 

To access this display: 

1. Select Configure > Totals > Totals from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select an instance to 
configure. 

Figure 229. Totals 

 

3. Review – and change as necessary – the values in the following fields: 
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Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
instance. 

Input to 
Totalize 

This read-only field shows the input totalized by the selected 
instance. 

Current These read-only fields show the total accumulation for the current 
hour, day, week, month, and batch. 

Note  
Batch totals apply to liquid meters only. 

Previous  These read-only fields show the total accumulation for the previous 
hour, day, week, month, and batch. 

Note  
Batch totals apply to liquid meters only. 

Current 
Accumulated 
Total 

This read-only field shows the total accumulation over the life of the 
input. This value resets only on a rollover or restart to factory 
defaults. 

Rollover Value Sets the value that (when reached) the Current Accumulated Total 
resets to 0. 

Value of Input 
at Last Period 
End 

This read-only field shows the value of the Current Accumulated 
Total at the time of the last period end. 

Timestamp of 
Last Period 
End 

This read-only field shows the timestamp at the time of the last 
period end. This will typically be top of hour, but it may be different 
based on configuration changes and QTR log break options specified. 

Non-
resettable 
Rollover 
Count 

This read-only field shows the number of times a rollover has 
occurred. 

Value of Input 
at Previous 
Batch Start 

This read-only field shows the value of the selected input at the time 
that the previous batch was started. 

Value of Input 
at Previous 
Batch End 

This read-only field shows the value of the selected input at the time 
that the previous batch was ended. 
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Field Description 

Value of Input 
at Current 
Batch Start 

This read-only field shows the value of the selected input at the time 
that the current batch was started. 

4. Select Save to save any changes you make to this display. 

4.18.2 Totals Setup 

Use the Totals Setup wizard to automatically configure optional fault totals in the FB 
Series device. Fault totals are calculated when the system becomes unhealthy and can be 
used to determine how measurement quantities are affected by faults and alarms. You 
can select which fault totals are calculated and which conditions cause fault totals to 
increase, and the Totals Setup wizard automatically configures the associated Totals 
instances in the FB Series product database based on your selections.  

Note 

• You must have at least one natural gas station configured. 

• Fault totals apply to all natural gas meters that are configured in your FB Series 
product.  

• Fault totals are separate for each meter. If a fault occurs for a meter assigned to a 
station configured to calculate fault totals, fault totals are calculated only for that 
meter. Station totals include all totals. 

• Using the Totals Setup wizard overwrites existing fault totals and may cause the total 
objects assignments, descriptors, and tags to be changed. 

To access the Totals Setup wizard, select Configure > Totals > Totals Setup from the 
FBxConnect™ main menu. The first page of Totals Setup wizard opens. 
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Figure 230. Totals Setup 

 

The Totals Setup wizard contains the following steps: 

Meter Fault Totals – Use this step to select which fault totals are calculated by the FB 
Series product.  

Meter Fault Triggers – Use this step to enable fault total calculations and configure which 
parameter faults and alarms are considered when determining the health of a meter. 

Summary – Use this step to review which instances of the Totals object will log fault totals 
before applying any changes to your FB Series product. 
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Finish – Use this step to review the configuration changes performed by the Totals Setup 
wizard.  

4.18.2.1 Totals Setup – Meter Fault Totals 

Use this step of the Totals Setup wizard to select which fault totals are calculated by the 
FB Series product. Fault Totals apply to all natural gas meters. This means if you have two 
natural gas meters configured in the FB Series product and select only one fault total type 
to calculate, then two instances of the Totals object in the FB Series product database will 
be configured to log fault totals (as shown in the Number of Fault Totals field). 

Figure 231. Totals Setup – Meter Fault Totals 
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1. Review – and change as necessary – the values in the following fields: 

Field Description 

Uncorrected 
Volume 

Place a check mark to calculate uncorrected volume fault totals for all 
natural gas meters. 

Corrected 
Volume 

Place a check mark to calculate corrected volume fault totals for all 
natural gas meters. 

Mass Place a check mark to calculate mass fault totals for all natural gas 
meters. 

Energy Place a check mark to calculate energy fault totals for all natural gas 
meters. 

Number of 
Fault Totals 

This read-only field shows the number fault totals that will be 
configured based on the selected fault totals and the number of 
natural gas meters. 

2. Select Next to advance to the next step in the Totals Setup wizard. 

4.18.2.2 Totals Setup – Meter Fault Triggers 

Use this step of the Totals Setup wizard to enable fault total calculations and configure 
which parameter faults and alarms are considered when determining the health of a 
meter. 
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Figure 232. Totals Setup – Meter Fault Triggers 

 

1. Review – and change as necessary – the values in the following fields: 
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Field Description 

Fault Total 
Enable 

Place a check mark to enable the system to calculate fault totals. Fault 
totals are calculated when the system becomes unhealthy and can be 
used to determine how measurement quantities are affected by faults 
and alarms. Fault totals are separate for each meter. If a fault occurs 
for a meter assigned to a station configured to calculate fault totals, 
fault totals are calculated only for that meter. Station totals include all 
totals. 

Note 

You configure which faults or alarms cause the system to become 
unhealthy using the fields below. 

Primary 
Inputs - 
Fault 

Place a check mark to include primary meter input parameter faults 
when determining health. Examples of primary input faults include a 
point fail on a meter input (for example, differential pressure, indicated 
flow, static pressure, or flowing temperature) or a point fail on optional 
meter input alarm that is used in flow calculations (for example, 
measured relative density, measured base density, measured flowing 
density, measured heating value, etc.). 

Primary 
Inputs - 
Alarm 

Place a check mark to include primary meter input parameter alarms 
when determining health. Examples of primary input alarms include 
Low, High High, or Rate of Change alarms on a meter input (for 
example, differential pressure, indicated flow, static pressure, or 
flowing temperature) or optional meter input alarm that is used in flow 
calculations (for example, measured relative density, measured base 
density, measured flowing density, measured heating value, etc.). 

Primary 
Inputs - 
Override 

Place a check mark to include primary input override conditions when 
determining health. Examples include a meter input (for example, 
differential pressure, indicated flow, static pressure, or flowing 
temperature) or optional meter input alarm that is used in flow 
calculations (for example, measured relative density, measured base 
density, measured flowing density, measured heating value, etc.) with a 
value currently in override. 

Calculation 
Alarms 

Place a check mark to include flow and property calculation alarms 
when determining health. For more information, refer to Gas DP Meter 
Diagnostic – Calculation Alarms Tab and Gas Linear Meter Diagnostics – 
Calculation Alarms Tab. 
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Field Description 

Flow Rate 
Alarms 

Place a check mark to include flow rate calculation alarms when 
determining the health. The flow rate alarms that can affect the health 
of the totals are limited to uncorrected volume, corrected volume, and 
mass. For more information, refer to Gas DP Meter Diagnostic – 
Calculation Alarms Tab and Gas Linear Meter Diagnostics – Calculation 
Alarms Tab. 

2. Select Next to advance to the next step in the Totals Setup wizard. 

4.18.2.3 Totals Setup – Summary 

Use this step of the Totals Setup wizard to review which instances of the Totals object will 
be configured to log fault totals before applying the changes to your FB Series product. 

Note 

Information for Gas DP and Gas Linear Meters is contained in separate drop-down boxes. 
To view information each meter type, select the down arrow ( ) next to each meter 
type. 
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Figure 233. Totals Setup – Summary 

 

1. Select Next to advance to the next step in the Totals Setup wizard. A confirmation 
message opens. 

Figure 234. Fault Totals Setup Confirmation 
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2. Select Yes to save your fault totals configuration. 

4.18.2.4 Totals Setup – Finish 

Use this step of the Totals Setup wizard to review the configuration changes performed 
by the wizard based on your selections. Select Finish to exit Totals Setup wizard. 

Figure 235. Totals Setup – Finish 
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4.19 Gas Chromatograph 

Use the Gas Chromatograph display to configure gas chromatograph options, and to view 
data from each configured gas chromatograph. 

To access this display, select Configure > GC from the FBxConnect™ main menu. 

Figure 236. Configure – GC 

 

The Gas Chromatograph display contains the following tabs: 

Last Poll – Use this tab to view the mole percentage values of each component and other 
fluid properties returned from the gas chromatograph, set limits, and view alarms related 
to the gas composition. 

Configuration – Use this tab to configure the parameters required to communicate with 
the connected gas chromatographs. 

4.19.1 Gas Chromatograph – Last Poll Tab 

 Use this tab to view the mole percentage values of each component and other fluid 
properties returned from the gas chromatograph, set limits, and view alarms related to 
the gas composition. 

To access this display: 

1. Select Configure > GC from the FBxConnect™ main menu. The Gas Chromatograph 
display opens showing the Last Poll tab. 

2. Click ▼ in the drop-down list at the top of the display to select an instance to 
configure. 
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Figure 237. Gas Chromatograph – Last Poll Tab 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Current 
Stream 
Number 

This read-only field shows the current cycle stream number of the gas 
chromatograph. 

Note  
This field appears only if you select American in the Chromatograph 
Settings field on the General tab of the GC Config display (Gas 
Chromatograph – Configuration Tab). 

Calibration 
Flag 

This read-only field shows the gas chromatograph’s status. Possible 
statuses are Analysis or Self Calibration. 

Note  
The FB Series product does not copy gas analysis data if the Calibration 
Flag is set to Self Calibration. 

Last Poll 
Time 

This read-only field shows the time and date of the last time the system 
polled the external gas chromatograph. 

Stream 
Data 

Use these fields to view data from the most recent analysis returned 
from the gas chromatograph.  
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Field Description 

Dry Superior 
Heating Value 

This read-only field shows the last dry superior 
heating value calculated and returned from the gas 
chromatograph. 

Saturated 
Superior 
Heating Value 

This read-only field shows the last saturated superior 
heating value calculated and returned from the gas 
chromatograph.  

Relative 
Density 

This read-only field shows the last relative density 
(specific gravity) calculated and returned from the gas 
chromatograph. 

Wobbe Index This read-only field shows the last Wobbe Index value 
calculated and returned from the gas chromatograph.  

Unnormalized 
Sum 

This read-only field shows the total un-normalized 
mole percent returned from gas chromatograph. 

Compressibility This read-only field shows the compressibility 
returned from gas chromatograph. 

Diagnostics Use these fields to view alarms returned by the gas chromatograph. 

Sample Minute 
of Last Analysis 

This read-only field shows the sample minute at the 
start of the Modbus requests. The current sample 
minute must be different than the previous sample 
minute or the program does not copy gas analysis 
data to the station. 

Note  
This field appears only when the Chromatograph 
Settings field is set to American (Gas Chromatograph 
– Configuration Tab). 

Alarm 1 Code This read-only field shows the current alarm 1 status 
returned by the gas chromatograph. 

Alarm 2 Code This read-only field shows the current alarm 2 status 
returned by the gas chromatograph. 

Last 
Analysis 
Data 

These read-only fields show the raw data returned from the gas 
chromatograph. 

Component Sequence number to show number of components 
returned from gas chromatograph. 
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Field Description 

Code The component ID’s of different composition values 
read from the gas chromatograph. 

Raw Value (%) Mole % of components read from the gas 
chromatograph. 

GC Data & 
Diagnostics 

Use the fields in this drop down box to set the stream number, heating 
value limits, relative density limits, and to view the Wobbe Index, 
normalized sum, un-normalized sum, and active alarms for a specified 
stream. A separate tab exists for each configured GC stream. 

Note 
Select the GC Data & Diagnostics heading to expand this section of the 
display. 

Dry Superior 
Heating Value 

This read-only field shows the last dry superior 
heating value calculated and returned from the gas 
chromatograph. 

High Dry 
Superior 
Heating Value 

Sets the dry superior heating value high limit. If the 
value returned from the gas chromatograph is 
greater than this value, then a Composition Validation 
alarm is triggered. 

Low Dry 
Superior 
Heating Value 

Sets the dry superior heating value low limit. If the 
value returned from the gas chromatograph is less 
than this value, then a Composition Validation alarm 
is triggered. 

Saturated 
Superior 
Heating Value 

This read-only field shows the last saturated superior 
heating value calculated and returned from the gas 
chromatograph. 

High Saturated 
Superior 
Heating Value 

Sets the saturated superior heating value high limit. If 
the value returned from the gas chromatograph is 
greater than this value, then a Composition Validation 
alarm is triggered. 

Low Saturated 
Superior 
Heating Value 

Sets the saturated superior heating value low limit. If 
the value returned from the gas chromatograph is 
less than this value, then a Composition Validation 
alarm is triggered. 

Wobbe Index This read-only field shows the last Wobbe Index value 
calculated and returned from the gas chromatograph. 
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Field Description 

Unnormalized 
Sum 

This read-only field shows the total un-normalized 
component mole percent returned from gas 
chromatograph. If the un-normalized component 
sum returned from gas chromatograph exceeds the 
Unnormalized Deviation Limit set in the GC Values & 
Limits drop down box, then a Composition Validation 
alarm is triggered. 

Normalized 
Component 
Sum 

This read-only field shows the normalized component 
sum as calculated by the FB Series product based on 
the values returned from the gas chromatograph. If 
the normalized component sum returned from gas 
chromatograph exceeds the Component Sum 
Deviation Limit set in the GC Values & Limits, then a 
Composition Validation alarm is triggered. 

Stream 
Number 

Sets the stream number from which to retrieve data.  

Relative 
Density 

This read-only field shows the last specific 
gravity/relative density calculated and returned from 
the GC.  

High Relative 
Density 

Sets the relative density high limit. If the value 
returned from the gas chromatograph is greater than 
this value, then a Composition Validation alarm is 
triggered. 

Low Relative 
Density 

Sets the relative density low limit. If the value 
returned from the gas chromatograph is less than 
this value, then a Composition Validation alarm is 
triggered. 

Alarm 1 Code This read-only field shows the status of Alarm 1 
register returned from the GC for the selected 
stream. If an Alarm 1 condition is present and 
enabled in the GC Data & Diagnostics drop down 
box, then a Composition Validation alarm is triggered. 
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Field Description 

Alarm 2 Code This read-only field shows the status of Alarm 2 
register returned from the GC for the selected 
stream. If an Alarm 2 condition is present and 
enabled in the GC Data & Diagnostics drop down 
box, then a Composition Validation alarm is triggered. 

Composition 
Validation 
Alarm 

This read-only field shows the status of the 
Composition Validation alarm. If the Composition 
Validation alarm is Normal, the FB Series product 
accepts the gas chromatograph data and copies the 
gas composition to the Components object for use in 
fluid property calculations. If the Composition 
Validation alarm is any value other than Normal, the 
Components object is not updated. Possible values 
are: 

• Normal 

• Component Limit Alarm 

• Heating Value Limit Alarm 

• Relative Density Limit Alarm 

• Un-normalized Mole Sum Alarm 

• Total Mole Sum Alarm 

• Composition Deviation Alarm 

• Alarm 1 

• Alarm 2 

GC Values 
& Limits 

Use the fields in this drop down box to view the mole percentage values 
of each component, and to set the high component, low component, and 
deviation limits. A separate tab exists for each configured GC stream. 

Note 
Select the GC Values & Limits heading to expand this section of the 
display. 

Component 
Name 

This read-only field shows the name of the 
component. 

Code This read-only field shows the code used by the gas 
chromatograph for this component. 
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Field Description 

Updated This read-only field shows the update status for each 
component. If the box is checked, the component 
value is updated by the GC. If the box is unchecked, 
the component value is not part of the GC analysis.  

Value This read-only field shows the mole percentage value 
returned from gas chromatograph. 

High Limit Sets mole percentage value high limit. If the value 
returned from the gas chromatograph is greater than 
this value, then a Composition Validation alarm is 
triggered. 

Low Limit Sets mole percentage value low limit. If the value 
returned from the gas chromatograph is less than 
this value, then a Composition Validation alarm is 
triggered. 

Component 
Deviation 
Alarm Limit % 
of % 

Sets the allowable deviation of an individual 
component's mole percentage compared to the 
previous analysis (in percent). If the value of one of 
the components changes by more than this 
percentage from one analysis to the next, then a 
Composition Validation alarm is triggered. 

4. Select Save to save any changes you make to this tab. 

4.19.2 Gas Chromatograph – Configuration Tab 
 Use this tab to configure the parameters required to communicate with the connected 
gas chromatographs. 

To access this tab: 

1. Select Configure > GC from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list and select an instance to configure. 

3. Select the Last Poll tab on the Gas Chromatograph display. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

630 

Figure 238. Gas Chromatograph – Configuration Tab 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Chromat 
Type 

Specifies either the American or 
European version of the SIM-
2251 Modbus map and polling 
sequences. 

Polling Enables or disables polling of the gas chromatograph. 

Polling 
Interval 

Sets the delay (in seconds) the system waits before 
asking the gas chromatograph for the next set of 
results. 

GC Polling 
Alarm 

This read-only field shows the status of the poll result. 
Possible alarms are: 

• Normal 

• Poll Failed 

• Comp Code Match Error 

• Poll Disabled 

• Auto-config Fail 
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Field Description 

Component 
Codes 

Enter the identification code for each component being measured by 
the gas chromatograph. 

Note  
The codes you enter must match the codes set in the gas 
chromatograph. 

Heavy Gas 
Settings 

Use these fields to configure heavy gas options for your gas 
chromatograph. 

Split based 
on code 

If enabled, the system reads the gas chromatograph's 
automatic split percentage for heavy gasses.  

Enabled Enables the gas chromatograph's 
automatic split percentage for heavy 
gasses. The received mole percent value 
split takes place based on the 
component code: 

Component 
Code 
(American / 
European) 

C6% C7% C8% 

08 / 108 47.466 35.34 17.194 

09 / 109 50 50 0 

10/ 110 60 30 10 

11 / 111 57.143 28.572 14.285 
 

Disabled Disables the gas chromatograph's 
automatic split percentage for heavy 
gasses. The received mole percent value 
split takes place based on the 
percentages you configure in the Heavy 
Gas Settings fields. 
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Field Description 

Hexane Plus 
Split 

Select for chromatographs that return a component 
that is a composite of hexane and heavier 
components. Enter the percentages that should be 
allocated from the composite to hexane, heptane, 
octane, nonane, and decane. 

Note 
The values you enter in the Heavy Gas % fields must 
add up to 100%.  

Heptane 
Plus Split 

Select for chromatographs that return a component 
that is a composite of heptane and heavier 
components. Enter the percentages that should be 
allocated from the composite to heptane, octane, 
nonane, and decane.  

Note  
The values you enter in the Heavy Gas % fields must 
add up to 100%.  

Octane Plus 
Split 

Select for chromatographs that return a component 
that is a composite of octane and heavier components. 
Enter the percentages that should be allocated from 
the composite to octane, nonane, and decane.  

Note  
The values you enter in the Heavy Gas % fields must 
add up to 100%.  

Nonane Plus 
Split 

Select for chromatographs that return a component 
that is a composite of nonane and heavier 
components. Enter the percentages that should be 
allocated from the composite to nonane and decane.  

Note  
The values you enter in the Heavy Gas % fields must 
add up to 100%. 

Auto 
Configure 

Use these fields to configure parameters for communicating to your 
GC. 
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Field Description 

Comm Port 
to GC 

Select  to open a Point Picker dialog and define 

which communications port on the FB Series product 
is connected to the gas chromatograph. After you 
have selected a communications port, select Save to 
view additional options. 

Note  

• You must select Save after you configure the 
Comm Port to GC field to view additional options. 

• Select  to open the configuration page for the 

selected port. 

GC Device 
Address 

Indicates the Modbus address the FB Series product 
uses to communicate with the gas chromatograph. 
You must set this value before the program can poll 
data and write it to the meter run. 

Note  
You must select Save after you configure the Comm 
Port to GC field to view this field. 

GC Server IP 
Address 

Specifies the IP address and port number of the GC. 

Note 

• This field applies only to GC connections using the 
Ethernet port. 

• You must select Save after you configure the 
Comm Port to GC field to view this field. 

Modbus 
polling 
timeout 

Sets the length of time (in seconds) the system waits 
for the GC to respond to a Modbus poll. 

Note  
You must select Save after you configure the Comm 
Port to GC field to view this field. 

Number of 
Modbus 
polling 
retries 

Sets the number of retries the FB Series product 
makes without a response from the gas 
chromatograph before cancelling the polling request. 

Note  
You must select Save after you configure the Comm 
Port to GC field to view this field. 
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Field Description 

Maptable 
number 

Identifies the number of the Modbus Map Register 
Table in the FB Series product where the gas 
chromatograph data is stored. Valid values are 1–11. 

Note 

• You must select Save after you configure the 
Comm Port to GC field to view this field. 

• The program uses this value for automatic 
configuration. 

• Verify the table does not contain any vital 
information before polling the gas 
chromatograph. Any information contained in the 
configured Modbus Map Table Register will be 
overwritten during gas chromatograph polling. 

Auto 
Configure 

Select this button to automatically configure the 
communication ports and Modbus parameters 
necessary to poll the gas chromatograph. The port 
owner is automatically changed to Modbus Master for 
selected communications port. For a list of the 
parameters automatically configured when you select 
the Auto Configure button, refer to Automatically 
Configured Parameters. 

Note  

• This option is not available if you have previously 
selected Use CSV Files in the Modbus Mapping 
using CSV Files field on the Communications – 
Modbus Slave or  Communications – Modbus 
Master pop-up display for any of the 
communications ports. To enable the Auto 
Configure button, set the Modbus Mapping using 
CSV Files field to Database Objects and save your 
changes. 

• You must select Save after you configure the 
Comm Port to GC field to view this field. 

• You must first specify an address in the GC 
Modbus Address field, select Disabled in the 
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Field Description 
Polling field, and Save your changes before 
selecting the Auto Configure button. 

Alarm 1 
Check 

Place a check mark next to an Alarm 1 Condition to prevent the FB 
Series product from updating the gas composition if that alarm 
condition is active. 

Note  
The FB Series product updates the gas composition if an alarm 
condition is unchecked and that alarm condition is active. 

Alarm 2 
Check 

Place a check mark next to an Alarm 2 Condition to prevent the FB 
Series product from updating the gas composition if that alarm 
condition is active. 

Note  
The FB Series product updates the gas composition if an alarm 
condition is unchecked and that alarm condition is active. 

5. Select Save to save any changes you make to this tab. 

4.19.3 Automatically Configured Parameters 

When you select Auto Configure on the GC display, the automatically configures the 
following parameters: 

Port Settings (Serial ports only) 

If you select a serial communications port in the Comm Port to GC field, the system 
automatically configures the following port settings: 

Note 

If you select an Ethernet communications port in the Comm Port to GC field, no port 
settings are automatically configured. 

 

Serial Port Settings  
 

Port Owner Modbus Master 

Baud Rate  19,200 

Data Bits  8 

Stop Bits 1 
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Serial Port Settings  
 

Parity  None 

Key-on Delay  0.0 seconds 

Key-off Delay  0.0 seconds 

 

Master Modbus Settings 

The system automatically configures the following Master Modbus settings: 

Master Modbus Settings  

Modbus Transmission Mode RTU 

Byte Order MSB 

Continuous Polling Disabled 

Note 

Do not edit the Starting Request Number and Number of Requests fields on the 
Master Modbus tab for the selected communications port as they are used by the polling 
algorithm. Each row in the poll table is requested separately, and the number of request 
is always 1.  

Master Modbus Poll Table Register 

The system automatically configures the following Master Modbus Poll Table Registers 
(using the values in the Comm Port to GC and GC Device Address fields to poll the 
following register in the GC: 

Table 40.Master Modbus Poll Table Register 

Register Number Configuration 

3001–3016 Component IDs, Table 1: 

3017–3032 Component IDs, Table 2 

3034 Current Stream 

3035 Mask of Streams 
associated with Table 1 

3045 Cycle Start Time – minutes 

3046 GC Alarm 1 

3047 GC Alarm 2 
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Register Number Configuration 

3059 Calibration/Analysis Flag 

7001–7016 Gas Composition Values 
Mole % Comp 1–16 

7033 BTU (day) 

7034 BTU (saturated) 

  

7035 Specific Gravity 

7036 Compressibility  

7037 Wobbe Index 

7038 Total Unnormalized Mole 
% 

7039  Total GPM CF 

 

GC Poll Sequence 

The actual poll sequence is: 

Table 41.GC Poll Sequence 

GC Poll Sequence 

3045–3047 

3001–3032 

3034–3035 

3059 

7001–7016 

7033–7038 

3045–3047 

 

Modbus Map Table Registers 

The Modbus Map Table Registers assign parameters to registers. The system 
automatically maps the necessary parameters to the register table you specify in the 
Maptable number field on the GC Config display. 
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4.20  Alarms 

Use the Alarms screen to configure the alarms in your device. Alarm 1 through 35, and 
Alarm 46 and 47 are pre-configured to alarm a specific parameter. Alarm 36 through 
Alarm 45 are user alarms, and they can be configured to alarm any parameter of your 
choice. You can configure the parameter to alarm, alarm limits, alarm deadband, and rate 
of change alarming for each parameter. 

To access this screen: 

1. Select Configure > Alarms from the FBxConnect™ main menu. 

2. Click ▼ in the alarm drop-down list to select an instance to configure. 

Figure 239. Alarms 
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3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Set an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Alarm 
Description 

Set a description (up to 20-alphanumeric characters) for the selected 
instance. 

Current Value This read-only field shows the current value of the selected point in 
the Value to Alarm field. 

Value to 
Alarm 

Displays the point currently being monitored by the system. Click  

to open a Point Picker dialog and select a parameter for the alarm to 
monitor. 

Note 

Instance 1 through 35 are preconfigured. You can configure instance 
36 through 45 to monitor any point available in the device. 

Composite 
Alarm Status 

This read-only field shows the current active alarms for the selected 
point in the Value to Alarm field. The Composite Alarm Status is 
Normal if there are no active alarms. Possible composite alarm 
statuses are Normal, Low, Low Low, High, High High, Rate of Change 
and Point Fail. 

Limits Use this section to configure the alarm limits for the selected input. 
You can configure a High High, High, Low, and Low Low alarm limit. 

Enable Select Enable to allow the system to monitor the point 
for the specified alarm limit. Select Disable to make 
the system ignore the specified alarm limit. 

Limit Sets a limit value (in engineering units) to which the 
input must rise (High High and High) or fall (Low and 
Low Low) to generate an alarm. 

Status This read-only field shows the current state specified 
limit. Possible statuses are Disabled, Normal, and 
Alarm. 
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Field Description 

Alarm 
Deadband 

Sets the value (in engineering units) that is an inactive 
zone above the low alarm and below the high alarm. 
The purpose of the Alarm Deadband is to prevent the 
alarm from being set and cleared continuously when 
the input value is oscillating around the alarm limit. 
This also prevents the Alarm Log from being over-
filled with data. 

Rate of 
Change 

Use this section to configure alarming based on the speed of 
variability in the value of the alarm input. 

Enable Click ▼ to configure the input value changes which 
trigger an alarm. Possible values are Disabled, Alarm 
on Positive Changes, Alarm on Negative Changes, and 
Alarm on Both. 

Limit Sets a limit value (in engineering units) to which the 
input must rise or fall during the configured time 
period to generate an alarm. 

Status This read-only field shows the current state Rate of 
Change alarm. 

Time Period Sets the time duration (in seconds) that the system 
uses to determine the Rate of Change for an input. 

4. Select Save to save any changes you make to this screen. 

4.21  History 

Use the History displays to allocate the number of history points in each history group, 
and to configure the parameters to be archived in each group. For more information 
about the structure of history stored in the FB Series products, refer to History Overview. 

To access these displays, select Configure > History from the FBxConnect™ main menu 
and select one of the options from the History drop-down menu. 

Figure 240. History Drop-Down Menu 
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The History drop-down menu contains the following options: 

Periodic History – Use this option to configure history points for each periodic history 
group in your FB Series product. You can also use this display to import or export your 
history configuration to a CSV file. 

Transaction History Group Configuration – Use this option to configure history points for 
each transaction history group in your FB Series product. You can also use this display to 
import or export your transaction history configuration to a CSV file. 

Default History Setup – Use this option to configure history points in your FB Series 
product using the default history values. 

Advanced Setup – Use this option to configure the total number of history points, 
configure the number records (hourly, daily, weekly, and monthly), and allocate the 
history points among the history groups in your FB Series product.  

4.21.1 History Overview 

There are two types of history available – periodic history and transaction history. Periodic 
history is recorded based on regular intervals with each record beginning at the same 
time the previous record ends. Only numeric data can be recorded in periodic history 
groups. Transaction history is recorded based on a trigger that causes the interval to start 
and another trigger that causes the interval to stop. The next transaction may be 
triggered at the end of the previous transaction but can also be triggered by a separate 
event. Both string and numeric data can be recorded in transaction history. Before history 
can be configured for either periodic or transaction history, you must allocate the number 
of history points and the number of records required for each type of history. 

Periodic History 

Periodic history is further divided into standard history and user periodic history. 
Standard history groups provide logging at four fixed intervals: hourly, daily, weekly, and 
monthly. User periodic history groups provide logging at one user-selectable interval per 
group. 

Standard History 

There are two types of standard history groups – general history and station history. 

The FB3000 RTU supports up to 36 stations. Each station is associated with a separate 
station history group. You can adjust the number of points between any of the periodic 
history groups. For more information about history point reallocation, refer to Advanced – 
Standard History Sizing Tab. 
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General History – Contains hourly, daily, weekly and monthly history not associated with 
a meter or station. General history groups should not be used to record meter totals or 
averages calculated by the meter run. 

Station History – Contains hourly, daily, weekly and monthly history associated with the 
station and any meters assigned to the station.  

Note  

For the station history groups, Emerson recommends that you configure the inputs to 
average on the Averages display before configuring history. 

Station history groups are typically used to archive metrologically significant data from 
the meters belonging to that station. When used together with meter data (represented 
via Average and Total objects), the station history groups read the previous period values 
calculated by the meter application and log them as configured in the history points. 

Configuring station history involves selecting Average and Total objects which contain the 
meter data. For this reason, it is recommended to configure Averages first and then 
configure Station History. 

The archive type for each history point is limited by which object is selected: 

• Average, minimum, and maximum archive types can only be selected for an Average 
object. 

• Total/Difference can only be selected for a Total object.  

• Snapshot values can be selected for either type, as both Averages and Totals store a 
snapshot of the value at the last period end. 

Station history also includes the ability to archive any numeric database parameters 
alongside meter data (for example, an ambient temperature or a well casing pressure). 
When adding numeric parameters directly to the station history group, you must select 
an appropriate archive type for each history point (Average, Total / Difference, Snapshot, 
Minimum, Maximum, Integration). 

User Periodic 

There are two user periodic history groups with a fixed number of points in each group. 
10 history points are allocated to the User Periodic 1 history group, and 20 history points 
are allocated to the User Periodic 2 history group. You can configure the logging interval 
independently for each group. Regardless of the selected logging interval, User Periodic 1 
has a capacity of 4000 records and User Periodic 2 has a capacity of 500 records. User 
periodic history groups should not be used to record meter totals or averages calculated 
by the meter run. 
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Averages and Totals 

Fiscal averages and totals for audit trail purposes are calculated by the metering 
application and stored in the database. Averages and minimum/maximum values for the 
current and previous periods are stored in the Average object, and the cumulative total 
and current and previous period totals are stored in the Total object. 

Totals – Total objects are not configurable and have been pre-defined for flowtime, 
uncorrected volume, corrected volume, mass, and energy for all meter types. DP meters 
have a pre-defined total for Integral Value (IV) and Linear meters have a pre-defined total 
for raw pulses. 

Averages – The first four averages are defaulted for a single DP meter application to 
average DP Mtr_1 values of the DP input value, Flowing Pressure input value, Flowing 
Temperature input value, and Integral Multiplier Value (IMV); however, you may re-define 
these to point to other meters or other parameters as required by your application. 

The averaging method is based on the selection in Meter Setup for Meter Averaging 
Method and are either flow dependent or flow weighted, which means they must be 
associated with a meter run. This association can either be by the selection of the Input to 
Average starting with the selection of a meter (DP Mtr or Linear Mtr instance), or by 
selecting a parameter from another object and then defining the associated meter run 
through the Input to Weight. 

Note 

You can select Station, Fluid Properties, or meter run input parameters by first selecting 
the meter, then the meter parameter that references that object (Station Assignment, 
Fluid Property Reference, Differential Pressure Object, Static Pressure Object, Flowing 
Temperature Object), then a parameter from that object. 

For instance, the default configuration of Average_2 is configured as DP 
Mtr_1.PF_OBJ.SELECTED. This will average the raw I/O value from the input assigned to DP 
Mtr_1 (which might be a downstream gauge pressure value). Another option would be to 
select DP Mtr_1 (Instance1) and then the PF_INUSE parameter. This will average the 
pressure as it is used in the flow equation, so in this case converted to upstream, absolute 
pressure. 

Daylight Saving Time 

The day that Daylight Saving Time starts, 23 hourly history records are recorded. The day 
that Daylight Saving Time ends, 25 hourly records are recorded. You configure Daylight 
Saving Time on the Clock display. 
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Transaction History 

Transaction history allows you to define any parameter to be recorded as part of the 
transaction. When a transaction starts, the start time is recorded. When a transaction 
ends, the stop time is recorded and a snapshot is taken of the selected parameters. Each 
transaction history group has independent triggers to start a transaction (Start), end a 
transaction (Stop) or end a transaction and immediately start another transaction (Next). 
You can configure up to 100 transaction history groups. Each group can contain up to 650 
points with a maximum of 3100 points allowed across all transaction history groups. For 
more information about adjusting the number of transaction history groups and points, 
refer to Transaction History Sizing Tab. 

4.21.2 Periodic History Group Configuration 

Use this display to configure history points and logging options for each periodic history 
group in your FB Series product. 

To access this display: 

1. Select Configure > History > Group Configuration > Periodic History from the 
FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select a history group to 
configure. 
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Figure 241. Periodic History Group Configuration 

 

Note 

The fields available on this display change based on the type of history group you select in 
the drop-down list. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
history group. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
history group. 

History Group 
Type 

This read-only field shows the history group type currently selected 
in drop-down list at the top of the display. Possible group types are 
User Periodic, General History and Meter History. 
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Field Description 

Contract Hour Click  to set the hour at which daily, weekly, and totals rollover and 

history records are logged (for daily-based, weekly-based, or 
monthly-based reports). 

Note 
This field appears only for the General History and Meter History 
History Group Type. 

Contract Day 
of Week 

Click  to set the day of the week at which totals rollover and history 

records are logged (for weekly-based reports). 

Note 
This field appears only for the General History and Meter History 
History Group Type. 

Contract Day 
of Month 

Click  to set the day of the month at which totals rollover and 

history records are logged (for monthly-based reports). 

Note 
This field appears only for the General History and Meter History 
History Group Type. 

Station 
Assignment 

This read-only field shows which station is associated with the 

selected Meter history group. Select  to open the Station 

Configuration display and configure the station. 

Note 
This field appears only for the Meter History History Group Type. 

Number of 
History Points 

This read-only field shows the current number of history points 
allocated to the selected history group. 

User Period Sets the amount of time (in seconds) between data samples. 

Note 
This field appears only for the User Periodic History Group Type. 

Log 
References 

These fields show which logs are used for each log type (Hourly, 

Daily, Weekly, Monthly, and User Periodic). Click  to open the Logs 

display and configure logging options. 

Note 

• The Hourly, Daily, Weekly, and Monthly Log references appear 
only for the General History and Meter History History Group 
Types. 
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Field Description 

• The User Periodic Log reference appears only for the User 
Periodic History Group Type. 

History 
Options 

Enables each of the log types (Hourly, Daily, Weekly, and Monthly). 

Note 
This field appears only for the General History and Meter History 
History Group Type. 

Show History 
Points 

Click to configure which parameters are logged and their archival 
type for the selected History Group Type. For more information, refer 
to Show History Points. 

4. Select Save to save any changes you make to this display. 

4.21.2.1 Show History Points 

Use this screen to configure history points of the selected history group. 

To access this screen: 

1. For Periodic History: 
Select Configure > History > Group Configuration > Periodic History from the 
FBxConnect™ main menu. 
 
For Transaction History: 
Select Configure > History > Group Configuration > Transaction History from the 
FBxConnect™ main menu. 

Note 

You must enable Transaction History on the History Setup - Advanced display before 
you can access this display. 

2. Click ▼ in the drop-down list at the top of the screen to select a History Group to 
configure. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

648 

Figure 242. History Group Drop-Down List 

 

3. At the bottom of the screen, select Show History Points. 

Figure 243. Show History Points 

 

The History Group screen is divided into the following sections: 

• History Points – This section shows for all History Group Types. You can configure 
each history point of the selected History Group, and each point's archival type. You 
assign a parameter to a history point by dragging an entry from either the “Averages 
and Totals” section or from “Objects, Instances and Parameters” section (depending 
on the selected History Group Type) and dropping it on to a history point. 
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• Averages and Totals – This section show only for Meter History History Group Types 
based on the status of the Show All Numeric Parameters / Show Station Averages 
and Totals Only button. You can drag and drop the Averages or Totals objects onto a 
history point in the History Points section. 

• Objects, Instances, and Parameters – This section always shows for User Periodic, 
General History, and Transaction History History Group Types. This section shows 
for the Meter History History Group Type based on the status of the Show All 
Numeric Parameters / Show Station Averages and Totals Only button. You can 
drag and drop the selected Object, Instance or Parameter onto a history point in the 
History Points section. 

Figure 244. History Group (Meter History) 

 

4. Review – and change as necessary – the values in the following fields: 
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Field Description 

History Points You can configure each history point of the selected History Group, 
and each point's archival type. You assign a parameter to a history 
point by dragging an entry from either the “Averages and Totals” 
section or from “Objects, Instances and Parameters” section 
(depending on the selected History Group Type) and dropping it on to 
a history point. 

Description Enter a description of the selected parameter. 

Note 

This field is automatically populated when you select a 
parameter. Modify this field after you select a 
parameter to archive. 

Parameter Select a parameter to be archived in history. 

Archive 
Type 

Select ▼ to choose the archival type for the selected 
history point. Possible options are: 

Average Archives the average value of the 
selected parameter over the period. 
Any numeric parameter in the 
database can be selected. The values 
are simple linear averages with all 
samples included. 

Total / 
Difference 

For Meter History History Group 
Type, archives the total accumulated 
value for the selected parameter. 

For User Periodic and General 
History History Group Types, archives 
the difference between period start 
value and period end value for the 
selected parameter. 

Snapshot Archives the snapshot value of the 
selected parameter at the end of the 
period. 

Note 

For Transaction History groups, this is 
the only valid option. 
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Field Description 

Minimum Archives the minimum value of the 
selected parameter over the period.  

Maximum Archives the maximum value of the 
selected parameter over the period.  

Integration Archives the total accumulated samples 
for the selected parameter over the 
period.  

Data Type This read-only field shows the Data Type for each 
point as configured on the Transaction History 
Group Details pop-up display accessed from the 
Advanced Setup – Transaction History Sizing Tab. 

Note 

This field applies to Transaction History groups only. 

Insert Row Click to insert a row before the currently selected row. 

Delete Row Click to delete the currently selected row from the table. 

Averages and 
Totals 

Drag and drop the Averages or Totals objects onto a history point in 
the History Points section. If you select an Average object, the values 
are averaged based on the Averaging Type selected on the Meter 
Setup display. If you select a numeric parameter, you must select an 
appropriate archive type for each history point (Average, Total / 
Difference, Snapshot, Minimum, Maximum, Integration). 

Note 

This section shows only for the Meter History History Group Type 
based on the status of the Show All Numeric Parameters / Show 
Station Averages and Totals Only button. 

Objects and 
Instances / 
Parameters / 
Referenced 
Parameters 

You can drag and drop the selected Object, Instance, Parameter, or 
Referenced Parameter onto a history point in the History Points 
section. For more information, refer to Point Picker. 

Note 

This section always shows for User Periodic, General History, and 
Transaction History History Group Types. This section shows for the 
Meter History History Group Type based on the status of the Show 
All Numeric Parameters / Show Station Averages and Totals Only 
button. 
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Field Description 

Show All 
Numeric 
Parameters / 
Show Station 
Averages and 
Totals Only 

Click to switch between viewing Objects and Instances / 
Parameters / Referenced Parameters and viewing Averages and 
Totals. 

Note 

This button shows only for the Meter History and Transaction 
History History Group types. 

Import CSV Click to import a CSV file into your FB Series product that contains 
your desired history configuration. Navigate to the location of the 
saved CSV file and select Open to start the import process. For more 
information, refer to Importing a History Configuration CSV File. 

Note  

• You must configure Averages before importing a history CSV 
file. The easiest way to configure Averages is by completing the 
Default Meter History Setup. 

• The system verifies the integrity of the CSV and asks for 
confirmation before continuing if any errors are found. Any 
invalid lines in the CSV file are ignored and data currently in the 
FB Series device is maintained. 

Export CSV Click to save a CSV file to your computer that contains the current 
history configuration of your FB Series product. A Select Table dialog 
opens where you can select which history groups to include in the 
export. Click Start, select a name and location for the exported file on 
your computer, and click Save to begin the export process. For more 
information, refer to Exporting a History Configuration CSV File. 

Note  

By default, all selected data is exported into a single file. Select 
Export to individual file to have the system create individual files for 
each history group you select. 

Open Log Click to open the ImportExportLogs folder on your computer that 
contains FBxConnect™ import/export error logs. Any errors 
encountered when importing a CSV file are stored in a log in this 
folder. 

Note 

Log file name includes the date and time the log was created. 

Refresh Click to reload the table with the data stored in the FB Series product. 
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Field Description 

Save Click to save any changes you have made to the table. 

Close Click to close the current window. 

5. Select Save to save any changes you make to this screen. 

4.21.2.1.1 Importing a History Configuration CSV File 

You can import a CSV file that contains your configuration for a single history group, 
multiple history groups, or your entire history configuration for use in the FB Series 
product. 

Note 

• For more information about history in the FB Series product, refer to History. 

• You must configure Averages before importing a history CSV file. The easiest way to 
configure Averages is by completing the Default Meter History Setup. 

• For more information about creating your own history CSV file, refer to Creating a 
History Configuration CSV File. 

• For more information about exporting a CSV file that contains the FB Series product's 
current history configuration, refer to Exporting a History Configuration CSV File. 

To import a CSV file that contains your history configuration: 

1. For Periodic History: 
Select Configure > History > Group Configuration > Periodic History from the 
FBxConnect™ main menu. 

For Transaction History: 
Select Configure > History > Group Configuration > Transaction History from the 
FBxConnect™ main menu. 

Note 

You must enable Transaction History on the History Setup - Advanced display before 
you can access this display. 

2.  At the bottom of the screen, select Show History Points. The History Group pop-up 
display opens. 
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Figure 245. History Group – Import CSV 

 

3. Select the Import CSV button.  

4. Navigate to the file location of your CSV file and select Open. 

Note 

The system verifies the integrity of the CSV and asks for confirmation before continuing if 
any errors are found. If you select Import removing invalid parameters, any invalid 
lines in the CSV file are ignored and data currently in the FB Series device is maintained. 

5.  A confirmation message displays after importing the CSV. Select OK to complete the 
process. 

Figure 246. Confirmation 
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4.21.2.1.2 Exporting a History Configuration CSV File 

You can export your FB Series product's current history configuration to a CSV file saved 
on your computer. 

Note 

• For more information about history in the FB Series product, refer to History. 

• For more information about creating your own history configuration CSV file, refer to 
Creating a History Configuration CSV File. 

• For more information about importing a CSV file that contains the FB Series product's 
current history configuration, refer to Importing a History Configuration CSV File. 

To export a CSV file that contains your history configuration: 

1. For Periodic History: 
Select Configure > History > Group Configuration > Periodic History from the 
FBxConnect™ main menu. 
 
For Transaction History: 
Select Configure > History > Group Configuration > Transaction History from the 
FBxConnect™ main menu. 

Note 

You must enable Transaction History on the History Setup - Advanced display before 
you can access this display. 

2. At the bottom of the screen, select Show History Points. The History Group pop-up 
display opens. 
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Figure 247. History Group – Export CSV 

 

3. Select the Export CSV button. The Select Table pop-up display opens. 
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Figure 248. Select Table 

 

4. Place a check mark next to each table you want to export. 

Note 

By default, all selected tables are exported to a single file. If you want each selected table 
to be exported to individual files, place a check mark next to Export to individual file. 

5. Select Start. A Save csv file window opens. 
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Figure 249. Save csv file 

 

6. Navigate to a location on your computer to save your exported CSV file and select 
Save. The system exports the CSV file and displays a progress bar at the top of the 
display. 

7. A confirmation message displays after exporting the CSV file. Select OK to complete 
the process. 

Figure 250. Confirmation 

 

4.21.2.1.3 Creating a History Configuration CSV File 

You can create a history configuration file on your computer and then import the file for 
use in the FB Series product. If your history configuration contains a large amount of 
points, then it may be easier to create a CSV file on your computer than it is to configure 
history in FBxConnect™.  

Note 

• For more information about history in the FB Series product, refer to History.  
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• The History CSV must contain the format shown below. The easiest way to begin 
creating a history CSV file is to export a CSV that contains the current FB Series 
product configuration and then edit that file. For more information about exporting a 
CSV file, refer to the Exporting a History CSV File. 
Figure 251. Example Periodic History CSV Format 

 

To create a history configuration CSV file: 

1. Open a blank spreadsheet (or open your previously exported history CSV file). 

2. In row one of the spreadsheet, enter the following text: 

• Column A = Group 

• Column B = Point 

• Column C = Description 

• Column D = Parameter 

• Column E = Archive Type 

• Column F = Data Type (Transaction History only) 

3. Each additional row is used to configure a row in the history table. Enter information 
in each column according to the descriptions below: 

Column 
Heading 

Description 

Group Enter the number corresponding to the history group the for the 
selected row. 

Periodic History 

1 = User Periodic 1 

2 = User Periodic 2 

3 = General History 

4 – 39 = Station 1 History – Station 36 History 

Transaction History 

1 – 100 = Transaction History 
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Column 
Heading 

Description 

Point For Periodic History, you can adjust the number of points between any 
of the periodic history groups. For more information about standard 
history point reallocation, refer to Advanced – Standard History Sizing 
Tab.  

The FB Series product also contains two groups of user periodic history 
points. User periodic history consists of 30 fixed history points. Ten 
points are allocated to the User Periodic 1 group and 20 points are 
allocated to the User Periodic 2 group. 

For Transaction History, you can adjust the number of points with the 
following limitations: 

• A maximum of 25 string points per group. 

• A maximum of 650 string points and numeric points combined. 

Description Enter a description of the selected parameter. 

Parameter Enter a parameter from the FB Series product's database to be 
archived in history. 

Archive Type Enter a number that corresponds to the archival type for the selected 
history point. Possible options are: 

0 Average 

Archives the average value of the selected parameter over the 
period.  

1 Total / Difference  

For Meter History History Group Type, archives the total 
accumulated value for the selected parameter.  

For User Periodic and General History History Group Types, 
archives the difference between period start value and period 
end value for the selected parameter. 

2 Snapshot  

Archives the snapshot value of the selected parameter at the 
end of the period. 

Note 

For Transaction History groups, this is the only valid option. 
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Column 
Heading 

Description 

3 Minimum  

Archives the snapshot value of the selected parameter at the 
end of the period. 

4 Maximum  

Archives the maximum value of the selected parameter over the 
period.  

5 Integration  

Archives the total accumulated samples for the selected 
parameter over the period.  

Note 
This archival type is only used with User Periodic and General 
History History Group Types.  

4. Save your changes. You can now import your CSV file for use in your FB Series 
product. For more information, refer to Importing a History Configuration CSV 
File. 

Note 

Make sure to save the file with a .csv file extension. 

4.21.3 Transaction History Group Configuration 

Use this display to configure which history points are logged for each transaction history 
group in your FB Series product and to start or stop individual transactions.  

Note 

You must enable Transaction History on the History Setup – Advanced display before you 
can view this option in the FBxConnect™ main menu. 

To access this display: 

1. Select Configure > History > Group Configuration > Transaction History from the 
FBxConnect™ main menu. The Transaction History Group Configuration display 
opens. 
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2. Click ▼ in the drop-down list at the top of the display to select a transaction history 
group to configure. 

Figure 252. Transaction History Group Configuration 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected transaction history group. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected transaction history group. 
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Field Description 

Transaction 
Trigger Status 

This read-only field shows the stage of the currently selected 
transaction. Possible statuses are: 

Note 
This field does not show for transaction history groups 
configured for liquid linear meter batching.  

Not Started No transactions have been started. 

In progress The transaction is currently in process. 

Stopped The transaction is currently stopped. 

Invalid 
Trigger 

An incorrect trigger sequence has occurred. 
For example, issuing a Stop trigger before 
issuing Start trigger or issuing a Start 
trigger when a transaction is already in 
progress. 

Short Trigger A second trigger signal (Next or Stop) has 
been issued too quickly.  

Note 
A transaction must be in progress for at 
least 5 seconds before you issue a second 
trigger. At the end of the 5 second window, 
the Short Trigger status will clear and you 
must issue the command again. 

No Points 
Added 

No history points have been configured for 
the selected transaction history group. 

Transaction 
Group use 
type 

This read-only field indicates the assigned purpose for the 
transactional history group, when configured for a standard 
application use-case. When not configured for a standard 
application use-case, this field shows the default text of 
General and indicates the group is either not configured or is 
configured for a custom user-defined data set.  

Note 
You configure this value in the Application Assignment 
Group Type column on the Transaction History Group Details 
pop-up display. 
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Field Description 

Transaction 
Group use 
instance 

This read-only field indicates which instance of the 
Transaction Group use type is configured for this 
transactional history group. Where there are multiple 
instances of the same data set (for example, multiple liquid 
meters or multiple production wells), multiple transactional 
history groups may be used to organize the data. The use 
instance identifies which use type instance applies to this 
transactional history group. 

Note 
You configure this value in the Application Assignment 
Instance column on the Transaction History Group Details 
pop-up display. 

Number of 
String Points 

This read-only field shows the current number of string 
points allocated to the selected transaction history group. 

Note 
This value is configured on the Transaction History Group 
Details pop-up display accessed from the Advanced Setup – 
Transaction History Sizing Tab. 

Number of 
Numeric 
Points 

This read-only field shows the current number of numeric 
points allocated to the selected transaction history group.  

Note 
This value is configured on the Transaction History Group 
Details pop-up display accessed from the Advanced Setup – 
Transaction History Sizing Tab. 
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Field Description 

Number of 
Transaction 
Records 

This read-only field shows the current number of transaction 
records allocated to the selected transaction history group.  

Note 

• This value is configured on the Transaction History 
Group Details pop-up display accessed from the 
Advanced Setup – Transaction History Sizing Tab. 

• The FB Series product retains transaction history records 
for at least 2 hours. The FB Series product generates a 
Trigger Limit Reached alarm and declines new triggers if 
more than N/2 transaction records are recorded in one 
hour (N = number of transaction records set in this field). 
If transactions are expected to generate at a rate faster 
than N/2 in one hour, then you must increase the value of 
N to a higher number. 

Sequence 
Number Last 
Read 

Sets the last record sequence number that was retrieved from 
the selected transaction history group. 

Note 
FBxConnect™ automatically updates this field when you 
generate a transaction history report and select By last 
sequence no. in the Collection period field. For more 
information about generating transaction history reports, 
refer to Transaction History Reports. 

Latest 
Sequence 
Number  

This read-only field shows the last sequence number 
generated by the FB Series product. 

Num Of Lost 
Records 

This read-only field shows the number of records that 
occurred but were not archived in the selected transaction 
history group. 

Transaction ID Sets an identifier (up to 20-alphanumeric characters) for the 
selected transaction. 
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Field Description 

Trigger Signal Use these buttons to control transactions on your FB Series 
product. 

Note 

• These buttons are disabled for offline configurations. 

• These buttons do not show for transaction history groups 
configured for liquid linear meter batching. For more 
information about starting and stopping liquid linear 
meter batching, refer to Station – Batching.  

Start Select this button to begin a transaction. 

Note 
To issue this command via an external 
system (such as a SCADA host), write a value 
of 1 to TransHGrp_x.TRANS_TRIG_SIGNAL. 

Next Select this button to end the current 
transaction, archive a transaction record, 
and immediately start another transaction.  
Note 
To issue this command via an external 
system (such as a SCADA host), write a value 
of 2 to TransHGrp_x.TRANS_TRIG_SIGNAL. 

Stop Select this button to end the current 
transaction and archive a transaction 
record. 

Note 
To issue this command via an external 
system (such as a SCADA host), write a value 
of 3 to TransHGrp_x.TRANS_TRIG_SIGNAL. 

Snapshot Select this button to immediately archive a 
transaction record with the current values 
of the parameters configured in the 
transactional history group. 

Note 
To issue this command via an external 
system (such as a SCADA host), write a value 
of 4 to TransHGrp_x.TRANS_TRIG_SIGNAL. 
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Field Description 

Auto snapshot 
period 

Sets, in seconds, the period of time the system waits before 
automatically archiving a transaction record with the current 
values of the parameters configured in the transactional 
history group. Valid values are 0 (disabled) and 3 – 720000. 

Show History 
Points 

Click to open a pop-up display where you can configure which 
parameters are logged for the selected History Group Type. 
You can also set a description and archive type for each 
logged parameter. For more information, refer to Show 
History Points. 

Note 
This button is disabled if the string and numeric points for the 
selected transaction history group is 0 (as configured on the 
Transaction History Group Details pop-up display). For 
more information, refer to Transaction History Group Details. 

4. Select Save to save any changes you make to this display. 

4.21.4 Default Meter History Setup 

Use this display to configure history points in your FB3000 RTU using the default history 
values for all configured meters. 

Note 

• You must configure meter inputs before applying the default history setup. 

• For more information about the structure of history store in the FB Series products, 
refer to History Overview. 

• To view the default configuration, refer to Default History Configuration.  

• Emerson recommends verifying your history configuration after applying the default 
history to your FB Series product. If you run into issues with the default meter history 
setup not completing successfully, then you can create an offline solution file with 
your history configuration and download the solution file (Download Solution) to 
configure the history correctly. 
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To access this display: 

1. Select Configure > History > Default History Setup from the FBxConnect™ main 
menu. 

Figure 253. Default Meter History Setup 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Gas Meters 
Setup 

Use these fields to configure the gas meter history types that are 
archived by the FB Series product. 

Number of 
Gas Meters 

This read-only field shows the number of gas meters 
configured on the Meter Setup display for your FB Series 
product. 

Do you want to setup default history for all Gas meters? 

 No The FB Series product does not 
archive standard periodic history for 
gas meters. 

Yes The FB Series product does archive 
standard periodic history for gas 
meters. 

Do you want components to be averaged and archived? 
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Field Description 

 No The FB Series product does not 
archive component averages for gas 
meters. 

Yes – Standard 
Composition 

The FB Series product does archive 
standard composition component 
averages for gas meters. 

Yes – Extended 
Composition 

The FB Series product does archive 
extended composition (includes C7, 
C8, C9, and C10) component 
averages for gas meters. 

Enter the number of spare history points (if any) you want to setup 
per Gas Meter 

 Numeric Enter the number of additional 
numeric points that the system adds 
to the end of the standard periodic 
history configuration for each meter. 

Liquid 
Meters 
Setup 

Use these fields to configure the liquid meter history types that are 
archived by the FB Series product. 

Number of 
Liquid 
Meters 

This read-only field shows the number of liquid meters 
configured on the Meter Setup display for your FB Series 
product. 

Do you want to setup default history for all Liquid meters? 

 No The FB Series product does not archive 
standard periodic history and/or does not 
archive transaction history for liquid meters. 

Yes The FB Series product does archive standard 
periodic history and/or does archive 
transaction history for liquid meters. 

Enter the number of spare history points (if any) you want to setup 
per Liquid Meter 

 String Enter the number of additional string 
points that the system adds to the 
end of the transaction history 
configuration for each meter. 
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Field Description 

Numeric Enter the number of additional 
numeric points that the system adds 
to the end of the standard periodic 
history configuration for each meter. 

Periodic 
Data 
Logging for 
Liquid 
meters 

Sets if standard periodic history is logged along with liquid batch 
transactions.  

Note  
These fields are shown only if you have enabled Batching on the Station 
Fluid Type pop-up display. 

Do you want to log periodic data in Transaction History for Liquid 
meters? 

No The FB Series product does not archive periodic data in 
Transaction History for liquid meters. 

Yes The FB Series product does archive periodic data in 
Transaction History for liquid meters. Possible options for 
each period (hourly, daily, weekly, monthly) are: 

Disable Do not log this type of periodic history in Transaction 
History. If configured, this data is logged in periodic 
history. 

Enable Log this type of periodic history in Transaction History 
based on top of hour, contract hour, contract day of week 
and/or contract day of month. Periodic data logging is 
not affected by batch start or batch end. Transaction 
history groups must be configured and assigned at the 
meter level. 
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Field Description 

Enable / 
Break with 

Batch 

Log this type of periodic history in Transaction history as 
described in the "Enable" option above, and also log 
when a batch starts and when a batch ends. Transaction 
history groups must be configured and assigned at the 
meter level. 

 

 Do you want to log periodic data in Standard Periodic History for 
Liquid meters? 

No The FB Series product does not archive periodic data in 
standard periodic history for liquid meters. 

Yes The FB Series product does archive periodic data in 
standard periodic history for liquid meters. 

Standard 
Periodic 
History 

Use these fields to view and adjust the amount of history points used by 
standard periodic history. 

Station 
History 

These read-only fields show the number of standard 
history points used by the FB Series product at the 
present time (Current) and after applying the default 
history setup (Post Setup) based on your current 
selections. 
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Field Description 

General 
History 

These fields show the number of general history points 
used by the FB Series product at the present time 
(Current) and after applying the default history setup 
(Post Setup) based on your current 

selections. 

Note  
Enter a value in the Post Setup column to manually 
adjust the total number of points allocated to standard 
periodic history. 

Total These read-only fields show the total number of history 
points used by the FB Series product at the present time 
(Current) and after applying the default history setup 
(Post Setup) based on your current selections. 

Transaction 
History 

Use these fields to view the number of string points, numeric points, and 
total points used by transaction history. 

Note 

When applying the default history for the first time, the system 
configures contiguous transaction history group instances for Liquid 
Batching. The system configures these groups after and does not 
overwrite any history groups set to a specific application (other than 
General) in the Application Assignment field on the Transaction History 
Group Details display. 

If you apply the default history more than once, the system reconfigures 
the transaction history groups previously set to Liquid Batching. If you 
add new liquid meters and apply the default history, the system first 
reconfigures transaction history groups previously set to Liquid Batching 
before adding additional history groups. 
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Field Description 

String 
Points 

These read-only fields show the number of string points, 
used by transaction history. The value in the Current 
column shows the total number of string points used by 
all transaction history groups at the present time. The 
value in the Post Setup column shows the total number 
of string points that will be used by all transaction history 
groups after applying the default history, and this value 
changes based on your selections in the Set Default 
Meter History and Transaction History fields. 

Numeric 
Points 

These read-only fields show the number of numeric 
points used by transaction history. The value in the 
Current column shows the total number of numeric 
points used by all transaction history groups the present 
time. The value in the Post Setup column shows the total 
number of numeric points that will be used by all 
transaction history groups after applying the default 
history, and this value changes based on your selections 
in the Set Default Meter History and Transaction History 
fields. 

Total These read-only fields show the total number points 
used by transaction history. The value in the Current 
column shows the total number of points used by all 
transaction history groups at the present time. The value 
in the Post Setup column shows the total number of 
points that will be used by all transaction history groups 
after applying the default history, and this value changes 
based on your selections in the Set Default Meter History 
and Transaction History fields. 

Requested 
Memory 
Utilization 

These read-only fields display the amount of memory that would be 
used based on currently requested memory allocation. Transaction 
history and standard periodic history share the same memory resource. 
The combination of memory used by transaction history and standard 
periodic history must be less than or equal to 100%. 
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Field Description 

Transaction 
History 

Shows the amount of memory that would be used by 
transaction history based on the values you enter in the 
Requested Number of Transaction History Groups field 
on the Transaction History Sizing Tab and the Requested 
number of String Points, Numeric Points, and Records 
on the Transaction History Group Details pop-up display. 

Std Periodic 
History 

Shows the amount of memory that would be used by 
standard periodic history based on the values you enter 
in the Requested Number of Points field and the 
Requested Number of Records fields on the Standard 
Periodic History Tab. 

Total Shows the total amount of memory that would be used 
based on the currently requested transaction history and 
standard periodic history allocation. This value must be 
less than or equal to 100%.  

Note 
If this value is more than 100%, you must modify the 
requested transaction history and standard periodic 
history allocation to be less than or equal to 100% before 
you can successfully history sizing. 

3. Select Apply Default History to save the default history configuration to your FB3000 
RTU. A confirmation message opens. 

CAUTION 
• Please export your current history configuration (Exporting a History Configuration 

CSV) in case you need to restore your FB Series product to the previous configuration. 

• Changes made to history sizing results in a reallocation of device memory and erases 
all existing history data. It is recommended to save any existing history data using the 
Reports Menu before applying any history size changes. 

• Current Transactions will be discarded and new Transactions will start after resizing. 
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Figure 254. Confirmation 

 

4. Select Yes to continue the setup. 

Note 

A message appears if have previously sized history and the FB Series product does not 
have the number of history points required to perform the default history setup. If this 
occurs, you must first increase the number of points on the History Setup – Advanced – 
Standard History Sizing Tab before you perform the default history setup. 

5. When the setup completes, select OK to close the dialog. 

Figure 255. Default history successfully setup 

 

4.21.4.1 Default History Configuration 

The table below shows the default history configuration for the FB3000 RTU: 

Note  

For more information about the configured history points after using the Default History 
Setup feature, refer the Appendix C, Default History Setup Point Configurations. 
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Table 42. Default History Configuration 

FB Series 
Product Type 

History Groups Total 
History 
Points 

Total 
Standard 
History 
Points 

Total 
History 
Points 

per 
Group 

Log 
Intervals 

Number 
of 

Records 

FB3000 RTU User 
Periodic 

User Periodic 
1 
(Group 1) 

640 

N/A 

10 
User 

Configurable 

4000 

User Periodic 
2 (Group 2) 

20 500 

Standard 
History 

General 
(Group 3) 

610 

10 
Hourly 

Daily 

Weekly 

Monthly 

4380 

730 

260 

60 

Station 1-24 
(Group 4-27) 

25 per 
group 

Station 25-36 
(Group 28-
39) 

0 per 
group 

 

4.21.5 History – Advanced Setup  

Use the tabs on this display to configure the total number of history points, configure the 
number records (hourly, daily, weekly, and monthly), and allocate the history points 
amongst the periodic history groups in your FB Series product. You can also configure the 
total number of transaction history groups and the number of points and records for 
each group. 

To access this display, select Configure > History > Advanced Setup from the 
FBxConnect™ main menu. The History Setup - Advanced display opens showing the 
Standard History Sizing tab. 

Figure 256. History – Advanced Setup 

 

The History Setup - Advanced display contains the following tabs: 
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Transaction History Sizing – Use this tab to configure the total number of transaction 
history groups and the details of each group. 

Note  

You must select Yes in the Do you want to enable Transaction History? drop-down to 
view this tab. 

Standard Periodic History – Use this tab to adjust the total number of history points, 
configure the number of records, and configure the allocation of history points amongst 
the standard history groups in your FB Series product.  

4.21.5.1 History Setup - Advanced – Transaction History Sizing Tab 

Use this tab to configure the number of transaction history groups that are logged by 
your FB Series product. 

Note 

• You must select Yes in the Do you want to enable Transaction History? drop-down 
list to view this tab. 

• You must have FB3000 RTU firmware version 2.11 or later to use this feature. 

To access this display: 

1. Select Configure > History > Advanced Setup from the FBxConnect™ main menu. 
The History Setup - Advanced display opens. 

2. Select the Transaction History Sizing tab. 

Note 

If you do not see this tab, select Yes in the Do you want to enable Transaction History? 
drop-down list. 
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Figure 257. History Setup - Advanced – Transaction History Sizing Tab 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Do you want to 
enable 
Transaction 
History? 

Sets if transaction history will be configured on your FB Series 
product. Possible options are: 

Yes Transaction history will be configured on your FB 
Series product. If you select this option, a Transaction 
History Sizing tab appears on the display. 

Note 
You must configure the number of transaction history 
groups and select Apply Number of Groups before 
proceeding. 
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Field Description 

No Transaction history will not be configured on your FB 
Series product. If you have previously enabled 
transaction history, a confirmation message opens. 
Select Yes on the confirmation message to disable 
transaction history. When complete, the Transaction 
History Sizing tab is removed and a confirmation 
message appears. Select OK to continue. 

Note 
If you previously enabled and configured transaction 
history, selecting this option causes history to be 
resized and erases all periodic and transaction 
history records. Please collect existing history records 
before proceeding. 

Number of 
Transaction 
History Groups 

Use these fields to adjust the number of transaction history groups 
stored in the memory of the FB Series product. 

Current The read-only field shows the number of currently 
enabled transaction history groups. 

Requested Enter the desired number of transaction history 
groups. The maximum number of transaction history 
groups is 100. 

Apply 
Number of 
Groups 

Select this button to adjust the number of transaction 
history groups based on the value set in the 
Requested column. A confirmation message displays. 
Select Yes to proceed. When complete, a 
confirmation message appears. Select OK to 
continue. 

Note 

• When transaction history groups are added, no 
string or numeric points are configured for the 
group. You can configure these parameters on 
the Transaction History Group Details pop-up 
display. 

• This button appears only if you modify the 
number in the Requested column. 
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Field Description 

Transaction 
History Group 
Details 

Select this button to open the Transaction History Group Details 
pop-up display and configure the required number of points and 
records for transaction history groups. 

Requested 
Memory 
Utilization 

These read-only fields display the amount of memory that would be 
used based on currently requested memory allocation. Transaction 
history and standard periodic history share the same memory 
resource. The combination of memory used by transaction history 
and standard periodic history must be less than or equal to 100%. 

Transaction 
History 

Shows the amount of memory that would be used by 
transaction history based on the values you enter in 
the Requested Number of Transaction History 
Groups field on the Transaction History Sizing Tab 
and the Requested number of String Points, 
Numeric Points, and Records on the Transaction 
History Group Details pop-up display. 

Std 
Periodic 
History 

Shows the amount of memory that would be used by 
standard periodic history based on the values you 
enter in the Requested Number of Points field and 
the Requested Number of Records fields on the 
Standard Periodic History Tab. 

Total Shows the total amount of memory that would be 
used based on the currently requested transaction 
history and standard periodic history allocation. This 
value must be less than or equal to 100%.  

Note 
If this value is more than 100%, you must modify the 
requested transaction history and standard periodic 
history allocation to be less than or equal to 100% 
before you can successfully history sizing. 

4. Select Save to save any changes you make to this display and commit any history 
allocation changes to memory in the FB Series product. 
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CAUTION 
• Saving changes to the points and records allocation of transaction history groups will 

clear all periodic and transaction history records. Please collect existing history 
records before proceeding. 

• If you adjust the total number of string points for a previously configured transaction 
history group, the existing configuration of numeric points for that transaction history 
group (as configured on the Transaction History Group Configuration display) is 
cleared during the resizing process. 

4.21.5.1.1 Transaction History Group Details  

Use this pop-up display to configure the type and quantity of data to be stored by each 
transaction history group, including the number of string points, numeric points, and 
transaction records. You can configure up to 100 transaction history groups, and each 
row on the display corresponds to a separate group. Each group can contain up to 25 
string points and up to 650 numeric points as long as the total number of points in a 
single group does not exceed 650 and the total number of points in all groups does not 
exceed 3100. The default number of transaction records in each group is 200. As you are 
making configuration changes, the memory needed for these changes is shown at the 
bottom of the display. 

To access this display: 

1. Select Configure > History > Advanced Setup from the FBxConnect™ main menu. 
The History Setup - Advanced display opens. 

2. Select the Transaction History Sizing tab. 
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Figure 258. Transaction History Group Details Button 

 

3. Select the Transaction History Group Details button. The Transaction History Group 
Details pop-up display opens. 

Figure 259. Transaction History Group Details 
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4. Review – and change as necessary – the values in the following fields: 

Field Description 

Number Each numbered row corresponds to a separate transaction history 
group in your FB Series product. 

Group Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
transaction history group. 

Application 
Assignment 

Assigns transactional history groups to standard application use 
cases, therefore determining the type and quantity of data to be 
stored. 

Group Type Click ▼ to select the use case for the transaction 
history group. Pre-defined standard application use 
cases are selectable. For custom user defined 
transactional history use cases, select a group type 
of General. 

Note  
To configure a transaction history group for liquid 
linear meter batching, you must set this field to 
General and then configure the Transactional 
History Group field 

on the Liquid Linear Meter – General Tab. 

Instance Click  or enter the associated instance number that 
corresponds to the group type and intended 
purpose for the transactional history group. When 
there are multiple instances of the same 
functionality (for example, multiple liquid meters or 
multiple production wells), each instance can be 
stored in its own transactional history group. For 
example, transaction history group 1 can be used to 
store data for well instance 1, transaction history 
group 2 can be used to store data for well instance 2, 
etc.  

Note 
The instance is not used when the Group Type is set 
to General. 
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Field Description 

Current These read-only fields show the total number of string points, 
numeric points, and transaction records configured for each 
transaction history group. 

Requested These fields set the total number of string points, numeric points, 
and transaction records for each transaction history group. To 
change these values, select a field in the appropriate column and 
type in your desired value. The amount of memory used by the new 
configuration is shown in the Memory Used (%) column for each 
Transaction History Group. 

The requested number of points and records have the following 
limits: 

• The maximum number of string points allowed in a single group 
is 25. 

• The maximum combined number of string points and numeric 
points allowed in a single group is 650. 

• The maximum combined number of string points and numeric 
points allowed across all transaction history groups is 3100. 

Note 

• You must save your changes on the Transaction History Sizing 
tab before the Transaction History Group Details configuration 
will take effect. 

• If you adjust the total number of string points for a previously 
configured transaction history group, the existing configuration 
of numeric points for that transaction history group (as 
configured on the Transaction History Group Configuration 
display) is cleared during the resizing process. 

Requested 
Memory 
Utilization 

These read-only fields display the amount of memory that would be 
used based on currently requested memory allocation. Transaction 
history and standard periodic history share the same memory 
resource. The combination of memory used by transaction history 
and standard periodic history must be less than or equal to 100%. 
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Field Description 

Transaction 
History 

Shows the amount of memory that would be used 
by transaction history based on the values you 
enter in the Requested Number of Transaction 
History Groups field on the Transaction History 
Sizing and the Requested number of String Points, 
Numeric Points, and Records on the Transaction 
History Group Details pop-up display.  

Std Periodic 
History 

Shows the amount of memory that would be used 
by standard periodic history based on the values 
you enter in the Requested Number of Points field 
and the Requested Number of Records fields on 
the Standard Periodic History Tab. 

Total Shows the total amount of memory that would be 
used based on the currently requested transaction 
history and standard periodic history allocation. 
This value must be less than or equal to 100%.  

Note 
If this value is more than 100%, you must modify 
the requested transaction history and standard 
periodic history allocation to be less than or equal 
to 100% before you can successfully history sizing. 

5. Select Close to return to the Transaction History Sizing tab.  

Note 

Select Cancel to revert any changes and return to the Transaction History Sizing tab. 

6. If you made changes to the points or records allocation for any transaction history 
group, a note appears that reminds you to save your changes on the Transaction 
History Sizing tab to apply your changes to memory in the FB Series product. Select 
Save. A confirmation message displays. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

686 

CAUTION 
• Please export your current history configuration (Exporting a History Configuration 

CSV) in case you need to restore your FB Series product to the previous configuration. 

• Changes made to history sizing results in a reallocation of device memory and erases 
all existing history data. It is recommended to save any existing history data using the 
Reports Menu before applying any history size changes. 

• Current Transactions will be discarded and new Transactions will start after resizing. 

Figure 260. Confirmation 

 

7. Select Yes to commit any history allocation changes to memory in the FB Series 
product. 

4.21.5.2 History Setup - Advanced – Standard Periodic History Sizing Tab 

Use this tab to adjust the total number of history points, configure the number of records, 
and configure the allocation of history points amongst the standard periodic history 
groups in your FB Series product. 

To access this display: 

1. Select Configure > History > Advanced Setup from the FBxConnect™ main menu. 
The History Setup - Advanced display opens. 

2. Select the Standard Periodic History tab. 
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Figure 261. History Setup - Advanced – Standard Periodic History Tab 

 

The History Setup - Advanced display contains the following tabs: 

Standard History Sizing – Use this tab to adjust the total number of history points 
available in the standard periodic history groups and configure the number of hourly, 
daily, weekly, and monthly records. 

Points Assignment – Use this tab to view and configure the allocation of history points 
amongst the standard periodic history groups in your FB Series product. 

4.21.5.2.1 History Setup - Advanced – Std Periodic History Sizing Tab 

Use this tab to adjust the number of history points available in the standard history 
groups and configure the number of hourly, daily, weekly, and monthly records. This 
feature allows you to configure the history memory to fit your needs. You can configure 
the history to store a few records (for example, 50 or 100) and store the data for a very 
long time (for example, over one year). Alternatively, you can configure the history to 
store a large number of records (for example, 1000) and store the data for a short period 
of time (for example, 30 days). If you only care about daily and hourly data, you can 
configure 0 weekly and 0 monthly records and reclaim that memory.  
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There are trade-offs to consider as you configure the items on this display. The maximum 
number of points is based the number of requested records (Hourly, Daily, Weekly, and 
Monthly), and the maximum number of records (Hourly, Daily, Weekly, and Monthly) is 
based on the number of requested points. Adjust both the number of points and records 
based on your organization's history requirements. Whatever you pick, it must fit within 
100% or less of the available memory.  

Note  

• Changes made to history sizing results in a reallocation of device memory and erases 
any existing history data. It is recommended to save any existing history data before 
applying any history size changes. 

• For more information about standard history groups, refer to History Overview. 

• After sizing history, use the Points Assignment tab to view and allocate history points 
amongst the standard history groups. 

• After sizing history, if the number of records for a history group is smaller than the 
values set in the Log Nearly Full Remaining Records or the Log Full Remaining 
Records fields on the Log Properties display, the system sets the Log Nearly Full 
Remaining Records field to 10% and the Log Full Remaining Records field to 5% of 
the total number of records. 

To access this display: 

1. Select Configure > History > Advanced Setup from the FBxConnect™ main menu. 
The History Setup - Advanced display opens showing the Standard History Sizing tab. 
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Figure 262. History Setup - Advanced – Standard History Sizing Tab 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Number of 
Points 

Use these fields to adjust the number of history points available in 
the standard history groups, which includes general history and 
station history. For example, if you are configuring a FB3000 RTU for 
24 meters and a need to historize 10 points for each meter, a 
minimum of 24 x 10 = 240 history points would be required. 

Current This read-only field shows the number of history 
points currently allocated to the standard history 
groups. 
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Field Description 

Requested Click  to set the number of history points to allocate 

for the standard history groups. 

Note 

• The maximum number of points is 1350. 

• The total number of points combined with the 
total number of records cannot cause the value in 
the Total memory used field to exceed 100%. 

Calculate 
Maximum 
Points 

Select this button to calculate the maximum number 
history points that can be provided given the 
requested number of Hourly, Daily, Weekly, and 
Monthly records, and the Requested column will be 
updated with a value that utilizes 100% of the 
available history memory. Fill out the requested 
hourly, daily, weekly, and monthly records before 
selecting this button. 

For example, if a long duration of history is not 
required, then it might be typical to save 35 days of 
history (which is 840 hours, 4 weeks, 2 months). You 
should enter these values in the Requested column of 
the Number of Records section first. Then, before 
selecting the Save button, select the Calculate 
Maximum Points button to determine the number of 
possible history points that can be allocated for the 
selected configuration. 

Number of 
Records 

Use these fields to reallocate the number of records stored in the 
memory of the FB Series product. These selections determine the 
duration that history is stored for the various available record types. 
Note that the various record types are not required to be equal in 
duration. For example, if weekly and monthly history are not 
required, then the number of weekly and monthly records can be set 
to 0. 

Current This read-only field shows the number of hourly, 
daily, weekly, and monthly history records currently 
allocated to the standard history groups. 
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Field Description 

Requested Click  to set the number of records to allocate for 

the hourly, daily, weekly, and monthly history logs. 

Note  

The total number of points combined with the total 
number of records cannot cause the value in the Total 
memory used field to exceed 100%. 

Requested 
Memory 
Used 

These read-only fields show, in percentage, the 
amount of FB Series product memory used by the 
hourly, daily, weekly, and monthly records based on 
the number of Requested Points and the number of 
Requested Records. 

Total 
memory 
used 

This read-only field shows, in percentage, the total 
amount of FB Series device memory used by the 
combined total number of Requested Points and the 
total number of Requested Records. 

Note 

The Total memory used is not required to equal 100%, 
only that it is less than or equal to 100%. 

Calculate 
Maximum 
Records 

Select this button to calculate the maximum number 
of records (Hourly, Daily, Weekly, and Monthly) that 
can be provided given the requested number points, 
and the Requested column will be updated with a 
value that utilizes 100% of the available history 
memory. Fill out the above requested total points 
before selecting this button. 

For example, if 500 history points will be required to 
store meter and station audit trial data, then you 
should enter a value of 500 in the Requested column 
of the Number of Points section first. Then, before 
selecting the Save button, select the Calculate 
Maximum Records button to determine the number 
of possible records (duration) that can be allocated for 
the selected configuration. 
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Field Description 

Total Points This read-only field shows the total number of standard history 
points (General, Station 1, Station 2) in the FB Series product, and the 
total number of requested history points. 

3. Select Save to save any changes you make to this display. 

CAUTION 
Changes made to history sizing results in a reallocation of device memory and erases any 
existing history data. It is recommended to save any existing history data before applying 
any history size changes. 

4.21.5.2.2  History Setup - Advanced – Points Assignment Tab 

Use this tab to view and allocate history points amongst the standard history groups in 
your FB Series product.  

The FB Series product also contains two groups of user periodic history points. User 
periodic history consists of 30 fixed history points. Ten points are allocated to the User 
Periodic 1 group and 20 points are allocated to the User Periodic 2 group. 

To access this display: 

1. Select Configure > History > Advanced Setup > Points Assignment from the 
FBxConnect™ main menu. The History Setup - Advanced display opens showing the 
Standard History Sizing tab. 

2. Select the Points Assignment tab. 
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Figure 263. History Setup - Advanced – Points Assignment Tab 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

User Periodic1 
Current Num 
of Pts 

This read-only field shows the total number of user history points 
allocated to the User Periodic 1 group. 

User Periodic 
2 Current 
Num of Pts 

This read-only field shows the total number of user history points 
allocated to the User Periodic 2 group. 

Total Num of 
Available 
Standard 
Points 

This read-only field shows the number of available history points not 
currently allocated to a standard history group. 

Station 1-12, 
Station 13-24, 
and Station 
25-36 tabs 

Select a tab to configure history points assigned to each respective 
station. 

Note 

The Station 1-12 tab also shows the history points assigned to the 
General history group. 
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Field Description 

General The General history group contains hourly, daily, weekly, and 
monthly history not associated with a meter or station.  

Current This read-only field shows the number of history 
points currently allocated to the Standard General 
history group. 

Requested Sets the number of history points to allocate for the 
Standard General history group. 

Note 

The total allocated number of standard history points 
cannot exceed the value in the Total Standard Points 
field. 

Station (#) The Station (#) history group contains hourly, daily, weekly, and 
monthly history associated with Station x and any meters assigned to 
Station x.  

Current This read-only field shows the number of history 
points currently allocated to the Standard Station x 
history group. 

Requested Sets the number of history points to allocate for the 
Standard Station x history group. 

Note 

The total allocated number of standard history points 
cannot exceed the value in the Total Standard Points 
field. 

Total Points This read-only field shows the total number of standard history 
points (General, Station 1, Station 2) in the FB Series product, and the 
total number of requested history points. 

4. Select Save to save any changes you make to this display and commit any history 
allocation changes to memory in the FB Series product. A confirmation message 
opens. 
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CAUTION 
• Changes made to history sizing results in a reallocation of device memory and erases 

all existing history data. It is recommended to save any existing history data using the 
Reports Menu before applying any history size changes. 

• Current Transactions will be discarded and new Transactions will start after resizing. 

Figure 264. Confirmation 

 

5. Select Yes to continue the setup. 

4.22 Logs 

 Use the displays in the Logs drop-down menu to configure how logs are created in your 
FB Series product. You can configure if the FB Series product creates separate or 
combined legal and non-legal event logs, enable or disable various logs, and verify the 
system.  

To access these displays, select Configure > Logs from the FBxConnect™ main menu and 
select one of the options from the Logs drop-down menu. 

Figure 265. Logs Drop-Down Menu 

 

Refer to the following topics for more information: 

Event Setup – Use this display to configure how event logs are created by the FB Series 
product. 

Log Properties – Use this display to configure options for history, alarm, and event logs. 

Log Descriptions – View a description of each log created by the FB Series product. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

696 

4.22.1 Event Setup 

Use this display to configure how event logs are created by your FB Series product. You 
can configure the system to create a single event log that contains both legal and non-
legal events, to create separate event logs for legal and non-legal events, or to create 
separate event logs for legal and non-legal events that are verifiable and exportable.  

Note  

If you chose to have verifiable logs, this display allows you to verify the system 
configuration. 

To access this display: 

1. Select Configure > Logs > Event Setup from the FBxConnect™ main menu. 

Figure 266. Event Setup 

 

2. Review – and change as necessary – the values in the following fields: 
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Field Description 

Event Log 
Configuration 
Type 

Sets the type of event log created by the FB Series product. 

Note 

Changing the Event Log Configuration Type between a combined log 
type (Combined Event) and a separate log type (Separate Legal and 
Non-Legal Event Logs or Separate Verifiable & Exportable Logs) will 
clear the Event Log. 

Combined 
Event Log 

The FB Series product creates one event log that 
contains both legal and non-legal events. The 
combined event log consists of 8000 entries. 

Separate 
Legal and 
Non-Legal 
Event Logs 

The FB Series product creates two event logs: one for 
legal events and one for non-legal events. Each event 
log consists of 4000 entries. 

Separate 
Verifiable & 
Exportable 
Logs 

The FB Series product creates two event logs: one for 
legal events and one for non-legal events. Each event 
log consists of 4000 entries. 

When the legal event log is full, the Lock Status 
changes to Locked and a warning message appears. 
The device no longer accepts changes to legal 
parameters, firmware updates, calibration, or 
configuration download. The legal event log must be 
exported before these actions are permitted and 
additional events can be created. 
Note 

• After you save your changes, a color-coded 
verification status field appears in the FBxConnect™ 
status bar. This field allows you to quickly 
determine the verification status of your FB Series 
product when viewing any display within 
FBxConnect™. 

• If your FB Series product becomes locked due to a 
full event log, refer to Export Events. 

• FBxConnect™ calculates the generated file's MD5 
hash and stores the result as a new event in the FB 
Series product's legal event log. This allows you to 
verify the integrity of the event report by 
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Field Description 
calculating the file's MD5 hash and comparing the 
results with the MD5 hash stored in the FB Series 
product's legal event log.  

Verification Use these fields to verify the configuration of your FB Series product. 

Note 
These field appear only if you select Separate Verifiable & 
Exportable Logs. 

Status This read-only field shows the current verification state 
of the FB Series product. Possible options are System 
Unverified or System Verified. 

Note 

A verification icon is also visible in the FBxConnect™ 
status bar at the bottom of the screen. 

Verification 
Change 
Timestamp 

This read-only field shows the time and date of the last 
change to the Verification Status field.  

Verify Select this button after you have verified the current 
configuration is correct, and a confirmation message 
displays. Select OK to verify the system. The Verification 
Status field changes to System Verified and a 
verification field appears in the FBxConnect™ status bar 
at the bottom of the screen. 

Lock Use these fields to view information about your FB Series product's 
current lock status. An FB Series product becomes locked when the 
Event Log Configuration Type is set to Separate Verifiable & 
Exportable Logs and the legal event log becomes full. When the legal 
event log is full, the Lock Status changes to Locked and a warning 
message appears. The device no longer accepts changes to legal 
parameters, firmware updates, calibrations, or configuration 
downloads. To unlock the device, you must export the legal event log 
to allow additional events to be created. 

Note 

• These field appear only if you select Separate Verifiable & 
Exportable Logs. 
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Field Description 
• If your FB Series product becomes locked due to a full event log, 

refer to Export Events. 

Status This read-only field shows the current state of the legal 
event log. Possible options are Unlocked or Locked. 

Lock 
Timestamp 

This read-only field shows the time and date of the last 
change to the Lock Status field.  

3. Select Save to save any changes you make to this display. 

4.22.2 Log Properties 

Use this display to configure options for history, alarm, and event logs. You can 
enable/disable individual logs, and configure the number of remaining records before an 
alarm is raised. 

To access this display: 

1. Select Configure > Logs > Log Properties from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display to select an instance to 
configure. 

Note 

Refer to Log Descriptions for more information. 
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Figure 267. Log Properties 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
instance. 

Total Log 
Capacity 

This read-only field shows the maximum number of records that can 
be stored in the currently selected log. 

Logging Enables the system to collect data for the selected log. 

Log Full 
Alarm 

Enables the system to log Log Nearly Full, Log Full and Log Integrity 
alarms for the selected log. 
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Field Description 

History 
Group 

This read-only field shows the History Group Object Reference to 
which the selected log belongs. Possible History Group Object 
References are Hist Grp_1, Hist Grp_2, Hist Grp_3, Hist Grp_4, Hist 
Grp_5 and Undefined. 

Type of Log This read-only field shows the Log Type of the selected log. Possible 
Log Types are Legal Event, Non Legal Event, Legal Alarm, Non Legal 
Alarm, Legal History and Non Legal History. 

Log Full 
Remaining 
Records 

Sets a limit value to which the number of remaining records in the 
selected log must fall to log a Log Full alarm. 

Log Nearly 
Full 
Remaining 
Records 

Sets a limit value to which the number of remaining records in the 
selected log must fall to log a Log Nearly Full alarm. 

Note 

The Log Nearly Full limit should be greater than or equal to the Log Full 
Limit. 

Sequence 
Number Last 
Read Record 

This parameter allows the SCADA host to store the sequence number 
of the last successfully read alarm, event, or history record in the FB 
Series product. The system then uses this number to determine the 
number of remaining records using the formula: 

Remaining Records = Total Records - Unread Records 

Where: 

Unread Records = Sequence Number of Newest Record - Sequence 
Number Last Read 

Latest 
Sequence 
Number 

This read-only field shows the last sequence number generated by the 
FB Series product. 

4. Select Save to save any changes you make to this display. 

4.22.3 Log Descriptions 

The FB3000 RTU stores a total of 154 logs. Refer to the table below for a description of 
each log. 
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Table 43. Log Descriptions 

Log Description 

Log 1 Legal Event Log 

Log 2 Non Legal Event Log 

Log 3 Alarm Log 

Log 4 Undefined 

Log 5 User Periodic 1 Log 

Log 6 User Periodic 2 Log 

Log 7 General Hourly Log 

Log 8 General Daily Log 

Log 9 General Weekly Log 

Log 10 General Monthly Log 

Logs 11 – 14 Station 1's Hourly, Daily, Weekly, and Monthly Logs 

Logs 15 – 18 Station 2's Hourly, Daily, Weekly, and Monthly Logs 

Logs 19 – 22 Station 3's Hourly, Daily, Weekly, and Monthly Logs 

Logs 23 – 26 Station 4's Hourly, Daily, Weekly, and Monthly Logs 

Logs 27 – 30 Station 5's Hourly, Daily, Weekly, and Monthly Logs 

Logs 31 – 34 Station 6's Hourly, Daily, Weekly, and Monthly Logs 

Logs 35 – 38 Station 7's Hourly, Daily, Weekly, and Monthly Logs 

Logs 39 – 42 Station 8's Hourly, Daily, Weekly, and Monthly Logs 

Logs 43 – 46 Station 9's Hourly, Daily, Weekly, and Monthly Logs 

Logs 47 – 50 Station 10's Hourly, Daily, Weekly, and Monthly Logs 

Logs 51 – 54 Station 11's Hourly, Daily, Weekly, and Monthly Logs 

Logs 55 – 58 Station 12's Hourly, Daily, Weekly, and Monthly Logs 

Logs 59 – 62 Station 13's Hourly, Daily, Weekly, and Monthly Logs 

Logs 63 – 66 Station 14's Hourly, Daily, Weekly, and Monthly Logs 

Logs 67 – 70 Station 15's Hourly, Daily, Weekly, and Monthly Logs 

Logs 71 – 74 Station 16's Hourly, Daily, Weekly, and Monthly Logs 

Logs 75 – 78 Station 17's Hourly, Daily, Weekly, and Monthly Logs 

Logs 79 – 82 Station 18's Hourly, Daily, Weekly, and Monthly Logs 
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Log Description 

Logs 83 – 86 Station 19's Hourly, Daily, Weekly, and Monthly Logs 

Logs 87 – 90 Station 20's Hourly, Daily, Weekly, and Monthly Logs 

Logs 91 – 94 Station 21's Hourly, Daily, Weekly, and Monthly Logs 

Logs 95 – 98 Station 22's Hourly, Daily, Weekly, and Monthly Logs 

Logs 99 – 102 Station 23's Hourly, Daily, Weekly, and Monthly Logs 

Logs 103 – 106 Station 24's Hourly, Daily, Weekly, and Monthly Logs 

Logs 107 – 110 Station 25's Hourly, Daily, Weekly, and Monthly Logs 

Logs 111 – 114 Station 26's Hourly, Daily, Weekly, and Monthly Logs 

Logs 115 – 118 Station 27's Hourly, Daily, Weekly, and Monthly Logs 

Logs 119 – 122 Station 28's Hourly, Daily, Weekly, and Monthly Logs 

Logs 123 – 126 Station 29's Hourly, Daily, Weekly, and Monthly Logs 

Logs 127 – 130 Station 30's Hourly, Daily, Weekly, and Monthly Logs 

Logs 131 – 134 Station 31's Hourly, Daily, Weekly, and Monthly Logs 

Logs 135 – 138 Station 32's Hourly, Daily, Weekly, and Monthly Logs 

Logs 139 – 142 Station 33's Hourly, Daily, Weekly, and Monthly Logs 

Logs 143 – 146 Station 34's Hourly, Daily, Weekly, and Monthly Logs 

Logs 147 – 150 Station 35's Hourly, Daily, Weekly, and Monthly Logs 

Logs 151 – 154 Station 36's Hourly, Daily, Weekly, and Monthly Logs 

4.23 Custom Reports 

Use the displays in the Custom Reports drop-down menu to configure customized reports 
that are generated by your FB3000 RTU based on a template that you create. You can 
configure a report template to include real-time data (date, time, meter number, quantity, 
etc.) or historical data (Snapshot, Hourly, Daily, Monthly, or Batch). Reports can be 
generated manually or automatically using the layout from your custom report template. 

Generated report files are stored as .txt files in the FB Series product’s flash memory. The 
report content and formatting are based on a custom report template that you create. 
You can download these reports using FBxConnect™ or you can configure a network 
printer to print your reports. 

To access these displays, select Configure > Custom Reports from the FBxConnect™ 
main menu and select one of the options from the Custom Reports drop-down menu. 
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Figure 268. Custom Reports Drop-Down Menu 

 

Refer to the following topics for more information: 

Report and Printer Setup – Use this display to configure the number of custom reports 
and the number of printers used by the FB Series product. 

Reports – Use this display to configure the custom report name, import a custom report 
template, and generate the custom report. 

Template Management – Use this dialog to import a template that the system uses to 
create a custom report.  

Template Editor – Use this option to launch the Custom Report Template Editor and 
create a custom report template that determines the layout and content of the report. 

Printers – Use this display to configure a network printer used for custom reports. 

Printer Alarms/Errors – Explanation of printer alarm log entries. 

Generating Custom Reports – Follow these steps to generate a custom report. 

Viewing Custom Reports – Download and view the generated report from the FB Series 
product’s memory to your PC. 

Deleting Custom Report Files and Templates – Delete custom report files and templates 
that are stored in the FB Series product’s flash memory. 

Creating a Custom Report Template – Details the required file structure used to create 
your own custom template. 

4.23.1 Report and Printer Setup  

Use this display to configure the number of custom report instances that can be 
configured to generate report files that are stored in the FB Series product's flash 
memory, and to configure the number of printers used by the FB Series product to print 
the custom reports. A maximum of 36 instances of the Reports object exist, and the FB 
Series product's flash memory can store up to the last 8 report files (.txt) for each 
instance. Each report file name includes a unique report sequence number, a user-
entered file name prefix, and the time and date. 
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To access this display: 

1. Select Configure > Custom Reports > Report and Printer Setup from the 
FBxConnect™ main menu. 

Figure 269. Report and Printer Setup 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Number of 
Reports 

Enter the number of custom report instances used to store reports in 
the FB Series product’s flash memory. The FB Series product’s flash 
memory can store a maximum of 8 report files (.txt) for each Report 
instance. 

Note 

You must configure at least one report on this display before you can 
access the Reports display. 
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Field Description 

Number of 
Printers 

Enter the number of printers used by your FB Series product to print 
custom reports. The maximum number of printers is 2.  

Note 

You must configure at least one printer before you can access the 
Printers display. 

3. Select Save to save any changes you make to this display. 

4.23.2 Reports  

Use this display to configure the custom report name, import custom report templates, 
and generate the custom report. 36 instances of the Reports object exist and the FB 
Series product's flash memory can store the last 8 report files (.txt) for each instance. 

Note 

You must configure at least one report in the Number of Reports field on the Report and 
Printer Setup display before you can access this display. 

To access this display: 

1. Select Configure > Custom Reports > Reports from the FBxConnect™ main menu. 
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Figure 270. Reports 

 

2. Click ▼ in the drop-down list at the top of the display to select a Reports instance to 
configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
reports instance. 

Note 

The Tag can be printed on a custom report by selecting 
REPORT_NAME in the Type field on the Placement Properties window. 
For more information, refer to Template Editor – Placement 
Properties. 
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Field Description 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
reports instance. 

Note 

The Description can be printed on a custom report by selecting 
REPORT_DESC in the Type field on the Placement Properties window. 
For more information, refer to Template Editor – Placement 
Properties. 
 

File Name 
Prefix 

Enter text (up to 15-alphanumeric characters) that the system includes 
in the file name of the saved report. The File Name Prefix is placed 
before the date and after the report number. For example, the bold 
text in the following file name is the File Name Prefix: 
00001_Report_1_20240702100211.txt 

Note 

Valid special characters are an underscore (_), dash (-) or period (.). 

Report 
Template 
Filename 

Enter the file name of a custom report template to use with the 
selected Reports instance. 

Note 

• Rather than typing in a template file name, you can use the 
Template Management button to select a template using 
FBxConnect™. 

• Valid special characters are an underscore (_), dash (-) or period (.). 
A period cannot be used as the last character in the Report 
Template Filename. 

Report 
Number 

This read-only field shows a unique number that is 
automatically generated by the system when a report file is 
successfully generated. Valid values are 0 to 99999. The 
report number appears at the beginning of the file name. 
For example, the bold text in the following file name is the 
Report Number: 00001_Report_1_20240702100211.txt 

Note 

The Report Number can be printed on a custom report by 
selecting REPORT_NUM in the Type field on the Placement 
Properties window. For more information, refer to 
Template Editor – Placement Properties. 
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Field Description 

Template 
Checksum 

This read-only field shows the checksum of the custom report 
template currently used for the selected Reports instance. The 
checksum is automatically generated from the structure of the 
template file and can be used for revision control. If it is not 
possible to calculate the checksum, a value of 0 is displayed.  

Note 

The checksum is not calculated when FBxConnect™ is operating 
offline. 

Template 
Management 

Select this button to open the Custom Report Templates window and 
select a template to use with the selected Reports instance. 
FBxConnect™ verifies the file structure before importing the template. 
If errors are found in the selected template, an error message opens 
and the template is not imported.  

Note 

• Emerson provides sample custom report templates with 
FBxConnect™. The default location for the custom report 
templates is: 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\CustomRepo
rtTemplates. 

• For information about creating your own template, refer to 
Creating a Custom Report Template. 

Clear 
Template 

Select this button to remove the custom report template 
currently used for the selected Reports instance.  

Edit Template Select this button to open the Custom Report Template Editor 
and modify the custom report template currently used for the 
selected Reports instance.  

Note 

This option modifies a custom report template file located on 
the FB Series product. Any modifications are downloaded to the 
FB Series product when you save your changes. 

Report 
Generate 
Command 
Parameter 

Click  to open a Point Picker dialog and select a parameter that 

generates the selected report whenever the value of the parameter 
changes. Parameters used for this function are often based on a 
specific period of time. For example, the following parameters can be 
used to generate period, day, week, month, and batch reports:  
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Field Description 
• End of period – Liq LinMtr_x.PREV_PER_END_TM or 

Station_x.PREV_PER_END_TM 

• End of day – Liq LinMtr_x.PREV_DAY_END_TM or 
Station_x.PREV_DAY_END_TM 

• End of week – Liq LinMtr_x.PREV_WK_END_TM or 
Station_x.PREV_WK_END_TM 

• End of month – Liq LinMtr_x.PREV_MNTH_END_TM or 
Station_x.PREV_MNTH_END_TM 

• End of batch – Liq LinMtr_x.PREV_BATCH_END_TM or 
Station_x.PREV_BATCH_END_TM  

Note 

• Any parameter belonging to the Clock_1 object is not a valid 
parameter for this field. 

• If a time-based parameter is used as a trigger, the generated 
report file name includes the time from that parameter. If non-
time-based parameter is used as a trigger, the generated report 
file name includes the time that the report was generated. 

• On heavily loaded solutions, it can take up to 10 seconds to fully 
process a report. 

Generate 
Report Now 

Select this button to instantly start generating the selected report. 

Note 

• On heavily loaded solutions, it can take up to 10 seconds to fully 
process a report. 

• If a report can be automatically triggered via the Report Generate 
Command Parameter, the report template must only use historic 
parameters; this is to ensure that duplicate tickets include the 
same data. 

• If an error occurs when generating the report, an event is logged 
in the event log. 

Printer 1 and 
Printer 2 

If checked, sends the generated report to the selected printer.  

Note 
If the printer status is “offline” when a report is generated, any reports 
that were not printed (up to the previous eight reports) are sent to the 
printer when the status returns to “online” (Ethernet printers only). 

4. Select Save to save any changes you make to this display. 
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4.23.2.1 Template Management 

Use this dialog to import a template that the system uses to create a custom report. The 
custom report template determines the layout and content of the report.  

Note 

• Emerson provides sample custom report templates with FBxConnect™. The default 
location for the custom report templates is: 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\CustomReportTemplates. 

• For information about creating your own template, refer to Creating a Custom Report 
Template. 

• Templates stored in the FB Series product’s flash memory are saved as part of your 
solution file when you Upload a Solution. 

To access this display: 

1. Select Configure > Custom Reports > Reports from the FBxConnect™  main menu. 
The Reports display opens. 
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Figure 271. Reports 

 

2. Select the Template Management button. The Custom Report Templates dialog 
opens. 
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Figure 272. Custom Report Templates 

 

3. Select Solution Templates as the source on the left side of the dialog. A list of 
templates stored FB Series product's flash file system shows on the right side of the 
dialog. 

4. Select a custom report template from the list and click Select. The dialog closes and 
the system shows the name of the template you selected in the Report Template 
Filename field. 

Note 

• To select a custom report template file saved on your PC, select Browse as the source 
on the left side of the dialog to open a File Explorer window. Navigate to the location 
of the template on your PC, select the custom report template file, and select Open.  

• Once the file has been transferred to the FB Series product, the checksum of the 
template is calculated (Report_x.TEMPLATE_CHECK parameter). The checksum is 
automatically generated from the structure of the template file and can be used for 
revision control. If it is not possible to calculate the checksum, a value of 0 is 
displayed. The checksum is not calculated when FBxConnect™ is operating offline. 
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The TEMPLATE_CHECK parameter is periodically verified to confirm that there are no 
unexpected changes to the template file. If a change occurs, an unexpected change 
event is recorded in the event log. 

• To delete a template stored on the device, right-click on the template name to reveal 
the option to delete the template.   

• To edit a template stored on the device, right-click on the template name to reveal the 
option to edit the template.   

• To export a template stored on the device, right-click on the template name to reveal 
the option to export the template to the PC. 

4.23.3 Template Editor 

Use this option to launch the Custom Report Template Editor and create a custom report 
template that determines the layout and content of your report.  

To launch the Custom Report Template Editor, select Configure > Custom Reports > 
Template Editor from the FBxConnect™ main menu. The Custom Report Template Editor 
opens. 

Figure 273. Custom Report Template Editor 

 

The user interface of the Custom Report Template Editor consists of the following: 
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Field Description 

1 Menu Bar – Use the Menu Bar to access options that allow you 
customize, save, and print your report. For more information, refer to 
Template Editor – Menu Bar. 

2 Toolbar – Use these icons to control the reports printed size, 
placement of items on the report, the number of report sections, and 
use the save/copy/cut/paste tools when creating your report template. 
For more information, refer to Template Editor – Toolbar. 

3 Section Tabs – Each section tab represents a unique portion of the 
report template. A single report template can consist of multiple 
sections. 

4 Section Editor – Enter text and placements (data from the FB Series 
product's internal database) in the section editor to customize the data 
shown in each section of the generated report. 

 

4.23.3.1 Template Editor Basics 

The Template Editor allows you to easily create a custom report template without having 
to create your own XML file. You can simply add the text and the data from the FB Series 
product's internal database that you want to appear on the generated report using the 
Template Editor, and the system creates a valid XML file with the tags and metadata 
required to generate the report. Successfully creating a report template requires an 
understanding of the elements of a report template and the features provided by the 
Template Editor. A report template consists of three elements that you can customize 
based on the information you want to show on the report: a template, sections, and 
placements.  

Note 

You can access the Custom Report Template Editor through the FBxConnect main menu 
by selecting Configure > Custom Reports > Template Editor or by selecting the Edit 
Template button on the Reports display. If you access the Custom Report Template Editor 
through the FBxConnect main menu, then you are creating or modifying a custom report 
template file located on your PC. You then need to download the modified custom report 
template file to the FB Series product using the Reports display. If you access the Custom 
Report Template Editor through the Edit Template button, then you are modifying a 
custom report template file located on the FB Series product. Any modifications are 
downloaded to the FB Series product when you save your changes. 
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FBxConnect ships with multiple default report templates for daily, batch, and snapshot 
reports. These default report templates are located in the following folder on your PC: 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\CustomReportTemplates  

Template 

A template is used by the system to generate a custom report. You can make a custom 
report template specific to a single FB Series product, or you can create a custom report 
template that is used by multiple FB Series products. You can track the different variations 
of your report template by assigning a unique version to a template and specify the 
default values that the system uses when adding new data placements to the report 
template. For more information, refer to Template Editor – Report Template Properties. 

Section 

Sections allow you to group data together on the report and contain the lines of text and 
data references (placements) you want to appear on the generated report. A template 
contains one of more sections, and each section appears as a separate tab in the 
Template Editor. Each line in a section is 80 characters long. You can add new lines, text, 
and data references (placements) directly to a section using the Template Editor. You can 
customize the names of each section, the section order on the generated report, and the 
symbols used for unavailable data in each section. For more information, refer to 
Template Editor – Report Section Properties. 

Placement 

Placements are references to data in the FB Series product's internal database. You add 
placements to sections of your report template, and those placements are replaced with 
data from the FB Series product's internal database on the generated report. When 
adding a placement to the report template, you can configure a specific parameter in the 
FB Series product's database (OPI) or use a generalized reference to the desired data 
(Map ID and Meter ID) to have the system automatically locate the data in the FB Series 
product database without specifying a specific parameter. You can configure the type of 
data and the presentation of the data on you generated report.  

There are several ways to add a Placement to a Section. You can select Insert > 
Placement from the Template Editor menu bar, right-click the section editor and select 
Insert Placement, or simply type the delimiter symbol ($) directly in the section editor to 
add a placement at the current cursor location. You can select the width of the data 
placement on the generated report. If a placement is not wide enough for the data, a 
hash mark (#) is used on the generated report instead. For more information, refer to 
Template Editor – Placement Properties. 
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You can configure a Placement to reference data using either an OPI or a Map ID and 
Meter ID. 

Note 

You can also pick REPORT_DESC, REPORT_NAME or REPORT_NUM in the Type field on the 
Template Editor – Placement Properties window to reference the report description, 
report name, or report number.  In these cases, the OPI and Map ID fields are not used. 

OPI 

An OPI is a reference to a specific object, parameter, and instance in the FB Series 
product. You use the Point Picker just like you would for configuring meter inputs on a 
regular FBxConnect configuration display. OPIs are device specific, and different FB Series 
products can have different OPIs depending on the configuration. 

Map ID and Meter ID 

Map IDs and Meter IDs are a way to reference data without specifying a specific OPI.  

When configuring a Map ID, you select a Map ID (for example, Meter Tag Name) and the 
system automatically locates the correct data is the FB Series product's database without 
having to configure a specific OPI. For a list of Map IDs and the equivalent FB Series 
product parameters for gas differential pressure meters, gas linear meters, and liquid 
linear meters, refer to Template Editor – Map ID Descriptions. 

The Meter ID works in a similar way to the Map ID. When configuring a Meter ID, you 
select a meter's position in a station (for example, the second meter in the station) and 
the system automatically locates the correct meter. This method of referencing data is 
particularly useful for creating report templates that can be shared between multiple 
stations and multiple meters with different configurations. 

To allow a report template to be shared across different meters, the Meter ID should not 
be specified; in this case the Meter ID defaults to the meter directly referenced by the 
Report Generate Command Parameter (see Reports). If the Report Generate Command 
Parameter references a station parameter, the meter ID defaults to the first meter in the 
station. 

4.23.3.2 Creating a Custom Report Template  

Follow these steps to create a custom report template that generates a report containing 
only the data relevant to your operations. You can use the Template Editor to edit an 
existing report template or create a report template from scratch. The following steps 
show the creation of a simple report template and demonstrate how to add different 
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elements to a report template. Repeat these steps to add additional data to create a more 
complex report. 

Note 

• For an overview of the elements of a report template and the features provided by the 
Template Editor, refer to Template Editor Basics. 

• To create a report template with the maximum amount of flexibility/reuse, data 
should be referenced via Map IDs and Meter IDs rather than OPIs.   

• If you are reusing a report template on stations with differing numbers of meters, 
then it may be advisable to change the symbol used in the Unavailable field to a 
space on the Template Editor – Report Section Properties window. 

To launch the Custom Report Template Editor: 

1. Select Configure > Custom Reports > Template Editor from the FBxConnect™ main 
menu. The Custom Report Template Editor opens and shows a blank report template. 

Figure 274. Custom Report Template Editor 

 

2. Enter a dollar sign ($) in the first character of the first line to add a placement and 
open the Placement Properties window. 
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Figure 275. Placement Properties – Report Name 

 

3. Click ▼ in the Type field and select REPORT_NAME from the drop-down list. This 
configures the generated report to show the text in the Tag field on the Reports 
display to be printed for the selected instance using the report template. 

4. Enter 15 in with Width field. This sets the number of characters that are reserved on 
the generated report for showing the REPORT_NAME value. 

5. Select OK to close the window and return to the Custom Report Editor. 

6. Press the Enter key twice to insert two new lines. 

7. Enter Base Press OPI on the third line. This text will print on the generated report. 
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Figure 276. Base Press OPI Text 

 

8. Arrow over five spaces and enter the dollar sign symbol ($). This gives you a five-
character space after the text you entered in the previous step and inserts a new 
placement. 

9. With the OPI radio button selected, select the browse button ( ). The Point Picker 

dialog opens.  

Note 

The OPI option adds a parameter directly from the FB Series product's internal database 
to the report template. Since the database parameters and configuration may be different 
between devices, a report template with this type of data placement is used for a single 
device. Parameters shown in this example may be different on your device. 
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Figure 277. Point Picker 

 

10. Select Station_1 in the Objects and instances list. 

11. Select Selected Base Pressure in the Parameters list. 

12. Select OK to close the Point Picker. 
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Figure 278. Placement Properties – OPI 

 

13. Click ▼ in the Type field and select OPI_VAL. This will print the value of the selected 
OPI on the generated report. 

14. Enter 10 in the Width field. This sets the number of characters that are reserved on 
the generated report for showing the Selected Base Pressure value. 

15. Click ▼ and select Right in the Align field. This right-aligns the value in the placement 
on the generated report. 

16. Enter 4 in the Decimal Place field. This prints four digits after the decimal place on the 
generated report. 

17. Select OK to close the Placement Properties window and return to the editor. A new 
placement is added to your report template. 

18. Select Insert > Section to add a new section to the report template. 

Note 

Sections are a way to group information on your report. For simplicity and an introduction 
to the concept of sections, this example shows only a single placement in each section. 
Normally you would continue to add multiple placements to a single section, and multiple 
sections are completely optional. 

19. Select the Section 2 tab to start editing the new section. 
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Figure 279. Report Template – Section 2 

 

20. Enter Base Press Map ID on the first character of the first line. This text will print on 
the generated report. 

21.  Arrow over five spaces and enter a dollar sign symbol ($). This gives you a five-
character space after the text you entered in the previous step and inserts a new 
placement. 

Figure 280. Placement Properties – Map ID 
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22. Select the Map ID radio button. 

Note 

The Map ID option adds an abstracted parameter reference to the report template and 
the system automatically locates the correct parameter in the FB Series product's internal 
database. Since you are not configuring a specific parameter and instead configuring an 
abstracted reference, a report template with this type of data placement can be used for 
multiple devices. 

23. Click ▼ in the Map ID field and select Base Pressure (Pb).  

Note 

This adds the same parameter as you selected using the Point Picker in the previous 
steps. For a list of Map IDs and the equivalent FB Series product parameters for gas 
differential pressure meters, gas linear meters, and liquid linear meters, refer to Template 
Editor – Map ID Descriptions. 

24. Click ▼ in the Meter ID field and select 1st meter in the station. 

25. Click ▼ in the Type field and select OPI_VAL. This will print the value of the selected 
Map ID on the generated report. 

26.  Enter 10 in the Width field. This sets the number of characters that are reserved on 
the generated report for showing the Selected Base Pressure value. 

27. Click ▼ and select Right in the Align field. This right-aligns the value in the placement 
on the generated report. 

28. Enter 4 in the Decimal Place field. This prints four digits after the decimal place on the 
generated report. 

29. Select OK to close the Placement Properties window and return to the editor. 

30. Select File > Save As to save your report template to your PC. A Save file as dialog 
opens. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

725 

Figure 281. Save file as 

 

31. Type a unique name into the File name field and select Save. 

Note 

The file name cannot contain any spaces or special characters. 

You have now created your own report template. You can continue to add multiple 
sections and parameters to your report template. When you have completed building 
your report template and are ready to print a report, refer to Generating Custom Reports. 

4.23.3.3 Template Editor – Menu Bar 

Use the Menu Bar to access tools that allow you to customize your report template. 
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Figure 282. Custom Report Template Editor – Menu Bar 

 

Menu Description 

File Use these options to create a new report template, open an existing 
report template or save the currently opened report template. 

New Opens a blank template. 

Open Opens an existing template. Templates can be saved 
as individual files or as part of a solution file. The 
default templates are located in the following folder: 
C:\Users\Public\Documents\Emerson\ 
FieldTools\FBx\CustomReportTemplates 

Open in 
Windows 

Opens the current template in Windows using your 
choice of XML editor. 

Note 

The custom report template must already have a file 
name (either saved by you or a pre-existing template) 
to use this feature. 

Save to 
Device 

Saves the report template file to memory on your FB 
Series product. 

Save As Opens the Save As dialog which allows you to enter a 
unique file name and specify a location on your PC to 
save the report template file. 

Note 

The file name cannot contain any spaces or special 
characters. 
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Menu Description 

Print Opens the Print dialog which allows you to print the 
currently opened report template. 

Exit Closes the Custom Report Template Editor. 

Insert Use these options to customize the data that is shown on your report. 

Placement Inserts a data placement at the current cursor 
location. 

Note 

You can also right-click the report template and select 
Insert Placement to perform this task. 

Line Inserts a new line below the current cursor location. 

Note 

You can also right-click the report template and select 
Insert Line to perform this task. 

Section Adds a new section tab before the currently selected 
section tab. To customize the order, name, and add 
or remove a section, refer to Template Editor – 
Report Section Properties. 

Edit Use these options to modify the text and placements on your report 
template. 

Cut Cut the information currently selected in your report 
template and place it on the clipboard. 

Copy Copy the information currently selected in your 
report template to the clipboard. 

Paste Paste the information from the clipboard that you 
previously cut or copied. 

Refresh Reloads the last saved copy of the current report 
template. 

Select All Selects all information on the report template. 

View Use these options to view various properties and adjust the viewing 
size of the report template. 

Template 
Info 

Opens the Report Template Properties window. For 
more information, refer to Template Editor – Report 
Template Properties. 
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Menu Description 

Section Info Opens the Report Section Properties window. For 
more information, refer to Template Editor – Report 
Section Properties. 

Placement 
Info 

Opens the Placement Properties window. For more 
information, refer to Template Editor – Placement 
Properties. 

Zoom In Increase the viewing size of the report template in 
the Custom Report Template Editor window. 
Note 
You can also use ctrl + mouse wheel to control the 
zoom. 

Zoom 
Default 

Restore the default viewing size of the report 
template in the Custom Report Template Editor 
window. 

Help Use these options to open the online help and view Custom Report 
Template Editor version information. 

Help Opens the online help. 

About View the Custom Report Template Editor version 
installed on your PC. 

 

4.23.3.4 Template Editor – Toolbar 

Use the toolbar icons as shortcuts to commonly used features in the Custom Report 
Template Editor window. 

Figure 283. Custom Report Template Editor – Toolbar 
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Field Description 

Placement (
) 

Opens the Placement Properties window when your cursor is located in 
an existing placement. You can also click ▼ and select one of the 
options below: 

Template & 
Defaults 

Opens the Report Template Properties window which 
allows you to update the version number of the 
template and modify the default values the system 
uses when adding new placements to the currently 
opened report template. For more information, refer 
to Template Editor – Report Template Properties. 

Sections Opens the Report Section Properties window which 
allows you to add, remove, and customize the sections 
in your report template. For more information, refer to 
Template Editor – Report Section Properties. 

Save ( ) Saves the currently opened report template to a file on your PC.  

Note 

• If the current template does not have a file name, selecting this 
option opens the Save As dialog. 

• If you access the Custom Report Template Editor from the Edit 
Template button on the Custom Reports – Reports display, this 
option downloads the report to the FB Series product and saves the 
template to the FB Series product's flash memory. 

Cut ( ) Cut the information currently selected in your report template and 
place it on the clipboard. 

Copy ( ) Copy the information currently selected in your report template to the 
clipboard. 

Paste ( ) Paste the information from the clipboard that you previously cut or 
copied. 

 

4.23.3.5 Template Editor – Report Template Properties 

Use the Report Template Properties pop-up window to update the version number of the 
template and modify the default values the system uses when adding new placements to 
the currently opened report template.   

To open the Report Template Properties pop-up window: 
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1. Either select View > Template Info from the Template Editor Menu Bar or select the 
Placement icon ( ) and select Template & Defaults. The Report Template 
Properties pop-up window opens. 

Figure 284. Report Template Properties 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

User Version Enter a unique number for this version of the report template. 

Default 
Properties 

Use these fields to specify the default values when adding placements 
to the template. 

Note 

These are just the defaults. You can customize these values later when 
adding each placement to your report template. 

Align Click ▼ and select the alignment of data shown in the 
placement on the generated report. Possible options 
are Left and Right. 
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Field Description 

Width Sets the number of characters on the report for the 
placement value. Valid values are 0 – 80. The default is 
5. 

Note 

If the placement value is longer than the value set in 
the Width field, then the pound sign (#) is shown on 
the generated report and indicates that the width is 
insufficient to display the value. Enter a larger value in 
the Width field to avoid data loss. 

Decimal 
Place 

Sets the number of digits that should print after 
decimal on the generated report. Valid values are 0 – 
80. The default is 2. 

3. Select OK to save any changes you make to this window. 

4.23.3.6 Template Editor – Report Section Properties 

Use the Report Section Properties pop-up window to add, remove, and customize the 
sections in your report template. You can modify the name, order, delimiter symbol, and 
unavailble data symbol used for each section.   

To open the Report Section Properties pop-up window: 

1. Either select View > Section Info from the Template Editor Menu Bar or select the 
Placement icon ( ) and select Sections. The Report Section Properties pop-up 
window opens. 
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Figure 285. Report Section Properties 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Sections List Shows a list of the sections in the report template. Each row consists of 
the current section position, name, delimiter symbol, and unavailable 
symbol. Use the up and down arrows to reorder the sections in your 
report template.  

Add Creates a new section at the end of the current sections. 

Remove Deletes the currently selected section from the report template. 

Update Saves any modifications you have made to the selected sections name, 
delimiter symbol, or unavailable symbol. 

Name Enter a unique name for the currently selected section.  

Note  

You must select Update before selecting a different section from the 
section list to save your changes.  

Delimiter Click ▼ to select a symbol to use as a delimiter for the currently 
selected section. A delimiter is used to indicate the placement of data 
when designing your report template. Possible options are currently 
limited to $.  

Note  

You must select Update before selecting a different section from the 
section list to save your changes.  
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Field Description 

Unavailable Click ▼ to select a symbol to use when report data is unavailable from 
the FB Series product. This symbol will appear if a data placement is 
included in the report template, but the requested data is not in the FB 
Series product's database. For example, if the report template includes 
a placement for a liquid meter tag but your FB Series product does not 
contain a liquid meter, then this symbol will appear on the custom 
report. Valid options are * or blank ( ).  

Note  

You must select Update before selecting a different section from the 
section list to save your changes.  

3. Select OK to save any changes you make to this window. 

4.23.3.7 Template Editor – Placement Properties 

The Placement Properties window allows you to specify the data show on the generated 
report.  

To open the Placement Properties window: 

1. For a new placement, either select Insert > Placement from the FBxConnect™ main 
menu or type the delimiter symbol ($) to insert a new data placement at the current 
cursor location and a Placement Properties windows open for the new placement.  
For an existing placement, either select View > Placement Info when your cursor is 
in an existing placement, select the Placement icon ( ) when your cursor is in an 
existing placement, or double-click a placement in the Template Editor to open the 
Placement Properties window for an existing placement. 
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Figure 286. Placement Properties 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

OPI 
Select this radio button and select browse ( ) to open the Point 
Picker dialog and choose a parameter from the FB Series product 
internal database to show on the report.  
Note 
• This field is unavailable if you select the Map ID radio button. 

• This field is unavailable if you select REPORT_NAME, REPORT_DESC, 
or REPORT_NUM in the Type field. 

Map ID Select this radio button and click ▼ to select a generalized reference 
(Map ID) to show on the report. When the report is generated, the 
system automatically locates the correct data in the FB Series product 
database based on the selected Map ID without the need to configure 
a specific OPI. For more information, refer to Template Editor Basics. 
Note 
• This field is unavailable if you select the OPI radio button. 

• This field is unavailable if you select REPORT_NAME, REPORT_DESC, 
or REPORT_NUM in the Type field. 

• You can search the drop-down list by typing in a keyword in Map ID 
field to narrow the possible options to Map IDs containing the 
entered text. 

• For a list of possible Map IDs and their associated parameters in the 
FB Series product, refer to Template Editor – Map ID Descriptions. 
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Field Description 

Meter ID Click ▼ and select which meter in the station contains the data 
configured in the Map ID field. When the report is generated, the 
system automatically locates the correct data in the FB Series product 
database based on the selected Meter ID without the need to 
configure a specific OPI. Possible options are Undefined and 1st 
meter in the station through 36th meter in the station. 
Note 
• This field is unavailable if you select the OPI radio button. 

• This field is unavailable if you select REPORT_NAME, 
REPORT_DESC, or REPORT_NUM in the Type field. 

Type Click ▼ and select the type of data to show on the generated report. 
Possible values are OPI_VAL, OPI_UNIT, OPI_ENUM_SHORT, OPI_TIME, 
OPI_DATE, REPORT_DESC, REPORT_NAME, and REPORT_NUM. 
• OPI_VAL is used to show a value of a parameter of type FLOAT, 

DOUBLE, INT8/16/32/64, UINT8/16/32/64, ENUM16, UC10/20/30/40, 
TIME, BIN8/16/32.  Types BINARY, BYTEARRAY4/6/32, MEMREF, 
OBJREF, PRMREF, UDT are not supported. TIME values are displayed 
as the date followed by the time according to the configured 
localization format (refer to Localization). 

• OPI_UNIT is used to show the engineering unit (if any) associated 
with the OPI or Map ID parameter.  

• OPI_ENUM_SHORT is used to show the enumerated string (if any) 
associated with the OPI or Map ID parameter. For example, Liq 
Prod_x.LIQ_TYPE. 

• OPI_TIME is used to show only the hour, minute, and seconds for 
an OPI / Map ID value that is a ‘time’ type. The value is shown 
according to the configured localization format (refer to 
Localization).  

• OPI_DATE is used to show only the day, month, and year for an OPI 
/ Map ID value that is a ‘time’ type. The value is shown according to 
the configured localization format (refer to Localization). 

• REPORT_DESC is used to show the Report Description for the report 
you are editing. 

• REPORT_NAME is used to show the Report Name for the report you 
are editing. 

• REPORT_NUM is used to show the Report Number for the report 
you are editing. 
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Field Description 

Align Click ▼ and select the alignment of data shown in the placement on 
the generated report. Possible options are Left and Right.  
Note 
If you do not specify a value, the system uses the default value (shown 
in parentheses) configured on the Template Editor – Report Template 
Properties window. 

Width Sets the number of characters on the report for the placement value. 
Valid values are 0 – 80. The default is 5. 
Note 
If you do not specify a value, the system uses the default value (shown 
in parentheses) configured on the Template Editor – Report Template 
Properties window.  
If the placement value is longer than the value set in the Width field, 
then the pound sign (#) is shown on the generated report and indicates 
that the width is insufficient to display the value. Enter a larger value in 
the Width field to avoid data loss. 

Decimal Sets the number of digits that should print after decimal on the 
generated report. Valid values are 0 – 80. The default is 2. 
Note 
If you do not specify a value, the system uses the default value (shown 
in parentheses) configured on the Template Editor – Report Template 
Properties window. 

3. Select OK to save any changes you make to this display. 

4.23.4 Printers 

Use this display to configure a network or serial printer used for custom reports.  

Note 

• You must configure at least one printer in the Number of Printers field on the Report 
and Printer Setup display before you can access this display. 

• Network printer support is provided using Raw TCP/IP Printing (Port 9100). 

• Serial printer support without handshaking is supported via the main CPU personality 
module only. 
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• Both serial and network printers provide support for ASCII characters only and a 
limited subset of UTF-8 characters. Unsupported characters are printed as a blank 
space. 

• An event is not logged if a report does not print. 

To access this display: 

1. Select Configure > Custom Reports > Printers from the FBxConnect™ main menu. 

Figure 287. Printers 

 

2. Click ▼ in the drop-down list at the top of the display to select a Printers instance to 
configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
printer. 
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Field Description 

Status This read-only field indicates the overall health of the selected printer. 
The status indicates Link error in the event of a printer communication 
problem. 

IP Address Enter the IP Address of the selected printer. 

Note 
This field shows only if you select either Ethernet Port 1 or Ethernet 
Port 2 in the Comm Port Selection field and save your changes. 

Printer Port 
ID 

Enter the TCP/IP port of the selected printer. 

Note 
This field shows only if you select either Ethernet Port 1 or Ethernet 
Port 2 in the Comm Port Selection field and save your changes. 

Comm Port 
Selection 

Click ▼ to select an Ethernet or serial communications port on the FB 
Series product that is used to send data to the connected printer. 

 

4.23.4.1 Printer Alarms/Errors 

If the configured printer is offline (misconfigured IP Address, printer power is off, etc.), 
then the system writes a Set Alarm record to the alarm log. When the printer comes back 
online, then the system writes a Clear Alarm record to the alarm log. 

Figure 288. Printer Alarms 

 

If you try to print a custom report and the configured printer is offline, the report is 
stored in a queue. The printer queue can store a maximum of 200 print commands. If you 
exceed this limit, then the system logs a printer queue alarm in the alarm log. 

Note 

In the event of a power fail, unprinted reports are not automatically printed. 
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4.23.5 Generating Custom Reports 

To generate a custom report: 

Note 

• To generate a custom report, you must have FB Series product firmware version 2.17 
or later and Field Tools version 3.17 or later. 

• You must import a custom report template before you can generate a custom report. 
Emerson provides sample custom report templates with FBxConnect™. The default 
location for the custom report templates is: 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\CustomReportTemplates. 

• For information about creating your own template, refer to Creating a Custom Report 
Template. 

1. Select Configure > Custom Reports > Report and Printer Setup from the 
FBxConnect™ main menu. The Report and Printer Setup display opens. 
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Figure 289. Report and Printer Setup 

 

2. To enable reporting feature, enter a number from 1 to 36 in the Number of Reports 
field.  

3. Select Save to save your changes. 

4. Select Configure > Custom Reports > Reports from the FBxConnect™  main menu. 
The Reports display opens. 
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Figure 290. Template Management Button 

 

5. (Optional) Add a description for the selected report instance in the Description field. 

6. Select the Template Management button to open the Custom Report Template 
dialog and select your custom report template. For more information about the 
Custom Report Templates dialog, refer to Template Management. 
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Figure 291. Reports – Save 

 

7. Select Save to save your changes. You now have a custom report template loaded in 
the FB Series product and can generate a custom report.  
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Figure 292. Generate Report Now 

 

8. Select the Generate Report Now button. A confirmation message opens after 
generating the report successfully. 

Figure 293. Confirmation 

 

9. Select OK to close the message.  

Note 

• If an error occurs while generating the report, a “Report failed” message is displayed. 
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• For information about viewing custom reports, refer to Viewing Custom Reports. 

4.23.6 Viewing Custom Reports 

After you have generated a report, you can download the report from the FB Series 
product’s memory to your PC using the Upload Custom Reports option located in the 
Reports menu or File Transfer option located in the Services menu. 

4.23.7 Deleting Custom Report Files and Templates 

You can delete reports that are stored in the FB Series product’s flash memory by 
performing a Cold Start and selecting either Database is re-initialized with factory 
defaults (this option deletes all custom report files and all custom report templates) or 
Leave database unchanged and Clear History (this option deletes all custom report files 
but does not delete any custom report templates). 

4.23.8 Manually Creating a Custom Report Template XML File 

The custom report template is an XML file that determines the layout and content of your 
custom report. The custom report template XML schema contains the rules, elements, 
and attributes you must follow when creating a custom report template XML file. When 
importing your custom report template, FBxConnect™ validates the file to verify it 
contains the required XML schema. You must strictly follow this schema to successfully 
import a custom report template. Failure to follow this schema results in an error when 
you try to import the template.  



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

745 

Figure 294. Custom Report Template XML File Example 

 

When importing a custom report template, FBxConnect™ performs the following 
validations: 

• Template is a valid XML format. 

• Only one XML tag appears per line. 

• Does not contain Tabs. 

• Has Report Sections and each report section has Layout and Metadata. 

• XML attributes (such as Align1, Type, etc.) have valid values. 

• An OPI placement of OPI1. 

• Object name of an OPI exists in the database. 

• Parameter name of an OPI exists in the database (does not apply to object 
references). 

• Number of delimiters in the Layout element is equal to the number of placements in 
the Metadata element. 
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• Delimiter must be 1 character long. Delimiter must be a punctuation character, but it 
cannot be any of the following: <>[] 

• String XML Attributes must have a value when specified. 

• Validation of widths. For example: 

o The number of characters between two delimiters is less than Width1. 

o The width would not cause the length of the line to exceed 80 characters. 

Note 

• You should have a working knowledge of XML files before attempting to create your 
own custom report template. 

• Emerson provides sample custom report templates with FBxConnect™. The easiest 
way to get started creating your own custom report templates is to modify one of the 
sample templates. The default location for the custom report templates is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\CustomReportTemplates. 

• Templates stored in the FB Series product’s flash memory are saved as part of your 
solution file when you Upload a Solution. 

To create your own custom report template, use only the following elements and 
attributes in your custom report template XML file: 

Element Description 

<ReportTemplate> Provides a way to version the template file.  

Example: <ReportTemplate Version="1"> 

<Defaults> Optional. Use this element to set the default values for Width1, 
DecimalPlace1, and Align1. If you do not set a value for these 
parameters, default values are used for report formatting. The 
Defaults element is a child element of the ReportTemplate 
element and a sibling element of the ReportSections element. 

<ReportSections> Every template file has a single ReportSections. The single 
ReportSections element can consists of multiple ReportSection 
child elements. 
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Element Description 

<ReportSection> A single section of the report. The ReportSection element 
contains the information for the layout (contained in the Layout 
element) and data (contained in the Metadata element) of a 
single section of the report. The ReportSection element is a child 
element of the ReportSections element. You can add multiple 
ReportSection elements to the ReportSections element. Each 
ReportSection element consists of Layout element and a 
Metadata element. 

<Layout> The page location of data on the generated report. The Layout 
element is a child element of the ReportSection element. 

Note 
Lines in the Layout element cannot exceed 80 characters. 

Delimiter An attribute of the Layout element. A single 
special symbol (for example, $ or #) used to 
indicate the placement of data when designing 
your layout. This symbol is replaced with an 
actual value on the generated report. Each 
delimiter is associated with a Placement 
element and its value. For example, the second 
delimiter used in the Layout element is 
associated with the second Placement element. 

Note 
The configured symbol should not be used 
elsewhere in the Layout element. 

<Metadata> A container element for information about the parameter values 
and formatting contained in the generated report.  

<Placement>   Defines the data contained in the generated report and the 
formatting of that data. The Placement element is a child element 
of the Metadata element. You can add multiple Placement 
elements to each ReportSection element. You control the data 
shown on the report by configuring attributes of the Placement 
element. Each configured attribute in the Placement element 
must have a corresponding delimiter in the Layout element. 
Possible attributes are Type, OPI1, MapId1, Mtr1, Width1, 
DecimalPlace1, Align1. 
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Element Description 

Type Sets the type of data to show on the generated 
report. Possible values are OPI_VAL, OPI_UNIT, 
OPI_ENUM_SHORT, OPI_TIME, OPI_DATE, 
REPORT_DESC, REPORT_NAME, and 
REPORT_NUM. 

• OPI_VAL is used to show a value of a 
parameter of type FLOAT, DOUBLE, 
INT8/16/32/64, UINT8/16/32/64, ENUM16, 
UC10/20/30/40, TIME, BIN8/16/32. Types 
BINARY, BYTEARRAY4/6/32, MEMREF, 
OBJREF, PRMREF, UDT are not supported. 
TIME values are displayed as the date 
followed by the time according to the 
configured localization format (refer to 
Localization). 

• OPI_UNIT is used to show the engineering 
unit (if any) associated with the OPI or Map 
ID parameter.  

• OPI_ENUM_SHORT is used to show the 
enumerated string (if any) associated with 
the OPI or Map ID parameter. For example, 
Liq Prod_x.LIQ_TYPE. 

• OPI_TIME is used to show only the hour, 
minute, and seconds for an OPI / Map ID 
value that is a ‘time’ type. The value is 
shown according to the configured 
localization format (refer to Localization).  

• OPI_DATE is used to show only the day, 
month, and year for an OPI / Map ID value 
that is a ‘time’ type. The value is shown 
according to the configured localization 
format (refer to Localization). 

• REPORT_DESC is used to show the Report 
Description for the report you are editing. 
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Element Description 
• REPORT_NAME is used to show the Report 

Name for the report you are editing. 

• REPORT_NUM is used to show the Report 
Number for the report you are editing.  

OPI1 Enter the Tag from the FB Series product 
database for the OPI value to show the on the 
generated report.  

Note 
If you configure an invalid OPI in the template, 
then an asterisk (*) is shown on the generated 
report. 

MapId1 Sets the specific parameter information to be 
placed, without having to specify an OPI tag. 
This can be advantageous when developing 
report templates to generic and work with 
multiple instances or multiple report types 
(Batch, Hourly, Daily, etc). The Map ID is a 
unique number which is not typically entered 
manually. Instead, these numbers can be 
applied to the template XML file using the 
Custom Report Template Editor. 

Note 

This attribute is not used with a direct OPI 
(OPI1) attribute. 

Mtr1 Sets the meter instance to be used. This 
attribute is used when a report includes data 
for multiple meter instances at once. Valid 
values are 1 through 36.  

Note 

This attribute is applicable only when used in 
conjunction with a Map ID (MapId1). This 
attribute is not used with a direct OPI (OPI1) 
attribute. 
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Element Description 

Width1 Sets the number of characters on the report for 
the OPI value. Valid values are 0 – 80. The 
default is 1. 

Note 

• If the OPI value is longer than the Width1 
value, the pound sign (#) is shown on the 
generated report and indicates that the 
width is insufficient to display the value. 
Enter a larger Width1 value to avoid data 
loss. 

• If the Width1 value is not specified, the 
Width1 value from the Defaults element is 
used. 

DecimalPlace1 Sets the number of digits that should print after 
decimal on the generated report. Valid values 
are 0 – 80. The default is 0. 

Note 

If the DecimalPlace1 value is not specified, the 
DecimalPlace1 value from the Defaults element 
is used. 

Align1 Sets the alignment. Possible values are Left or 
Right. The default is Left. 

Note 

If the Align1 value is not specified, the Align1 
value from the Defaults element is used. 

</Metadata> Metadata section end tag. 

</Layout> Layout section end tag. 

</ReportSection> ReportSection section end tag. 

</ReportSections> ReportSections section end tag. 

</Defaults> Default section end tag. 
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Element Description 

<!--Comment--> A single line comment (replace Comment with your own plain 
text. 

Note  

• Multi-line comments are not supported. 

• A comment must not include any special XML characters 
such as <, >, etc. 

 

4.24 PID Loops 

Proportional, Integral, and Derivative (PID) controls enable you to provide smooth and 
stable operation for feedback control loops that employ a regulating device, such as a 
control valve or a motor. The typical use for PID is to control a process variable to a 
setpoint. FB3000 RTUs allow you to dynamically resize the number of instances to fit your 
specific needs on the Control Setup display. 

PID is the most common control methodology in process control. PID is a continuous 
feedback loop that keeps the process flowing normally by taking corrective action 
whenever any deviation from the desired value (setpoint) of the process variable (rate of 
flow, temperature, voltage, and such) occurs. An "error" occurs when an operator 
manually changes the setpoint or when an event (such as a valve opening or closing) or a 
disturbance changes the load, thus causing a change in the process variable. 

The PID controller receives signals from sensors and computes corrective action to the 
actuators from a computation based on the error (proportional), the sum of all previous 
errors (integral) and the rate of change of the error (derivative). 

To access this display, select Configure > PID Loops from the FBxConnect™ main menu. 

Figure 295. PID Loops 

 

The PID Loops display contains the following items: 

General – Use this display to configure general PID loop parameters, including enabling 
the PID loop, selecting the PID loop type, and configuring the setpoints. 
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Inputs/Outputs – Use this pop-up display to configure the inputs and outputs of the PID 
loop. 

Advanced – Use this pop-up display to configure advanced PID parameters, including the 
loop period, ramp rates, and output deadband. 

Tuning – Use this pop-up display to configure the PID tuning parameters. 

4.24.1 PID Loops – General 

Use this display to configure general PID loop parameters, including enabling the PID 
loop, selecting the PID loop type, and configuring the setpoints. 

To access this display: 

1. Select Configure > PID Loops from the FBxConnect™ main menu. The PID Loops 
display opens showing the General tab. 

2. Click ▼ in the drop-down list at the top of the display to select an instance to 
configure. 
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Figure 296. PID Loops – General  

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the 
selected instance. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected instance. 

Enable Switch Sets the status of the selected PID loop instance. 

Enable The PID loop is active. 

Disable The PID loop is not active, no inputs are updated, 
and no calculations are performed. 

Output Mode Sets the output mode of the selected PID loop instance. Possible 
options are: 
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Field Description 

Auto Active control is performed. You enter a setpoint and 
the system automatically sends the calculated output 
to the configured output point. 

Note 

You cannot set the output mode to auto, until a valid 
process variable input and control output have been 
defined on the Inputs/Outputs tab. 

Manual No active control is performed. The PID control 
output is assigned to the value you enter for the 
manual position. 

Output Type Sets the output type for the PID loop. Possible options are: 

Discrete The system writes the PID control output to the 
assigned DO used to raise the control element if the 
change in output is positive, or write to the assigned 
DO used to lower the control element if the change 
in output is negative. 

Analog The system writes the PID control output to the 
assigned analog output point, or equivalent analog 
style parameter. 

Note 

The system calculates the change in output using the following 
algorithm: 

Change in Output = DF * PG * (errCng + (IG * ALP * err) + (DG * 
ΔRPC)) 

Where: 

DF = Direction Factor (forward = 1.0 and reverses = -1.0) 

PG = Proportional Gain (entered by user) 

IG = Integral Gain (entered by user) 

DG = Derivative Gain (entered by user) 

errCng = Error Change (error – last error) 

ALP = Actual Loop Period (measured in minutes) 

err = Error (Process Variable – Setpoint) 

ΔRPC = Delta Rate of Process Variable Change (Rate of PV 
Change – Last Rate of PV Change) 
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Field Description 

PID Loop Type Sets the control type for PID loop. Possible options are: 

Primary 
Only 

Sets the Primary loop as the only active loop. The 
system uses the output the Primary loop calculates 
to adjust the control output. 

Override 
Only 

Sets the Override loop as the only active loop. The 
system uses the output the Override loop calculates 
to adjust the control output. 

Note 

This control type is used mainly for tuning the 
Override loop, or when the loop selection is 
controlled by other logic external to the PID 
algorithm. 

Dual 
Control 

Sets both the Primary and Override loops as active. 
The system compares the outputs from the two 
loops and uses either the lesser or greater of the two 
outputs (based on the selection in the Override Type 
Select field) to adjust the control output. 

Selected Loop This read-only field shows the status of the selected PID loop 
instance. 

Primary/Override 
Setpoint Value 

Sets a setpoint value for controlling the Primary PID loop's process 
variable and the Override PID loop's process variable. 

Primary/Override 
Process Variable 
Value 

This read-only field shows the current value of the primary and 
override process variables. 

Note 

The process variables are configured on the PID Loops – 
Inputs/Outputs pop-up display. 

Primary/Override 
Change in 
Output 

This read-only field shows the calculated change in output from 
the associated loop. 

Primary/Override 
Setpoint 
Tracking 

Sets how the system tracks setpoint and process variable values 
when moving between Auto and Manual modes in the Output 
Mode field. Possible options are: 
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Field Description 

Enable If Setpoint Tracking is set to Enable and the 
Output Mode is Auto, then the system sets the 
value in the Manual Position field equal to the 
current output value. 

If Setpoint Tracking is set to Enable and the 
Output Mode is Manual, then the system sets the 
value in the Setpoint field equal to the process 
variable. 

Disable If Setpoint Tracking is set to Disable and the 
Output Mode is Auto, then the value in the Current 
Output field is copied to the Manual Position field 
to provide for a bumpless transfer when switching 
from Auto to Manual mode.  
If Setpoint Tracking is set to Disable and the 
Output Mode is Manual, then the setpoint value 
remains unchanged and the system sets the integral 
action field to the value required to maintain the 
current position. 

Override 
Threshold Value 

Sets the threshold to prevent premature selection of the Override 
loop. If the Override process variable is outside of this threshold 
on the safe side of the Override setpoint, the system always 
selects the Primary loop. However, if the Override process variable 
is within the threshold of the Override setpoint or is on the unsafe 
side of that setpoint, the system can select the Override loop. 

Note 

If you set the Override Threshold Value to 0.0, the system uses 
the high/low value of the Override Type Select field to select the 
appropriate change, regardless of the error in the Override loop. 

Override Type 
Select 

Sets the control output for the Override Type. Possible options 
are: 

High Selects as the change in the control output either the 
higher of the Primary Change In Output value or 
the Override Change In Output value. 

Low Selects as the change in the control output either the 
lesser of the Primary Change In Output value or 
the Override Change In Output value. 
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Field Description 

Current Output 
of PID 

This read-only field shows the value of the PID loop. 

Digital Output 1 
(Raise) 

This read-only field shows the value of the Digital Output (Raise) 
configured on the PID Loops – Inputs/Outputs pop-up display. 

Note 

This field appears only if you select Discrete in the Output Type 
field.  

Digital Output 2 
(Lower) 

This read-only field shows the value of the Digital Output (Lower) 
configured on the PID Loops – Inputs/Outputs pop-up display. 

Note 

This field appears only if you select Discrete in the Output Type 
field.  

Manual Position 
% (In Manual 
Mode) 

Sets the value that will be assigned to the PID control output when 
the Output Mode is set to Manual. 

Input Health 
Status 

This read-only field shows the quality of the data received from 
the parameter selected in the Primary/Override Process 
Variable Input field on the PID Loops – Inputs/Outputs pop-up 
display. 

Setpoint Health 
Status 

This read-only field shows the quality of the data received from 
the parameter selected in the Primary/Override Setpoint Input 
field on the PID Loops – Inputs/Outputs pop-up display. 

Output Health 
Status 

This read-only field shows the quality of the data received from 
the parameter selected in the Analog Output Point field on the 
PID Loops – Inputs/Outputs pop-up display. 

Note 

This field appears only if you select Analog in the Output Type 
field.  

4. Select Save to save any changes you make to this display. 

4.24.2 PID Loops – Inputs/Outputs  

Use this pop-up display to configure the inputs and outputs of the PID loop. 

To access this tab: 
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1. Select Configure > PID Loops from the FBxConnect™ main menu. The PID Loops 
display opens. 

2. Click ▼ in the drop-down list at the top of the display to select a PID loop to configure. 

3. Select the Inputs/Outputs button. The PID Loops – Inputs/Outputs pop-up display 
opens. 

Figure 297. PID Loops – Inputs/Outputs  

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Primary / 
Override 
Process 
Variable Input 

Click  to open a Point Picker dialog and select a parameter to use 

as the primary and override process variable. 
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Field Description 

Primary / 
Override 
Process 
Variable Value 

This read-only field shows the current value of the parameter 
selected in the Primary/Override Process Variable Input field. 

Input Health 
Status 

This read-only field shows the quality of the data received from the 
parameter selected in the Primary/Override Process Variable Input 
field. 

Primary / 
Override 
Process 
Variable Low 
Limit 

Sets the low limit for the process variable in the same engineering 
units of the process variable. 

Primary / 
Override 
Process 
Variable High 
Limit 

Sets the high limit for the process variable in the same engineering 
units of the process variable. 

Primary / 
Override 
Setpoint Input 

Click  to open a Point Picker dialog and select a parameter to use 

as the setpoint. 

Primary / 
Override 
Setpoint Value 

If a parameter is defined in the Primary/Override Setpoint Input field, 
this read-only field shows the value of that parameter. If the 
Primary/Override Setpoint Input field is Undefined, enter a setpoint 
value. 

Primary / 
Override 
Setpoint 
Health Status 

This read-only field shows the quality of the data received from the 
parameter selected in the Primary/Override Setpoint Input field. 

Primary / 
Override 
Control Action 
Direction 

Selects the direction in which the PID control loop will act. 

Reverse The control output decreases as the process variable 
increases. 

Forward The control output increases as the process variable 
increases. 
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Field Description 

Analog 
Output Point 

Click  to open a Point Picker dialog and select an analog output 

point for the loop. 

Note 

This field appears only if you select Analog in the Output Type field 
on the PID Loops – General display. 

Current 
Output of PID 

This read-only field shows the current value of the parameter 
selected in the Analog Output Point field. 

Note 

This field appears only if you select Analog in the Output Type field 
on the PID Loops – General display. 

Output Health 
Status 

This read-only field shows the quality of the data received from the 
parameter selected in the Analog Output Point field. 

Note 

This field appears only if you select Analog in the Output Type field 
on the PID Loops – General display. 

Digital Output 
1 (Raise) 

Click  to open a Point Picker dialog and select an open point for 

the loop. 

Note  

• The Digital Output (Raise) and Digital Output (Lower) values, 
respectively, open or close the valve or other device. 

• This field appears only if you select Discrete in the Output Type 
field on the PID Loops – General display. 

Digital Output 
2 (Lower) 

Click  to open a Point Picker dialog and select a close point for the 

loop. 

Note  

• The Digital Output (Raise) and Digital Output (Lower) values, 
respectively, open or close the valve or other device. 

• This field appears only if you select Discrete in the Output Type 
field on the PID Loops – General display. 

Output 
Clamping 
Mode 

Select to prevent the output from going above the value set in the 
High Limit field or falling below the value set in the Low Limit field. 

Enable Output value is limited to values between the output Low 
Limit and the High Limit (recommended). 
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Field Description 

Disable Output value is not limited. 

Note 

This field appears only if you select Analog in the Output Type field 
on the PID Loops – General display. 

Output 
Clamping 
High Limit 
Value 

Sets the high limit for the analog. If a change in output causes the 
current value to rise above this value, the system sets the output to 
High Limit value. 

Output 
Clamping Low 
Limit Value 

Sets the low limit for the analog. If a change in output causes the 
current value to fall below this value, the system sets the output to 
the Low Limit value. 

5. Select Save to save any changes you make to this display. 

4.24.3 PID Loops – Advanced  

Use this pop-up display to configure advanced PID parameters, including the loop period, 
ramp rates, and output deadband. 

To access this pop-up display: 

1. Select Configure > PID Loops from the FBxConnect™ main menu. The PID Loops 
display opens. 

2. Click ▼ in the drop-down list at the top of the display to select a PID loop instance to 
configure. 

3. Select the Advanced button. The PID Loops – Advanced pop-up display opens. 
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Figure 298. PID Loops – Advanced 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Loop Period Sets the period (in seconds) of time between executions of the PID 
algorithm. This is the amount of time between executions from the 
beginning of one execution to the beginning of the next. 

Note 

If you select Dual Control, both loops are executed in this time 
period. 

Action of 
Output on 
Unhealthy 
Data Quality 

Selects the action to be taken when the process variable or live 
setpoint values report a data quality of Fault.  

Note 

This feature does not apply to data quality indications of Override or 
Alarm. 

Manual 
Mode 

The Output Mode is changed to Manual and the 
value you configure in the Manual Position field (PID 
Loops – General) is applied to the control output. 

Continue The PID control loop continues in the current output 
mode and no action is taken. 
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Field Description 

Resume PID 
Control On 
System 
Restart 

Sets if the PID loop automatically resumes when the system restarts. 

Enable The PID loop does automatically resume when the 
system restarts. 

Disable The PID loop does not automatically resume when the 
system restarts. 

Output Ramp 
Rate Per 
Second 

Sets the allowed limit of change in the control output from one cycle 
to the next. A value of zero disables this feature. 

Primary 
Setpoint Ramp 
Rate Per 
Second 

Sets a length of time (in seconds) the maximum rate at which the 
Primary PID setpoint can ramp to a new value. 

Primary 
Control 
Deadband 

Sets a "window" around the setpoint for the Primary PID loop. When 
the process variable is within this window, the system does not apply 
the calculated change in output. If you enter 5, the deadband is a 
region of 5 units above and 5 units below the setpoint in which the 
process variable can move without affecting the output. 

Override 
Setpoint Ramp 
Rate Per 
Second 

Sets a length of time (in seconds) the maximum rate at which the 
Override PID setpoint can ramp to a new value. 

Override 
Control 
Deadband 

Sets a "window" around the setpoint for the Override PID loop. When 
the process variable is within this window, the system does not apply 
the calculated change in output. If you enter 5, the deadband is a 
region of 5 units above and 5 units below the setpoint in which the 
process variable can move without affecting the output 

5. Select Save to save any changes you make to this display. 

4.24.4 PID Loops – Tuning 

Use this pop-up display to configure the PID tuning parameters. The trend appears in a 
chart at the bottom of the display. 
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Note 

• If you select Primary Only in the PID Loop Type field on the PID – General display, 
the Primary Process Variable Value, Primary Setpoint Value, and Current Output of 
PID are shown in the chart. 

• If you select Override Only in the PID Loop Type field on the PID – General display, 
the Override Process Variable Value, Override Setpoint Value, and Current Output of 
PID are shown in the chart. 

• If you select Dual Control in the PID Loop Type field on the PID – General display, 
the Primary Process Variable Value, Primary Setpoint Value, Override Process Variable 
Value, Override Setpoint Value, and Current Output of PID are shown in the chart. 

When viewing a chart on the display, your mouse has the following functionality: 

• Mouse Wheel – Scroll the mouse wheel to zoom the x-axis and y-axis based on your 
cursor position. You can zoom each axis individually (by placing your cursor over a 
single axis) or simultaneously (by placing your cursor over the chart).  

• Right Button – Click and drag the right mouse button to pan the chart. You can pan 
each axis individually (by placing your cursor over a single axis) or simultaneously (by 
placing your cursor over the chart). 

To access this pop-up display: 

1. Select Configure > PID Loops from the FBxConnect™ main menu. The PID Loops 
display opens . 

2. Click ▼ in the drop-down list at the top of the display to select a PID loop instance to 
configure. 

3. Select the Tuning button. The PID Loops – Tuning pop-up display. 
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Figure 299. PID Loops – Tuning  

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Primary / 
Override 
Proportional 
Gain 

Sets proportional gain as the ratio of the change in output to the 
change in the error. 

Primary / 
Override 
Integral Gain 

Sets integral gain as the ratio of the change in output to the change 
in the integral of the error with respect to time. This value is in terms 
of repeats per minute. 

Typically calculated as either (Primary Process Variable – Primary 
Setpoint) or (Override Process Variable – Override Setpoint). 
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Field Description 

Primary / 
Override 
Derivative 
Gain 

Sets the derivative gain as the ratio of the change in output to the 
change in the error with respect to time. This value is in terms of 
minutes. 

Typically calculated as either (Primary Process Variable / Primary 
Setpoint) or (Override Process Variable / Override Setpoint). 

Live Values Theses fields show the current value of the configured PID loop 
parameters. 

Time Duration Enter the amount of time (in seconds) to display data in the Tuning 
Trend chart. After the configured amount of time has elapsed, this 
rolling chart adds new samples to the end of the chart and removes 
the oldest data. The default is 300. 

Start Select this button to begin displaying data in the chart. 

Stop Select this button to prevent new data from being added to the chart. 
Data collected before selecting this button is preserved in the chart. 

Clear Select this button to remove all data from the chart. 

Export Trend Select this button to extract PID trend data and save it to a file on 
your computer. The extracted data is saved in a CSV file to your 
computer's home directory using the current year, month, date, 
hour, minute, second, and millisecond for naming convention (YYYY-
MM-DD HH-MM-SS.FFF.csv).  

5. Select Save to save any changes you make to this display. 

4.25  Action Blocks 

Action Blocks are configurable programming components that check a basic logic 
condition, and use the result to activate effects or perform other actions (such as opening 
or closing a valve). FB3000 RTUs allow you to dynamically resize the number of instances 
to fit your specific needs on the Control Setup display. 

To access this display, select Configure > Action Blocks from the FBxConnect™ main 
menu. 

Figure 300. Action Blocks 
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The Action Blocks display contains the following items: 

General – Use this display to configure the logic performed by each Action Block, and 
what action the system takes when the Action Block is active. 

Bypass – Use this pop-up display to configure temporary overrides for the result of the 
raw action block logic. 

Chain – Use this pop-up display to logically link one action block to another. 

4.25.1 Action Blocks – General 

Use this display to configure the logic performed by each Action Block, and what action 
the system takes when the Action Block is active. 

To access this display: 

1. Select Configure > Action Blocks from the FBxConnect™ main menu. The Action 
Blocks display opens. 

2. Click ▼ in the drop-down list at the top of the display to select an instance to 
configure. 
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Figure 301. Action Blocks – General 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
instance. 

Enable Switch Sets the status of the selected Action Block instance. 

Enable The Action Block is evaluated and logic is performed. 

Disable The Action Block is not evaluated and no logic is 
performed. 

Logic The fields in this section configure the logic performed by the Action 
Block. 

Variable 1 Defines the first variable to use in the Action Block. 
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Field Description 

Description  Sets an identifier (up to 20-
alphanumeric characters) for the 
selected variable. 

Input Click  to open a Point Picker dialog 

and select a parameter from the FB 
Series product database used as the 
first variable in a logic expression, as 
defined by the action block operator. 
Any read/write numerical parameter 
from the FB Series product’s database 
can be selected. 

Value  Shows the value of the selected 
parameter. If you leave the parameter 
undefined, you can manually enter a 
value in this field. 

Operator Greater 
Than 

If Variable 1 is greater than the 
Variable 2 value for the Activation 
Delay time, the Logic Trip Status is set 
to active. 

Less Than If Variable 1 is less than the Variable 2 
value for the Activation Delay time, 
the Logic Trip Status is set to active. 

Equal To If Variable 1 is equal to the Variable 2 
value for the Activation Delay time, 
the Logic Trip Status is set to active. 

Greater 
Than Or 
Equal To 

If Variable 1 is greater than or equal to 
the Variable 2 value for the Activation 
Delay time, the Logic Trip Status is set 
to active. 

Not Equal 
To 

If Variable 1 is not equal to the Variable 
2 value for the Activation Delay time, 
the Logic Trip Status is set to active. 
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Field Description 

Less Than 
Or Equal To 

If Variable 1 is less than or equal to the 
Variable 2 value for the Activation 
Delay time, the Logic Trip Status is set 
to active. 

AND 
(Bitwise) 

Compares each bit in Variable 1 to each 
bit in Variable 2. If ALL of the bits set in 
Variable 2 are also set in Variable 1, the 
Logic Trip Status is set to active. 

OR 
(Bitwise) 

Compares each bit in Variable 1 to each 
bit in Variable 2. If ANY of the bits set in 
Variable 2 are also set in Variable 1, the 
Logic Trip Status is set to active. 

Watchdog Monitors the Variable 1 value for a 
transition. When a transition occurs, 
the watchdog counter starts over. If the 
counter reaches the time defined in the 
Activation Delay time, the Logic Trip 
Status is set to active. 

Soft Timer Monitors the Variable 1 Value for a 
transition from 0 to any number. Once 
this transition occurs the block is set 
true and a time delay starts for the 
amount of seconds specified in the 
Activation Delay field. When the timer 
expires the block is set to inactive and 
the Variable 1 Value is forced back to a 
zero. 

Variable 2 Defines the second variable to use in the Action Block. 

Description Sets an identifier (up to 20-
alphanumeric characters) for the 
selected variable. 

Note 

This field applies only if you select 
Greater Than, Less Than, Equal To, 
Greater Than Or Equal To, Not Equal 
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Field Description 

To, Less Than Or Equal To, AND 
(Bitwise), or OR (Bitwise) in the 
Operator field. 

Input Click  to open a Point Picker dialog 

and select a parameter from the FB 
Series product database which will be 
used as the second variable in a logic 
expression, as defined by the action 
block operator. Any read/write 
numerical parameter from the FB 
Series product’s database can be 
selected. 

Note 

This field applies only if you select 
Greater Than, Less Than, Equal To, 
Greater Than Or Equal To, Not Equal 
To, Less Than Or Equal To, AND 
(Bitwise), or OR (Bitwise) in the 
Operator field. 

Value  Shows the value of the selected 
parameter. If you leave the parameter 
undefined, you can manually enter a 
value in this field. 

Note 

This field applies only if you select 
Greater Than, Less Than, Equal To, 
Greater Than Or Equal To, Not Equal 
To, Less Than Or Equal To, AND 
(Bitwise), or OR (Bitwise) in the 
Operator field. 
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Field Description 

Activation 
Delay 

Sets the delay in seconds. This delay acts as either a 
delay before logic functions set the Logic Trip Status 
to an active state, or as the time for the soft timer and 
watchdog operations. 

Note 

For more information about the Activation Delay, 
refer to the Operator description. 

Elapsed 
Delay 

This read-only field shows the time delay that has 
elapsed in seconds, starts by counting up from zero to 
the Activation Delay time and the action block trip 
status changes when the Activation Delay time is 
reached. 

Deadband 
EU 

Sets the deadband (in engineering units) used when 
comparing Variable 1 and Variable 2. 

Note 

This field applies only if you select Greater Than, Less 
Than, Greater Than Or Equal To, or Less Than Or 
Equal To in the Operator field. 

Basic Logic 
Block 
Status 

This read-only field shows the status of the action 
block based only on the block logic operation, and 
before any bypasses are applied. Possible values are 
Active or Inactive 

Action Block The fields in this section determine the behavior of the action block 
trip status, and what action (if any) is taken when the action block trip 
status is active. 

Output 
Type 
Triggered 

Selects what output (if any) is desired from this action 
block when it is active. Possible options are: 

No Action No output action will take place when 
the Basic Logic Block Status is active. 
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Field Description 

Effect One or more associated effects is 
activated when the Basic Logic Block 
Status is active. 

Note 

See Trip Effect Links for additional 
configuration. 

Binary 
Action 

A value of 1 or 0 will be written out to 
the selected parameter when the Basic 
Logic Block Status is active. Typically 
used with a discrete output. 

Note 

See the Output Boolean Behavior for 
additional configuration. 

Move Value The input variable 1 is moved to the 
output action point when the Basic 
Logic Block Status is active. 

Load Value Saves the value in the output action 
point into the internal result register 
when the Basic Logic Block Status is 
active. 

Write Value Retrieves the internal result register 
value, and writes it to the parameter 
defined for the output action point 
when the Basic Logic Block Status is 
active. 

Condition 
to Trip 
Action 
Block 

Sets how the Basic Logic Block Status is determined. 
Possible options are: 

True If 
Block True 

The Basic Logic Block Status is active 
if the basic block logic trip status is 
active, and no bypasses are active. 

True If 
Chain True 

The Basic Logic Block Status is active 
if the chain trip status is active. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

774 

Field Description 

True If 
Either True 

The Basic Logic Block Status is active 
if either the Chain trip status, or the 
Bypass block trip status is active. 

True If 
Both True 

The Basic Logic Block Status is active 
only if the Chain trip status and the 
Bypass block trip status is active. 

Trip Effect 
Links 

Each Action Block can trigger up to 20 Effect instances. 
Click ▼ and select an Effect instance that is triggered 
by this Action Block. 

Note 

This field appears only when the Action Type is set to 
Effect. 

Output 
Actions 

The fields in this section configure the output 
parameters for the action block. 

Output 
Action 
Point 

Click  to open a Point Picker dialog 

and select a parameter from the FB 
Series product database to be used in 
one of the action types.  

Note 

This field appears only when the Action 
Type is set to Binary Action, Move 
Value, Load Value, or Write Value. 

Output 
Boolean 
Behavior 

Sets the discrete signal style written to 
the selected output parameter, where 
“Poke” means write a value once, and 
“Force” means to write a value 
continuously. Possible options are: 

• Force 1 If True & 0 If False 

• Force 0 If True & 1 If False 

• Poke 1 If True 

• Poke 0 If True 

• Poke 1 If True & 0 If False 

• Poke 0 If True & 1 If False 

• Force 1 If True & Poke 0 If False 
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Field Description 

• Force 0 If True & Poke 1 If False 

• Force 1 If True 

• Force 0 If True 

Note 

This field appears only when the 
Action Type is set to Binary Action. 

Output 
Block Trip 
Status 

This read-only field shows the status of the action 
block, and determines if any action is taken by the 
action block (such as moving a value or activating an 
effect). Possible values are Active or Inactive 

Alarm Logging 
Option 

Sets if the system writes to the Alarm Log with the action block.  

Note 

The text of the action block description string is used for each entry in 
the alarm log created by the action block. 

Alarm on 
Active 

Action block transitions from inactive to active will 
write a Set Alarm record to the alarm log. 

Alarm on 
Inactive 

Action block transitions from active to inactive will 
write a Clear Alarm record to the alarm log. 

Alarm Type Click ▼ to select what type of application alarm is 
written to the FB Series product alarm log. Possible 
options are Low, Low Low, High, High High, Rate of 
Change, and Other. 

Event Logging 
Option 

Sets if the system writes to the Event Log with the action block. 

Event on 
Active 

Action block transitions from inactive to active will 
create a record in the event log. 

Event on 
Inactive 

Action block transitions from active to inactive will 
create a record in the event log. 

Event 
Description 

This 40-character message will appear with any event 
created by the action block. The default value is 
“Action Block X”, where X is the instance number (1 
through 30). 

4. Select Save to save any changes you make to this display. 
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4.25.2 Action Blocks – Bypass 

Use this pop-up display to configure temporary overrides for the result of the raw action 
block logic. 

To access this pop-up display: 

1. Select Configure > Action Blocks from the FBxConnect™ main menu. The Action 
Blocks display opens. 

2. Click ▼ in the drop-down list at the top of the display to select an Action Block 
instance to configure. 

3. Select the Bypass button. The Action Blocks – Bypass pop-up display opens. 

Figure 302. Action Block – Bypass 

 

4. Review – and change as necessary – the values in the following fields: 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

777 

Field Description 

Bypass Block 
Trip Status 

This read-only field shows the combination of the Basic Logic Block 
Status and any active bypasses. If any bypass is active, this trip status 
shows a state of Inactive. If no bypasses are active, then this field can 
either have a state of Active or a state of Inactive, depending on the 
basic logic. 

On Demand 
Local Bypass 

Controls the manual latched bypass. This value could be set or 
removed from an HMI, host system, or from another action block. 

Enable The manual latched bypass is active. 

Disable The manual latched bypass is inactive. 

Remote 
Bypass 

Allows you to use other action blocks to define bypass functionality. 
When the remote action block is true, the bypass for this block is true. 

Action 
Block 

Click  to select a remote action block to serve as the 

trigger to enter a bypass state. When the remote 
action block is active, the bypass for this block is 
active. 

Information This read-only field shows the user-defined tag 
associated with the selected action block. When no 
block is selected, this field reads “NO BLOCK 
ASSOCIATED”. 

Type Click ▼ to select the type of bypass you desire. 
Possible options are: 

• Latched – Bypassed while the Remote Bypass 
block is active. 

• Class B – Bypassed for the amount of time set in 
the Class B Timer field once the Remote Bypass 
block is active. 

• Class C – Bypassed until the block clears once the 
Remote Bypass block is active. 

• Class B/C – Bypassed for the amount of time in 
the Class B Timer field or unless the Block clears 
before the timer expires once the Remote Bypass 
block is active. 

Current 
Bypass Active 

Shows a check mark next to all currently active bypasses. Note that 
there can be more than one bypass active simultaneously. 
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Field Description 

Local 
Latched 

Activates the manual latched bypass when selected. 
This value could be set or removed from an action 
block. 

Remote 
Latched 

Bypassed while the Remote Bypass block is true. 

Class B Bypassed for the amount of time in the Class B Timer 
field once the Remote Bypass block is true. 

Class C Bypassed until the block clears once the Remote 
Bypass block is true. 

Class B/C Bypassed for the amount of time in the Class B Timer 
field or unless the Block clears before the timer 
expires once the Remote Bypass block is true. 

Timer Sets the timers used with Class B and Class C bypasses. 

Class B 
Preset 
Delay Time 

Sets the amount of time (in seconds) that a Class B 
status should be clear, before the bypass is no longer 
active. 

Class B 
Elapsed 
Time 

Shows the elapsed time (in seconds) for a Class B 
bypass. 

Class C 
Preset 
Delay Time 

Sets the amount of time (in seconds) that a Class C 
status should be clear, before the bypass is no longer 
active. 

Class C 
Elapsed 
Time 

Shows the elapsed time (in seconds) for a Class C 
bypass. 

Class C 
Deadband 
EU Value 

Sets the deadband for Class C bypass. 

5. Select Save to save any changes you make to this display. 

4.25.3 Action Blocks – Chain 

Use this pop-up display to logically link one action block to another. 

To access this pop-up display: 
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1. Select Configure > Action Blocks from the FBxConnect™ main menu. The Action 
Blocks display opens. 

2. Click ▼ in the drop-down list at the top of the display to select an Action Block 
instance to configure. 

3. Select the Chain button. The Action Blocks – Chain pop-up display opens. 

Figure 303. Action Blocks – Chain 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Action Block Click ▼ to select an Action Block instance to be chained to this one. 
The results of the two action blocks (this action block and the action 
block you select) are compared using the logic you select in the Using 
Operation field. 
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Field Description 

Using 
Operation 

Selects the logic to be used to chain the user-configured trip status 
(set in the Chain Selected Block Status field) of an action block (set 
in the Action Block field) to the current action block's Bypass Block 
Trip Status (shown on the Bypass tab). Possible options are: 

AND If the Action Trip Status of the chained Action Block 
instance and the current Action Block instance are 
both Active, the Chain Block Trip Status is set to Active. 

OR If either the Action Trip Status of the chained Action 
Block instance or the current Action Block instance are 
Active, the Chain Block Trip Status is set to Active. 

NAND If the Action Trip Status of the chained Action Block 
instance and the current Action Block instance are 
both Active, the Chain Block Trip Status is set to 
Inactive. Any other combination of Active and Inactive 
causes the Chain Block Trip Status to be Active. 

Chain Preset 
Delay Time 

Sets the value for the delay timer in seconds. This is the number of 
seconds that a chain combination must remain active, before the 
Chain Block Trip Status becomes active. 

Chain Elapsed 
Delay Time 

Shows the delay time elapsed in seconds. 

This Block Is 
The End Of 
The Chain 

Indicates the current action block is the last in the chain. 

Chain Selected 
Block Status 

Selects which status (from the action block selected in the Action 
Block field) chained to this action block. 
Block 
Status 

The Logic Trip Status defined on the Action Block – 
General display. 

Chain 
Status 

The Chain Block Trip Status defined on the Action 
Block – Chain display. 

Note 

This is typically used in chains of more than two action 
blocks. 

Output 
Status 

The Action Trip Status defined on the Action Block – 
General display. 
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Field Description 

Chain Block 
Trip Status 

This read-only field shows the status of this action block result, with 
the action block it is chained to. Possible values are Active or Inactive. 

5. Select Save to save any changes you make to this display. 

4.26  Math Blocks 

Math Blocks perform mathematical equations using live variables from the system as 
inputs. Each calculation is updated once per second. The Math Blocks display is divided 
into three sections: Input Variables, Calculation, and Results. FB3000 RTUs allow you to 
dynamically resize the number of instances to fit your specific needs on the Control Setup 
display. 

Input Variables – Use this section to define up to four parameters to be used as variables 
(A, B, C, and D) in the Calculation section. You can enter a description for each variable. 

Calculation – Use this section to enter up to three mathematical equations (X, Y, and Z) 
using variables defined in the Input Variables section (A, B, C, or D), constants, and 
operators. Equations can be up to 40 characters in length. Each equation is checked for 
correct syntax before it can be evaluated. You can use standard math functions (POW, 
EXP, LOG, SQRT, etc.), and double precision floating point math is used throughout the 
equation. 

Note 

Boolean logic is not supported. 

Results – Use this section to display the results of each equation (X, Y, and Z) entered into 
the Calculation section. You can enter a description for each result. You can also configure 
the system to write the result value to a specific parameter in the database. 

Note 

Logic and syntax validity checks are not performed until you select Enable in the Enable 
Switch field. 

To access this display: 

1. Select Configure > Math Blocks from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display and select an instance to 
configure. 
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Figure 304. Math Blocks 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
instance. 

User Enable 
Switch 

Sets the status of the current math block instance. 

Enable Input variables are updated and calculations are 
performed. 

Disable No input variables are updated and no calculations 
are performed. 
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Field Description 

Input 
Variables 

Use the fields in this section to configure up to four variables (A, B, C, 
and D) for use in math block calculations. You can use a parameter to 
automatically provide a value or manually enter a value to use as the 
variable. 

Description Sets a 20-character text description for the input 
variable. 

Input 
Definition 

Click  to open a Point Picker dialog and select a live 

input to use in the calculation. You can select any 
numerical parameter from the FB Series product 
database. When integers are selected, they are 
converted to floating point values. 

Note 

When an input is not required, this field should be set 
to Undefined. 

Value When a parameter is defined in the Input Definition 
field, this read-only field shows the value of the 
defined parameter. When no parameter is defined in 
the Input Definition field, enter a value to use as an 
input variable. 

Calculation Use this section to configure up to three equations (X, Y, and Z). 

Enter 
Calculation 
String 

Enter the calculation to be solved using Input 
Variables (A, B, C, D, X, Y, and Z), constants, operators, 
and functions. For more details on the available 
operators and functions, refer to Supported Operators 
and Functions. 

Validity 
Check 

The syntax is checked for validity when the Enable 
Switch field is set to Enable. Possible values are Valid 
(the calculation string has no issues) or Invalid (the 
calculation string has a problem or is empty). 

Results This section shows the results for the three equations entered in the 
Calculation section (X, Y, and Z). 

Description Sets a description (up to 20-characters) for the 
calculation result value. 
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Field Description 

Value This read-only field shows the numerical result for the 
equation.  

Note 

When an equation is considered invalid, the value is 
set to 0.0. 

Optional 
Output 
Definition 

Used to “push” the result value out to a user selected 
parameter somewhere else in the database (for 
example, a User Data float, or an Analog Output 

override value). Click  to open a Point Picker dialog 

and select a parameter. Any read/write numerical 
parameter from the FB Series product’s database can 
be selected. 

4. Select Save to save any changes you make to this display. 

4.26.1 Supported Operators and Functions 

You can use the following operators and functions in math block calculation strings: 

Table 44. Supported Operators 

Symbol Function Description Example 

+ Addition Add two numbers A+B or (A+B)+C 

- Subtraction Subtract two numbers A-B or (A-B)-C 

* Multiplication Multiply two numbers A*B or (A*B)*C 

/ Division Divide two numbers A/B or (A/B)/C 

^ Exponent Take one number to the 
power of another 

A^B 

 

Table 45. Supported Functions 

Abbreviation Function Description Example 

ABS Absolute Value Returns the absolute value 
of a number 

ABS(A) 
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Abbreviation Function Description Example 

SQRT Square Root Returns the square root of 
a number 

SQRT(A) 

LOG10 Base 10 Log Returns the logarithm 
(base 10) of a number 

LOG10(A) 

LOG Natural Log Returns the logarithm 
(base e) of a number 

LOG(A) 

EXP Exponent Returns the value of an “e” 
to the power of a number 

EXP(A) 

POW Power Returns the result of a 
number raised to a power 

POW(A,B) 

MOD Modulus Returns the remainder of 
division 

MOD(A,B) 

ROUND Round Rounds a value to the 
nearest whole number 

ROUND(A) 

TRUNC Truncate Truncates a value to a 
whole number 

TRUNC(A) 

SIN Sine Returns the sine of the 
number 

SIN(A) 

COS Cosine Returns the cosine of the 
number 

COS(A) 

TAN Tangent Returns the tangent of the 
number 

TAN(A) 

  

4.27  Effects 

Effects are configurable custom logic components that drive a selected FB Series product 
parameter to a user defined value. They are similar to the concept of “cause and effect,” 
where the action block replaces the “cause” and is used to activate one or more effects. 
FB3000 RTUs allow you to dynamically resize the number of instances to fit your specific 
needs on the Control Setup display. 

To access this display: 

1. Select Configure > Effects from the FBxConnect™ main menu. 
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2. Click ▼ in the drop-down list at the top of the display and select an instance to 
configure. 

Figure 305. Effects 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
instance. 

Enable Switch Sets the status of the selected Effects instance. 

Enable The effect is evaluated and logic is performed. 

Disable No logic is performed. 

Effect Output 
Configuration 

Use the fields in this section to configure an output parameter driven 
by the effect.  
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Field Description 

Output 
Definition 

Click  to open a Point Picker dialog and select an 

output parameter to be driven by the effect. You can 
select any read/write numerical parameter from the 
FB Series product’s database. If you select an integer, 
they are converted to floating point values.  

Note 

When an output is not required, this field should be 
set to Undefined. 

Description Sets a description (up to 20-alphanumeric characters) 
for the output parameter. 

Value This read-only field shows the current numerical 
value of the defined output parameter. 

Output 
Active Value 
to Write 

Sets the value written to the Output Variable Param 
Reference when the effect is tripped (Active). 

Output 
Inactive 
Value to 
Write 

Sets the value written to the Output Variable Param 
Reference when the effect is not tripped (Inactive). 

Inactive 
Value Set 
Enable 

Selects if the value configured in the Output Inactive 
Value to Write field is used. If unchecked, this value 
is not written to the defined output parameter when 
the effect is not tripped (inactive). 

Assert 
Output 
Continuously 

Click ▼ to select how the system writes the values 
defined in the Output Active Value to Write and 
Output Inactive Value to Write fields to the effect 
output parameter defined in the Output Variable 
Parameter Reference field. 

• Neither State – The system writes the value 
configured in the Output Active Value to Write 
field to the output parameter one time when the 
Effect Status changes to Active. and writes the 
value configured in the Output Inactive Value 
to Write field to the output parameter one time 
when the Effect Status changes to Inactive. 
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Field Description 

• Active State Only – The system continuously 
writes the value configured in the Output Active 
Value to Write field to the output parameter 
while the Effect Status is Active. 

• Inactive State Only – The system continuously 
writes the value configured in the Output 
Inactive Value to Write field to the output 
parameter while the Effect Status is Inactive. 

• Both States – The system continuously writes 
the value configured in the Output Active Value 
to Write field to the output parameter while the 
Effect Status is Active, and continuously writes 
the value configured in the Output Inactive 
Value to Write field to the output parameter 
while the Effect Status is Inactive. 

Effect Status Shows the current trip status of the effect. Possible values are Active 
or Inactive. 

First Out 
Effect 
Instance 

Shows the numerical value of the associated Action 
Block (1 through 30) that first tripped this effect to go 
active. If the effect is associated with multiple action 
blocks (all of which could be active), this field 
indicates which Action Block was active first. 

First Out 
Effect Tag 

Shows the tag of the associated Action Block that first 
tripped this effect to go active. 

Effect Reset Use the fields in this section to configure parameters used to 
manually reset the effect. 

Effect 
Requires 
Reset When 
Tripped 

Select this option if the effect requires a manual reset 
(user intervention). When selected, the effect will not 
leave the active state until explicitly told to do so via a 
reset. If this option is not selected, the effect moves 
to the inactive state automatically when the action 
block(s) that tripped it become inactive. 
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Field Description 

Reset 
Definition 

Click  to open a Point Picker dialog and select a 

parameter used to force a manual reset of the active 
effect. When the effect is ready to be reset, any non-
zero value written to the referenced parameter resets 
the effect. For example, you might select a discrete 
input or a User Data byte value. Any read/write 
numerical parameter from the FB Series product’s 
database can be selected. 

Note 

You must select Reset Required in the Effect 
Requires Reset When Tripped field and Save your 
changes to view this field. 

Reset 
Command 

If a dynamic external input is not required to reset a 
“latched” effect, this field can be used to reset the 
effect. Any non-zero value written to this parameter 
will perform the effect reset. 

Note 

You must select Reset Required in the Effect 
Requires Reset When Tripped field and Save your 
changes to view this field. 

4. Select Save to save any changes you make to this display. 

4.28  Control Setup 

Use this display to configure the number of Action Blocks, Math Blocks, Effects, and PID 
Loops instances available on your FB3000 RTU. The FB3000 RTU allows you to dynamically 
resize the number of instances for each control type (Action Blocks, Math Blocks, Effects, 
and PID Loops) to fit your specific needs. Enter the number of desired instances for each 
control type and save your changes. 

To access this display: 

1. Select Configure > Control Setup from the FBxConnect™ main menu. 
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Figure 306. Control Setup 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Number of 
Action Blocks 

Sets the number of Action Blocks instances available on your FB3000. 

Number of 
Math Blocks 

Sets the number of Math Blocks instances available on your FB3000. 

Number of 
Effects 

Sets the number of Effects instances available on your FB3000. 

Number of 
PIDs 

Sets the number of PID Loops instances available on your FB3000. 

Maximum This read-only field shows the total number of control instances you 
can configure on your FB3000. You can assign these instances to 
Action Blocks, Math Blocks, Effects, and PID Loops in any combination 
using the fields above, but the total of those instances cannot exceed 
this number. 
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Field Description 

Available This read-only field shows the remaining control instances not yet 
assigned to Action Blocks, Math Blocks, Effects, or PID Loops. 

3. Select Save to save any changes you make to this display. 

4.29  Communications 

Use this display to configure the communications ports on your FB Series product. 

To access this display, select Configure > Communications from the FBxConnect™ main 
menu. 

Figure 307. Communications 

 

CAUTION 
When making multiple FBxConnect™ connections to the same FB Series product (as with a 
remote and a local connection), be aware that the changes one connection makes to the 
FB Series product may not be immediately visible to other connections and may even 
require the other connections to restart FBxConnect™ before changes become visible. For 
example, simple changes (such as changes to setpoints) may be immediately visible to all 
connections, but changing the number of meters, configuring I/O, adding/deleting menu 
items, or other major configuration changes may require re-establishing the connection 
using FBxConnect™.  

The Communications display contains the following items: 

General – Use this display configure general settings for the selected port, including 
enabling the port and setting the protocol used by the port. 

DNP3 – Use this pop-up display to configure protocol options for communications ports 
using DNP3 protocol.  

Modbus Slave – Use this pop-up display to configure protocol options for communications 
ports using Modbus Slave protocol. 

Modbus Master – Use this pop-up display to configure protocol options for 
communications ports using Modbus Master protocol. 
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4.29.1 Communications – General  

Use this display to configure general settings for the selected port, including enabling the 
port and setting the protocol. 

To access this display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the drop-down list at the top of the display and choose a communications 
port to configure. 

Note 

FBxDesigner™ connections are currently supported only on Comm5 (ENET1). 

Figure 308. Communications – General (Serial port) 

 

3. Review – and change as necessary – the values in the following fields: 
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Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
communications port. 

Port 
Description 

Sets a description (up to 20-alphanumeric characters) for the selected 
communications port. 

Port Settings Sets if communications are allowed using the selected port.  

Enable Allow communications using the selected port.  

Disable Prevent communications using the selected port. 

WARNING:  
To prevent flow calculation errors, do not disable a 
communications port when the Port Owner is 
MVS4088B and the 4088B's inputs are used for flow 
calculations. If you need to temporarily disable a 
specific 4088B, you can select Disable in the 
Transmitter Scanning field for that single 4088B. For 
more information, refer to 4088B – General tab. 

Port Owner Click ▼ to set the communications protocol used on the selected 
port. Possible protocols include: 

Note 

This field applies only to Serial and Wi-Fi communications ports. 

DNP3/ 
Modbus 
Slave 

Sets the selected port to only communicate using 
DNP3 protocol messages and to act as a Modbus 
slave device. 

DNP3 Sets the selected port to only communicate using 
DNP3 protocol messages. 

Modbus 
Slave 

Sets the selected port to allow the FB Series product 
to act only as a Modbus slave device. 

Master 
Modbus 

Sets the selected port to allow the FB Series product 
to poll Modbus devices. 
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Field Description 

MVS4088B Sets the selected port to only communicate with 
4088B devices. The FB Series product automatically 
configures settings to match the defaults of the 
4088B’s serial port.  

Note 

This field applies only to the Com3 or Com4 
communications port. 

Application 
Master 

Sets the selected port to only communicate as a 
master device for an installed application. 

Application 
Slave 

Sets the selected port to only communicate as a slave 
device for an installed application. 

LCD Display Sets the selected port to only communicate with an 
attached display. 

Printer Sets the selected port to only communicate with an 
attached printer. 

Port Type This read-only field shows the type of communications port currently 
selected. 

Modbus Slave Select this button to open the Modbus Slave pop-up display and 
configure Modbus Slave protocol options. 

Note 

This button appears only if you select either DNP3/Modbus Slave or 
Modbus Slave in the Port Owner field. 

DNP3 Select this button to open the DNP3 pop-up display and configure 
DNP3 Slave protocol options. 

Note 

This button appears only if you select either DNP3/Modbus Slave or 
DNP3 in the Port Owner field. 

Modbus 
Master 

Select this button to open the Modbus Master pop-up display and 
configure Modbus Master protocol options. 

Note 

This button appears only if you select Modbus Master in the Port 
Owner field. 
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Field Description 

Serial Settings Use these fields to configure the selected serial port. 

Note 

These fields appear only if you select a Serial port in the 
Communications drop-down list. 

Serial 
Settings 

Click ▼ to set the number of data bits and stop bits 
contained in an asynchronous byte, and the parity 
value used for communications on the port. 

Note 

Communications with FBxConnect™ software support 
only the default option of 8 data bits/no 
parity/1stop bit. 

Baud Rate Click ▼ to set the transmit and receive data baud rate 
(in bits per second) for the communications port. 

Serial Mode Click ▼ to set the type of interface used by the 
communications port. Possible options are RS-232, 
RS-485 2-Wire (No Termination), RS-485 2-Wire 
(Terminated), RS-485 4-Wire (No Termination), and RS-
485 4-Wire (Terminated). 

Key On 
Delay 

Sets the time (in seconds) from RTS signal activation 
to the transmission of the first character. 

Note 

This field does not appear if you select MVS4088B in 
the Port Owner field. 

Key Off 
Delay 

Sets the time (in seconds) from the transmission of 
the last character to RTS signal de-activation. 

Note 

This field does not appear if you select MVS4088B in 
the Port Owner field. 

IP Settings Use these fields to configure the selected Ethernet port. 

Note 

These fields appear only if you select the Ethernet port in the 
Communications drop-down list. 
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Field Description 

IPv4 IP 
Address 

Sets the IP address for the FB Series product when 
using the Ethernet port. 

Note 

You must have separate IP Addresses for each 
Ethernet port. 

Gateway 
Address 
(IPv4) 

Sets the gateway address for the FB Series product. The 
gateway address identifies the network node that serves 
as an entrance to the network on which the FB Series 
product resides. 

Subnet 
Mask (IPv4) 

Sets a value for the subnet mask portion of the IP 
address. The subnet mask indicates the subnet to 
which an IP address belongs. 

 

MAC 48-bit 
Address 

This read-only field shows the MAC address for the 
FB Series product when using the Ethernet port. 

 

Properties Use these fields to enable or disable communications protocols on 
the Ethernet port, and to set the IP port number used by each 
protocol. 

Note 

These fields appear only if you select the Ethernet port in the 
Communications drop-down list. 

 

Protocol Place a check mark next to the communications 
protocols that are enabled on the Ethernet port. 
Possible options are DNP3, Modbus Slave, HART_IP 
(slave), and Modbus Master. 

Note 

• You must have a physical HART module to enable 
HART protocol. 

• If you enable HART protocol on the port, you also 
must enable Pass Through Mode on the HART 
module for the HART pass through feature to 
work. For more information, refer to HART I/O. 
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Field Description 

Port # Sets the IP port number to be used by the protocol. 

Note 

Do not enter 9009 for this number; it is reserved by 
FBxNet. 

 

Enable Place a check mark next to each protocol to enable 
the FB Series product to use the selected 
communication protocol on the Ethernet port. 
Removing a check mark disables use of the selected 
protocol on the Ethernet port. 

 

Allow 
Application 
Use of Port 

Place a check mark next to this option to allow 
applications installed on your FB3000 RTU to 
communicate using the selected Ethernet port. 

IP 
Connections 

Use these fields to configure the number of connections and the 
protocols used with communications over the Ethernet ports. 

Note 

• These fields appear only if you select either Comm_5 or Comm_6 
in the Communications drop-down list. 

• FBxNet and Modbus Master Ethernet connections are managed 
separately and do not count towards the Maximum Number of 
Connections. 

Maximum 
Number of 
Connections 

This read-only field shows the maximum number of 
connections allowed on the selected Ethernet port. 

Current 
Number of 
Connections 

This read-only field shows the current number of 
connections active on the selected Ethernet port. 

Reserved Sets, for each protocol, the minimum number of 
connections dedicated to using only that protocol on 
the selected Ethernet port. For example, if you enter 6 
in the DNP3 row, you reserve at least 6 DNP3 
connections of DNP3 type, leaving 14 connections (20 
max - 6 reserved) available to use with any type of 
protocol, including DNP3. 
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Field Description 

Active This read-only field shows, for each protocol, the 
current number of connections using the protocol on 
the selected Ethernet port. 

Current 
Application 
Connections 

This read-only field shows the current number of 
application connections active on the selected 
Ethernet port. 

Note 
These connections do not count towards the 
maximum number of connections. 

4. Select Save to save any changes you make to this display. 

4.29.1.1 Port Owners 

You can configure the port owner (communications protocol) used by each 
communications port. Possible options for each communications port type are listed 
below: 

Table 46. Port Owners 

Communications Port Type Port Owner 

Serial • DNP3 

• DNP3/Modbus Slave 

• Modbus Slave 

• Modbus Master 

• MVS4088B 

• Application Master 

• Application Slave 

• LCD Display 

• Printer 
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Communications Port Type Port Owner 

Ethernet One session dedicated to: 

• Modbus Master 

Six sessions configurable as: 

• DNP3 

• Modbus SlaveHART IP 
Slave 

  

Note 

For a detailed description of the DNP3 protocol usage, refer to the DNP3 Protocol 
Specifications Manual (for the Emerson FB3000 RTU) (D301858X012). 

4.29.2 Communications – DNP3 

Use this pop-up display to configure options when using the DNP3 protocol. FB Series 
products can be implemented as DNP3 outstations for communication and configuration 
with Emerson Field Tools software and SCADA hosts. DNP3 is an open and public protocol 
used to ensure standards-based inter-operability between DNP3 outstations and a SCADA 
host. 

FB Series products use DNP3 tunnel command messaging for RDI data collection and FB 
Series product configuration. A single message size can be 4096 bytes in size. Messages 
tunnel using the DNP3 string object (group 110). 

Note 

• This pop-up display is available only if you select either DNP3 or DNP3/Modbus Slave 
in the Port Owner drop-down list on the Communications – General display. 

• For a detailed description of the DNP3 protocol usage, refer to the DNP3 Protocol 
Specifications Manual (for the Emerson FB3000RTU) (D301858X012). 

To access this pop-up display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the DNP3 protocol. 
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3. Select the DNP3 button. The DNP3 pop-up display opens. 

Figure 309. Communications – DNP3 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Flow 
Computer 
Address 

Sets the address of the FB Series product. Valid values are 0 – 65519. 

Require Login Place a check mark to require login credentials be entered for all 
requests using DNP3 protocol on the selected communication port. 

Note 

If Require Login is Disabled, activity for the selected communication 
port is logged under user account UNSECURED_DNP3. 
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Field Description 

DNP3 Host 
Linking 

Select to open the DNP3 Host Linking display and define which 
communications ports on the FB Series product are used to 
communicate with SCADA hosts using DNP3 protocol. For more 
information, refer to DNP3 Host Information. 

Note 

• Events are divided evenly between each configured host. 

• The maximum number of events (configured in the Event Log 
frame) for each communications port decreases for each DNP3 
Host Link you add. 

TCP/IP Enables or disables DNP3 protocol communications for this port. 

Note 

This field applies only to the Ethernet port. 

TCP/IP Port Sets the communications IP port number on the FB Series product to 
be used by DNP3 protocol.  

Note 

• This field applies only to the Ethernet port. 

• Do not enter 9009 for this number; it is reserved by FBxNet. 

Master 
Confirmation 
Timeout 

Sets the length of time (in milliseconds) the slave DNP3 device waits 
for a confirmation message from the master for a response sent to a 
master device before retrying the request. The default is 10000 
milliseconds. 

Inactivity 
Timeout 

Sets the length of time (in seconds) without a valid DNP3 message 
being received before the user login is timed out. The default is 120 
seconds. 

DNP3 Secure 
Authentication 
Reply Timeout 

Sets the length of time (in seconds) the system waits for the master 
to respond to a request.  

Note 

• This field is applicable only if you have SAv5 enabled. For more 
information, refer to Apply Security File. 

• For security, the length of time you enter should be kept as short 
as possible. 

• Care needs to be taken when tuning this parameter as setting 
the value too short relative to the network speed can cause 
failure to communicate with hosts.  
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Field Description 

DNP3 SA Max 
session key 
status count 

Sets the number of session key exchanges that, when exceeded, 
causes the system to log an event in the security log. 

Maximum 
Binary Input 
Events 

Sets the number of the most recent binary events to be maintained 
for a host device to request. The high limit is 17. Refer to DNP3 
Protocol Specifications Manual (for the Emerson FB3000RTU) 
(D301858X012) for a list of supported binary input points. 

Note 

• If the desired maximum number of events is 0, then the Group 2 
Scan Period field should be set to 0 (disabled). 

• The maximum number of events decreases for each DNP3 Host 
Link you add (configured on the DNP3 Host Linking display). 

Maximum 
Analog Input 
Events 

Sets the number of the most recent analog input events to be 
maintained for a host to request. The high limit is 115. 

Note 

• If the desired maximum number of events is 0, then the Group 
32 Scan Period field should be set to 0 (disabled). 

• The maximum number of events decreases for each DNP3 Host 
Link you add (configured on the DNP3 Host Linking display). 

Maximum 
Binary 
Counter 
Events 

Sets the number of the most recent binary counter events to be 
maintained for a host to request. The high limit is 10. 

Note 

• If the desired maximum number of events is 0, then the Group 
22 Scan Period field should be set to 0 (disabled). 

• The maximum number of events decreases for each DNP3 Host 
Link you add (configured on the DNP3 Host Linking display). 

Maximum 
Frozen 
Counter 
Events 

Sets the number of the most recent frozen counter events to be 
maintained for a host to request. 

Note 

This feature is not currently supported. 
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Field Description 

Binary Input 
Scan Period 

Sets the scan period (in seconds) for the binary input group. A value 
of 1 indicates that all supported binary input points are scanned for 
changes every one second. The default is 0 (scanning disabled). Refer 
to DNP3 Protocol Specifications Manual (for the Emerson FB3000RTU) 
(D301858X012) for a list of supported binary input points. 

Note 

Scanning the database increases CPU loading.  

Analog Input 
Scan Period 

Sets the scan period (in seconds) for the analog input group. A value 
of 1 indicates that all supported analog input points are scanned for 
changes every one second. Refer to DNP3 Protocol Specifications 
Manual (for the Emerson FB3000RTU) (D301858X012) for a list of 
supported analog input points. 

Binary 
Counter Scan 
Period 

Sets the scan period (in seconds) for the counter group. A value of 1 
indicates that all supported binary input points are scanned for 
changes every one second. 

Active DNP3 
Map 

Specifies the DNP3 map used by the FB Series product. 

Note  

Changing this option will also change the DNP3 map index used by 
the FB Series product. After saving your changes, you must update 
your SCADA system with the new DNP3 map to ensure uninterrupted 
communication. 

Default The FB Series product uses the default DNP3 map. 

User 
Defined 

The FB Series product uses a user-defined DNP3 map. 
If you select this option, save your changes and use 
the button below to define the DNP3 mapping used 
by the FB Series product. 

DNP3 
Mapping 

Select to open the DNP3 Map Table and 
define the DNP3 mapping used by the 
FB Series product. For more 
information, refer to DNP3 Map Table. 

Note 

This button appears only if you select 
User Defined and Save your changes. 
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Field Description 

Auto 
Managed 

The FB Series product uses Object Mapping Template 
files to define the DNP3 map. If you select this option, 
save your changes, and use the buttons below to 
define the DNP3 mapping used by the FB Series 
product. 

Note 

The following buttons appear only if you select Auto 
Managed and Save your changes. 

Edit 
Template 

Select this button to open the Object 
Mapping Template Editor and edit the 
template. For more information, refer 
to Creating an Object Mapping 
Template.  

Build DNP3 
Map 

Select this button to open the DNP3 
Map Generator and immediately begin 
building the DNP3 map based on the 
currently configured Object Mapping 
Template files. For more information, 
refer to Building a DNP3 Map. 

View DNP3 
Map 

Select this button to open a read-only 
version of the currently configured 
DNP3 map. For more information, refer 
to Viewing a DNP3 Map. 

Unsolicited 
Messages 

Enables the FB Series product to send unsolicited messages on the 
selected port. 

Note 

Enabling unsolicited messages will prevent FBxConnect™ 
communications on the selected port.  

Unsolicited 
Destination 
Address 

Sets the destination device address to use when sending unsolicited 
messages to a host system. 

Unsolicited 
Confirmation 
Timeout 

Sets the length of time (in milliseconds) the FB Series product waits 
for a confirmation message from the host device for an unsolicited 
data transmission before marking the message as retry needed. 
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Field Description 

Unsolicited 
Number of 
Retries 

Specifies the maximum number of unsolicited retries to the host 
before discarding the message. 

Delay Between 
Unsolicited 
Retries 

Sets the length of time (in milliseconds) to wait after an unsolicited 
confirmation from the host before retrying the unsolicited message 
to the host device. 

Class 1/2/3 Enables unsolicited messages for class 1 (highest importance), class 
2, and class 3 (lowest importance) events. Sends out an unsolicited 
message based on the maximum time (in milliseconds) or when the 
maximum number of events have been queued for transmission. 

Max Delay Sets the maximum amount of time (in milliseconds) before an 
unsolicited message is generated and sent to the host for class 1, 
class 2, and class 3 event categories. If this value is set to 5000, the 
FB Series product sends an unsolicited message to the host every 
five seconds with any events changes since the last unsolicited 
message. 

Max Events Specifies the maximum number of events that will be queued before 
an unsolicited message is generated and sent to the host for class 1, 
class 2, and class 3 event categories. 

5. Select Save to save any changes you make to this pop-up display. 

4.29.2.1 DNP3 Host Information 

Use this pop-up display to define which communications ports on the FB Series product 
are used to communicate with SCADA hosts using DNP3 protocol. For the FB3000 RTU, 
you can define up to ten communications ports. 

Note 

It is possible to exceed the maximum number of DNP3 connections (as configured on the 
Communications – General display) when adding multiple IP addresses to the DNP3 Host 
Information display without saving between each entry. If you exceed the allowed 
number, the connections will appear to save but will not work. To avoid this issue, you 
should save the DNP3 Host Information display after each IP address you enter. 

To access this display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 
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2. Select ▼ in the Communications drop-down list and choose a communications port 
that is configured to use the DNP3 protocol. 

3. Select the DNP3 button. The DNP3 pop-up display opens. 

4. Select the DNP3 Host Linking button. The DNP3 Host Information display opens. 

Figure 310. DNP3 Host Information 

 

5. Click  in the Communication Ports field to open a Point Picker dialog and select the 

desired communications port. 

Note 

• The Port Owner of each selected communications port must be set to DNP3 or 
DNP3/Modbus Slave.  

• If you select an Ethernet port, you must enter the IP address of the SCADA host in the 
IP address field. 

• Events are divided evenly between each configured host. 
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• The maximum number of events (configured in the Event Log frame on the 
Communications – DNP3 pop-up display) for each communications port decreases for 
each DNP3 Host Link you add. 

6. The DNP3 Secure Authentication Enable checkbox sets if SAv5 is enabled (checked) 
or disabled (unchecked) for all DNP3 traffic on individual serial ports or specific IP 
addresses on Ethernet ports. This is useful if you need to communicate with a 
host/device that does not support SAv5. The default is checked.  

Note  

This field appears only if you have enabled SAv5 on the FB Series product. For more 
information, refer to Apply Security File. 

7. Select Save to save any changes you make to this pop-up display. 

4.29.2.2 DNP3 Map Table 

Use this pop-up display to configure the DNP3 groups and point indexes stored in the FB 
Series product. You can add a parameter to the DNP3 map table by clicking and dragging 
the parameter onto the desired position in the table or selecting the desired parameter 
(or referenced parameter) and clicking the Add button. 

Note 

For a description of the data types contained in the internal FB Series product database, 
refer to Native Data Types. 

DNP3 Mapping Basics 

• Different signal types have separate map tables. 

• Each entry in a map table is identified by its Point Index. 

• You add a device parameter to a Point Index. 

• You assign a class to each added parameter. Each class can have a user-defined 
significance based on your own definition. 

• Each parameter belongs to a certain group. Groups enable you to classify the data 
types within a message. Each group number shares a common point type and a 
common method of data generation, creation, and collection.  

• Variations are different encoding formats for the data types within a group. 
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• Static data refers to a point’s current or most recently recorded value. For binary input 
points, “static data” refers to the present on/off condition. 

• Events are associations with changes in points, such as state changes, measurement 
at some threshold, or an analog input changing by more than its defined dead band. 

Note 

For a complete description of DNP3 implementation in the FB Series devices, refer to the 
DNP3 Protocol Specifications Manual (for the Emerson FB3000RTU) (D301858X012). 

To access this display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the DNP3 protocol. 

3. Select the DNP3 button. The DNP3 pop-up display opens. 

4. Select User Defined in the Active DNP3 Map field. 

5. Select Save to save your changes. A DNP3 Mapping button appears. 

6. Select the DNP3 Mapping button. The DNP3 Map Table display opens. 
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Figure 311. DNP3 Map Table 

 

7. A separate map table is used for different signal types. Select ▼ in the Table drop-
down list and choose the table with the signal type you want to map. Possible options 
and the maximum number of points are: 

• Binary Inputs – 65535 points 

• Binary Outputs – 65535 points 

• Analog Inputs – 65535 points 

• Analog Outputs – 65535 points 

• Counters – 65535 points 

• Strings – 65535 points 

8. Review – and change as necessary – the values in the following fields: 

Field Description 

Point Index Identifies the point in the selected table. 
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Field Description 

Device 
Parameter 

Identifies the parameter in the FB3000 RTU. 

Class Class 1, 2, and 3 are event classes. DNP3 does not assign significance 
to these event classes. Implementations can use different strategies 
around these classes, such as assigning highest priority events to 
class 1 and lowest priority events to class 3. Host devices may request 
events from one or more of these classes. 

Click ▼ to assign the selected parameter to a class. Possible options 
are: 

• Class 1 

• Class 2 

• Class 3 

• All 

Group 1 
Variation 

Binary Input Static. Used to report the current value of a binary input 
point. Possible status flags include: 

Bit 0 = ONLINE 

Bit 1 = RESTART 

Bit 2 = COMM_LOST 

Bit 3 = REMOTE_FORCED 

Bit 4 = LOCAL_FORCED 

Bit 5 = CHATTER_FILTER 

Bit 6 = Reserved, always 0 

Bit 7 = STATE 

Note 

This field appears only if you select Binary Inputs in the Table field. 

None No variation 

1 - Packed 
Format 

Package format having single bit binary input state. 

2 - With 
Flags 

Package format having single bit binary input state, 
with status flags. 
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Field Description 

Group 2 
Variation 

Binary Input Events. Used to report events related to a binary input 
point. Possible status flags include: 

Bit 0 = ONLINE 

Bit 1 = RESTART 

Bit 2 = COMM_LOST 

Bit 3 = REMOTE_FORCED 

Bit 4 = LOCAL_FORCED 

Bit 5 = CHATT_FILTER 

Bit 6 = Reserved, always 0 

Bit 7 = STATE 

Note 

This field appears only if you select Binary Inputs in the Table field. 

None No variation 

1 - Without 
Time 

Package format having single bit binary input state, 
with status flags 

2 - Absolute 
Time 

Package format having single bit binary input state, 
with status flags, and the absolute time when the 
event occurred. 

3 - Relative 
Time 

Package format having single bit binary input state, 
with status flags, and the relative time when the event 
occurred. 

Group 10 
Variation 

Binary Output Static. Used to control or report the state of one or 
more binary output points. Possible status flags include: 

Bit 0 = ONLINE 

Bit 1 = RESTART 

Bit 2 = COMM_LOST 

Bit 3 = REMOTE_FORCED 

Bit 4 = LOCAL_FORCED 

Bit 5 = Reserved, always 0 

Bit 6 = Reserved, always 0 

Bit 7 = STATE 

Note 

This field appears only if you select Binary Outputs in the Table field. 
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Field Description 

None No variation 

1 - Packed 
Format 

Package format having single bit binary output state. 

2 - With 
Flags 

Package format having single bit binary output state, 
with status flags 

Group 12 
Variation 

Binary Output Command or Control Relay Output Block. Used to 
perform digital control operations at binary output points. 

Note 

This field appears only if you select Binary Outputs in the Table field. 

None No variation 

1 - CROB Control Relay Output Block 

2 - PCB Pattern Control Block (PCB); this variation is not 
supported. 

3 - Pattern 
Mask 

Pattern Control Mask; this variation is not supported. 

Group 30 
Variation 

Analog Input Static. Used to report the current value of an analog 
input point. Possible status flags include: 

Bit 0 = ONLINE 

Bit 1 = RESTART 

Bit 2 = COMM_LOST 

Bit 3 = REMOTE_FORCED 

Bit 4 = LOCAL_FORCED 

Bit 5 = OVER_RANGE 

Bit 6 = REFERENCE_ERR 

Bit 7 = Reserved, always 0 

Note 

This field appears only if you select Analog Inputs in the Table field. 

None No variation 

1 - 32 bit w 
Flag 

Package format containing a 32-bit signed integer, 
with status flags. 

2 - 16 bit w 
Flag 

Package format containing a 16-bit signed integer, 
with status flags. 
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Field Description 

3 - 32 bit wo 
Flag 

Package format containing a 32-bit signed integer. 

4 - 16 bit wo 
Flag 

Package format containing a 16-bit signed integer. 

5 - Float w 
Flag 

Package format containing a single precision floating 
point value, with status flags. 

6 - Double w 
Flag 

Package format containing a double precision floating 
point value, with status flags. 

Group 32 
Variation 

Analog Input Events. Used to report events related to an analog input 
point. Possible status flags include: 

Bit 0 = ONLINE 

Bit 1 = RESTART 

Bit 2 = COMM_LOST 

Bit 3 = REMOTE_FORCED 

Bit 4 = LOCAL_FORCED 

Bit 5 = OVER_RANGE 

Bit 6 = REFERENCE_ERR 

Bit 7 = Reserved, always 0 

Note 

This field appears only if you select Analog Inputs in the Table field. 

None No variation 

1 - 32 bit wo 
Time 

Package format containing a 32-bit signed integer, 
with status flags. 

2 - 16 bit wo 
Time 

Package format containing a 16-bit signed integer, 
with status flags. 

3 - 32 bit w 
Time 

Package format containing a 32-bit signed integer, 
with status flags, and the time when the event 
occurred. 

4 - 16 bit w 
Time 

Package format containing a 16-bit signed integer, 
with status flags, and the time when the event 
occurred. 

5 - Float wo 
Time 

Package format containing a single precision floating 
point value. 
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Field Description 

6 - Double 
wo Time 

Package format containing a double precision floating 
point value. 

7 - Float w 
Time 

Package format containing a single precision floating 
point value, and the time when the event occurred. 

8 - Double w 
Time 

Package format containing a double precision floating 
point value, and the time when the event occurred. 

Group 40 
Variation 

Analog Output Status. Used to report the status of an analog output 
point. Possible status flags include: 

Bit 0 = ONLINE 

Bit 1 = RESTART 

Bit 2 = COMM_LOST 

Bit 3 = REMOTE_FORCED 

Bit 4 = LOCAL_FORCED 

Bit 5 = OVER_RANGE 

Bit 6 = REFERENCE_ERR 

Bit 7 = Reserved, always 0 

Note 

This field appears only if you select Analog Outputs in the Table field. 

1 - 32 bit w 
Flag 

Package format containing a 32-bit signed integer, 
with status flags. 

2 - 16 bit w 
Flag 

Package format containing a 16-bit signed integer, 
with status flags. 

3 - Float w 
Flag 

Package format containing a single precision floating 
point value, with status flags. 

4 - Double w 
Flag 

Package format containing a double precision floating 
point value, with status flags. 

Group 41 
Variation 

Analog Outputs. Used to set an analog output point.  

Note 

This field appears only if you select Analog Outputs in the Table field. 

1 - 32 bit Package format containing a 32-bit signed integer. 

2 - 16 bit Package format containing a 16-bit signed integer. 
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Field Description 

3 - Float Package format containing a single precision floating 
point value. 

4 - Double Package format containing a double precision floating 
point value. 

Group 20 
Variation 

Counters Static. Used to report the current value of a counter point. 
Possible status flags include: 

Bit 0 = ONLINE 

Bit 1 = RESTART 

Bit 2 = COMM_LOST 

Bit 3 = REMOTE_FORCED 

Bit 4 = LOCAL_FORCED 

Bit 5 = ROLLOVER 

Bit 6 = DISCONTINUITY 

Bit 7 = Reserved, always 0 

Note 

This field appears only if you select Counters in the Table field. 

None No variation 

1 - 32 bit w 
Flag 

Package format containing a 32-bit unsigned integer, 
with status flags. 

2 - 16 bit w 
Flag 

Package format containing a 16-bit unsigned integer, 
with status flags. 

5 - 32 bit wo 
Flag 

Package format containing a 32-bit unsigned integer. 

6 - 16 bit wo 
Flag 

Package format containing a 16-bit unsigned integer. 
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Field Description 

Group 22 
Variation 

Counters Events. Used to report the value of a counter point after the 
count has changed. Possible status flags include: 

Bit 0 = ONLINE 

Bit 1 = RESTART 

Bit 2 = COMM_LOST 

Bit 3 = REMOTE_FORCED 

Bit 4 = LOCAL_FORCED 

Bit 5 = ROLLOVER 

Bit 6 = Reserved, always 0 

Bit 7 = Reserved, always 0 

Note 

This field appears only if you select Counters in the Table field. 

None No variation 

1 - 32 bit w 
Flag 

Package format containing a 32-bit unsigned integer, 
with status flags. 

2 - 16 bit w 
Flag 

Package format containing a 16-bit unsigned integer, 
with status flags. 

5 - 32 bit w 
Time & Flag 

Package format containing a 32-bit unsigned integer, 
with status flags, and the time when the event 
occurred. 

6 - 16 bit w 
Time & Flag 

Package format containing a 16-bit unsigned integer, 
with status flags, and the time when the event 
occurred. 

Operation Click ▼ to select the operation type for the selected parameter. 
Possible options are: 

Note 

• This field appears only if you select either Binary Outputs or 
Analog Outputs in the Table field. 

• Click ▼ in the column heading and select a value that is copied to 
all rows of the currently selected table. 

None Control modes are not allowed on the point. 

Select 
Control 

Control commands are accepted only if a point is 
selected. 
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Field Description 

Direct 
Control 

Control commands are accepted even if a point is not 
selected. 

Deadband 
Type 

Click ▼ to select the type of deadband to use with the selected 
parameter. Possible options are: 

Note 

• This field appears only if you select Analog Inputs in the Table 
field. 

• Click ▼ in the column heading and select a value that is copied to 
all rows of the currently selected table. 

None No deadband applies to this parameter. 

Absolute Sets the deadband range as a single value. If a new 
value differs from the last logged value by an amount 
that is less than the absolute value, then the new value 
is not recorded as a DNP3 event. If a new value differs 
from the baseline value by an amount that is greater 
than the absolute value, then the new value is recorded 
as a DNP3 event and becomes the new baseline for the 
absolute deadband. 
(Last Event Value - Current Value) > 
Deadband Value 

If true, then a DNP3 event is generated. 

If false, then no DNP3 event is generated. 

Percentage Sets the deadband range as a percent of the last logged 
value. If a new value differs from the last logged value 
by an amount that is less than the percentage value, 
then the new value is not recorded as a DNP3 event. If 
a new value differs from the last logged value by an 
amount that is greater than the percentage value, then 
the new value is recorded as a DNP3 event and 
becomes the new baseline for the percentage 
deadband. 
((Last Event Value - Current 
Value)/(Current Value))*100 >= Deadband 
Value 

If true, then a DNP3 event is generated. 

If false, then no DNP3 event is generated.  
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Field Description 

Deadband 
Value 

Enter a value to use as the deadband with the currently selected 
parameter. The deadband is a value that is an inactive zone above the 
low limits and below the high limits. The purpose of the deadband is 
to prevent a value (such as an alarm) from being set and cleared 
continuously when the input value is oscillating around the specified 
limit. This also prevents the logs or data storage location from being 
over-filled with data. 

Note 

• This field appears only if you select Analog Inputs in the Table 
field. 

• Click ▼ in the column heading and enter a value that is copied to 
all rows of the currently selected table. 

Insert Row Click to insert a row before the currently selected row. 

Add Row Click to add a new row at the end of the selected table. 

Delete Row Click to delete the currently selected row from the table. 

Clear Row Click to delete the information in the currently selected row. 

Clear Table Click to delete the current configuration for the selected table. 

Filter Click ▼ to narrow the number of parameters shown in the parameter 
list by object type. 

Object and 
instances 

Lists the available database objects (types) and instances (iterations) 
of each object. Select an Object and Instance to view the available 
parameters. 

Parameters Lists the available parameters (properties) for the selected object and 
instance. 

Referenced 
Parameters 

Lists the available parameters for the referenced object, when the 
data type of the parameter in the Parameters column is an OBJREF. 

Tag This read-only field shows the name of the parameter selected in the 
parameter list. 

Data Type This read-only field shows the data type of the parameter selected in 
the parameter list. 

Access Type This read-only field shows the read/write access of the parameter 
selected in the parameter list. 
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Field Description 

Value This read-only field shows the value of the parameter selected in the 
parameter list. 

Import CSV Click to import a CSV file into your FB Series product that contains 
your desired DNP3 configuration. Navigate to the location of the 
saved CSV file and select Open to start the import process. 

Note 

The system verifies the integrity of the CSV and asks for confirmation 
before continuing if any errors are found. Any invalid lines in the CSV 
file are ignored and data currently in the FB Series device is 
maintained. 

Export CSV Click to save a CSV file to your computer that contains the current 
DNP3 configuration of your FB Series product. A Select Table dialog 
opens where you can select which DNP3 tables to include in the 
export. Click Start, select a name and location for the exported file on 
your computer, and click Save to begin the export process. 

Note  

By default, all selected data is exported into a single file. Select Export 
to individual file to have the system create individual files for each 
DNP3 table you select. 

Open Log Click to open the ImportExportLogs folder on your computer that 
contains FBxConnect™ import/export error logs. Any errors 
encountered when importing a CSV file are stored in a log in this 
folder. 

Note 

Log file name includes the date and time the log was created. 

Load Default 
Map 

Click to load the default DNP3 map into your FB Series product. 

Refresh Reloads the table with the data stored in the FB Series product. 

Save Saves any changes you have made to the selected table. 

Close Closes the current display. 

9. Select an Object and Instance of that Object from the Objects and instances frame. A 
list of available parameters appears in the Parameters frame. 

10. Click and drag a parameter from the Parameters frame (or the Referenced 
Parameters frame) to the desired Point Index in selected the Map Table. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

820 

11. Click ▼ in the Class column to assign a Class to the selected parameter. 

12. Click ▼ in the Variations columns to assign the required variations to the selected 
parameter. 

13. Select Save to save any changes you make to this pop-up display. 

Note 

A Warm Start is required before changes take effect. 

4.29.2.2.1 Importing a DNP3 Map Table CSV File 

You can import a CSV file that contains your DNP3 map table configuration for use in your 
FB Series product.  

Note 

• For more information about DNP3 map tables in the FB Series product, refer to DNP3 
Map Table. 

• For more information about creating your own DNP3 map table CSV file, refer to 
Creating a DNP3 Map Table CSV File. 

• For more information about exporting a CSV file that contains the FB Series product's 
current Modbus poll table configuration, refer to Exporting a DNP3 Map Table CSV 
File. 

To import a CSV file that contains your DNP3 map table configuration: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the DNP3 protocol. 

3. Select the DNP3 button. The DNP3 pop-up display opens. 

4. Set the Active DNP3 Map field to User Defined. 

5. Select Save to save the changes to the display. 

6. Select the DNP3 Mapping button. The DNP3 Map Table pop-up display opens. 
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Figure 312. DNP3 Map Table – Import CSV 

 

7. Select the Import CSV button.  

8. Navigate to the file location of your CSV file and select Open. 

Note 

The system verifies the integrity of the CSV and asks for confirmation before continuing if 
any errors are found. If you select Import removing invalid parameters, any invalid 
lines in the CSV file are ignored and data currently in the FB Series device is maintained. 

9.  A confirmation message displays after importing the CSV. Select OK to complete the 
process. 

Note 

A Warm Start is required before changes take effect. 
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Figure 313. Confirmation 

 

4.29.2.2.2 Exporting a DNP3 Map Table CSV File 

You can export your FB Series product's current DNP3 map table configuration to a CSV 
file saved on your computer. 

Note 

• For more information about DNP3 map tables in the FB Series product, refer to DNP3 
Map Table. 

• For more information about creating your own DNP3 map table CSV file, refer to 
Creating a DNP3 Map Table CSV File. 

• For more information about importing a CSV file that contains your DNP3 map table 
configuration for use in your FB Series product, refer to Importing a DNP3 Map Table 
CSV File. 

To export a CSV file that contains your DNP3 map table configuration: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the DNP3 protocol. 

3. Select the DNP3 button. The DNP3 pop-up display opens. 

4. Set the Active DNP3 Map field to User Defined. 

5. Select Save to save the changes to the display. 

6. Select the DNP3 Mapping button. The DNP3 Map Table pop-up display opens. 
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Figure 314. DNP3 Map Table – Export CSV 

 

7. Select the Export CSV button. The Select Table pop-up display opens. 
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Figure 315. Select Table 

 

8. Place a check mark next to each table you want to export. 

Note 

By default, all selected tables are exported to a single file. If you want each selected table 
to be exported to individual files, place a check mark next to Export to individual file. 

9. Select Start. A Save csv file window opens. 
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Figure 316. Save csv file 

 

10. Navigate to a location on your computer to save your exported CSV file and select 
Save. The system exports the CSV file and displays a progress bar at the top of the 
display. 

11. A confirmation message displays after exporting the CSV file. Select OK to complete 
the process. 

Figure 317. Confirmation 

 

4.29.2.2.3 Creating a DNP3 Map Table CSV File 

You can create a CSV file that contains your DNP3 map table on your computer, and then 
import the CSV file for use in the FB Series product. If your DNP3 map is large, it may be 
easier to create a CSV file on your computer than it is to configure the table in 
FBxConnect™.  
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Note 

• For more information about DNP3 map tables, refer to DNP3 Map Table. 

• For more information about importing CSV file that contains your DNP3 map table 
configuration for use in your FB Series product, refer to Importing a DNP3 Map Table 
CSV File. 

• The DNP3 map CSV must contain the format shown below. The easiest way to begin 
creating a custom map is to export a CSV that contains the current configuration and 
then edit that file. For more information about exporting a CSV file, refer to Exporting 
a DNP3 Map Table CSV File. 
Figure 318. Example DNP3 Map CSV Format 

 

To create a CSV file that contains your Modbus map table configuration: 

1. Open a blank spreadsheet (or open your previously exported Modbus poll table CSV 
file). 

2. In row one of the spreadsheet, enter the following text:  

• Column A = Table 

• Column B = Point Index 

• Column C = Device Parameter 

• Column D = Class 

• Column E = Variation 1 

• Column F = Variation 2 

3. In the proceeding rows, enter information for each table entry according to the 
descriptions below: 

Note 

Drop-down lists on the FBxConnect™ display are represented as numbers in the CSV file. 
See the descriptions below for a description for each number. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

827 

Column 
Heading 

Description 

Table Specifies which DNP3 table the selected row belongs to. Valid values 
and the number of points available in each table are listed below: 

• Binary Inputs – 65535 points 

• Binary Outputs – 65535 points 

• Analog Inputs – 65535 points 

• Analog Outputs – 65535 points 

• Counters – 65535 points 

• Strings – 65535 points 

Point Index Enter a number to specify the point in the selected table. 

Device 
Parameter 

Enter a parameter for the FB Series product's database. 

Class Enter a number to assign the selected parameter to a class. Possible 
options are: 

0 None 

1 Class 1 

2 Class 2 

4 Class 3 

7 All 

Variation 1 Group variations are associated with different table types. Enter a 
number that corresponds to a bit for the selected table type. Refer to 
DNP3 Map Table for a complete list of variations and their associated 
bits. The variations for each table type are below: 

• Binary Input = Group 1 Variation 

• Binary Output = Group 10 Variation 

• Analog Input = Group 30 Variation 

• Analog Output = Group 40 Variation 

• Counters = Group 20 Variation 
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Column 
Heading 

Description 

Variation 2 Group variations are associated with different table types. Enter a 
number that corresponds to a bit for the selected table type. Refer to 
DNP3 Map Table for a complete list of variations and their associated 
bits. 

• Binary Input = Group 2 Variation 

• Binary Output = Group 12 Variation 

• Analog Input = Group 32 Variation 

• Analog Output = Group 41 Variation 

• Counters = Group 22 Variation 

4. Save your changes. You can now import your CSV file for use in your FB Series 
product. For more information, refer to Importing a DNP3 Map Table CSV File. 

Note 

Make sure to save the file with a .csv file extension. 

4.29.2.3 Auto Managed DNP3 Map 

Use the Auto Managed Object DNP3 Map option to create templates that map 
parameters in the FB Series product database to DNP3 data points. You can generate a 
DNP3 map file based on these templates and then import the DNP3 map file into your 
SCADA system to easily retrieve information contained in your FB Series product.  

There are two types of files used in the Auto Managed Object Mapping process: an Object 
Mapping Template file and a generated DNP3 Map file. 

Object Mapping Template  

An Object Mapping Template file is needed as the first step in the Auto Managed DNP3 
Mapping process. An Object Mapping Template file contains parameters from the FB 
Series product database that are mapped to DNP3 data types. A default Object Mapping 
Template file (DefaultOMT.omt) is included with FBxConnect™ that contains default 
mapping for the FB Series products. You can edit this Object Mapping Template file 
and/or create your own Object Mapping Template files that contain mapping only for the 
specific object parameters you select. You can then import the template files into 
different FB Series products and easily create consistent DNP3 maps. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

829 

Applications installed on an FB3000 RTU may include their own template file. An 
application template is a file that contains application parameter names that are mapped 
to DNP3 data types. Application templates are created by the application developer and 
copied to your FB Series product when you install the application. If an application does 
not contain a template, you can create your own template for the parameters used by the 
application.  

Note 

• The default location for the default Standard Configuration Object Mapping Template 
file (DefaultOMT.omt) is C:\Users\Public\Documents\Emerson\FieldTools\FBx\DNP3 Map 
Templates.  

• For more information about creating your own Object Mapping Template file(s), refer 
to Creating an Object Mapping Template. 

• Application templates are created by the application developer and are not included 
with every application. 

DNP3 Map 

A DNP3 map is the final output of the Auto Managed DNP3 Mapping process. A DNP3 
map is a set of binary files that contain parameters mapped to DNP3 points.  There is a 
DNP3 binary file for each DNP3 group (Binary Inputs, Binary Outputs, Analog Inputs, 
Analog Outputs, Counters and Strings. You can import these files into your SCADA system 
to identify which parameters you want to include in your SCADA database. This process 
saves you time and reduces the need to manually configure these parameters within your 
SCADA system. 

Note 

• Referenced parameters are not currently supported when building a DNP3 map 
from an Object Mapping Template file. 

• Not all SCADA systems support DNP3 maps. Please check with your SCADA vendor to 
see if this feature is supported.  

To create this file, select which parameters you want to include from your Object Mapping 
Template(s) and then either select the Build DNP3 Map button on the Communications – 
DNP3 pop-up display or the Generate DNP3 Map files on the Object Mapping Template 
Editor dialog box. The system builds a DNP3 Map based on the configured Object 
Mapping Template and either replaces the current DNP3 map or merges any newly 
defined parameters to the existing map, dependent on the option you select, in the 
connected FB Series product. 
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Note 

• If you add meters to an FB Series product after mapping your device, you must 
generate a new DNP3 Map. 

• For more information about creating a DNP3 map, refer to Building a DNP3 Map. 

• To remove an existing DNP3 Map file from the FB Series product, either perform a 
Cold Start and select Clear user protocol maps or delete the DNP3 Map files (located 
in the protocol > dnp3 > map_1 folder) using the File Transfer dialog box. 

For more information, refer to the following topics: 

Object Mapping Template Editor 

Creating an Object Mapping Template 

Building a DNP3 Map 

Viewing a DNP3 Map 

4.29.2.4 Object Mapping Template Editor 

Use this dialog box to create an Object Mapping Template file that contains parameters in 
your FB Series product that are mapped to DNP3 Map Groups. 

Note 

• This topic contains field descriptions for the Object Mapping Template Editor dialog 
box. For more information on the process of creating an Object Mapping Template, 
refer to Creating an Object Mapping Template. 

• If you add meters to an FB Series product after mapping your device, you must 
generate a new DNP3 map. 

• To remove an existing DNP3 Map file from the FB Series product, perform a Cold Start 
and select Clear user protocol maps. 

To access this pop-up display: 

1. Select Configure > Communications for the FBxConnect™ main menu. The 
Communications display opens. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the DNP3 protocol. 

3. Select the DNP3 button. The DNP3 pop-up display opens. 
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Figure 319. DNP3 – Edit Template Button 

 

4. Select Auto Managed in the Active DNP3 Map field. 

5. Select Save to save your selection. 

6. Select the Edit Template button. The Object Mapping Template Editor dialog box 
opens. 
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Figure 320. Object Mapping Template Editor 

 

# Description 

1 Objects Tree / DNP3 Groups Tree 

2 Objects / DNP3 Groups Buttons 

3 Information Grid 

7. Review – and change as necessary – the values in the following fields: 

Field Description 

Objects Tree Shows the Objects in the FB Series product internal database and the 
Objects in any installed applications.  

Note 
Objects that you have included in the Object Mapping Template file 
are shown using the color green. 

DNP3 Groups 
Tree 

Shows the DNP3 map currently in the FB Series product.  

Objects 
Button 

Select this button to show the Objects tree on the Object Mapping 
Template Editor dialog box. 
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Field Description 

DNP3 Groups 
Button 

Select this button to show the DNP3 Groups tree on the Object 
Mapping Template Editor dialog box. 

Information 
Grid 

Shows information associated with your selection in the Objects Tree 
or DNP3 Tree. For more information, refer to Objects Grid, Object 
Attributes Grid, Parameters Grid, and Viewing a DNP3 Map. 

Save to 
Template 
files 

Select this button to save the currently defined Object Mapping to a 
template file(s). 

Note 
Template files are stored as part of the solution file. 

Generate 
DNP3 Map 
files 

Select this button to build a DNP3 map based on an Object Mapping 
Template and transfer the DNP3 map to the connected FB Series 
product. For more information, refer to Building a DNP3 Map. 

Import 
Template file 

Select this button to load a previously saved standard configuration 
Object Mapping Template file or application Object Mapping Template 
file into the Object Mapping Template Editor. The import functionality 
supports two different modes: 

• Merge – Merges the new template with existing templates. This is 
the default option. 

• Replace – Replace existing templates with the new template. Click 
▼ to select this option. 

Note 

• A default standard configuration Object Mapping Template file 
(DefaultOMT.omt) is included with FBxConnect™ that contains 
default mapping for the FB Series products.  

• When loading an application Object Mapping Template file, the 
application must contain the same Objects that are used in the 
template file. If the Objects used in the template file are not 
present in the application, the system does not import the 
template file data for the missing Objects. 

Settings Select this button to open the Object Mapping Template Editor 
Settings dialog box and customize the layout of the Object Mapping 
Template Editor and to configure the mapping of FBx data types to 
DNP data types. 
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Field Description 

Auto-
populate 
Start Indexes 

Select this button to automatically generate OMT map start indexes 
for each selected Object based on the number of reserved entries for 
each Object. 

8. Select Close to exit the Object Mapping Template Editor dialog box. 
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4.29.2.4.1 Objects Grid (Object Mapping Template Editor) 

Use the Objects Grid to select which objects from the FB Series product are included in 
the Object Mapping Template and to configure how each object is mapped to the DNP3 
map groups. 

To access the Objects Grid: 

1. From the Object Mapping Template Editor dialog box, select the Objects Button at 
the bottom left-hand side of the dialog box to show the Objects tree. 

2. Select the Objects node in the Objects tree. The Objects Grid lists all Objects in the 
right-hand side of the dialog box. 

Figure 321. Objects Grid 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Checkbox Place a check mark in the row next to the Object name to include the 
Object in the Object Mapping Template. 

Name This column shows the Object names from the FB Series product's 
internal database and any installed applications. 

Binary Input 
Start Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

Binary Input 
Count 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Binary 
Output Start 
Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 
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Field Description 

Binary 
Output Count 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Analog Input 
Start Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

Analog Input 
Count 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Analog 
Output Start 
Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

Analog 
Output Count 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Counter Start 
Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

Counter 
Count 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

String Start 
Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

String Count Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Condition Enter a simple logical expression that indicates when the selected 
object is included in the resulting DNP3 Map. Valid logical operators 
are: ==, !=, >, <, >=, <=. For example, when the expression is 
PID_ENABLE == 1, the PID parameters are included in the DNP3 Map 
only when the value of the PID_1.PID_ENABLE parameter is 1. 

Alias Enter an alternate name used by your SCADA system when polling for 
the selected object. 

Template File 
Name 

Click ▼ and select an existing Object Mapping Template file or enter a 
file name to create a new Object Mapping Template file that the 
system uses to save the object mapping configuration for the selected 
row. 
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4.29.2.4.2 Object Attributes Grid (Object Mapping Template Editor) 

Use the Objects Attributes Grid to configure if the selected Object is included in an Object 
Mapping Template and to configure how the selected Object is mapped to the DNP3 map 
groups. 

Note 

You can also configure the Object parameters for multiple Objects from the Objects Grid. 

To access the Objects Attributes Grid: 

1. From the Object Mapping Template Editor dialog box, select the Objects Button at 
the bottom left-hand side of the dialog box to show the Objects tree. 

2. Select an object name from the Object tree (DP Mtr_ in the example below). The 
Object Attributes Grid lists all attributes for the selected Object in the right-hand side 
of the dialog box. 

Figure 322. Object Attributes Grid 
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3. Review – and change as necessary – the values in the following fields: 

Field Description 

Include in 
Template 

Click ▼ to configure if the selected Object is included in the Object 
Mapping Template (Yes) or not (No). 

Template File 
Name 

Click ▼ and select an existing Object Mapping Template file or enter a 
file name to create a new Object Mapping Template file that the 
system uses to save the object mapping configuration for the selected 
row. 

Object Alias Enter an alternate name used by your SCADA system when polling for 
the selected object. 

Condition Enter a simple logical expression that indicates when the selected 
instances are included in the resulting DNP3 Map. Valid logical 
operators are: ==, !=, >, <, >=, <=. For example, when the expression is 
PID_ENABLE == 1, the PID_1 parameters are included in the DNP3 Map 
only when the value of the PID_1.PID_ENABLE parameter is 1. 

The expression format can consist of one of the following three 
options: 

1. Condition – one condition 

2. Condition AND Condition – two conditions separated by the 
AND operator (both conditions must match) 

3. Condition OR Condition – two conditions separated by the OR 
operator (either condition must match) 

Condition Format: 

Each condition is comprised of three parts: 
 Parameter Operator Value 

Parameter Format: 
 A parameter in the current instance (i.e. PID_ENABLE) 
 A parameter in another fixed object (i.e. Station_1.FLD_TYPE) 
 A parameter in another associated object (i.e. 

Station_{i}.FLD_TYPE)  
Note 
{i} is replaced with the current instance number. 

Operator Format: 
 For strings: ==     != 
 For integers: ==     !=     <     <=     >     >= 
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Field Description 
 Analogs are not supported 

Value Format: 
 Use double quotes around the value (“Value”) to indicate a 

string parameter. 

Examples: 
 INSTALLED == 1 
 DESC==”Analog Input 3” 
 INSTALLED==1 AND ENABLED==1 
 INSTALLED==1 OR ENABLED==1 
 DP Mtr_1.MTR_TYPE==2 
 DP Mtr_{i}.MTR_TYPE==2 

Binary Input 
Start Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

Binary Input 
Reserved 
Parameters 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Binary 
Output Start 
Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

Binary 
Output 
Reserved 
Parameters 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Analog Input 
Start Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

Analog Input 
Reserved 
Parameters 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Analog 
Output Start 
Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 
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Field Description 

Analog 
Output 
Reserved 
Parameters 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Counter Start 
Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

Counter 
Reserved 
Parameters 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

String Start 
Index 

Click  to set the selected Object's starting position in the DNP3 map 

group. 

String 
Reserved 
Parameters 

Click  to set the number of entries reserved for the selected Object 

in the DNP3 map group. 

Total number 
of selected 
parameters 

Shows the total number of binary input (BI), binary output (BO), 
analog input (AI), analog output (AO), counter, and string parameters 
that are included in the template for the currently selected Object. 

 

4.29.2.4.3 Parameters Grid (Object Mapping Template Editor) 

Use the Parameters Grid to configure if individual parameters for the selected Object are 
included in an Object Mapping Template and how each parameter is mapped to the DNP3 
map groups. 

To view the Parameters Grid: 

1. From the Object Mapping Template Editor dialog box, select the Objects Button at 
the bottom left-hand side of the dialog box to show the Objects tree. 

2. Click  next an Object Name in the Object tree to expand the Object (DP Mtr_ in the 

example below). 

3. Select Parameters underneath the expanded Object. The Parameters Grid lists all 
parameters for the selected Object in the right-hand side of the dialog box. 
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Figure 323. Parameters Grid 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Checkbox Place a check mark in the row next to a Parameter Name to include 
the parameter in your Object Mapping Template. 

Note 
Place a check mark in the column heading row to select all 
parameters belonging to the selected object. 

Name This read-only column shows the name of the parameter in the FB 
Series product's internal database for the selected row. 

Description This read-only column shows a description of the parameter in the 
FB Series product's internal database for the selected row. 

FBx Data Type This read-only column shows the data type of the parameter in the 
FB Series product's internal database for the selected row. 

DNP Data Type Click ▼ to select the data type stored in the DNP3 map for the 
selected row. 
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Field Description 

Position Click  to set the position in the DNP3 map group of the data in the 

selected row.  

Note 

• Positions must start at 1 and must be consecutive. 

• The system automatically increments the position number for 
each DNP3 map group when you select a parameter for inclusion 
in the template. 

• Different signal types have separate map groups, and each map 
group has its own positions. For example, if you have two 
parameters with a DNP Data Type of AI and three parameters 
with a DNP Data Type of Counter, then the AI positions would be 
1 and 2 and the Counter positions would be 1, 2, and 3. 

Variation 1 Click ▼ to set the data type encoding formats for the data types. For 
more information on the different variations for different data types, 
refer to DNP3 Map Table. 

Variation 2 Click ▼ to set the data type encoding formats for the data types. For 
more information on the different variations for different data types, 
refer to DNP3 Map Table. 

Class Click ▼ to set an event class for the selected parameter. For more 
information on the different variations for different data types, refer 
to DNP3 Map Table. 

Control 
Operation 

Click ▼ to set the control operation type for the selected parameter. 
For more information, refer to DNP3 Map Table. 

Deadband 
Type 

Click ▼ to set the deadband type for the selected parameter. For 
more information, refer to DNP3 Map Table. 

Deadband 
Value 

Click ▼ to set the deadband value for the selected parameter. For 
more information, refer to DNP3 Map Table. 

Alias Enter an alternate name used by your SCADA system when polling 
for the selected parameter. 

Total number 
of selected 
parameters 

Shows the total number of binary input (BI), binary output (BO), 
analog input (AI), analog output (AO), counter, and string parameters 
that are included in the template for the currently selected Object. 
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4.29.2.5 Object Mapping Template Editor Settings 

Use this dialog box to customize the layout of the Object Mapping Template Editor and to 
configure the mapping of FBx data types to DNP data types.  

To customize the Object Mapping Template Editor, select the Settings button on the 
Object Mapping Template Editor dialog box. The Object Mapping Template Editor Settings 
dialog box opens showing the General tab. 

Figure 324. Object Mapping Template Editor Settings 

 

The Object Mapping Template Editor Settings display contains the following tabs: 

General – Use this tab to customize the layout of the Object Mapping Template Editor.  

Data Type Mapping – Use this tab to customize how data types in the FB Series product's 
internal database (FBx Data Type) are mapped to DNP3 data types.  
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4.29.2.5.1 Object Mapping Template Editor Settings – General Tab 

Use this tab to customize the layout of the Object Mapping Template Editor.  

To customize the Object Mapping Template Editor dialog box: 

1. Select the Settings button on the Object Mapping Template Editor dialog box. The 
Object Mapping Template Editor Settings showing the General tab. 

Figure 325. Object Mapping Template Editor Settings – General Tab 
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2. Review – and change as necessary – the values in the following fields: 

Field Description 

Group objects 
on the tree 
(Standard 
Configuration 
and 
Applications) 

Place a check mark to have the objects shown in the Objects tree be 
separated based on if the objects are included in the standard FB 
Series product configuration or if the objects are included in 
applications. 

Note 
If this option is not selected, all objects are shown in the Objects tree 
with no grouping. 

Show 
template file 
name on the 
Objects tree 

Place a check mark to show the Object Mapping Template name next 
to the object name in the Objects tree. You can also configure if you 
want the name to appear on the left-hand side or right-hand side of 
the Object name in the Objects tree. 

Show FBx 
Data Type 
column on 
the 
Parameters 
grid 

Place a check mark to show the FBxData Type column when viewing 
the Parameters grid. 

Show 
Description 
column on 
the 
Parameters 
grid 

Place a check mark to show the Description column when viewing the 
Parameters grid.  

Import Select this button to import a saved Object Mapping Template Editor 
Settings file.  

Note 
Importing an Object Mapping Template Editor Settings file applies to 
all FBxConnect™ sessions on this PC. 

Export Select this button to export your Object Mapping Template Editor 
Settings to a file on your PC. The exported file uses the file extension 
.OMTS. 
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4.29.2.5.2 Object Mapping Template Editor Settings – Data Type Mapping Tab 

Use this tab to customize how data types in the FB Series product's internal database (FBx 
Data Type) are mapped to DNP3 data types.  

To customize the Object Mapping Template Editor dialog box: 

1. Select the Settings button on the Object Mapping Template Editor dialog box. The 
Object Mapping Template Editor Settings dialog box opens showing the General tab. 

2. Select the Data Type Mapping tab. 

Figure 326. Object Mapping Template Settings – Data Type Mapping Tab 

 

3. In the rows for each FBx Data Type, select what type of data is stored in the DNP3 
Map when converting data from FBx Data Types to DNP Data Types. 

4. Select Close to exit the Object Mapping Template Settings dialog box. 
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4.29.2.6 Creating an Object Mapping Template 

Use the Object Mapping Template Editor to create a template file that maps parameters 
in the FB Series product database to DNP3 data types. Creating an Object Mapping 
Template file is the first step that is required to generate an Auto Managed DNP3 Map. 
You can select which objects and parameters from the FB Series product database that 
you want to include in the Object Mapping Template file. After you have created the 
Object Mapping Template file, you can then use the file to create DNP3 maps for multiple 
FB Series products. For more information, refer to Generating a DNP3 Map. 

To create an Object Mapping Template file: 

1. Select Configure > Communications for the FBxConnect™ main menu. The 
Communications display opens. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the DNP3 protocol. 

3. Select the DNP3 button. The DNP3 pop-up display opens. 

Figure 327. DNP3 – Edit Template Button 

 

4. Select Auto Managed in the Active DNP3 Map field. 

5. Select Save to save your selection. 
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6. Select the Edit Template button. The Object Mapping Template Editor opens showing 
the Objects tree. 

Note 

If you do not currently have an Object Mapping Template configured, a message opens 
asking if you would like to import a default template. Select Yes to import the default 
template or a template you have previously created on another FB Series product. Select 
No to start from an empty template with no Objects or Parameters selected. 
Figure 328. Use Default Question 

 

Figure 329. Object Mapping Template Editor 

 

7. Place a check mark next to an Object Name for each Object you want to include in 
the DNP3 map. 
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8. For each selected Object, enter the Start Index to set the starting position in the 
DNP3 map for each DNP3 map group (Binary Input, Binary Output, Analog Input, 
Analog Output, Counters, and Strings). 

9. For the selected Object, enter the Count to set the number of entries that are 
reserved for the Object in the DNP3 map groups. 

10. For the selected Object, click ▼ in the Template File Name column and select an 
existing Object Mapping Template file or enter a file name to create a new Object 
Mapping Template file that the system uses to save the object mapping configuration. 

Note 

For descriptions of the other columns, refer to the Objects Grid or Object Attributes Grid 
topics. 

11. Click  next an Object Name in the Object tree to expand the Object (DP Mtr_ in the 

example below). 

12. Select Parameters underneath the expanded Object. The Parameters Grid shows in 
the right-hand side of the dialog box listing all parameters for the selected Object. 

13. Place a check mark next to each parameter name you want the include in the DNP3 
Map. 

Note 

For descriptions of the other columns, refer to the Parameters Grid topic. 

14. When you have finished configuring which Objects and Parameters to add to your 
template, select the Save to Template files button. The system saves your 
configuration to the file name(s) you configured in the Template File Name field for 
each object. You can now build a DNP3 Map that contains DNP3 data types that are 
mapped to parameters in your FB Series product. For more information, refer to 
Building a DNP3 Map. 

4.29.2.7 Building a DNP3 Map 

Use this feature to create an DNP3 Map file that contains DNP3 data types that are 
mapped to parameters in your FB Series product. 
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Note 

• Before you can build a DNP3 map, you first need to either create a Object Mapping 
Template file or select a default Object Mapping Template file.  

• If you add meters to an FB Series product after mapping your device, you must edit 
your Object Mapping Template and generate a new DNP3 map. 

• Referenced parameters are not currently supported when building a DNP3 map 
from an Object Mapping Template file. 

• To remove an existing DNP3 Map file from the FB Series product, perform a Cold Start 
and select Clear user protocol maps. 

To generate a DNP3 map: 

1. From the Communications – DNP3 pop-up display: Select the Build DNP3 Map button. 
FBxConnect™ uploads the current DNP3 map from the FB Series product to compare 
it against the new map.  
or 
From the Object Template Mapping Editor dialog box: Select the Generate DNP3 Map 
files button. FBxConnect™ uploads the current DNP3 map from the FB Series product 
to compare it against the new map.  

Figure 330. Merge Dialog 

 

2. A message box opens asking if you want to merge the map currently in the FB Series 
product with the newest map.  

• Select Yes to keep the map currently in the FB series product and add any new 
information to the end of the map. The DNP3 Map Generator dialog box opens. 

• Select No to replace the map currently in the FB Series product with the newest 
map. The DNP3 Map Generator dialog box opens. 

• Select Cancel to return to the DNP3 display. 
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3. If you select Yes or No in the previous step, the DNP3 Map Generator opens and 
processes your request to either merge or replace the DNP3 map in the FB Series 
product. When the process is finished and the DNP3 map is transferred to the FB 
Series product, a message on the DNP3 Map Generator says DNP3 Map Generation 
Complete. 

Figure 331. DNP3 Map Generator 

 

Note 

An error messages opens if the system encounters any errors when building the DNP3. 
Select OK to close this error message and select the View Log File button on the DNP3 
Map Generator dialog box to open a log file and view the results of building the DNP3 
map. 
Figure 332. Object Mapping Template Error Message 
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4. Select Close to exit the DNP3 Map Generator dialog box. 

Note 

A Warm Start is required before changes take effect. 

4.29.2.8 Viewing a DNP3 Map 

Use this feature to view the DNP3 map currently used by the FB Series product. 

Note 

You can also view the DNP3 Map by selecting the DNP3 Groups button on from the 
Object Mapping Template Editor dialog box. 

To view the current DNP3 map: 

1. From the Communications – DNP3 pop-up display: Select the View DNP3 Map button. 
The DNP3 Map View dialog box opens. 
or 
From the Object Template Mapping Editor dialog box: Select the View DNP3 Map 
button. The DNP3 Map View dialog box opens. 

Figure 333. DNP3 Map View 
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2. Select a DNP3 data type from the tree on the left-hand side of the dialog box to view 
read-only information about the DNP3 map currently in use. 

Note 

• You must select a DNP3 data type (Binary Inputs, Analog Outputs, etc.) before 
information is shown in the right-hand side of the dialog box. 

• You must build a DNP3 map before any information is shown on this dialog box. If 
you do not build a DNP3 before viewing this dialog box, no information is shown 
when you select a DNP3 data type. 

3. Select Close to exit the DNP3 Map View dialog box. 

4.29.3 Communications – Modbus Slave 

Use this pop-up display to configure Modbus Slave protocol options for each 
communications port that is configured to use Modbus Slave protocol. 

Note 

This pop-up display is available only if you select either Modbus Slave or DNP3/Modbus 
Slave in the Port Owner drop-down list on the Communications – General display. 

To access this pop-up display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave protocol. 

3. Select the Modbus Slave button. The Modbus Slave pop-up display opens. 
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Figure 334. Communications – Modbus Slave  

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Modbus TCP 
Enable/Disable 

Sets if Modbus messages are recognized on the Ethernet port. 

Note 

This field applies only to the Ethernet port. 

Enable Modbus messages are recognized on the Ethernet 
port. 

Disable Modbus messages are not recognized on the 
Ethernet port. 
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Field Description 

Modbus 
Transmission 
Mode 

Sets the communications mode for the selected communications 
port. 

Note 

You must configure all devices in the same communications network 
with the same mode of transmission. Additionally, in either ASCII or 
RTU mode, the transmitting device places the Modbus message into 
a frame that has a known beginning and ending point. 

RTU Remote Terminal Unit mode allows for greater 
character density and better data throughput than 
ASCII for the same baud rate. Each message is 
transmitted in a continuous stream. Data is sent in 8-
bit binary characters. RTU mode uses Cyclic 
Redundancy Check (CRC) error checking. By default, 
RTU is enabled. 

ASCII American Standard Code for Information Interchange 
mode represents each 8-bit byte of data as two ASCII 
characters that are the hexadecimal representation of 
the value. This allows the messages to be read with 
the use of a dumb terminal but uses twice as many 
characters as the RTU mode. Each character sent is 
composed of a start bit, 7 or 8 data bits, and one or 
two stop bits with Even, Odd, or No parity. ASCII mode 
uses Longitudinal Redundancy Checking (LRC) error 
checking. 

TCP Adds a 6-byte header to Modbus messages, and then 
encapsulates it for transmission over TCP/IP. The 
header consists of the following: 

• A 2-byte transaction ID that increments for each 
packet sent. 

• A 2-byte protocol ID. The protocol ID for Modbus 
is 0. 

• A 2-byte indicator of the packet length. 

Note 

This field applies only to the Ethernet port. 
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Field Description 

Byte Order Sets the order of data bytes in a transmission or requests, which can 
be reversed. This only affects the Data field of a Modbus message 
and has no effect on the data bytes for Function Codes 01, 02, and 
05. 

LSB Least Significant Byte First (places the Least Significant 
Byte first). This is the default value. 

MSB Most Significant Byte First (places the Most Significant 
Byte first). 

Modbus Slave 
Address 

Sets the Modbus Slave address for the selected communications port 
on the FB Series product. 

Note 

• This field changes positions on the display based on your 
selection in the Modbus Mapping using CSV Files field. If you 
select Database Objects, then the field shows in the Options 
section of the display. If you select Use CSV Files, then the field 
shows in the EFM Modbus section of the display. 

• If you set the Enhanced Modbus Slave IDs field to Enable, then 
this field applies to requests for Modbus EFM registers only. 

Modbus TCP 
Port Num 

Sets the TCP port to use for Modbus messages on the Ethernet port. 
The default is 502. 

Note 

• This field applies only to the Ethernet port. 

• Do not enter 9009 for this number; it is reserved by FBxNet. 
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Field Description 

Enhanced 
Modbus Slave 
IDs 

Click ▼ and select Enable to allow the FB Series product to 
respond to multiple slave IDs on a single communications port. 
For example, if you enable this feature and configure the Map 
Table Register using Slave IDs 1, 3, and 5, then the FB Series 
product would only respond to Modbus requests using Slave 
IDs 1, 3, and 5 and ignore all other Slave ID requests. 

Note 

• This field shows only if you select Use CSV Files in the 
Modbus Mapping using CSV Files field. 

• To access the EFM Hourly Registers and EFM Daily 
Registers after you enable Enhanced Mode Slave IDs, you 
must configure at least one row in the Map Table Register 
using the same Slave ID as the ID you configured in the 
Modbus Slave Address field. 

Map Table 
Registers 

Click to open the Map Table Register pop-up display and configure 
the Modbus registers stored in the FB Series product. 

Note 

• Map Table Registers are shared between all communications 
ports that are configured to use either Modbus Slave or Modbus 
Master protocol. 

• You can create a Modbus Map Table as a CSV file on your 
computer and then import the CSV file for use in the FB Series 
product. For more information about creating, importing, and 
exporting your own Modbus Map Table CSV files, refer to 
Creating a Modbus Map Table CSV File, Importing a Modbus Map 
Table CSV File, and Exporting a Modbus Map Table CSV File and 
Remote Data Types. 

Modbus 
Mapping using 
CSV Files 

Sets the location where the Modbus map table is stored by the FB 
Series product.  

Note  

• If you change this option, you must perform a warm start before 
any changes are applied. 

• Your selection applies to both Modbus Slave and Modbus Master 
protocols. 
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Field Description 

Database 
Objects 

Select this radio button to store the Modbus map 
table in the FB Series product's internal database. 

Use CSV 
Files 

Select this radio button to store the Modbus map 
table as CSV files in the FB Series product. 

Note 

• This option removes the Modbus map table from 
the internal database and increases the available 
amount of memory in the FB Series product. 

• To avoid losing data, export your current Modbus 
map table before you select this option. For more 
information, refer to Exporting a Modbus Map 
Table CSV File. 

Modbus 
Mapping 
Status 

This read-only field shows the current condition of 
the Modbus map table. Possible values are: 

No Error (0) The CSV file is valid. 

No Mapping 
Found (1) 

There is no mapping file currently on 
the device. 

Column 
Mismatch (2) 

The CSV file is not formatted correctly. 
Some rows have more or less columns 
than the header. Open the Log within 
the EFM Registers window for a 
detailed analysis. 

Missing Req 
Column (3) 

The CSV file is missing a required 
column. Open the Log within the EFM 
Registers window for a detailed 
analysis. 

Exceeded 
Max Data (4) 

The CSV file contained more rows 
than the firmware supports. 

Invalid Row 
Data (5) 

The CSV file contains a row with 
invalid data. This can be out of range 
data or mappings that cannot be 
processed. Open the Log within the 
EFM Registers window for a detailed 
analysis. 
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Field Description 

Duplicate 
Data (7) 

The CSV file contains two mappings 
with similar data or identical register 
numbers. Open the Log within the 
EFM Registers window for a detailed 
analysis.  

EFM Modbus 
Option 

Sets whether the selected communications port supports EFM 
Modbus reporting. 

Enable The selected port supports EFM Modbus reporting. 

Disable The selected port supports standard Modbus 
reporting. 

EFM Date 
Register 

Sets the Modbus register used to access (read/write) the date when 
using the selected communications port. 

Note 

The Current Date value identifies the current date from the FB Series 
product. This may be useful when you desire the date as a floating-
point number. 

EFM Time 
Register 

Sets the Modbus register used to access (read/write) the time when 
using the selected communications port. 

Note 

The Current Time value identifies the current time from the FB Series 
product. This may be useful when you desire the time as a floating-
point number. 

Alarm/Event 
Register 

Sets the Modbus Register Number used to acquire the most current 
unacknowledged Event and Alarms Log entries when using the 
selected communications port. 

EFM 
Application 
Event Enable 

Sets whether the selected communications port supports retrieval of 
Application Events, User Application Events, String Events, 
Application Alarms, and User Application Alarms contained in the 
Event and Alarm logs via Modbus. For a list of the Modbus registers 
used when retrieving EFM Application Events, refer to Modbus 
Registers for EFM Application Events. 

Enable Allows these Events and Alarms to be retrieved via 
Modbus. 
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Field Description 

Disable Does not allow these Events and Alarms to be 
retrieved via Modbus. 

Enable Enron 
Modbus 
Register 
Format 

Sets the type of EFM Modbus register mapping used for the selected 
communications port. 

Enable Multiple FB Series product events are mapped to one 
Modbus register. For more information, contact 
Emerson technical support. 

Disable One FB Series product event is mapped to one 
Modbus register. This is the default. 

Enable Float 
Date Time 
Event 

Sets if date and time changes are added to the event log when a time 
sync request is received via Modbus. 

Note 

Enable Float Date Time Event settings are shared between all 
communications ports that are configured to use Modbus Slave 
protocol. 

Enable When a time sync request is received, the following 
three events are added to the event log. The date and 
time events are retrievable via Modbus: 

• Clock_1.TIME – Change  

• Clock_1.FLOAT_DATE 

• Clock_1.FLOAT_TIME 

Note 

• The Clock_1.FLOAT_DATE event is added to the 
event log only if the date is changed. 

• The Clock_1.FLOAT_TIME event is added to the 
event log only if the time is changed. 

Disable When a time sync request is received, the following 
event is added to the event log. The data and time 
events are not retrievable via Modbus: 

• Clock_1.TIME – Change  

EFM History 
Time Format 

Sets the EFM history timestamp format used for the selected 
communications port. 

HHMM Two-digit hour and two-digit minute. 
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Field Description 

HHMMSS Two-digit hour, two-digit minute, and two-digit 
second. 

Historical Log 
Timestamp 
Mode 

Sets whether the system logs (stamps) history data with the time 
from the beginning of a period or from the end of the period. 

Start of 
Period 

The system logs history data with the time from the 
beginning of the period. For example, the system 
time-stamps data it collects from 8:00 to 9:00 as 8:00. 

End of 
Period 

The system logs history data with the time from the 
end of the period. For example, the system time-
stamps data it collects from 8:00 to 9:00 as 9:00. 

EFM Archive 
Mapping 

Click to open an EFM archive mapping pop-up display that allows you 
to configure the EFM archive mapping used for the selected 
communications port. 

Note 

The display that opens is dependent on your selection in the EFM 
Archive Mapping using CSV Files field. If you select Database Objects 
in the EFM Archive Mapping using CSV Files field, the EFM Archive 
Mapping pop-up display opens. If you select Use CSV Files in the EFM 
Archive Mapping using CSV Files field, the EFM Registers pop-up 
display opens.  

EFM Archive 
Mapping using 
CSV Files 

Sets the location where the EFM archive mapping table is stored by 
the FB Series product.  

Note 

If you change this option, you must perform a warm start before any 
changes are applied. 

Database 
Objects 

Select this radio button to store the EFM Archive 
Mapping table in the FB Series product's internal 
database. EFM Archive Mapping using this option is 
unique for each communications port. This allows you 
to access different history data through each 
communications port. 
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Field Description 

Use CSV 
Files 

Select this radio button to store the EFM Archive 
Mapping table as a CSV file in the FB Series product. 
EFM Archive Mapping using this option is shared 
between all communications ports. 

EFM 
Archive 
Mapping 
file status 

This read-only field shows the current condition of 
the EFM Archive Mapping in the FB Series product. 
Possible values are: 

No Mapping 
Found 

There is no mapping file currently on 
the device. 

Column 
Mismatch 

The CSV file is not formatted correctly. 
Some rows have more or less columns 
than the header. Open the Log within 
the EFM Registers window for a 
detailed analysis. 

Missing Req 
Column  

The CSV file is missing a required 
column. Open the Log within the EFM 
Registers window for a detailed 
analysis. 

Exceeded 
Max Data  

The CSV file contained more rows 
than the firmware supports. 

Invalid Row 
Data 

The CSV file contains a row with 
invalid data. This can be out of range 
data or mappings that cannot be 
processed. Open the Log within the 
EFM Registers window for a detailed 
analysis. 

Duplicate 
Data 

The CSV file contains two mappings 
with similar data or identical register 
numbers. Open the Log within the 
EFM Registers window for a detailed 
analysis. 

5. Select Save to save any changes you make to this pop-up display. 
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4.29.3.1 Map Table Register 

Use this pop-up display to configure the Modbus registers stored in the FB Series product. 
Map Table Registers can store values received from FB Series product parameters or 
values received from remote devices. A SCADA system can then retrieve data stored in the 
FB Series product from the Map Table Register. 

Note 

Register tables are shared by all communication ports, and by both Modbus slave and 
master port owners. 

Your selection (Database Objects or Use CSV Files) in the Modbus Mapping using CSV 
Files field on either the Communications – Modbus Slave or Communications – Modbus 
Master pop-up display affects the functionality and fields shown on this display.  

• If you select Database Objects, each register map is contained in separate register 
tables and stored in the FB Series product's internal database. You can configure 48 
register tables. Each register table is comprised of 15 individual register entries 
(rows). Indexing allows for each entry to configure multiple registers (i.e., a single 
entry can represent 10 contiguous registers).  

• If you select Use CSV Files, information for all register maps is contained in a single 
CSV file that is stored in the FB Series product. The register table can contain up to 
65,535 rows. 

You can map one line in the Map Table Register to more than one register or parameter 
pair by using either Point Indexing or Parameter Indexing. 

• Point Indexing – Maps the same parameter for multiple instances of an object. 

• Parameter Indexing – Maps consecutive parameters for the same instance of an 
object. 

Note 

The order of parameters in the database can change from one firmware version to the 
next. 

You can add a parameter to the register table by clicking and dragging the parameter 
onto the desired position in the table. 

To access this display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 
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2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave protocol. 

3. Select the Modbus Slave button. The Modbus Slave pop-up display opens. 

4. Select the Map Table Registers button. The Map Table Register pop-up display 
opens. 

Figure 335. Map Table Register (configured to use Database Objects) 

 

5. Review – and change as necessary – the values in the following fields: 
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Field Description 

Table Click ▼ to select a map table register to configure. 

Note  

This field is shown only if you select Database Objects in the 
Modbus Mapping using CSV Files field on either the 
Communications – Modbus Slave or Communications – Modbus 
Master pop-up display. 

Tag Sets a name for the selected instance of the map table. 

Note  

This field is shown only if you select Database Objects in the 
Modbus Mapping using CSV Files field on either the 
Communications – Modbus Slave or Communications – Modbus 
Master pop-up display. 

Slave ID (drop-
down) 

Click ▼ to filter the Map Table Register rows based on the Slave ID 
field. Select All to view all rows or select a Slave ID to only view rows 
configured with the selected Slave ID. 

Note 

This field is shown only if you select Use CSV Files in the Modbus 
Mapping using CSV Files field on either the Communications – 
Modbus Slave or Communications – Modbus Master pop-up display 
and set the Enhanced Slave IDs field to Enable on the the 
Communications – Modbus Slave pop-up display. 

Number This read-only field shows the instance of the map table being 
accessed. 
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Field Description 

Start of 
Register 

Sets the first data register in the address span. Any number from 0 to 
65535 is valid. You can duplicate register numbers as long as you 
assign them to separate communication ports. Number the tables 
from smallest to largest. 

For example, configure a starting register of 400 and an ending 
register of 700. When the host device requests starting register 500 
through ending register 700, all the host-requested register numbers 
(500 through 700) are valid and elicit responses: the requested 
register numbers (500 through 700) match (or fall between) the 
starting register and ending register numbers (400 through 700). 

Note 

In certain Modbus Host devices, the register 40101 is actually 
transmitted as "100". The value "100" should be placed in this field as 
the FB Series product uses the actual number sent by the host. 

End of 
Register 

Sets the last register in the address span. Compute the value for this 
field by adding the total number of registers used to the Start or 
Starting Register number and subtracting 1. 

Device 
Parameter 

Defines the parameter of the object and instance in the database to 
set or to acquire. Be aware of the different data types (Character, 
Integer, Long, Float) and the size of the data types. 

Remote Data 
Type 

Click ▼ to select the data format sent to and received from the 
remote device. The FB Series product automatically converts the data 
as transmitted to/from the remote device to the correct data type for 
the parameter defined in the Device Parameter field. For more 
information, see Remote Data Types. 

Note 

No conversion sends the data type as stored in the FB Series product. 

Indexing Sets a block of register values as successive Logical Point Numbers or 
Parameters without having to define each separately. Possible 
options are: 

Point Maps the Start or Starting Register to the selected 
Device Parameter. Subsequent registers, through the 
End Register, are mapped to the same Object and 
Parameter, and increment the Instance. 
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Field Description 

Parameter Maps the Start or Starting Register to the selected 
Device Parameter. Subsequent registers, through the 
End Register, are mapped to the same Object and 
Instance, and increment the Parameter Number. 

Note 

The order of parameters in the database can change 
from one firmware version to the next. 

Read/Write Click ▼ to set if the data in the selected row of the map table register 
can be modified by a remote device. Possible options are: 

Note  

This field is shown only if you select Use CSV Files in the Modbus 
Mapping using CSV Files field on either the Communications – 
Modbus Slave or Communications – Modbus Master pop-up display. 

Read Only The data cannot be modified by a remote device. 

Read/Write The data can be modified by a remote device. 

Ports Click this cell to open a Select Comm port instance pop-up display 
and configure which communications ports instances that a remote 
device must use to access data in the selected row of the map table 
register. Place a check mark next each allowed communications port. 
Select OK to save your changes and return to the previous display. 

Note  

This field is shown only if you select Use CSV Files in the Modbus 
Mapping using CSV Files field on either the Communications – 
Modbus Slave or Communications – Modbus Master pop-up display. 

Slave ID (field) Enter the Modbus Slave ID that the FB Series product will respond to 
when a device requests data contained in the selected Map Table 
Register. If the requesting device is configured with a different 
Modbus Slave ID, then the FB Series product ignores the request.  

Note  

This field is shown only if you select Use CSV Files in the Modbus 
Mapping using CSV Files field on either the Communications – 
Modbus Slave or Communications – Modbus Master pop-up display 
and set the Enhanced Slave IDs field to Enable on the the 
Communications – Modbus Slave pop-up display. 
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Field Description 

Insert Row Select to add a new row to the map table register at the location of 
the currently highlighted row. Existing entries are moved down one 
row. 

Note 

If you select Database Objects in the Modbus Mapping using CSV 
Files field on either the Communications – Modbus Slave or 
Communications – Modbus Master pop-up display, then the last row 
in the Map Table Register (row 15) is overwritten by the previous row 
(row 14). 

Delete Row Select to remove the currently highlighted row from the map table 
register. Existing entries are moved up one row. 

Note 

If you select Database Objects in the Modbus Mapping using CSV 
Files field on either the Communications – Modbus Slave or 
Communications – Modbus Master pop-up display, then an empty 
row is added to the last row in the Map Table Register (row 15). 

Clear Row Select to remove data from the currently highlighted row of the map 
table register. 

Add Row Select to add a row to the end of the map table register. 

Note  

This field is shown only if you select Use CSV Files in the Modbus 
Mapping using CSV Files field on either the Communications – 
Modbus Slave or Communications – Modbus Master pop-up display. 

Filter Click ▼ to narrow the number of parameters by object type. 

Object and 
instances 

Lists the available database objects (types) and instances (iterations) 
of each object. Select an Object and Instance to view the available 
parameters. 

Parameters Lists the available parameters (properties) for the selected object and 
instance. 

Referenced 
Parameters 

Lists the available parameters for the referenced object, when the 
data type of the parameter in the Parameters column is an OBJREF. 

Parameter's 
Tag 

This read-only field shows the name of the selected parameter. 

Data Type This read-only field shows the data type of the selected parameter. 
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Field Description 

Access Type This read-only field shows the read/write access of the selected 
parameter. 

Value This read-only field shows the value of the selected parameter. 

Import CSV Click to import a CSV file into your FB Series product that contains 
your desired Modbus configuration. Navigate to the location of the 
saved CSV file and select Open to start the import process. For more 
information, refer to Importing a Modbus Map Table CSV File. 

Note  

The system verifies the integrity of the CSV and asks for confirmation 
before continuing if any errors are found. Any invalid lines in the CSV 
file are ignored and data currently in the FB Series device is 
maintained. 

Export CSV Click to save a CSV file to your computer that contains the current 
Modbus configuration of your FB Series product. A Select Table dialog 
opens where you can select which Modbus tables to include in the 
export. Click Start, select a name and location for the exported file on 
your computer, and click Save to begin the export process. For more 
information, refer to Exporting a Modbus Map Table CSV File. 

Note  

By default, all selected data is exported into a single file. Select 
Export to individual file to have the system create individual files for 
each Modbus table you select. 

Open Log Click to open the ImportExportLogs folder on your computer that 
contains FBxConnect™ import/export error logs. Any errors 
encountered when importing a CSV file are stored in a log in this 
folder. 

Note  

Log file name includes the date and time the log was created. 

Refresh Select to re-display the map table entries currently stored in memory 
of the FB Series product. 

Save Select to save the current map table and any changes to memory in 
the FB Series product. 

Close Select to exit the Map Table Register display. 
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6. If you’re starting from a blank map table, click Add Row to add a new row to the map 
table. 

7. Select an Object and Instance of that Object from the Objects and instances frame. A 
list of available parameters displays in the Parameters frame. 

8. Click and drag a parameter from the Parameters frame to the desired register 
number in selected the Map Table. 

9. Enter the first data register in the address span in the Start of Register field. 

10. Enter the last register in the address span in the End of Register field. 

11. Click ▼ in the Remote Data Type field to set the data format sent to and received 
from the remote device. 

12. Click ▼ in the Indexing field to set a block of register values as successive Object 
Numbers or Parameters. 

13. Click ▼ to set if the data in the selected row of the map table register can be either 
read (Read Only) or modified (Read/Write) by a remote device.   
Note  
This field is shown only if you select Use CSV Files in the Modbus Mapping using CSV 
Files field on either the Communications – Modbus Slave or Communications – 
Modbus Master pop-up display. 

14. Click the Ports cell to open a Select Comm port instance display and configure which 
communications ports instances that a remote device is allowed to use to access the 
data in the selected row of the map table register. Place a check mark next each 
allowed communications port. Select OK to save your changes and return to the 
previous display. 
Note  
This field is shown only if you select Use CSV Files in the Modbus Mapping using CSV 
Files field on either the Communications – Modbus Slave or Communications – 
Modbus Master pop-up display. 

15. Select Save to save any changes you make to this pop-up display. 

Note 

If you selected Use CSV Files in the Modbus Mapping using CSV Files field on either the 
Communications – Modbus Slave or Communications – Modbus Master pop-up display, 
you must perform a warm start before any changes take effect. 
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4.29.3.1.1 Importing a Modbus Map Table CSV File 

You can import a CSV file that contains your Modbus map table configuration for use in 
your FB Series product.  

Note 

• For more information about Modbus map tables in the FB Series product, refer to 
Map Table Register. 

• For more information about creating your own Modbus map table CSV file, refer to 
Creating a Modbus Map Table CSV File. 

• For more information about exporting a CSV file that contains the FB Series product's 
current Modbus map table configuration, refer to Exporting a Modbus Map Table CSV 
File. 

• Your selection in the Modbus Mapping using CSV files field (either Database 
Objects or Use CSV Files) affects the format of Modbus map table. To import a CSV 
file that was created by an FB Series product with a different selection in the Modbus 
Mapping using CSV files field, then you must first modify the CSV file to have the 
correct format. For more information about the format required for each selection 
(either Database Objects or Use CSV Files), refer to Creating a Modbus Map Table 
CSV File. 

To import a CSV file that contains your Modbus map table configuration: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave or Modbus Master protocol. 

3. Depending on the protocol used by the selected communications port, select either 
the Modbus Slave or Modbus Master button. The Modbus Slave or Modbus Master 
pop-up display opens. 

4. Select the Map Table Registers button. The Map Table Register pop-up display 
opens. 
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Figure 336. Map Table Register – Import CSV 

 

5. Select the Import CSV button.  

6. Navigate to the file location of your CSV file and select Open. 

Note 

The system verifies the integrity of the CSV and asks for confirmation before continuing if 
any errors are found. If you select Import removing invalid parameters, any invalid 
lines in the CSV file are ignored and data currently in the FB Series device is maintained. 
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Figure 337. Example Import Map Table Errors 

 

7.  A confirmation message displays after importing the CSV. Select OK to complete the 
process. 

Figure 338. Confirmation 

 

4.29.3.1.2 Exporting a Modbus Map Table CSV File 

You can export your FB Series product's current Modbus map table configuration to a CSV 
file saved on your computer. 

Note 

• For more information about Modbus map tables in the FB Series product, refer to 
Map Table Register. 

• For more information about creating your own Modbus map table CSV file, refer to 
Creating a Modbus Map Table CSV File. 

• For more information about importing a CSV file that contains the FB Series product's 
current Modbus map table configuration, refer to Importing a Modbus Map Table CSV 
File. 
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To export a CSV file that contains your Modbus map table configuration: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave or Modbus Master protocol. 

3. Depending on the protocol used by the selected communications port, select either 
the Modbus Slave or Modbus Master button. The Modbus Slave or Modbus Master 
pop-up display opens. 

4. Select the Map Table Registers button. The Map Table Register pop-up display 
opens. 

Figure 339. Map Table Register – Export CSV 

 

5. Select the Export CSV button. One of two things happens based on your selection in 
the Modbus Mapping using CSV Files field on either the Communications – Modbus 
Slave or Communications – Modbus Master pop-up display: 
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• If you select Database Objects, the Select Table pop-up display opens. Proceed to 
step 6. 

• If you select Use CSV Files, the Save csv File window opens. Proceed to step 8. 

Figure 340. Select Table 

 

6. Place a check mark next to each table you want to export. 

Note 

By default, all selected tables are exported to a single file. If you want each selected table 
to be exported to individual files, place a check mark next to Export to individual file. 

7. Select Start. A Save csv file window opens. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

876 

Figure 341. Save csv file 

 

8. Navigate to a location on your computer to save your exported CSV file and select 
Save. The system exports the CSV file and displays a progress bar at the top of the 
display. 

9. A confirmation message displays after exporting the CSV file. Select OK to complete 
the process. 

Figure 342. Confirmation 

 

4.29.3.1.3 Creating a Modbus Map Table CSV File 

You can create a Modbus Map Table on your computer and then import the file for use in 
the FB Series product. If your Modbus Map Table contains a large amount of points, it 
may be easier to create a CSV file on your computer than it is to configure the table in 
FBxConnect™.  
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Note 

• For more information about Modbus Map Tables, refer to Map Table Register. 

• The easiest way to begin creating a custom map is to export a CSV that contains the 
current configuration and then edit that file. For more information about exporting a 
CSV file, refer to the Exporting a Modbus Map Table CSV File. 
Figure 343. Example Modbus Map Table CSV Format (configured to use CSV Files) 

 

To create a CSV file that contains your Modbus map table configuration: 

1. Open a blank spreadsheet (or open your previously exported Modbus poll table CSV 
file). 

2. Your selection (Database Objects or Use CSV Files) in the Modbus Mapping using 
CSV Files field on either the Communications – Modbus Slave or Communications – 
Modbus Master pop-up display affects the format of the CSV file. In row one of the 
spreadsheet, enter the following text based on your configuration: 

Table 47. Modbus Map Table CSV Headers 

Database Objects Use CSV Files 

• Column A = Table 

• Column B = Number 

• Column C = Start of Register 

• Column D = End of Register 

• Column E = Device Parameter 

• Column F = Remote Data Type 

• Column G = Indexing 

• Column A = Number 

• Column B = Start of Register 

• Column C = End of Register 

• Column D = Device Parameter 

• Column E = Remote Data Type 

• Column F = Indexing 

• Column G = Read/Write 

• Column F = Ports 

• Column I = Slave ID 

3. In the proceeding rows, enter information for each table entry according to the 
descriptions below: 
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Note 

Drop-down lists on the FBxConnect™ display are represented as numbers in the CSV file. 
See the descriptions below for a description for each number. 

Column Heading Description 

Table Indicates the map table register for the selected row. Valid values 
are: 

1 through 48 

Note 

• Register tables are shared by all communication ports, and by 
both Modbus Slave and Master port owners. 

• This column is required only if you select Database Objects in 
the Modbus Mapping using CSV Files option on either the 
Communications – Modbus Slave or Communications – 
Modbus Master pop-up display. For more information, refer to 
Map Table Register. 

Number Enter the row of the selected map table register. The number of 
possible rows is dependent on your selection in the Database 
Objects in the Modbus Mapping using CSV Files option on either 
the Communications – Modbus Slave or Communications – 
Modbus Master pop-up display: 

• If you select Database Objects, valid values are 1 through 15. 

• If you select Use CSV Files, valid values are 1 through 65,000. 
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Column Heading Description 

Start of Register Enter the first data register in the address span. Any number from 
0 to 65535 is valid. You can duplicate register numbers as long as 
you assign them to separate communication ports. Number the 
tables from smallest to largest. 

For example, configure a starting register of 400 and an ending 
register of 700. When the host device requests starting register 
500 through ending register 700, all the host-requested register 
numbers (500 through 700) are valid and elicit responses: the 
requested register numbers (500 through 700) match (or fall 
between) the starting register and ending register numbers (400 
through 700). 

Note  

In certain Modbus Host devices, the register 40101 is actually 
transmitted as "100". The value "100" should be placed in this field 
as the FB Series product uses the actual number sent by the host. 

End of Register Enter the last register in the address span. Compute the value for 
this field by adding the total number of registers used to the Start 
or Starting Register number and subtracting 1. Any number from 
0 to 65535 is valid. 

Device 
Parameter 

Enter the parameter of the object and instance in the database to 
set or to acquire. Be aware of the different data types (Character, 
Integer, Long, Float) and the size of the data types. 

Remote Data 
Type 

Enter the number that corresponds to the data format sent to and 
received from the remote device. The FB Series product 
automatically converts the data as transmitted to/from the remote 
device to the correct data type for the parameter defined in the 
Device Parameter field. For more information, refer to the CSV 
Value field in the Remote Data Types topic. 

Note  

No conversion sends the data type as stored in the FB Series 
product. 

Indexing Sets a block of register values as successive Logical Point Numbers 
or Parameters without having to define each separately. Possible 
options are: 
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Column Heading Description 

0 Point 

Maps the Start or Starting Register to the selected Device 
Parameter. Subsequent registers, through the End Register, 
are mapped to the same Object and Parameter, and increment 
the Instance. 

1 Parameter 

Maps the Start or Starting Register to the selected Device 
Parameter. Subsequent registers, through the End Register, 
are mapped to the same Object and Instance, and increment 
the Parameter Number. 

Note 

The order of parameters in the database can change from one 
firmware version to the next. 

Read/Write Sets if the data in the selected row of the map table register can 
be modified by a remote device. Possible options are Read Only 
(the data cannot be modified) or Read/Write (the data can be 
modified). 

Note  

This column is required only if you select Use CSV Files in the 
Modbus Mapping using CSV Files field on either the 
Communications – Modbus Slave or Communications – Modbus 
Master pop-up display. For more information, refer to Map Table 
Register. 
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Column Heading Description 

Ports Enter the communications port instances that a remote device 
must use to access the data in the selected row of the map table 
register.  

Note  

• At least one communications port instance must be defined. 

• To allow multiple communications ports access to the data, 
place a semicolon between each instance (for example, 
Comm_1;Comm_4;Comm_5). 

• Typing All enables all communications port instances to access 
the data.  

• This column is required only if you select Use CSV Files in the 
Modbus Mapping using CSV Files field on either the 
Communications – Modbus Slave or Communications – 
Modbus Master pop-up display. For more information, refer to 
Map Table Register. 

Slave ID The values in this column apply only if you select Use CSV Files in 
the Modbus Mapping using CSV Files field on either the 
Communications – Modbus Slave or Communications – Modbus 
Master pop-up display and set the Enhanced Slave IDs field to 
Enable on the Communications – Modbus Slave pop-up display. 

4. Save your changes. You can now import your CSV file for use in your FB Series 
product. For more information, refer to Importing a Modbus Map Table CSV File. 

Note 

Make sure to save the file with a .csv file extension. 

4.29.3.1.4 Remote Data Types 

Remote data types in the Modbus register table tell the FB Series product what data type 
to send to and receive from the remote device. The FB Series products support the 
following remote data types. 

Table 48. Remote Data Types 

CSV Value Data Type Description 

0 No 
Conversion 

Format of selected parameter (byte order determined 
by LSB/MSB option). 
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CSV Value Data Type Description 

1 UINT8 8-bit unsigned integer. 

2 INT8 8-bit signed integer. 

3 UINT16 16-bit unsigned integer (byte order determined by 
LSB/MSB option). 

4 INT16 16-bit signed integer (byte order determined by 
LSB/MSB option). 

5 UINT32 (2 
Registers 0-
1-2-3) 

32-bit unsigned integer value to be sent or received in 
two Modbus registers with byte order of 0-1-2-3 (where 
0 is the least significant byte). 

6 UINT32 (2 
Registers 1-
0-3-2) 

32-bit unsigned integer value to be sent or received in 
two Modbus registers with byte order of 1-0-3-2 (where 
0 is the least significant byte). 

7 UINT32 (2 
Registers 2-
3-0-1) 

32-bit unsigned integer value to be sent or received in 
two Modbus registers with byte order of 2-3-0-1 (where 
0 is the least significant byte). 

8 UINT32 (2 
Registers 3-
2-1-0) 

32-bit unsigned integer value to be sent or received in 
two Modbus registers with byte order of 3-2-1-0 (where 
0 is the least significant byte). 

9 INT32 (2 
Registers 0-
1-2-3) 

32-bit signed integer value to be sent or received in two 
Modbus registers with byte order of 0-1-2-3 (where 0 is 
the least significant byte). 

10 INT32 (2 
Registers 1-
0-3-2) 

32-bit signed integer value to be sent or received in two 
Modbus registers with byte order of 1-0-3-2 (where 0 is 
the least significant byte). 

11 INT32 (2 
Registers 2-
3-0-1) 

32-bit signed integer value to be sent or received in two 
Modbus registers with byte order of 2-3-0-1 (where 0 is 
the least significant byte). 

12 INT32 (2 
Registers 3-
2-1-0) 

32-bit signed integer value to be sent or received in two 
Modbus registers with byte order of 3-2-1-0 (where 0 is 
the least significant byte). 

13 UINT64 (4 
Registers 0-
1-2-3-4-5-6-7) 

64-bit unsigned integer value to be sent or received in 
four Modbus registers with byte order of 0-1-2-3-4-5-6-7 
(where 0 is the least significant byte). 
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CSV Value Data Type Description 

14 UINT64 (4 
Registers 2-
3-0-1-6-7-4-5) 

64-bit unsigned integer value to be sent or received in 
four Modbus registers with byte order of 2-3-0-1-6-7-4-5 
(where 0 is the least significant byte). 

15 UINT64 (4 
Registers 4-
5-6-7-0-1-2-3) 

64-bit unsigned integer value to be sent or received in 
four Modbus registers with byte order of 4-5-6-7-0-1-2-3 
(where 0 is the least significant byte). 

16 UINT64 (4 
Registers 6-
7-4-5-2-3-0-1) 

64-bit unsigned integer value to be sent or received in 
four Modbus registers with byte order of 6-7-4-5-2-3-0-1 
(where 0 is the least significant byte). 

17 UINT64 (4 
Registers 1-
0-3-2-5-4-7-6) 

64-bit unsigned integer value to be sent or received in 
four Modbus registers with byte order of 1-0-3-2-5-4-7-6 
(where 0 is the least significant byte). 

18 UINT64 (4 
Registers 3-
2-1-0-7-6-5-4) 

64-bit unsigned integer value to be sent or received in 
four Modbus registers with byte order of 3-2-1-0-7-6-5-4 
(where 0 is the least significant byte). 

19 UINT64 (4 
Registers 5-
4-7-6-1-0-3-2) 

64-bit unsigned integer value to be sent or received in 
four Modbus registers with byte order of 5-4-7-6-1-0-3-2 
(where 0 is the least significant byte). 

20 UINT64 (4 
Registers 7-
6-5-4-3-2-1-0) 

64-bit unsigned integer value to be sent or received in 
four Modbus registers with byte order of 7-6-5-4-3-2-1-0 
(where 0 is the least significant byte). 

21 INT64 (4 
Registers 0-
1-2-3-4-5-6-7) 

64-bit signed integer value to be sent or received in four 
Modbus registers with byte order of 0-1-2-3-4-5-6-7 
(where 0 is the least significant byte). 

22 INT64 (4 
Registers 2-
3-0-1-6-7-4-5) 

64-bit signed integer value to be sent or received in four 
Modbus registers with byte order of 2-3-0-1-6-7-4-5 
(where 0 is the least significant byte). 

23 INT64 (4 
Registers 4-
5-6-7-0-1-2-3) 

64-bit signed integer value to be sent or received in four 
Modbus registers with byte order of 4-5-6-7-0-1-2-3 
(where 0 is the least significant byte). 

24 INT64 (4 
Registers 6-
7-4-5-2-3-0-1) 

64-bit signed integer value to be sent or received in four 
Modbus registers with byte order of 6-7-4-5-2-3-0-1 
(where 0 is the least significant byte). 
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CSV Value Data Type Description 

25 INT64 (4 
Registers 1-
0-3-2-5-4-7-6) 

64-bit signed integer value to be sent or received in four 
Modbus registers with byte order of 1-0-3-2-5-4-7-6 
(where 0 is the least significant byte). 

26 INT64 (4 
Registers 3-
2-1-0-7-6-5-4) 

64-bit signed integer value to be sent or received in four 
Modbus registers with byte order of 3-2-1-0-7-6-5-4 
(where 0 is the least significant byte). 

27 INT64 (4 
Registers 5-
4-7-6-1-0-3-2) 

64-bit signed integer value to be sent or received in four 
Modbus registers with byte order of 5-4-7-6-1-0-3-2 
(where 0 is the least significant byte). 

28 INT64 (4 
Registers 7-
6-5-4-3-2-1-0) 

64-bit signed integer value to be sent or received in four 
Modbus registers with byte order of 7-6-5-4-3-2-1-0 
(where 0 is the least significant byte). 

29 FLOAT (2 
Registers 0-
1-2-3) 

32-bit single precision floating point value to be sent or 
received in two Modbus registers with byte order of 0-1-
2-3 (where 0 is the least significant byte). 

30 FLOAT (2 
Registers 1-
0-3-2) 

32-bit single precision floating point value to be sent or 
received in two Modbus registers with byte order of 1-0-
3-2 (where 0 is the least significant byte). 

31 FLOAT (2 
Registers 2-
3-0-1) 

32-bit single precision floating point value to be sent or 
received in two Modbus registers with byte order of 2-3-
0-1 (where 0 is the least significant byte). 

32 FLOAT (2 
Registers 3-
2-1-0) 

32-bit single precision floating point value to be sent or 
received in two Modbus registers with byte order of 3-2-
1-0 (where 0 is the least significant byte). 

33 DOUBLE (4 
Registers 0-
1-2-3-4-5-6-7) 

64-bit double precision floating point value to be sent 
or received in four Modbus registers with byte order of 
0-1-2-3-4-5-6-7 (where 0 is the least significant byte). 

34 DOUBLE (4 
Registers 2-
3-0-1-6-7-4-5) 

64-bit double precision floating point value to be sent 
or received in four Modbus registers with byte order of 
2-3-0-1-6-7-4-5 (where 0 is the least significant byte). 

35 DOUBLE (4 
Registers 4-
5-6-7-0-1-2-3) 

64-bit double precision floating point value to be sent 
or received in four Modbus registers with byte order of 
4-5-6-7-0-1-2-3 (where 0 is the least significant byte). 
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CSV Value Data Type Description 

36 DOUBLE (4 
Registers 6-
7-4-5-2-3-0-1) 

64-bit double precision floating point value to be sent 
or received in four Modbus registers with byte order of 
6-7-4-5-2-3-0-1 (where 0 is the least significant byte). 

37 DOUBLE (4 
Registers 1-
0-3-2-5-4-7-6) 

64-bit double precision floating point value to be sent 
or received in four Modbus registers with byte order of 
1-0-3-2-5-4-7-6 (where 0 is the least significant byte). 

38 DOUBLE (4 
Registers 3-
2-1-0-7-6-5-4) 

64-bit double precision floating point value to be sent 
or received in four Modbus registers with byte order of 
3-2-1-0-7-6-5-4 (where 0 is the least significant byte). 

39 DOUBLE (4 
Registers 5-
4-7-6-1-0-3-2) 

64-bit double precision floating point value to be sent 
or received in four Modbus registers with byte order of 
5-4-7-6-1-0-3-2 (where 0 is the least significant byte). 

40 DOUBLE (4 
Registers 7-
6-5-4-3-2-1-0) 

64-bit double precision floating point value to be sent 
or received in four Modbus registers with byte order of 
7-6-5-4-3-2-1-0 (where 0 is the least significant byte). 

41 SINGLE 
REGISTER 
FLOATING 
POINT 

32-bit single precision floating point value to be sent or 
received as a single Modbus register (byte order 
determined by LSB/MSB option). 

42 SINGLE 
REGISTER 
DOUBLE 

64-bit double precision floating point value to be sent 
or received as a single Modbus register (byte order 
determined by LSB/MSB option). 

43 SINGLE 
REGISTER 
INT32 

32-bit signed integer value to be sent or received as a 
single Modbus register (byte order determined by 
LSB/MSB option). 

44 SINGLE 
REGISTER 
UINT32 

32-bit unsigned integer value to be sent or received as a 
single Modbus register (byte order determined by 
LSB/MSB option). 

45 SINGLE 
REGISTER 
INT64 

64-bit signed integer value to be sent or received as a 
single Modbus register (byte order determined by 
LSB/MSB option). 

46 SINGLE 
REGISTER 
UINT64 

64-bit unsigned integer value to be sent or received as a 
single Modbus register (byte order determined by 
LSB/MSB option). 
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CSV Value Data Type Description 

47 STRING (10 
Characters) 

A 10-character string value provided as two characters 
per consecutive register. To be sent or received as five 
Modbus registers. Strings with less than 10 characters 
are padded with extra space characters to become 10 
characters in length. 

48 STRING (20 
Characters) 

A 20-character string value provided as two characters 
per consecutive register. To be sent or received as ten 
Modbus registers. Strings with less than 20 characters 
are padded with extra space characters to become 20 
characters in length. 

49 STRING (30 
Characters) 

A 30-character string value provided as two characters 
per consecutive register. To be sent or received as 
fifteen Modbus registers. Strings with less than 30 
characters are padded with extra space characters to 
become 30 characters in length. 

50 STRING (40 
Characters) 

A 40-character string value provided as two characters 
per consecutive register. To be sent or received as 
twenty Modbus registers. Strings with less than 40 
characters are padded with extra space characters to 
become 40 characters in length. 

 

4.29.3.2 Modbus Registers for EFM Application Events 

The following registers are used when you enable EFM Application Events and retrieve 
events via Modbus. 

Table 49. Application Events 

Register Description 

60000  String Event 

61001 Power Applied 

61002 Power Removed 

61003  Battery Changed 

61004  Firmware Update Start 

61005  Firmware Apply Package Version 
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Register Description 

61006  Firmware Update Complete 

61007  Firmware Update Package Restore Fail 

61008  Task Restarted 

61009  CPU Module Changed 

61010  PM Module Changed 

61011  CPU Module Previous 

61012 PM Module Previous 

61013  Schedule Slip Detected 

61014  Event Type 14 

61015  Event Type 15 

61016  Login Success 

61017  Login Fail Invalid Credentials 

61018  Account Locked 

61019 Logout  

61020  Account Added 

61021  Account Removed 

61022  Account Modified 

61023  Log Clear  

61024  Log Clear Due to CRC Corrupt 

61025  History Point Cleared 

61026  System Down 

61027  Action Block Trip Status Changed 

61028  Database Initialized 

61029  Daylight Saving Time Change 

61030  Total Rollover 

61031  System Restart 

61032  Pulse Accum Rollover 

61033 Firmware Apply Image Version 

61034  Firmware I/O Board Disabled 
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Register Description 

61035  Restart During Calc Cycle 

61036  Configuration Counter Changed 

61037  Log Clear for Combined Event Log 

61038  Log Clear for Separate Event Logs 

61039  History Clear 

61040  Alarm Clear  

61041  Event Clear  

61042  History Records Lost 

61043  Alarm Records Lost 

61044  Event Records Lost 

61045  Standard History Point Archival Reset 

61046  GC Data Read Failed 

61047  Hist Group Read Failed 

61048  Application Clear 

61049  Users Clear  

61050 - 62000 Reserved for Future Events 

62001  Informational 

62002  Error  

62003  Status 

62004  Calculated Factor 

62005 Message  

62006  Data  

62007  Notice  

62008  Feedback  

62009  Confirmation 

62010  Program Adjusted 

62011  Estimated Result 

62012  User Input  

62013  System Change 
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Register Description 

62014  HMI Input  

62015  Other  

62016 - 63000  Reserved for Future Events 

63001  Low  

63002  Low Low  

63003  High  

63004  High High  

63005  Rate of Change 

63006  User Account Locked 

63007  Log Full Limit Exceeded 

63008  Log Nearly Full Limit Exceeded 

63009  Log Integrity Failure 

63010  Battery Status 

63011  Low Voltage 

63012  Override  

63013  Point Fail  

63014  Digital ON Status Alarm 

63015  No Response From History 

63016  Analysis Timeout 

63017  Normalization Failure 

63018  Flow Calculation Alarm 

63019  Properties Calculation Alarm 

63020  Auto-Adjust System Alarm 

63021  Auto-Adjust Flow Alarm 

63022  Auto-Adjust Delta A Alarm 

63023  History Point Movement Failure 

63024  Door Open Status Alarm 

63025  Other  

63026  Flow Calc Alarm: Invalid Input(s) 
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Register Description 

63027  Flow Calc Alarm: Invalid Config 

63028  Flow Calc Alarm: Calculation Error 

63029  Flow Calc Alarm: Boundary Error 

63030  Flow Calc Alarm: Invalid Station Assign 

63031  Flow Calc Alarm: Reserved 

63032  Flow Calc Alarm: Reserved 

63033  Flow Calc Alarm: Reserved 

63034  Flow Calc Alarm: DP/Flow 

63035  Flow Calc Alarm: Pressure 

63036  Flow Calc Alarm: Temperature 

63037  Flow Calc Alarm: Flowing Density/Z 

63038  Flow Calc Alarm: Base Density/Z 

63039  Flow Calc Alarm: Relative Density 

63040  Flow Calc Alarm: HV/Enthalpy 

63041  Flow Calc Alarm: Viscosity 

63042  Flow Calc Alarm: User Corr Factor 

63043  Flow Calc Alarm: Total/Incement 

63044  Flow Calc Alarm: Integral Mult Value 

63045 Flow Calc Alarm: Reserved 

63046  Flow Calc Alarm: Reserved 

63047  Flow Calc Alarm: Reserved 

63048  Flow Calc Alarm: Reserved 

63049  Flow Calc Alarm: Reserved 

63050  Flow Calc Alarm: Reserved 

63051  Flow Calc Alarm: Beta Ratio 

63052  Flow Calc Alarm: DP/P Ratio 

63053  Flow Calc Alarm: Isentropic Exponent 

63054  Flow Calc Alarm: Reynolds Number 

63055  Flow Calc Alarm: Pressure Loss/Ratio 
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Register Description 

63056 Flow Calc Alarm: Alpha 

63057  Flow Calc Alarm: Expansion Factor 

63058  Flow Calc Alarm: K-factor/Meter Factor 

63059  Flow Calc Alarm: Mass Press Corr Factor 

63060  Flow Calc Alarm: Reserved 

63061  Flow Calc Alarm: Reserved 

63062  Flow Calc Alarm: Reserved 

63063  Flow Calc Alarm: Reserved 

63064  Flow Calc Alarm: Reserved 

63065  Flow Calc Alarm: K-factor/Meter Factor 

63066  Flow Calc Alarm: Mass Press Corr Factor 

63067  Flow Calc Alarm: Water Cut 

63068  Flow Calc Alarm: Shrinkage Factor 

63069  Flow Calc Alarm: CTL 

63070  Flow Calc Alarm: NGL Factor/Flash Fctr 

63071  Flow Calc Alarm: Reserved 

63072  Prop Calc Alarm: Invalid Input(s) 

63073  Prop Calc Alarm: Invalid Config 

63074  Prop Calc Alarm: Calculation Error 

63075  Prop Calc Alarm: Boundary Error 

63076  Prop Calc Alarm: Reserved 

63077  Prop Calc Alarm: Reserved 

63078  Prop Calc Alarm: Reserved 

63079  Prop Calc Alarm: Reserved 

63080  Prop Calc Alarm: Pressure 

63081  Prop Calc Alarm: Temperature 

63082  Prop Calc Alarm: Flowing Density/Z 

63083  Prop Calc Alarm: Base Density/Z 

63084  Prop Calc Alarm: Relative Density 
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Register Description 

63085  Prop Calc Alarm: HV/Enthalpy 

63086  Prop Calc Alarm: Composition 

63087  Prop Calc Alarm: Water Content 

63088  Prop Calc Alarm: Atm Press/Grav Accel 

63089  Prop Calc Alarm: Viscosity 

63090  Prop Calc Alarm: Isentropic Exponent 

63091  Prop Calc Alarm: Speed of Sound 

63092  Prop Calc Alarm: Reserved 

63093  Prop Calc Alarm: Reserved 

63094  Prop Calc Alarm: Reserved 

63095  Prop Calc Alarm: Reserved 

63096  Prop Calc Alarm: Reserved 

63097  Prop Calc Alarm: Reserved 

63098  Prop Calc Alarm: Reserved 

63099  Prop Calc Alarm: Reserved 

63100  Prop Calc Alarm: Reserved 

63101  Prop Calc Alarm: Reserved 

63102  Prop Calc Alarm: Reserved 

63103  Prop Calc Alarm: Reserved 

63104  Parameter Health Status 

63105  Meter Task Detected Fatal Error 

63106 - 64000  Reserved for Future Alarms 

64001  Low  

64002  Low Low  

64003  High  

64004  High High  

64005  Rate of Change 

64006  Discrete  

64007  Calculation  
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Register Description 

64008  Manual  

64009  Scanning Disabled 

64010  Calibration  

64011  Failure  

64012  Failsafe  

64013  Permanent Shutdown 

64014  Temporary Shutdown 

64015  Action On Failure 

64016  Other  

64017 - 65000  Reserved for Future Alarms 

 

4.29.3.3 Modbus Events and Alarms 

The record formats for the event log and alarm log are the same size and have similar 
contents. The first word in a record is a bit map in which bit 9 indicates if the log record is 
an Event (1) or an Alarm (0). The meanings of the other bits are specific to either the Event 
or the Alarm Log records. Refer to Event & Alarm Change Bit Map Contents. 

The FB Series products support the Modbus with EFM extensions method for retrieving 
alarms and events. When the FB Series product receives a Function Code 03 request 
referencing defined Events and Alarms Register (usually 32), the FB Series product begins 
to collect records from first the Event Log and then the Alarm Log, starting where the last 
poll left off. The FB Series product collects records until either there are not any more new 
events, alarms, or it collects the maximum of 12 records. The FB Series product sends the 
information back to the Host, which in return replies with Function Code 05, referencing 
the same Events and Alarms Register, indicating that the points have been received and 
that the Host is ready for the next 12 records.  

The following paragraphs detail how FB Series products place event log and alarms log 
information in Modbus event and alarm messages, and how (or what) is generated upon 
the event or alarm condition. 

Normal Event Record 

A normal Event record format: 
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Bit Map Register Time as float Date as float Old Value as float New Value as 
float 

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 

 

System Text Events 

When you set the System Command Change Bit (bit 7) in the Operator Change Bit Map of 
the Event, it sets the Register number for all System Command Change events to the 
Event/Alarm Register number (default is 32). 

Bit 
Map 

Register Time as 
float 

Date as float Code New Value as float 

0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 

 

Refer to the following topics for more information: 

Reading Events and Alarms  

Acknowledging Events and Alarms 

Event and Alarm Change Bit Map Contents  

4.29.3.3.1 Reading Events and Alarms Register 

The Modbus request to read the Event Log and Alarm Log uses the standard read 
Function Codes 03 or 04 and the Register Number defined in the Alarm/Event field on the 
Communications – Modbus Slave pop-up display. In this request, the number of Registers 
is included to maintain format compatibility but is ignored by the receiving FB Series 
product. 

Twenty bytes are returned for each event and alarm in the response. Up to 12 events and 
alarms can be returned in a single response. If no events and alarms have occurred since 
the last collection, the response contains 0 data bytes. 

For the date stamp in the events and alarms returned, the year (YY) is really the number 
of years since 1980. For example, if the current year is 2007, the year (YY) for the date 
stamp would be 27. 

Following is an example of a request for events and alarms with the history access 
event/alarm register defined as 32 (0x0020 hex). 
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Table 50. Host Event/Alarm Request Example Message 

Message 
Field 

Device 
Address 

Function 
Code 

Register 
Offset 

Num Reads 
(ignored) 

Error Check 

Bytes 1 1 2 2 2 

TX Order 
  

MS LS MS LS LS MS 

Value 01H 03H 00H  20H 00H 01H CRC-16 

 

The following example shows a response returning three events and alarms. 

Table 51. Event/Alarm Response Example Message 

Message 
Field 

Device 
Address 

Function 
Code 

Byte 
Count 

Data Error 
Check 

Bytes 1 1 1 (20 bytes per event or alarm) 2 

TX Order 
   

Integers — MS LS LS MS 

Floats — Selectable 

Value 01H 03H 3CH CRC-16 

 
4.29.3.3.2 Acknowledging Events and Alarms 

After receiving event and alarm data, the host transmits an acknowledgement message 
to the FB Series product to clear these events and alarms from the Modbus buffer. Until 
an acknowledgement message is received, the FB Series product continues to send the 
same event and alarm records to the host. The Modbus acknowledgement (to clear the 
Event Log and Alarm Log buffer) uses Function Code 05 and the Register Number defined 
in the History Access configuration. In this request, the data value is always one (1). 

Table 52. Event and Alarm Acknowledgement Response Example Message 

Message 
Field 

Device 
Address 

Function 
Code 

Register Data Error 
Check 

Bytes 1 1 2 2 2 

TX Order MS LS MS LS MS LS MS LS 

Value 01H 05H 00H 20H FFH 00H CRC-16 

 
4.29.3.3.3 Event & Alarm Change Bit Map Contents 

The following table shows the contents of event and alarm bit maps. 
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Table 53. Event and Alarm Change Bit Map Contents 

Bit Operator Change Bit Map Alarm Change Bit Map 

0 Fixed value – change to an EU value on 
an I/O point in Manual Mode 

Not Used 

1 Zero scale – change to the 0% Adjusted 
on an AO or AI 

Not Used 

2 Full scale – change to the 100% Adjusted 
on an AO or AI 

Not Used 

3 Operator entry work value – change to 
any parameter other than those 
described 

Not Used 

4 Boolean fixed bit – change to Status in 
DO or DI 

Not Used 

5 Fixed/variable flag – change to Manual 
Mode for an I/O point 

Manual Alarm 

6 Table entry change – change to Modbus 
Function Tables 

Status Change Alarm 

7 System command change – events 
logged by system (Power up) 

No Flow Alarm 

8 Not Used Point Fail Alarm 

9 Operator change (Event Log) identifier 
bit 

0 for Alarm 

10 Low Low Limit – change to Low Low 
Alarm parameter 

Low Low Alarm 

11 Low Limit – change to Low Alarm 
parameter 

Low Alarm 

12 High Limit – change to High Alarm 
parameter 

High Alarm 

13 High High Limit – change to High High 
Alarm parameter 

High High Alarm 

14 Rate of Change Limit – change to Rate 
Alarm parameter 

Rate Alarm 
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Bit Operator Change Bit Map Alarm Change Bit Map 

15 Not Used Set/Clear Alarm 
(1 = Set or 0 = Clear) 

 

4.29.3.4 EFM Archive Mapping 

Use this pop-up display to configure EFM Archive Mapping for the FB Series products. EFM 
archive mapping allows you to access history data stored on the FB Series product. 

Note 

• EFM Archive Mapping using Database Objects is unique for each communications 
port. 

• EFM Archive Mapping using CSV Files is shared between all communications ports. 

To access this display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave protocol. 

3. Select the Modbus Slave button. The Modbus Slave pop-up display opens. 

4. Select Database Objects in the EFM Archive Mapping using CSV Files frame. 

5. Select the EFM Archive Mapping button. 
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Figure 344. EFM Archive Mapping Button 

 

Depending on your selection in the EFM Archive Mapping using CSV Files frame, one of 
the following two displays will open: 

EFM Archive Mapping Display – Use this pop-up display to configure EFM Archive Mapping 
using database objects for the FB Series products. Mapping is unique foe each 
communications port. 

EFM Registers – Use this pop-up display to configure EFM Archive Mapping using CSV files 
for the FB Series products. Mapping is shared between all communications ports.  

Note 

• For more information about importing a CSV file that contains EFM Archive Mapping, 
refer to Importing an EFM Archive Mapping CSV File. 

• For more information about exporting a CSV file that contains the FB Series product's 
current EFM Archive Mapping, refer to Exporting an EFM Archive Mapping CSV File.  

• For more information about creating your own EFM Archive Mapping using CSV files, 
refer to Creating an EFM Archive Mapping CSV File. 
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4.29.3.4.1 EFM Archive Mapping Display 

Use this pop-up display to configure EFM archive mapping for the FB Series products. 

Note 

EFM Archive Mapping using database objects is unique for each communications port 
(unlike the EFM Archive Mapping using CSV files, which is shared between all 
communications ports). This allows you to access different history data through each 
communications port. 

To access this pop-up display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave protocol. 

3. Select the Modbus Slave button. The Modbus Slave pop-up display opens. 

4. Select Database Objects in the EFM Archive Mapping using CSV Files frame. 

5. Select the EFM Station Mapping button. 

Figure 345. EFM Archive Mapping Display 

 

6. Review – and change as necessary – the values in the following fields: 
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Field Description 

EFM Hist Val 1 Click  to open a Point Picker dialog and select the a history. This 

selection defines the first history point returned when you request 
history data with an hourly or daily history register. 

Note 
Each history group is offset by 800 points. History group 1 starts at 
Hist_1, history group 2 starts at Hist_801, history group 3 starts at 
Hist_1601, history group 4 starts at Hist_2401, and so on. 

Num of Hist 
Points 

Sets the number of history points to collect. This selection defines 
how many history values are returned when you request history 
data with an hourly or daily history register. 

Note 

The starting history point is the point configured in the EFM History 
Value 1 field. 

Hr Hist Reg Sets the Modbus Register Number to acquire hourly history values. 

Hr Idx Reg Sets the Modbus Register Number to acquire the hourly index value. 

Day Hist Reg Sets the Modbus Register Number to acquire daily history values. 

Day Idx Reg Sets the Modbus Register Number to acquire the daily index value. 

7. Select Save to save any changes you make to this pop-up display. 

4.29.3.4.2 EFM Registers 

Use this pop-up display to configure EFM Archive Mapping using CSV files for the FB 
Series products. 

Note 

• EFM Archive Mapping using CSV files is shared between all communications ports. 

• You can configure a maximum of 100 rows for the EFM Registers table. 

To access this pop-up display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave protocol. 

3. Select the Modbus Slave button. The Modbus Slave pop-up display opens. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

901 

4. Select Use CSV Files in the EFM Archive Mapping using CSV Files frame. 

5. Select the EFM Archive Mapping button. The EFM Registers pop-up display opens. 

Figure 346. EFM Registers 

 

6. Review – and change as necessary – the values in the following fields: 

Field Description 

EFM History Value 1 This field defines the first history point returned when you request 
history data with an hourly or daily history register. 

Note 
Each history group is offset by 800 points. History group 1 starts at 
Hist_1, history group 2 starts at Hist_801, history group 3 starts at 
Hist_1601, history group starts at Hist_2401, and so on. 
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Field Description 

Number of History 
Points 

Sets the number of history points to collect. This selection defines 
how many history values are returned when you request history 
data with an hourly or daily history register. 

Note  
The starting history point is the point configured in the EFM History 
Value 1 field. 

Hourly History 
Register 

Sets the Modbus Register Number to acquire hourly history values. 

Hourly Index 
Register 

Sets the Modbus Register Number to acquire the hourly index 
values. 

Daily History 
Register 

Sets the Modbus Register Number to acquire daily history values. 

Daily Index Register Sets the Modbus Register Number to acquire the daily index value. 

Ports Click this cell to open a Select Comm port instance pop-up display 
and configure which communications ports instances that a remote 
device must use to access data in the selected row of the map table 
register. Place a check mark next each allowed communications 
port. Select OK to save your changes and return to the previous 
display. 

Insert Row Select to add a new row to the EFM register at the location of the 
currently highlighted row. Existing entries are moved down one row. 

Delete Row Select to remove the currently highlighted row from the EFM 
register. Existing entries are moved up one row. 

Clear Row Select to remove data from the currently highlighted row of the EFM 
register.  

Add Row Select to add a row to the end of the EFM register. 

Object and 
instances 

Lists the available database objects (types) and instances (iterations) 
of each object. 
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Field Description 

Import CSV Click to import a CSV file into your FB Series product that contains 
your desired EFM archive mapping configuration. Navigate to the 
location of the saved CSV file and select Open to start the import 
process. For more information, refer to Importing an EFM Archive 
Mapping CSV File. 

Note 
The system verifies the integrity of the CSV and asks for 
confirmation before continuing if any errors are found. Any invalid 
lines in the CSV file are ignored and data currently in the FB Series 
device is maintained. 

Export CSV Click to save a CSV file to your computer that contains the current 
Modbus map table configuration of your FB Series product. A Select 
Table dialog opens where you can select which Modbus tables to 
include in the export. Click Start, select a name and location for the 
exported file on your computer, and click Save to begin the export 
process. For more information, refer to Exporting an EFM Archive 
Mapping CSV File. 

Open Log Click to open the ImportExportLogs folder on your computer that 
contains FBxConnect™ import/export error logs. Any errors 
encountered when importing a CSV file are stored in a log in this 
folder. 

Note 
Log file name includes the date and time the log was created. 

Refresh Select to re-display the table entries currently stored in memory of 
the FB Series product. 

Save Select to save the current table and any changes to memory in the 
FB Series product. 

Close Select to exit the Map Table Register display. 

7. Select the History object (Hist_) in the Objects and instances frame to view a list of 
history instances in the FB Series product. 

8. Select the history instance you want to include in your EFM archive mapping.  

9. Drag and drop the instance from the Objects and instances frame to the Register 
Table frame. A new row is added to the Register Table frame. 
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10. Enter the number of history points to collect in the Number of History Points field. 

11. Enter the Modbus Register Number to acquire the hourly index values in the Hourly 
History Register field. 

12. Enter the Modbus Register Number to acquire hourly index values in the Hourly 
Index Register field. 

13. Enter the Modbus Register Number to acquire daily history values in the Daily 
History Register field. 

14. Enter the Modbus Register Number to acquire daily index values in the Daily Index 
Register field. 

15. Click the Ports cell to open a Select Comm port instance pop-up display and 
configure which communications ports instances that a remote device must use to 
access data in the selected row of the map table register. Place a check mark next 
each allowed communications port. Select OK to save your changes and return to the 
previous display. 

16. Select Save to save any changes you make to this pop-up display. 

4.29.3.4.3 Importing an EFM Archive Mapping CSV File 

You can import a CSV file that contains your Modbus poll table configuration for use in 
your FB Series product.  

Note 

• For more information about EFM Archive Mapping using CSV file, refer to EFM 
Registers. 

• For more information about creating your own EFM Archive Mapping using CSV files, 
refer to Creating an EFM Archive Mapping CSV File. 

• For more information about exporting a CSV file that contains the FB Series product's 
current EFM Archive Mapping, refer to Exporting an EFM Archive Mapping CSV File. 

To import a CSV file that contains your Modbus poll table configuration: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave protocol. 

3. Select the Modbus Slave button. The Modbus Slave pop-up display opens. 
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4. Select Use CSV Files in the EFM Archive Mapping using CSV Files frame. 

5. Select the EFM Archive Mapping button. The EFM Registers pop-up display opens. 

Figure 347. EFM Registers – Import CSV 

 

6. Select the Import CSV button.  

7. Navigate to the file location of your CSV file and select Open. 

Note 

The system verifies the integrity of the CSV and asks for confirmation before continuing if 
any errors are found. If you select Import removing invalid parameters, any invalid 
lines in the CSV file are ignored and data currently in the FB Series device is maintained. 

8. A confirmation message displays after importing the CSV. Select OK to complete the 
process. 
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Figure 348. Confirmation 

 

4.29.3.4.4 Exporting an EFM Archive Mapping CSV File 

You can export your FB Series product's current EFM archive mapping to a CSV file saved 
on your computer. 

Note 

• For more information about EFM Archive Mapping using CSV file, refer to EFM 
Registers. 

• For more information about creating your own EFM Archive Mapping using CSV files, 
refer to Creating an EFM Archive Mapping CSV File. 

• For more information about importing a CSV file that contains EFM Archive Mapping, 
refer to Importing an EFM Archive Mapping CSV File. 

To export a CSV file that contains your EFM archive mapping: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Slave or Modbus Master protocol. 

3. Select the Modbus Slave button. The Modbus Slave pop-up display opens. 

4. Select Use CSV Files in the EFM Archive Mapping using CSV Files frame. 

5. Select the EFM Archive Mapping button. The EFM Registers pop-up display opens. 
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Figure 349. EFM Registers – Export CSV 

 

6. Select the Export CSV button. A Save csv file window opens. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

908 

Figure 350. Save csv file 

 

7. Navigate to a location on your computer to save your exported CSV file and select 
Save. The system exports the CSV file and displays a progress bar at the top of the 
display. 

8. A confirmation message displays after exporting the CSV file. Select OK to complete 
the process. 

Figure 351. Confirmation 

 

4.29.3.4.5 Creating an EFM Archive Mapping CSV File 

You can create an EFM Archive Map on your computer and then import the file for use in 
the FB Series product. If your EFM Archive Map contains a large amount of points, it may 
be easier to create a CSV file on your computer than it is to configure the map in 
FBxConnect™.  
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Note 

• For more information about EFM Archive Mapping using CSV file, refer to EFM 
Registers. 

• For more information about importing a CSV file that contains the FB Series product's 
current EFM Archive Mapping, refer to Importing an EFM Archive Mapping CSV File. 

• The easiest way to begin creating a custom map is to export a CSV that contains the 
current configuration and then edit that file. For more information about exporting a 
CSV file, refer to Exporting an EFM Archive Mapping CSV File. 
Figure 352. Example EFM Archive Map CSV Format 

 

To create a CSV file that contains your EFM archive mapping: 

1. Open a blank spreadsheet (or open your previously exported EFM Registers CSV file). 

2. In row one of the spreadsheet, enter the following text based on your configuration:  

• Column A = Archive 

• Column B = EFM Hist Val 1 

• Column C = Num of Hist Points 

• Column D = Hr Hist Reg 

• Column E = Hr Idx Reg 

• Column F = Day Hist Reg 

• Column G = Day Idx Reg 

• Column H = Ports 

3. In the proceeding rows, enter information for each table entry according to the 
descriptions below: 
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Column Heading Description 

Archive The row number of the EFM register table as displayed in 
FBxConnect™. 

Note 

You can configure a maximum of 100 rows for the EFM Registers 
table (rows 2-101 in the CSV file). 

EFM Hist Val 1 This column defines the first history point returned when you 
request history data with an hourly or daily history register. 

Note 
Each history group is offset by 800 points. History group 1 starts 
at Hist_1, history group 2 starts at Hist_801, history group 3 
starts at Hist_1601, history group 4 starts at Hist_2401, and so 
on. 

Num of Hist Points Sets the number of history points to collect. This selection 
defines how many history values are returned when you request 
history data with an hourly or daily history register. 

Note  
The starting history point is the point configured in the EFM Hist 
Val 1 column. 

Hr Hist Reg Sets the Modbus Register Number to acquire hourly history 
values. 

Hr Idx Reg Sets the Modbus Register Number to acquire the hourly index 
values. 

Day Hist Reg Sets the Modbus Register Number to acquire daily history values. 

Day Idx Reg Sets the Modbus Register Number to acquire the daily index 
value. 
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Column Heading Description 

Ports Enter the communications port instances that a remote device 
must use to access the data in the selected row of the EFM 
archive.  

Note 

• At least one communications port instance must be defined. 

• To allow multiple communications ports access to the data, 
place a semicolon between each instance (for example, 
Comm_1;Comm_4;Comm_5). 

• Typing All enables all communications port instances to 
access the data.  

4. Save your changes. You can now import your CSV file for use in your FB Series 
product. For more information, refer to Importing an EFM Archive CSV File. 

Note 

Make sure to save the file with a .csv file extension. 

4.29.4 Communications – Modbus Master 

Use this pop-up display to configure communications ports using Modbus Master 
protocol. The Modbus Master mode of operation allows the FB Series products to 
simulate a master device that can poll other devices for data and to store that data in 
Modbus registers within the FB Series product. The FB Series products can also send 
commands to set outputs and write data to a slave device. Each command can transmit or 
receive up to 240 bytes of data. 

Each master request you configure uses data read from or written to registers defined in 
the Modbus Table Registers. When using Modbus function codes 1, 2, 3, and 4, the FB 
Series product reads data from a slave device and writes it to the parameter specified in 
the Modbus Registers table. When using Modbus function codes 5, 6, 15, and 16, the FB 
Series product reads data from the parameter specified in the Modbus Registers table 
and writes it to the slave device. 

You can configure the Modbus Master functionality on the serial or Ethernet ports. 
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Note 

This pop-up display is available only if you select Modbus Master in the Port Owner 
drop-down list on the Communications – General display. 

To access this pop-up display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Master protocol. 

3. Select the Modbus Master button. The Modbus Master pop-up display opens. 

Figure 353. Communications – Modbus Master 

 

4. Review – and change as necessary – the values in the following fields: 
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Field Description 

Modbus 
Transmission 
Mode 

Sets the communications mode for the selected communications 
port. The Modbus protocol supports two modes of transmission, 
ASCII and RTU. RTU is the default. 

Note 

You must configure all devices in the same communications network 
with the same mode of transmission. Additionally, in either ASCII or 
RTU mode, the transmitting device places the Modbus message into 
a frame that has a known beginning and ending point. 

RTU Remote Terminal Unit mode allows for greater 
character density and better data throughput than 
ASCII for the same baud rate. Each message is 
transmitted in a continuous stream. Data is sent in 8-
bit binary characters. RTU mode uses Cyclic 
Redundancy Check (CRC) error checking. By default, 
RTU is enabled. 

ASCII American Standard Code for Information Interchange 
mode represents each 8-bit byte of data as two ASCII 
characters that are the hexadecimal representation of 
the value. This allows the messages to be read with 
the use of a dumb terminal but uses twice as many 
characters as the RTU mode. Each character sent is 
composed of a start bit, 7 or 8 data bits, and one or 
two stop bits with Even, Odd, or No parity. ASCII mode 
uses Longitudinal Redundancy Checking (LRC) error 
checking. 

TCP Adds a 6-byte header to Modbus messages, and then 
encapsulates it for transmission over TCP/IP. The 
header consists of the following: 

• A 2-byte transaction ID that increments for each 
packet sent. 

• A 2-byte protocol ID. The protocol ID for Modbus 
is 0. 

• A 2-byte indicator of the packet length. 

Note 

This field appears only for the Ethernet port. 
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Field Description 

Byte Order Sets the order of data bytes in a transmission or requests, which can 
be reversed. This only affects the Data field of a Modbus message 
and has no effect on the data bytes for Function Codes 01, 02, and 05. 
Possible options are: 

LSB Least Significant Byte First (places the Least Significant 
Byte first). This is the default value. 

MSB Most Significant Byte First (places the Most Significant 
Byte first). 

Starting 
Request 
Number 

Sets a beginning value from which the Modbus Master polling 
sequence begins. This number corresponds to a line number on the 
Modbus Master Poll Table associated with this comm port. 

Number of 
Requests 

Sets the total number of requests (polls) the Modbus Master makes 
for this polling sequence. This value specifies the total number of 
lines in the Master polling tables on which to execute the polls. The 
default value 0 prevents the polling from occurring. 

Note 

You can define up to six Modbus Master tables for each 
communications port. Each Modbus Master table is comprised of 25 
lines. The tables are contiguous. If you indicate more requests than 
are on a single table, the system accesses the subsequent table to 
complete the request. 

Receive 
Timeout 

Sets the amount of time (in seconds) that the Master (Host) waits to 
receive a valid message after the FB Series product sends a request 
to a device. The default is 30 seconds. 

Number of 
Retries 

Sets the number of times (after the initial try) that the FB Series 
product attempts to establish communications with the specified 
device before reporting a timeout error. The default is 2. 

TCP 
Connection 
Timeout 

Sets the time (in seconds) the system waits for a valid Modbus Master 
protocol message before closing the TCP/IP connection. The timeout 
resets after each valid message. The default is 3. 

Note 

This field applies only to the Ethernet port. 
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Field Description 

Delay 
Between 
Individual 
Requests 

Sets a delay time (in seconds) between individual polling requests. 
The default is 0.0. 

Note 

The system considers each line in a Modbus Master Polling Table as a 
request. 

Delay after a 
Single 
Sequence of 
Polls 

Sets a delay time (in seconds) between polling request sequences. 
This field is valid only when you enable Continuous Polling. The 
default is 1.0. 

Actual Poll 
Time 

This read-only field shows (in seconds) the actual time required to 
complete the polling sequence. 

Modbus 
Mapping 
using CSV Files 

Sets the location where the Modbus map table is stored by the FB 
Series product.  

Note  

• If you change this option, you must perform a warm start before 
any changes are applied. 

• Your selection applies to both Modbus Slave and Modbus Master 
protocols. 

Database 
Objects 

 Select this radio button to store the Modbus map 
table in the FB Series product's internal database. 

Use CSV 
Files 

 Select this radio button to store the Modbus map 
table as CSV files in the FB Series product. 

Note 

• Using this option removes the Modbus map table 
from the internal database and increases the 
available amount of memory in the FB Series 
product. 

• To avoid losing data, export your current Modbus 
map table before you select this option. For more 
information, refer to Exporting a Modbus Map 
Table CSV File. 

Modbus 
Mapping 
Status 

This read-only field shows the current condition of the 
Modbus map table. Possible values are: 

No Error (0) The CSV file is valid. 
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Field Description 

No Mapping 
Found (1) 

There is no mapping file currently on 
the device. 

Column 
Mismatch 
(2) 

The CSV file is not formatted correctly. 
Some rows have more or less columns 
than the header. Open the Log within 
the EFM Registers window for a 
detailed analysis. 

Missing Req 
Column (3) 

The CSV file is missing a required 
column. Open the Log within the EFM 
Registers window for a detailed 
analysis. 

Exceeded 
Max Data (4) 

The CSV file contained more rows than 
the firmware supports. 

Invalid Row 
Data (5) 

The CSV file contains a row with invalid 
data. This can be out of range data or 
mappings that cannot be processed. 
Open the Log within the EFM Registers 
window for a detailed analysis. 

Duplicate 
Data (7) 

The CSV file contains two mappings 
with similar data or identical register 
numbers. Open the Log within the 
EFM Registers window for a detailed 
analysis. 

Start Modbus 
Poll 

Controls whether the system begins a Modbus Master polling 
sequence. 

Start Select Start and Save to begin a Modbus Master 
polling sequence. The system clears this field when 
the polling sequence completes. 

Cancel Select Cancel and Save to discontinue a Modbus 
Master polling sequence. 
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Field Description 

Enable 
Continuous 
Polling 

Indicates whether the system continually executes the Modbus 
Master polling sequence. 

Enable The system does continually execute the Modbus 
Master polling sequence as defined in the polling 
table. 

Disable The system does not continually execute the Modbus 
Master polling sequence. 

Poll Table 
Registers 

Click to open the Poll Table Register pop-up display and map 
parameters in remote devices to Modbus Map Table Registers in the 
FB Series product. 

Note 

You can create a Modbus Poll Table as a CSV file on your computer 
and then import the CSV file for use in the FB Series product. For 
more information about creating, importing, and exporting your own 
Modbus Poll Table CSV files, refer to Creating a Modbus Poll Table 
CSV File, Importing a Modbus Poll Table CSV File, and Exporting a 
Modbus Poll Table CSV File. 

Map Table 
Registers 

Click to open the Map Table Register pop-up display and configure 
the Modbus registers stored in the FB Series product. 

Note 

• To view documentation for the Modbus Master Map Table 
Register pop-up display, refer to Modbus Slave Map Table 
Register. 

• Map Table Registers are shared between all communications 
ports that are configured to use either Modbus Slave or Modbus 
Master protocol. 

• You can create a Modbus Map Table as a CSV file on your 
computer and then import the CSV file for use in the FB Series 
product. For more information about creating, importing, and 
exporting your own Modbus Map Table CSV files, refer to 
Creating a Modbus Map Table CSV File, Importing a Modbus Map 
Table CSV File, Exporting a Modbus Map Table CSV File, and 
Remote Data Types. 

5. Select Save to save any changes you make to this pop-up display. 
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4.29.4.1 Poll Table Register 

Use this pop-up display to configure the Modbus Poll Table Register. The Modbus Poll 
Table Register maps Modbus registers in slave devices to the Modbus register in the FB 
Series product. Each communications port with Modbus Master support is assigned its 
own tables, and each table contains 25 available entries: 

• COM1 – Tables 1 through 6  

• COM2 – Tables 7 through 12 

• COM3 – Tables 13 through 18 

• COM4 – Tables 19 through 24 

• Ethernet 1 – Tables 25 through 30  

• Ethernet 2 – Tables 31 through 36 

For additional communication modules, the system assigns tables in numerical order 
based on the slot number and the next six consecutive tables to each port. For example, 
an FB3000 with a single 4-port ommunications module installed in slot 3 would be 
assigned the following tables: 

• COM31 – Tables 37 through 42 

• COM32 – Tables 43 through 48 

• COM33 – Tables 49 through 54 

• COM34 – Tables 55 through 60 

To access this display: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Master protocol. 

3. Select the Modbus Master button. The Modbus Master pop-up display opens. 

4. Select the Poll Table Registers button. The Poll Table Register pop-up display opens. 
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Figure 354. Poll Table Register 

 

5. Review – and change as necessary – the values in the following fields: 

Field Description 

Table Click ▼ to select a poll table register to configure. 

Tag Sets a name for the selected poll table register. 

Number This read-only field shows the poll request number. 

Server IP 
Address 

Specifies the IP address of the device to be polled. 

Note 

This field applies only to the Ethernet communications port. 

Server Port No Specifies the IP port number of the device to be polled. 

Note 

This field applies only to the Ethernet communications port. 

RTU Address Specifies the Modbus RTU address of the device to be polled. 

Function Code Click ▼ to select the Modbus function code to be sent to the slave 
device. Possible options are: 
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Field Description 

Polling 
Disabled 

This line in the polling table will be skipped. 

Read Coil 
Status 

Function code 1 – Read coil status. 

Read Input 
Status 

Function code 2 – Read input status. 

Read 
Holding 
Registers 

Function code 3 – Read holding registers. 

Read Input 
Registers 

Function code 4 – Read Input registers. 

Force 
Single Coil 

Function code 5 – Force single coil. 

Set Single 
Register 

Function code 6 – Set single register. 

Force 
Multiple 
Coils 

Function code 15 – Force multiple coils. 

Set 
Multiple 
Registers 

Function code 16 – Set multiple registers. 

Slave Register Sets the starting register number from which data is drawn from or 
to which data is written in the slave device. 

Master 
Register 

Sets the starting register number in the FB Series product to which 
data is stored, as defined in the Modbus Map Table. 

Number of 
Registers 

Sets the total number of registers to poll (read/write) in a single 
request. 

Comm Status This read-only field shows the status of the selected poll. Possible 
statuses are: 

• Inactive or Start of Transmission 

• Response Timeout 

• Function Code Error 

• Invalid Register Error 

• Invalid Request Data Error 

• Exception Error Code Received 

• Mapping Table Error 
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Field Description 

• Invalid Response Received 

• CRC or LRC Check Error 

• Database Read Error 

• Valid Response Received 

• Request Framing Error 

• Transmit Timeout Error 

• Database Write Error 

• Broadcast Request Transmitted 

Import CSV Click to import a CSV file into your FB Series product that contains 
your desired Modbus poll table configuration. Navigate to the 
location of the saved CSV file and select Open to start the import 
process. For more information, refer to Importing a Modbus Poll 
Table CSV File. 

Note  

The system verifies the integrity of the CSV and asks for confirmation 
before continuing if any errors are found. Any invalid lines in the CSV 
file are ignored and data currently in the FB Series device is 
maintained. 

Export CSV Click to save a CSV file to your computer that contains the current 
Modbus poll table configuration of your FB Series product. A Select 
Table dialog opens where you can select which tables to include in 
the export. Click Start, select a name and location for the exported 
file on your computer, and click Save to begin the export process. For 
more information, refer to Exporting a Modbus Poll Table CSV File. 

Note  

By default, all selected data is exported into a single file. Select 
Export to individual file to have the system create individual files for 
each table you select. 

Open Log Click to open the ImportExportLogs folder on your computer that 
contains FBxConnect™ import/export error logs. Any errors 
encountered when importing a CSV file are stored in a log in this 
folder. 

Note  

Log file name includes the date and time the log was created. 
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Field Description 

Refresh Select to re-display the table entries currently stored in memory of 
the FB Series product. 

Save Select to save the current table and any changes to memory in the FB 
Series product. 

Close Select to exit the Poll Table Register display. 

6. Select Save to save any changes you make to this pop-up display. 

4.29.4.1.1 Importing a Modbus Poll Table CSV File 

You can import a CSV file that contains your Modbus poll table configuration for use in 
your FB Series product.  

Note 

• For more information about Modbus poll tables in the FB Series product, refer to Poll 
Table Register. 

• For more information about creating your own Modbus poll table CSV file, refer to 
Creating a Modbus Poll Table CSV File. 

• For more information about exporting a CSV file that contains the FB Series product's 
current Modbus poll table configuration, refer to Exporting a Modbus Poll Table CSV 
File. 

To import a CSV file that contains your Modbus poll table configuration: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Master protocol. 

3. Select the Modbus Master button. The Modbus Master pop-up display opens. 

4. Select the Poll Table Registers button. The Poll Table Register pop-up display opens. 
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Figure 355. Poll Table Register – Import CSV 

 

5. Select the Import CSV button.  

6. Navigate to the file location of your CSV file and select Open. 

Note 

The system verifies the integrity of the CSV and asks for confirmation before continuing if 
any errors are found. If you select Import removing invalid parameters, any invalid 
lines in the CSV file are ignored and data currently in the FB Series device is maintained. 

7. A confirmation message displays after importing the CSV. Select OK to complete the 
process. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

924 

Figure 356. Confirmation 

 

4.29.4.1.2 Exporting a Modbus Poll Table CSV File 

You can export your FB Series product's current Modbus poll table configuration to a CSV 
file saved on your computer. 

Note 

• For more information about Modbus poll tables in the FB Series product, refer to Poll 
Table Register. 

• For more information about creating your own Modbus poll table CSV file, refer to 
Creating a Modbus Poll Table CSV File. 

• For more information about importing a CSV file that contains the FB Series product's 
current Modbus poll table configuration, refer to Importing a Modbus Poll Table CSV 
File. 

To export a CSV file that contains your Modbus poll table configuration: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Select ▼ in the Communications drop-down list and choose a communications port 
using the Modbus Master protocol. 

3. Select the Modbus Master button. The Modbus Master pop-up display opens. 

4. Select the Poll Table Registers button. The Poll Table Register pop-up display opens. 
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Figure 357. Poll Table Register – Export CSV 

 

5. Select the Export CSV button. The Select Table pop-up display opens. 
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Figure 358. Select Table 

 

6. Place a check mark next to each table you want to export. 

Note 

By default, all selected tables are exported to a single file. If you want each selected table 
to be exported to individual files, place a check mark next to Export to individual file. 

7. Select Start. A Save csv file window opens. 
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Figure 359. Save csv file 

 

8. Navigate to a location on your computer to save your exported CSV file and select 
Save. The system exports the CSV file and displays a progress bar at the top of the 
display. 

9. A confirmation message displays after exporting the CSV file. Select OK to complete 
the process. 

Figure 360. Confirmation 

 

4.29.4.1.3 Creating a Modbus Poll Table CSV File 

You can create a Modbus poll table on your computer and then import the file for use in 
the FB Series product. If your Modbus poll table contains a large amount of points, then it 
may be easier to create a CSV file on your computer than it is to configure the table in 
FBxConnect™. 
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Note 

• For more information about Modbus poll tables, refer to Poll Table Register. 

• The Modbus poll table CSV must contain the format shown below. The easiest way to 
begin creating a custom map is to export a CSV that contains the current 
configuration and then edit that file. For more information about exporting a CSV file, 
refer to the Exporting a Modbus Poll Table CSV File. 
Figure 361. Example Modbus Poll Table CSV Format 

 

To create a CSV file that contains your Modbus poll table configuration: 

1. Open a blank spreadsheet (or open your previously exported Modbus poll table CSV 
file). 

2. In row one of the spreadsheet, enter the following text:  

• Column A = Table 

• Column B = Number 

• Column C = Server IP Address 

• Column D = Server Port No 

• Column E = RTU Address 

• Column F = Function Code 

• Column G = Slave Register 

• Column H = Master Register 

• Column I = Number of Registers 

3. In the proceeding rows, enter information for each table entry according to the 
descriptions below: 

Note 

Drop-down lists on the FBxConnect™ display are represented as numbers in the CSV file. 
See the descriptions below for a description for each number. 
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Column 
Heading 

Description 

Table Enter a number that specifies which poll register table number the 
selected row belongs to. Each communications port with Modbus 
Master support is assigned its own tables. Valid values are: 

• 1 through 6 = Com1  

• 7 through 12 = Com2  

• 13 through 18 = Com3  

• 19 through 24 = Com4 s  

• 25 through 30 = Ethernet 1 

• 31 through 36 = Ethernet 2  

Number Enter a number that specifies the poll request number (or row) for 
table number you entered in the previous column. Each table contains 
up to 25 poll request numbers. Valid values are 1 through 25. 

Server IP 
Address 

Enter the IP address of the device to be polled. 

Note  

This field applies only to the Ethernet communications port. 

Server Port 
No 

Enter the IP port number of the device to be polled. 

Note  

This field applies only to the Ethernet communications port. 

RTU Address Enter the Modbus RTU address of the device to be polled. 

Function 
Code 

Specifies the Modbus function code to be sent to the slave device. 
Only a number is entered and corresponds to the following values: 

• 0 = Polling Disabled. This line in the polling table will be skipped. 

• 1 = Read Coil Status 

• 2 = Read Input Status 

• 3 = Read Holding Registers 

• 4 = Read Input Registers 

• 5 = Force Single Coil 

• 6 = Set Single Register 

• 15 = Force Multiple Coils 

• 16 = Set Multiple Registers 

Slave 
Register 

Enter the starting register number from which data is drawn from or 
to which data is written in the slave device. 
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Column 
Heading 

Description 

Master 
Register 

Enter the starting register number in the FB Series product to which 
data is stored, as defined in the Modbus Map Table. 

Number of 
Registers 

Enter the total number of registers to poll (read/write) in a single 
request. 

4. Save your changes. You can now import your CSV file for use in your FB Series 
product. For more information, refer to Importing a Modbus Poll Table CSV File. 

Note 

Make sure to save the file with a .csv file extension. 

4.29.5 Configuring Communications Ports 

Use these steps to configure a communications port. 

CAUTION 
When making multiple FBxConnect™ connections to the same FB Series product (as with a 
remote and a local connection), be aware that the changes one connection makes to the 
FB Series product may not be immediately visible to other connections, and may even 
require the other connections to restart FBxConnect™ before changes become visible. For 
example, simple changes (such as changes to setpoints) may be immediately visible to all 
connections, but changing the number of meters, configuring I/O, adding/deleting menu 
items, or other major configuration changes may require re-establishing the connection 
using FBxConnect™.  

To configure a communications port: 

1. Select Configure > Communications from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the display and select a communications 
port to configure. 
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Figure 362. Communications – General (Ethernet port) 

 

3. In the Tag field, enter a name for the selected communications port. 

4. In the Port Description field, enter a description for the selected communications 
port. 

5. In the Port Settings frame, select Enable to allow communications on the selected 
port. 

6. For Serial communications ports, click ▼ in the Port Owner drop-down list and 
select the communications protocol used by selected communications port. 

7. Review – and change as necessary – the values in the remaining fields. For more 
information about the available fields, refer to Communications – General display. 

8. Select Save to save your changes to device memory and enable additional pop-up 
displays for the selected protocols. You must also configure the additional pop-up 
displays for each selected protocol. 

For more information about the additional pop-up displays, refer to the following topics: 
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Communications – DNP3  

Communications – Modbus Slave 

Communications – Modbus Master 

4.30 Localization 

Use the Localization screen to configure the time and date format for to three localization 
profiles. 

Note 

You assign localization profiles to users on the User Management screen. 

To access this screen: 

1. Select Configure > Localization from the FBxConnect™ main menu. 

2. Click ▼ in the drop-down list at the top of the screen to choose a localization profile to 
modify.  

Note 

Any changes made on this screen apply only to the selected localization profile. 
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Figure 363. Localization 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
localization profile. 

Language Select the language to use with the selected localization profile. 

Date Format Click ▼ to configure the date format to use with the selected 
localization profile. 

Time Format Click ▼ to configure the time format to use with the selected 
localization profile. 

4. Select Save to save your changes if you modify any of the fields on this screen.  

Note 

You must perform a Warm Start to apply your changes to the FB Series product.  
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4.31  Clock 

Use the Clock screen to set the clock in the FB Series product, and to configure daylight 
saving time options. 

To access this screen: 

1. Select Configure > Clock from the FBxConnect™ main menu. The Clock screen 
displays: 

Figure 364. Clock 

 

2. Review – and change as necessary – the values in the following fields: 
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Field Description 

Current Time Shows the current time and date of the device clock. 

Synchronize 
Time 

Select this button to synchronize the device clock with your PC clock. 
Refer to Time Sync. 

Daylight Saving 
Time Status 

This read-only field displays if daylight saving time is currently in 
effect. Possible values are Standard Time (Daylight Saving Time is 
not in effect), Saving Time (Daylight Saving Time is in effect), or Gift 
Time (the extra hour from 1AM to 2AM after the clock is set back 
one hour). 

Daylight 
Savings Time 

Enable or disable Daylight Saving Time clock changes. 

Note 

If you enable Daylight Saving Time, select Save and configure the 
starting and ending times for Daylight Saving Time in the Start and 
End columns. 

Day of the 
Week 

Click ▼ to select the day of the week to start and end 
Daylight Saving Time. 

Hour Click ▼ to select the hour to start and end Daylight 
Saving Time. 

Note 

Entered in military time (0 through 23). 

Month Click ▼ to select the month to start and end Daylight 
Saving Time. 

Note 

1 = January, 2 = February, 3 = March, 4 = April, etc. 

Week Click ▼ to select the week of the month to start and 
end Daylight Saving Time. 

Note 

The Last Week option configures Daylight Saving 
Time on the last week of the month, regardless of 
what week that falls on. 
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Field Description 

Date and 
Time 

These read-only fields show the next pending Daylight 
Savings Time start and end times for validation of the 
above configuration. As these start and end time pass, 
these fields will be automatically updated with the new 
start and end times for the next year. 

Note 

You must save any changes to update this field. 

Note 

For example, suppose you make the following Daylight Saving Start 
configuration: 

• Day of Week = Sunday 

• Hour = 2 

• Month = 3  

• Week of Month = Second Week  

Daylight Saving Time would begin at 2:00 am on the second Sunday 
of March. 

 

Time 
Synchronization 
Deadband 

Enter a time (in seconds) that a new time must be different than the 
old time to be accepted by the FB Series product. Any request to 
synch/write time that does not exceed the deadband is ignored. 
Valid values are 0 through 30. 

 

3. Select Save to save your changes if you modify any of the fields on this screen. 

4.32 LCD Touchpad 

Use this display to customize the functionality of a connected FB3000 RTU LCD Touchpad. 
In addition to the pre-defined menus available on the LCD Touchpad (Meters, System, 
etc.), you also have the ability to view user-configurable charts that show historical or real-
time data and to view two different kinds of user-configurable display lists (User Lists and 
List Mode) that show parameter descriptions and their associated values. 

Note 

After wiring your LCD Touchpad to a communications port on the FB3000, you must 
select LCD Display in the Port Owner field and 19.2K in the Baud Rate field on the 
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Communications – General display for the selected communications port instance. For 
more information, refer to FB3000 LCD Touchpad User Manual (D301935X012). 

To access this display: 

1. Select Configure > LCD Touchpad from the FBxConnect™ main menu. The LCD 
Touchpad display opens. 

Figure 365. LCD Touchpad 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 
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Field Description 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
instance. 

Inactivity 
Time 

Sets, in minutes, the amount of time the system waits without activity 
before triggering the "idle state" screen. The "idle state" screen shows 
either the Emerson logo (Power Save Mode disabled) or a blank screen 
(Power Save Mode enabled). The default is 5. 

Module 
Mode 

This read-only field shows the current status of the LCD 
Touchpad. 

Display Lists Select this button to open the User List Display List pop-up 
display and configure which parameters are shown in User List 
on the LCD Touchpad. List Mode is a user-configured auto-
scrolling list of read-only data that is accessible after you log in 
to the LCD Touchpad. You can configure up to four User Lists, 
each with up to 16 parameters.  

Note 
You must log in to the LCD Touchpad before you can access the 
User Lists. 

Display Chart 
Parameters 

Select this button to open the Display Chart Parameter pop-up 
display and configure which parameters are shown as real-time 
dynamic charts on the LCD Touchpad. 

Note 
You must log in to the LCD Touchpad before you can view 
Display Chart Parameters. 

Power Save 
Mode Enable 

Enables or disables the LCD Touchpad power-savings mode, which 
activates whenever you trigger the idle state screen. The power 
savings mode works with either Normal or List Mode. 

Disable The "idle screen" shows the Emerson logo. The screen 
is constantly active. 
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Field Description 

Enable The "idle screen" is blank to save power. The green 
LED blinks once every three seconds to indicate the 
LCD Touchpad is still active. 

Note 
Select Enable and then select Save to apply your 
changes. The FB3000 performs a warm start and 
reboots the LCD Touchpad.  

List Mode 
Status 

Enables or disables List Mode on the LCD Touchpad. List Mode is a 
user-configured auto-scrolling list of read-only data that is shown 
before you are required to log in to the LCD Touchpad. 

Note 
List Mode parameters are shown without logging in to the LCD 
Touchpad. 

Disable List Mode parameters do not show on the LCD 
Touchpad. 

Enable List Mode parameters show on the LCD Touchpad. 

Display Lists Select this button to open the List Mode Display List 
pop-up display and configure which parameters are 
shown in List Mode on the LCD Touchpad.  

Note 
You must select Enable and save your changes before 
you can access this button. 

Firmware 
Details 

Firmware 
Description 

This read-only field shows the description of the 
firmware installed on the LCD Touchpad. 

Firmware 
Part 
Number 

This read-only field shows the part number of the 
installed version of firmware. 

Firmware 
Version 

This read-only field shows the version of the firmware 
installed on the LCD Touchpad. 

Firmware 
Creation 
Date 

This read-only field shows the date and time that the 
installed version of firmware was created. 
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Field Description 

Firmware 
Serial 
Number 

This read-only field shows the serial number of the 
firmware installed on the LCD Touchpad. 

Boot Details Boot Part 
Number 

This read-only field shows the part number of the 
installed boot firmware. 

Boot 
Version 

This read-only field shows the version of the boot 
firmware installed on the FB Series product. 

Boot 
Creation 
Date 

This read-only field shows the date and time that the 
installed boot firmware was created. 

3. Select Save to save any changes you make to this display. 

4.32.1 Display List  

Use this pop-up display to configure both the User List parameters that are accessible 
after logging in to the LCD Touchpad and the List Mode parameters that are shown 
before logging in to the LCD Touchpad.  

User List 

You can configure up to four User Lists, and each list can show up to 16 parameters. After 
logging in and selecting a User List on the LCD Touchpad, the system automatically scrolls 
through the configured parameters and their values at a user-defined time interval. 

Note 

• You must log in to the LCD Touchpad before you can access User Lists. 

• Four instances (DispList_1, DispList_2, DispList_3, and DispList_4) make up the four 
User Lists. 

List Mode 

List Mode parameters shown before logging in to the LCD Touchpad. You can configure 
up to 48 parameters (three instances, each with 16 parameters) to show on the LCD 
Touchpad without logging in. The system automatically scrolls through the configured 
parameters and their values at a user-defined time interval. This mode allows service 
technicians to quickly review a dynamic display of current values without requiring them 
to log into the LCD Touchpad.  
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Note 

• You must set the List Mode Status field to Enable (LCD Touchpad) to view List Mode 
parameters on the LCD Touchpad. 

• The system does not require you to log in to the LCD Touchpad to view the 
configured List Mode parameters. 

• Three instances (DispList_5, DispList_6, and DispList_7) make up the single List Mode 
display list. 

To access the User List pop-up display: 

1. Select Configure > LCD Touchpad from the FBxConnect™ main menu. The LCD 
Touchpad display opens. 

2. Select the Display Lists button. The Display List (User List) pop-up display opens. 
Continue to step 7. 

To access List Mode pop-up display: 

3. Select Configure > LCD Touchpad from the FBxConnect™ main menu. The LCD 
Touchpad display opens. 

4. Select Enable in the List Mode Status frame. 

5. Select Save to apply your changes. 

6. Select the Display Lists button in the List Mode Status frame. The Display List (List 
Mode) pop-up display opens. 
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Figure 366. Display Lists Buttons 

 

7. Click ▼ in the drop-down list at the top of the display and select an instance to 
configure. 
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Figure 367. Display List (User List) 

 

8. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Note 
The value of this field is the same for the DispList_5, DispList_6, or 
DispList_7 instances. FBxConnect™ shows this field as read-only for 
the DispList_6 and DispList_7 instances. If SCADA changes this 
parameter for either the DispList_5, DispList_6, or DispList_7 instance, 
then the remaining instances (DispList_5, DispList_6, or DispList_7) are 
also changed to the new value. 
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Field Description 

Description Sets a description (up to 10-alphanumeric characters) for the selected 
instance. 

Note 
The value of this field is the same for the DispList_5, DispList_6, or 
DispList_7 instances. FBxConnect™ shows this field as read-only for 
the DispList_6 and DispList_7 instances. If SCADA changes this 
parameter for either the DispList_5, DispList_6, or DispList_7 instance, 
then the remaining instances (DispList_5, DispList_6, or DispList_7) are 
also changed to the new value. 

Scroll Time Sets, in seconds, the amount of time the LCD Touchpad shows each 
configured parameter set before scrolling to the next parameter set. 
(The screen displays up to two parameters at a time.)  Valid values are 
1 to 255. The default is 4.  

Note 
The value of this field is the same for the DispList_5, DispList_6, or 
DispList_7 instances. FBxConnect™ shows this field as read-only for 
the DispList_6 and DispList_7 instances. If SCADA changes this 
parameter for either the DispList_5, DispList_6, or DispList_7 instance, 
then the remaining instances (DispList_5, DispList_6, or DispList_7) are 
also changed to the new value. 

Parameter 
Reference 

Click  to open a Point Picker dialog and select a parameter to show 

in the Display List on the LCD Touchpad. 

Custom 
Description 

Sets a description (up to 10-alphanumeric characters) to show on the 
LCD Touchpad for the selected parameter reference. If set, this 
description is shown instead of the parameter name. 

9. Select Save to save any changes you make to this display. 

4.32.2 Display Chart Parameters 

Use this pop-up display to configure the parameters that show, in a chart recorder 
format, historical or dynamic values on the LCD Touchpad. Each chart corresponds to one 
instance of the DispChart_ object, and you can configure up to 24 instances.   
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To access this display: 

1. Select Configure > LCD Touchpad from the FBxConnect™ main menu. The LCD 
Touchpad display opens. 

Figure 368. Display Chart Parameters Button 

 

2. Select the Display Chart Parameters button. The Display Chart Parameter pop-up 
display opens. 

3. Click ▼ in the drop-down list at the top of the display, and select an instance to 
configure. 
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Figure 369. Display Chart Parameter 

 

4. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Sets a description (up to 10-alphanumeric characters) for the selected 
instance. 

Chart 
Parameter 

Click  to open a Point Picker dialog and select a parameter to show 

as a dynamic chart on the LCD Touchpad. 

Auto Scale Controls the resolution of the vertical axis for the chart shown on the 
LCD Touchpad. 

Disable The system uses the values set in the Lower Range 
Limit and Upper Range Limit fields as the minimum 
and maximum values of the chart's vertical axis. 
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Field Description 

Enable The system overrides the values you configure in the 
Lower Range Limit and Upper Range Limit fields and 
automatically sets minimum and maximum values of 
the chart's vertical axis based on the sampling of the 
data it gathers.  

Lower Range 
Limit 

Sets the minimum value of the chart's vertical axis. 

Upper Range 
Limit 

Sets the maximum value of the chart's vertical axis. 

5. Select Save to save any changes you make to this display. 

4.33  Power Control 

Use the Power Control screen to enable and disable power to a radio or other device via a 
DO or other I/O, as well as wake the device from low power to communicate. You can 
configure three separate power control instances, and each instance can be configured 
with independent timer values and output parameters. 

For each Power Control instance, the power cycling can be configured to automatically 
change four times a day. During each of these four periods (Time 1, Time 2, Time 3, and 
Time 4), the ON (Time On) and OFF (Time Off) times can be set up to operate at various 
intervals to conserve battery power.  

During the ON time: 

• The selected Control to Toggle is set to ON. 

During the OFF time: 

• The selected Control to Toggle is set to OFF. 

If communications occur during the ON time, the ON time is extended by the idle timeout 
of the communicating device. 

Set a value in the Low Battery Shutoff Voltage field to automatically disable Radio Power 
Control if the input voltage to the device falls below this value. Radio Power Control is 
automatically re-enabled when the input voltage rises to this value.  

To access this screen: 

1. Select Configure > Power Control from the FBxConnect™ main menu. 
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2. Click ▼ in the drop-down list at the top of the display and select an instance to 
configure. 

Figure 370. Power Control 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Set an identifier (up to 20-alphanumeric characters) for the selected 
instance. 

Description Set a description (up to 20-alphanumeric characters) for the selected 
instance. 
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Field Description 

Output Ref Click  to open the point picker dialog and choose an output that 

is controlled by the selected power control instance. 

Power Control 
Enable 

Enables or disables the selected power control instance. 

Communication 
Port Enable 
Option 

Click ▼ to select the communications ports controlled by the 
selected power control instance. 

Power Control 
Status 

This read-only field shows the status of the selected power control 
instance. 

Power Control 
Timer Start 
Time 

Sets the time of day (in hours and minutes, HHMM) that the selected 
power control instance starts. You can configure up to four separate 
Start Times (Time 1, Time 2, Time 3, and Time 4) for each power 
control instance. Each Start Time configuration stays active until the 
next Start Time occurs.  

Note 

The Start Time's Time On and Time Off alternate throughout the 
period the Start Time is active. Enter a non-zero Time On or Time Off 
if you wish power control to remain on or off. 

Power Control 
Timer Duration 

Sets the length of time (in seconds) power control remains on while 
it’s Start Time (Time 1, Time 2, Time 3, and Time 4) is active. 

Power Control 
Timer Off 
Duration 

Sets the length of time (in seconds) power control remains off while 
it’s Start Time (Time 1, Time 2, Time 3, and Time 4) is active. 

4. Select Save to save your changes if you modify any of the fields on this screen. 

4.34  System 

Use the System screen to configure how your FB Series product restores the device 
database after a failure and set the minimum voltage required to power the device. 

To access this screen: 

1. Select Configure > System from the FBxConnect™ main menu. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

950 

Figure 371. System 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

System 
Recovery 
Option 

Sets how the FB Series product restores the device database after a 
failure. Failures can happen for several reasons including static 
electricity, radiation, software issues, etc. Possible recovery options 
are: 
Restore to 
Database 
Defaults 

Restores the FB Series product configuration to the 
original defaults after a failure. 
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Field Description 

Restore 
from Flash 
Config File 

Restores read-only values to the FB Series product 
defaults and read/write values from a configuration 
file previously stored in flash memory of the FB Series 
product (if one exists).  

Note 

If you select this option, you must save a 
configuration file to flash memory. For more 
information, refer to Download to Flash. 

Timestamp 
of Last 
Download 
to Flash 

This read-only field shows the date and time when 
the configuration file for restoring the system was 
loaded to flash memory.  

Note 
When no configuration has been saved to flash, this 
field shows a time of Saturday, January 1, 2000 
12:00:00 AM. 

Delete 
Config from 
Flash 

Select to remove the currently saved configuration 
from flash memory. 

Main Power Click ▼ to set the set the minimum voltage required to power the 
device. Possible options are Solar Supply (powered by solar panel) 
and DC Supply (powered by a DC power supply).  

There are two trip points for the FB3000: a power fail trip point and a 
shutdown trip point. If power drops to the power fail trip point, the 
RTU firmware initiates an orderly shutdown procedure. If power falls 
below that to the shutdown trip point, hardware shuts down 
abruptly. The trip points for each option are as follows: 

Solar Supply 

Power Fail Trip Point = 10.49 V 

Shutdown Trip Point = 10.19 V 

DC Supply 

Power Fail Trip Point = 9.38 V 

Shutdown Trip Point = 8.5 V 

Note 

Because of variation in power measurements, the trip points are 
approximate. 
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Field Description 

Database save 
Params to 
Flash File 

Enables the FB Series product to use memory from the flash file 
system as an extension of the standard database memory. This 
allows certain configuration parameters to be removed from the 
database and stored as files on the FB Series product’s flash file 
system. This setting is useful if the overall product features and 
installed applications exceed the standard database memory 
allocation (as viewed on the Services – Service Info display). 

Note 

If you change this option, you must perform a Warm Start before any 
changes are applied. 

Enable Certain parameters are stored in the flash file system 
resulting in an increase to the available memory of the 
standard database. You may need to enable this 
option when installing large applications or enabling a 
large number of features. 

Note 

Parameters stored in this manner are pre-determined 
and not selectable. These are typically configuration 
parameters of larger data types, such as strings or 
parameter references. The files used to store this data 
are not visible, but they do consume a portion of the 
flash file system (as viewed on the Services – Service 
Info display). 

Disable All parameters are stored in the default standard 
database. Although this limits the amount of memory 
available for the standard database, it is sufficient for 
the majority of configuration scenarios. This is the 
default. 

Note  

If you select Disable after the feature has been 
enabled, then the database is reset to defaults. To 
prevent loss of data, you should save your 
configuration (refer to Upload Solution) and collect 
history (History Report). 
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Field Description 

SysLog Use these fields to configure parameters used to communicate with a 
SysLog server for system management and auditing purposes. 

Note 
If you change the SysLog configuration, you must perform a Warm 
Start before any changes are applied. 

Tag Sets an identifier (up to 20-alphanumeric characters) 
that the FB Series product will use when logging to the 
SysLog server. 

IPv4 IP 
Address 

Enter the IP address of the SysLog server used for 
communications. 

Server IP 
Port 

Enter the TCP/IP port number of the SysLog server 
used for communications. 

SysLog 
Interface 

Click ▼ to set which communications port on the FB 
Series product is used to send messages to the SysLog 
server. Possible options are: 

ETH1 Use Ethernet 1 to send messages to the 
SysLog server. 

ETH2 Use Ethernet 2 to send messages to the 
SysLog server. 

Log 
Diagnostics 

Place a check mark to include diagnostic log 
information when sending messages to the SysLog 
server. 

Log Events Place a check mark to include event log information 
when sending messages to the SysLog server. 

Log Alarms Place a check mark to include alarm log information 
when sending messages to the SysLog server. 

3. Select Save to save your changes if you modify any of the fields on this screen. 

4.35  I/O Bus 

Use the I/O Bus display to configure the polling interval and view statistics for each I/O 
module installed in an FB3000 RTU. 

To access this display: 
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1. Select Configure > I/O Bus from the FBxConnect™ main menu. The I/O Bus display 
opens: 

Figure 372. I/O Bus 

 

2. Click ▼ in the drop-down list at the top of the display to select a I/O bus to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
I/O bus. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
I/O bus. 
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Field Description 

Maximum Size 
of Rack to Poll 

This read-only field shows the maximum number of I/O cards you 
can install.  

Note 

The system auto-detects the size of the rack based on an I/O 
module’s physical slot location. For example, if there is only one I/O 
module and it is installed in slot 19, then system detects the rack size 
as 24. Every extended rack can house a maximum 8 I/O modules.  

Desired 
Interval to 
Poll I/O 

Sets the time the system waits between reads of the I/O modules. 

Note 

This is your desired interval. The actual interval is based on your 
requested interval and the maximum frequency allowed based on 
the number of installed racks. 

Actual 
Interval to 
Poll I/O 

This read-only field shows the actual time the system waits between 
reads of the I/O modules. 

Note 

This time may differ from you desired Interval to Poll I/O. The actual 
interval is based on your requested interval and the maximum 
frequency allowed based on the number of installed racks. 

Statistics These read-only fields show statistical information for the currently 
selected I/O bus. 

Reset Select to zero-out the information contained in the Statistics fields. 

4. Select Save to save your changes if you modify any of the fields on this display. 

4.36 FBxNet 

Use the this display to configure the FB Series product to communicate over FBxNet. 
FBxNet is a peer-to-peer communication network for exchanging data between Emerson 
RTUs and flow computers over Ethernet connections. The network consists of publishers 
and subscribers. You can configure the FB3000 RTU as an FBxNet publisher or FBxNet 
subscriber. 

Note 

For more information about FBxNet, refer to Field Tools Quick Start Guide (D301703X412). 
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To access this display: 

1. Select Configure > FBxNet from the FBxConnect™ main menu. The FBxNet display 
opens. 

Figure 373. FBxNet 

 

2. A tab shows at the top of the display for each communications port that supports 
FBxNet communications. Select the tab corresponding to the communications port 
you want to configure. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
communications port. 
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Field Description 

Port 
Description 

Sets a description (up to 20-alphanumeric characters) for the selected 
communications port. 

FBxNet 
Publisher 

These fields display parameters associated with FBxNet publishers. 

Publisher 
Status 

This read-only field shows if the FB Series device is 
currently configured as an FBxNet publisher. 

Enable 
Read/Write 

Select to enable subscribers to read data from and 
write data to this device. 

Enable Read 
Only 

Select to enable subscribers to only read data from 
this device. 

Disabled Select to prevent subscribers from reading data from 
or writing data to the device. 

Number of 
Subscribers 

This read-only field shows the number of FBxNet 
subscribers configured to receive information from 
the currently connected FB Series product. 

Publisher 
Watchdog 
Timer 

Sets the amount of time, in seconds, that a publisher 
must receive an update from a subscriber before 
determining that the subscriber has stopped 
communication. If this timer expires, any applicable 
fault modes are applied and the subscriber is forced to 
re-authenticate with the publisher.  

Show 
Subscribers 

Select this button to open a pop-up display that 
contains a list of IP addresses belonging to the FBxNet 
subscribers configured to receive information from 
the currently connected FB Series product. 

FBxNet 
Subscriber 

These fields display parameters associated with FBxNet subscribers. 

Subscriber 
Status 

This read-only field shows if the FB Series device is 
currently configured as an FBxNet subscriber. 

Poll Cycle Enables/disables polling for the selected port. 

Connection 
File Parsing 
Status 

This read-only field shows the current parsing status 
of the publisher device’s parameter mapping file. 
Possible status messages include: 

No Error  Parse was successful. 
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Field Description 

File Open 
Fail  

Could not open the file or the file is 
corrupt. 

Column 
Mismatch  

Column of the file is invalid. Can be 
either in the connection or map file. 

Missing 
Required 
Column  

Missing required column. Can be either 
in the connection or map file. 

Too Much 
Data 

The number of entries in the map file 
exceed the number supported. 

Invalid 
Subscriber 
Tag  

There is a subscriber tag in the file that 
is invalid (see diagnostic log for 
details). 

Invalid FBx 
Instance 
Number 

There is an entry in the file that has an 
invalid FBx Instance Number (see 
diagnostic log for details). 

Missing or 
Invalid 
Required 
Value  

One of the values in the FBxData 
columns (i.e., mode, fault value, 
instance number) is missing or invalid 
(see diagnostics log for details). 

Duplicate 
FBx 
Instance 
Number  

There are duplicate entries in the file. 
Each fault handling number must be 
unique. 

Parse Not 
Configured 

There is no connection or map file 
configured for the given port. 

Actual Poll 
Time 

This read-only field shows the time (in seconds) to 
complete the poll. 

Max 
Supported 
Data Points 

This read-only field shows the maximum number of 
data points possible. 

Current In 
Use Data 
Points 

This read-only field shows the number of data points 
currently in use. 

Available 
Data Points 

This read-only field shows the number of data points 
still available to be used. 
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Field Description 

TCP 
Connection 
Timeout 

Sets the number of seconds the subscriber waits for a 
response from a connection request before a timeout 
occurs. 

Receive 
Timeout 

Sets the number of seconds the subscriber waits for a 
response from the publisher after the connection has 
been established. 

Number of 
Retries 

Sets the number of retry attempts when a timeout 
occurs. 

Scan Rate Sets the frequency (in seconds) at which the subscriber 
polls its publishers. 

4. Select Save to save your changes if you modify any of the fields on this display. 
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Section 5: Services Menu 
Use the options in this menu to access utilities and perform maintenance on your FB 
Series product, such as user management, firmware updates, and calibration. 

Figure 374. Services Menu 

 

The Services menu contains the following options: 

Service Info – View information about the connected FB Series product, including the part 
number, application version, and creation date. 

Board Info – Set a name and description for each module installed in your FB Series 
product and view general information for each module. 

Firmware Update – Update the firmware on your FB Series product. 

Warm Start – Perform a warm start on the connected FB Series product. 

Cold Start – Perform a cold start on your FB Series product. 

Calibration – Opens the Calibration Wizard to calibrate various I/O points. 

Plate Change – Opens the Plate Change Wizard which walks you through the steps to 
successfully change the size of an orifice plate under flowing or non-flowing conditions. 

System Power – View battery diagnostics and reset battery timers. 

Time Synch – Use this pop-up display to synchronize the FB Series product clock with your 
PC clock. 

User Management – Add, delete, and modify the user accounts able to log in to the FB 
Series product. 

Security Management – Set a minimum password length and configure the lock out 
functionality. 

Device License – Manage licenses for your device.  

Apply Security File – Use this option to enable DNP3 Secure Authentication version 5 
(SAv5) on the FB Series product.  
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Note 

This appears only if you are physically connected via the USB port. 

Disable Sav5 – Use this option to turn off DNP3 Secure Authentication version 5 (SAv5) on 
the FB Series product. 

Note 

This option appears only after you have enabled SAv5 of the FB Series product and are 
physically connected via the USB port. 

5.1  Service Info 

Use this display to view read-only information about the connected FB Series product, 
including the part number, firmware version, and system resources. 

Note 

The Restart Time field shows the date and time the FB Series product last finished 
rebooting following a restart (warm start, cold start, etc.). Restarts that are not user-
initiated, such as a power failure, are recorded in the Event Log. Refer to Event Report for 
more information about retrieving Event Log data. 

To access this display: 

1. Select Services > Service Info from the FBxConnect™ main menu. The Service Info 
display opens. 
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Figure 375. Service Info 

 

2. Review the values in the following fields: 

Field Description 

Firmware 
Version 

This read-only field shows the version of the firmware installed in 
the FB Series product. 

Firmware 
Creation Date 

This read-only field shows the date and time that the installed 
version of firmware was created. 

Firmware Part 
Number 

This read-only field shows the part number of the installed version 
of firmware. 

Boot Version This read-only field shows the version of the boot firmware 
installed in the FB Series product. 

Boot Creation 
Date 

This read-only field shows the date and time that the installed boot 
firmware was created. 

Boot Part 
Number 

This read-only field shows the part number of the installed boot 
firmware. 
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Field Description 

IFS Version This read-only field shows the version of the initial file system 
installed in the FB Series product. 

IFS Creation 
Date 

This read-only field shows the date and time that the installed 
initial file system was created. 

IFS Part Number This read-only field shows the part number of the installed initial 
file system. 

Restart Time The Restart Time field shows the date and time the FB Series 
product last finished rebooting following a restart (warm start, cold 
start, etc.).  

Note 

Restarts that are not user-initiated, such as a power failure, are 
recorded in the Event Log. Refer to Event Report for more 
information about retrieving Event Log data. 
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Field Description 

Database 
Resources 

These read-only fields represent the status of the system database. 
The database is a shared resource that is common to all FB3000 
functionality. While the memory allocated for the database is 
sufficient for the vast majority of use-cases, caution is advised for 
larger systems. Additional database resources are used whenever 
the number of meters is increased, the number of history points is 
increased, or new I/O modules are installed. The same is true when 
adding applications with user defined objects. When you 
commission a new system, or expand the functionality of an 
existing system, you should review these fields for any areas of 
concern.  

The color of these fields change based on the following conditions: 

• Green = This color shows if the resource usage is between 0-
74%. 

• Orange – This color shows if the resource usage is between 75-
89%. 

• Red – This color shows if the resource usage is between 90-
100%. 

Note 

A red field is not necessarily a problem for operation, but 
increasing the system functionality (additional meters, history, IO, 
applications, etc.) may not be possible. 

Number of 
Small Blocks 

This field shows the current and maximum possible 
usage of “small” data type parameters in the 
database. These parameters are 8 bytes or less in 
size and consist of the following data types: UINT8, 
INT8, UINT16, INT16, UINT32, INT32, UINT64, 
INT64, FLOAT, DOUBLE, ENUM16, BIN8, BIN16, 
BIN32, and TIME. For more information about 
native system data types, refer to Native Data 
Types. 
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Field Description 

Number of 
Medium 
Blocks 

This field shows the current and maximum possible 
usage of “medium” data type parameters in the 
database. These parameters are 10 or 20 bytes in 
length and consist of the following data types: 
UC10 (String 10), UC20 (String 20), and OBJREF. For 
more information about native system data types, 
refer to Native Data Types. 

Number of 
Big Blocks 

This field shows the current and maximum possible 
usage of “Large” (or Big) data type parameters in 
the database. These parameters are 30 bytes or 
greater in length and consist of the following data 
types: UC30 (String 30), UC40 (String 40), BYTE32 
and PRMREF. For more information about native 
system data types, refer to Native Data Types. 

Number of 
Instances 

This field shows the current and maximum possible 
usage of database object instances. For every 
database object, there is at least one instance. For 
most database objects, there are multiple 
instances. The total number of instances (for both 
firmware objects and application objects) must not 
exceed the limit shown here. 

Number of 
Parameter 
References 

This field shows the current and maximum possible 
usage of parameter reference database parameters 
in the database. Parameter reference parameters 

(often represented in FBxConnect™ via a [ ] 

button) are a special type of database parameter 
used throughout the system for pointing to or 
linking to an individual piece of data. Sometimes 
these links are defined by the user and other times 
they are predefined in a fixed manner. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

967 

Field Description 

Number of 
Object 
References 

This field shows the current and maximum possible 
usage of object reference database parameters in 
the database. Object Reference parameters (often 

represented in FBxConnect™ via a [ ] button) are 

a special type of database parameter used 
throughout the system for linking data and groups 
of data together. These references are used to 
point to other related objects. Sometimes these 
links are defined by the user and other times they 
are predefined in a fixed manner. 

System 
Resources 

These fields represent the memory utilization for the system.  

The color of these fields change based on the following conditions: 

• Green = This color shows if the resource usage is between 0-
74%. 

• Orange – This color shows if the resource usage is between 75-
89%. 

• Red – This color shows if the resource usage is between 90-
100%. 

File System This field represents the usage of the FB Series 
product's flash file system. Data stored in flash is 
persistent, meaning it is retained following a power 
cycle or restart. This memory is used for application 
files, protocol files, license files, and other system 
related or user stored files. The contents of the 
flash file system can be viewed via the File Transfer 
display. 

System 
Memory 

This field represents the usage of the FB Series 
product's SDRAM. SDRAM (synchronous DRAM) is 
non-persistent, meaning data is not retained upon 
a power cycle or restart. This memory is used for 
firmware and application execution, variables, 
stacks, and heaps. 

 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

968 

5.2  Board Info 

Use this display to set a name and description for each module installed in your FB Series 
product and view general information for each module. Displayed information includes 
details about the module type, firmware version, and boot code. Each module is assigned 
a number by FBxConnect™, and you can select each module from the drop-down list at 
the top of the display.  

Note 

All flow calculations, alarms, events, and history reside in the main CPU (Module_1). 

The module number assignments are listed below: 

• Module_1 – CPU 

• Module_2 through Module_32 – I/O Cards 

To access this display: 

1. Select Services > Board Info from the FBxConnect™ main menu. The Board Info 
display opens. 
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Figure 376. Board Info (Module 1 - CPU) 

 

2. Click ▼ to select a module from the drop-down list at the top of the display. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
module. 

Description Sets a description (up to 20-alphanumeric characters) for the selected 
module. 

Serial 
Number 

This read-only field shows the serial number assigned to the selected 
module. 

Installed This read-only field shows if the module is installed. 
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Field Description 

Hardware 
Test Date 

This read-only field shows the date and time of the hardware test. 

Module 
Details 

Module Type This read-only field shows the module type. Possible 
options are Unknown, Main CPU, I/O Cards, HMI, On-
Board I/O, Optional I/O, and Expanded I/O. 

Module 
Mode 

This read-only field shows the status of the selected 
module. For more information about possible 
statuses, refer to I/O Configuration – Properties Tab. 

Module 
Subtype 

This read-only field shows the module subtype. 

MPU 
Loading 

This read-only field shows the current MPU loading 
of the system.  

Note 

This field appears only for Module 1 (Main CPU). 

CPU 
Temperature 

This read-only field shows the current temperate of 
the CPU.  

Note 

This field appears only for Module 1 (Main CPU). 

CPU Current 
Value 

This read-only field shows the current value, in mA, 
of the CPU.  

Note 

This field appears only for Module 1 (Main CPU). 

Firmware 
Details 

Firmware 
Description 

This read-only field shows the description for the 
firmware of the selected module. 

Firmware 
Part Number 

This read-only field shows the part number for the 
firmware installed on the selected module. 
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Field Description 

Firmware 
Version 

This read-only field shows the current firmware 
version installed on the selected module. 

Note 

The firmware, boot and IFS version numbers are 
displayed in the following format w.x.y.z  
Where: 

w = major release  
x = minor (feature) release  
y = issue release 
z = build number 

Firmware 
Creation 
Date 

This read-only field shows the date and time the 
current firmware version was created. 

Boot Details Boot Part 
Number 

This read-only field shows the part number for the 
boot installed on the selected module. 

Boot Version This read-only field shows the current boot version 
installed on the selected module. 

Boot 
Creation 
Date 

This read-only field shows the date and time the 
current boot version was created. 

Configuration 
Details 

Low Power 
Option 

This read-only field shows if the low power mode is 
available.  

Note 

This field appears only for Module 1 (Main CPU). 

Ethernet 
Support 

This read-only field shows if Ethernet support is 
available. 

Note 

This field appears only for Module 1 (Main CPU). 

IFS Version IFS Version This read-only field shows the current IFS version 
installed on the selected module. 

IFS Part 
Number 

This read-only field shows the part number for the 
IFS installed on the selected module. 

IFS Creation 
Date 

This read-only field shows the date and time the 
current boot version was created. 
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Field Description 

Personality 
Module 

Personality 
Module 
Status 

This read-only field shows the status of the 
personality module installed for the selected module. 

Personality 
Module Type 

This read-only field shows the type of personality 
module installed for the selected module. 

Personality 
Module 
Serial 
Number 

This read-only field shows the serial number of the 
personality module installed for the selected module.  

Personality 
Module 
Calibration 
Date 

This read-only field shows the date and time the 
personality module was calibrated by the factory. 

4. Select Save to save any changes you make to this display. 

5.3  Firmware Update 

Use this option to update the firmware on your device. The firmware update functionality 
is used for updates to the main CPU application firmware, as well as the firmware for any 
of the expansion or accessory boards (HMI Module, expanded I/O, etc.).  

Note 

• Firmware updates and versions are audited in the Event log via the following events: 
Firmware Update Start, Firmware Update Complete, Firmware Apply Image Version, 
and Firmware Apply Package Version. 

• The FB Series product continues to operate as normal while firmware is being 
downloaded. Once the firmware download is complete, the FB Series product goes 
offline, applies the downloaded firmware, and restarts. 

• For a list of possible firmware update error codes and their solutions, refer to 
Firmware Update Error Codes. 

To access this screen: 

1. Select Services > Firmware Update from the FBxConnect™ main menu. The Firmware 
Update screen opens. 
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Note 

To prevent loss of data, perform steps 1 and 2 prior to updating firmware. 

Figure 377. Firmware Update 

 

2. Select Solution Upload to save application and configuration data from your FB 
Series product to your PC. The Solution Upload display opens. For more information, 
refer to Upload Solution. 

3. Select History Report to generate a report from the periodic history data stored in 
your FB Series product. The History Report display opens. For more information, refer 
to History Report. 

4. Place a check mark next to each module slot number you want to update. Module slot 
numbers without a check mark will not be updated. 
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Note 

The current firmware version number installed in the module and the module type are 
shown next to each module slot number. 

5. Select Firmware Update. The Firmware download display opens. 

6. Select Browse... to open a file explorer window. 

7. Navigate to the location on your PC of the firmware file and select Open. 

Figure 378. Firmware Update 

 

8. A firmware package may contain multiple firmware components. Place a check mark 
in the Selected column of the firmware you want to download. 

9. Place a check mark next to Download even if unchanged to update the firmware 
even if it is the same version already in the device. 

10. Place a check mark next to Time Synch device after the download to synchronize 
the device clock with your PC clock after the firmware update is complete. 

11. Select Start to begin the firmware update process. A dialog opens showing the 
SHA256 and MD5 Hash values of the firmware package. 
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Figure 379. Hash Values Dialog 

 

12. After confirming the hash values of the package, select Yes to begin the firmware 
update. A progress bar shows you the status of the update process. 

Note 

• Place a check mark next to Do not show hash values again to prevent FBxConnect™ 
from showing the hash values dialog during future firmware updates. To show this 
dialog again after turning it off, refer to the Settings menu in Field Tools. 

• A warning dialog opens if you attempt to download an older version of firmware to 
the FB Series device. Some features and parameters may not be present in older 
versions of firmware. Downgrading firmware may result in the loss of history records 
and configuration. Select Yes to continue or No to cancel the download. If you 
continue, you must perform a cold start and clear history after the download 
completes. 
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Figure 380. Status 

 

13. A status message displays saying the firmware update has completed. Select Close to 
return to the Firmware Update screen. 

Figure 381. Firmware Update Completed 
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5.3.1 Firmware Update Error Codes 

An error code appears if you encounter problems updating the firmware on your FB 
Series product. Possible error codes and the steps you can take to correct the errors are 
listed below: 

• Error Code: 18 – The device has received too much data which cannot process 

The device flash file system likely does not have sufficient space to download and 
manage the new firmware image. Review the contents of the flash file system for 
items that can be manually removed to free up more space. 

• Error Code: 206 – The CRC check of the package file has failed 

The firmware image downloaded to the FB Series product is incorrect for the device 
type or has otherwise become corrupted. Contact your local Emerson representative 
for a new version of the file. 

• Error Code: 207 – File system error occurred during firmware update 

There was a problem when opening or writing files on the FB Series product's flash 
file system. Power cycle the FB Series device to free up resources for the process to 
complete successfully.  

Note 

You must power cycle the FB Series product to restart the operating system. The 
operating system does not restart during a warm start or cold start. 

• Error Code: 208 – File system write failure during firmware update 

The device flash file system likely does not have sufficient space to unzip and manage 
the new firmware image. Review the contents of the flash file system for items that 
can be manually removed to free up more space. 

Note 

You can view the status of the system database in the Database Resources fields on 
the Services > Service Info display.  

5.4  File Transfer 

Use this pop-up display to upload a file from the FB Series product to your computer, 
download a file from your computer to the FB Series product, or delete a file from the FB 
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Series product. This display is mainly used by developers to verify files that are 
transferred to and from the FB Series product programmatically. 

To access this display: 

1. Select Services > File Transfer. The File Transfer pop-up display opens. 

Figure 382. File Transfer 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Device folders 
and files 

This frame shows the file tree of the FB Series product. 

Upload file 
from device 

Use these fields to transfer a file from your FB Series product to your 
computer. 

Destination This field shows the folder location on your computer 
to save the uploaded file. The default location is 
C:\Users\Public\Documents\Emerson. To choose a 
different folder, select Browse to open a Browse For 
Folder window and navigate to a location on your 
computer to save the file. 
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Field Description 

Select file 
from tree 

Select this radio button to choose a file to upload to 
your computer by selecting it from the file tree on the 
left side of the display. 

Specify 
device file 
path 

Select this radio button to choose which file to upload 
to your computer by manually entering the file path. 

Upload 
from device 

Select this button to transfer the chosen file from you 
FB Series product to the destination on your 
computer. 

Download file 
to device 

Use these fields to transfer a file from your computer to your FB 
Series product. 

Select file This field shows the file path on your computer of the 
file to transfer to the FB Series product. Select Browse 
to open a window and navigate to the desired file. 

Download 
to device 

Select this button to transfer the file specified in the 
Select file field from your computer to your FB Series 
product. 

Delete file 
from device 

Select a file from the file tree on the left side of the display and select 
Delete from device to permanently remove the file from the FB 
Series product. 

Note 

You cannot delete files from the FB Series product that are required 
for operation. 

3. Select Close to exit the File Transfer pop-up display. 

5.5  Warm Start 

Use this option to force the FB Series product to perform a warm start. A warm start 
resets the FB Series product's processor and restarts all tasks. Database values are not 
reset to default. 
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Note 

When a warm start occurs, the system logs a System Restart event to the Event log. 
Additionally, the system logs a System Down event along with the number of seconds 
that the system was offline. 

To perform a warm start: 

1. Select Services > Warm Start from the FBxConnect™ main menu. A confirmation 
dialog displays. 

Figure 383. Warm Start Confirmation Dialog 

 

2. Select Yes to perform a warm start on the connected FB Series product. The system 
resets the processor and displays the following dialog. 

Figure 384. Warm Start In Progress 

 

3. Select Close and wait for the FB Series product to restart or wait for the FB Series 
product to restart and the dialog automatically closes. 
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5.6  Cold Start 

Use this option to force the FB Series product to perform a cold start. You can configure 
the actions a cold start performs including clearing of alarm, event, and history logs. You 
can also configure if the FB Series product parameters are restored using previously 
saved values or reset to default values (configured on the System display).  

Note 

When a cold start occurs, the system logs a System Restart event to the Event log. 
Additionally, the system logs a System Down event along with the number of seconds 
that the system was offline. 

To perform a cold start: 

1. Select Services > Cold Start from the FBxConnect™ main menu. The Cold start 
options display opens. 

Figure 385. Cold Start Options 

 

2. Select the radio button next to your desired database initialization option. Possible 
options are: 

• Leave database unchanged – No changes are made to the read/write 
parameters. 
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• Database is re-initialized with factory defaults – The read/write parameters 
restored to factory defaults. 

Note 

This option clears Alarm, Event, and History logs, any stored calibration reports, 
and any stored custom reports and custom report templates. 

• Configuration restored from FLASH – The read/write parameters are restored 
from a configuration stored in flash memory of the FB Series product. 

Note 

This option is only available if you have previously saved a configuration file to 
flash memory. For more information, refer to Download to Flash. 

3. Place a check mark next to the additional actions you want the system to perform 
during the cold start. Possible options are: 

• Clear alarm log – Deletes all entries in the alarm log, and logs an Alarm Clear 
event to the Event log. 

• Clear event log – Deletes all entries in the event log, and logs an Event Clear 
event to the Event log. 

• Clear history – Deletes all entries in the history log, any stored custom reports, 
and logs a History Clear event to the Event log. 

• Clear users – Deletes all user log on information. 

• Reset I/O modules – Restarts the firmware in the I/O modules. Module 
configuration remains unchanged. 

• Clear applications – Removes all installed applications. 

• Clear user calibration – Removes any previous input point calibration and 
restores the factory defaults. Deletes any stored calibration reports 

• Clear user protocol maps – Removes any custom DNP3 or Modbus maps and 
restores the factory defaults. 

• Clear Totals and Averages – Deletes all station and meter totals and averages. 

4. Select OK to perform the cold start using the selected options. The following dialog 
displays. 
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Figure 386. Cold Start In Progress 

 

5. Select Close and wait for the FB Series product to restart or wait for the FB Series 
product to restart and the dialog automatically closes. 

5.7  Calibration 

Use the Calibration Wizard to calibrate various input points on your FB Series product, 
verify a current calibration, or set the zero shift. You can perform a calibration in one of 
two ways: By Meter and By Point. Calibration By Meter allows you to calibrate all inputs 
for a specific meter. Calibration By Point allows you to calibrate a specific I/O point.  

The test equipment used to perform a calibration should be at least three times more 
accurate than the device being calibrated. You may actually achieve better results with 
the factory default calibration, rather than narrowing the calibrated span using 
equipment that is only accurate to +/- 1%.  

In some instances, it may be more meaningful to simply verify an existing calibration 
instead of performing a complete calibration. If the existing calibration is good, then 
there is no need to spend unnecessary time and risk replacing a good calibration with a 
bad calibration.  

Note 

• Often, performing a zero shift will account for out of tolerance readings and a full 
calibration is not required. 

• The default location for calibration reports is 
C:\ProgramData\Emerson\OpenEnterprise\FBx\Reports\Calibration. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

984 

To open the Calibration Wizard, select Services > Calibration from the FBxConnect™ 
main menu. The Calibration Wizard displays. 

Figure 387. Calibration Wizard 

 

For more information, refer to the following topics: 

BLM Required Information – Configure information included on calibration reports 

required by the Bureau of Land Management (BLM). 

Calibrating Inputs – Calibrate analog inputs, static pressure inputs, differential pressure 
inputs, and remote temperature devices. 

Verifying a Calibration – Verify the calibration for analog inputs, static pressure inputs, 
differential pressure inputs, and remote temperature devices. 

Setting Zero Shift – Use the Zero Shift to set a value (offset) to compensate for any slight 
errors in your input readings. 

Resetting a Calibration – Use this option to clear a previous calibration and restore the 
factory defaults. 
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Viewing a Calibration Report – Follow these steps to view a previously generated 
calibration report. 

Calibration Errors – Possible errors you may encounter during the calibration process. 

5.7.1 BLM Required Information 

Use this pop-up display to configure information included on calibration reports required 
by the Bureau of Land Management (BLM). FBxConnect™ stores BLM information on your 
PC, and unique BLM information is associated with each device connection in Field Tools. 
If the BLM information is similar between device connections, you can copy information 
associated with a device connection into the current calibration report. 

Note 

For more information about device connections, refer to the "Using the Connections List 
Pane" topic in Field Tools' online help file. 

To access this display: 

1. Select Services > Calibration from the FBxConnect™ main menu.  

2. Select the meter you wish to calibrate. 

3. Place a check mark next to Generate report in the Calibration Report frame to have 
FBxConnect™ create a calibration report that details the calibration results. 

4. Place a check mark next to Add BLM Information in the Calibration Report frame to 
have FBxConnect™ include Bureau of Land Management information on the 
calibration report. 

5. Select Next. The BLM Required Information display opens. 
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Figure 388. BLM Required Information 

 

6. Review – and change as necessary – the values in the following fields: 

Field Description 

Enable Load 
Parameters 

Select this checkbox to enable the Select Connection drop-down, the 
Load BLM Parameters button, and checkboxes next to each field to 
be copied from BLM information associated with a device connection 
to this calibration report. 

Note 

To enable this checkbox, you must have previously created a 
calibration report containing BLM information on this PC for the 
device. 

Select 
Connection 

Select ▼ to choose a device connection associated with the BLM 
information you want to copy to the current calibration report. 

Note 

For information to be successfully copied from a device connection, 
you must have previously created a calibration report containing 
BLM information on this PC for the device you select in the Select 
Connection drop-down. 
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Field Description 

Load BLM 
Parameters 

Select to copy BLM information associated with the device connection 
you select in the Select Connection drop-down to the current 
calibration report. 

Note 

For information to be successfully copied from a device connection, 
you must have previously created a calibration report containing 
BLM information on this PC for the device you select in the Select 
Connection drop-down. 

Meter 
Information 

Enter information about the meter being inspected. 

Calibration 
Equipment 
Information 

Enter information about the equipment used in the calibration 
process. 

Tester 
Information 

Enter information about the person who is performing the calibration 
process. 

Witness 
Information 

Enter information about the person who is observing the calibration 
process. 

Transducer 
Information 

Enter information about the differential pressure, static pressure, and 
temperature sensors. 

Note 

The LRL (Lower Range Limit) and URL (Upper Range Limit) columns 
display only if you select analog inputs for use as meter inputs. 

7. Select Save to save any changes you make to this pop-up display. 

5.7.2 Calibrating Inputs 

Follow these steps to calibrate analog inputs, static pressure inputs, differential pressure 
inputs, and remote temperature devices. During the calibration process, you can create a 
calibration report to keep a record of your calibration. The default location for calibration 
reports is C:\ProgramData\Emerson\OpenEnterprise\FBx\Reports\Calibration. 

Note 

• Performing a calibration clears the current zero shift setting. 

• You cannot calibrate a 4088B if the Transmitter Security switch on the device is 
enabled. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

988 

• HART inputs only support freezing and unfreezing the input value. 

• The 4088B provides range checking on input values. The calibration process fails if the 
input values deviate to an extent that would degrade sensor performance. Use an 
input source that is at least three times more accurate than the transmitter and allow 
the input to stabilize for 10 seconds before entering any values. 

• If you have a 4088B and click Cancel at any time during the calibration process, you 
must start the calibration process over from the beginning. 

• If you still have trouble calibrating a 4088B, power cycle the 4088B and try the 
calibration again. 

To calibrate an input: 

1. Select Services > Calibration from the FBxConnect™ main menu. The Calibration 
Wizard opens. 

Figure 389. Calibration Wizard 
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2. In the Calibration Selection field, select By Meter to group all inputs together for a 
specific meter, By Point to group all inputs together by input type, or By MVS to 
group inputs by 4088 instance. 

Note 

• The process is the same for each Calibration Selection option. The only difference 
is how each input is grouped. This example shows By Meter in the Calibration 
Selection field. 

• If you select By Meter in the Calibration Selection field, select a meter and the 
system automatically selects the meter inputs. 

• If you select By Point in the Calibration Selection field, place a check mark next to 
one or more inputs. 

• If you select By MVS in the Calibration Selection field, select the communications 
port connected to the MVS and select the 4088 instance. The system automatically 
selects the inputs of the 4088 instance. 

3. Select  next to the type of meter you want to calibrate to show all available meters 
of that type. 

4. Select a meter to calibrate. 

5. Place a check mark next to Generate report in the Calibration Report frame if you 
want FBxConnect™ to create a calibration report. 

6. Place a check mark next to Add BLM Information in the Calibration Report frame if 
you want FBxConnect™ to include Bureau of Land Management information on the 
calibration report. 

7. Select a format for the generated report in the Format field. Possible options are CSV 
or PDF. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the 
Secure PDF box and entering a password. 

8. The calibration report is saved to a default location on your PC. If you want to save the 
report to a different location, select Browse and navigate to your desired location. 
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Note 

FB3000 RTUs with firmware version 2.15 or later also save CSV versions of the 
previous five calibration reports to internal memory. The reports are stored in the 
"/user/calibration" folder using the following naming convention: 
Calibration_Report_D[YYYYMMDD]-T[hhmmss].csv. 

9. Select View to open a saved calibration report. This is useful to compare previous 
calibration values against the current values. 

10. Select Next. 

11. If you selected BLM Info option, enter the required BLM information and select Save 
and Continue to Calibration.  

Note 

For more information, refer to BLM Required Information. 

12. The Calibration Wizard shows all inputs associated with the selected meter (or the 
selected channel). 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

991 

Figure 390. Freeze 

 

13. Select Freeze to freeze all inputs listed in the table and stop the values from being 
updated during the calibration process. 

Note 

If you selected the BLM Report option, select Modify BLM Info to open the BLM 
Required Information display and revise any report information. 
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Figure 391. Calibrate 

 

14. Select the input you want to calibrate and select Calibrate. 

15. For the selected input, disconnect the field sensor and connect a decade box (or 
comparable equipment) to the terminals of the device. 

Note 

You can also use a pocket current source or another deadweight test input source to 
test this value. 

16. Set the test equipment to produce a value equal to zero. 

17. Enter the value produced by the test equipment in the Tested Value field and select 
Apply. 
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Figure 392. Set Zero 

 

Field Description 

Selected I/O 
Point 

This read-only field shows the name of the currently selected input. 

Calibration 
Status 

This read-only field shows the current calibration status. 

Input Health 
Status 

This read-only field shows the current operating status of the 
selected channel. 

Action Grid This grid reflects the calibration commands that have been 
performed on the selected input. 

Action Indicates the current action and shows any previous 
actions you have taken. 

As Found This read-only field shows the value of the input 
before any adjustments have been applied. 

As Left This read-only field shows the value entered in the 
Tested Value field. 
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Field Description 

Deviation This read-only field shows the amount of deviation 
between the As Found and As Left values. 

Deviation 
% 

This read-only field shows a percentage deviation 
between the As Found and As Left values. 

Tested Value Enter the value produced by the test equipment. 

Live Value This read-only field shows the current value of the input. 

Zero Shift This read-only field shows the current Zero Shift value applied to the 
input. 

Deviation This read-only field shows a percentage deviation between the 
Tested Value and Live Value fields. 

Apply Select to log the value entered in the Tested Value field. 

Finish Select to end the current calibration process. 

Cancel Select to exit the Calibration Wizard and restore the previous 
calibration. 

18. Set your test equipment to produce a value for the span. 

19. Enter the value produced by the test equipment and select Apply. 
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Figure 393. Set Span 

 

Note 

A calibration requires only two points (zero and span). Your organization determines 
whether additional points (up to five) are necessary for a calibration.  

20. After you are done entering midpoint values, select Finish. 
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Figure 394. Set Midpoint 1 

 

21. Select Save if you are satisfied with the calibration. 
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Figure 395. Calibration Summary 

 

22. Select OK to close the dialog and return to the Select Operation display. 

Figure 396. Calibration Completed 

 

23. You can now perform a verification (Verifying a Calibration) or set the offset (Setting 
Zero Shift) of the input. Select Back to exit the Calibration Wizard.  
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Figure 397. Calibration Wizard 

 

24. If you selected to include BLM Info on your calibration report, a BLM Remarks display 
opens. Enter any additional information to be included in the report. 

Figure 398. BLM Remarks 

 

25. Select OK when you are finished to create your calibration report. 
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5.7.3 Verifying a Calibration 

Use this process to verify that the input is within operating limits. Typically, you verify the 
same points you calibrate. Temperature might be an example (–100, 200, 50). For each 
test point, you set your test equipment to produce a certain value, enter that value in the 
Tested Value field, wait for the live input to stabilize, and then log the value. You can verify 
up to seven verification points. 

Note 

If the value is incorrect, calibrate the input. 

To verify an input: 

1. Select Services > Calibration from the FBxConnect™ main menu. The Calibration 
Wizard displays. 

Figure 399. Calibration Wizard 
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2. In the Calibration Selection field, select By Meter to group all inputs together for a 
specific meter, By Point to group all inputs together by input type, or By MVS to 
group inputs by 4088 instance. 

Note 

• The process is the same for each Calibration Selection option. The only difference 
is how each input is grouped. This example shows By Meter in the Calibration 
Selection field. 

• If you select By Meter in the Calibration Selection field, select a meter and the 
system automatically selects the meter inputs. 

• If you select By Point in the Calibration Selection field, place a check mark next to 
one or more inputs. 

• If you select By MVS in the Calibration Selection field, select the communications 
port connected to the MVS and select the 4088 instance. The system automatically 
selects the inputs of the 4088 instance. 

3. Select  next to the type of meter you want to calibrate to show all available meters 
of that type. 

4. Select a meter to calibrate. 

5. Place a check mark next to Generate report in the Calibration Report frame if you 
want FBxConnect™ to create a calibration report. 

6. Place a check mark next to Add BLM Information in the Calibration Report frame if 
you want FBxConnect™ to include Bureau of Land Management information on the 
calibration report. 

7. Select a format for the generated report in the Format field. Possible options are CSV 
or PDF. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the 
Secure PDF box and entering a password. 

8. The calibration report is saved to a default location on your PC. If you want to save the 
report to a different location, click Browse and navigate to your desired location. 
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9. Select View to open a saved calibration report. This is useful to compare previous 
calibration values against the current values. 

10. Click Next. 

11. If you selected BLM Info option, enter the required BLM information and select Save 
and Continue to Calibration.  

Note 

For more information, refer to BLM Required Information. 

12. The Calibration Wizard displays all inputs associated with the selected meter. 

Figure 400. Freeze 

 

13. Select Freeze to stop the values from being updated during the calibration process. 
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Figure 401. Verify 

 

14. Select the input you want to verify and select Verify. 
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Figure 402. Set Verification Point 1 

 

Field Description 

Selected I/O 
Point 

This read-only field shows the name of the currently selected input. 

Calibration 
Status 

This read-only field shows the current calibration status. 

Input Health 
Status 

This read-only field shows the current operating status of the 
selected channel. 

Action Grid This grid reflects the calibration commands that have been 
performed on the selected input. 

Action Indicates the current action, and shows any previous 
actions you have taken. 

Expected This read-only field shows the value of the input 
before any adjustments have been applied. 

Actual This read-only field shows the value entered in the 
Tested Value field. 
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Field Description 

Deviation This read-only field shows the amount of deviation 
between the As Found and As Left values. 

Deviation 
% 

This read-only field shows a percentage deviation 
between the As Found and As Left values. 

Tested Value Enter the value produced by the test equipment. 

Live Value This read-only field shows the current value of the input both with 
and without the Zero Shift applied. 

Zero Shift This read-only field shows the current Zero Shift value applied 
to the input. 

Deviation This read-only field shows a percentage deviation between the 
Tested Value and Live Value fields both with and without the Zero 
Shift applied. 

Apply Click to log the value entered in the Tested Value field. 

Finish Click to end the current calibration process. 

Cancel Click to exit the Calibration Wizard and restore the previous 
calibration. 

15. Set the test equipment to produce a value equal to the desired verification point. 

16. Enter the value produced by the test equipment and click Apply. 
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Figure 403. Set Verification Point 2 

 

17. Repeat the previous two steps for as many verification points as are required 
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Figure 404. Finish 

 

18. After you are done entering verification points, click Finish. A summary of the 
verification displays. 
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Figure 405. Verification Summary 

 

19. Click Done to exit the Calibration Wizard. 

Figure 406. Verification Confirmation 

 

20. Click OK to exit the dialog to return to the Select Operation display. 

21. You can now perform a new calibration (Calibrating Inputs) or set the offset (Setting 
Zero Shift) of the input. Select Back to exit the Calibration Wizard.  
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Figure 407. Calibration Wizard 

 

22. If you selected to include BLM Info on your calibration report, a BLM Remarks display 
opens. Enter any additional information to be included in the report. 

Figure 408. BLM Remarks 

 

23. Select OK when you are finished to create your calibration report. 
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5.7.4 Setting Zero Shift 

Use the Zero Shift to eliminate any bias that has shifted the calibration curve, such as 
static pressure effect on differential pressure or ambient temperature effect. 

Note  

• HART inputs only support freezing and unfreezing the input value.  

• Performing a calibration clears the current zero shift setting. 

To set the zero shift: 

1. Select Services > Calibration from the FBxConnect™ main menu. The Calibration 
Wizard displays. 

Figure 409. Calibration Wizard 

 

2. In the Calibration Selection field, select By Meter to group all inputs together for a 
specific meter, By Point to group all inputs together by input type, or By MVS to 
group inputs by 4088 instance. 
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Note 

• The process is the same for each Calibration Selection option. The only difference 
is how each input is grouped. This example shows By Meter in the Calibration 
Selection field. 

• If you select By Meter in the Calibration Selection field, select a meter and the 
system automatically selects the meter inputs. 

• If you select By Point in the Calibration Selection field, place a check mark next to 
one or more inputs. 

• If you select By MVS in the Calibration Selection field, select the communications 
port connected to the MVS and select the 4088 instance. The system automatically 
selects the inputs of the 4088 instance. 

3. Select  next to the type of meter you want to calibrate to show all available meters 
of that type. 

4. Select a meter to calibrate. 

5. Place a check mark next to Generate report in the Calibration Report frame if you 
want FBxConnect™ to create a calibration report. 

6. Place a check mark next to Add BLM Information in the Calibration Report frame if 
you want FBxConnect™ to include Bureau of Land Management information on the 
calibration report. 

7. Select a format for the generated report in the Format field. Possible options are CSV 
or PDF. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the 
Secure PDF box and entering a password. 

8. The calibration report is saved to a default location on your PC. If you want to save the 
report to a different location, click Browse and navigate to your desired location. 

9. Select View to open a saved calibration report. This is useful to compare previous 
calibration values against the current values. 

10. Click Next. 
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11. If you selected BLM Info option, enter the required BLM information and select Save 
and Continue to Calibration.  

Note 

For more information, refer to BLM Required Information. 

12. The Calibration Wizard displays all inputs associated with the selected meter. 

Figure 410. Freeze 

 

13. Select Freeze to stop the values from being updated during the calibration process. 
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Figure 411. Set Zero Shift 

 

14. Select the input you want to calibrate and select Set Zero Shift. 
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Figure 412. Set Zero Shift Value 

 

15. Select the Calculate Zero Shift Value button to automatically fill in the Enter Shift 
Value field with a value that offsets the current Live Value field, so it is equal to zero.  

Note  

You can also manually enter a value in the Enter Shift Value field. 
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Figure 413. Zero Shift Applied 

 

16. Select Apply to set the Zero Shift Value. 
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Figure 414. Zero Shift Applied 

 

17. Click Back to exit the display. A confirmation dialog displays. 

Figure 415. Confirmation Dialog 

 

18. Click OK to exit the dialog and return to the Select Operation display. 

19. You can now perform a verification (Verifying a Calibration) of the input. Select Back 
to exit the Calibration Wizard.  



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

1016 

Figure 416. Calibration Wizard 

 

20. If you selected to include BLM Info on your calibration report, a BLM Remarks display 
opens. Enter any additional information to be included in the report. 

Figure 417. BLM Remarks 

 

21. Select OK when you are finished to create your calibration report. 
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5.7.5 Resetting a Calibration 

Use this option to clear a previous calibration and restore the factory defaults.  

To reset a calibration: 

1. Select Services > Calibration from the FBxConnect™ main menu. The Calibration 
Wizard displays. 

Figure 418. Calibration Wizard 

 

2. In the Calibration Selection field, select By Meter to group all inputs together for a 
specific meter, By Point to group all inputs together by input type, or By MVS to 
group inputs by 4088 instance. 

Note 

• The process is the same for each Calibration Selection option. The only difference 
is how each input is grouped. This example shows By Meter in the Calibration 
Selection field. 
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• If you select By Meter in the Calibration Selection field, select a meter and the 
system automatically selects the meter inputs. 

• If you select By Point in the Calibration Selection field, place a check mark next to 
one or more inputs. 

• If you select By MVS in the Calibration Selection field, select the communications 
port connected to the MVS and select the 4088 instance. The system automatically 
selects the inputs of the 4088 instance. 

3. Select  next to the type of meter you want to reset calibration data for to show all of 
the available meters of that type. 

4. Select a meter to reset. 

5. Select Restore Factory Defaults: 

• If you selected By meter in the Calibration Selection field, the system resets the 
inputs configured for the selected meter to factory defaults values.  

• If you selected By point in the Calibration Selection field, the system resets the 
selected input channel(s) to factory default values. 

• If you selected By MVS in the Calibration Selection field, the system resets the 
inputs configured for the selected MVS instance to factory default values. 

6. FBxConnect™ restores the factory default calibration and displays a confirmation 
dialog. 

Figure 419. Confirmation 

 

7. Select OK to close the dialog. 

5.7.6 Viewing a Calibration Report 

Follow these steps to view a previously generated calibration report.  

To view a calibration report: 
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1. Select Services > Calibration from the FBxConnect™ main menu. The Calibration 
Wizard displays. 

Figure 420. Calibration Wizard 

 

2. Select View. A window opens showing the default location for calibration reports. 
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Figure 421. Default Calibration Report File Location 

 

3. Select the report you want to view and select Open to view the calibration report. 

Figure 422. Calibration Report Example 
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5.7.7 Calibration Errors 

When calibrating your equipment, you may encounter a variety of errors based on your 
selected calibration point. Refer to the following error descriptions for each I/O type. 

Analog Input (AI) Calibration Errors 

4088B Calibration Errors 

215 MultiVariable ™ Sensor Calibration Errors 

5.7.7.1 Analog Input (AI) Calibration Errors 

The following list provides possible errors you may encounter while calibrating an analog 
input (AI). 

Bit Error Description 

No Bit Set Calibration Not In Progress Set when no calibration is performed. 

0 Input Frozen Set when a live value is frozen. 

1 Calibration In Progress Set after the Start Calibration command is 
issued and remains until the Save or Cancel 
command is issued. 

2 Reserved Not used. 

3 Set Command Failed Set when the last command failed due to 
an error. 

4 Timeout Occurred Set when the calibration has timed out due 
to inactivity. 

5 Span Too Small Not used. 

6 Excess Correction Set when the slope of applied value is out 
+/- 5% of range limits. 

7 Passed Parameter Too 
Small 

Not used. 

8 Passed Parameter Too 
Large 

Not used. 

9 Ideal Value Too Small Not used. 

10 Ideal Value Too Large Not used. 
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Bit Error Description 

11 Wrong Command This error is set for the following reasons: 

• The channel is disabled. 

• The module is in point fail due to 
communication failure or termination 
missing. 

• The last command issued is not as per 
calibration command sequence. 

12 Verification In Progress When verification is in progress. 

 

5.7.7.2 4088B Calibration Errors 

The following list provides possible errors you may encounter while calibrating a 4088B. 

Bit Error Description 

No Bit Set Calibration Not In Progress Set when no calibration is performed. 

0 Input Frozen Set when a live value is frozen. 

1 Calibration In Progress Set after the Start Calibration command is 
issued and remains until the Save or Cancel 
command is issued. 

2 Reserved Not used. 

3 Set Command Failed This error is set for the following reasons: 

• 4088 Polling is disable. 

• The command failed due to a 

• Communications error during 
calibration. 

Or when one of the following exceptions is 
returned from 4088B: 

• Illegal command or value 

• Slave fail or busy 

• Transmitter sensor error 

• Write protect switch ON 

• Out of sensor limits 
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Bit Error Description 

• Measurement in point fail 

• Transmitter in communication failure. 

4 Timeout Occurred Set when the calibration has timed out due 
to inactivity. 

5 Span Too Small Set when one of the following exceptions is 
returned from the 4088B: 

• Span less than zero 

• Midpoint less than zero 

6 Excess Correction Not used. 

7 Passed Parameter Too 
Small 

Not used. 

8 Passed Parameter Too 
Large 

Not used. 

9 Ideal Value Too Small Not used. 

10 Ideal Value Too Large Not used. 

11 Wrong Command Set when one of the following exceptions is 

returned from 4088B: 

• Measurement not supported 

• Calibration already in progress 

• Measurement in simulation 

• Invalid calibration sequence 

• Invalid command 

12 Verification In Progress When verification is in progress. 

 

5.7.7.3 215 MultiVariable™ Sensor Calibration Errors 

The following list provides possible errors you may encounter while calibrating the 
integral 215 MultiVariable™ Sensor. 

Bit Error Description 

No Bit Set Calibration Not In Progress Set when no calibration is performed. 

0 Input Frozen Set when a live value is frozen. 
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Bit Error Description 

1 Calibration In Progress Set after the Start Calibration command is 
issued and remains until the Save or Cancel 
command is issued. 

2 Reserved Not used. 

3 Set Command Failed Set when the last command failed due to 
an error or point fail. 

4 Timeout Occurred Set when the calibration has timed out due 
to inactivity. 

5 Span Too Small Set when the Span is less than zero, the 
Midpoint is less than zero, or the difference 
of span and zero is less than the minimum 
span. 

6 Excess Correction Set when the slope of applied value is out 
+/- 5% of range limits. 

7 Passed Parameter Too 
Small 

DP/SP 

Set when the value is less than Lower 
range limit. 

RTD 

Set when the value < LRL+5% of LRL. 

8 Passed Parameter Too 
Large 

DP/SP 

Set when the value is greater than Upper 
range limit. 

RTD 

Set when the value > URL+5% of URL. 

9 Ideal Value Too Small DP/SP 

Set when the value is less than LRL+ 5% of 
LRL. 

RTD 

Not used. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

1025 

Bit Error Description 

10 Ideal Value Too Large DP/SP 

Set when the value is greater than URL+ 5% 
of 

URL. 

RTD 

Not used. 

11 Wrong Command Set when the last commend issued is not as 
per calibration command sequence. The 
channel is disabled. 

12 Verification In Progress When verification is in progress. 

 

5.8  Plate Change 

The Plate Change Wizard allows you to change the size of an orifice plate under flowing or 
non-flowing conditions. 

To perform a plate change: 

1. Select Services > Plate Change from the FBxConnect™ main menu. The Plate Change 
Wizard display opens. 
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Figure 423. Plate Change Wizard - Select Meter 

 

2. Select ▼ to choose the meter with the plate you want to change and select Next. 

Note  

For meters with inputs assigned to a HART input, HART inputs must be enabled and 
configured with a Poll Mode set to either PV only or All Process. 
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Figure 424. Plate Change Wizard - Flowing Conditions 

 

3. Select Yes if the plate change occurs during flowing conditions. You will be allowed to 
freeze the inputs for the duration of the Plate Change process. Select Next and 
proceed to step 5. 
or 
Select No if the plate change occurs during non-flowing conditions. Select Next and 
proceed to step 4. 
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Figure 425. Plate Change Wizard - Meter Shut-In 

 

4. Select Yes if the meter is shut-in. Select Next and proceed to step 6. 
or 
Select No if the meter is not shut-in. Select Next and proceed to step 9. 
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Figure 426. Plate Change Wizard - Next When Stable 

 

5. Wait until the input values are stable, and then select Next to freeze the values. 
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Figure 427. Plate Change Wizard - Orifice Plate Size 

 

6. Select Yes if you are changing the size of the orifice. Select Next and proceed to step 
7. 
or  
Select No if you are installing a new plate with the same size orifice as the old plate. 
Select Next and proceed to step 10. 
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Figure 428. Plate Change Wizard - New Orifice Plate Size 

 

7. Enter the size of the new orifice plate and select Next.  
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Figure 429. Plate Change Wizard - Next to Complete 

 

8. Select Next after you have completed maintenance of the meter and you are ready to 
return to live inputs. 
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Figure 430. Plate Change Wizard - Maintenance Complete 

 

9. Select Finish to close the Plate Change Wizard. A Confirmation message appears. 

Figure 431. Plate Change Wizard - Maintenance Complete 

 

10. Select Yes to exit the Plate Change Wizard. 
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5.9  System Power 

FBxConnect™ monitors battery health and displays battery diagnostics, including the last 
time the battery was changed. If you change the device battery or SRAM battery, you 
should reset the timers displayed in FBxConnect™. 

You can also set the operating trip point. The operating trip point is the external voltage 
required to power the device. The device enters a low-power mode when the external and 
battery (if applicable) voltage falls below the operating trip point. 

To access this screen:  

1. Select Services > System Power from the FBxConnect™ main menu. The System 
Power screen displays. 

Figure 432. System Power 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Enter a short name (up to 20-alphanumeric characters) for the point. 

Description Enter a short description (up to 20-alphanumeric characters) for the 
point. 
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Field Description 

External 
Voltage Alarm 

This read-only field shows you which alarm is currently configured 
for the external voltage. 

Note 

Click  to open the Alarms screen and configure the alarm 

parameters. 

External 
Voltage 

This read-only field shows the current voltage from the external 
power source. 

Operating Trip 
Point 

Click ▼ to set the set the minimum voltage required to power the 
device. The device enters a low power mode when the voltage falls 
below the configured trip point. Possible options are Solar Supply 
(powered by solar panel) and DC Supply (powered by a DC power 
supply). 

SRAM Battery 
Status  

This read-only field shows the status of the CPU SRAM battery. 
Possible statuses include Battery Normal and Battery Failure or 
Removal. 

Note 
This field is updated once per day at 8 a.m. and when the FB Series 
product is power cycled. 

SRAM Battery 
In Use 

This read-only field shows the number of days the CPU SRAM battery 
has been in use. The CPU SRAM battery is considered in use when the 
external voltage and battery voltage are too low to power the device. 

SRAM Battery 
Change 
Date/Time 

This read-only field shows the date for the last time the user 
indicated a CPU SRAM battery change. 

CPU SRAM 
Battery 
Replaced 

Click to indicate the CPU SRAM battery has been replaced. The 
software updates the Backup Battery Diagnostics and Battery Change 
Events fields, including resetting the CPU SRAM battery runtime. 

PB SRAM 
Battery Status 

This read-only field shows the status of the Power Blocks (PB) SRAM 
battery. Possible statuses include Battery Normal and Battery Failure 
or Removal. 

Note 
This field is updated once per day at 8 a.m. and when the FB Series 
product is power cycled. 
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Field Description 

PB SRAM 
Battery In Use 

This read-only field shows the number of days the PB SRAM battery 
has been in use. The PB SRAM battery is considered in use when the 
external voltage and battery voltage are too low to power the device. 

PB SRAM 
Battery 
Change 
Date/Time 

This read-only field shows the date for the last time the user 
indicated a PB SRAM battery change. 

PB SRAM 
Battery 
Replaced 

Click to indicate the PB SRAM battery has been replaced. The 
software updates the Backup Battery Diagnostics and Battery Change 
Events fields, including resetting the CPU SRAM battery runtime. 

3. Select Save to save any changes you make to this screen. 

5.10  Time Sync 

Use this pop-up display to synchronize the FB Series product clock with your PC clock. 

To synchronize the FB Series product clock with your PC clock: 

1. Select Services > Time Sync from the FBxConnect™ main menu. The following display 
opens. 

Figure 433. Time Sync 

 

2. Select a time sync option. Possible options are: 
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• Time Sync with PC – Copy the PC clock time to the FB Series product. 

Note 

If the time zone displayed is incorrect, select ▼ to in the drop-down list and select 
your desired time zone. 

• Manual Time Sync – Manually set the date and time of the FB Series product. 

3. Place a check mark in the box next to Do not show these options again if you do not 
want to have the option to manually change the time when synchronizing the time in 
the future. 

4. Select OK to synchronize the clock. A confirmation message displays stating the 
synchronization operation completed successfully. 

Figure 434. Confirmation Message 

 

5.11  User Management 

Use the User Management display to add, delete, and modify user accounts that are able 
to log in to the FB Series product. The username and password defined in the FB Series 
product should match the username and password used to log into Field Tools. For more 
information about creating and modifying a username or password in Field Tools, refer to 
the Field Tools online help. 

Note 

• Changes to user accounts are audited in the event log via the Account Added, Account 
Removed, Account Modified and Account Locked events. 
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• Whenever a user logs in or logs out of the system, Login Success and Logout events 
are recorded in the event log along with the username. 

• Unsuccessful login attempts are recorded in the event log as Login Fail Invalid 
Credentials. 

• The “admin” user account is created by default and is counted towards your total 
number of user accounts. You must be logged in using a different username that is 
assigned a Role of Admin in order to delete the “admin” user account. 

The FB3000 RTU supports a total of 100 user accounts. The total number of user accounts 
does not include the internal user accounts (SEC_DISABLE_DNP3, SEC_DISABLE_MODBUS, 
and FBxNet_Internal), and you cannot delete the internal user accounts from the 
Accounts list. 

The Accounts list shows internal user accounts only if a communications port is 
configured to use that particular internal user account. The internal user accounts are 
used in the following situations: 

• The SEC_DISABLE_DNP3 user account is used when DNP3 protocol communications 
occur on a communications port with security disabled. Event log entries show 
changes were performed by the SEC_DISABLE_DNP3 user account. 

• The SEC_DISABLE_MODBUS user account is used when MODBUS protocol 
communications occur on a communications port with security disabled. Event log 
entries show changes were performed by the SEC_DISABLE_MODBUS user account. 

• The FBxNet_Internal user account is used when FBxNet read/write operations occur. 
Event log entries show changes were performed by the FBxNet_Internal user account. 

CAUTION 
If you require changes to be made on-site only, configure the internal user accounts with 
a Role of Auditor. This prevents anyone from logging in remotely and changing your 
configuration. Refer to Roles for more information. 

To access this display: 

1. Select Services > User Management from the FBxConnect™ main menu. 
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Figure 435. User Management 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Accounts Shows a list of all currently configured user accounts on the FB Series 
product. 

Note 

The Accounts list shows internal user accounts only if a 
communications port is configured to use that particular internal 
user account. 

Username This read-only field shows the name configured for 
the user account. 

Role This read-only field shows the organizational role 
assigned to the user account. Roles limit the access a 
user account has to the system. For example, the 
Admin role has full R/W access to parameters while the 
Auditor role has read-only access to parameters. For 
more information, refer to Roles. 
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Field Description 

Protocol This read-only field shows what protocol type is used 
to log on to the FB Series product with the user 
account. Possible options are DNP3, Modbus, and 
FBxNet. 

User Status This read-only field shows the status of the selected 
user account. Possible options are Unlocked and 
Locked. 

Type Shows if the user account was created by a user (User) 
or is a default internal user account (System). 

Add User Select this button to add a new user account to the FB Series product. 
For more information, refer to Adding a User. 

Modify User Select a user account from the Accounts list and select this button to 
modify the selected user account. For more information, refer to 
Modifying a User. 

Delete User Select a user account from the Accounts list and select this button to 
remove the selected user account from the FB Series product. For 
more information, refer to Deleting a User. 

Apply Select this button to save any user account changes to FB Series 
product memory. 

OK Select this button to save any user account changes to FB Series 
product memory and exit the display. 

Close Select this button to exit the display. 

3. Select Close to exit this display. 

5.11.1 Adding a User 

You must first add a user account for them to be able to log in to the FB Series product. 
When adding a user account, you can configure the user name, password, and 
organizational role. The FB3000 supports a total of 100 user accounts. 

Note 

The total number of user accounts includes the does not include the default user 
accounts. 
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To add a new user: 

1. Select Services > User Management from the FBxConnect™ main menu. The User 
Management display opens. 

Figure 436. User Management 

 

2. Select Add User. The Security user details display opens. 
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Figure 437. Security user details 

 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Protocol Type Click ▼ to select the what protocol type is used to log on to the FB 
Series product. Possible options are:  

• DNP3 – Login through FBxConnect™ or another DNP3 host.  

• FBxNet – Login through FBxNet connections. 

Note 

If you are modifying an existing user account, this field is read-only. 

Username Enter a name for the new user account. 

• DNP3 – Up to 30-alphanumeric characters. 

• FBxNet – Up to 30-alphanumeric characters. 

Note 

If you are modifying an existing user account, this field is read-only. 
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Field Description 

Password Enter a password for the new user account. 

• DNP3 – Up to 32-alphanumeric characters. 

• FBxNet – Up to 32-alphanumeric characters. 

Note 

The minimum password is set on the Security Management display.  

Show 
Password 

Place a check mark to display the characters entered in the Password 
field. 

Pin Enter up to four numerical characters to use as a personal 
identification number (Pin) for the selected user account. A Pin is 
used when you log in to a device through the LCD. 

Note 

• If you want a use account to use a PIN, you must place a check 
mark next to Enable PIN. 

• This option is only applicable if select DNP3 in the Protocol Type 
field. 

Show Pin Place a check mark to display the characters entered in the Pin field. 

Enable Pin Place a check mark to enable the user account to log in through a 
device's LCD using the configured Pin. 

Role Click ▼ to assign an organizational role for the user account. Roles 
limit the access a user account has to the system. For example, the 
Admin role has full R/W access to parameters while the Auditor role 
has read-only access to parameters. For more information, refer to 
Roles. 

Localization 
Profile 

Click ▼ to assign a Localization profile to use when the selected user 
account logs in to the device. For more information, refer to 
Localization. 

User Status This read-only field displays the status of the selected user account. 
Possible options are User unlocked and User locked. 

4. Press OK to close the Security user details display. The User Management display 
opens showing the newly added user account in the Accounts frame. 
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Figure 438. User Management 

 

5. Select OK to save your changes and close the User Management display. 

5.11.2 Modifying a User 

Use this option to change the login details of a user account. 

To modify a user: 

1. Select Services > User Management from the FBxConnect™ main menu. The User 
Management display opens. 
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Figure 439. User Management 

 

2. Select the user account whose login details you want to change. 

3. Select Modify User. The Security user details display opens. 

Figure 440. Security User Details 
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4. Review – and change as necessary – the values in the following fields: 

Field Description 

Protocol Type Click ▼ to select the what protocol type is used to log on to the FB 
Series product. Possible options are:  

• DNP3 – Login through FBxConnect™ or another DNP3 host.  

• FBxNet – Login through FBxNet connections. 

Note 

If you are modifying an existing user account, this field is read-only. 

Username Enter a name for the new user account. 

• DNP3 – Up to 30-alphanumeric characters. 

• FBxNet – Up to 30-alphanumeric characters. 

Note 

If you are modifying an existing user account, this field is read-only. 

Password Enter a password for the new user account. 

• DNP3 – Up to 32-alphanumeric characters. 

• FBxNet – Up to 32-alphanumeric characters. 

Note 

The minimum password is set on the Security Management display.  

Show 
Password 

Place a check mark to display the characters entered in the Password 
field. 

Pin Enter up to four numerical characters to use as a PIN for the selected 
user account. A Pin is used when you log in to a device through the 
LCD. 

Note 

• If you want a user to use a PIN, you must place a check mark next 
to Enable PIN. 

• This option is only applicable if select DNP3 in the Protocol Type 
field. 

Enable Pin Place a check mark to display the characters entered in the Pin field. 

Show Pin Place a check mark to enable the user account to log in through a 
device's LCD using the configured Pin. 
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Field Description 

Role Click ▼ to assign an organizational role for the user account. Roles 
limit the access a user account has to the system. For example, the 
Admin role has full R/W access to parameters while the Auditor role 
has read-only access to parameters. For more information, refer to 
Roles. 

User Status This read-only field displays the status of the selected user account. 
Possible options are User unlocked and User locked. 

5. Select OK when you are finished modifying the user account details. The display 
closes and FBxConnect™ shows the User Management display. 

Figure 441. User Management 

 

6. Select OK to save your modifications and exit the User Management display. 

5.11.3 Deleting a User 

You can prevent users from logging into the FB Series product by removing their user 
accounts from the Accounts list. 
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Note 

You cannot delete the default user accounts from the Accounts list. 

To delete a user: 

1. Select Services > User Management from the FBxConnect™ main menu. The User 
Management display opens. 

Figure 442. User Management 

 

2. Select the user account you want to remove. 

3. Select Delete User. A confirmation dialog opens. 

Figure 443. Delete User Confirmation 

 

4. Select Yes. The system removes the user account from the Accounts list. 
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Figure 444. User Deleted Successfully 

 

5. Select OK to save your changes and exit the display. 

5.11.4 Roles 

Roles control access to specific parameters in the FB Series product. You assign a "role" to 
each user account in FBxConnect™, and each parameter in the FB Series product also has 
a "role" attribute. For example, a user account with a role set to Admin has access to all 
read/write parameters in the FB Series product. A user account with a role set to Auditor 
has read-only access to all parameters in the FB Series product. 

Note 

• The role assigned to each parameter is detailed in the DNP3 Protocol Specifications 
Manual (for the Emerson FB3000 RTU) (D301858X012). 

• Functions not associated with one specific parameter (such as firmware update or 
configuration download) are controlled by Permissions. Use the Permissions display 
to configure which roles have access to perform these functions in FBxConnect™. 
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Figure 445. Security User Details – Role 

 

The following table outlines the permissions available to each role: 

Note 

At least one user account needs to be assigned a role of Admin. 

Role Description 

Admin Access to all R/W parameters; setup user accounts; download 
configurations; update firmware; update the FB Series product clock; 
collect data; clear alarms, events, history, and totals. 

Engineer Same access as Admin, but cannot setup user accounts or configure 
roles. 

Measurement 
Tech 

Same access as Engineer. 

Operator Access to collect data, adjust alarm limits, and permission to 
configure PID setpoints, modes, and manual output values. 

Auditor Access to only view data. 
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5.12  Security Management 

Use this pop-up display to configure password and login requirements for users logging 
into the FB Series product, and to configure which user roles have access to perform 
specific functions in the software. 

Note 

Changes made to the Security Configuration display apply to all users on the FB Series 
product. 

To access this display: 

1. Select Services > Security Management. The Security Configuration display opens: 

Figure 446. Security Configuration 

 

2. Review – and change as necessary – the values in the following fields: 
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Field Description 

Password 
length 

Sets a required minimum number of characters for a valid user 
password. To enable this feature, place a check mark in the 
Minimum length field and enter the required number of characters 
in the characters field. 

Note  

• Modifying this field does not affect existing passwords. 

• This field applies only to passwords set through FBxConnect™. 

Lock Out The lock out feature prevents an account from logging in to an FB 
Series product if that account's credentials have been incorrectly 
entered a pre-configured number of times. 

Disabled Prevents a user from becoming locked out. 

Timed Enables a user to be locked out for a configurable 
amount of time. 

Note 

An alarm is active on the FB Series product for the Lock Out duration. 

Lockout 
Threshold 

Sets the number of consecutive invalid login attempts that must 
occur before the account becomes locked. 

Lockout 
Duration 

Sets the length of time (in minutes) you must wait after being locked 
out before you can successfully log in. 

Note 

You can cancel the Lockout Duration by restarting the FB Series 
product. 

User Roles 
and 
Permissions 

Select to open the Permissions pop-up and configure which user 
Roles have access to specific functions in the software.  

3. Select OK to save any changes and close this display. 

5.12.1 Permissions 

Permissions allow you to control access to functions not associated with one specific 
parameter in the FB Series product (such as firmware update or configuration download). 
Use this display to configure which user roles have access to perform these functions in 
FBxConnect™. 
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Note 

• Refer to Roles for more information about which roles have access to what 
parameters in the FB Series product.  

• Refer to User Management to configure which role is assigned to a user. 

To access this display: 

1. Select Services > Security Management. The Security Configuration display opens: 

Figure 447. Security Configuration 

 

2. Select User Roles and Permissions. The Permissions display opens: 
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Figure 448. Permissions 

 

3. To grant functional permissions to user roles, place a check mark in the user role 
column for each Permission Name. In the graphic above, the Engineer and 
Measurement Tech have permission to all system functions, while the Operator has 
permissions only for Data Collection, Time Synchronization, and Read Device Files. 
Any user you assign to those roles have those permissions.  

Functions associated with each Permission Name are as follows: 

Permission 
Name 

Description 

Calibration Allows you to calibrate an input, verify a calibration, reset a 
calibration, set zero shift, and perform a plate change.  

Configuration 
Download 

Allows you to download a configuration to the FB Series product.  

Note 

You must also select Data Management for a user role to be able 
to successfully download a configuration. 

Data Collection Allows you to create history, alarm, and event reports from the FB 
Series product; access the Upload Custom Reports display. 
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Permission 
Name 

Description 

Data 
Management 

Allows you to create diagnostic reports and clear alarm, event, and 
history data from the FB Series product; access the Custom 
Reports menu options. 

Firmware 
Update 

Allows you to update the firmware on the FB Series product. 

Note 

You must also select Data Management for a user role to be able 
to successfully apply a update firmware. 

License 
Management 

Allows you to add and remove product licenses from the FB Series 
product. 

System Restart Allows you to perform a warm or cold start on the FB Series 
product. 

Time 
Synchronization 

Allows you to adjust the clock on the FB Series product. 

Read Device Files Allows you read-only access to the files stored on the FB Series 
product. 

Legal Event 
Verification 

Allows you to verify the configuration of the FB Series product. 

4. Select Save to save any changes you make to this display 

5. Select Close to return to the previous display. 

5.13  Device License 

Use the Device License pop-up display to view products licensed on your FB3000 RTU, add 
a previously downloaded license file to your FB3000 RTU, or login to Licensing Tool to 
manage licenses for your device.  

The Device License display has two tabs (Products and Features), and each tab is split into 
an upper (Summary of Products/Features) and lower (Associated Products/Features) 
section. Select a Product or Feature in the upper section to display the corresponding 
product or features in the lower section. 

To access this display: 

1. Select Services > Device License from the FBxConnect™ main menu. The Device 
License display opens. 
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Figure 449. Device License 

 

2. Review – and change as necessary – the values in the following fields: 

Field Description 

Sign in Select to login to Licensing Tool and manage the software licenses 
assigned to your account.  

License 
Information 

Show information related to the license installed on your FB Series 
product. 

Date license 
was applied 

This read-only field shows the date and time the license 
was added to the FB Series product. 

Device 
License 
Version 

This read-only field shows the license version currently 
installed in the FB Series product. 

Device 
serial 
number 

This read-only field shows the serial number of the 
currently connected FB Series product. 
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Field Description 

Summary of 
Licenses / 
Features 

Shows a table of licenses/features currently assigned to the FB3000 
RTU. Each row of the table contains information specific to the 
license/feature described in that row. Select on a Licenses/Features 
row to view information about the associated product/features in the 
section below. 

Product 
Name 

This read-only field shows the code of the product 
licensed on the FB Series device.  

Note 

This column appears only for the Products tab. 

Description This read-only field shows a description of the 
product/feature licensed on the FB Series device. 

In Use This read-only field shows the number of 
product/features currently used by the FB Series 
product.  

Remaining This read-only field shows the number of 
product/features not currently used by the FB Series 
product.  

Licensed This read-only field shows the total number of 
product/features licensed on the FB Series product.  

Features 
Associated 
with a 
Product/ 
Products 
Associated 
with a Feature 

Shows the information for the product or feature selected in the 
Summary section. 

Feature 
Name/ 
Product 
Name 

This read-only field shows the product name or 
feature description associated with the 
product/feature selected in the Summary section. 

AppCode This read-only field shows a code the vendor or 
developer has associated with the particular 
application. Refer to the vendor’s application 
documentation for a meaning of the application code. 

Note 

Do not mistake the AppCode for the license quantity. 

In Use This read-only field shows the number of a 
product/feature currently used by the FB Series 
product. 
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Field Description 

Remaining This read-only field shows the allowed number of a 
product/feature not currently used by the FB Series 
product.  

Quantity This read-only field shows the total number of a 
product/feature available of the FB Series product. 

Publisher This read-only field shows the organization who 
issued the license for a product/feature. 

Version This read-only field shows the revision level of the 
product/feature. 

Time 
Created 

This read-only field shows the date and time the 
license was created for a product/feature. 

Expiration This read-only field shows the date and time the 
license will expire for a product/feature. 

Add license 
file to device 

Select to add a license file to your FB3000 RTU.  

Note 

License files are downloaded from the Emerson license website. For 
more information, refer to Add License File to Device. 

Manage 
license 

Select to log in to Licensing Tool (if not already logged in) and open 
the License Management display. The License Management display 
allows you to move product licenses between Licensing Tool servers 
and the FB Series product. For more information, refer to License 
Management. 

Close Click to close the Device License display. 

 

5.13.1 Add a License File to Device 

Use this option to add a previously downloaded license file to your FB3000. 

Note 

You can download a license file through Licensing Tool. 

To add a license file to your device: 
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1. Select Services > Device License from the FBxConnect™ main menu. The Device 
License display opens. 

Figure 450. Device License 

 

2. Select Add license file to device. The Add license file pop-up opens. 

Figure 451. Add license file 

 

3. Select Browse. A file window dialog opens. 
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Figure 452. Add license file 

 

4. Navigate to the location of the downloaded license file on your PC, select the file, and 
then select Open. 

Figure 453. Add license file 

 

5. Select Apply license file to add the selected license file to your device. The system 
applies the license to your device and updates the Status field. 
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Figure 454. License File Applied Successfully 

 

6. Select Close to return to the previous screen. 

5.13.2 License Management 

The License Management pop-up display allows you move product licenses between 
Licensing Tool and the FB Series product. After you make a change to the products 
licensed to your FB Series device, a new license file is downloaded from Licensing Tool 
servers and applied to your device.  

Note 

If the license information becomes corrupt on your device, use the Restore feature to 
download and apply a new license file based on the information stored in Licensing Tool 
servers. 

To open the License Management pop-up display: 

1. Select Services > Device License from the FBxConnect™ main menu. The Device 
License display opens. 
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Figure 455. Device License 

 

2. Select Manage license. The Licensing Tool log in dialog opens. 

Figure 456. Licensing Tool Log In – Email address 
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3. Enter the e-mail address required to log in to Licensing Tool, and select LOG IN. 

Figure 457. Licensing Tool Log In – Password 

 

4. Enter the password required to login to Licensing Tool, and select LOG IN. A User 
Authentication dialog opens. 

Note  

If this is your first time logging in, then a QR code appears. Scan the QR code in your 
preferred authenticator app and enter the provided one-time code. 
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Figure 458. Licensing Tool Log In – User Authentication 

 

5. Enter the code from your preferred authenticator app and select Continue. The 
License Management pop-up display opens. 

Figure 459. License Management 

 

6. Review – and change as necessary – the values in the following fields: 
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Field Description 

Device Serial 
Number 

This read-only field shows the serial number of the currently 
connected FB Series product. 

Device 
Description 

This read-only field shows the tag of the currently connected FB 
Series product. 

Device License 
Version 

This read-only field shows the license version currently installed in 
the FB Series product. 

Device 
Company 

This read-only field shows the name of your company as 
configured in Licensing Tool. 

Device Site This read-only field shows the name of your company as 
configured in Licensing Tool. 

Server License 
Version 

This read-only field shows the license version available in the 
Licensing Tool server. 

Help Select to open the online help for the License Management display. 

License This read-only field shows the product code for a software 
application/feature assigned to the selected site.  

Description Shows an explanation of the product code. 

Device These columns show the products currently activated on your FB 
Series product. 

In Use This read-only field shows the number of products 
currently activated and being used by the FB Series 
product. 

Remaining This read-only field shows the number of products 
activated, but not currently being used by the FB 
Series product. 

License Server These columns show products currently available for your FB Series 
product through the License Tool servers.  

Activated This read-only field shows the number of licenses 
currently activated. 

Available This read-only field shows the number of products 
on Licensing Tool servers that are availble to activate. 

Quantity 
to Activate 

In the row for the product you want to activate, 
double click this field and enter the number of 
licenses to assign to the FB Series product. 
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Field Description 

Apply License Select to activate the products you configured in the Quantity to 
Activate column, download, and then apply a new license file to 
your FB Series product. For more information, refer to Add a 
Product License from Licensing Tool.  

Restore License 
Online 

Select to download and apply a new license file based on the 
information associated with your serial number that is stored in the 
Licensing Tool servers. For more information, refer to Restore 
License Info from Licensing Tool. 

Revoke Select to open the License Revocation pop-up display and remove 
products currently activated on your FB Series product, transfer 
them to Licensing Tool servers, and download a new license file. 
For more information, refer to Remove a Product License. 

Close Select Close to return to the previous display. 

7. Select Close to return to the Device License pop-up display. 

5.13.2.1 Add a Product License from Licensing Tool 

You can login to the Licensing Tool directly from within FBxConnect™. This allows you to 
add products and features to your FB Series product, download a new license file from 
the Licensing Tool servers, and apply the new license file to your device. 

To add a product license from Licensing Tool: 

1. Select Services > Device License from the FBxConnect™ main menu. The Device 
License display opens. 
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Figure 460. Device License 

 

2. Select Manage license. The Licensing Tool log in dialog opens. 

Figure 461. Licensing Tool Log In – Email address 
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3. Enter the e-mail address required to log in to Licensing Tool, and select LOG IN. 

Figure 462. Licensing Tool Log In – Password 

 

4. Enter the password required to login to Licensing Tool, and select LOG IN. A User 
Authentication dialog opens. 

Note  

If this is your first time logging in, then a QR code appears. Scan the QR code in your 
preferred authenticator app and enter the provided one-time code. 
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Figure 463. Licensing Tool Log In – User Authentication 

 

5. Enter the code from your preferred authenticator app and select Continue. The 
License Management pop-up display opens. 

Figure 464. License Management 
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6. The Device columns show the products currently licensed on your device. The 
License Server columns show products currently available for your device through 
Licensing Tool. In the row for the product you want to activate, select the Quantity to 
Activate column and enter the number of licenses to assign to the serial number of 
the connected FB Series product.  

Figure 465. Apply License 

 

7. Select Apply License to activate the selected product/feature on your FB Series 
product. The system downloads a new license file and applies it to the FB Series 
product. When the transfer is complete, the Status field shows License file applied 
successfully. 
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Figure 466. License File Applied Successfully 

 

8. Select Close to exit the License Management display. The Device License display now 
shows the new license on your FB Series product. 
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Figure 467. Device License 

 

5.13.2.2 Restore License Info from Licensing Tool 

Use this feature to download and apply a new license file based the information stored in 
Licensing Tool servers for your FB Series product’s serial number. 

To restore a license: 

1. Select Services > Device License from the FBxConnect™ main menu. The Device 
License display opens. 
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Figure 468. Device License 

 

2. Select Manage license. The Licensing Tool log in dialog opens. 

Figure 469. Licensing Tool Log In – Email address 
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3. Enter the e-mail address required to log in to Licensing Tool, and select LOG IN. 

Figure 470. Licensing Tool Log In – Password 

 

4. Enter the password required to login to Licensing Tool, and select LOG IN. A User 
Authentication dialog opens. 

Note  

If this is your first time logging in, then a QR code appears. Scan the QR code in your 
preferred authenticator app and enter the provided one-time code. 
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Figure 471. Licensing Tool Log In – User Authentication 

 

5. Enter the code from your preferred authenticator app and select Continue. The 
License Management pop-up display opens. 

Figure 472. License Management 
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6. Click Restore License Online. The system downloads a new license file and applies it 
to the FB Series product. When the transfer is complete, the Status field shows 
License file applied successfully. 

Figure 473. License File Applied Successfully 

 

7. Select Close to return to the previous screen. 

5.13.2.3 Remove a Product License 

Use the License Revocation pop-up display to remove user-activated product licenses 
from your FB Series product. 

To remove a product license: 

1. Select Services > Device License from the FBxConnect™ main menu. The Device 
License display opens. 
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Figure 474. Device License 

 

2. Select Manage license. The Licensing Tool log in dialog opens. 

Figure 475. Licensing Tool Log In – Email address 
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3. Enter the e-mail address required to log in to Licensing Tool, and select LOG IN. 

Figure 476. Licensing Tool Log In – Password 

 

4. Enter the password required to login to Licensing Tool, and select LOG IN. A User 
Authentication dialog opens. 

Note  

If this is your first time logging in, then a QR code appears. Scan the QR code in your 
preferred authenticator app and enter the provided one-time code. 
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Figure 477. Licensing Tool Log In – User Authentication 

 

5. Enter the code from your preferred authenticator app and select Continue. The 
License Management pop-up display opens. 

Figure 478. License Management 
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6. Select Revoke. The License Revocation pop-up display opens showing the user 
activated products that may be removed in the bottom portion of the display.  

Note 

You can only remove user activated products, not factory configured products. 

Figure 479. License Revocation 

 

7. In the row of the product you want to remove, enter the number of licenses to 
remove in the New Quantity column. 

8. Select Apply New Quantity to remove selected products from your FB Series product 
and transfer them back to Licensing Tool servers. A confirmation message opens. 

Figure 480. License Revocation Confirmation 

 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

1081 

Note 

• In order for the system to apply a license successfully, the new license file must 
contain a minimum quantity of currently configured features. For example, if you 
have three gas meters currently configured, the new license file must contain at least 
three meter runs and gas calculations. If you attempt to revoke a license for a product 
that is currently configured in the FB Series product, the following error message 
opens: 
Figure 481. New Quantity Warning  

 

• If a downloaded license fails to apply, reconfigure your device with only the products 
contained in the new license before you apply the new license file. For more 
information about adding a previously downloaded license to an FB Series product, 
refer to Add License File to Device. 

9. Select OK. The Apply License File to Device display opens and automatically applies 
the updated license file to your FB Series product. When the transfer is complete, the 
Status field shows License file applied successfully. 
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Figure 482. License File Applied Successfully 

 

10. Select Close to return to the License Management display. 

5.13.3 Serial Number Location 

The serial number is located on the side of your module. The serial number will be one of 
two formats. The picture below shows the location and possible formats of a module 
serial number. 

Note 

The serial number is case-sensitive. 

Figure 483. Serial Number Location 

 

5.14 Apply Security File 

Use this option to enable DNP3 Secure Authentication version 5 (SAv5) on the FB Series 
product. You create the security file using Field Tools and apply the file to the FB Series 
product using FBxConnect™.  
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Note 

• For more information about creating the security file using Field Tools, refer to 
D301703X412, Emerson Field Tools Quick Start Guide. 

• This appears only if you are physically connected via the USB port. 

To add a SAv5 security file to your device: 

1. Select Services > Apply Security File from the FBxConnect™ main menu. The Apply 
Device Security File pop-up display opens. 

Figure 484. Browse 

 

2. Select Browse. A file window dialog opens. 

Figure 485. Open 

 

3. Navigate to the location of the security file on your PC, select the file, and select Open. 
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Figure 486. Password 

 

4. Enter the file password and click OK. The system applies the security file to your 
device. 

Figure 487. Apply 

 

Note 

An error appears if the connected device name does not match the device name in the 
security file. Click Yes to continue applying the security file to the connected device. Click 
No to cancel the operation and select a new security file. 

 

5. A status message appears telling you that the Security Key has been applied to the 
device successfully. Select Cancel to return to the previous screen. 

Note 

If you apply a security file to an FB Series product that previously had security disabled, 
the FB Series product performs a warm start. 
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Figure 488. Security Key Applied Successfully 

 

5.15 Disable SAv5 

Use this option to turn off DNP3 Secure Authentication version 5 (SAv5) on the FB Series 
product. 

Note 

This option appears only after you have enabled SAv5 of the FB Series product and are 
physically connected via the USB port. 

To disable SAv5: 

1. Select Services > Disable SAv5 from the FBxConnect™ main menu. A confirmation 
message opens. 

Figure 489. Disable SAv5 Confirmation 

 

2. Select Yes to disable SAv5 security. A progress dialog opens confirming that secure 
authentication has been disabled, and the FB Series product performs a warm start. 
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Figure 490. Disable SAv5 Progress 
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Section 6: Reports Menu 
Use the Reports menu to collect data from the FB Series product and create various 
history, configuration, calibration, and diagnostic reports. 

Note 

• If you change the time zone of your PC, you must restart your PC before reports 
include the updated time zone. 

• Report file names include the connection/device name, report type, and timestamp of 
report creation. 

Figure 491. Reports Menu 

 

The Reports menu contains the following options: 

EFM Report – Generates an Electronic Flow Measurement (EFM) report from the data 
stored in your FB Series product. 

CFX Report – Generates a CFX (Flow-Cal) report from the data stored in your FB Series 
product. 

History 

Periodic History – Generates a report from the periodic history data stored in your FB 
Series product. 

Transaction History – Generates a report from the transaction history data stored in 
your FB Series product. 

Alarms – Generates an alarm report from the data stored in your FB Series product. 

Events – Generates an event report from the data stored in your FB Series product. 

Export Events – Exports events stored in the legal event log of your FB Series product as a 
CSV or PDF file. 

Configuration – Generates a report that shows you all of the parameters and parameter 
values in the connected FB Series product. 

Config Comparison – Generates a report that compares multiple device configurations. 
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Gas Composition – Generates a report that details the gas components and mole 
percentages of the fluid flowing through each station and meter. 

Parameter Status – Generates a report showing the status of all parameters in the FB 
Series product. 

Diagnostics – Generates a report that is used to assist Emerson's technical support team 
when investigating issues with an FB Series product. 

Calibration – View previously generated calibration reports. 

Upload Custom Reports – Use this option to upload custom reports that are stored on 
your FB Series product to your PC. 

6.1  EFM Report 

Use the EFM Report option to generate an electronic flow measurement (EFM) report 
from the data stored in your device. An EFM report is a combination of meter 
configuration, history, alarms and events. 

Note 

You can configure the number of decimal places shown on history reports using the 
Settings menu option in the Field Tools menu bar. 

To generate an EFM Report: 

1. Click Reports > EFM Report from the FBxConnect™ main menu. The EFM Report 
screen displays. 
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Figure 492. EFM Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\History. 

3. Click ▼ in the Station field and select the station that contains the data you want to 
collect.  

4. Click ▼ in the Meter field and select the meter that contains the data you want to 
collect.  

5. Select the time frequencies (Daily and/or Hourly) of the collected data in the History 
Type field.  

6. Place a check mark in the box next to Alarms if you want alarm data to be included in 
the report. 

7. Place a check mark in the box next to Events if you want event data to be included in 
the report. 

8. Select a Collection period in the Options frame. Possible options are: 
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• Since last collection – Collects all EFM data created since the last EFM report was 
generated.  

• Time range – Collects all EFM data created during the time frame you specify in 
the From and To fields. 

9. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the Secure 
PDF box and entering a password. 

10. Click Generate. A status bar provides you with the current progress of the report 
creation. 

Figure 493. EFM Report Generation Completed 

 

11. After the report is generated, click View to open the completed report. 

12. Click Close to return to the previous screen. 
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6.2  CFX Report 

Use the CFX Report option to generate a CFX (Flow-Cal) report from the data stored in 
your device. You can generate reports using CFX version 5 (gas) or CFX version 7 (gas or 
liquid) formats. 

Note 

Some fields on the report may be blank if you incorrectly configure the Input to Average 
in your FB Series product. For more information, refer to Averages.  

To collect a CFX Report: 

1. Click Reports > CFX Report from the FBxConnect™ main menu. The CFX Report 
screen displays. 

Figure 494. CFX Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

• The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\History\CFX.  
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• The file name of the saved CFX report includes Station and Meter Tags. Invalid 
characters (\, /, :, *, ?, <, >, |) in Station and Meter Tags are replaced by an underscore 
(_) in the CFX report file name. 

3. Click ▼ in the Station field and select the station that contains the data you want to 
collect.  

4. Click ▼ in the Meter field and select the meter that contains the data you want to 
collect.  

5. Select a Collection period in the Options frame. Possible options are: 

• Since last collection – Collects all CFX data created since the last CFX report was 
generated.  

• Time range – Collects all CFX data created during the start and end date you 
specify in the From and To fields. 

6. Click ▼ in the Format field to select the type of CFX file version. 

Note 

Liquid linear meters support only CFX file version 7. 

7. Select the CFX version of the generated report in the Version field.  

8. Click Generate. A status bar provides you with the current progress of the report 
creation. 
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Figure 495. CFX Report Generation Completed 

 

9. After the report is generated, click View to open the location on your PC of the 
completed report. 

10. Click Close to return to the previous screen. 

6.3  Periodic History Report 

Use the Periodic History Report option to generate a report from the periodic history data 
stored in your FB Series product. You can configure the report to include only periodic 
history data that occurred during a specific time period or to include periodic history data 
that has occurred since the last periodic history report was generated. You can generate 
reports using CSV or PDF formats. 

Note 

• You must first configure history in the device before creating a history report. For 
more information, refer to Configure – History. 

• The integrity of each history record is checked, and only history records with good 
integrity are shown. 

• Each history record has an associated sequence number. A missing history record 
sequence number indicates a deleted or lost record. 

• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 
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• You can configure the number of decimal places shown on history reports using the 
Settings menu option in the Field Tools menu bar. 

To generate a Periodic History Report: 

1. Click Reports > History > Periodic History from the FBxConnect™ main menu. The 
Periodic History Report screen displays. 

Figure 496. Periodic History Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\History.  

3. Place a check mark next to the history groups to include in the report in the History 
Group field. 
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Note 

Select the All button to automatically select all available history groups.  

4. Select the time frequency of the collected data in the Interval field.  

Note 

You can select more than one time frequency in the Interval field. 

5. Select a Collection period in the Options frame. Possible options are:  

• Since last collection – Collects all history data created since the last history report 
was generated.  

• By last sequence no. – Collects all history data from the Last Sequence Number 
which is contained in the FB Series product. Once completed, FBxConnect™ sets 
the Last Sequence Number in the FB Series product.  

Note 

The Historical, Event, Alarm logs each have their own last sequence number. 

• Time range – Collects all history data created during the start and end date you 
specify in the From and To fields. 

6. Click the Sorting button to configure the order of information in the generated 
report. Possible options are: 

• Oldest to newest – The report presents data showing the oldest entries first and 
the newest entries last. 

• Newest to oldest – The report presents data showing the newest entries first and 
the oldest entries last.  

7. In the Columns field, select or deselect the columns you want to include in the report. 

8. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the 
Secure PDF box and entering a password. 
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9. Click Generate. A status bar provides you with the current progress of the report 
creation. 

Figure 497. Periodic History Report Generation Completed 

 

10. After the report is generated, click View to open the completed report. 

Note 

Every calculated parameter in meter runs has a health attribute. The status of this 
attribute is determined by a combination of the inputs used to calculate the parameter 
and the status of the calculation. A symbol is placed after values with questionable data 
integrity. The top of the report contains a legend that explains the meaning of the 
symbols. The symbol definitions are below:  
? = In Fault  
# = In Override 
X = Unverified Value  
! = In Alarm  
> = Over Range Limit  
^ = Stale Value  
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& = Inactive 
* = Invalid History  
@ = Undefined History 

11. Click Close to return to the previous screen. 

6.4 Transaction History Report 

Use the Transaction History Report option to generate a report from the transaction 
history data stored in your FB Series product. You can configure the report to include only 
transaction history data that occurred during a specific time period or to include 
transaction history data that has occurred since the last transaction history report was 
generated. You can generate reports using CSV or PDF formats. 

Note 

• You must first configure history in the device before creating a history report. For 
more information, refer to Configure – History. 

• The integrity of each history record is checked, and only history records with good 
integrity are shown. 

• Each history record has an associated sequence number. A missing history record 
sequence number indicates a deleted or lost record. 

• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 

• You can configure the number of decimal places shown on history reports using the 
Settings menu option in the Field Tools menu bar. 

To generate a Transaction History Report: 

1. Click Reports > History > Transaction History from the FBxConnect™ main menu. 
The Transaction History Report display opens. 
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Figure 498. Transaction History Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\TransHistory.  

3. Place a check mark next to the history groups to include in the report in the History 
Group field. 

Note  

Select the All button to automatically select all available history groups. 

4. In the Sub-Type field, select the type of history to include in the report. The default 
selection is Batch. 
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Note  

• If you select Hourly, Daily, Weekly, or Monthly in the Sub-Type field, you must 
have previously configured transaction history to include periodic data in the 
Periodic Data Logging in Transaction History field on the Station – Batching Tab 
and configured transaction history to include this data on the Transaction History 
Group Configuration display. 

• The Snapshot Sub-Type is not selectable for transaction history groups 
configured for liquid linear meter batching.  

5. Select a Collection period in the Options frame. Possible options are:  

• Since last collection – Collects all transaction history data created since the last 
history report was generated.  

• By last sequence no. – Collects all transaction history data from the Last 
Sequence Number which is contained in the FB Series product. Once completed, 
FBxConnect™ sets the Last Sequence Number in the FB Series product.  

Note 

The Historical, Event, Alarm logs each have their own last sequence number. 

• Time range – Collects all transaction history data created during the start and end 
date you specify in the From and To fields. 

• All – Collects all transaction history data stored in the FB Series product. 

6. Click the Sorting button to configure the order of information in the generated 
report. Possible options are: 

• Oldest to newest – The report presents data showing the oldest entries first and 
the newest entries last. 

• Newest to oldest – The report presents data showing the newest entries first and 
the oldest entries last.  

7. In the Filter field, enter a Transaction ID to narrow the results to show only specific 
transactions.  

Note 

• This field is not case sensitive. 
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• For transactions assigned to a meter, you configure the Transaction ID in the 
Batch Identifier field on the Station – Batching display. 

• For transactions not assigned to a meter, you configure the Transaction ID in the 
Transaction ID field on the Transaction History Group Configuration display. 

8. Place a check mark in the Match whole words only field to search only for 
Transaction IDs that contain the entire word you entered in the Filter field. 

9. In the Columns field, select or deselect the columns you want to include in the report. 

10. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the 
Secure PDF box and entering a password. 

11. Click Generate. A status bar provides you with the current progress of the report 
creation. 
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Figure 499. Transaction History Report Generation Completed 

 

12. After the report is generated, click View to open the completed report. 

Note 

Every calculated parameter in meter runs has a health attribute. The status of this 
attribute is determined by a combination of the inputs used to calculate the parameter 
and the status of the calculation. A symbol is placed after values with questionable data 
integrity. The top of the report contains a legend that explains the meaning of the 
symbols. The symbol definitions are below:  
? = In Fault  
# = In Override 
X = Unverified Value  
! = In Alarm  
> = Over Range Limit  
& = Inactive 
^ = Stale Value  
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* = Invalid History  
@ = Undefined History 

13. Click Close to return to the previous screen. 

6.5  Alarms Report 

Use the Alarms Report option to generate a report from the alarm data stored in your 
device. You can configure the report to include only alarm data that occurred during a 
specific time period or to include alarm data that has occurred since the last alarm report 
was generated. You can generate reports using CSV or PDF formats. 

Note 

• The integrity of each alarm record is checked, and only alarm records with good 
integrity are shown. 

• Each alarm record has an associated sequence number. A missing alarm record 
sequence number indicates a deleted or lost record. 

• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 

To generate an Alarms Report: 

1. Click Reports > Alarms from the FBxConnect™ main menu. The Alarms Report screen 
displays. 
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Figure 500. Alarms Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\AlarmEvent. 

3. Select a Collection period in the Options frame. Possible options are: 

• Since last collection – Collects all history data created since the last history report 
was generated.  

• By last sequence no. – Collects from the Last Sequence Number which is 
contained in the device. Once completed FBxConnect™ sets the Last Sequence 
Number in the device.  

Note 

The Historical, Event, Alarm logs each have their own last sequence number. 

• Time range – Collects all history data created during the start and end date you 
specify in the From and To fields. 
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4. Click the Sorting button to configure the order of information in the generated 
report. Possible options are: 

• Oldest to newest – The report presents data showing the oldest entries first and 
the newest entries last. 

• Newest to oldest – The report presents data showing the newest entries first and 
the oldest entries last.  

5. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the Secure 
PDF box and entering a password. 

6. Click Generate to create the report. A status bar provides you with the current 
progress of the report creation. 

Figure 501. Alarms Report Generation Completed 

 

7. After the report is generated, click View to open the completed report. 

8. Click Close to return to the previous screen. 
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6.6  Events Report 

Use the Events Report option to generate a report that from the event data stored in your 
device. You can configure the report to include only events that occurred during a specific 
time period or to include events that occurred since the last event report was generated. 
You can generate reports using CSV or PDF formats. 

Note 

• The integrity of each event record is checked, and only event records with good 
integrity are shown. 

• Each event record has an associated sequence number. A missing event record 
sequence number indicates a deleted or lost record. 

• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 

To generate an Events Report: 

1. Click Reports > Events from the FBxConnect™ main menu. The Events Report screen 
displays. 

Figure 502. Events Report 
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2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\AlarmEvent. 

3. Select a Collection period in the Options frame. Possible options are: 

• Since last collection – Collects all history data created since the last history report 
was generated.  

• By last sequence no. – Collects from the Last Sequence Number which is 
contained in the device. Once completed FBxConnect™ sets the Last Sequence 
Number in the device.  

Note 

• This option is available only if you select Non Legal Event Log in the Sub-
Type field. 

• The Historical, Event, Alarm logs each have their own last sequence number. 

• Time range – Collects all history data created during the start and end date you 
specify in the From and To fields. 

4. Click the Sorting button to configure the order of information in the generated 
report. Possible options are: 

• Oldest to newest – The report presents data showing the oldest entries first and 
the newest entries last. 

• Newest to oldest – The report presents data showing the newest entries first and 
the oldest entries last.  

5. In the Sub-type field, select if you want to view legal or non-legal events. 

Note 

You must configure your FB Series product to keep separate legal and non-legal event 
logs on the Configure – System screen to view this field. 

6. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 
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Note 

If you select PDF, you can password protect the file by placing a check mark in the Secure 
PDF box and entering a password. 

7. Click Generate to create the report. A status bar provides you with the current 
progress of the report creation. 

Figure 503. Events Report Generation Completed 

 

8. After the report is generated, click View to open the completed report. 

9. Click Close to return to the previous screen. 

6.7 Export Events Report 

Use the Export Events Report option to export events stored in the legal event log of your 
device. The Export Events Report differs from the regular Events Report and is used to 
permanently acknowledge and export a set of legal events from the device. Once 
exported, events included in the report are marked as “read” in the device and will be 
overwritten by new events. Therefore, it should only be performed by an appropriate 
authority and the generated report should be archived externally in the host system for 
audit trial purposes. 
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The Export Events Report is also used to unlock a device which has become locked due to 
a full legal event log. After an Export Events Report is generated, sufficient event log 
space is freed to allow for additional legal events and the FB Series product is unlocked.  

Note 

• This option is available only when the Event Log Configuration Type is set to Separate 
Verifiable & Exportable Logs. For more information, refer to Event Setup.  

• The integrity of each event record is checked, and only event records with good 
integrity are shown. 

• Each event record has an associated sequence number. A missing event record 
sequence number indicates a deleted or lost record. 

• If you change the time zone of your PC, you must restart your PC before reports 
reflect the updated time zone. 

• FBxConnect™ calculates the generated file's MD5 hash and stores the result as a new 
event in the FB Series product's legal event log. This allows you to verify the integrity 
of the event report by calculating the file's MD5 hash and comparing the results with 
the MD5 hash stored in the FB Series product's legal event log. 

To generate an Export Events Report: 

1. Click Reports > Export Events from the FBxConnect™ main menu. The Export Events 
Report screen displays. 

Figure 504. Export Events Report 
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2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note  

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\ExportEvent. 

3. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 

Note  

If you select PDF, you can password protect the file by placing a check mark in the Secure 
PDF box and entering a password. 

4. Click Generate to create the report. A status bar provides you with the current 
progress of the report creation, and a dialog opens after the report is created. 

Figure 505. Archive Dialog 

 

Note 

• Remember to archive the generated report file for audit purposes. 

• FBxConnect™ calculates the generated file's MD5 hash and stores the result as a new 
event in the FB Series product's legal event log. This allows you to verify the integrity 
of the event report by calculating the file's MD5 hash and comparing the results with 
the MD5 hash stored in the FB Series product's legal event log.  
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• If the report cannot be generated, an error message appears in the status bar. 

 

5. Select OK to acknowledge the message and close the dialog.  

Figure 506. Export Events Report Generation Completed 

 

6. After the report is generated, click View to open the completed report. 

7. Click Close to return to the previous screen. 

6.8  Configuration Report 

Use the Configuration Report option to generate a report that shows you all of the 
parameters and parameter values in the connected device. You can generate reports 
using CSV or PDF formats. 

To generate a Configuration Report: 

1. Select Reports > Configuration from the FBxConnect™ main menu. The 
Configuration Report screen displays. 
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Figure 507. Configuration Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\Configuration. 

3. Place a check mark next to Include Applications if you want the generated report to 
include the configuration of applications installed on your device. 

4. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the Secure 
PDF box and entering a password. 

5. Click Generate to create the report. A status bar provides you with the current 
progress of the report creation. 
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Figure 508. Configuration Report Generation Completed 

 

6. After the report is generated, click View to open the completed report. 

7. Click Close to return to the previous screen. 

6.9  Configuration Comparison Report 

Use the Configuration Comparison Report option to generate a report that compares 
multiple device configurations. You can compare two previously saved configuration files 
or compare the configuration of the currently connected device to a saved configuration 
file. Reports can be generated in CSV or PDF file formats. 

Note 

The completed report contains only the R/W parameters which are different between the 
two configurations. 

To generate a Configuration Comparison Report: 

1. Select Reports > Config Comparison. The Configuration Comparison Report dialog 
displays. 
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Figure 509. Configuration Comparison Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\Configuration. 

3. In the Source 1 frame, select the first configuration as either Connected device (the 
currently connected device) or Solution (a solution file stored on your PC).  

4. If you select Configuration, select  and navigate to a configuration file stored on 

your PC to use in the comparison. 

5. In the Source 2 frame, select  and navigate to a solution or configuration file 

stored on your PC to use in the comparison. 

6. Place a check mark in the Compare Applications field to compare the applications 
installed in each configuration. 

7. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 
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Note 

If you select PDF, you can password protect the file by placing a check mark in the Secure 
PDF box and entering a password. 

8. Click Generate to create the report. A status bar provides you with the current 
progress of the report creation. 

Figure 510. Configuration Comparison Report Generation Completed 

 

9. After the report is generated, click View to open the completed report. The report lists 
only parameters that are different between the two configurations. 

10. Click Close to return to the previous screen. 

6.10  Gas Composition Report 

Use the Gas Composition Report option to generate a report that details the gas 
components and mole percentages of the fluid flowing through each station and meter. 
You can generate reports using CSV or PDF formats.  

To generate a Gas Composition Report: 

1. Select Reports > Gas Composition from the FBxConnect™ main menu. The Gas 
Composition Report dialog displays. 
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Figure 511. Gas Composition Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\Operations\GasComposition. 

3. Click ▼ in the Station field and select the station that contains the data you want to 
collect.  

4. Click ▼ in the Meter field and select the meter that contains the data you want to 
collect.  

5. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the Secure 
PDF box and entering a password. 

6. Click Generate to create the report. A status bar provides you with the current 
progress of the report creation. 
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Figure 512. Gas Composition Report Generation is Completed 

 

7. After the report is generated, click View to open the completed report. 

8. Click Close to return to the previous screen. 

6.11  Parameter Status Report 

Use the Parameter Status report to help identify measurement issues with your FB Series 
product. The Parameter Status report contains a list of parameters in the following 
conditions: 

• Override – A list of all selectable options that could be "live" but are instead in 
override. 

• Fault – A list of all selectable items (parameters that end in "_SEL") with the fault bit 
set in the data quality attribute (PrmStatus). 

• Default – A list of metrology parameters that have not been changed from their 
default values. 

To generate a Parameter Status Report: 

1. Select Reports > Parameter Status from the FBxConnect™ main menu. The 
Parameter Status Report dialog displays.  
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Figure 513. Parameter Status Report 

 

2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\Configuration\ParameterStatus. 

3. Click ▼ in the Format field to select the file type of the created report. Options 
include CSV or PDF formats. 

Note 

If you select PDF, you can password protect the file by placing a check mark in the Secure 
PDF box and entering a password. 

4. Click Generate to create the report. A status bar provides you with the current 
progress of the report creation. 
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Figure 514. Parameter Status Report Generation Completed 

 

5. After the report is generated, click View to open the completed report. 

6. Click Close to return to the previous screen. 

6.12  Diagnostic Report 

Use the Diagnostic Report option to generate a report used to aid in investigations by 
Emerson's technical support team.  

Note 

The Diagnostic Report option creates an encrypted file that is only useful to Emerson's 
technical support team. 

To generate a Diagnostic Report: 

1. Select Reports > Diagnostics from the FBxConnect™ main menu. The Diagnostic 
Report dialog displays.  

Figure 515. Diagnostic Report 
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2. Click  in the Destination field to open a Save As dialog and navigate to a location 

on your PC to store the report.  

Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\Operations\Diagnostic. 

3. Select the type of report you want to generate. Possible options are Diagnostic log, 
Security log ,or Memory dumps. 

4. Click Generate to create the report. A status bar provides you with the current 
progress of the report creation. 

Figure 516. Diagnostic Report Generation CompletedU 

 

Note 

Select the Clear memory dumps button to permanently delete any memory dumps on 
your device. 

5. After the report is generated, click Close to return to the previous screen. 

6.13  Calibration Report 

Use this option to view previously generated calibration reports stored on your PC. 

To view a Calibration Report: 

1. Select Reports > Calibration from the FBxConnect™ main menu. A file explorer 
window displays showing calibration reports stored on your PC. 
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Note 

The default location is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Reports\Calibration. 

Figure 517. Open Calibration Report 

 

2. Select a calibration report and select Open. The calibration report displays. 
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Figure 518. Calibration Report 

 

6.14  Upload Custom Reports 

Use this option to upload custom reports that are stored on your FB Series product to 
your PC. 

Note  

You cannot delete individual custom reports from your FB Series product from this 
display. To delete your custom reports, refer to Cold Start. 

To open the Custom Reports Explorer: 

1. Select Reports > Upload Custom Reports from the FBxConnect™  main menu. The 
Custom Reports Explorer dialog opens. 
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Figure 519. Custom Reports Explorer 

 

2. Select an individual report or a report folder to transfer to your PC from the report 
hierarchy on the left-side of the dialog. 

3. Select Browse to open a Browse For Folder window. 

Figure 520. Browse For Folder 

 

4. Navigate to the folder where you want to save the reports and select OK.  
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5. Place a check mark next to Preserve device folder hierarchy to copy the folder 
structure from your device to your PC.  

Note  

If you do not select this option, only the selected reports are copied to your PC. 

6. Select Upload from device to copy the selected custom reports from the FB Series 
product to the selected folder on your PC. 

Note  

If you select only one report from the report hierarchy on the left-side of the dialog, 
select Upload and View file to copy the selected custom report from the FB Series 
product to the selected folder and open the copied file in a text editor on your PC. 

7. Select Close to exit the dialog. 
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Section 7: Applications Menu 
Use the Applications menu to install, remove, and view information about each 
application installed on your FB3000. 

Figure 521. Applications Menu 

 

The Applications menu contains the following options: 

Management – Add, remove, or export applications. 

Information – View information for each application installed in the FB3000 including 
resource usage, starting, and stopping the application. 

Note 

Any installed applications also display in this menu. For instructions about a specific 
application, refer to that application's documentation. 

7.1  Management 

Applications allow your FB3000 RTU to perform additional functions. You can create a 
custom application using FBxDesigner™ or import an application and load it into your FB 
Series product. The Application management window allows you to add, remove, or 
export applications. 

To access this display, select Applications > Management from the FBxConnect™ main 
menu. The Application management window opens. 
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Figure 522. Application management 

 

You can perform the following actions with the Application management window: 

Add FBxDesigner Project – Add a project created in FBxDesigner™ to your FB3000, and 
optionally include user defined objects and/or user displays made using FBxVue. 

Open FBxDesigner Project – Open an existing FBxDesigner™ project for editing. 

Import Application – Import and start an application package (.zap). 

Export Application – Export an application package (.zap). 

Remove Application – Remove an application package, including the FBxDesigner™ 
program, user defined objects and user displays. 

7.1.1 Add FBxDesigner™ Project 

You can create custom applications in FBxDesigner™ and then load them in an FB Series 
product. Use this option to load an FBxDesigner™ project on your FB3000, and optionally 
include user defined objects and/or user displays created using FBxVue. 

To add an FBxDesigner™ project: 

1. Select Applications > Management from the FBxConnect™ main menu. The 
Application management window opens. 
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Figure 523. Add FBxDesigner™ project 

 

Note 

The following warning appears if your FB Series product's database resources are low. 
You can free up database resources by removing certain configuration parameters from 
the database and storing those parameters as files on the FB Series product’s flash file 
system. For more information, refer to the Database save Params to Flash File field on 
the Configure – System display. 

 

2. Select which slot the FBxDesigner™ project should be loaded into and select Add 
FBxDesigner project. The Add FBxDesigner project to Solution pop-up display opens. 
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Figure 524. Add FBxDesigner™ project to Solution 

 

3. Select Browse in the FBxDesigner project file field. A file explorer window opens. 
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Figure 525. Open 

 

4. Navigate to the location of the FBxDesigner™ project file on your PC, select the file, 
and then select Open.  

Note 

The default location for saved Solutions is 
C:\Users\Public\Documents\Emerson\FBxDesigner\Projects. This location is in a hidden folder, 
and you may need to select "show hidden files" on your computer to view this folder. 

5. To add user defined objects to your FBxDesigner™ project, place a check mark next to 
User objects folder, select Browse, select the folder on you PC that contains the user 
defined objects, and then select OK. 

Note 

• Adding user defined objects is optional. 

• Creating user defined objects is an advanced feature of the FB3000. For more 
information about the steps involved in creating user defined objects, please contact 
technical support. 

6. To add displays created with FBxVue to your FBxDesigner™ project, place a check 
mark next to User displays folder, select Browse, select the folder on you PC that 
contains the custom displays, and then select OK. 
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Note 

Adding displays is optional. 

7. To add object mapping templates to your FBxDesigner™ project, place a check mark 
next to Object Mapping Templates folder, select Browse, select the folder on you PC 
that contains the custom Object Mapping Templates (OMT), and then select OK. 

Note 

Adding Object Mapping Templates is optional. 

Figure 526. Add project 

 

8. Select Add project to add the FBxDesigner™ project to your FB3000. The Status field 
shows Project added successfully. 
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Note 

An error message appears if the FBxDesigner  project contains an object with a major 
and/or minor version equal to zero (as defined in the application's Objects.csv file). To fix 
this error, update the major and/or minor version in the application's Objects.csv file to a 
number greater than zero and try again. 

Figure 527. Project Added Successfully 

 

9. Select Close to return to the main Application management window. 
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Figure 528. Application Added Successfully 

 

10. FBxConnect™ downloads the FBxDesigner™ project to your FB3000. Select Close to 
exit the Application management window. Any user displays are now available from 
the Application menu. 

Figure 529. Application Showing User Displays 

 

Note 

When creating a display, the system periodically creates a backup copy (_bak) of your 
display. You can safely remove the application, delete the file from the display folder, and 
re-add the application to the FB3000 to prevent this from showing in the UI. 

7.1.1.1 Add FBxDesigner™ Project Help Files 

You can include a help file for your FBxDesigner™ project. This help file opens when you 
press F1 while an application display is open in FBxConnect. 
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For FBxConnect™ to open the help file for your FBxDesigner™ project, you must include 
the following two files:  

• Apphelp.chm – A compiled HTML file that contains your help content. You create this 
file with the help authoring tool of your choice. 

• Apphelp.csv – A map file that associates specific displays in your application with 
specific topics in the Apphelp.chm file. If you do not include a map file, then the help 
file always shows the default help screen of FBxConnect.  

The Apphelp.csv file must be formatted according to the following rules for FBxConnect™ 
to open the correct help topic. The file contains only two columns. Column A contains the 
display file name and column B contains the map ID. Enter Display in the first cell of 
column A. Enter ID in the first cell of column B. In the proceeding rows, enter the name of 
the display files used in your application in column A and the corresponding map ID for 
that display in column B. 

Note 

• When building the display for your application, you must enter the map ID in the 
TOPIC ID field (located in the PROPERTIES pane when the Canvas is selected in 
FBxVue). 

• When creating your compiled HTML file, you must associate the corresponding map 
ID to a help topic using your help authoring tool. 

Figure 530. Apphelp.csv Format Example 
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Note 

You must name the files Apphelp.chm and Apphelp.csv. 

When loading an FBxDesigner project, these help files must be present in the folder you 
select in User displays folder field. 

Figure 531. User Displays Folder 

 

7.1.2 Open FBxDesigner Project 

You can open and edit an existing FBxDesigner™ project that is loaded in you FB3000. 

To open an FBxDesigner™ project: 

1. Select File > Manage Applications from the FBxConnect™ main menu. The 
Application Management window opens. 
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Figure 532. Open FBxDesigner project 

 

2. Select the slot that contains the FBxDesigner™ project and select Open FBxDesigner 
project. The project opens in FBxDesigner™. 
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Figure 533. Open 

 

3. You can now view and modify the FBxDesigner™ project. 

Note 

You must save any changes you make to the FBxDesigner™ project to a new project file, 
and then add the new project file to the FB Series product. 

7.1.3 Import Application 

Applications allow your FB Series product to perform additional functions. Use this option 
to import and start an application (.zap) package. 

To import an application: 

1. Select File > Manage Applications from the FBxConnect™ main menu. The 
Application management window opens. 
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Figure 534. Import Application 

 

Note 

The following warning appears if your FB Series product's database resources are low. 
You can free up database resources by removing certain configuration parameters from 
the database and storing those parameters as files on the FB Series product’s flash file 
system. For more information, refer to the Database save Params to Flash File field on 
the Configure – System display. 

 

2. Select which slot the application should be loaded into and select Import 
Application. A file explorer window opens. 
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Figure 535. Open 

 

3. Navigate to the location of the application file on your PC, select the file, and then 
select Open. A dialog opens showing the SHA256 and MD5 Hash values of the 
application file. 

Note 

The default location for saved Solutions is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Applications. This location is in a hidden 
folder, and you may need to select "show hidden files" on your computer to view this 
folder. 
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Figure 536. Hash Values Dialog 

 

4. After confirming the hash values of the package, select Yes to begin the firmware 
update. A progress bar shows you the status of the update process. 

Note 

• The application is immediately loaded on your FB Series product. 

• An error message appears if the new application contains an object with a major 
and/or minor version equal to zero (as defined in the application's Objects.csv file). To 
fix this error, update the major and/or minor version in the application's Objects.csv 
file to a number greater than zero and try again. 

5. When the application is added successfully, select Close to return to the main 
FBxConnect™ display. 
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Figure 537. Application Added Successfully 

 

7.1.4 Update Application 

You can update applications installed on your FB Series product without the need to 
remove the previous version first. This allows you to keep any configured program data 
when installing the new version. 

To update an application: 

1. Select File > Manage Applications from the FBxConnect™ main menu. The 
Application management window displays. 

2. Select the slot containing the application you want to update. 
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Figure 538. Update Application 

 

3. Select Update Application. A file explorer window opens. 

Figure 539. Open 

 

4. Navigate to the location of the new version of the application file on your PC, select 
the file, and then select Open.  
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Note 

• The default location for saved Solutions is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Applications. This location is in a 
hidden folder, and you may need to select "show hidden files" on your computer to 
view this folder. 

• The application is immediately loaded on your FB Series product. 

• An error message appears if the new application contains an object with a major 
and/or minor version equal to zero (as defined in the application's Objects.csv file). To 
fix this error, update the major and/or minor version in the application's Objects.csv 
file to a number greater than zero and try again.  

Figure 540. Application Updated Successfully 

 

5. When the application is updated successfully, select Close to return to the main 
FBxConnect™ display. 
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7.1.5 Export Application 

You can export applications from an FB Series product and save them as solution files on 
your PC. Use this option to export an application package (.zap), select the destination 
path, and assign an application version number to the exported application package. 

To export an application package: 

1. Select File > Manage Applications from the FBxConnect™ main menu. The 
Application management window opens. 

Figure 541. Export Application 

 

2. Select the slot with the application you want to export and click Export application. 
The Application Packager window opens. 
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Figure 542. Application Packager 

 

3. Select Browse to open a File Explorer window. 

4. Navigate to the location on your PC you want to save the application, enter a name for 
the file and select Save.  

Note 

The default location for saved Solutions is 
C:\Users\Public\Documents\Emerson\FieldTools\FBx\Applications. This location is in a hidden 
folder, and you may need to select "show hidden files" on your computer to view this 
folder. 

5. Enter a version number in the Application Version field.  

6. Place a check mark next to Include application's configuration if you want to 
include your customized configuration in the application package. 

7. Select Package to save the application in a Solution file on your PC. 
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Figure 543. Application Packager 

 

Note 

• If the application package file name already exists on your computer, the system asks 
you want to overwrite the existing file. Select Yes to overwrite the file or select No to 
cancel the operation and enter a unique name for this application package. 

• An error message appears if any application object contains a major and/or minor 
version equal to zero (as defined in the application's Objects.csv file). If this occurs, 
you cannot export the application. 

8. Select Close to return to the main FBxConnect™ display. 
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Figure 544. Application Exported Successfully 

 

7.1.6 Remove Application 

Use this option to remove an application package from the device, including the 
FBxDesigner™ program, user defined objects and user displays. 

To remove an application: 

1. Select File > Manage Applications from the FBxConnect™ main menu. The 
Application management window opens. 
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Figure 545. Application management 

 

2. Select the slot that contains the application you want to remove.  

3. Select Remove application. A confirmation dialog opens. 

Figure 546. Remove Confirmation 

 

4. Select Yes. The Application management window shows Application removed 
successfully. 
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Figure 547. Removed Successfully 

 

5. Select Close to exit the Application management window. 

7.2  Application Information 

Use this display to start or stop an application from executing, and to view information for 
each application installed in the FB3000. 

To access this display: 

1. Select Applications > Information. The Application Information display opens. 
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Figure 548. Application Information 

 

2. Click ▼ in the drop-down list at the top of the display to select an application slot that 
contains the application information you want to view. 

3. Review – and change as necessary – the values in the following fields: 

Field Description 

Tag Sets an identifier (up to 20-alphanumeric characters) for the selected 
application slot. 

Description Sets a description (up to 20-alphanumeric characters) for the 
selected application slot. 

Package 
Name 

This read-only field shows the name of the application package 
installed in the selected application slot. 
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Field Description 

Package 
Version 

This read-only field shows the version number of the installed 
application package. 

Package 
Library 
Version 

This read-only field shows the FB3000 RTU firmware library version 
that the application package was compiled with. The Package Library 
Version needs to be less than or equal to the Application Library 
Version in order for the application to run. 

Firmware 
Library 
Version 

This read-only field shows the FB3000 RTU firmware library version 
that is currently supported by firmware. 

Application 
Status 

This read-only field shows the status of the application runtime 
regarding application packages (.zap files) in the selected application 
slot. When an application package is installed via FBxConnect™, this 
color-coded field provides an indication of the status for that 
application package. If an IEC61131 project is loaded separately via 
FBxDesigner™ (without an application package), then this field is 
considered not applicable. 

Unloaded  No application is loaded in the selected application 
slot 

Loaded  An application is loaded in the selected application 
slot but has not been started. The field showing this 
status is colored red. 

Running  An application is currently executing in the selected 
application slot. The field showing this status is 
colored green. 

Stopped  An application is currently stopped but was previously 
running in the selected application slot. The field 
showing this status is colored red. 

Application 
Exception 

This read-only field shows any errors that occur when running the 
application. Possible values are: 

None  No errors have occurred. 

String Error  An error occurred during runtime while performing 
string manipulation. Review any application code 
involving string data types for correct usage. 
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Field Description 

Watchdog 
Exceeded  

Applications which execute on a cyclic basis (once per 
100 milliseconds, once per second, etc.) can be 
developed with an optional watchdog timer. If the 
amount of time the application code takes to run 
exceeds the configured watchdog time, then this 
exception occurs. Consider increasing the watchdog 
time or revising the application code to execute 
within the configured time. 

Max CPU 
Load 
Exceeded  

The maximum allowed CPU strain for an application 
has been exceeded. Consider revising the application 
code or splitting it across multiple applications. 

System 
Error  

An internal runtime error has occurred. Retrieve the 
device’s diagnostic log and contact technical support. 

Task Status This read-only field shows the status of the IEC 61131 runtime task 
in the firmware. IEC 61131 projects can be loaded into the device as 
an application package (via FBxConnect™) or as a raw project via 
FBxDesigner™. When IEC 61131 application code is loaded in the 
device, this color-coded field provides an indication if the 
programmed logic is executing. 

Stopped The application is not currently executing. The field 
showing this status is colored red. 

Started The application is currently executing. The field 
showing this status is colored green. 

No License The application requires a license to be installed 
before it will run. The field showing this status is 
colored red. 

Application 
Control 

Use these buttons to start and stop the application in the selected 
application slot. 

IEC61131 
Runtime 
Memory 

These read-only fields show the amount of IEC61131 runtime 
memory currently being used and the maximum amount of memory 
available by the application loaded in the selected application slot. 
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Field Description 

Restart 
Counter 

This read-only field shows the number of times the selected 
application has been restarted. When an application encounters an 
error during execution, rather than halting the application, the 
application is restarted. This can happen if the runtime encounters 
an exception (such as watchdog timer being exceeded) or if the 
runtime itself restarts due to an unexpected fault.  

When this sort of restart occurs, an entry is created in the device 
event log. If the restart counter increments to a value of 10, then it is 
assumed there is a significant problem with the application, and the 
application is not restarted automatically until the counter has been 
manually reset. 

Reset 
Counter 
Button 

Click to zero out the value in the Restart Counter 
field. 

System 
Resources 

These read-only fields show the system memory and CPU used by 
the application loaded in the selected application slot. 

4. Select Save to save any changes you make to this display. 
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Section 8: FBxVue Menu 
Use the FBxVue menu to create customized displays for the FB Series products. 

Note 

FBxVue allows you to create customized displays using the C# programming language 
and store them as files on your PC or FB Series product, load and edit displays from a file, 
or include custom displays as part of a Solution file. You can add controls to a custom 
display to monitor flow, I/O points, and other object or parameter references. For detailed 
instructions about using the features in FBxVue, refer to the FBxVue User Manual 
(D301925X012). 

 

Figure 549. FBxVue Menu 

 

The FBxVue menu contains the following options: 

New – Create a new custom display using FBxVue. 

Open – Open and edit a previously saved display file in FBxVue. 

Save – Save the currently opened display to your PC. 

Save As – Specify a file name and location when saving the currently opened display.  

Delete Displays – Remove displays from the FB Series product and your PC. 

Download Displays – Download displays to the FB Series product. 

Standalone Displays – View displays not tied to a specific application. 

8.1  New Display 

Use this option to create a new custom display using FBxVue. Select FBxVue > New from 
the FBxConnect™ main menu. A blank canvas opens in FBxVue. 
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Note 

For more information about managing display files, refer to FBxVue Overview.  

8.2  Open Display 

Use this option to open and edit a previously saved display file in FBxVue. 

To open a display file: 

1. Select FBxVue > Open > Browse from the FBxConnect™ main menu. The Open 
Display dialog opens. 

Figure 550. Open Display 

 

2. Select Standalone displays as the source on the left side of the dialog. A list of 
displays stored in the default location on your PC shows on the right side of the 
dialog. 

3. Select a display from the list and select Open. The display file opens in FBxVue. 
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Note 

To open a display file not saved in the default location, select Browse to open a File 
Explorer window. Navigate to a location on your PC, select the display file, and then select 
Open. The display file opens in FBxVue. 

8.3  Save Display 

Use this option to save the currently opened display to your PC. With a display file opened 
in FBxVue, select FBxVue > Save to save the display file.  

Note 

If this is your first time saving the display, the Save Display As dialog opens. 

8.4  Save Display As 

Use this option to specify a file name and location when saving the currently opened 
display. You can save a display as a standalone file or as part of an installed application.  

You can save displays using two different file extensions (.XML and .BIN):  

• .XML – The file extension used when you save a display file and do not select the 
encryption option. You can open and edit the saved display file using FBxVue. 

• .BIN – The file extension used when you save a display file and do select the 
encryption option. You cannot open or edit the saved file using FBxVue.  

To save a display file: 

1. Select FBxVue > Save As from the FBxConnect™ main menu. The Save Display As 
dialog opens. 
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Figure 551. Save Display As 

 

2. Optional - Place a check mark next to the Compress and encrypt display file option 
to reduce the size and save an encrypted display file (.BIN). 

Note 

Emerson recommends you save an unencrypted version (.XML) of your display before you 
save an encrypted version. You cannot open or edit a display file after it has been 
encrypted. 

3. Select the location of the saved display. Possible options are: 

• Standalone Displays – Saves the display to the default location on your PC for 
FB3000 RTU displays not associated with an application. Displays stored as 
standalone displays are available from the Standalone displays group in the 
FBxVue menu. 

• Slot # – Saves the display to the folder on you PC associated with the application 
installed in the selected application slot. Displays stored as part of an application 
are accessible from the Applications menu.  

• Browse – Navigate to a location on your PC to save the file.  
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4. Enter the name of the display in the file name box. 

5. Select Save to save the display. 

6. If you select Standalone Displays or a Slot # as the location of the saved display, a 
dialog asks if you want to download the display to the FB Series product. Select Yes to 
allow the display to reside on the FB Series product and not be tied a particular PC. 
Select No to only have the display available on your PC. 

Figure 552. Download Display Confirmation 

 

8.5  Delete Displays 

Use this option to remove displays from the FB Series product and your PC. You can 
delete both standalone displays and displays tied to an application. 

To delete a display: 

1. Select FBxVue > Delete Displays from the FBxConnect™ main menu. 
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Figure 553. Delete Displays 

 

2. Select the location of the display that you want to delete from the list on the left. 
Possible options are: 

• Standalone displays – Displays not associated with an application.  

• Slot # – Displays associated with the application installed in the selected 
application slot. 
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Figure 554. Delete Displays – Delete 

 

3. Choose a Display name from the list on the right and select Delete to remove the 
selected display. A confirmation dialog displays. 

Note 

Select the Delete all checkbox to remove all standalone/application slot displays from 
your computer and the FB Series product. 

Figure 555. Delete Confirmation 

 

4. Select Yes to remove the display from your computer and FB Series product. 
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8.6  Download Displays 

Use this option to download displays to the FB Series product. This allows the display to 
reside on the FB Series product and not be tied a particular PC. Any custom controls and 
text styles are also downloaded to the FB Series product, and anyone who connects to the 
device can access the display. 

To download a display: 

1. Select FBxVue > Download Displays from the FBxConnect™ main menu. 

Figure 556. Download Displays 

 

2. Place a check mark next to the application that contains the display(s) you want to 
download to your FB Series product. 

3. Select Download to download the displays. Downloaded displays are accessible from 
the FBxVue menu tab. 
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8.7  Standalone Displays 

Use this option to open a previously saved display file not tied to a specific application. To 
open a standalone display, select FBxVue from the FBxConnect™ main menu and choose 
a display from the Standalone Displays group. 

Figure 557. Standalone Displays 
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Section 9: Help Menu 
Use the Help menu to access the online help system and view software version 
information about Field Tools. 

Figure 558. Help Menu 

 

The Help menu contains the following options: 

Online – FBxConnect™ includes a comprehensive help system that describes the features 
and functions of the software. 

About – View information about the Field Tools software versions installed on your 
computer. 

9.1  Online 

FBxConnect™ includes a comprehensive help system that describes the features and 
functions of the software. Press F1 while viewing an FBxConnect™ display to display 
context-sensitive help for that display. 

Select Help > Online to display the FBxConnect™ help system: 
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Figure 559. FBxConnect™ Online Help 

 

9.2  About 

Use the About display to view software version information for Field Tools. To access this 
display, select Help > About. The About Field Tools display opens. 

Figure 560. About Field Tools 
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Appendix A: Measuring Pure Gas 
Pure gas measurement is supported by the FB Series products.  

To measure pure gases: 

1. Select the AGA8 Part 2 2017 / GERG 2008 in the Compressibility/Density Calculation 
field on the Station – General Tab.  

2. Enter the required gas composition on the Components – Component Tab.  

The following gases, temperature ranges, and maximum pressures are supported: 

Note 

Pure gas calculations in the FB Series products can measure both Gaseous CO2 as well as 
Dense Phase CO2. 

Table 54. Supported Pure Gas Measurements 

Gas Temperature Range Maximum Pressure 

• Methane 

• Nitrogen 

• Carbon Dioxide 

• Ethane 

• Propane 

• Isobutane 

• n-Butane 

• Isopentane 

• n-pentane 

• n-Hexane 

• n-Heptane 

• Octane 

• Nonane 

• Decane 

• Hydrogen 

• Oxygen 

• Carbon monoxide 

-297.7 to 800°F 

90 to 700 K 

-183 to 426.85°C 

≤ 10,150 psia 
≤ 70.0 MPa 
≤ 700 Bara 
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Gas Temperature Range Maximum Pressure 

• Water 

• Hydrogen sulfide 

• Helium 

• Argon 
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Appendix B: Liquid / Dense Phase 
Measursement Using a Gas DP Meter 
Differential Pressure (or DP) meters are perhaps most commonly used in gas 
measurement; however, the same basic concept is applicable to liquid measurement as 
well. You can configure the FB Series Gas DP meters for use with liquid phase or dense 
phase fluids - with certain caveats and considerations. The following provides background 
information for this concept, and configuration considerations for using FB Series Gas DP 
meters with liquid or dense phase fluids. 

The basic equation for measuring fluid through a differential pressure meter is given 

as follows: 

 

Where: 

 

Corrected volume quantities are calculated from the mass and the base density as 

follows: 

 

Where: 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

1168 

 

This equation is applicable to measuring single-phase gas, liquid, or dense phase 
(supercritical) fluids. The expansion factor (Y) corrects the flow rate for the effects of the 
density change caused by the pressure drop through a differential pressure type meter. 
Because incompressible or slightly compressible fluids do not undergo a significant 
density change across the meter, the expansion factor is set equal to 1 for liquid and 
dense phase fluids. For this reason, the Gas DP Meter can be used for liquids and dense 
phase fluids with the following considerations: 

• The flowing density and base density are known – AGA 8 Part 2 (GERG) supports all 
phases for pure gas or gas mixtures. Other density sources may be configured by 
setting flowing density and base density to measured mode (set on the Fluid 
Properties – General display)and defining the database parameters to read for these 
values. 

• The mass form of the equation above is used which includes the flowing density as an 
input and does not use relative density – for a meter type of AGA 3 Orifice (Flange 
Taps), select either AGA 3 Mass 1992 or AGA 3 Mass 2013. The following combinations 
for meter type and AGA 3 Calculation Selection can not be used: 

 AGA 3 Orifice (Flange) – AGA 3 1992 Volume 

 AGA 3 Orifice (Flange) – AGA 3 1992 Relative Density 

 AGA 3 Orifice (Flange) – AGA 3 2013 Volume 

 AGA 3 Orifice (Flange) – AGA 3 2013 Relative Density 

All other differential pressure meter types use a form of the mass equation and can 
be used. For more information, refer to the Meter Type field on the DP Meter – 
General display. 

• The expansion factor is set to override mode with an override value = 1.0. For more 
information, refer to the Upstream Expansion Factor (Y1) Mode field on the DP 
Meter – Advanced display. 

• Set the station fluid type to gas. For more information, refer to the Fluid Type field on 
the Station – General display. 

• Set the units for the station as desired for properties and calculated quantities. For 
more information, refer the Engineering Units. 
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Note  

The gas DP meter must be assigned to a station with fluid type of gas, but you can set the 
engineering units for gas density, gas volume, and gas volume rate that are used by the 
station to the appropriate liquid units. 
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Appendix C: Default History Setup Point 
Configurations 
The tables in this section detail the history point configuration after running the Default 
History Setup wizard. 

• Gas Differential Pressure Meter – Default History Setup Point Configuration 

• Gas Linear Meter – Default History Setup Point Configuration 

• Liquid Linear Meter – Default History Setup Point Configuration 

• Liquid Linear Meter – Default Transaction History Setup Point Configuration 
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C.1 Gas DP Meter – Default History Setup Point Configurations 

The table below shows the history point configuration for gas differential pressure meters after using the default history setup 
feature. 

Note 

• For Totals, the Total_X.RAW_PARAM signal is used to set Hist_Y.HIST_PARAM. The Archive Type is set as Total/Diff or 
Snapshot.  

• For Averages, the Average_X.SAMPLE_PARAM signal is used to set Hist_Y.HIST_PARAM. The Archive Type is set as Average.  

Table 55. Gas DP Meter – Default History Setup Point Configurations 

ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

1 FTime  DP Mtr_X.FLWTM_RAW_TOT   Total / 
Diff 

    GasDPxx FTime 

2 DP  DP Mtr_X.DP_INUSE  Average      GasDPxx DP 

3 Pressure  DP Mtr_X.PF_OBJ.SELECTED Average   • If PF_OBJ is assigned 
to User Data_ object 
then average 
DOUBLE_2. 

• If PF_OBJ is assigned 
to FBxNData_ object 
then average 
SELECTED_DOUBLE. 

GasDPxx Pressure 
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ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

• If PF_OBJ is assigned 
to HART_ object then 
average 
PV_SELECTED. 

4 Temp  DP Mtr_X.TF_OBJ.SELECTED  Average   • If TF_OBJ is assigned 
to User Data_ object 
then average 
DOUBLE_3. 

• If TF_OBJ is assigned 
to FBxNData_ object 
then average 
SELECTED_DOUBLE. 

• If TF_OBJ is assigned 
to HART_ object then 
average 
PV_SELECTED. 

GasDPxx Temp 

5 IMV  DP Mtr_X.IMV_SEL  Average    GasDPxx IMV 

6 IV  DP Mtr_X.IV_RAW_TOT  Total / 
Diff 

   GasDPxx IV 

7 Corr Vol  DP Mtr_X.SVOL_RAW_TOT  Total / 
Diff 

   GasDPxx Corr Vol 

8 Energy  DP Mtr_X.ENERGY_RAW_TOT  Total / 
Diff 

   GasDPxx Energy 

9 CorrVol Snap DP Mtr_X.SVOL_RAW_TOT  Snapshot    GasDPxx CorrVol Snap 
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ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

10 Energy Snap DP Mtr_X.ENERGY_RAW_TOT  Snapshot    GasDPxx Energy Snap 

11 Rel Dens  DP 
Mtr_X.FLUID_PROP_OBJ.RD_REAL_SEL  

Average Yes Yes  GasDPxx Rel Dens 

12 HV  DP 
Mtr_X.FLUID_PROP_OBJ.HV_REAL_SEL  

Average Yes Yes  GasDPxx HV 

13 Methane  DP Mtr_X.FLUID_PROP_OBJ.C1_INUSE  Average Yes Yes  GasDPxx Methane 

14 Ethane  DP Mtr_X.FLUID_PROP_OBJ.C2_INUSE  Average Yes Yes  GasDPxx Ethane 

15 Propane  DP Mtr_X.FLUID_PROP_OBJ.C3_INUSE  Average Yes Yes  GasDPxx Propane 

16 N-Butane  DP 
Mtr_X.FLUID_PROP_OBJ.NC4_INUSE 

Average Yes Yes  GasDPxx N-Butane 

17 I-Butane  DP 
Mtr_X.FLUID_PROP_OBJ.IC4_INUSE 

Average Yes Yes  GasDPxx I-Butane 

18 N-Pentane  DP 
Mtr_X.FLUID_PROP_OBJ.NC5_INUSE 

Average Yes Yes  GasDPxx N-Pentane 

19 I-Pentane DP 
Mtr_X.FLUID_PROP_OBJ.IC5_INUSE 

Average Yes Yes  GasDPxx I-Pentane 

20 N-Hexane  DP Mtr_X.FLUID_PROP_OBJ.C6_INUSE Average Yes Yes  GasDPxx N-Hexane 

21 Heptane  DP Mtr_X.FLUID_PROP_OBJ.C7_INUSE  Average No Yes  GasDPxx Heptane 

22 Octane  DP Mtr_X.FLUID_PROP_OBJ.C8_INUSE Average No Yes  GasDPxx Octane 

23 Nonane  DP Mtr_X.FLUID_PROP_OBJ.C9_INUSE Average No Yes  GasDPxx Nonane 

24 Decane  DP 
Mtr_X.FLUID_PROP_OBJ.C10_INUSE 

Average No Yes  GasDPxx Decane 
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ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

25 Nitrogen  DP 
Mtr_X.FLUID_PROP_OBJ.N2_INUSE 

Average Yes Yes  GasDPxx Nitrogen 

26 C02  DP 
Mtr_X.FLUID_PROP_OBJ.CO2_INUSE 

Average Yes Yes  GasDPxx C02 
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C.2 Gas Linear Meter – Default History Setup Point Configurations 

The table below shows the history point configuration for gas linear meters after using the default history setup feature. 

Note 

• For Totals, the Total_X.RAW_PARAM signal is used to set Hist_Y.HIST_PARAM. The Archive Type is set as Total/Diff or 
Snapshot.  

• For Averages, the Average_X.SAMPLE_PARAM signal is used to set Hist_Y.HIST_PARAM. The Archive Type is set as Average.  

Table 56. Gas Linear Meter – Default History Setup Point Configurations 

ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

1 FTime  Linear Mtr_X.FLWTM_RAW_TOT  Total / 
Diff 

   GasLinxx FTime 

2 Pulses  Linear Mtr_X.PULSE_RAW_TOT  Total / 
Diff 

   GasLinxx Pulses 

3 Pressure  Linear Mtr_X.PF_OBJ.SELECTED  Average   • If PF_OBJ is assigned 
to User Data_ object 
then average 
DOUBLE_2. 

• If PF_OBJ is assigned 
to FBxNData_ object 
then average 
SELECTED_DOUBLE. 

GasLinxx Pressure 
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ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

• If PF_OBJ is assigned 
to HART_ object then 
average 
PV_SELECTED. 

4 Temp  Linear Mtr_X.TF_OBJ.SELECTED  Average   • If TF_OBJ is assigned 
to User Data_ object 
then average 
DOUBLE_3. 

• If TF_OBJ is assigned 
to FBxNData_ object 
then average 
SELECTED_DOUBLE. 

• If TF_OBJ is assigned 
to HART_ object then 
average 
PV_SELECTED. 

GasLinxx Temp 

5 MF  Linear Mtr_X.MF_SEL  Average   Meter type = Turbine (0) 
or Ultrasonic (3) or PD 
(4) or Coriolis (1) ] and 
Curve Option = 1  (Meter 
Factor Curve / Single K-
factor) 

GasLinxx MF 

5 KF  Linear Mtr_X.KF_SEL  Average   Meter type = Turbine (0) 
or Ultrasonic (3) or PD 
(4) or Coriolis (1) ] and 

GasLinxx KF 
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ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

Curve Option = 2  (Single 
Meter Factor / K-factor 
Curve) 

• If FLOW_OBJ is 
assigned to 
FBxNData_ object 
then average 
SELECTED_DOUBLE. 

• If FLOW_OBJ is 
assigned to HART_ 
object then average 
PV_SELECTED. 

5 Flow  Linear Mtr_X.FLOW_OBJ.SELECTED  Average   For all other conditions: 

• If FLOW_OBJ is 
assigned to PI_ object  
then average 
SELECTED_FREQ. 

• If FLOW_OBJ is 
assigned to User 
Data_ object then 
average DOUBLE1. 

GasLinxx Flow 

6 Corr Vol  Linear Mtr_X.SVOL_RAW_TOT  Total / 
Diff 

   GasLinxx Corr Vol 

7 Energy  Linear Mtr_X.ENERGY_RAW_TOT  Total / 
Diff 

   GasLinxx Energy 
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ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

8 CorrVolSnap  Linear Mtr_X.SVOL_RAW_TOT  Snapshot    GasLinxx CorrVolSnap 

9 Energy Snap Linear Mtr_X.ENERGY_RAW_TOT  Snapshot    GasLinxx Energy Snap 

10 UVol  Linear Mtr_X.UVOL_RAW_TOT  Total / 
Diff 

  Meter type = Turbine (0), 
Auto-Adjust (2), 
Ultrasonic (3), PD(4) 

GasLinxx UVol 

11 Mass  Linear Mtr_X.MASS_RAW_TOT  Total / 
Diff 

  Meter type = Coriolis (1) GasLinxx Mass 

12 Rel Dens  Linear 
Mtr_X.FLUID_PROP_OBJ.RD_REAL_SEL  

Average Yes Yes  GasLinxx Rel Dens 

13 HV  Linear 
Mtr_X.FLUID_PROP_OBJ.HV_REAL_SEL  

Average Yes Yes  GasLinxx HV 

14 Methane  Linear 
Mtr_X.FLUID_PROP_OBJ.C1_INUSE  

Average Yes Yes  GasLinxx Methane 

15 Ethane  Linear 
Mtr_X.FLUID_PROP_OBJ.C2_INUSE 

Average Yes Yes  GasLinxx Ethane 

16 Propane  Linear 
Mtr_X.FLUID_PROP_OBJ.C3_INUSE 

Average Yes Yes  GasLinxx Propane 

17 N-Butane  Linear 
Mtr_X.FLUID_PROP_OBJ.NC4_INUSE 

Average Yes Yes  GasLinxx N-Butane 

18 I-Butane  Linear 
Mtr_X.FLUID_PROP_OBJ.IC4_INUSE 

Average Yes Yes  GasLinxx I-Butane 

19 N-Pentane  Linear 
Mtr_X.FLUID_PROP_OBJ.NC5_INUSE 

Average Yes Yes  GasLinxx N-Pentane 
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ID 

History 
Point 

(Description) Parameter 
Archive 

Type 

Components 
Average  

(Standard 
Composition) 

Components 
Average  

(Extended 
Composition) Condition Full Description 

20 I-Pentane  Linear 
Mtr_X.FLUID_PROP_OBJ.IC5_INUSE 

Average Yes Yes  GasLinxx I-Pentane 

21 N-Hexane  Linear 
Mtr_X.FLUID_PROP_OBJ.C6_INUSE 

Average Yes Yes  GasLinxx N-Hexane 

22 Heptane  Linear 
Mtr_X.FLUID_PROP_OBJ.C7_INUSE 

Average No Yes  GasLinxx Heptane 

23 Octane  Linear 
Mtr_X.FLUID_PROP_OBJ.C8_INUSE 

Average No Yes  GasLinxx Octane 

24 Nonane  Linear 
Mtr_X.FLUID_PROP_OBJ.C9_INUSE  

Average No Yes  GasLinxx Nonane 

25 Decane  Linear 
Mtr_X.FLUID_PROP_OBJ.C10_INUSE 

Average No Yes  GasLinxx Decane 

26 Nitrogen  Linear 
Mtr_X.FLUID_PROP_OBJ.N2_INUSE 

Average Yes Yes  GasLinxx Nitrogen 

27 C02  Linear 
Mtr_X.FLUID_PROP_OBJ.CO2_INUSE 

Average Yes Yes  GasLinxx C02 
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C.3 Liquid Linear Meter – Default History Setup Point Configurations 

The tables below show the compact and expanded history point configurations for liquid linear meters, based on your selected 
liquid product configuration (Use Case), after using the default history setup feature.  

FBxConnect™ first attempts to configure the FB Series product's default history using the points described in the Expanded 
Liquid History table below. If the FB Series product does not have sufficient memory to log all the points in expanded history, 
then FBxConnect™ configures the FB Series product's default history using the points described in the Compact Liquid History 
table below. 

The history points logged are also dependant on the use case/liquid product configuration of your FB Series product: 

Note 

• For Totals, the Total_X.RAW_PARAM signal is used to set Hist_Y.HIST_PARAM. The Archive Type is set as Total/Diff or 
Snapshot.  

• For Averages, the Average_X.SAMPLE_PARAM signal is used to set Hist_Y.HIST_PARAM. The Archive Type is set as Average.  

Table 57. Use Case 

Use Case Liquid Product Configuration Compact History Expanded History 

Crude Oil Custody 
Transfer 

• Crude Oil (Liq Prod_X.LIQ_TYPE = 0) 

• API Ch.12.2 (Station_X.OIL_METHOD = 0) 
Yes Yes 

Crude Oil Allocation - 
Low Water 

• Crude Oil (Liq Prod_X.LIQ_TYPE = 0) 

• API Ch.20.1 (Station_X.OIL_METHOD = 1)  

• Station_X.WATER_OPT = 0 

Yes No 

Crude Oil Allocation - 
High Water 

• Crude Oil (Liq Prod_X.LIQ_TYPE = 0) 

• API Ch.20.1 (Station_X.OIL_METHOD = 1)  

• Station_X.WATER_OPT = 1 

Yes No 
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Use Case Liquid Product Configuration Compact History Expanded History 

Refined Products / 
Lubricating Oil 

• Refined Products / Lubricating Oil (Liq Prod_X.LIQ_TYPE = 1 or 3) 
Yes Yes 

Light Hydrocarbons • Light Hydrocarbon - NGL/LPG (Liq Prod_X.LIQ_TYPE = 6) Yes Yes 

Additional Fluids • Additional Fluid (Liq Prod_X.LIQ_TYPE = 7) Yes Yes 

 
 
Table 58. Compact Liquid History 

ID 
History Point 
(Description) Parameter 

Archive 
Type 

Crude Oil 
Custody 
Transfer 

Crude Oil 
Allocation 

– Low 
Water 

Crude Oil 
Allocation – High 

Water 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon

s Additional Fluids Condition 

Full 
Descriptio

n 

1 FDensity  Liq 
LinMtr_X.FLUID_PR
OP_OBJ.DENSF_SEL 

Average  Yes  Yes  • Coriolis = 
Yes 

• Turbine = 
No 

• Ultrasonic = 
No 

• Positive 
Displaceme
nt = No 

Yes  Yes  Yes  LiqLinxx 
FDensity 

2 Pressure  Liq 
LinMtr_X.PF_OBJ.SE
LECTED 

Average  Yes  Yes  Yes  Yes  Yes  Yes • If PF_OBJ is 
assigned to 
User Data_ 
object then 
average 
DOUBLE_2. 

• If PF_OBJ is 
assigned to 
FBxNData_ 
object then 
average 

LiqLinxx 
Pressure 
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ID 
History Point 
(Description) Parameter 

Archive 
Type 

Crude Oil 
Custody 
Transfer 

Crude Oil 
Allocation 

– Low 
Water 

Crude Oil 
Allocation – High 

Water 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon

s Additional Fluids Condition 

Full 
Descriptio

n 

SELECTED_DOU
BLE 

• If PF_OBJ is 
assigned to 
HART_ object 
then average 
PV_SELECTED. 

3 Temp  Liq 
LinMtr_X.TF_OBJ.SE
LECTED 

Average  Yes  Yes  Yes  Yes  Yes  Yes • If TF_OBJ is 
assigned to 
User Data_ 
object then 
average 
DOUBLE_3. 

• If TF_OBJ is 
assigned to 
FBxNData_ 
object then 
average 
SELECTED_DOU
BLE 

• If TF_OBJ is 
assigned to 
HART_ object 
then average 
PV_SELECTED. 

LiqLinxx 
Temp 
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ID 
History Point 
(Description) Parameter 

Archive 
Type 

Crude Oil 
Custody 
Transfer 

Crude Oil 
Allocation 

– Low 
Water 

Crude Oil 
Allocation – High 

Water 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon

s Additional Fluids Condition 

Full 
Descriptio

n 

4 MF or KF  Liq 
LinMtr_X.MF_SEL 
or KF_SEL 

Average  • Set to 
MF_SEL 
when 
FACTO
R_CURV
E_OPT 
= 0 or 1 
(Single 
MF/KF 
or MF 
Curve) 

• Set to 
KF_SEL 
when 
FACTO
R_CURV
E_OPT 
= 2 (KF 
Curve) 

• Set to 
MF_SEL 
when 
FACTOR
_CURVE
_OPT = 
0 or 1 
(Single 
MF/KF 
or MF 
Curve) 

• Set to 
KF_SEL 
when 
FACTOR
_CURVE
_OPT = 
2 (KF 
Curve) 

• Set to MF_SEL 
when 
FACTOR_CURV
E_OPT = 0 or 1 
(Single MF/KF 
or MF Curve) 

• Set to KF_SEL 
when 
FACTOR_CURV
E_OPT = 2 (KF 
Curve) 

• Set to 
MF_SEL 
when 
FACTOR_
CURVE_O
PT = 0 or 
1 (Single 
MF/KF or 
MF 
Curve) 

• Set to 
KF_SEL 
when 
FACTOR_
CURVE_O
PT = 2 
(KF 
Curve) 

• Set to 
MF_SEL 
when 
FACTOR_C
URVE_OPT 
= 0 or 1 
(Single 
MF/KF or 
MF Curve) 

• Set to 
KF_SEL 
when 
FACTOR_C
URVE_OPT 
= 2 (KF 
Curve) 

• Set to MF_SEL 
when 
FACTOR_CURVE
_OPT = 0 or 1 
(Single MF/KF 
or MF Curve) 

• Set to KF_SEL 
when 
FACTOR_CURVE
_OPT = 2 (KF 
Curve) 

 LiqLinxx MF 
or KF 

5 IQ  Liq 
LinMtr_X.IQ_RAW_
TOT 

Total / 
Diff  

Yes  Yes  Yes  Yes  Yes  Yes   LiqLinxx IQ 

6 IQ Snap Liq 
LinMtr_X.IQ_RAW_
TOT 

Snapshot Yes  Yes  Yes  Yes  Yes  Yes   LiqLinxx IQ 
Snap 

7 Oil UVol UVol Liq 
LinMtr_X.UVOL_O_
RAW_TOT 

Total / 
Diff  

No  No  Yes No  No No  LiqLinxx Oil 
UVol 

7 GS Vol  Liq 
LinMtr_X.GSVOL_R
AW_TOT 

Total / 
Diff  

Yes  Yes  No  Yes  Yes  Yes   LiqLinxx GS 
Vol 
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ID 
History Point 
(Description) Parameter 

Archive 
Type 

Crude Oil 
Custody 
Transfer 

Crude Oil 
Allocation 

– Low 
Water 

Crude Oil 
Allocation – High 

Water 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon

s Additional Fluids Condition 

Full 
Descriptio

n 

8 GS Vol Snap Liq 
LinMtr_X.GSVOL_R
AW_TOT 

Snapshot  No  No  No  Yes  Yes  Yes   LiqLinxx GS 
Vol Snap 

8 Oil SVol  Liq 
LinMtr_X.SVOL_O_
RAW_TOT  

Total / 
Diff  

Yes  Yes  Yes  No  No  No  LiqLinxx Oil 
SVol 

9 OilSVolSnap Liq 
LinMtr_X.SVOL_O_
RAW_TOT 

Snapshot  Yes  Yes  Yes  No  No No  LiqLinxx 
OilSVolSnap 

10 CSW  Liq 
LinMtr_X.CSW_INU
SE 

Average  Yes  Yes  No  No  No  No  LiqLinxx 
CSW 

10 S&W %   Liq 
LinMtr_X.FLUID_PR
OP_OBJ.WC_SEL  

Average  No  No  Yes No  No No  LiqLinxx 
S&W % 

10 Pe  Liq 
LinMtr_X.FLUID_PR
OP_OBJ.PE_INUSE  

Average  No  No  No  No  Yes  No  LiqLinxx Pe 

11 CTL  Liq 
LinMtr_X.CTL_INUS
E  

Average  Yes  Yes  No  Yes  Yes  No  LiqLinxx 
CTL 

12 CPL  Liq 
LinMtr_X.CPL_INUS
E 

Average  Yes  Yes  No  Yes  Yes  No  LiqLinxx 
CPL 

13 CTPL Liq 
LinMtr_X.CTPL_INU
SE  

Average  No  No  No  No  No  Yes   LiqLinxx 
CTPL 

14 Mass  Liq 
LinMtr_X.MASS_RA
W_TOT  

Total / 
Diff  

Yes  No  No  Yes  Yes  Yes   LiqLinxx 
Mass 
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ID 
History Point 
(Description) Parameter 

Archive 
Type 

Crude Oil 
Custody 
Transfer 

Crude Oil 
Allocation 

– Low 
Water 

Crude Oil 
Allocation – High 

Water 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon

s Additional Fluids Condition 

Full 
Descriptio

n 

15 HDens  Liq 
LinMtr_X.STATION_
OBJ.DENSH_INUSE 

Average  Set when 
Station_X.
DENS_OPT 
= 2 
(Station 
Header 
Density) 

Set when 
Station_X.D
ENS_OPT = 
2 (Station 
Header 
Density)  

No  Set when 
Station_X.DE
NS_OPT = 2 
(Station 
Header 
Density) 

Set when 
Station_X.DEN
S_OPT = 2 
(Station 
Header 
Density) 

No  LiqLinxx 
HDens 

16 HPres  Liq 
LinMtr_X.STATION_
OBJ.PH_INUSE  

Average  Set when 
Station_X.
DENS_OPT 
= 2 
(Station 
Header 
Density) 

Set when 
Station_X.D
ENS_OPT = 
2 (Station 
Header 
Density) 

No  Set when 
Station_X.DE
NS_OPT = 2 
(Station 
Header 
Density) 

Set when 
Station_X.DEN
S_OPT = 2 
(Station 
Header 
Density) 

No  LiqLinxx 
HPres 

17 HTemp  Liq 
LinMtr_X.STATION_
OBJ.TH_INUSE  

Average  Set when 
Station_X.
DENS_OPT 
= 2 
(Station 
Header 
Density) 

Set when 
Station_X.D
ENS_OPT = 
2 (Station 
Header 
Density) 

No  Set when 
Station_X.DE
NS_OPT = 2 
(Station 
Header 
Density)  

Set when 
Station_X.DEN
S_OPT = 2 
(Station 
Header 
Density) 

No  LiqLinxx 
HTemp 

 
 
Table 59. Expanded Liquid History 

I
D 

History 
Point 

(Descriptio
n) Parameter 

Archive 
Type 

Crude Oil Custody 
Transfer 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon 

Additiona
l  Fluids Condition Full Description 

1 Pulses  Liq LinMtr_X.PULSE_RAW_TOT  Total / 
Diff  

Yes  Yes  Yes  Yes  LiqLinxx Pulses 
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I
D 

History 
Point 

(Descriptio
n) Parameter 

Archive 
Type 

Crude Oil Custody 
Transfer 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon 

Additiona
l  Fluids Condition Full Description 

2 Pulses Snap Liq LinMtr_X.PULSE_RAW_TOT  Snapsho
t  

Yes  Yes  Yes  Yes  LiqLinxx Pulses Snap 

3 IQ  Liq LinMtr_X.IQ_RAW_TOT  Total / 
Diff  

Yes  Yes  Yes  Yes  LiqLinxx IQ 

4 IQ Snap Liq LinMtr_X.IQ_RAW_TOT  Snapsho
t  

Yes  Yes  Yes  Yes  LiqLinxx IQ Snap 

5 FDensity  Liq 
LinMtr_X.FLUID_PROP_OBJ.DENSF_S
EL 

Average  Yes  Yes  Yes  Yes  LiqLinxx FDensity 

6 Pressure  Liq LinMtr_X.PF_OBJ.SELECTED Average  Yes  Yes  Yes  • Yes • If PF_OBJ is 
assigned to User 
Data_ object 
then average 
DOUBLE_2. 

• If PF_OBJ is 
assigned to 
FBxNData_ 
object then 
average 
SELECTED_DOU
BLE. 

• If PF_OBJ is 
assigned to 
HART_ object 
then average 
PV_SELECTED. 

LiqLinxx Pressure 

7 Temp  Liq LinMtr_X.TF_OBJ.SELECTED Average  Yes  Yes  Yes  • Yes • If TF_OBJ is 
assigned to User 
Data_ object 
then average 
DOUBLE_3. 

LiqLinxx Temp 
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I
D 

History 
Point 

(Descriptio
n) Parameter 

Archive 
Type 

Crude Oil Custody 
Transfer 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon 

Additiona
l  Fluids Condition Full Description 

• If TF_OBJ is 
assigned to 
FBxNData_ 
object then 
average 
SELECTED_DOU
BLE. 

• If TF_OBJ is 
assigned to 
HART_ object 
then average 
PV_SELECTED. 

8 MF  Liq LinMtr_X.MF_SEL Average  Yes  Yes  Yes  Yes  LiqLinxx MF 

9 KF  Liq LinMtr_X.KF_SEL Average  Yes  Yes  Yes  Yes  LiqLinxx KF 

1
0 

S&W % Liq 
LinMtr_X.FLUID_PROP_OBJ.WC_SEL  

Average  Yes  No  No  No  LiqLinxx S&W % 

1
0 

Pe  Liq 
LinMtr_X.FLUID_PROP_OBJ.PE_SEL 

Average  No  No  Yes  No  LiqLinxx Pe 

1
1 

CSW  Liq LinMtr_X.CSW_INUSE Average  Yes  No  No  No  LiqLinxx CSW 

1
2 

CTL  Liq LinMtr_X.CTL_INUSE Average  Yes  Yes  Yes  No  LiqLinxx CTL 

1
3 

CPL  Liq LinMtr_X.CPL_INUSE Average  Yes  Yes  Yes  No  LiqLinxx CPL 

1
4 

CTPL Liq LinMtr_X.CTPL_INUSE Average  No No No Yes  LiqLinxx CTPL 

1
5 

CCF  Liq LinMtr_X.CCF_INUSE Average  Yes  Yes  Yes  Yes  LiqLinxx CCF 

1
6 

GVol  Liq LinMtr_X.GVOL_RAW_TOT Total / 
Diff  

Yes  Yes  Yes  Yes  LiqLinxx GVol 
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I
D 

History 
Point 

(Descriptio
n) Parameter 

Archive 
Type 

Crude Oil Custody 
Transfer 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon 

Additiona
l  Fluids Condition Full Description 

1
7 

GS Vol  Liq LinMtr_X.GSVOL_RAW_TOT  Total / 
Diff  

Yes  Yes  Yes  Yes  LiqLinxx GS Vol 

1
8 

Oil SVol  Liq LinMtr_X.SVOL_O_RAW_TOT Total / 
Diff  

Yes  No No  No  LiqLinxx Oil SVol 

1
9 

Wtr SVol  Liq LinMtr_X.SVOL_W_RAW_TOT Total / 
Diff  

Yes  No  No  No  LiqLinxx Wtr SVol 

2
0 

Mass  Liq LinMtr_X.MASS_RAW_TOT  Total / 
Diff  

Yes  Yes  Yes  Yes  LiqLinxx Mass 

2
1 

GVol Snap Liq LinMtr_X.GVOL_RAW_TOT Snapsho
t 

Yes  Yes  Yes  Yes  LiqLinxx GVol Snap 

2
2 

GSVol Snap Liq LinMtr_X.GSVOL_RAW_TOT  Snapsho
t 

Yes  Yes  Yes  Yes  LiqLinxx GSVol Snap 

2
3 

OilSVolSnap Liq LinMtr_X.SVOL_O_RAW_TOT  Snapsho
t 

Yes  No  No  No  LiqLinxx OilSVolSnap 

2
4 

WtrSVolSna
p 

Liq LinMtr_X.SVOL_W_RAW_TOT Snapsho
t 

Yes  No  No  No  LiqLinxx WtrSVolSnap 

2
5 

Mass Snap Liq LinMtr_X.MASS_RAW_TOT  Snapsho
t 

Yes  Yes  Yes  Yes  LiqLinxx Mass Snap 

2
6 

HDens  Liq 
LinMtr_X.STATION_OBJ.DENSH_INU
SE 

Average Set when 
Station_X.DENS_OP
T = 2 (Station 
Header Density) 

Set when 
Station_X.DEN
S_OPT = 2 
(Station 
Header 
Density) 

Set when 
Station_X.DENS_OP
T = 2 (Station 
Header Density) 

No  LiqLinxx HDens 

2
7 

HPres  Liq 
LinMtr_X.STATION_OBJ.PH_INUSE 

Average Set when 
Station_X.DENS_OP
T = 2 (Station 
Header Density) 

Set when 
Station_X.DEN
S_OPT = 2 
(Station 
Header 
Density) 

Set when 
Station_X.DENS_OP
T = 2 (Station 
Header Density) 

No  LiqLinxx HPres 
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C.4 Liquid Linear Meter – Default Transaction History Setup Point 
Configurations 

The tables below show the default transaction history parameters for Strings, Totals, and Averages. 

Table 60. Default Transaction Hisotory Setup – Strings 

Batch Ticket Description Parameter Archive Type Full Description 

Device ID  Device ID System_1.OBJ_NAME  Snapshot End Device ID 

Meter ID  Meter ID  Liq LMtr_X.OBJ_NAME  Snapshot End LiqLinxx Meter ID 

Product Number  Prod Num  Liq LMtr_X.STATION_OBJ.LIQ_PROD_OBJ  Snapshot End LiqLinxx Prod Num 

Product ID  Prod ID  Future  Snapshot End LiqLinxx Prod ID 

Product Table  Prod Tbl  Future  Snapshot End LiqLinxx Prod Tbl 

 

I
D 

History 
Point 

(Descriptio
n) Parameter 

Archive 
Type 

Crude Oil Custody 
Transfer 

Refined 
Products / 

Lubricating 
Oil 

Light 
Hydrocarbon 

Additiona
l  Fluids Condition Full Description 

2
8 

HTemp  Liq 
LinMtr_X.STATION_OBJ.TH_INUSE  

Average  Set when 
Station_X.DENS_OP
T = 2 (Station 
Header Density) 

Set when 
Station_X.DEN
S_OPT = 2 
(Station 
Header 
Density) 

Set when 
Station_X.DENS_OP
T = 2 (Station 
Header Density) 

No  LiqLinxx HTemp 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 

December 2024 
 

1191 

Table 61. Default Transaction Hisotory Setup – Totals 

Batch Ticket Description Parameter Archive Type Full Description 

Opening Reading (Pulses)  PulsesStart  Liq LinMtr_X.PULSE_TOT_OBJ.RAW_PARAM  Snapshot Start  LiqLinxx PulsesStart 

Closing Reading (Pulses)  Pulses End  Liq LinMtr_X.PULSE_TOT_OBJ.RAW_PARAM  Snapshot End  LiqLinxx Pulses End 

Pulses  Pulses  Liq LinMtr_X.PULSE_TOT_OBJ.RAW_PARAM  Total/Difference  LiqLinxx Pulses 

Opening Reading (IQ)  IQ Start  Liq LinMtr_X.IQ_TOT_OBJ.RAW_PARAM  Snapshot Start  LiqLinxx IQ Start 

Closing Reading (IQ)  IQ End  Liq LinMtr_X.IQ_TOT_OBJ.RAW_PARAM  Snapshot End   LiqLinxx IQ End 

Indicated Quantity  IQ  Liq LinMtr_X.IQ_TOT_OBJ.RAW_PARAM  Total/Difference  LiqLinxx IQ 

Opening Reading (GV)  GVol Start  Liq LinMtr_X.GV_TOT_OBJ.RAW_PARAM  Snapshot Start  LiqLinxx GVol Start 

Closing Reading (GV)  GVol End  Liq LinMtr_X.GV_TOT_OBJ.RAW_PARAM  Snapshot End  LiqLinxx GVol End 

GV  GVol  Liq LinMtr_X.GV_TOT_OBJ.RAW_PARAM  Total/Difference  LiqLinxx GVol 

Opening Reading (GSV)  GSVol Start  Liq LinMtr_X.GSV_TOT_OBJ.RAW_PARAM  Snapshot Start  LiqLinxx GSVol Start 

Closing Reading (GSV)  GSVol End  Liq LinMtr_X.GSV_TOT_OBJ.RAW_PARAM  Snapshot End  LiqLinxx GSVol End 

GSV  GSVol  Liq LinMtr_X.GSV_TOT_OBJ.RAW_PARAM  Total/Difference  LiqLinxx GSVol 

Opening Reading (NSV)  NSVol Start  Liq LinMtr_X.SVOL_O_TOT_OBJ.RAW_PARAM  Snapshot Start  LiqLinxx NSVol Start 

Closing Reading (NSV)  NSVol End  Liq LinMtr_X.SVOL_O_TOT_OBJ.RAW_PARAM Snapshot End  LiqLinxx NSVol End 

NSV  Net SVol  Liq LinMtr_X.SVOL_O_TOT_OBJ.RAW_PARAM  Total/Difference  LiqLinxx Net SVol 

Opening Reading (S&W)  S&W Start  Liq LinMtr_X.SVOL_W_TOT_OBJ.RAW_PARAM  Snapshot Start  LiqLinxx S&W Start 

Closing Reading (S&W)  S&W End  Liq LinMtr_X.SVOL_W_TOT_OBJ.RAW_PARAM  Snapshot End  LiqLinxx S&W End 

S&W  S&W  Liq LinMtr_X.SVOL_W_TOT_OBJ.RAW_PARAM  Total/Difference  LiqLinxx S&W 

Opening Reading (Mass)  Mass Start  Liq LinMtr_X.MASS_TOT_OBJ.RAW_PARAM  Snapshot Start  LiqLinxx Mass Start 

Closing Reading (Mass)  Mass End  Liq LinMtr_X.MASS_TOT_OBJ.RAW_PARAM  Snapshot End  LiqLinxx Mass End 

Mass  Mass  Liq LinMtr_X.MASS_TOT_OBJ.RAW_PARAM  Total/Difference  LiqLinxx Mass 
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Batch Ticket Description Parameter Archive Type Full Description 

Flow Time  Flow Time  Liq LinMtr_X.FLWTM_TOT_OBJ.RAW_PARAM  Total/Difference  LiqLinxx Flow Time 

 

Table 62. Default Transaction History Setup – Averages 

Batch Ticket Description Average Parameter History Parameter 
Archive 

Type Condition Full Description 

FWA Pressure  Pressure Liq LinMtr_X.PF_OBJ.NNNNN  Average_X.SAMPLE_PARAM  Average  If PF_OBJ is 
assigned to User 
Data_ object then 
average 
DOUBLE_2. 
If PF_OBJ is 
assigned to 
FBxNData_ object 
then average 
SELECTED_DOUBL
E. 
If PF_OBJ is 
assigned to HART_ 
object then 
average 
PV_SELECTED. 

LiqLinxx Pressure 

FWA 
Temperature  

Temp Liq LinMtr_X.TF_OBJ.NNNNN  Average_X.SAMPLE_PARAM  Average  If TF_OBJ is 
assigned to User 
Data_ object then 
average 
DOUBLE_3. 
If TF_OBJ is 
assigned to 
FBxNData_ object 
then average 

LiqLinxx Temp 
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Batch Ticket Description Average Parameter History Parameter 
Archive 

Type Condition Full Description 

SELECTED_DOUBL
E. 
If TF_OBJ is 
assigned to HART_ 
object then 
average 
PV_SELECTED. 

Average 
Meter Factor  

MF Liq LinMtr_X.MF_SEL  Average_X.SAMPLE_PARAM  Average   LiqLinxx MF 

Average K-
Factor  

KF Liq LinMtr_X.KF_SEL  Average_X.SAMPLE_PARAM  Average   LiqLinxx KF 

Average CTL  CTL Liq LinMtr_X.CTL_INUSE  Average_X.SAMPLE_PARAM  Average   LiqLinxx CTL 

Average CPL  CPL Liq LinMtr_X.CPL_INUSE  Average_X.SAMPLE_PARAM  Average   LiqLinxx CPL 

Average CTPL  CTPL Liq LinMtr_X.CTPL_INUSE  Average_X.SAMPLE_PARAM  Average   LiqLinxx CTPL 

Average CCF  CCF Liq LinMtr_X.CCF_INUSE  Average_X.SAMPLE_PARAM  Average   LiqLinxx CCF 

Average 
%S&W  

S&W % Liq 
LinMtr_X.FLUID_PROP_OBJ.
WC_SEL  

Average_X.SAMPLE_PARAM  Average   LiqLinxx S&W % 

Average CSW  CSW Liq LinMtr_X.CSW_INUSE  Average_X.SAMPLE_PARAM  Average   LiqLinxx CSW 

Average 
Meter Density  

FDensity Liq 
LinMtr_X.FLUID_PROP_OBJ.D
ENSF_SEL  

Average_X.SAMPLE_PARAM  Average   LiqLinxx FDensity 

Average 
Observed 
Density  

HDens Liq 
LinMtr_X.STATION_OBJ.DEN
SH_INUSE  

Average_X.SAMPLE_PARAM  Average   LiqLinxx HDens 
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Batch Ticket Description Average Parameter History Parameter 
Archive 

Type Condition Full Description 

Average 
Density 
Pressure  

HPres Liq 
LinMtr_X.STATION_OBJ.PH_I
NUSE  

Average_X.SAMPLE_PARAM  Average   LiqLinxx HPres 

Average 
Density 
Temperature  

HTemp Liq 
LinMtr_X.STATION_OBJ.TH_I
NUSE  

Average_X.SAMPLE_PARAM  Average   LiqLinxx HTemp 

Average Base 
Density  

Base Dens Liq 
LinMtr_X.FLUID_PROP_OBJ.D
ENSB_O_SEL  

Average_X.SAMPLE_PARAM  Average   LiqLinxx Base Dens 

Average Flow 
Rate  

Flow Rate Liq LinMtr_X.GV_RATE  Average_X.SAMPLE_PARAM  Average   LiqLinxx Flow Rate 

Average 
Indicated 
Density  

IDens Future     LiqLinxx IDens 

Average 
Density 
Correction 
Factor  

Dens CF Future     LiqLinxx Dens CF 
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Appendix D: Template Editor Map ID Descriptions 
The following table describes the possible Map IDs used by the Template Editor and the equivalent FB Series product parameters for 
gas differential pressure meters, gas linear meters, and liquid linear meters.  

Table 63. Template Editor Map ID Descriptions 

Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

No Mapping N/A N/A N/A 

Meter Tag Name DP Mtr_x.OBJ_NAME Linear Mtr_x.OBJ_NAME Liq LinMtr_x.OBJ_NAME 

Meter Description DP Mtr_x.DESC Linear Mtr_x.DESC Liq LinMtr_x.DESC 

Meter Serial Number DP Mtr_x.SER_NUM Linear Mtr_x.SER_NUM Liq LinMtr_x.SER_NUM 

Meter Type DP Mtr_x.MTR_TYPE Linear Mtr_x.MTR_TYPE Liq LinMtr_x.MTR_TYPE 

Base Pressure (Pb) Station_x.PB_SEL Station_x.PB_SEL Station_x.PB_SEL 

Base Temperature (Tb) Station_x.TB_SEL Station_x.TB_SEL Station_x.TB_SEL 

Latitude Station_x.LATITUDE  Station_x.LATITUDE  Station_x.LATITUDE  

Elevation Station_x.ELEVATION Station_x.ELEVATION Station_x.ELEVATION 

Contract Hour Hist Grp_x.CONTRACT_HR Hist Grp_x.CONTRACT_HR Hist Grp_x.CONTRACT_HR 

Contract Day of Month Hist Grp_x.CONTRACT_DAY   Hist Grp_x.CONTRACT_DAY Hist Grp_x.CONTRACT_DAY 

Meter Pressure Type Gauge 
or Absolute 

DP Mtr_x.PRESS_TYPE Linear Mtr_x.PRESS_TYPE Liq LinMtr_x.PRESS_TYPE 

Low Flow Cutoff DP Mtr_x.NO_FLOW_LIM  Linear Mtr_x.NO_FLOW_LIM Liq LinMtr_x.NO_FLOW_LIM 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Meter Static Pressure Press_x-y.SELECTED or AI_x-
y.SELECTED 

Press_x-y.SELECTED or AI_x-
y.SELECTED 

Press_x-y.SELECTED or AI_x-y.SELECTED 

Meter Temperature RTD_x-y.SELECTED or AI_x-
y.SELECTED 

RTD_x-y.SELECTED or AI_x-
y.SELECTED 

RTD_x-y.SELECTED or AI_x-y.SELECTED 

Atmospheric Pressure Station_x.ATMPR_SEL Station_x.ATMPR_SEL Station_x.ATMPR_SEL 

Meter Factor   Linear Mtr_x.MF_SEL Liq LinMtr_x.MF_SEL 

K-Factor   Linear Mtr_x.KF_SEL Liq LinMtr_x.KF_SEL 

Factor Curve Type   Linear 
Mtr_x.FACTOR_CURVE_OPT 

Liq LinMtr_x.FACTOR_CURVE_OPT 

Mass Pressure Effect Option   Linear 
Mtr_x.MASS_CORR_PF_OPT 

Liq LinMtr_x.MASS_CORR_PF_OPT 

Mass Pressure Effect 
Coefficient 

  Linear 
Mtr_x.MASS_CORR_PF_COEFF 

Liq LinMtr_x.MASS_CORR_PF_COEFF 

Coriolis Calibration Pressure   Linear Mtr_x.PCAL Liq LinMtr_x.PCAL 

Shrinkage Factor     Liq FlProp_x.SF_SEL 

Meter Base Density of Oil     Liq FlProp_x.DENSB_O_SEL 

Accum Current Meter IQ 
Total 

    Liq LinMtr_x.IQ_TOT_OBJ.CURRENT 

Meter Rate   AI_x-y.SELECTED or PI_x-
y.SELECTED_FREQ or User 
Data_x.DOUBLE_1 

AI_x-y.SELECTED or PI_x-y.SELECTED_FREQ or 
User Data_x.DOUBLE_1 

Density Correction Factor     Liq Dens_x.DENS_FACTOR 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Meter Sediment & Water %     Liq FlProp_x.WC_SEL 

Station Object Reference DP Mtr_x.STATION_OBJ Linear Mtr_x.STATION_OBJ Liq LinMtr_x.STATION_OBJ 

Fluid Property Object 
Reference 

DP Mtr_x.FLUID_PROP_OBJ Linear Mtr_x.FLUID_PROP_OBJ Liq LinMtr_x.FLUID_PROP_OBJ 

Meter Flow Alarm Object 
Reference 

DP Mtr_x.FLW_ALM_OBJ Linear Mtr_x.FLW_ALM_OBJ Liq LinMtr_x.FLW_ALM_OBJ 

Periodic History Object 
Reference 

Station_x.HIST_GRP_OBJ Station_x.HIST_GRP_OBJ Station_x.HIST_GRP_OBJ 

Transactional History Object 
Reference 

    Liq LinMtr_x.TRANSHGRP_OBJ 

Liquid Product Object 
Reference 

    Station_x.LIQ_PROD_OBJ 

Liquid Density Object 
Reference 

    Station_x.DENSH_OBJ 

Linear Meter Flow Type Mass 
or Volume 

    Liq LinMtr_x.FLOW_TYPE 

Meter PE     Liq_FlProp_x.PE_INUSE 

Liquid Oil Method     Station_x.OIL_METHOD 

Liquid Water Option     Station_x.WATER_OPT 

Liquid Density Option     Station_x.DENS_OPT 

Liquid Product Name     Liq Prod_x.OBJ_NAME 

Liquid Product Type     Liq Prod_x.LIQ_TYPE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Liquid Product Base Density     Liq Prod_x.DENSB 

Liquid Product Base Density 
Units 

    Liq Prod_x.DENSB_UNITS_TB 

Meter FG Factor     Liq FlProp_x.GASF_SEL 

Meter Density     Liq LinMtr_x.FLUID_PROP_OBJ.DENSF_SEL 

CTLmw     Liq LinMtr_x.CTLM_W_SEL 

Header Pressure     Station_x.PH_INUSE 

Header Temperature     Station_x.TH_INUSE 

Header Density     Station_x.DENSH_INUSE 

Meter Frequency     Liq LinMtr_x.FREQ_INUSE 

Flowing Pressure (A)     Liq LinMtr_x.PF_INUSE 

Flowing Pressure (G)     Liq LinMtr_x.PF_INUSE_G 

Flowing Temperature     Liq LinMtr_x.TF_INUSE 

Meter CTL     Liq LinMtr_x.CTL_INUSE 

Meter CPL     Liq LinMtr_x.CPL_INUSE 

Meter CTPL     Liq LinMtr_x.CTPL_INUSE 

Meter CCF     Liq LinMtr_x.CCF_INUSE 

Meter S&W Correction Factor     Liq LinMtr_x.CSW_INUSE 

Meter Current Batch Number     Liq LinMtr_x.CUR_BATCH_NUM 

Station Batch ID     Station_x.BATCH_ID 

Meter IQ Rate     Liq LinMtr_x.IQ_RATE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Meter GV Rate     Liq LinMtr_x.GVOL_RATE 

Meter GSV Rate     Liq LinMtr_x.GSVOL_RATE 

Meter Unshrunk Vol Rate     Liq LinMtr_x.UVOL_O_RATE 

Meter NSV Rate     Liq LinMtr_x.SVOL_O_RATE 

Meter Water UVol Rate     Liq LinMtr_x.UVOL_W_RATE 

Meter SWV Rate     Liq LinMtr_x.SVOL_W_RATE 

Meter FG Net Vol Rate     Liq LinMtr_x.SVOL_FG_RATE 

Meter NGL Net Vol Rate     Liq LinMtr_x.SVOL_NGL_RATE 

Meter Mass Rate     Liq LinMtr_x.MASS_RATE 

Accum Current Meter GV 
Total 

    Liq LinMtr_x.GVOL_TOT_OBJ.CURRENT 

Accum Current Meter GSV 
Total 

    Liq LinMtr_x.GSVOL_TOT_OBJ.CURRENT 

Accum Current Meter 
Unshrunk Vol Total 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.CURRENT 

Accum Current Meter NSV 
Total 

    Liq LinMtr_x.SVOL_O_TOT_OBJ.CURRENT 

Accum Current Meter Water 
Vol Total 

    Liq LinMtr_x.UVOL_W_TOT_OBJ.CURRENT 

Accum Current Meter SWV 
Total 

    Liq LinMtr_x.SVOL_W_TOT_OBJ.CURRENT 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Accum Current Meter FG 
Total 

    Liq LinMtr_x.SVOL_FG_TOT_OBJ.CURRENT 

Accum Current Meter NGL 
Total 

    Liq LinMtr_x.SVOL_NGL_TOT_OBJ.CURRENT 

Accum Current Meter Flow 
Time Total 

    Liq LinMtr_x.FLWTM_TOT_OBJ.CURRENT 

Accum Current Meter Pulse 
Total 

    Liq LinMtr_x.PULSE_TOT_OBJ.CURRENT 

Accum Current Meter Mass 
Total 

    Liq LinMtr_x.MASS_TOT_OBJ.CURRENT 

Prev Period End Meter IQ     Liq LinMtr_x.IQ_TOT_OBJ.SNAPSHOT 

Prev Period End Meter GV     Liq LinMtr_x.GVOL_TOT_OBJ.SNAPSHOT 

Prev Period End Meter GSV     Liq LinMtr_x.GSVOL_TOT_OBJ.SNAPSHOT 

Prev Period End Meter 
Unshrunk Vol 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.SNAPSHOT 

Prev Period End Meter NSV     Liq LinMtr_x.SVOL_O_TOT_OBJ.SNAPSHOT 

Prev Period End Meter Water 
Vol 

    Liq LinMtr_x.UVOL_W_TOT_OBJ.SNAPSHOT 

Prev Period End Meter SWV     Liq LinMtr_x.SVOL_W_TOT_OBJ.SNAPSHOT 

Prev Period End Meter FG     Liq LinMtr_x.SVOL_FG_TOT_OBJ.SNAPSHOT 

Prev Period End Meter NGL     Liq LinMtr_x.SVOL_NGL_TOT_OBJ.SNAPSHOT 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Period End Meter Flow 
Time 

    Liq LinMtr_x.FLWTM_TOT_OBJ.SNAPSHOT 

Prev Period End Meter Pulse     Liq LinMtr_x.PULSE_TOT_OBJ.SNAPSHOT 

Prev Period End Meter Mass     Liq LinMtr_x.MASS_TOT_OBJ.SNAPSHOT 

Prev Hour Meter Start Time     Liq LinMtr_x.PREV_PER_START_TM 

Prev Hour Meter End Time     Liq LinMtr_x.PREV_PER_END_TM 

Prev Hour Start Meter IQ     Liq LinMtr_x.IQ_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter GV     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter GSV     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter 
Unshrunk Vol 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter NSV     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter UVOL     Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter SWV     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter FG     Liq LinMtr_x.SVOL_FG_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter NGL     Liq 
LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter Flow 
Time 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter Pulse     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_PER_START 

Prev Hour Start Meter Mass     Liq LinMtr_x.MASS_TOT_OBJ.PREV_PER_START 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Hour Meter IQ Total     Liq LinMtr_x.IQ_TOT_OBJ.PREV_PER 

Prev Hour Meter GV Total     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_PER 

Prev Hour Meter GSV Total     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_PER 

Prev Hour Meter Unshrunk 
Vol Total 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_PER 

Prev Hour Meter NSV Total     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_PER 

Prev Hour Meter Water Vol 
Total 

    Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_PER 

Prev Hour Meter SWV Total     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_PER 

Prev Hour Meter FG Total     Liq LinMtr_x.SVOL_FG_TOT_OBJ.PREV_PER 

Prev Hour Meter NGL Total     Liq LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_PER 

Prev Hour Meter Flow Time 
Total 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_PER 

Prev Hour Meter Pulse Total     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_PER 

Prev Hour Meter Mass Total     Liq LinMtr_x.MASS_TOT_OBJ.PREV_PER 

Prev Hour Meter Static 
Pressure Avg 

    Hourly average Liq LinMtr_x.PF_OBJ 

Prev Hour Meter 
Temperature Avg 

    Hourly average Liq LinMtr_x.TF_OBJ 

Prev Hour Meter Density Avg     Hourly average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSF_SEL 

Prev Hour Meter Factor Avg     Hourly average Liq LinMtr_x.MF_SEL 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Hour K-factor Avg     Hourly average Liq LinMtr_x.KF_SEL 

Prev Hour CTLmw Avg     Hourly average Liq LinMtr_x.CTLM_W_SEL 

Prev Hour Shrinkage Factor 
Avg 

    Hourly average Liq 
LinMtr_x.FLUID_PROP_OBJ.SF_SEL 

Prev Hour Meter Base 
Density Oil Avg 

    Hourly average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSB_O_SEL 

Prev Hour S&W% Avg     Hourly average Liq 
LinMtr_x.FLUID_PROP_OBJ.WC_SEL 

Prev Hour Meter FG Factor 
Avg 

    Hourly average Liq 
LinMtr_x.FLUID_PROP_OBJ.GASF_SEL 

Prev Hour Header Pressure 
Avg 

    Hourly average Station_x.PH_INUSE 

Prev Hour Header 
Temperature Avg 

    Hourly average Station_x.TH_INUSE 

Prev Hour Header Density 
Avg 

    Hourly average Station_x.DENSH_INUSE 

Prev Hour Meter Frequency 
Avg 

    Hourly average Liq LinMtr_x.FREQ_INUSE 

Prev Hour Flowing Pressure 
(A) Avg 

    Hourly average Liq LinMtr_x.PF_INUSE 

Prev Hour Flowing Pressure 
(G) Avg 

    Hourly average Liq LinMtr_x.PF_INUSE_G 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Hour Flowing 
Temperature Avg 

    Hourly average Liq LinMtr_x.TF_INUSE 

Prev Hour Meter PE Avg     Hourly average Liq 
LinMtr_x.FLUID_PROP_OBJ.PE_INUSE 

Prev Hour Meter CTL Avg     Hourly average Liq LinMtr_x.CTL_INUSE 

Prev Hour Meter CPL Avg     Hourly average Liq LinMtr_x.CPL_INUSE 

Prev Hour Meter CTPL Avg     Hourly average Liq LinMtr_x.CTPL_INUSE 

Prev Hour Meter CCF Avg     Hourly average Liq LinMtr_x.CCF_INUSE 

Prev Hour S&W Correction 
Factor Avg 

    Hourly average Liq LinMtr_x.CSW_INUSE 

Prev Hour Meter Factor Avg     Hourly average Liq LinMtr_x.MF_INUSE 

Prev Hour Meter IQ Rate Avg     Hourly average Liq LinMtr_x.IQ_RATE 

Prev Hour Meter GV Rate Avg     Hourly average Liq LinMtr_x.GVOL_RATE 

Prev Hour Meter GSV Rate 
Avg 

    Hourly average Liq LinMtr_x.GSVOL_RATE 

Prev Hour Meter Unshrunk 
Vol Rate Avg 

    Hourly average Liq LinMtr_x.UVOL_O_RATE 

Prev Hour Meter NSV Rate 
Avg 

    Hourly average Liq LinMtr_x.SVOL_O_RATE 

Prev Hour Meter Water Vol 
Rate Avg 

    Hourly average Liq LinMtr_x.UVOL_W_RATE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Hour Meter SWV Rate 
Avg 

    Hourly average Liq LinMtr_x.SVOL_W_RATE 

Prev Hour Meter FG Net Vol 
Rate Avg 

    Hourly average Liq LinMtr_x.SVOL_FG_RATE 

Prev Hour Meter NGL Net Vol 
Rate Avg 

    Hourly average Liq LinMtr_x.SVOL_NGL_RATE 

Prev Hour Meter Mass Rate 
Avg 

    Hourly average Liq LinMtr_x.MASS_RATE 

Prev Day Start Time     Liq LinMtr_x.PREV_DAY_START_TM 

Prev Day End Time     Liq LinMtr_x.PREV_DAY_END_TM 

Prev Day Start IQ     Liq LinMtr_x.IQ_TOT_OBJ.PREV_DAY_START 

Prev Day Start GV     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_DAY_START 

Prev Day Start GSV     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_DAY_START 

Prev Day Start Unshrunk Vol     Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_DAY_START 

Prev Day Start NSV     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_DAY_START 

Prev Day Start UVol     Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_DAY_START 

Prev Day Start SWV     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_DAY_START 

Prev Day Start FG     Liq LinMtr_x.SVOL_FG_TOT_OBJ.PREV_DAY_START 

Prev Day Start NGL     Liq 
LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_DAY_START 

Prev Day Start Flow Time     Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_DAY_START 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Day Start Pulse     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_DAY_START 

Prev Day Start Mass     Liq LinMtr_x.MASS_TOT_OBJ.PREV_DAY_START 

Prev Day Meter IQ Total     Liq LinMtr_x.IQ_TOT_OBJ.PREV_DAY 

Prev Day Meter GV Total     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_DAY 

Prev Day Meter GSV Total     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_DAY 

Prev Day Meter Unshrunk Vol 
Total 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_DAY 

Prev Day Meter NSV Total     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_DAY 

Prev Day Meter Water Vol 
Total 

    Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_DAY 

Prev Day Meter SWV Total     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_DAY 

Prev Day Meter FG Total     Liq LinMtr_x.SVOL_FG_TOT_OBJ.PREV_DAY 

Prev Day Meter NGL Total     Liq LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_DAY 

Prev Day Meter Flow Time 
Total 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_DAY 

Prev Day Meter Pulse Total     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_DAY 

Prev Day Meter Mass Total     Liq LinMtr_x.MASS_TOT_OBJ.PREV_DAY 

Prev Day Meter Static 
Pressure Avg 

    Daily average Liq LinMtr_x.PF_OBJ 

Prev Day Meter Temperature 
Avg 

    Daily average Liq LinMtr_x.TF_OBJ 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Day Meter Density Avg     Daily average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSF_SEL 

Prev Day Meter Factor Avg     Daily average Liq LinMtr_x.MF_SEL 

Prev Day K-factor Avg     Daily average Liq LinMtr_x.KF_SEL 

Prev Day CTLmw Avg     Daily average Liq LinMtr_x.CTLM_W_SEL 

Prev Day Shrinkage Factor 
Avg 

    Daily average Liq 
LinMtr_x.FLUID_PROP_OBJ.SF_SEL 

Prev Day Meter Base Density 
Oil Avg 

    Daily average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSB_O_SEL 

Prev Day S&W% Avg     Daily average Liq 
LinMtr_x.FLUID_PROP_OBJ.WC_SEL 

Prev Day Meter FG Factor 
Avg 

    Daily average Liq 
LinMtr_x.FLUID_PROP_OBJ.GASF_SEL 

Prev Day Header Pressure 
Avg 

    Daily average Station_x.PH_INUSE 

Prev Day Header 
Temperature Avg 

    Daily average Station_x.TH_INUSE 

Prev Day Header Density Avg     Daily average Station_x.DENSH_INUSE 

Prev Day Meter Frequency 
Avg 

    Daily average Liq LinMtr_x.FREQ_INUSE 

Prev Day Flowing Pressure 
(A) Avg 

    Daily average Liq LinMtr_x.PF_INUSE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Day Flowing Pressure 
(G) Avg 

    Daily average Liq LinMtr_x.PF_INUSE_G 

Prev Day Flowing 
Temperature Avg 

    Daily average Liq LinMtr_x.TF_INUSE 

Prev Day Meter PE Avg     Daily average Liq 
LinMtr_x.FLUID_PROP_OBJ.PE_INUSE 

Prev Day Meter CTL Avg     Daily average Liq LinMtr_x.CTL_INUSE 

Prev Day Meter CPL Avg     Daily average Liq LinMtr_x.CPL_INUSE 

Prev Day Meter CTPL Avg     Daily average Liq LinMtr_x.CTPL_INUSE 

Prev Day Meter CCF Avg     Daily average Liq LinMtr_x.CCF_INUSE 

Prev Day S&W Correction 
Factor Avg 

    Daily average Liq LinMtr_x.CSW_INUSE 

Prev Day Meter Factor Avg     Daily average Liq LinMtr_x.MF_INUSE 

Prev Day Meter IQ Rate Avg     Daily average Liq LinMtr_x.IQ_RATE 

Prev Day Meter GV Rate Avg     Daily average Liq LinMtr_x.GVOL_RATE 

Prev Day Meter GSV Rate Avg     Daily average Liq LinMtr_x.GSVOL_RATE 

Prev Day Meter Unshrunk Vol 
Rate Avg 

    Daily average Liq LinMtr_x.UVOL_O_RATE 

Prev Day Meter NSV Rate Avg     Daily average Liq LinMtr_x.SVOL_O_RATE 

Prev Day Meter Water Vol 
Rate Avg 

    Daily average Liq LinMtr_x.UVOL_W_RATE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Day Meter SWV Rate 
Avg 

    Daily average Liq LinMtr_x.SVOL_W_RATE 

Prev Day Meter FG Net Vol 
Rate Avg 

    Daily average Liq LinMtr_x.SVOL_FG_RATE 

Prev Day Meter NGL Net Vol 
Rate Avg 

    Daily average Liq LinMtr_x.SVOL_NGL_RATE 

Prev Day Meter Mass Rate 
Avg 

    Daily average Liq LinMtr_x.MASS_RATE 

Prev Week Meter Start Time     Liq LinMtr_x.PREV_WK_START_TM 

Prev Week Meter End Time     Liq LinMtr_x.PREV_WK_END_TM 

Prev Week Start Meter IQ     Liq LinMtr_x.IQ_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter GV     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter GSV     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter 
Unshrunk Vol 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter NSV     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter UVOL     Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter SWV     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter FG     Liq LinMtr_x.SVOL_FG_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter NGL     Liq LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter Flow 
Time 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_WK_START 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Week Start Meter Pulse     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_WK_START 

Prev Week Start Meter Mass     Liq LinMtr_x.MASS_TOT_OBJ.PREV_WK_START 

Prev Week Meter IQ Total     Liq LinMtr_x.IQ_TOT_OBJ.PREV_WK 

Prev Week Meter GV Total     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_WK 

Prev Week Meter GSV Total     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_WK 

Prev Week Meter Unshrunk 
Vol Total 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_WK 

Prev Week Meter NSV Total     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_WK 

Prev Week Meter Water Vol 
Total 

    Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_WK 

Prev Week Meter SWV Total     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_WK 

Prev Week Meter FG Total     Liq LinMtr_x.SVOL_FG_TOT_OBJ.PREV_WK 

Prev Week Meter NGL Total     Liq LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_WK 

Prev Week Meter Flow Time 
Total 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_WK 

Prev Week Meter Pulse Total     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_WK 

Prev Week Meter Mass Total     Liq LinMtr_x.MASS_TOT_OBJ.PREV_WK 

Prev Week Meter Static 
Pressure Avg 

    Weekly average Liq LinMtr_x.PF_OBJ 

Prev Week Meter 
Temperature Avg 

    Weekly average Liq LinMtr_x.TF_OBJ 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Week Meter Density Avg     Weekly average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSF_SEL 

Prev Week Meter Factor Avg     Weekly average Liq LinMtr_x.MF_SEL 

Prev Week K-factor Avg     Weekly average Liq LinMtr_x.KF_SEL 

Prev Week CTLmw Avg     Weekly average Liq LinMtr_x.CTLM_W_SEL 

Prev Week Shrinkage Factor 
Avg 

    Weekly average Liq 
LinMtr_x.FLUID_PROP_OBJ.SF_SEL 

Prev Week Meter Base 
Density Oil Avg 

    Weekly average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSB_O_SEL 

Prev Week S&W% Avg     Weekly average Liq 
LinMtr_x.FLUID_PROP_OBJ.WC_SEL 

Prev Week Meter FG Factor 
Avg 

    Weekly average Liq 
LinMtr_x.FLUID_PROP_OBJ.GASF_SEL 

Prev Week Header Pressure 
Avg 

    Weekly average Station_x.PH_INUSE 

Prev Week Header 
Temperature Avg 

    Weekly average Station_x.TH_INUSE 

Prev Week Header Density 
Avg 

    Weekly average Station_x.DENSH_INUSE 

Prev Week Meter Frequency 
Avg 

    Weekly average Liq LinMtr_x.FREQ_INUSE 

Prev Week Flowing Pressure 
(A) Avg 

    Weekly average Liq LinMtr_x.PF_INUSE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Week Flowing Pressure 
(G) Avg 

    Weekly average Liq LinMtr_x.PF_INUSE_G 

Prev Week Flowing 
Temperature Avg 

    Weekly average Liq LinMtr_x.TF_INUSE 

Prev Week Meter PE Avg     Weekly average Liq 
LinMtr_x.FLUID_PROP_OBJ.PE_INUSE 

Prev Week Meter CTL Avg     Weekly average Liq LinMtr_x.CTL_INUSE 

Prev Week Meter CPL Avg     Weekly average Liq LinMtr_x.CPL_INUSE 

Prev Week Meter CTPL Avg     Weekly average Liq LinMtr_x.CTPL_INUSE 

Prev Week Meter CCF Avg     Weekly average Liq LinMtr_x.CCF_INUSE 

Prev Week S&W Correction 
Factor Avg 

    Weekly average Liq LinMtr_x.CSW_INUSE 

Prev Week Meter Factor Avg     Weekly average Liq LinMtr_x.MF_INUSE 

Prev Week Meter IQ Rate Avg     Weekly average Liq LinMtr_x.IQ_RATE 

Prev Week Meter GV Rate 
Avg 

    Weekly average Liq LinMtr_x.GVOL_RATE 

Prev Week Meter GSV Rate 
Avg 

    Weekly average Liq LinMtr_x.GSVOL_RATE 

Prev Week Meter Unshrunk 
Vol Rate Avg 

    Weekly average Liq LinMtr_x.UVOL_O_RATE 

Prev Week Meter NSV Rate 
Avg 

    Weekly average Liq LinMtr_x.SVOL_O_RATE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Week Meter Water Vol 
Rate Avg 

    Weekly average Liq LinMtr_x.UVOL_W_RATE 

Prev Week Meter SWV Rate 
Avg 

    Weekly average Liq LinMtr_x.SVOL_W_RATE 

Prev Week Meter FG Net Vol 
Rate Avg 

    Weekly average Liq LinMtr_x.SVOL_FG_RATE 

Prev Week Meter NGL Net 
Vol Rate Avg 

    Weekly average Liq LinMtr_x.SVOL_NGL_RATE 

Prev Week Meter Mass Rate 
Avg 

    Weekly average Liq LinMtr_x.MASS_RATE 

Prev Month Meter Start Time     Liq LinMtr_x.PREV_MNTH_START_TM 

Prev Month Meter End Time     Liq LinMtr_x.PREV_MNTH_END_TM 

Prev Month Start Meter IQ     Liq LinMtr_x.IQ_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter GV     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter GSV     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter 
Unshrunk Vol 

    Liq 
LinMtr_x.UVOL_O_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter NSV     Liq 
LinMtr_x.SVOL_O_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter 
UVOL 

    Liq 
LinMtr_x.UVOL_W_TOT_OBJ.PREV_MNTH_START 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

1214 

Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Month Start Meter SWV     Liq 
LinMtr_x.SVOL_W_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter FG     Liq 
LinMtr_x.SVOL_FG_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter NGL     Liq 
LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter Flow 
Time 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter Pulse     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Meter Mass     Liq LinMtr_x.MASS_TOT_OBJ.PREV_MNTH_START 

Prev Month Meter IQ Total     Liq LinMtr_x.IQ_TOT_OBJ.PREV_MNTH 

Prev Month Meter GV Total     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_MNTH 

Prev Month Meter GSV Total     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_MNTH 

Prev Month Meter Unshrunk 
Vol Total 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_MNTH 

Prev Month Meter NSV Total     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_MNTH 

Prev Month Meter Water Vol 
Total 

    Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_MNTH 

Prev Month Meter SWV Total     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_MNTH 

Prev Month Meter FG Total     Liq LinMtr_x.SVOL_FG_TOT_OBJ.PREV_MNTH 

Prev Month Meter NGL Total     Liq LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_MNTH 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Month Meter Flow Time 
Total 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_MNTH 

Prev Month Meter Pulse 
Total 

    Liq LinMtr_x.PULSE_TOT_OBJ.PREV_MNTH 

Prev Month Meter Mass Total     Liq LinMtr_x.MASS_TOT_OBJ.PREV_MNTH 

Prev Month Meter Static 
Pressure Avg 

    Monthly average Liq LinMtr_x.PF_OBJ 

Prev Month Meter 
Temperature Avg 

    Monthly average Liq LinMtr_x.TF_OBJ 

Prev Month Meter Density 
Avg 

    Monthly average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSF_SEL 

Prev Month Meter Factor Avg     Monthly average Liq LinMtr_x.MF_SEL 

Prev Month K-factor Avg     Monthly average Liq LinMtr_x.KF_SEL 

Prev Month CTLmw Avg     Monthly average Liq LinMtr_x.CTLM_W_SEL 

Prev Month Shrinkage Factor 
Avg 

    Monthly average Liq 
LinMtr_x.FLUID_PROP_OBJ.SF_SEL 

Prev Month Meter Base 
Density Oil Avg 

    Monthly average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSB_O_SEL 

Prev Month S&W% Avg     Monthly average Liq 
LinMtr_x.FLUID_PROP_OBJ.WC_SEL 

Prev Month Meter FG Factor 
Avg 

    Monthly average Liq 
LinMtr_x.FLUID_PROP_OBJ.GASF_SEL 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Month Header Pressure 
Avg 

    Monthly average Station_x.PH_INUSE 

Prev Month Header 
Temperature Avg 

    Monthly average Station_x.TH_INUSE 

Prev Month Header Density 
Avg 

    Monthly average Station_x.DENSH_INUSE 

Prev Month Meter Frequency 
Avg 

    Monthly average Liq LinMtr_x.FREQ_INUSE 

Prev Month Flowing Pressure 
(A) Avg 

    Monthly average Liq LinMtr_x.PF_INUSE 

Prev Month Flowing Pressure 
(G) Avg 

    Monthly average Liq LinMtr_x.PF_INUSE_G 

Prev Month Flowing 
Temperature Avg 

    Monthly average Liq LinMtr_x.TF_INUSE 

Prev Month Meter PE Avg     Monthly average Liq 
LinMtr_x.FLUID_PROP_OBJ.PE_INUSE 

Prev Month Meter CTL Avg     Monthly average Liq LinMtr_x.CTL_INUSE 

Prev Month Meter CPL Avg     Monthly average Liq LinMtr_x.CPL_INUSE 

Prev Month Meter CTPL Avg     Monthly average Liq LinMtr_x.CTPL_INUSE 

Prev Month Meter CCF Avg     Monthly average Liq LinMtr_x.CCF_INUSE 

Prev Month S&W Correction 
Factor Avg 

    Monthly average Liq LinMtr_x.CSW_INUSE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Month Meter Factor Avg     Monthly average Liq LinMtr_x.MF_INUSE 

Prev Month Meter IQ Rate 
Avg 

    Monthly average Liq LinMtr_x.IQ_RATE 

Prev Month Meter GV Rate 
Avg 

    Monthly average Liq LinMtr_x.GVOL_RATE 

Prev Month Meter GSV Rate 
Avg 

    Monthly average Liq LinMtr_x.GSVOL_RATE 

Prev Month Meter Unshrunk 
Vol Rate Avg 

    Monthly average Liq LinMtr_x.UVOL_O_RATE 

Prev Month Meter NSV Rate 
Avg 

    Monthly average Liq LinMtr_x.SVOL_O_RATE 

Prev Month Meter Water Vol 
Rate Avg 

    Monthly average Liq LinMtr_x.UVOL_W_RATE 

Prev Month Meter SWV Rate 
Avg 

    Monthly average Liq LinMtr_x.SVOL_W_RATE 

Prev Month Meter FG Net Vol 
Rate Avg 

    Monthly average Liq LinMtr_x.SVOL_FG_RATE 

Prev Month Meter NGL Net 
Vol Rate Avg 

    Monthly average Liq LinMtr_x.SVOL_NGL_RATE 

Prev Month Meter Mass Rate 
Avg 

    Monthly average Liq LinMtr_x.MASS_RATE 

Prev Batch Meter Batch 
Number 

    Liq LinMtr_x.PREV_BATCH_NUM 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Batch Meter Start Time     Liq LinMtr_x.PREV_BATCH_START_TM 

Prev Batch Meter End Time     Liq LinMtr_x.PREV_BATCH_END_TM 

Prev Batch Start Meter IQ     Liq LinMtr_x.IQ_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter GV     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter GSV     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter 
Unshrunk Vol 

    Liq 
LinMtr_x.UVOL_O_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter NSV     Liq 
LinMtr_x.SVOL_O_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter UVOL     Liq 
LinMtr_x.UVOL_W_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter SWV     Liq 
LinMtr_x.SVOL_W_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter FG     Liq 
LinMtr_x.SVOL_FG_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter NGL     Liq 
LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter Flow 
Time 

    Liq 
LinMtr_x.FLWTM_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter Pulse     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Meter Mass     Liq LinMtr_x.MASS_TOT_OBJ.PREV_BATCH_START 

Prev Batch End Meter IQ     Liq LinMtr_x.IQ_TOT_OBJ.PREV_BATCH_END 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Batch End Meter GV     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter GSV     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter 
Unshrunk Vol 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter NSV     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter UVOL     Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter SWV     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter FG     Liq 
LinMtr_x.SVOL_FG_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter NGL     Liq 
LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter Flow 
Time 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter Pulse     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Meter Mass     Liq LinMtr_x.MASS_TOT_OBJ.PREV_BATCH_END 

Prev Batch Meter IQ Total     Liq LinMtr_x.IQ_TOT_OBJ.PREV_BATCH 

Prev Batch Meter GV Total     Liq LinMtr_x.GVOL_TOT_OBJ.PREV_BATCH 

Prev Batch Meter GSV Total     Liq LinMtr_x.GSVOL_TOT_OBJ.PREV_BATCH 

Prev Batch Meter Unshrunk 
Vol Total 

    Liq LinMtr_x.UVOL_O_TOT_OBJ.PREV_BATCH 

Prev Batch Meter NSV Total     Liq LinMtr_x.SVOL_O_TOT_OBJ.PREV_BATCH 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Batch Meter Water Vol 
Total 

    Liq LinMtr_x.UVOL_W_TOT_OBJ.PREV_BATCH 

Prev Batch Meter SWV Total     Liq LinMtr_x.SVOL_W_TOT_OBJ.PREV_BATCH 

Prev Batch Meter FG Total     Liq LinMtr_x.SVOL_FG_TOT_OBJ.PREV_BATCH 

Prev Batch Meter NGL Total     Liq LinMtr_x.SVOL_NGL_TOT_OBJ.PREV_BATCH 

Prev Batch Meter Flow Time 
Total 

    Liq LinMtr_x.FLWTM_TOT_OBJ.PREV_BATCH 

Prev Batch Meter Pulse Total     Liq LinMtr_x.PULSE_TOT_OBJ.PREV_BATCH 

Prev Batch Meter Mass Total     Liq LinMtr_x.MASS_TOT_OBJ.PREV_BATCH 

Prev Batch Meter Static 
Pressure Avg 

    Batch average Liq LinMtr_x.PF_OBJ 

Prev Batch Meter 
Temperature Avg 

    Batch average Liq LinMtr_x.TF_OBJ 

Prev Batch Meter Density 
Avg 

    Batch average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSF_SEL 

Prev Batch Meter Factor Avg     Batch average Liq LinMtr_x.MF_SEL 

Prev Batch K-factor Avg     Batch average Liq LinMtr_x.KF_SEL 

Prev Batch CTLmw Avg     Batch average Liq LinMtr_x.CTLM_W_SEL 

Prev Batch Shrinkage Factor 
Avg 

    Batch average Liq 
LinMtr_x.FLUID_PROP_OBJ.SF_SEL 

Prev Batch Meter Base 
Density Oil Avg 

    Batch average Liq 
LinMtr_x.FLUID_PROP_OBJ.DENSB_O_SEL 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Batch S&W% Avg     Batch average Liq 
LinMtr_x.FLUID_PROP_OBJ.WC_SEL 

Prev Batch Meter FG Factor 
Avg 

    Batch average Liq 
LinMtr_x.FLUID_PROP_OBJ.GASF_SEL 

Prev Batch Header Pressure 
Avg 

    Batch average Station_x.PH_INUSE 

Prev Batch Header 
Temperature Avg 

    Batch average Station_x.TH_INUSE 

Prev Batch Header Density 
Avg 

    Batch average Station_x.DENSH_INUSE 

Prev Batch Meter Frequency 
Avg 

    Batch average Liq LinMtr_x.FREQ_INUSE 

Prev Batch Flowing Pressure 
(A) Avg 

    Batch average Liq LinMtr_x.PF_INUSE 

Prev Batch Flowing Pressure 
(G) Avg 

    Batch average Liq LinMtr_x.PF_INUSE_G 

Prev Batch Flowing 
Temperature Avg 

    Batch average Liq LinMtr_x.TF_INUSE 

Prev Batch Meter PE Avg     Batch average Liq 
LinMtr_x.FLUID_PROP_OBJ.PE_INUSE 

Prev Batch Meter CTL Avg     Batch average Liq LinMtr_x.CTL_INUSE 

Prev Batch Meter CPL Avg     Batch average Liq LinMtr_x.CPL_INUSE 

Prev Batch Meter CTPL Avg     Batch average Liq LinMtr_x.CTPL_INUSE 
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Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Batch Meter CCF Avg     Batch average Liq LinMtr_x.CCF_INUSE 

Prev Batch S&W Correction 
Factor Avg 

    Batch average Liq LinMtr_x.CSW_INUSE 

Prev Batch Meter Factor Avg     Batch average Liq LinMtr_x.MF_INUSE 

Prev Batch Meter IQ Rate 
Avg 

    Batch average Liq LinMtr_x.IQ_RATE 

Prev Batch Meter GV Rate 
Avg 

    Batch average Liq LinMtr_x.GVOL_RATE 

Prev Batch Meter GSV Rate 
Avg 

    Batch average Liq LinMtr_x.GSVOL_RATE 

Prev Batch Meter Unshrunk 
Vol Rate Avg 

    Batch average Liq LinMtr_x.UVOL_O_RATE 

Prev Batch Meter NSV Rate 
Avg 

    Batch average Liq LinMtr_x.SVOL_O_RATE 

Prev Batch Meter Water Vol 
Rate Avg 

    Batch average Liq LinMtr_x.UVOL_W_RATE 

Prev Batch Meter SWV Rate 
Avg 

    Batch average Liq LinMtr_x.SVOL_W_RATE 

Prev Batch Meter FG Net Vol 
Rate Avg 

    Batch average Liq LinMtr_x.SVOL_FG_RATE 

Prev Batch Meter NGL Net 
Vol Rate Avg 

    Batch average Liq LinMtr_x.SVOL_NGL_RATE 
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Prev Batch Meter Mass Rate 
Avg 

    Batch average Liq LinMtr_x.MASS_RATE 

Station GV Rate     Station_x.GVOL_RATE 

Station NSV Rate     Station_x.SVOL_O_RATE 

Station SWV Rate     Station_x.SVOL_W_RATE 

Station Mass Rate     Station_x.MASS_RATE 

Accum Current Station GV 
Total 

    Station_x.GVOL_TOT_OBJ.CURRENT 

Accum Current Station NSV 
Total 

    Station_x.SVOL_O_TOT_OBJ.CURRENT 

Accum Current Station SWV 
Total 

    Station_x.SVOL_W_TOT_OBJ.CURRENT 

Accum Current Station Mass 
Total 

    Station_x.MASS_TOT_OBJ.CURRENT 

Prev Period End Station GV     Station_x.GVOL_TOT_OBJ.SNAPSHOT 

Prev Period End Station NSV     Station_x.SVOL_O_TOT_OBJ.SNAPSHOT 

Prev Period End Station SWV     Station_x.SVOL_W_TOT_OBJ.SNAPSHOT 

Prev Period End Station Mass     Station_x.MASS_TOT_OBJ.SNAPSHOT 

Prev Hour Station End Time     Station_x.PREV_PER_END_TM 

Prev Hour Start Station GV     Station_x.GVOL_TOT_OBJ.PREV_PER_START 

Prev Hour Start Station NSV     Station_x.SVOL_O_TOT_OBJ.PREV_PER_START 
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Prev Hour Start Station SWV     Station_x.SVOL_W_TOT_OBJ.PREV_PER_START 

Prev Hour Start Station Mass     Station_x.MASS_TOT_OBJ.PREV_PER_START 

Prev Hour Station GV Total     Station_x.GVOL_TOT_OBJ.PREV_PER 

Prev Hour Station NSV Total     Station_x.SVOL_O_TOT_OBJ.PREV_PER 

Prev Hour Station SWV Total     Station_x.SVOL_W_TOT_OBJ.PREV_PER 

Prev Hour Station Mass Total     Station_x.MASS_TOT_OBJ.PREV_PER 

Prev Day Station End Time     Station_x.PREV_DAY_END_TM 

Prev Day Start Station GV     Station_x.GVOL_TOT_OBJ.PREV_DAY_START 

Prev Day Start Station NSV     Station_x.SVOL_O_TOT_OBJ.PREV_DAY_START 

Prev Day Start Station SWV     Station_x.SVOL_W_TOT_OBJ.PREV_DAY_START 

Prev Day Start Station Mass     Station_x.MASS_TOT_OBJ.PREV_DAY_START 

Prev Day Station GV Total     Station_x.GVOL_TOT_OBJ.PREV_DAY 

Prev Day Station NSV Total     Station_x.SVOL_O_TOT_OBJ.PREV_DAY 

Prev Day Station SWV Total     Station_x.SVOL_W_TOT_OBJ.PREV_DAY 

Prev Day Station Mass Total     Station_x.MASS_TOT_OBJ.PREV_DAY 

Prev Week Station End Time     Station_x.PREV_WK_END_TM 

Prev Week Start Station GV     Station_x.GVOL_TOT_OBJ.PREV_WK_START 

Prev Week Start Station NSV     Station_x.SVOL_O_TOT_OBJ.PREV_WK_START 

Prev Week Start Station SWV     Station_x.SVOL_W_TOT_OBJ.PREV_WK_START 

Prev Week Start Station Mass     Station_x.MASS_TOT_OBJ.PREV_WK_START 
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Prev Week Station GV Total     Station_x.GVOL_TOT_OBJ.PREV_WK 

Prev Week Station NSV Total     Station_x.SVOL_O_TOT_OBJ.PREV_WK 

Prev Week Station SWV Total     Station_x.SVOL_W_TOT_OBJ.PREV_WK 

Prev Week Station Mass Total     Station_x.MASS_TOT_OBJ.PREV_WK 

Prev Month Station End Time     Station_x.PREV_MNTH_END_TM 

Prev Month Start Station GV     Station_x.GVOL_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Station NSV     Station_x.SVOL_O_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Station 
SWV 

    Station_x.SVOL_W_TOT_OBJ.PREV_MNTH_START 

Prev Month Start Station 
Mass 

    Station_x.MASS_TOT_OBJ.PREV_MNTH_START 

Prev Month Station GV Total     Station_x.GVOL_TOT_OBJ.PREV_MNTH 

Prev Month Station NSV Total     Station_x.SVOL_O_TOT_OBJ.PREV_MNTH 

Prev Month Station SWV 
Total 

    Station_x.SVOL_W_TOT_OBJ.PREV_MNTH 

Prev Month Station Mass 
Total 

    Station_x.MASS_TOT_OBJ.PREV_MNTH 

Prev Batch Station Start Time     Station_x.PREV_BATCH_START_TM 

Prev Batch Station End Time     Station_x.PREV_BATCH_END_TM 

Prev Batch Start Station GV     Station_x.GVOL_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Station NSV     Station_x.SVOL_O_TOT_OBJ.PREV_BATCH_START 
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Prev Batch Start Station SWV     Station_x.SVOL_W_TOT_OBJ.PREV_BATCH_START 

Prev Batch Start Station 
Mass 

    Station_x.MASS_TOT_OBJ.PREV_BATCH_START 

Prev Batch End Station GV     Station_x.GVOL_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Station NSV     Station_x.SVOL_O_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Station SWV     Station_x.SVOL_W_TOT_OBJ.PREV_BATCH_END 

Prev Batch End Station Mass     Station_x.MASS_TOT_OBJ.PREV_BATCH_END 

Prev Batch Station GV Total     Station_x.GVOL_TOT_OBJ.PREV_BATCH 

Prev Batch Station NSV Total     Station_x.SVOL_O_TOT_OBJ.PREV_BATCH 

Prev Batch Station SWV Total     Station_x.SVOL_W_TOT_OBJ.PREV_BATCH 

Prev Batch Station Mass 
Total 

    Station_x.MASS_TOT_OBJ.PREV_BATCH 

Prev Meter Start Time     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter End Time     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter IQ     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev Start Meter GV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter GSV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter Unshrunk 
Vol 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter NSV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter UVol     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter SWV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter FG     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter NGL     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev Start Meter Flow Time     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter Pulse     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Meter Mass     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter IQ     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter GV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter GSV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter Unshrunk Vol     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter NSV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev End Meter UVol     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter SWV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter FG     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter NGL     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter Flow Time     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter Pulse     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev End Meter Mass     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter IQ Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev Meter GV Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter GSV Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Unshrunk Vol 
Total 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter NSV Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Water Vol Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter SWV Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter FG Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter NGL Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev Meter Flow Time Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Pulse Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Mass Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Static Pressure Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Flowing Temperature 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Density Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Factor Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev K-factor Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev CTLmw Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Shrinkage Factor Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Base Density Oil 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev S&W% Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter FG Factor Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Header Pressure Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Header Temperature 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Header Density Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev Meter Frequency Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Flowing Pressure (A) 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Flowing Pressure (G) 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Flowing Temperature 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter PE Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter CTL Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter CPL Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter CTPL Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 



FBxConnect™ Configuration Software User Manual (for the FB3000 RTU) 
D301882X012 
December 2024 
 

1234 

Map ID Gas DP Meter Equivalent Gas Linear Meter Equivalent Liquid Linear Meter Equivalent 

Prev Meter CCF Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev S&W Correction Factor 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Factor Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter IQ Rate Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter GV Rate Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter GSV Rate Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Unshrunk Vol 
Rate Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter NSV Rate Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev Meter Water Vol Rate 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter SWV Rate Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter FG Net Vol Rate 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter NGL Net Vol Rate 
Avg 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Mass Rate Avg     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Station Start 
Time 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Meter Station End Time     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Station GV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Prev Start Station NSV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Station SWV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Prev Start Station Mass     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Station Prev End Station GV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Station Prev End Station NSV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Station Prev End Station SWV     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Station Prev End Station 
Mass 

    Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Station Prev GV Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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Station Prev NSV Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Station Prev SWV Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 

Station Prev Mass Total     Parameter depends upon the Report Generate 
Command Parameter. For more information, 
refer to Reports. 
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